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The Configurer is our name for the tabbed dialog that appears when you click Config on the Entry 
Window top menu, and then choose Configure Ports, Mode Control, Audio, Other. The Configurer has 
many tabs with program settings influencing all aspects of the behavior of the program. Be careful in 
setting up items on the different tabs, to be sure that you understand that the option you are choosing 
is what you want.  

All settings are remembered by the program in N1MM Logger.ini. Function key definitions, telnet 
clusters, call history, and country information are not saved in the .ini file, but in the database that 
was in use when you loaded them. That means, for example, that function key definitions loaded or 

modified when you are using one database will only appear in that database. You will need to export 
them from that database and load them into another database before they would show up there. The 
N1MM Logger.ini file contains the name of the .mdb file you were last using, which the program will 
load when it is started, as well as the name of the current contest and other recently-opened contests.  

If you have not unchecked "Hide extensions for known file types" in Windows Explorer Options, you 
will not see N1MM Logger.ini. You will see "N1MM Logger" with a Type of "Configuration Settings". 
Also, do not be confused by the file N1MM Logger.ini.init". This is used by the program during 
installation. You should not modify this file, because if you ever have to delete your .ini file and start 
over (to resolve a configuration problem, for example), it provides the basis for starting a new one  

Multiple ini files 

You can invoke an ini file whose name is different from N1MM Logger.ini by using the file name as a 

command-line argument when the program is started.  

For example, suppose you wanted to be able to choose between two separate configurations, one for 

SO2R and one for SO1V, perhaps using different radios and with different settings. You could create 
two new copies of your N1MM Logger.ini file in the N1MM Logger program folder and rename them to, 
for example, SO2R.ini and SO1V.ini.  



Then create two desktop shortcuts for N1MM Logger by right-clicking in an unused area of the screen 

and selecting New > Shortcut. Use the Browse button to find your N1MM Logger program folder and 

click on the N1MM Logger.exe file. You will notice that the file name appears in the location box 
within quotation marks, e.g.  
"C:\Program Files\N1MM logger\N1MM Logger.exe" . Click just to the right of this file name within the 
box after the closing " , press the space bar once and add the name of one of your new ini files, e.g. 
SO2R.ini, so that it looks like  
"C:\Program Files\N1MM logger\N1MM Logger.exe" SO2R.ini  

Note that if the name of your new ini file contains a space, such as "RTTY SO2R.ini", you will need to 
enclose the file name in quotation marks as well, e.g. "C:\Program Files\N1MM logger\N1MM 
Logger.exe" "RTTY SO2R.ini"  

Click Next, choose a name for the shortcut, e.g. N1MM Logger SO2R, and click Finish. Repeat this 
procedure for other specific shortcuts.  

Each of these shortcuts will now start up the Logger using the ini file named in the shortcut. Any 
configuration changes you make will be stored in the named ini file, thus enabling you to save 
different configurations in the two files and to choose which configuration to use by starting the 

program from the appropriate desktop icon. 

1. Configurer >Hardware tab 

The Hardware tab is used to set up your radios, packet interfaces, telnet connections, CW/PTT/digital 
ports and the interfaces to other devices, such as SO2R controllers, multi-purpose interfaces, and 
keyers, if they require serial or parallel ports. Set the values appropriate to your station. If you do not 
have one of the items listed connected to a port, make sure the port selection is 'None' and the check 
boxes are not checked for that port.  

1.1. Hardware setup 

The program supports 8 serial ports (COM1 - COM8) and 3 parallel ports (LPT1 - LPT3).  
Set up each port depending on what equipment is connected and enter the appropriate information.  

1.1.1. Why Only 8 ports 

One of the first things people notice when they begin setting up N1MM Logger is that there are only 
COM ports 1-8 available. This is a limitation of some of the components used in the programming, and 
cannot be changed at this point without a prohibitive amount of effort.  

In helping people who say "but my lower-numbered COM ports are all committed to other things", we 
have found that it often turns out that some of these ports, though seemingly in use, are in fact relics 
of the past. As an example, COM3 used to be the standard port for built-in modems, and even though 
those modems have largely gone the way of the dinosaur, many computers still show COM 3 as 
committed to that use.  

If you are familiar with the use of Device Manager, you can always set up several hardware profiles, 
including one for ham radio that deletes the devices that are getting in your way (printers and so on). 

That way, you are only a reboot away from being ready to go for radio or being back in everyday 
mode.  

Sometimes, though, ports will not seem to be committed, but when you try to create virtual serial 
ports (with a USB-to-serial adapter, for example) Windows will inexplicably skip some lower number 
ports. Ron Rossi, KK1L, has contributed the following note about how to track down and eliminate 



these phantoms. Be aware that it involves a little beyond the basic user-level skills, so ask for expert 
local help if you're not comfortable with what he suggests.  

Often there are ports assigned which no longer have devices connected to them. These are called 
"phantom ports". These can be discovered and removed. It may then be possible to move ports 
around to accommodate the program.  

Here is how to have Device Manager show any "phantom" ports.  

1. Click Start  
2. Click Run  
3. Type cmd.exe in the textbox and click OK  
4. Type set devmgr_show_nonpresent_devices=1 and hit ENTER  
5. Type cd\windows\system32 and hit ENTER  

6. Type start devmgmt.msc and hit ENTER  
7. When the device manager opens, click the View menu  

8. Click Show Hidden Devices  
9. Click on the + sign next to the Ports to see the full list of Com ports being used  
10. Highlight the port you wish to delete and then press delete  

 
Accept when asked to do so and continue with any more that you wish  
to delete.  

Here's what the Device Manager looks like before you delete the phantom ports:  

 



 

 

 

If you want, you can right-click on any of the shaded ports and examine their properties. Each one will 
show up as a "device no longer connected to this computer."  

1.1.2. Options on the Tab 

 
 
 

Setting up each port -  

 Radio - The radio that is interfaced with the program using this port for radio control, i.e. 

control of the radio's frequency and mode. A maximum of two radios can be connected. Select 
'None' if this port is not being used for radio control (even if it is being used for some other 
purpose, such as PTT or CW). If you have only one radio connected, only one of the boxes in 
this column should be set to anything other than None.  

 Digital - Checking this box means this port is used for digital communication 
(MMTTY/MMVARI/Fldigi engine or TNC). This box cannot be checked if this port is used for 
radio control.  

o Use this to indicate the port that is used for a TU or TNC that is being used for 

RTTY.  



o Use it also to indicate the port that will be used for PTT in digital modes, if PTT is to be 

controlled from the digital engine (not applicable if the digital engine is 2Tone).  
 Exception: if you do PTT on the radio control port or from a Winkeyer, do not 

check the Digital box for that port.  

 Second exception: if you are using a port with MMTTY using the EXTFSK add-
in, do not check the Digital box for that port.  

 Packet - Check this box if the port is used for packet radio (TNC). Do not select if no TNC is 
connected for packet radio.  

 CW/Other - Check this box if this port is used for CW, PTT, a foot-switch, a DVK or an SO2R 
controller. This selection may be made in combination with a Radio, Digital or Packet selection 
provided the uses are compatible (e.g. Winkeyer and radio control cannot use the same serial 
port, because both use serial communications, whereas keying CW on the DTR control line can 
be compatible with radio control on the same port if your hardware interface supports it).  

Use ONLY ONE method of PTT or CW keying 

Note that having multiple ports configured for CW or PTT can cause problems; for example, having 

two methods of PTT control operating at the same time can result in the radio failing to switch to 
transmit, or worse, locking up in transmit at the end of a function key message. Pick one method of 
CW keying and one method of PTT control, check the CW/Other box for the port or ports you need for 
them and complete the port configuration using the Set button, and make sure CW/Other is not 
checked for ports that you are not currently using. For digital modes, do not configure PTT control 

from the digital engine (MMTTY or Fldigi) if you have PTT control operating from the main N1MM 
Logger program. 

 Details - Click on the Set button in this column to open a window with a set of controls that 
depends on what is selected in the preceding columns (Radio, Digital, Packet, CW/Other). To 
the right of the details column is a summary of the detailed settings. See below for details.  

The radio buttons in the upper right corner are used to fit the program to your desired mode of 
operation.  

 SO1V - Single Operator 1 VFO  

o In SO1V mode, the backslash, Pause, Ctrl+Right-arrow, grave accent(`) and 
Ctrl+Alt+K keys are disabled to prevent opening the second Entry window. If the 
second Entry window and/or Bandmap window were open, they will be closed when 
exiting the Configurer after selecting SO1V.  

 SO2V - Single Operator 2 VFO (one radio, using both VFOs)  

o Permits using two separate Entry windows, one for each VFO; the full SO2V 
functionality is usable only with radios that have dual receivers  

 SO2R - Single Operator 2 Radio  
o Permits using two separate Entry windows, one for each radio  

1.2. Set button examples 

 COM7 details shown when Radio selected (serial port)  

 COM5 details shown when CW/Other selected for Winkeyer (serial port)  

 COM3 details shown when Digital selected (serial port)  

 LPT1 details shown when CW/Other selected (parallel port)  



 

 
Of course, there will be many more possible combinations, depending on your setup.  

 Speed - The speed of the serial port to radio/if-interface link (check the manual of your 

radio/TNC)  

 Parity - The parity used (check the manual of your radio/TNC)  

 Data Bits - The number of data bits used (check the manual of your radio/TNC)  

 Stop Bits - The number of stop bits used (check the manual of your radio/TNC)  

 DTR - The following selections can be made (pin 4 on DB9 connector):  

o PTT - used for keying the radio  



o CW - used for sending CW to the radio  

o Always on - DTR is always 'high'  
o Always off - DTR is always 'low'  
o Handshake - DTR is used for handshaking  

 RTS - The following selections can be made (pin 7 on DB9 connector):  
o PTT - used for keying the radio  
o Always on - RTS is always 'high'  
o Always off - RTS is always 'low'  
o Handshake - RTS is used for handshaking  

Windows 98 Users 

We do not officially support Windows 98, but we know some people are still using it. If you are, and 

are having trouble getting your radio working, try this - Go into the Windows Control Panel, select the 
serial port, advanced settings and mark the port for XON/XOFF or "NONE" handshaking. Many radios 
now do not support hardware handshaking, and you have to turn it off to get data to/from them 

 Icom Addr (hex) - The address for the radio used, enter without the "H" i.e. 26 not 26H. 

(This field is only shown when an Icom is the selected radio)  

 Radio Nr - The radio controlled from this port  
o In SO1V (one radio, one VFO used) Radio Nr = 1  

o In SO2V (one radio, two VFOs) Radio Nr = 1  
o In SO2R select the radio (1 or 2) connected to or controlled by this port  

 If one LPT "CW/Other port" is set up as Radio=Both, and another LPT 
"CW/Other port" is set up as Radio=2, route band data for second radio to 
second port  

 When using CW/Other with an external SO2R controller the lowest numbered 
(first) LPT port must be assigned RADIO=BOTH (toggles pin 14)  

 I.e. When using LPT-2 and LPT-3 then LPT-2 must have Radio=Both  

 Dig Wnd Nr - Set this to indicate which Digital Interface window uses this port for PTT and/or 
FSK keying (only shown when Digital is checked)  

o If only one DI window is used, select 1  

o If two DI windows are used, select the DI window number this port will be used for  
o If the port is being used for FSK keying, you will also have to configure it in the MMTTY 

Setup window  

 Allow ext. interrupts - Allow external interrupts from this port (serial port - DSR pin 6; 

parallel port - pin 15), e.g. from a footswitch. An interrupt on this line will bring focus to the 
Entry window and stop a CQ in progress  

 Winkeyer - Select when using a Winkeyer keyer. Speed, Parity, Data bits, Stop bits or 
Handshake settings do not have to be adjusted; they are fixed and set by the program. 
Settings for the keyer can be done on the Winkeyer tab in the Configurer. If you select 

Winkeyer, DO NOT set DTR to CW.  
o Not possible if the port is used for radio control, digital or SO2R control (incompatible 

uses)  
o Note: Only one Winkeyer is supported, but a single Winkeyer can key two radios  

 Two Radio Protocol - Support for the MK2R or other SO2R controller from microHAM (using 

control protocol on COM port). USB-only SO2R (no LPT port required) with the MK2R/MK2R+. 
Protocol used may be either the MK2R proprietary protocol or OTRSP (Open Two Radio 

Switching Protocol)  
o Disabled when selection for CW/Other is turned off or when a radio is selected  
o OTRSP forces the port speed etc. to 9600,N,8,1  

o More info in the Digging Deeper chapter on supported hardware  

 CW/Other Port Addr - specify port address for serial and parallel ports  
o Note: For real ports, the address here should be the same as used for this port in 

Windows  

 The initial default address in this box may not be correct in some computers or 
for some add-in cards; if the port does not work, check the port's properties in 
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Device Manager to determine the correct address. There is more information 

on this topic in the Interfacing chapter.  
o For USB-to-serial adapters, the address here can be ignored  
o When both RTS and DTR are set to PTT they will both be keyed for PTT with the set 

PTT delay  
o Packet uses as handshaking RTS + XON/XOFF  
o When using a self-powered interface set the handshaking to always on (DTR), always 

on (RTS) to supply power to the interface  

LPT Port Numbers 

With N1MM, SO2R and LPT CW, the LOWEST number port must have the CW output for BOTH radios if 
it is used with a conventional LPT SO2R box (DXD, KK1L, N6BV, etc.) or microHAM MK2R/MK2R+ in 
LPT (Classic auto control) mode, The LPT with CW, PTT and the TX/RX/Split controls must be 

connected to the SO2R controller. If N1MM is configured for CW on TWO LPT ports (first port: 
Radio=1, second port Radio=2) then CW will be present only on the port representing the radio with 
transmit focus. 

 DVK - DVK interface for MK2R, W9XT & other external DVKs. See this page for detailed 
information, pinouts, and limitations  

o When DVK is selected, the Antenna selection via the LPT port is disabled  
o Note: The DVK pins and the antenna pins on the LPT port overlap  
o When using an external DVK, all of the Run and S&P SSB function keys should be set 

to empty.wav and not left blank  
o microHAM MK2R: if DVK is checked, N1MM Logger will use the DVK in Router instead 

of its own DVK support  

 FootSwitch mode - Pin 6 on the serial ports and pin 15 on parallel ports. The combo box 
options are:  

o None - No footswitch  
o ESM Enter - Pressing Footswitch will cause the same action as pressing Enter key in 

ESM mode  

o Typing Focus - Pressing Footswitch will switch typing focus  

o Switch Radios - Pressing Footswitch will switch the radios (in SO2R)  
o Normal - Pressing the footswitch it will behave if it was connected to the PTT of the 

active transmitter and is automatically connected to the proper (active) radio.When 
the footswitch is released the focus will be set to main Entry window  

o F1 - Pressing Footswitch will cause the same action as pressing functionkey F1  

o F2 - Pressing Footswitch will cause the same action as pressing functionkey F2  
o F3 - Pressing Footswitch will cause the same action as pressing functionkey F3  
o F4 - Pressing Footswitch will cause the same action as pressing functionkey F4  
o F11 - Pressing Footswitch will cause the same action as pressing functionkey F11  
o F12 - Pressing Footswitch will cause the same action as pressing functionkey F12  
o Band lockout - Implemented mostly for multi user stations to block second signal on 

the same band/mode. It may be useful for single user as well. This mode should allow 

you to control PTT for both radios (in case of SO2R) in different modes (SSB/CW). The 
advantage of using it (compared to the foot switch directly connected to the radio) is - 
it stops AutoCQ and Dueling CQ's  

 
It is possible to hook up a footswitch to a serial or parallel port. This should help users with only one 
or no serial ports (when a USB to serial adapter is used) to get the footswitch connected to the 
computer. A pull-up resistor is needed between DSR input (pin 6 on both DB9 and DB25) and +12 
VDC. For using a parallel port as a footswitch, a pull-up resistor is needed between pin 15 and +12 
VDC. Multiple footswitches (one per parallel or serial port) can be used where different settings may 
be used for each one.  

1.3. PTT Options 
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Originally, Push-to-Talk (PTT) was actually a copyrighted term, describing how operators of one 

company's radios could press a button on their microphones to switch from Receive to Transmit. Over 
the years, however, it has come to denote any form of transmit/receive switching external to the 
radio. It could be as simple as a microphone button or a footswitch working directly with the radio, or 
as sophisticated as control by a logging program.  

N1MM Logger provides several options:  

 PTT via serial or parallel port - This option uses the RTS or DTR lines on a serial port or pin xx 

on an LPT port. This more-or-less standard method requires a simple one-transistor interface 
to switch the radio. USB-to-serial adapters can be used for this function; ordinary USB-to 
parallel adapters will not work, because they lack the ability to control individual lines in the 
parallel interface - the one exception is the SO2RXLAT interface developed by PIEXX.  

 PTT via Winkeyer - If a Winkeyer, a keyer that emulates the Winkeyer, or an interface 

incorporating a Winkeyer chip is used, its PTT output can be used in all modes to control 
transmit/receive switching.  

 PTT via radio command - For radios that support it, this option eliminates any need for 

external hardware other than a serial port cable or a serial to USB converter. Check your radio 
manual for details.  

Warning: At the moment, there is no provision for both controlling radio PTT via radio 
command and simultaneously introducing a delay before N1MM begins to send a stored 
message, so if you need to protect external equipment (see below) you should not use this 
option.  

1.3.1. Selecting a PTT Method 

 

Use only one PTT Method at a Time 

Do not select PTT via DTR or RTS in addition to Radio PTT via Command. Whether on the same port 
or another, doing so can result in conflicts that may cause PTT lockups or other 
malfunctions. If these occur, a first troubleshooting step is to verify that you do not have more than 
one PTT method checked. 



 

The screenshot above shows all of the PTT options except for Winkey PTT - shown below. Selecting 
PTT via radio command is done on the port that you have set to control the radio; the three 
checkboxes allow you to select by mode.  

1.3.2. PTT delay: 

This is an important aspect of PTT operation. Some amplifiers are slower than many radios, so if the 
radio begins to transmit as soon as PTT is asserted, it may result in hot-switching of the amplifier's 
internal transmit/receive relays, which can result in damage. In addition, for VHF operation, 
preamplifiers located at the antenna may need to be properly sequenced to avoid damage from 
transmitted RF.  

 In the case of PTT via serial or parallel port, this delay is set in the Configurer, on the 

Hardware tab, when configuring a port for PTT. Note that you will only see this option if you 
have first selected PTT on either RTS or DTR.  

 For Winkeyer PTT, set this delay (called lead-time in Winkeyer parlance) on the Winkeyer tab 

of the Configurer. This affects both hand-sent CW and stored messages. You will probably find 
that any value over 20 milliseconds (probably enough for most amps) throws off your hand-
sent keying.  

 
 

1.4. Other Information 

 
It is possible to have the PTT on the same serial port as the radio with interfaces that support this 
(e.g. with a keying circuit connected between RTS and the radio's PTT input).  

If the type of CW/Other port chosen is LPT1, LPT2 or LPT3, additional information will be present on 
the parallel port. See Radio Interfacing for more detailed info.  

1.5. Windows NT/2000/XP (32 bit OS) 

 
Under 32 bit Windows operating systems, using the parallel and serial ports for PTT and CW keying 
requires a special dll. In N1MM Logger version 11.10.0 and later, this is inpout32.dll, which is installed 
with the Logger. In older versions of the Logger, it is dlportio.dll, which is installed using the program 
Port95nt.exe. A link to this file can be found in the Installation chapter. There is also information on 
installation for WIndows Vista and Windows 7, and for 64-bit OS versions, in that chapter.  

2. Configurer >Telnet Cluster tab 

 Telnet Cluster - The default telnet cluster to connect in the Telnet Window  

o Ctrl+D - delete a row in the table or use right click menu  

 Edit button - Change Telnet Cluster List  

o File  
 Import... - Import a text file with Packet/Telnet cluster nodes into the 

program  
 Export... - Export the the Packet/Telnet cluster nodes to a text file  

3. Configurer >Files Tab 
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The files Tab is used to set the path to the Buckmaster callsign database if present, and to wav files 
used for voicing callsigns and serial numbers on SSB.  

3.1. Files Field Descriptions 

 Callsign database path - Used to identify the directory of the Buckmaster callsign database 

to be used by the logging program. Be sure to include a trailing '\' in the directory name. Make 
sure that the path to the CD is set correctly. You can set the path to the Buckmaster database 
here and type in the full path to the Buckmaster database on your CD. For example: If your 
CD-ROM is mapped to the 'E' drive, the full path is: E:\HAM0\  

o Don't forget the back-slash '\' at the end of the path! Also, make sure to copy the 

HAMCAL32.DLL from the CD to the program directory where N1MM Logger is installed. 
On older CDs, this file is located in the \API\WINDOWS directory. It may be located 
elsewhere on newer CDs  

 Letters file path - The full path to the letters directory, where the individual letter and 
number wav files are stored for use by the ! and # macros. This is used for voicing call signs 

or serial numbers, more fully described here. The {OPERATOR} macro can be used to invoke 
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different sets of letter files for each operator's voice. Example: C:\program Files\N1MM 

Logger\letters\{OPERATOR}\ . This provides the ability to have a separate letters file for each 
operator in a multi-op, or for guest ops, without having to move your own letters and numbers 
files out of the letters directory. Again, don't forget the backslash at the end of the path.  

4. Configurer >Function Keys Tab 

 

 

 
Function keys for each message are set here.  

4.1. Function Keys Field Descriptions 

 Monitor via PC speaker (Win98/ME only) - The CW sent by the program plays via the PC 

speaker (only for Windows 95, 98, ME, disabled for NT/2000/XP machines)  

 Send Corrected Call (Before End of QSO Msg) - Send Corrected Call (Before End of QSO 
Message) - If the callsign is corrected after answering a call, then the corrected call will be 
sent before the End of QSO message (as configured by the End of QSO Key). E.g. 'PA1M TU 

DE N1MM' instead of 'TU DE N1MM'  

 Send Partial Calls - Only CW. When sending a partial corrected call only the corrected part 
will be send (prefix or suffix). If not checked the whole call will be sent  



 Work Dupes when Running - Work dupes is for ESM in Run mode and don't send the QSO 

B4 Key. All it does is determine what is sent when a dupe calls you AND YOU PRESS ENTER. 
Normally you do want to work dupes. See the chapter Off topic for a discussion  

 Use Contest Word Spacing for CW - The box is defaulted ON for "Use Contest Spacing for 
CW". This setting changes the spacing between words in your CW, where "N1MM 599 5" is 3 

words. Default is 6 bits for "contest spacing". When box is not checked, 7 bits between words 
is used, which is "normal spacing"  

 Send Cut Numbers - In CW this causes serial numbers, and RSTs if you are using the 
{SENTRSTCUT} macro, to be sent using the Cut Number Style set at the bottom of the dialog. 
Ctrl+G can be used to toggle this option while operating. The new status after toggling will be 

shown in the status line at the bottom of the entry window. Numbers other than serial 
numbers and {SENTRSTCUT} will not be affected by this option. This option does not apply to 
SSB or digital modes  

 Send leading zeros in serial numbers - Send leading zeros to make into 3 digit number. In 

CW: Select leading T with the Cut Number Style selector. RTTY: In RTTY zeros will be added, 
so 1 will become 001  

 Stop Sending CQ when Callsign changed - Typing a character in the callsign field will stop 
a (repeated) CQ  

 ESM only sends your call once in S&P, then ready to copy received exchange - This is 
many times called the "Big Gun versus Little Pistol switch" . When selected and in Enter Sends 
Message mode the cursor moves to the Exchange field when there is something in the Callsign 
field and Enter is pressed (so it does not keep the cursor in the callsign field). If you don't 

usually get a station on the first call then deselect this option. Read more about Big Gun \ 
Little Pistol operation inder ESM HERE  

 String to use on CW between his call key and exchange key (default is one space) - 
Just as it says. Example ' ur '  

 Keycode of Ins Key Substitute - Enter the number for the Ins Key substitute as mapped 
below in this configurer dialog. Defaults to 186, the ; character. The program can 
automatically enter the keycode in this field . Place the cursor in the keycode field and press 
the key you want to substitute, it will put the correct keycode in. 186 is an extended key code. 

Not all keyboards map keys the same way. Note that you can't use a Shift, Ctrl, Alt etc. key. I 
would not advise using a key like Numeric + that is already in use. It may or may not work. In 

this case Numeric +, does NOT work  

 Keycode of TU/Log Key Substitute - Enter the number for the TU/Log Key substitute as 
mapped below in this configurer dialog. Defaults to 222, the ' character. The program can 

automatically enter the keycode in this field . Place the cursor in the keycode field and press 
the key you want to substitute, it will put the correct keycode in. 222 is an extended key code. 
Not all keyboards map keys the same way. Note that you can't use a Shift, Ctrl, Alt etc. key. I 
would not advise using a key like Numeric + that is already in use. It may or may not work. 
This particular case (Numeric +) does NOT work  

 Cut Number Style - the following cut number styles can be chosen:  

o T1234567890 (leading T) - leading 0 will be replaced with a T. So 007 will become TT7 
and 030 will become T30  

o O1234567890 (leading O) - leading 0 will be replaced with an O. So 007 will become 
OO7 and 030 will become O30  

o T123456789T (all T) - all zeros will be replaced with a T. So 007 will become TT7 and 
030 will become T3T  

o O123456789O (all O) - all zeros will be replaced with an O. So 007 will become OO7 

and 030 will become O3O  
o T12345678NT (TN) - all zeros will be replaced with a T, all nines with an N. So 097 will 

become TN7 and 090 will become TNT  
o O12345678NO (ON) - all zeros will be replaced with an O, all nines with an N. So 097 

will become ON7 and 090 will become ONO  
o TA2345678NT (TAN) - all zeros will be replaced with a T, all nines with an N, all ones 

with an A. So 091 will become TNA and 190 will become ANT  
o TA234E678NT (TAEN) - all zeros will be replaced with a T, all nines with an N, all ones 

with an A, all fives with an E. So 091 will become TNA and 1590 will become AENT  
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o TAU34E67DNT - the zero, one, two, five, eight, nine will be replaced with a T, A, U, E, 
D, N respectively  

4.2. Remapping Function Keys 

Select which function keys to send messages. Each type of message has a combo box for you to set 
the appropriate function key. If the program is sending the wrong message check here first. The only 
restriction is that a key must mean the same thing in Running and in S&P. Function keys do not have 
to be unique for a selected message. There is little reason to do so although if you want it can be 
done. For the following messages a function key can be selected  

 CQ Key - defaults to F1  

 Exchange Key - defaults to F2  

 End of QSO Key - defaults to F3  

 His Call Key - defaults to F5  

 My Call Key - defaults to F4  

 QSO B4 Key - defaults to F6  

 Again Key - defaults to F8 (can be disabled)  

 Next Call Key - defaults to Disabled  

ESM 
Mode 

Work dupes 
when 
running 

Mode 
QSO B4 
Key 

Again 
Key 

Action Result action  

On 
don't work 

dupes 
Run Disabled F-key 

DUPE callsign 

entered 

Send AGN message when Enter 

pressed  

On 
don't work 
dupes 

Run Disabled Disabled 
DUPE callsign 
entered 

Send the EXCH when Enter is 
pressed, station will be worked 
and logged with Enter, Enter  

On 
don't work 

dupes 
S&P Disabled F-key 

DUPE callsign 

entered 

Pressing Enter does nothing, no 
blue buttons in the Entry 

window  

On 
don't work 
dupes 

S&P Disabled Disabled 
DUPE callsign 
entered 

Pressing Enter does nothing, no 
blue buttons in the Entry 
window  

On work dupes Run - Disabled 

DUPE callsign 
entered. Mistake 
with received QSO 

data 

Send EXCH when Enter is 
pressed  

On 
don't work 
dupes 

Run - Disabled 
Mistake with 
received QSO data 

Send EXCH when Enter is 
pressed  

On - S&P - Disabled 
Mistake with 
received QSO data 

Send EXCH when Enter is 
pressed. After the user corrects 
the entry, it will log and not 
send anything 

 

5. Configurer >Digital Modes Tab 



 

 

The Digital modes tab is used to set up the interfacing to external Controllers (TNCs), or for PTT 
control using MMTTY/MMVARI for sound card digital modes.  

In SO1V mode, there is only one Digital Interface window, DI-1. In SO2V and SO2R modes, there are 
two Digital Interface windows, DI-1 and DI-2. Each DI window is associated with one of the two Entry 
windows. Each DI window is opened from the Window > Digital Interface menu item in the 
corresponding Entry window. The Digital Modes tab in the Configurer is used to configure both Digital 
Interface windows.  

5.1. Digital Modes Field Descriptions 

 Digital Interface 1 / 2  

o TU type  

 None  
 Soundcard - use this selection for MMTTY, MMVARI or Fldigi sound card 

software  
 Other - use this selection for a TNC or TU such as a PK-232 or KAM  
 Dxp38 - for the HAL DXP-38 TU  

o Port, Speed, Parity, Data Bits, Stop Bits, Flow Control - Used when Other or 
Dxp38 is selected, to set the parameters for the COM port used to communicate with 
the TNC or TU (e.g. 9600 baud, N, 8, 1, no flow control for the DXP-38)  

 DI-1 MMTTY Mode | DI-2 MMTTY mode  

o When using MMTTY, select whether AFSK or FSK is being used  



o If AFSK is selected the serial port (if any) with a check in the Digital check box and 

with Dig Wnd Nr corresponding to the DI window number will get passed to MMTTY 
when the DI window is opened, so that MMTTY can use it for PTT control.  

o If FSK is selected the serial port will not get passed to MMTTY. The serial port for FSK 

has to be set in the MMTTY Setup. This is necessary in order to allow for the possibility 
of using EXTFSK in MMTTY. More information in the MMTTY support chapter  

 DI-1 MMTTY Path | DI-2 MMTTY Path  
o The path to the MMTTY engine goes here including the file name of the program  

o It's not necessary that MMTTY be in the same directory as N1MM logger  
o Via the 'Select' buttons the path and file name can be selected  
o It is possible to select two instances of MMTTY in two separate folders. You must do 

this if you want the MMTTY settings in the two instances to be different (e.g. left vs. 
right channel, different sound cards, etc.)  

 DI-1 Fldigi Path | DI-2 Fldigi Path  

o The path to the Fldigi engine goes here including the file name of the program  
o Via the 'Select' buttons the path and file name can be selected  

 DI-1 MMVARI RTTY Mode | DI-2 MMVARI RTTY Mode  

o When using MMVARI for RTTY, select whether AFSK or FSK is being used  
o If AFSK is selected the serial port (if any) with a check in the Digital check box and 

with Dig Wnd Nr corresponding to the DI window number will get passed to MMVARI 
when the DI window is opened, so that MMVARI can use it for PTT control  

o If FSK is selected, the port to be used for PTT control is defined in a separate setup 
window  

 DI-1 MMVARI FSKPort | DI-2 MMVARI FSKPort  
o Choose FSK8250 if you are using a true serial port or a device that can simulate a 

serial port and handle 5-bit codes at 45.45 baud (this does not include most USB-to-
serial adapters, but it does include some commercial interfaces designed to support 

FSK RTTY)  
 When MMVARI is opened for FSK RTTY, a small window labelled 

FSK8250/16550 1.03 will open, or appear on the Windows Task bar. In this 
window you select the COM port number and the signal line to be used for PTT 
(RTS or DTR). FSK keying will be done on the TxD line. If this is a USB device 

that simulates a serial port, check Limiting speed. You can use the _ box at 
the top right to minimize this window after completing the setup  

o Choose EXTFSK if you are using a regular USB-to-serial adapter  
 When MMVARI is opened for FSK RTTY, a small window labelled EXTFSK 1.05a 

will open, or appear on the Windows Task bar. In this window you select the 
COM port number and the signal lines to be used for FSK keying (normally 
TxD) and PTT (RTS or DTR). You can use the _ box at the top right to 
minimize this window after completing the setup  

6. Configurer >Other Tab 
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The Other tab is used to set up default values and select special modes and functions.  

6.1. Other Tab Field descriptions 

 

 Packet Spot Time (min) - Indicates how long (in minutes) spots are kept in the bandmaps. 

The default is 60 minutes, any integer may be specified  

 Repeat time in millisecs - Specify the repeat interval (CW or SoundBlaster) in the Entry 

window (Auto-CQ). The default value is 1.8 seconds. Enter a value in seconds or milliseconds. 
The maximum value is 32767. This is the same as Ctrl+R or 'Config | Set CQ repeat time' in 
the Entry Window  

 Default # Spots in SH/DX/# - The number of returned spots by the SH/DX command in the 

bandmap window. The default value is 30 spots. The number of returned spots for the SH/DX 
command in the Packet / Telnet window is not affected by this value and has to be changed in 
the Entry window under 'Config menu | Edit Packet/Telnet Buttons'  

 SSB Tuning Tolerance (Hz) - SSB mode: Clicking on or next to a station in the bandmap 

window will put the call on the callsign frame (if the callsign field is empty) of the Entry 
window. This value gives the maximum frequency distance to the call on the bandmap when it 
will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz). The 
default value is 300  

 CW Tuning Tolerance (Hz) - CW mode: Clicking on or next to a station in the bandmap 

window will put the call in the callsign frame (if the callsign field is empty) of the Entry 



window. This value gives the maximum frequency distance to the call on the bandmap when it 

will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz). The 
default value is 300  

 RTTY Tuning Tolerance (Hz) - RTTY mode: Clicking on or next to a station in the bandmap 

window will put the call on the callsign frame (if the callsign field is empty) of the Entry 
window. This value gives the maximum frequency distance to the call on the bandmap when it 
will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz). The 
default value is 300  

 CW Weight - Adjusts the CW weight (between 30-70% limits). The default value is 50. Thie 
weight command not only works for serial or lpt CW but also for Winkeyer  

 SSB Up/Down Arrow Incr (kHz) - This value gives the frequency jump amount in SSB by 

the up/down arrow keys. NB. Never make it smaller than the smallest step your radio can 
make in SSB. Older Icom rigs are known to have a smallest step of 100 Hz which is quite big. 
When the step is made smaller than the minimum step size the Up/Down Arrows don't seem 
to work. Also controls the amount of each frequency change when tuning the RIT on radios 
that support doing so from the computer.  

 CW Up/Down Arrow Incr (kHz) - This value gives the frequency jump amount in CW and 
digital modes by the up/down arrow keys. NB. Never make it smaller than the smallest step 
your radio can make in CW. Most rigs have a smallest step in the order of 10 Hz. When the 
step is made smaller than the minimum step size the Up/Down Arrows don't seem to work. 

Also controls the amount of each frequency change when tuning the RIT on radios that 
support doing so from the computer.  

 PgUp/PgDn Incr (kHz) - This value gives the frequency jump amount for the {PGUP} 
{PGDN} macros (Note: the PgUp and PgDn keys are not used for this; the {PGUP} and 
{PGDN} macros must be used in function key macros. These macro names are holdovers from 

early versions of the program)  

 Primary CW speed Step - The primary speed step is used with PgUp/PgDn button or the 
speed adjust in the Entry Window  

 Secondary CW speed Step -The secondary speed step is used when Shift+PgUp/PgDn is 

pressed. Alt+PgUp/PgDn adjusts the CW speed of the inactive radio/VFO in SO2R/SO2V 
mode  

 Clear automatically populated exchange on callsign change - When selected (default is 

Off), if the callsign in the Entry window is changed by the operator, this option clears the 
contents of exchange fields in the Entry window that were populated (filled in) from a 
CallHistory file, from previous QSOs in the contest, or from a Telnet spot. Does not affect 
exchange data that have been manually filled in.  

 Keep log of all QSOs to facilitate recovery of log - This is the transaction back-up log file. 

This journaling back-up text file has all QSOs from the contest in it. So if the database for 
some reason would become corrupt it is possible to import this file in a new database and go 
on with the contest  

o When this option is selected the transaction log is created for each contest you log to  

o The file is closed after each transaction and reopened to force the data to be written to 
disk  

o To keep things simple and foolproof, you are not allowed to change the name of the 
transaction log  

 The name is used to make sure you are loading it properly, and to prevent 
mixing logs of two contests  

 Example name: 'hamDB - CQWWCW - 2005-09-19.TRN' i.e.: Database name- 

contest name - date log created. The database name ends in "DB", rather than 
.mdb, to remind users that this is NOT the log file maintained in the ham.mdb 
database  

o To Recover your log, you MUST import the transaction log into a NEW (empty) 
database and a NEW contest log  

 >File >NewDatabase followed by >FIle >New Log in Database  
 The new contest log must be the same contest as the contest from the 

transaction file (Example: if restoring CQWPXCW, the new contest 
must also be CQWPSCW)  



 Why? To prevent a user recovering from a database problem making the 

problem worse. This will prevent any issues from duplicate contacts and a 
number of other problems  

 Use >File >Import >Recover QSOs from a Transaction Log - to import the 

transaction log file  
o As you load the transaction log, a new transaction log is automatically made with the 

transactions in the first log. Thus you should never have to merge logs. You always 
use the last one  

 Start Contest Reporting Application - Start the contest reporting application. With this 

application you can show your contest efforts in real time during a contest to the world. Next 
to this application a website is needed where everyone can see the score. This application 
does automatically upload scores from the current selected contest to the configured website  

 Mute mic on supported radios - Mute the microphone during transmit. Normally used to 

enter audio via an other radio input then the microphone. Default is to not mute  
o Tentec Orion: If "Mute" is checked, it causes the Orion's mic input to be muted and 

the Aux input to un-mute during voice keyer events  
o Supported radios are: Tentec Orion and Elecraft K3  

 Format for DXSpider Cluster - This will send the right SH/DX message for DXSpider clusters 

from the button in the top of the bandmaps (Example: SH/DX/30 on 20). Also SH/QRZ will be 
sent instead of SH/BUCK. Only select this when connecting a DXSpider cluster. Connect the 
cluster and send: SH/VER A DX-spider cluster will say something like: DX Spider Cluster. The 
'normal' setting is not selecting this option  

 Auto-Completion Mode - Auto-completion of callsigns. It works like Internet Explorer's 

address bar. If you type in a partial callsign, the program will attempt to match it with a call 
that you have already logged or is uniquely identified in the check window. If it matches, the 
rest of the call will be added to the callsign textbox and highlighted. You can then either 
accept the call as displayed, or keep typing. If you keep typing, the highlighted portion will be 

replaced by what you type  

 Use Reverse CW - When selecting CW send a command to the radio to use Reverse CW  

7. Configurer >Winkeyer Tab 



 

 

The Winkeyer tab is used to control functions of the K1EL Winkeyer keyer chip. Winkeyer is designed 
by K1EL and G3WGV. It is only active when the Winkeyer box has been checked on a serial 
port, and that port (whether real or virtual), has been connected either to a stand-alone 
keyer or to a device that embeds the Winkeyer chip, such as various MicroHAM products 
and RigExpert. Consult your unit's manual along with the Winkeyer chip manual for more 
information on these settings.  

Winkeyer is fed ASCII characters from N1MM Logger (via COM or USB Ports), and converts the ASCII 

to timed CW. The pot speed range is from a minimum of 10 wpm to a maximum of 55 wpm. Winkeyer 
can also be used to control PTT. Winkeyer PTT can be used on modes other than CW. Note: This only 
works for Winkeyer versions 10, and 21 and greater. 

7.1. Winkeyer Field Descriptions 

 Keying Mode - Select the keying mode. Choices are: Iambic A, Iambic B, Ultimatic and Semi-
Automatic. The default is Iambic-B  

 Autospace - Select when the autospace feature should be used. When using the paddles to 

send, if a pause of longer than one 'dit' time is detected, THREE dit times of pause will be 
inserted before the next character. See the manual for more information  

 Pot is wired with two leads - Select when the potentiometer on the board is wired only with 

two instead of three wires. Under normal operation, leave unchecked. Unless you've built the 
keyer yourself, or your keyer vendor recommends this, leave unchecked  

http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Hardware&structure=N1MM+Logger+Manual#K1EL_-_Winkeyer


 Pin 5 Function - Select the function of pin 5. Unless your keyer's manual tells you otherwise, 

the default of PTT is likely what you want here. The Winkeyer manual is also a good reference. 
The choices are:  

o PTT (default)  
o Sidetone  
o 2nd CW (second output, do not use for SO2R - see below))  
o None  

 Sidetone Frequency - Select the sidetone frequency. The default sidetone frequency is 469 

Hz  

 Reverse Paddles - Reverse the left and right paddle  

 Ignore Winkeyer Speed Pot - Ignore the setting of the Winkeyer potentiometer  

 Lead Time - Set the lead time value in 10ms Increments (up to 2.55 seconds). This value 

reflects the amount of time that the Winkeyer PTT will be asserted BEFORE keying commences  
o If when sending CW you are missing the first dot or dash, or if paddle-sent CW doesn't 

seem responsive (again, missing the first character) set this to at least 10 mSec  
o NOTE that this field denotes 10 mSec intervals — '1' in this box means 10 mSec  

o IF Pin 5 function is set to PTT, set this value to at least 1 (10 mSec)  

 Tail Time - Sets the tail time in 10 mSec Increments (up to 2.55 SECONDS). This value 

reflects the amount of time that the Winkeyer PTT line will be held after keying stops. Tail 
Time = 1 results in a tail time of one dit time (v2.2; 10 msec in earlier versions of Winkeyer), 
Tail Time = 2 adds 10 msec to that, Tail Time = 3 adds another 10 msec, and so on. If Tail 
Time is set to zero, then Hang Time is used instead  

 First Character Extension - Sets the extension time in 10 mSec steps (up to 2.55 seconds). 
Normally ONLY used with older, slower-keying rigs at speeds above 25 wpm, this setting will 
add time to the first element sent to help with the lack of T/R speed of those rigs. This value is 
usually set by experimentation. See the Winkeyer manual for more information on setting this 

value  

 Keying Compensation - Normally only used with high speed (>30 wpm) QSK operation. 
Adds time (in 1 mSec increments) to both dashes and dots to adjust for rig switching delays 
(however slight). See the Winkeyer manual for more information  

 Hang Time - Provides a CW-Speed dependent means of holding PTT after CW sending is 
finished. Hang Time can be used to set a CW-speed dependent delay of 1, 1.33, 1.67 or 2 

letterspaces (not dit spaces). Tail Time must be set to zero to use Hang Time  

 Winkeyer 2  

o Sidetone - Gives a sidetone when sending CW (when using paddle and computer 
input)  

o Paddle only sidetone - Gives a sidetone only when sending by paddle  
o Use 2nd output - If this option is checked, when the N1MM Transmit focus is in the 

second radio Entry window, CW and PTT will be switched to Winkeyer Output 2. This is 

convenient for minimal CW SO2R, because no additional hardware is needed to switch 
CW and PTT between radios. You'll still need to do something about the received audio 
switching, though. Select this option only for SO2R operation.  

Setting CW Speed and Weight in Winkeyer 

Speed setting is done just as with other keying methods. The PgUp and PgDn keys will increase or 
decrease the speed (default is 2 WPM steps). You can also overwrite the value in the speed window, or 
use its up/down arrows. Ctrl+PgUp/PgDn increases or decreases the speed by a larger amount 

(default is 4 WPM). Both values can be adjusted on the Other tab.  

Setting the speed using the speed control pot changes BOTH the paddle speed and the N1MM sending 
speed. Setting the speed using the entry window changes both the paddle sending speed and N1MM 

sending speed but ONLY UNTIL the next time the speed pot is adjusted, i.e. the absolute position of 
the speed pot then overrides any changes made in the entry window.  

CW weight for Winkeyer can be set on the Other tab, but is not usually changed from the 50% default. 



8. Configurer >Mode Control Tab 

 

 

The mode control tab determines how the mode will be controlled on the connected radio, 
whether the program sets the mode when changing frequency or not, and what mode it changes it 
to. This dialog also gives you control over how contacts will be logged.  

Mode logged vs. Radio mode 

In an ideal world, the mode in the log, the radio's mode and the mode in the software would all be the 
same. For traditional voice and keyed CW modes (CW, USB, LSB, AM, FM) this actually holds true. 
With the obvious exception of radios that do not support all of these modes, there is a one-to-one 
correspondence between the names of the modes on the radios, in the software and in the log. If 

these were the only modes that existed, it would always be possible to change modes on the radio and 
have the software follow (or vice versa) without risk of confusion or error, and there would be no need 
for mode control configuration settings.  

However, when digital modes are brought into the picture this one-to-one correspondence breaks 
down. Any SSB-capable radio can be used for digital modes using a sound card, even if the radio itself 
does not have any native digital modes. This results in a many-to-one relationship (many different 
modes in the log can map to a single mode on the radio). In the case of RTTY, some radios have a 
native RTTY mode using FSK keying, and when it exists, this mode is uniquely associated with RTTY 
and not with any other digital mode in the log. However, the reverse is not true; depending on the 



hardware configuration and the operator's choice, RTTY in the log may correspond with either RTTY or 

SSB on the radio. In the case of some radios, there may also be an additional mode or modes in the 
radio tailored either specifically for AFSK RTTY or for sound-card digital modes generally.  

Because of this breakdown in the one-to-one correspondence, a radio-first priority system cannot be 
imposed in all situations - once digital modes are involved, setting the mode on the radio does not 
always uniquely identify the mode that should be logged. Instead, the primary rule is "software first". 

Setting the mode in the software always controls what the radio does. You can select the mode in the 
software simply by typing the name of the mode (CW, SSB, USB, LSB, AM, FM, RTTY, PSK) into the 
entry window in the callsign box and pressing the Enter key. Provided the mode you have chosen is 
supported by the contest (this is determined by the Mode category in the contest setup window), the 
software and the radio will switch to the mode you have commanded, and that is the mode that will be 
logged, When the MMVARI or Fldigi digital engine is used, the specific digital mode logged will depend 
on what mode has been selected within the digital engine. Since not all radios use the same radio 

mode for digital modes, there are settings in the right side of the mode control configuration window 
that determine which radio mode is used for each of RTTY and PSK.  

Despite the lack of a complete one-to-one correspondence between the modes in the log and in the 
radio, there are many situations where some degree of automated mode switching is possible, based 
either on the radio's mode or on the frequency, and within the limits imposed by the current contest 
setup (i.e. what modes are supported within the current contest). The settings that control whether 
this kind of automation is used, and on what basis, are in the left side of the mode control window.  

One of these options is to use the band map. You may be able to use this within a single mixed-mode 
contest where the modes are kept well-separated in frequency. Unfortunately, this doesn't work in all 
situations. During major CW contests, for example, CW may be used pretty much throughout the 
normal digital sub-band. On the other hand, during a major RTTY contest you may find RTTY being 

used on frequencies that would normally be considered to be CW frequencies. For this reason, using 
the band map to determine the mode is not a foolproof set-and-forget option. Depending on the 
modes supported by your radio and the nature of the particular contest(s) you are operating in, you 
may need to choose one of the other options.  

Digital Interface Window - Open or Closed? 

There is a difference in mode control behavior between the situation where the DI window and digital 
engine window are open and the situation where they are closed. This is due to the way serial ports 
are used by the digital engines and by the Logger. The digital engines are separate processes from the 
rest of the Logger, and a single serial port cannot be shared between two processes. Since serial ports 

can be a scarce resource in a complex contest station, the Logger allows time-sharing of serial ports 
between digital (FSK & PTT) and non-digital (CW & PTT) uses. It does this by switching the ports 
between the processes depending on whether the DI window is open or not. When the DI window is 
opened, serial ports that have the Digital box checked in the Configurer are closed by the Logger so 
that they can be opened by the digital engine. When the DI window is closed, these ports are released 
so that the Logger can open them for use in other modes.  

Thus, whether the DI window is open or closed can make a significant difference to the hardware 

configuration. Whenever a serial port is time-shared between the Logger and a digital engine, that 
port cannot be used for PTT or CW keying in non-digital modes while the DI window is open.  

In order to support the wide range of possible hardware configurations in a hardware-independent 
fashion, mode control in the Logger depends on whether the DI window is open or not. When the DI 

window is closed, radio-first mode control works between non-digital modes, but switching the radio 
mode to (or through) a digital mode or tuning the radio's frequency into (or through) a digital band 
segment does not open the DI window and switch the software to digital mode. To switch into a digital 
mode, the DI window must be opened from the software. This can be done by using the Entry window 



to select RTTY or PSK mode in a contest that supports digital modes, or by using the Window > Digital 
Interface menu item.  

Once the DI window is open, changing modes on the radio does not close the DI window and the 
software does not switch out of digital mode, which means that radio mode-driven mode control does 
not work when the DI window is open. Mode changes in this state must be performed from the 
software. If the software is commanded from the Entry window to use a non-digital mode, the DI 

engine is closed by the software in order to free up any time-shared ports for the Logger to use. 

8.1. Mode Control Field Descriptions 

 Mode recorded in log - Set how to determine the mode that will be entered in the log  
o Use radio mode (default) - if the DI Window is not open, use the mode received 

from the radio. If the DI Window is open, the mode used depends only on the digital 
engine and not on the mode received from the radio, as follows:  

 In digital modes, the mode in the log will be RTTY if using the MMTTY engine 

or a TNC  
 When using the MMVARI or Fldigi engine, the mode will be as selected in the 

MMVARI or Fldigi window (digital modes only for Fldigi)  
o Follow band plan - use the mode the internal bandplan gives for this frequency  
o Use contest mode or bandplan - if the contest is a single mode, use that mode. If 

mixed, use the bandplan (as above)  

o Use contest or radio mode - if the contest is a single mode, use that mode. If 
mixed, use the mode from the radio (as above)  

o Always: - always log the mode selected here (CW, SSB, RTTY, PSK31, PSK63, 
PSK125) regardless of the mode from the radio  

 Mode sent to radio - Select how to determine the mode sent to the radio  
o This applies only for digital modes. See the note below for details  

Digital Mode Selection 

Every radio seems to have a different range of choices and names for digital modes. Some radios have 

no modes specialized for digital modes, some have only one digital mode for FSK RTTY (for sound-
card digital modes, you use USB or LSB), some add to this a separate mode intended for sound-card 
digital modes like AFSK RTTY and PSK31, and some radios have three separate digital modes for FSK 
RTTY, AFSK RTTY, and other sound-card digital modes like PSK31. There may also be two versions of 

each of these, one "normal" and one "reverse" (opposite sideband). Every manufacturer uses different 
names for these specialized modes.  

 

For simplicity, N1MM Logger has its own radio-independent terminology. The Logger uses RTTY for the 
radio mode normally used for FSK RTTY (which is usually but not always called FSK or RTTY on the 
radio). If the radio has a mode that is designated for AFSK RTTY, the Logger calls it AFSK. AFSK-R is 
the "reverse" of this AFSK mode, i.e. on the upper sideband instead of LSB. If there is a mode 
intended for sound card data modes that is different from the AFSK-R mode, it will be called PSK in 
the Logger. Not all radios have all of these modes, so not all choices will necessarily be available, 
depending on what radio(s) is/are configured.  

The translation between the mode name used on the radio and the mode name used in N1MM Logger 
is described at Click here to see the table  

For RTTY, if you are using FSK, you should normally select RTTY. If you are using AFSK, you should 
normally select AFSK or LSB/USB, depending on whether your radio offers a specialized AFSK mode or 
not.  

For PSK, the choice would normally be one of: PSK (if available), AFSK-R (on some radios), or USB. 

http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Radios#Digital_Mode_Mapping


9. Configurer >Antennas Tab 

 

The Antennas Tab defines how antennas will be selected by the program, if you have appropriate 
hardware, and also controls the rotor program. The example above illustrates the features of this tab.  

 

Tip 

Unlike most software you don't map bands to bcd outputs 0-15 with N1MM Logger. You map 

antennas to bcd outputs 0-15. You can still map bands, but the antenna approach is much more 
powerful. It supports multiple antennas per band, stacks, and multiple bands per antenna. See the 
screen shot above.  

9.1. Field Descriptions 

 Code - The code which will be presented on the LPT port as binary coded decimal output, 
using pins 9, 8, 7 and 2  

o The codes themselves are pre-determined. Sixteen different codes are the most that 
can be represended by the state of 4 pins.  



o Each code represents ONE ANTENNA,, and you can have many different combinations. 

In the example above, there is no antenna corresponding to the code of 0.The other 6 
are each defined separately.  

 Antenna -Text to describe the antenna. This text will appear on the status bar of the Entry 

window when you change bands or switch antennas for a given band.  

 Bands - The bands on which this antenna will be selected  

o List bands in MHz e.g. 1.8, 3.5, 7, separated by commas if more than one is covered 
by the antenna, as in the illustration.  

o The first antenna in the table will be selected when changing to a band. Press Alt+F9 
to toggle through all the antennas for the current band .  

o An antenna may be used on any number of bands  

 Rotor Description - enter the description as defined in setting up the rotor program. It must 

be exactly the same in each, because these names make the connection between the two 
programs.** More than one rotor can be selected (separate using commas), for example to 
turn a stack where more than onbe rotor is involved.  

 Offset - This offset is added to the rotor position to determine the antenna position. This is 

useful for antennas that are mounted at 90 degrees for pattern interference reasons, or for 
antennas that have simply turned some in the wind over the winter. The offset can also be 
entered for the selected rotor in the rotor program  

 Bidirect - Set to 1 if the antenna can be set bidirectional (0 = not bidirectional, 1 = 

bidirectional) (e.g. Steppir)  

 Start UDP port for Rotor Program - Set the UDP which is used in communication between 

the Rotor program and N1MM logger. Defaults to UDP port 12040 and has to be set up the 
same in both programs to work  

 Start Rotor Program - Start rotor program automatically by N1MM Logger main program. 
You will need to stop it manually  

LPT Port Conflict 

When DVK is selected on the same LPT port, antenna selection on the pins will not work because the 

DVK pins and the antenna pins overlap. 

10. Configurer >Audio Tab 

http://n1mm.hamdocs.com/tiki-index.php?page=Rotator+Control


 

 

Before We Start 

Any time you change the Default sound card in your Windows Control Panel while N1MM Logger is 

running, you must shut N1MM Logger down and re-start it. Otherwise, the program and the operating 
system may be on "different pages", and it can cause audio functions not to work or to work 
strangely. Moreover, any time that you change the Windows Default sound card, you will have to 
come back to this tab and reset your audio options. You can imagine how we found this out!  

For the Two Sound Card SO2R ($5 SO2R) check the SO2R chapter.  

Select at the top of the page the configuration to use. (example picture how to connect can be found 
in the SO2R chapter.)  

1 - Only use Radio 1 Output Device, Output on both channels  

 One radio and one sound card to play wav files and record new messages and mute the 
microphone when playing wav files  

http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29#N1MM_Logger_Manual


 Only the top part of the dialog above (Tx Sound Card Setup) has to be set up. Bottom part is 

deselected (greyed out)  

 
2 - Two Radio, Output left channel on left radio, right channel on right radio  

 One sound card to play wav files to each radio  

 Only the top part of the dialog (Tx Sound Card Setup) has to be set up. Bottom part is 
deselected  

 
3 - Two radio, Sound Card $5SO2R, CW Only  

 $5 SO2R with one sound card for CW only  

 The drawback here is that no switching of the headphones is done  

 You will have to wire a cable to the CD or aux input of a sound card in order to make use of 

this feature  

 You'll need to define your mode as SO2R in the Hardware tab  

 Both Tx Sound Card Setup and Rx Sound CardSetup must be filled in  

 
4 - Dual Cards - Two radio, $5 Sound Card SO2R  

 Full $5 SO2R with audio switching - two soundcards are needed  

 Switching of the headphones is done  

 You will have to wire a cable to the CD or aux input of a sound card in order to make use of 
this feature  

 You'll need to define your radios as SO2R in the Hardware tab  

 Both the Tx and RX Sound Card setups must be completed.  

 Tx Sound Card Setup - It is best to choose the default sound card (the one named in your 

operating system's Sound section in the Control Panel) for the Tx sound card. This is because 
the CD input is not used for Tx and can be used normally.  

o Select Radio 1 Output Device - Select the sound card to use for sending WAV files 
(DVK) on Radio 1  

o Select Radio 2 Output Device - Select the sound card to use for sending WAV files 
(DVK) on Radio 2  

o Radio 1 Output Device is an Internal Radio Codec - Check if you are using a 

CODEC built into Radio 1 instead of a separate sound card (CODEC is used here and 
elsewhere in this manual as a synonym for sound card)  

o Radio 2 Output Device is an Internal Radio Codec - Check if you are using a 
CODEC built into Radio 2 instead of a separate sound card  

o Select Port to Mute - Typically, this is used to mute the microphone during stored 
message playback, so you would select Microphone from the drop-down list. The two 

options are for Radio 1 and 2, left to right.  

o Select Message Recording Device - Select the sound card to use for recording 
stored messages for later playback on either radio  

o Select Message Recording Port - This is used for recording messages on the fly, 
and will almost always be the Microphone.  

o Recording Channels - Select 1 or 2, depending on your transceiver's line output 
capabilities and whether you want a one or two-channel recording - for example in 

SO2R mode.  
o Recording Bits - 8 bits gives the most compact recordings, at the price of audio 

fidelity.  



o Recording Sample Rate - Select the sample rate to record. The lower the rate the 
smaller the files but, audio quality will be less  

Not All Sound Cards are Created Equal 

The Configurer lets you pick parameters that your sound card may not support... usually 16 bit, 11025 
Hz/sec is safe for all cards. If you choose a parameter that is not supported by your card, you will see 

Error 4 in the status line of your Entry Window when you try to play back a message. 

The output port for recorded messages going to the radio is always the sound card's Line Out or 
Speaker Out port  

 Rx Sound Card Setup (used for SO2R Headphone Switching) - Two line-level inputs are 
required for SO2R switching by sound card.  

o Device - Select the (second) sound card to use  
o Left Radio Input Port - Select the Left Radio Input Port which receives the audio 

from the radio.  
 Must be different from Right Radio Input Port  

o Right Radio Input Port - Select the Right Radio Input Port which receives the audio 
from the radio.  

 Must be different from Left Radio Input Port  

 

2.1.2 The Contest Setup Dialog - Basics 

 2.1.2 The Contest Setup Dialog - Basics  

 1. Databases versus Logs  
 2. What Else is In a Database?  

o 1. Start a new contest log  
 1.1. Start Date  

o 2. Open an Existing Contest Log  
o 3. Contest-Specific Information  

 3.1. Contest Tab  

 3.1.1. Operator Category  
 3.1.2. Band Category  
 3.1.3. Power Category  
 3.1.4. Mode Category  
 3.1.5. Overlay Category  
 3.1.6. Station Category  
 3.1.7. Assisted Category  

 3.1.8. Xmitter Category  
 3.1.9. Time Category  
 3.1.10. Assisted Category  
 3.1.11. Sent Exchange  

 3.1.11.1. If the Exchange is a serial number  
 3.1.11.2. Starting with a Serial Number other than Zero  

 3.1.11.3. Using a Serial Number Server  
 3.1.12. Operators  
 3.1.13. Soapbox comments  
 3.1.14. Section Lists  

 3.2. Tab: Associated Files  

This dialog is reached from the File menu in the Entry Window, by clicking on either New Log in 
Database or Open Log in Database. It is used either to set up a new contest or to modify something 
about a contest that you have already created.  



 

There Are Contests, and Then There Are Contests 

As it is generally used in ham radio, the word "contest" refers to a competitive operating event of 
some kind. As the term is used in N1MM Logger, it can refer either to such an event or to a specific 

occurrence of a particular event, for which you have set up a log. You can have an unlimited number 
of CQWWCW "contests" (distinct contest logs) in a single database - it might be better to call them 
"contest instances", but it is probably too late to find and correct every use of the term according to 
its meaning in context. In virtually all cases, what is meant will be obvious from context.  

1. Databases versus Logs 

 
Before starting your first contest, you should understand how N1MM Logger stores contests and 
contacts. The two keys terms are Databases and Logs. As an analogy, think of your PC's hard disk as 
a large room containing computer stuff. Into this room, N1MM Logger places File Cabinets (Databases) 

and within those File cabinets, N1MM Logger adds individual Folders (Logs). For each contest that you 

operate, you will add a new Log to hold the contacts for that contest. Your large room with computer 
stuff can hold as many File Cabinets (Databases) and as many Folders (Logs) as you want - until, of 
course, your hard drive is full.  

Continuing our File Cabinet and Folder analogy, there are many methods by which you can arrange 
your file cabinets (Databases). Here are three examples:  

1. DATABASE PER CONTEST TYPE - Some hams prefer to create a Database for each major contest 
type. Your \N1MM Logger directory would contain databases (>File >New Database) named CQ WW. 
MDB, ARRL DX.MDB, ARRL 160.MDB and CQ WPX.MDB. When setting up each contest, you >File 
>Open the Database corresponding to the contest to be operated, then >File >New Log (folder) for 
that particular contest. So, one of these databases would contain CW, Phone, and RTTY logs from 

2007, 2008, and 2009... for that particular contest. You might want to add a database like 
MISCELLANEOUS.MDB for the smaller contests or contests that you only plan to operate a couple of 
times.  

2. DATABASE PER CALENDAR YEAR - Some hams create a new Database each year. At the beginning 
of each year, you would >File >New Database a database named K8UT 2008.MDB, K8UT 2009.MDB or 
K8UT 2010.MDB. In each database would be the Logs (folders) for every contest you operate during 
that year. When setting up each contest, you would >File >Open Database for the correct year, then 
>File >New Log (folder) for that particular contest. So, this database would contain all contests (CQ 
WW, ARRL DX, CQ WPX...) worked during that year.  

3. DATABASE PER EACH CONTEST - Some hams create a new Database each time they operate a 
contest. Your \N1MM Logger directory would contain lots of databases - one for each contest that you 

operate. When setting up each contest, you would >File >New Database, and then within that 
database you would >File >New Log. Although some hams may find this the easiest method to 
understand, managing all of those files after many years may become a problem.  

These aren't your only Database/Log options, but perhaps one of them matches the way your brain 

works. How about organizing your logs by mode: CW.MDB, PHONE.MDB, DIGITAL.MDB? N1MM Logger 
can do any of these - choose the method that provides the easiest way for you to create new logs 
before the contest and find your old logs after the contest.  

2. What Else is In a Database? 

In addition to your QSOs, there are a number of tables in the database that contain data that may, 
and probably will vary from one contest to the next. These include such things as multiplier lists for 



particular contests, function key definitions for CW, SSB and digital modes, the contents of the last 
wl_cty.dat file that you loaded, and a Call History table (if one has been loaded).  

Why should you care? For several reasons:  

If you modify the function key definitions while operating, that modification applies only to the current 
database. Each database only has space for one set of function keys for each mode, one Call history 
file, one set of Telnet buttons, and a pointer to one master.dta file in the program directory.  
When you switch to another database, those definitions (and in particular, any changes you made) are 
left behind. That's why the program provides for exporting function key definitions (among other 

things) to text files, which can then be loaded into the database as needed. You can label these text 
files in a contest-specific way so that it will be easy to find when you set up for the next time.  
Master.dta files may change from contest to contest, too. You don't have to load them into the 
database, but you do have to make sure that you have pointed to the appropriate file for each 
contest. For example, the master file MASUSVE.DTA, which contains only US and VE callsigns, would 
be useless to a US station in the ARRL DX Contest or CQWW. That is one reason for the Associated 

Files tab in the Contest Setup dialog - so that when you switch contests within the same database, the 

files you need (or pointers to them) are automatically loaded.  
The same thing applies to Call History files. One common error that Call History users often make is to 
forget to load the appropriate file into the database (you can only have one at a time loaded). They 
set up a contest and find they are getting the wrong information about stations they work.  

The takeaway is this - when you change contests within a database, or change databases, your 
function keys, master.dta file, Call History file, and Telnet buttons will still be those from the last 
contest you worked using that database, UNLESS you have identified the appropriate files on the 
Associated Files tab while setting up the new contest.  

1. Start a new contest log 

To start a new contest select >File >New Log in Database. This is called the Contest Setup dialog.  

Initially, you'll see the name of the contest last used by the program.  

 

Click the downward-pointing arrow to the right of the current contest name (called the "handle") to 
drop down the list of all supported contests.  



 

 You can search alphabetically by pressing the first letter of a contest's short name, and then 
scrolling to find the right one.  

 

A list of supported contests can be found in the Supported Contests chapter. Check the contest 
website for the latest rules and check the contest setup information in the Contest Setup 
Instructions chapter.  

1.1. Start Date 

 
When you set up a new contest, the Start Date defaults to the current date. This can be useful if you 

have several versions of a given contest in your database. If you prefer, you can overwrite the default 
and enter the actual start date. Once you have selected a contest, it gets a little more interesting. 
Year to year, dates of contests change, but the day of the week usually remains the same. For this 
reason, the program assumes that the contest will actually start on the correct day of the week (and 
time of day) following the Start Date entered in the Contest Setup Dialog. For example, if you set up a 
new contest on Wednesday, to start at 0000Z on Saturday, the program assumes that will be the 
actual start time, for purposes of computing time on or off the air, and for displaying any goals you 

have set in the Info window.  

To avoid confusion, it is best to set up the log you will actually use within a week before the start of 

the contest, or else to change the Start Date to the correct date for the contest. If you want to 
practice ahead of time, you can set up a practice version of the contest with an earlier date. So long 
as it is in the same database, you'll be able to set goals, set up your function keys and other 
associated files, and all of this will be available for use when you set up the "real" log. Just delete the 
practice log and you're ready to go.  

2. Open an Existing Contest Log 

To open an existing contest log in the currently selected database. Select >File >Open Log in 
Database  

 In the top part of the dialog the currently available (already created) contest logs can be 

selected by clicking on the down arrow to the right of the textbox. Note that the textbox is 
captioned "Select Existing Log"  

 Contest-specific changes can be made in the Contest and Associated Files tabs. More 
information in the paragraph below  
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To delete a contest, click on the contest in the contest pane, as shown above, so it is selected. Then 
press Delete.  
For example, the CQWWSSB in the picture above is selected and can be deleted by pressing the 

Delete key.  

3. Contest-Specific Information 

 
Below the contest selection area is a section where you define your entry in this particular running of 
the contest. This is further divisible into Categories, Sent Exchange, Operators and Soapbox 
Comments  

Of these, the first is Categories - are you single op or multi-op, high or low power, and so on. 
Depending on the contest you will see one of two lists of categories to be chosen. This is because 
some contest organizers (the ARRL and IARU in particular) have adopted the Cabrillo 3.0 format for 
contest entries, while the others continue to accept Cabrillo 2.0. The Cabrillo file headers are different, 
requiring different lists.  

These lists may seem a bit daunting at first, but remember a couple of things. You can always change 
your selections before the contest, if things don't come up as you expect them to, or after the contest, 
if you have trouble getting the contest organizer to accept your Cabrillo entry. As a last resort, you 
can use a text editor on the header of the Cabrillo file.  



 



 

 
 
Initially, the entry information displayed on the tab will be that which was entered for the last 
previously opened contest. This may not be appropriate to the new contest you are setting up.  

3.1. Contest Tab 

3.1.1. Operator Category 

Make a choice for your situation. Choices in Cabrillo 2.0 contests are:  

o SINGLE-OP  
o SINGLE-OP-ASSISTED  
o MULTI-ONE  

 In CQWW contests, you will be asked whether this station is a Run or a Mult 
station  

o MULTI-TWO  
 An identifier is needed for Station 1 and Station 2 that must be specified when 

setting up initially in this category. Each time the program is loaded or the 
contest changed, the program will ask you to specify Station 1 or 2  

o MULTI-MULTI  



o SCHOOL-CLUB  

o CHECKLOG  
o SINGLE-OP-PORTABLE  
o ROVER  

 If your entry is in this class, selecting Rover will enable some useful additional 
functions.  

o MULTI-UNLIMITED  
o MULTI-LIMITED  

 Choices in Cabrillo 3.0 contests are:  

o SINGLE-OP  
o MULTI-OP  
o CHECKLOG  

3.1.2. Band Category 

Make a choice for your situation. Choices are:  

o ALL  
o 160M  

o 80M  
o 40M  
o 20M  
o 15M  
o 10M  
o LIMITED  
o CHECKLOG  

 Choices in Cabrillo 3.0 range from ALL to LIGHT  

3.1.3. Power Category 

Make a choice for your situation. Choices are:  

o HIGH  
o LOW  

o QRP  
o MEDIUM  

3.1.4. Mode Category 

Make a choice for your situation. Choices are:  

o CW  
o SSB  
o RTTY  
o PSK  

o MIXED - the Available Mults and Qs window will show one column each for CW and 

SSB. The number of band/mode buttons may be limited by the contest rules. For 
instance, in a mixed mode contest that has mults once per band and a dupe type of 
Each Band (mode independent), there is no need to display more than one column of 
mode buttons.  

o DIGITAL = no CW & SSB, just RTTY & PSK, or RTTY (defined by the contest)  
o MIXED+DIG = CW & SSB & Digital (defined by the contest) Could be RTTY & PSK or 

RTTY  

3.1.5. Overlay Category 

http://n1mm.hamdocs.com/tiki-index.php?page=Available+Mults+and+Qs+Window


Used in relatively few contests. In Cabrillo 3.0 contests, only N/A, TB-WIRES, NOVICE-TECH, OVER-50 
and ROOKIE are valid. Choices are:  

o N/A (default)  
o ROOKIE  
o BAND-LIMITED  
o TB-WIRES (tri-bander and wires)  

o OVER-50  
o HQ  
o NOVICE-TECH  
o EXPERT - The EXPERT overlay category in contests where it exists must be selected for 

the 5 minute band change counter to be inactive for SINGLE-OP stations.  

 
 
In CQ WPX CW and CQ WPX SSB, category overlay may be any combination of ROOKIE, BAND-

LIMITED, or TB-WIRES. In STEW PERRY, the category overlay may be OVER-50. In IARU-HF, the 
category overlay may be HQ. In PACC the category overlay may be NOVICE-TECH.  

The following items are required by Cabrillo 3.0  

3.1.6. Station Category 

Choices are:  

o FIXED  
o MOBILE  
o PORTABLE  
o ROVER  
o EXPEDITION  
o HQ  

o SCHOOL  

3.1.7. Assisted Category 

o ASSISTED  
o NON-ASSISTED  

3.1.8. Xmitter Category 

o ONE  
o TWO  
o LIMITED  
o UNLIMITED  
o SWL  

3.1.9. Time Category 

o N/A  
o 6-HOURS  
o 12-HOURS  
o 24-HOURS  

3.1.10. Assisted Category 

o Xmitter Category  



o Time Category  

3.1.11. Sent Exchange 

o Sent exchanges are defined for each contest. Look in >Digging Deeper >Supported 

Contest Setup instructions for guidance. Usually a serial number, zone, state etc  
o Do not put 59, 599, or RS(T) information in the Exchange field  

 

No RST in the Exchange 

Do not put a signal report in the sent exchange. It will cause incorrect Cabrillo output. Typically, the 
program will warn you if you make this mistake. 

3.1.11.1. If the Exchange is a serial number  

o Enter the expression 001 in the Exchange field  

3.1.11.2. Starting with a Serial Number other than Zero  

o Some contests which have more parts/sessions there is the need to start a next 

session with the next number given in the previous part. So how not to start with 001?  
o There are two workarounds:  

 Start second part as a separate contest and make the first QSO with number 
001 and log it, then correct (Ctrl+Y) to proper sent number  

 Start second part as a separate contest, enter fake QSO, open QSO in EDIT 
window, change SENT number from 001 to last number you sent in the 
previous part of the contest, save changes, et voila, it's done. When a couple 
of real contacts have been entered, delete the fake QSO  

3.1.11.3. Using a Serial Number Server  

N1MM logger supports a single sequence of serial numbers for SO2R, MS, M2 and MM.  

The serial number is reserved in S&P mode when the cursor leaves the callsign field or the Exchange 
key (F2 default) is sent  

o Either through spacing, tabbing, or hitting Enter in ESM or pressing the Exchange key. 

This is needed so you can enter calls to check for dupes while not reserving a serial 
number  

o RUN mode as soon as you enter a letter in the call-sign field. This is because on SSB 
people frequently talk before they type, and they need to see the serial number 
displayed earlier. A serial number is not assigned in S&P mode until the space bar is 
pressed, so you can do dupe and check multipliers without committing a serial number 
to it, by entering it in the callsign field without pressing Enter or Space  

 

In SO2R and SO2V, typing Alt+W (wipe) after a serial number has been reserved or wipe through QSY 
will "un-reserve" that number.  

Because of the way the serial number server works, there are a few cautions:  

o Serial numbers issued by the second radio may be out of time sequence with those 
issued by the main one. This occurs because certain program actions cause a serial 

number to be reserved for the use of a station, and if that station does not use that 
number until after the other station has made several QSOs, when the log is viewed in 



chronological order the serial number will appear to be out of order. I don't think there 

is anything to be done about this  
o For similar reasons, depending on operator actions at one or the other station, such as 

shutting down the program while a number is reserved, there may be some gaps 

(numbers not issued) when reviewing the final log  
o The most important aspects of serial numbering are that the serial sent to a station be 

correctly logged, and that there be no duplicate serial numbers sent; N1MM logger 
seems to meet both these criteria  

o Sometimes it's possible a number will be skipped when given out but not used 
(example: QSO not made after all or deleted). Contest committees do accept this 
behavior!  

o The maximum sent number to give is 32767. The maximum receive number is 99999  

 

What Do Sponsors Look For? 

Most sponsors are more interested in serial number accuracy than in serial number time order. If you 

think about it, it is impossible to guarantee the order of serial numbers in a two radio situation. This 
assumes that you always log the time when the QSO is added to the log, which is the right time from 
a rules point of view. i.e. end of contact.  

 
 

Addendum by Steve, N2IC 
 
Let me say a few words about the way serial numbers are "reserved" in N1MM Logger. For the sake of 
this discussion, I'll assume that ESM is being used.  

When you enter a callsign in the Entry Window, and hit the Enter or Space key, a serial number is 
reserved and locked-in to that QSO. If it turns out that the QSO is not completed and logged, that 
serial number is "lost", and will be not used for a subsequent QSO.  

This gets to be especially interesting with SO2R and SO2V. Let's say you are running on Radio 1, and 
search-and-pouncing on Radio 2. You enter a call on Radio 2, and hit the Enter key, reserving a serial 
number on Radio 2. You get beaten out on Radio 2, and go back to running stations on Radio 1, 
advancing the serial number beyond the number reserved on Radio 2. A few minutes pass, and you 

finally work the station on Radio 2. Your log now appears to have non-sequential serial numbers. If 
you never work that station on Radio 2, the reserved serial number on Radio 2 is lost, and will not be 
used for any subsequent QSO.  

I can't speak for all contest sponsors, but for Sweepstakes and CW/SSB WPX, this is not an issue. 
There is no problem for these log adjudicators if your serial numbers are out-of-sequence, or if there 
are missing serial numbers in your log. Your log will be correctly processed. In addition, the N1MM 
Logger Summary window reports the correct number of successfully completed QSO's.  

In summary, stop fretting about out-of-sequence or missing serial numbers. The software is working 

as designed  

3.1.12. Operators 

o Enter here all the operators' callsigns. Clicking the button 'Update Ops from Log' will 
do this for you (most useful after the contest, if your operator list changed).  

o Update Ops from Log"" - Clicking this button will transfer all operators from the 
contest log to the Operators field.  

3.1.13. Soapbox comments 



o Your comments on the contest, results, propagation etc., for inclusion in your Cabrillo 
submission. This text is cleared when selecting a new contest.  

3.1.14. Section Lists 

o When operating a state QSO Party, select the State from the drop-down list. If in 
doubt, click on the Import Section List button to make sure you have the most current 
list of county abbreviations  

 
 
** These selection buttons are only shown when the contest has a section list (like QSO parties).  

o In the example above the QSO party for the state CA (California) has been selected 

which has 2 QSO's in it.  
o There may be two section lists, for in-state or in-country and other entrants. You will 

be prompted to import both section lists if more than one exists  
o The appropriate section list is used to determine multipliers (States, Provinces etc.) for 

the contest which will be shown in the Multiplier window  

o The name of the list is hardcoded and will be shown while importing the file. Example 
name: IOTA.SEC  

Click the Edit Section List button to edit the contest section table for the selected contest.  

o This function edits the section table in the current database. It does NOT edit the 

section text file. If you want to export your section file after editing, use the File 
export menu link in the upper left corner of the Edit Section List dialog.  

 Button: Show Rules (Internet access required): Goes to the contest sponsor's website 
where the rules can be found. QSO parties, new contests, and minor contests tend to change 
their website addresses and/or rules frequently. Please contact us so we can update the 
program when this happens.  

3.2. Tab: Associated Files 



 

 Master.DTA Filename: Shows the selected master.dta file for this specific contest-specific 

(not contest instance-specific)  
o For example, all QSO Parties will use the same master.dta filename  
o Defaults to master.dta  

 Use the Change button if you wish to select a file other than the basic 
master.dta for use in this contest.  

 

Update Your CTY.DAT File Before Each Contest 

In addition to these files, be sure always to load the most recent CTY.DAT file before entering a 

contest. This is a 2-step process. Download the most recent country file from the Internet using 
>Tools >Download latest country file (wl_cty.dat) (Internet). Then import it into the current database 
using >Tools >Import country list from downloaded file. The program will warn you if you open a 
database whose CTY table is less recent than the wl_cty.dat file in your N1MM Logger program 
directory. 

 
For each of the following Associated Files, the Change and Clear buttons have the same function - the 
Change button allows you to select or change the file to be used, wherever you have stored it. The 
Clear button lets you clear the filename if you don't wish to load one.  



 SSB Function Key Filename - Select the SSB function keys to use with this contest.  

 CW Function Key Filename - Select the CW function keys to use with this contest.  

 Digital Function Key Filename - Select the Digital Interface function keys to use with this 

contest from the Entry Window (not the extra keys that can be set up in the Digital Interface).  

 Call History Filename - Select a call history file to be loaded for use with this contest. This is 
entirely optional. See the manual section on Call history Lookup? for details. If you want to 
use a Call History file, don't forget to turn on Call History Lookup on the Config menu.  

 Sample Function Keys - This button opens the Sample Function Keys page on the N1MM 

Logger website, from which you can download customized function key message files for many 
contests.  

 

2.1.3 Supported Contests 

 1 General Contest Logging - All Modes 

 2 Supported HF Contests - CW and SSB 

 3 Supported QSO Parties - CW and SSB 

 4 Supported VHF Contests - CW and SSB 

 5 Supported RTTY and PSK Contests 

 6 Supported User Defined Contests 

o 6.1 The User Defined Contest Editor 

 7 My Contest Isn't Here 

 

 

2.1.3.1 General Contest Logging (all modes) 

Contest  
Log Type 
and 
Setup Link  

Remarks 

DX (General 
log)  

DX  Sent RST, Received RST fields, Name and Comment field 

DXPEDITION  DXPEDITION  Only has Sent and Received RST fields 

DXSERIAL  DXSERIAL  
Sent and received RST, Nr fields and a Comment field for Generic Serial 
number contests. Default multipliers and points. 

DXSATELLIT  DXSATELLIT  Only three fields: Call, Grid and Satellite 

VHFDX  VHFDX  Sent RST, Received RST fields, Grid and Comment field 

VHFSERIAL  VHFSERIAL  
Sent and received RST, Nr fields and Grid fields. For generic VHF serial 
number contests. Comments possible. 

 
 

 

 

2.1.3.2 Supported HF Contests - CW and SSB 
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All contests are supported 'both' sides unless specifically mentioned.  

 

Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

9A CW Contest   9ACW  CW only; 3rd full weekend in December 

AGCW Happy New Year  

AGCW Happy New Year 

All Asian DX contest CW / SSB

  

ALLASIASSB 
ALLASIACW  

CW - Third Saturday of June (48 hours) 
SSB - First Saturday of September (48 hours) 

Asiatic Russia Championship  

ASRUCHAMP January, 6 hours, 160-40 meters, SSB/CW 

ARCI QRP Contests   ARCI  
This contest supports 7 ARCI QRP contests plus 
several other QRP contests with similar exchanges 

ARI International DX Contest   ARIDX  Per version 4.0.63 

ARRL 10 Meter contest   ARRL10M  
 

ARRL 160-meter contest  

ARRL160  
 

ARRL Field Day contest   FD  See ARRL Field Day Setup instructions. 

ARRL International DX contest 

CW /Phone   

ARRLDXCW 
ARRLDXSSB   

ARRL November Sweepstakes 

CW / SSB   

SSCW 
SSSSB   

ARRL Rookie Roundup   
RRSSB 
RRCW  

SSB in April, RTTY in August, CW in December 

Asia-Pacific Sprint Contest CW / 

SSB   

 
APSCW 
APSSSB  

In Spring, Summer, Fall (2 hours) 
 

Baltic contest   BALTIC  
Every year the next to last weekend in May - one 

week before WPX CW Contest  

BFRR CW/SSB Championship  

BFRRCW 

BFRRSSB 

For Belarus stations only 
 

Black Sea Cup International  

BSCI  First full weekend in February 
 

CNCW Spanish contest   CNCW  Local Spanish CW contest 
 

CQ-M International DX contest

  
CQM Second weekend of May 

 

CQ World-Wide 160 Meter DX 

Contest - CW / Phone   

CQ160CW 

CQ160SSB    

CQ World Wide DX contest - CW 

/ SSB   

CQWWCW 
CQWWSSB  

CW - Last full weekend of November (48 hours) 
SSB - Last full weekend of October (48 hours)  

CQ World Wide WPX contest - 

CW / Phone   

CQWPXCW 
CQWPXSSB    

CQSA SSB Contest   CQSASSB  South America. Second full weekend in October 
 

Cup of the Russian Federation - 

SSB   

RFCCW 
RFCSSB  

Internal Russian contest in January 
 

Cup of the Russian Federation - 

CW   

RFCCW 
RFCSSB  

Internal Russian contest in January - see also RTTY 
version below  

CWops Mini-CWT Test  

CWOPS  Several 1-hour contests each month 
 

CWops CW Open  

CWOPSOPEN  TBD - August 20/21 in 2011, September 1/2 in 2012 
 

DARC 10 meter contest   DARC10M  2nd full weekend in January 
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Contest Name and Website 

Link  

Log Type & 

Setup Link  
Remarks 

DARC Weihnachtswettbewerb - 

XMAS contest   
XMAS  December 26 

 

European Sprint  

EUSCW 
EUSSSB  

In April and October, both modes, 4 hours 
 

DIG contest - CW / Phone   
DIGCW 
DIGSSB  

SSB: Second weekend in March 
CW: Second weekend in April 

Also for short contests in June and October 
 

Elecraft QSO Party   EQSO  Despite the name, handled as a separate contest 
 

EU HF Championship   EUHFC  First Saturday in August (12:00 - 23:59 UTC) 
 

FOC QSO Party   FOCBWQP  First Class Operators Club (FOC) QSO Party 
 

FOC Marathon   FOCCW  
First Class Operators Club (FOC) Marathon. First full 

weekend in February  

Gagarin Cup   GCUP  April; CW, HF plus satellites 
 

GACW WWSA CW DX contest   GACW  Second weekend in June. CW only 
 

HA DX contest   HADX  3rd full weekend in January 
 

Helvetia Contest   HELVETIA  
  

High Speed CW Contest -HSC 

CW   
HSCCW  

  

Holyland contest   HOLYLAND  
  

IARU HF Contest   IARU  
  

IARU Region 1 Field Day   FDREG1  

Varying rules for Belgium, Germany, United Kingdom 
(SSB and CW), Netherlands, Switzerland, Ireland 
(only CW), Italy, Slovenia (S5) and Russia (UA, UA2, 
UA9) 

 

RSGB Islands On The Air 

Contest   
IOTA  

  

International Naval Contest   NAVAL  
  

JA-domestic  JADOMESTIC  Generic support for Japanese domestic contests 
 

JIDX Contest   
JIDXCW 
JIDXSSB  

CW: 2nd full weekend of April 
PH: 2nd full weekend of November 
Sat. 0700 UTC - Sun. 1300 UTC 

 

JT DX Contest  

JTDX Third weekend in November, CW or SSB (pick one) 
 

King of Spain contest   
KINGEACW 
KINGEASSB    

LOTW   
LOTWCW 
LOTWSSB    

LZ DX contest   LZDX  
The weekend before the last full weekend of 
November (weekend before CQWW CW)  

LZ Open and LZ Sprint contests

  
LZOPEN  

For all three contests. LZ Open and both sprint 
contests (40/80 meter)  

Manchester Mineira DX Contest

  
CQMMDX  

International contest by CWJF - 3rd full weekend of 
April  

Michigan QRP Contest   ARCI  
This contest supports 4 Michigan QRP contests. 
Select ARCI contest (same rules)  

NA Sprint - CW / SSB   
SPRINTCW 
SPRINTSSB  

CW: First Sunday in February 
SSB: Sunday of first full weekend in February 
CW: Sunday following first Monday in September 
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Contest Name and Website 

Link  

Log Type & 

Setup Link  
Remarks 

SSB: Second Sunday following first Monday in 
September 

NS Sprint and Sprint Ladder  

SPRINTNS 
SPRINTLADD 

Both contests are weekly, CW only, identical except 
for dupe rules, which may change on short notice 
SPRINTLADD allows sasme-band dupes after one 
intervening QSO, while SPRINTNS does not allow 
same-band dupes. 

 

Minitest CW Test   MINITESTCW  CW:Almost every Wednesday 1800-1900Z 
 

North American QSO Parties - 

CW / SSB   

NAQPCW 
NAQPSSB  

CW: Second full weekend in January. First full 
weekend in August 
SSB: Third full weekend in January. Third full 
weekend in August 

 

NRAU-Baltic contest   
NRAUCW 

NRAUSSB  
2nd full weekend in January 

 

Oceania contest CW / SSB   
OCEANIACW 
OCEANIASSB  

SSB: First weekend in October 
CW: Second weekend in October  

OK-OM DX contest   OKOMDX  Second full weekend in November 
 

PA-beker CW / SSB contest   
PABEKERCW 
PABEKERSSB  

Second full weekend in November 
Local Dutch CW and SSB contest  

PACC contest   PACC  First full weekend of February 
 

Portugal Day Contest   PORTUGAL  Second Saturday of June 
 

QCWA QSO Party  

QCWAQSO Despite the name, treated as a separate contest 
 

QSO parties (US and Canada)  QSOPARTY  See next chapter/section 
 

RAC Canada Day Contest / RAC 

Canada Winter Contest   
RAC  Both contests have the same rules 

 

RAEM Contest  (E.T.Krenkel 

contest)  
RAEM  Fourth full weekend of December 

 

REF DX contest   
REFCW 
REFSSB  

CW: last weekend of January 
SSB: last weekend of February  

RF Championship   RFCHAMP  For English text select on top "Translate to English" 
 

RSGB 160 Meter CW contests   RSGB160CW  CW only. In February and November 
 

RSGB 21/28 MHz contest   RSGB2128  
  

RSGB 80 Meter Club 

Championship   
RSGB80MCC  

  

RSGB Affiliated Societies 

Contests  

RSGBAFS-C 
RSGBAFS-S    

RSGB Club Calls contest   RSGBCLUB  
  

RSGB Commonwealth Contest

  
RSGBBERU  British Commonwealth stations only 

 

RSGB National Field Day, RSGB 

SSB Field Day   
FDREG1  

According rules for Belgium, Germany, United 
Kingdom (SSB and CW), Netherlands, Switzerland, 
Ireland (only CW), Slovenia (S5) and Russia (UA, 
UA2, UA9). 

 

RSGB Low Power Contest   RSGBLP  
  

RSGB ROPOCO   ROPOCO  Internal RSGB contest 
 

Russian District Award Contest 

 

RDAC  
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Contest Name and Website 
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Log Type & 

Setup Link  
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Russian DX   RUSSIANDX  
  

Russian Radiosport Team 

Championship   

RRTC 
RRTCT  

Third Saturday in July 
 

Russian YL/OM contest   RUSYLOM  in Russian 
 

SAC - CW / SSB   
SACCW 

SACSSB  
Scandinavian Activity Contest 

 

SYLRA contest  

SYLRA 

  
SP DX contest   SPDX  First full weekend of April (15:00-15:00 GMT) 

 
Stew Perry Topband Distance 

Challenge   
STEWPERRY  Last full weekend of December 

 

TRC DX Contest   TRCDX  
  

UA1DZ Memorial Cup   DZCUP  For English text select on top "Translate to English" 
 

UBA DX Contest CW/SSB   
UBACW 
UBASSB  

SSB: last weekend of January 
CW: last weekend of February  

UBA ON contest   UBAON  

Last Sunday September: 6 m Phone/CW 

First Sunday October: HF - 80 m SSB 
Second Sunday October: HF - 80 m CW 
Third Sunday October: 2 m Phone/CW 

 

UBA Low Band Winter Contest

  
UBAWINTER  160, 80 and 40 meters 

 

UBA Spring   UBASPRING  

Second Sunday March: HF - 80m CW 
Third Sunday March: VHF-6m Phone/CW 

Fourth Sunday March: VHF-2m Phone/CW 
First Sunday April: HF - 80m SSB 

 

Ukrainian Championship   
UKRCHCW 

UKRCHSSB    

Ukrainian DX contest   UKRAINDX  First full weekend of November 
 

UN DX contest  

UNDX Open Kazakhstan Championship 
 

WAEDC-Contest   
WAECW 
WAESSB  

The starter for the new Contest season. 
 

Worked All Germany contest   WAG  October, third full weekend 
 

World Wide Peace Messenger 

Contest   
WWPMC  

1200UTC Saturday to 1200 UTC Sunday, every 
second weekend of January  

World Radiosport Team 

Championship   
WRTC  

for on-site participants in World Radiosport Team 
Championship held every 4 years - others use IARU  

World Wide Iron Ham Contest

 

WWIH Last full weekend in December (also RTTY) 
 

YO DX HF contest   YOHFDX  Last weekend in August 
 

YU DX Contest   YUDX  Third full weekend in April 
 

Independence of Venezuela 

Contest   
YV  First full weekend in July 

 

Norwegian RRL Winter Contest

  
NRRLVINTER  March. Rules in Norwegian, as .pdf file 
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2.1.3.3 QSO Parties (CW/SSB) 

The QSO parties listed below are supported by NM1MM Logger.  
Select: QSOPARTY and select the correct state in the dropdown box which will appear.  
The QSO parties use a configuration file named 'QSOparty.sec' with the used sections per QSO party.  

See the QSO Party Setup Instructions for more information on QSO parties in general and some 
specifics. There are some scoring anomalies with some of the QSO parties.  

1. United States 

State and Website Link  Setup Link 

Alabama - AL   
 

Alaska - AK   
 

Arkansas - AR   
 

Arizona - AZ   
 

California - CA   
 

Colorado - CO   
 

Connecticut - CT   Inactive. See New England Contest NEWE 

Delaware - DE   
 

Florida - FL   FL Setup Instructions  

Georgia - GA   
 

Hawaii - HI   
 

Idaho - ID   
 

Indiana - IN   
IN Setup Instructions Same weekend: 7QP, Indiana QSO Party and the 
New England QSO Party 

Illinois - IL   
 

Iowa - IA   
 

Kansas - KS   
 

Kentucky - KY   
 

Louisiana - LA   
 

MARAC - county hunters

  
MARAC Setup Instructions  

Maryland DC - MD   
 

Michigan - MI   
 

Minnesota - MN   
 

Missouri - MO   
 

Montana - MT   
 

Nebraska - NE   
 

New England - NEWE   
NEWE Setup Instructions Same weekend: 7QP, Indiana QSO Party and 
the New England QSO Party 

New Mexico - NM   
 

New Hampshire - NH   
 

New Jersey - NJ   
 

New York - NY   
 

North Carolina - NC   
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State and Website Link  Setup Link 

North Dakota - ND   
 

Nevada - NV   
 

Ohio - OH   
 

Oklahoma - OK   
 

Oregon - OR   
 

Pennsylvania - PA   PA Setup Instructions  

South Carolina - SC   
 

South Dakota - SD   
 

Tennessee - TN   
 

Texas - TX   
 

Vermont - VT   
 

Virginia - VA   
 

Wisconsin - WI   
The 1.5 power multiplier is not supported. The score is stored as an 

integer. 

Washington Salmon Run - 

WA    

West Virginia - WV   
 

7th Call Area - 7QP   
7QP Setup Instructions Same weekend: 7QP, Indiana QSO Party and 
the New England QSO Party 

IN7QPNE  
IN7QPNE Setup Instructions 
For users who are "out-of-state" for the IN, NEWE, or 7QP QSO parties 
Log all contests in one log and send the same cabrillo file to all sponsors 

2. Canada 

Province and Website Link  Setup Link  
 

British Columbia - BC   
  

Maritime QSO Party - MCC   
  

Ontario - ON   
  

3. Other QSO Parties 

For the Elecraft and QCWA QSO Parties, please visit the Supported HF Contests page.  

 

 

2.1.3.4 Supported VHF CW and SSB Contests 

Contest Name and Website Link  
Log Type and 
Setup Link  

Remarks  
 

ARRL January VHF Sweepstakes   ARRLVHFJAN  January 
 

ARRL June VHF QSO Party   ARRLVHFJUN  June 
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Contest Name and Website Link  
Log Type and 

Setup Link  
Remarks  

 

ARRL August UHF Contest   ARRLUHFAUG  August 
 

ARRL September VHF QSO Party   ARRLVHFSEP  September 
 

CQ WW VHF Contest   CQWWVHF  July - 50 MHz and 144 MHz only 
 

IARU Region 1 50 MHz contest   VHFREG1  Only 50 MHz - June 
 

IARU Region 1 144 MHz September

  
VHFREG1  Only 144 MHz - September 

 

IARU Region 1 UHF/Microwaves 

October   
VHFREG1  UHF and Microwaves - October 

 

Other Region 1 VHF and up 

contests   
VHFREG1  VHF and up - March, May, July 

 

Marconi CW contest 144 MHz / 50 

MHz   
VHFREG1  

  

NRAU Activity Contest   VHFNAC  
  

REF Departments contest 50 MHz

  
DDFM50  Only 50 MHz 

 

VHF/UHF Helvetia 26 contest   VHFHELV26  Swiss VHF and up contest 
 

VHF HG OB contest   VHFHGOB  Hungarian VHF contest 
 

VHF UA1DZ Cup   VHFDZCUP  Russian VHF contest 
 

VRZA - Nederlandse Locator 

Contest   
REGIOVHF  

WANLC - Dutch contest, every month NB 

selecteer: REGIOVHF  

UKSMG sporadic-E competition   UKSMG  
  

 

2.1.3.5 Supported RTTY/PSK Contests 

All contests are supported 'both' sides unless specifically mentioned.  

Contest Name and Website 
Link  

Log Type and 
Setup Link  

Remarks 

10 Meter RTTY Contest   ARRLRTTY  
First full weekend of December (rules same as ARRL 

RTTY Roundup) 

ANARTS WW RTTY contest   DLDCRTTY  Defunct - Replaced by DRCG Long Distance Contest 

Anatolian RTTY contest   ANATOLRTTY  Discontinued contest? Third full weekend in May 

ARRL Rookie Roundup RTTY   RRRTTY  Third Sunday of August 

ARRL RTTY Roundup   ARRLRTTY  First full weekend of January (not on January 1) 

BARTG Spring RTTY contest   BARTGSRTTY  Third full weekend in March 

BARTG RTTY Sprint contest   BARTGRTTYS  Fourth full weekend of January 

BARTG Sprint75 contest   BAR75RTTYS  75 baud RTTY. April, September (4 hours each) 

CQ World Wide DX - RTTY   CQWWRTTY  Last full weekend of September (48 hours) 

CQ World Wide WPX - RTTY   CQWPXRTTY  Second full weekend of February 

CIS DX RTTY contest   CISDXRTTY  
QPSK63 in 2009/2010. Third full weekend of 
September 

Russian Federation Digital 

contest   
RFCDIGI  Second weekend of September 
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Contest Name and Website 

Link  

Log Type and 

Setup Link  
Remarks 

Cup of the Russian Federation 

RTTY   
RUCUPRTTY  For Russians only. Second weekend of September 

DL-DX RTTY contest   DLDXRTTY  First full weekend of July 

DMC RTTY   DMCRTTY  Third full weekend of July 

DRCG Long Distance RTTY   DRCGWWRTTY  Second full weekend of June 

EA PSK31 contest   EAPSK  Second full weekend of March 

EA RTTY contest   EARTTY  First full weekend of April 

EPC PSK World Wide DX   EPCWWDX  PSK63. First weekend in February 

EPC RU DX Contest  

EPCRUDX  March BPSK63 

EPC PSK63 QSO party   EPCPSK63QP  PSK63. Third full weekend of November 

EU PSK DX contest   EUPSKDX  PSK63. Third full weekend of May 

JARTS WW RTTY contest   JARTSWWRTY  Third full weekend in October 

JT RTTY DX Contest   JTDXRTTY  Second full weekend in January 

LOTW RTTY contest   LOTWRTTY  Contest discontinued? 

Makrothen RTTY contest   MAKRORTTY  Second full weekend in October 

NA Sprint - RTTY   SPRINTRTTY  
Sunday of second full weekend in March. Sunday of 
second full weekend in October 

North American QSO Parties 

(NAQP) - RTTY   
NAQPRTTY  

Last full weekend in February. Third full weekend in 
August 

OK DX RTTY contest   OKDXRTTY  Third full weekend in December 

Quick PSK63 contest   SARTGRTTY  
PSK63. Uses SARTG rules. First Saturday of 
September 

Russian PSK DX Contest  

RUSDXPSK PSK. Third weekend in February 

Russian DX RTTY contest   RUSDXRTTY  RTTY. First Saturday of September 

SARTG New Year RTTY   SARTGNYRTY  January 1st 

SARTG WW RTTY contest   SARTGRTTY  Third weekend in August 

SCC RTTY Championship   SCCRTTY  Last full weekend in August 

SP DX RTTY contest   SPDXRTTY  4th full weekend of April 

TARA Grid Dip contest   TARAGRID  RTTY and PSK. First Saturday of August 

TARA PSK Rumble   TARAPSK  PSK31. First Saturday of October 

TARA RTTY Melee   TARARTTY  RTTY. First Saturday of December 

TARA Skirmish   TARAPSK  Digital. Third Saturday of April 

Ukrainian RTTY Championship

  
UKRCHRTTY  For Ukrainian stations only. Third weekend of April 

Ukrainian DX RTTY contest   UKRAINRTTY  First full weekend of November 

Ukrainian Open RTTY 

Championship   
UKRTTYOPEN  First full weekend of March 

Ukrainian DX DIGI contest   UKRAINDIGI  RTTY 75 baud, PSK63. Fourth full weekend of June 

Ukrainian DX Classic RTTY 

contest   
UKRAINDX  DX Classic RTTY. Third weekend of June 

United Kingdon DX Contest - 

RTTY   
UKDXRTTY  Second full weekend of July 
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Contest Name and Website 

Link  

Log Type and 

Setup Link  
Remarks 

Volta RTTY contest   VOLTARTTY  Second full weekend in May 

WAEDC RTTY contest   WAERTTY  Second full weekend in November 

World Wide Iron Ham Contest

 

WWIH Last full weekend in December (also SSB and CW) 

XE RTTY contest   XERTTY  First full weekend of February 

 

 

2.1.3.6 Supported User Defined Contests 

 

UDC Installation Instructions 

Installation instructions for User Defined Contests are located at the top of the >Documents >Digging 
Deeper >Setup User Defined Contest page  

 

Contest Name and Website Link  
Log Type & 
Setup Link  

Remarks 

PODXS Valentine Sprint Contest  

070VSRTTY  PODXS Valentine Sprint Contest 

ACHAMPCW  

ACHAMPCW  ACHAMPCW 

ARKTIKA-SPRING  

AC-SPRING  ARKTIKA-SPRING 

AEGEAN RTTY Contest   AEGEANRTTY  AEGEAN RTTY Contest 

AGB   AGB  AGB 

AGB NEMIGA/PARTY   AGB_RTTY  AGB NEMIGA/PARTY 

AGB Party   AGBPARTY  AGB Party 

ALASKA QSO Party   AKQP_RTTY  ALASKA QSO Party 

ARI RTTY 80/40m   ARIRTTY  ARI RTTY 80/40m 

Arktika Polar Radioman   ARKTIKAPR  Arktika Polar Radioman 

ARRL-EME   ARRLEMEVHF  ARRL-EME 

ARR PSK63   ARR_RTTY  Portuguese ARR PSK63 

Belgian Data Modes WW Contest  

BDMWWRTTY  Belgian Data Modes WW Contest 

Brazil Independance Day Contest

  
BRAZ_IRTTY  Brazil Independance Day Contest 

Bucuresti Contest   BUCURESTI  Bucharest-HF-Contest 

Worked All China Provinces   BY_WAPC_BY  Worked All China Provinces 

Worked All China Provinces   BY_WAPC_DX  Worked All China Provinces 

CA HF   CAHF  CA HF 

Comment   COMMENT  Comment 

CQ Western Electric   CQWE_RTTY  CQ Western Electric Contest 
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Contest Name and Website Link  
Log Type & 

Setup Link  
Remarks 

CSA-VHF   CSAVHF  CSA-VHF 

CUCALAMBE Contest   CUCALAMBE  CUCALAMBE Contest 

DIG_PA Contest  

DIG_PA  DIG_PA Contest 

DNIEPER CUP   DNIEPERTTY  DNIEPER CUP 

The Day of YLs   DOYLSRTTY  The Day of YLs 

CONCURSO NACIONAL FONIA   EACNF  CONCURSO NACIONAL FONIA 

50RS VHF   EARSVHF  50RS VHF 

Suffixes XXIX National   EASUFF29  Suffixes XXIX National 

EPC Ukrainian DX   EPC-UKR-DX  EPC Ukrainian DX 

Eesti LÃƒÆ’Ã‚Â¼hilaine 

KarikavÃƒÆ’Ã‚Âµistlused   
ES-LL-KV  Eesti LÃƒÆ’Ã‚Â¼hilaine KarikavÃƒÆ’Ã‚Âµistlused 

ES OPEN HF   ESOPENHF  ES OPEN HF 

ES OPEN HF   ESOPENHF  ES OPEN HF 

EUCW ON5ME-160   EUCW160  EUCW ON5ME-160 

EUCW Fraternizing Party   EUCWFP  EUCW Fraternizing Party 

FGUP 2011   FGUP2011  FGUP 2011 

Podxs070 PSK 31 Flavors   FLAVORRTTY  Podxs070 PSK 31 Flavors 

Flight of the Bumblebees   FLTOTBBS  Flight of the Bumblebees 

GEDEBAGE DX Contest  

GEDEBAGE  GEDEBAGE DX Contest 

GENERIC   GENERIC  GENERIC 

GENERIC2   GENERIC2  GENERIC2 

GENERIC RTTY   GENERRTTY  GENERIC RTTY 

HA3NS Memorial Contest  

HA3NS  HA3NS Memorial Contest 

International Lighthouse Week 

2010   
ILLW-2010  International Lighthouse Week 2010 

IRTS80M   IRTS80M  IRTS80M 

IRTS CQIR   IRTSCQIR  IRTS CQIR 

JW-FD   JWFD  Jock White Memorial FD. 

Kanagawa   KANAGAWA  Kanagawa 

KCJ   KCJ  KCJ 

Keymens Club of Japan   KCJ_DX  Keymens Club of Japan 

Keymens Club of Japan   KCJ_JA  Keymens Club of Japan 

KT Serbian Cup   KTKUP  KT Serbian Cup 

Lighthouse Christmas Lights 2010

  
LCL-2010  Lighthouse Christmas Lights 2010 

Lighthouse Spring Lites 2010  

LSL2010  Lighthouse Spring Lites 2010 

LY WAL Contest  

LYWAL  LY WAL Contest 

Moscow-Championship   MA-CHAMP  Moscow-Championship 

Marconi Memorial Contest   MARCONIMEM  Marconi Memorial Contest 

MOON CONTEST   MOONRTTY  MOON CONTEST 

MULAN WAP   MULANDXC  MULAN WAP 
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Contest Name and Website Link  
Log Type & 

Setup Link  
Remarks 

NRL Cup   NRLC  NRL Cup 

North American QRP CW Club 

Sprints  

NAQCC  North American QRP CW Club Sprints 

NRRL TELEFONITEST   NRRLTELEFO  NRRL TELEFONITEST 

OBLAST   OBLAST  OBLAST 

OH-PARKS   OH-PARKS  OH-PARKS 

OKOM DX SSB Contest   OKOM DX SSB  OKOM DX SSB Contest 

Old New Year   OLDNEWYEAR  Old New Year 

Original QRP   OQRP  Original QRP 

OZ ACTIV Contest   OZACTIV  OZ ACTIV Contest 

OZCHR-VHF   OZCHRVHF  OZCHR-VHF 

PARLA   PARL  PARLA 

SP PGA Contest   PGATEST-DX  SP PGA Contest 

SP PGA Contest   PGATEST-SP  SP PGA Contest 

Podxs 070 Contest   PODXS1RTTY  
Podxs 070 Contests: PSK FEST, JAY HUDAK 
Mem., PUMPKIN SPRINT, and Firecracker. 

Podxs 070 St. Patrick's Day 

Contest   
PODXS2RTTY  Podxs 070 Contest: St. Patrick's Day Contest. 

Popov Memorial   POPOVMEMOR  Popov Memorial 

POPOV-VHF   POPOVVHF  POPOV-VHF 

PW 144 and 70Mhz   PW_144_70  PW 144 and 70Mhz 

R3E-SC   R3E-SC  R3E-SC 

QRP HF RTTY Contest   QRPHFRTTY  QRP HF RTTY Contest 

R4C Champ   R4CCHAMP  R4C Champ 

R4W (Udmurtia, Russia) Open 

Championship   
R4W-CHAMP  R4W (Udmurtia, Russia) Open Championship 

R6H Champ   R6HCHAMP  R6H Champ 

Championship of Astrahan oblast   R6U-CHAMP  Championship of Astrahan oblast 

REGION-NR   REGION-NR  REGION-NR 

RUSSIAN160   RUSSIAN160  RUSSIAN160 

SALMON-RUN   SALMON-RUN  SALMON-RUN 

SARA Spring Sprint   SARA  SARA Spring Sprint 

SARA Spring Sprint   SARA_OM  SARA Spring Sprint OM Stations. 

SCAG SPRINT   SCAG  SCAG SPRINT 

Seanet Contest   SEANETRTTY  Seanet Contest 

TARA SKIRMISH   SKIRMRTTY  TARA SKIRMISH 

SMIRK   SMIRK  SMIRK 

Silent Key Memorial Contest   SKMEM  Silent Key Memorial Contest 

SPAR Winter FD   SPAR_FD  SPAR Winter FD 

SPEPC_RTTY Memorial Contest  

SPEPC_RTTY  SP WW EPC BPSK63 Contest 

SRR JR   SRRJR  SRR JR 
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Contest Name and Website Link  
Log Type & 

Setup Link  
Remarks 

International 2010   SWL  International 2010 

TA VHF/UHF Contest  

VHF_UHF_TA  TA VHF/UHF Contest 

TenTen QSO Party   TENTENRTTY  TenTen QSO Party 

Tesla HF Memorial Contest  

TESLA_VHF  Tesla HF Memorial Contest 

SV Triathlon Contest  

TRIATHRTTY  SV Triathlon Contest 

UFT HF Contest   UFT-HF  UFT HF Contest, First Weekend in December 

UK DXC BPSK63   UKDX63RTTY  UK DXC BPSK63 2nd Weekend in January 

URAL CUP   URALCUP  URAL CUP 

USi W/VE Islands Qso Party   USI_QPRTTY  USi W/VE Islands Qso Party 

UT5EU-MEMORIAL-VHF   UT5EUVHF  UT5EU-MEMORIAL-VHF 

DigiFest   VHF_DFRTTY  DigiFest 

RSGB VHF Contests   VHFRSGB  
RSGB VHF Contests see VHF_RSGB_Read_Me.txt 
in VHFRSGB.zip 

RSGB UKAC (VHF)   VHF_PAUL4  RSGB UKAC (VHF) 

VHF GRIDS   VHFGRIDS  VHF GRIDS 

VHF-SPRING   VHFSPRING  VHF-SPRING 

Vytautas Magnus trophy   VMTROPHY  Vytautas Magnus trophy 

VU Himalaya Contest  

VU_HIMA_VU  Himalaya Contest 

VU International DX Contest  

VU_DX_VU  VU International DX Contest 

VU Summer Contest  

VUSUMMRTTY  VU Summer Contest 

Worked All Britain Contest  

WAB  Worked All Britain Contest 

WSEM minitest   WESM  WSEM minitest 

World Lighthouse OTA   WLOTARTTY  World Lighthouse OTA 

YACHAMP   YACHAMP  YACHAMP 

YL-OM   YLOM  YL-OM 

YO PSK31   YORTTY  YO PSK31 

ZOMBIE   ZOMBIE  ZOMBIE 

 

1.3.6.1 The User Defined Contest Editor 

 
Enabling users of a contest logger to define their own contests has always been a very difficult thing 
to do. With the proliferation of contests, often with (ahem) innovative rules, it has gotten harder in 
recent years. Normally, it requires someone with knowledge of the programming language to create a 

contest "module", and even then the rules may defy incorporation.  

In an effort to help with this problem, Nick, NA3M has written a very clever User Defined Contest 

(UDC) Editor, which is found in a new sub-folder in the N1MM Logger program folder, beginning with 
Version 10.3.4. The same description of how to use this editor is found both here and in a Help file, 
also in that folder, which contains information in different languages selectable from the UDC File 
Editor. We will try hard to keep this manual updated to reflect the evolution of the UDC Editor, but the 
Help file will always be up to date. The Help file can be opened from the UDC File Editor by clicking its 
HELP button or by double-clicking a specific contest parameter line. Notepad will automatically start 

and display the Help file. Resize windows so you can see both the UDC editor window and the Notepad 

http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_SWL
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#SWL
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VHF_UHF_TA
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VHF_UHF_TA
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_TENTENRTTY
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#TENTENRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_TESLA_VHF
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#TESLA_VHF
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_TRIATHRTTY
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#TRIATHRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=UFT-HF
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#UFT-HF
http://fw.hamdocs.com/?file=sponsors.csv&id=UKDX63RTTY
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#UKDX63RTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_URALCUP
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#URALCUP
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_USI_QPRTTY
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#USI_QPRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_UT5EUVHF
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#UT5EUVHF
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VHF_DFRTTY
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VHF_DFRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VHFRSGB
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VHFRSGB
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VHF_PAUL4
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VHF_PAUL4
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VHFGRIDS
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VHFGRIDS
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VHFSPRING
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VHFSPRING
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VMTROPHY
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VMTROPHY
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VU_HIMA_VU
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VU_HIMA_VU
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VU_DX_VU
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VU_DX_VU
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_VUSUMMRTTY
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#VUSUMMRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_WAB
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#WAB
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_WESM
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#WESM
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_WLOTARTTY
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#WLOTARTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_YACHAMP
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#YACHAMP
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_YLOM
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#YLOM
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_YORTTY
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#YORTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=UDC_ZOMBIE
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests#ZOMBIE


window at the same time. Double-clicking on a parameter is particularly useful because 

Notepad then goes directly to that parameter in the Help file. The first time you call for help 
during an editing session, you will be asked to select the language. This selection stays in memory 
until you close the editor. If the wrong language was selected, you will have to close and restart the 
UDC Editor.  

There are three ways that you can take advantage of the User Defined Contest feature: choose a UDC 

that was selected by the N1MM Logger Development Team and included with the program as part of a 
Latest Update; build your own UDC using the UDC editor, or download a UDC that was built by 
another ham and contributed to the Yahoo user group UDC file directory.  

Regardless of which method you use, the drop-down list of available contests in N1MM Logger's 
Contest Setup dialog will only list UDCs that have been copied to the UserDefinedContests folder in the 
N1MM program directory.  

If you have developed and thoroughly tested a UDC for a particular contest, please share it with other 

users by uploading it to the UDC folder in the Files Section of the N1MMLogger group on Yahoo. But 
please remember - UDCs are USER-defined, and bug fixes or feature improvements are the 
responsibility of the user who created the UDC, not the N1MM Development Team.  

 

Limitations 

While the UDC Editor gives a user extensive options for adapting N1MM Logger to the rules of many 
contests, it cannot provide the same control that a programmer has, or that may be required to fully 

implement them. For example, a contest defined with the UDC Editor can only give a fixed number of 
points per QSO. Many contests (WPX is a good example) are more complicated. Also, in many 
contests the rules are different for contestants from one area than for those from another - a good 
example is QSO parties with different rules for in-state and out of state participants. In those cases, it 
may make sense to create two UDC contests, for use by in-area and out-of-area contestants .  

1. List of User Defined Contests  

There are approximately 100 User Defined Contests available for download from the website's Files 

Gallery. Select >Files >User Defined Contests, or click HERE   

2. The UDC Editor  

 
The UDC Editor is quite simple. When you open the Editor, you will first be asked to select a User 

Defined Contest file. You'll note that these files all have the extension ".udc"), and are stored in the 
UserDefinedContests sub-folder in the N1MM Logger folder.  

http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=18


 
 
 

 

When you open an existing contest file, you will be warned to do a "Save As..." unless you intend to 
edit the file you have opened. This is because any changes are saved immediately to the file you have 
opened. You have to be careful not to damage the existing User Defined Contest file that you are 
going to use as a starting point for your new contest file.  

Here is an example of a contest created by a user during testing, as viewed in the UDC Editor.  



 
 
 

 

To change a contest parameter, click once on it. You'll note that the parameter and its value appear in 
the gray pane to the right. Change the value in the Value field. Click on Set Value for Key to save it. 
This will save it in the file immediately. That is why the Editor does not have a Save button. When you 
are done editing a contest just exit, and your contest file will have all changes saved.  

Once the new (or modified) .udc file is ready to test, save it one last time into the "N1MM 

logger/UserDefinedContests" folder and start N1MM Logger. Go to File > New Contest in Database, 
and you should be able to see your new contest in the list of available contests. Test it to make sure 

everything works as you planned. If there is something wrong, you can edit the .udc file even while it 
is loaded in N1MM Logger. To test any changes, just go to the Entry Window of N1MM Logger, click on 
the File menu, and reload the contest from the drop-down list of recent contests.  

If you want to help with this project and add one more language - simply add your translation to an 
empty [Language...] section in the UDC help file and send the file to na3m@arrl.net, Please use 
UNICODE encoding when saving the file.  

3. Editing Tips  



 

The UDC Editor will not allow you to delete parameter names but you can erase or omit the value in 
the gray pane, in which case the default value will be used (these are marked with * in the list of 
values for each parameter). You should only use values mentioned below. At the moment, there is no 

check for correctness of the value supplied for a parameter. The wrong value may cause unpredictable 
N1MM Logger behavior, such as display of warning messages with the name of the wrong parameter.  

By default, the UDC editor does not show "empty" parameters, for which N1MM Logger will be using 
default values. You can see the full list of parameters by clicking on the "Show Default" check box, 
and edit them by assigning a non-default value. Do not attempt to remove "empty" parameters - they 
may be needed in case this file is later used as a template for another contest.  

Keep your .udc files in the "N1MM logger/UserDefinedContests" folder. If you define a UDC and store it 
in the database, but subsequently remove its .udc file from the folder, then the next time you try to 
open that contest, a warning message will be displayed and the contest will not work.  

 

Don't worry about messing up 

One of the nice things about the UDC Editor is that you can't do much damage if you mess up. The 
only thing you are editing is the .udc file, and if it doesn't work and you can't fix it, you can always 
just delete it from the UDC folder and start over. 

4. Running a User Defined Contest  

 

User defined contests appear in the drop-down list of contests in the Select Contest dialog, just like 
those programmed at the factory.  

5. The UDC File  

 

Note: it is not recommended to use any language other than English for contest parameters. Take a 
look at the sample UDC files using a text editor, if you want to understand the file format, but we 
recommend you use the UDC Editor to edit or create a new file.  

5.1. File Format with Explanations  

This is the English-language text from the UDC Editor help file, describing how to configure a User 

Defined Contest for N1MM logger. Versions in Portuguese, Spanish, Russian can be found in the 
Help.txt file that is downloaded with every Latest Update.  

The most convenient way to use this information is to open the help.txt file from the UDC Editor, by 
pressing its HELP button or by double clicking on a contest parameter line. You will be asked to select 
a language. This selection stays in memory until you close the Editor. If a language is selected that is 
not there, you will have to restart the Editor. Assuming you choose one of the languages that is there, 
Notepad will automatically start and open the Help file.  

It's best to resize the Notepad window so you can see both the UDC Editor window and the Notepad 
window at the same time.  

To change a parameter in the UDC Editor, click once on it and change its value in the Value field. Click 
on Set Value for Key to save it. This will save it in the file immediately. That is why the UDC Editor 

does not have a Save button. When you are done editing, all you have to do is exit, and your contest 
file will have all your changes saved.  



Because of this, if you use an existing UDC file as a starting point for your new one, you will have to 

be careful not to damage it. Open it with the UDC Editor, and click the Save File As... button. Give 
your new contest file a name that positively identifies it (preferably its short name, like ARRLDXCW).  

Once the new (or modified) UDC file is ready, copy it into the N1MM Llogger/UserDefinedContests 
folder and start the Logger. You should be  
able to see your new contest in the list of contests in the Contest Setup Dialog.. Test it to make sure 

everything works as you planned. If there is something wrong - you can keep editing it even while it is 
loaded in the Logger. Once you make a change to a parameter of the UDC file simply reload the 
contest (select "File" and then your contest name in the drop down menu). Note: this will not work if 
you change the name of the contest while editing.  

If you decide to help with this project and add another language - simply add your translation to an 
empty section [Language..] and send the  
file to na3m@arrl.net so it can be included in the next update of this program. Note: Be sure to use 
UNICODE encoding when saving the file.  

The UDC Editor will not allow you to delete parameters, but you can set a parameter to "nothing". If 
you do this, the default value will be used marked with * in this file). You should only use values listed 
in this file. There is no check for correctness of the value in this Editor at the moment. A wrong value 

may cause unpredictable Logger behavior. Some wrong values may cause Logger to display warning 
messages with the name of the wrong parameter.  

By default, the UDC editor does not show "empty" parameters. Logger will be using default values for 
them. You can see them by clicking on the "Show Default" check box. After that you will be able to 
edit them by assigning non-default values. Do not remove "empty" parameters - they may be needed 
in case this file is used as a template for another contest.  

Keep your .UDC files in the N1MM logger\UserDefinedContests folder if you are planning to use 
contests defined by those files. If you try to load some previously used (and stored in the current 
database) User Defined Contest and the .udc file for it is not in the folder, Logger will not start the 
contest, and there will be a warning message displayed.  

To start the UDC Editor by clicking on a .udc file, right-click on one of them, select "Open with", 
"Choose program" and select "UDCeditor.exe" as the "Recommended Program" for this type of files.  

[Author] section  

/AuthorName/ =  
Put your name here. Users should know who will  
be able to help them with this contest file.  

/Callsign/=  
your callsign  

/Email/=  
your email  

[File] section  

/Revision/ =  
Start with 1.0.0 It is recommended that you increment it every time you modify the UDC file.  



/LastUpdate/ =  

Will be automatically filled with the current date if you create a new file (using Save File As...) or edit 
the current file.  

/Description/ =  
Short description of the contest type (one line). Example: "Finnish Domestic VHF Contest"  

[Contest] section  

/Name/ =  
This is the short name that will be used in the Contest Setup dialog. 10 Characters maximum, no 
spaces. Example: ARRLDXCW. RTTY contests must have RTTY somewhere in the name; VHF contest 
names must start with VHF.  

/DisplayName/ =  
Your choices, spaces allowed Example: ARRL DX CW  

/CabrilloName/ =  
Your choice, 15 characters maximum, no spaces. Example: ARRL- DX-CW This name will be used in 
the  
Cabrillo file header  

/Mode/ =  
Valid modes are: CW* SSB BOTH RTTY  

/DupeType/ =  

1 = All bands (stations may be worked only once in the contest)  
2* = Each band (common)  
3 = Each band & mode (stations may be worked on each band/mode combination (e.g. 40 SSB, 40 
CW, 40 RTTY))  
4 = no check)  

Also used in the Multiplier window to show modes (when 2 or 3) in the Section window.  

/Multiplier1Name/ =  
See list below  

/Multiplier2Name/ =  
See list below (mostly N/A if the contest recognizes only one multiplier type)  

/Multiplier3Name/ =  
See list below (mostly N/A if the contest recognizes only one multiplier type)  

Name Comment 

CountryPrefix Each country is a multiplier Example: DL, PA etc (uses WL_CTY.DAT) 

WPXPrefix Each prefix is a multiplier 

Sect 

Each Section is a multiplier Need a *.sec file loaded with button "Import Section 
File" in the Contest Setup dialog. The MultWindowType below should match the 

name of .sec file 

ZN Each CQ Zone is a multiplier (max. 40) 

MiscText Each misc. Text is a multiplier 



 

/Period/ =  
How many days is the contest (not used at  
the moment). Options are 1 or 2  

/PointsPerContact/ =  
Default 1*. May be any integer.  

You can put several parameters in one line. Separate each with a comma: For example OH, 5, SM, 5, 
MyCountry, 1, SameContinent, 2, OtherContinent, 3 (will award 5 points for QSOs with OH or SM, 1 
point for contacts in your own country, etc.(NOTE: country prefixes should match those that are in 
wl_cty.dat file and be the first in line if used)  
Another example: SSB, 2, CW, 3, DIGI, 4, RTTY, 4, PSK, 5, FM, 2  
(2 points for SSB, 3 points for CW, 4 for RTTY and so on)  
And yet another: 160m, 5, 80m, 4, 40m, 3( 5 points for QSO on 160m and so on). In this type of 

entry, the allowed bands are 160ÃƒÂ•Ã‚Â¼, 80ÃƒÂ�Ã‚Â¼, 40ÃƒÂ�Ã‚Â¼, 20ÃƒÂ•Ã‚Â¼, 
15ÃƒÂ•Ã‚Â¼, 10ÃƒÂ�Ã‚Â¼, 6ÃƒÂ�Ã‚Â¼, 4ÃƒÂ�Ã‚Â¼, 2ÃƒÂ�Ã‚Â¼, 1.25ÃƒÂ�Ã‚Â¼, 70cm, 33cm, 
23cm, 13cm, 9cm. The values for this parameter can be mixed, but if the QSO meets two or more 

criteria (for example, 160m and OH), then priority order will be: band, mode, continent, country.  
IsMisc, 3,  
IsComment, 4 -  

give some point if there is any value in MiscText or Comment  
NOTE: for VHF contests the numeric value will be used as the multiplier, i.e. KM*multiplier. ! 
Exchange, * - use numeric value  
entered in Exchange as Points (do not replace *, just use "Exchange, *")  

/ShowMyCountryStations/ =  
True* Yes show My Country stations in the bandmap (normal)  
False No don't show them in the bandmap  

/ShowWarcBands/ =  
True Yes show the WARC bands (only for general logging (DX)  
False* No don't show them (all contests)  

/ZoneType/ =  
CQ* CQ type zones should be shown (for most contests)  
IARU IARU zones should be shown  

/MultWindowType/ =  
State US states  
StateProvince US states and Canadian Provinces are both valid entries  

Province Canadian Provinces (or 13P)  
Section* ARRL sections (or 48S14P, 48SDC14P, 49S8P, 50S8P, 50S10P, 50S13P, 50S13PCY0, 
50S14P, 50SDC14P, 50SDC10P, 71SEC13WB, 50SDC13P, 50S13RAC, 50S9P, 50S11P, 50SNOLAB)  
Provincie Netherlands Provinces (for PACC Contest)  
DOK DOK letters letters: A to Z except Q, for WAG contest  
UBA ON contest  
Oblast Russian oblasts  

AnyName Prepare AnyName.sec file with the list of sections (look at any *.sec for sample). NOTE: This 
filename should not be longer than 9 characters!  

/CQZoneMultContest/ =  
True Contest uses CQ zones as a second multiplier e.g. CQWW  
False* It doesn't! (Mostly)  

/NumMults/ =  
0 for Field Day or other contests with no multiplier  



1* for most contests  
2 for CQWW (i.e. Country and Zone)  

/BonusPoints/ =  
Several bonus callsigns, DXCC entities, /P, /M or /QRP stations are allowed, use comma to separate 
bonus call from bonus points. Leave empty  
if no bonus station(s) or countries.  
Example: RM1DZ, 20, RA1DZ, 20, DL, 25, /M, 4, /P, 2, /QRP, 5  

/BonusPoints2/ = points, filename  

This allows using a file with a number of Callsigns that give bonus points.  
Parameter format: BonusPoints2 = 5, BonusPoints.txt (points, file name).  

Filename can be any name with the extension *.txt but the file must be in the main Logger program 
folder. Every callsign in the file should have a comma at the end, including the last one:  

<file starts>Call1, Call2, Call3, ..., LastCall,<file ends>  

or  

<file starts> Call1, Call2, Call3, ... LastCall, <file ends>  

BonusPoints2 extends BonusPoints but has higher priority. In other words, if the callsign is found in 
the BonusPoints string and also in the file  
BonusPoints.txt, then the bonus point assigned for BonuPoints2 will be used.  

/MultSqlString/ =  
1 MultSqlString = Country (new country will be counted as multiplier)  
2 MultSqlString = Section (new section will be counted as multiplier)  
3 MultSqlString = WPXPrefix (new WPXPrefix will be counted as multiplier)  

4 MultSqlString = N/A* (no multipliers)  
5 MultSqlString = Grid (new 4-character GridSquare will be counted as multiplier)  
6 MultSqlString = CallSign (new CallSign will be counted as multiplier). NOTE - uses NameText.  
7 MultSqlString = SGrid (new 6-character GridSquare will be counted as multiplier)  
8 MultSqlString = FirstQSO (first QSO on every band (mode) will be counted as multiplier)  

/MultSqlString2/ =  
Country (, Band)  
Section (, Band)  
N/A* i.e., no multipliers. See details above.  

/MultSqlString3/ =  
Country (, Band)  

Section (, Band)  
N/A* i.e. no multipliers. See details above.  

/DoNotCountMeAsMult/ =  
True Do not count Multiplier1 for my Country, Section or WPX prefix (depends on what was set as 
MultSqlString)  
False* Count Multiplier1 for my Country, Section or WPX prefix.  

/DoNotCountMeAsMult2/=  
True Do not count Multiplier2 for my Country, Section or WPX prefix (depends on what was set as 
MultSqlString2)  
False* Count Multiplier2 for my Country, Section or WPX prefix.  



/DoNotCountMeAsMult3/=  

True Do not count Multiplier3 for my Country, Section or WPX prefix (depends on what was set as 
MultSqlString3)  
False* Count Multiplier3 for my Country, Section or WPX prefix.  

/CountMultOnlyFor/ =  
Default value is empty. Set it to one or several countries from the wl_cty.dat file to make the 

multiplier work for those countries only.  
Example: CountMultOnlyFor =G, GW, GM, GI, GD, GU, GJ. Do not use too many countries here - it 
may stop working if the line is too  
long and also will slow down the computer .  

/CountMultOnlyFor2/ =  
Same as for /CountMultOnlyFor/ but will be applied for Multiplier2  

/CountMultOnlyFor3/ =  
Same as for /CountMultOnlyFor/ but will be applied for Multiplier3  

/CountMultOnlyForSec/ =  
Default value is empty. Set it to one or several sections from the .sec file to make the multiplier work 
for those sections only. Example: CountMultOnlyForSec = MA, MO. Do not use too many sections here 
- it may stop working if the line is too long and also will  
slow down the computer.  

/CountMultOnlyForSec2/ =  
Same as for /CountMultOnlyForSec/ but will be applied for Multiplier2  

/CountMultOnlyForSec3/ =  
Same as for /CountMultOnlyForSec/ but will be applied for Multiplier3  

/QsoErrorString/ =  

The exchange field will be checked according to this setting before logging QSO  
Numeric - only numbers allowed (like serial number) 12 characters max  

Any - both numbers and letters allowed (12 characters max) but some value is required.  
Grid - Grid Square Text, 4 or 6 characters  
If none of the above, put in some text ("Sect" for example), only exchange listed in .sec file will be 
excepted !  
Empty* If empty, then do not check (anything including empty field will be accepted, 12 characters 
max)  

/LogInfo/ = SentReport, 500, SentNR, 500, ReceiveReport, 500, NR, 500, Points, 500 SentReport, 
SentNR, ReceiveReport, NR, IsMultiplier1, IsMultiplier2, CountryPrefix, GridSquare, Exchange1, 
MiscText, Points, opname,  

Comment adjust the field names and spacing for the log window by adding/deleting relevant name 
and spacing (only names in the example  

are allowed)  

/FrameText/ = SntRpt SntNR RcvRpt NR  

These are the names displayed on top of each field of Entry Window, except for the callsign. Adjust 
the field names and spacing for the frame text by adding/deleting spaces in this line. Any names 
allowed.  

/EntryWindowInfo/ = SNTText, 500, SntNrText, 700, RCVText, 500, Exchange1Text, 500 SNTText, 
SntNrText, RCVText, RcvNrText,  
GridSquareText, Exchange1Text, CommentText, NameText  



Adjust the field names and spacing for the main window by adding/deleting relevant name and 
spacing (only names in the line above are allowed)  

The following table shows possible EntryWindow Items, followed by the width normally used.  

Name Width 
Max. 
Length 

Comment 

SNT Text 450 10 Sent exchange field 

RCV Text 450 15 Received exchange field (default 59 or 599) 

NameText 855 20 Name field, only letters allowed 

CommentText 1695 60 
Comment field, space character allowed so space 
as tab does not work here 

SntNrTxt 625 5 
Sent following number field, auto-numbered by 
the program 

RcvNrTxt 625 5 
Received following number field, only numbers 

allowed 

Exchange1Text 615 12 Exchange field, numbers and letters allowed 

GridSquareText 600 6 Textbox for Grid Square 

MiscText 600 15 Miscellaneous textbox 

 

/DefaultContestExchange/ =  
001* this will show up in the contest selection window for editing. It may have two or three parts like 
this: "001 Prov", "001 NA123". If the first part is 001 the logger will generate a serial number for 
every QSO and the second part will be sent by F2 with the number unchanged  

/CabrilloFormat/ =  

1*= standard (use 0 if Cabrillo is not supported)  

2 = NAQP format  
3 = NASPRINT format  
4 = SS (Sweepstakes)  
5 = RFC (Russian Federation Cup)  
99 = handcoded, uses CabrilloString (see below)  

/CabrilloString/ =  
SNT, 4, SentNr, 4, CallSign, 13, RCV, 4, RcvNr, 4, Comment, 40  
Format: value1 name, value1 width, value2 name, value2 width, ... Will work with: SNT, SentNr, 

CallSign, RCV, RcvNr, Comment, GridSquare, Exchange1, Name, SentExch, SentExchPart1, 
SentExchPart2, SentExchPart3  

To add some number of spaces use Space, N (N - number of spaces)  

/IsWorkable/ =  

ExceptMyCountry  
Any*  
MyContinentOnly  
MyCountryOnly,ExceptMyCountry  
list of countries (prefixes from wl_cty.dat file) separated by comma: UA2, UA, UA9.  
In the last case make sure you are using correct prefixes  

/SpecialInstructions/ =  
Special Instructions. Any text terminated by CR/LF This message will show up after Cabrillo file was 



generated - use  
it for a note to the operator. Leave it empty if not needed.  

/DupeSqlString/ =  
Select clause that will uniquely identify a dupe:  
0*- turns it off,  
1 - use Section,  

2 - use whatever is in ExchangeText,  
3- use mode (this will allow QSO with same station but different modes  
(CW, SSB, FM, AM)  
4- use GridSquare; This is needed for qso parties where you can have mobile stations in different 
counties.  

/StartOfContest/ =  
Example 7, 1.5 First number - day of week (Saturday=1, Sunday=2, Monday=3,....., Saturday=7) 
Second number - offset in hours  

(1.5 = 1 hour and 30 minutes) relative to GMT time, i.e. if it starts at 00.00 GMT the offset should be 

0. This will be used to calculate OFF  
times.  

/EndOfContest/ = 1, 1.5 Same format as for StartOfContest. This will be used to calculate OFF times  

/IsMultPer/ =  

0* NoMults  
1 OncePerBand  
2 OncePermMode  
3 OncePerBandAndMode  
4 OncePerContest  

/MinimumOffTime/ =  
30* Min. Off time in minutes  

/UsesWAECountries/ =  
False* Answer whether this contest uses the WAE countries list (countries with '*' in cty.dat). For 
example, for CQWW it should be True  

/SetSentTimeForContact/ =  
False* Used to set Sent Time in contests that require it. See CBARGT for use  

/ScoreSummaryMultNames/ =  
Sec  
Cty  
Grd Used to set title of Mult column in Score Summary  

/WebAddress/ = http://www.srr.ru/CONTEST/cup_raem_engl_08.php (example)  
Web address for the contest rules  

/GenericPrintString/ = SNT, 4, SentNr, 0, CallSign, 15, RCV, 4, RcvNr, 0, Comment, 12 Format: 
value1 name, value1 width, value2 name, value2  

width, ... Will work with: SNT, SentNr, CallSign, RCV, RcvNr, Comment, GridSquare, Exchange1, 
Name, Points, SentExch, SentExchPart1,  
SentExchPart2, SentExchPart3, Multiplier1, Multiplier2, Multiplier3. This will configure Generic file 
output that can be used instead of Cabrillo.  

/GenericPrintStringHeader/ = Date Time Freq Mode MyCall RST Snt Call RST Rcvd Comment  
Adjust the names and number of spaces here according to the values in GenericPrintString (above)  



/MultiplierBands/ =  

1* All HF Contest Bands  
2 All HF Bands  
3 All HF Contest Bands plus 6 meters and 2 meters  
4 All VHF Bands  

/QsoNumbersByBand/ =  

0* Use a single sequence of QSO numbers (common)  
1 QSO Numbers by Band for all categories  
2 = QSO Numbers by Band for Multi-Multi category only  

/DigitalModeSqlString/ = False* Used to merge RTTY and PSK into one digital contest mode  

/MultipleSessions/ =  

 Leave it empty if the contest time is not broken into sessions  

Examples: 0000/30 - starting at 00:00 UTC, sessions = 30 minutes 0000/60 - starting at 00:00 UTC, 
sessions = 60 minutes 0000/200 - starting at 00:00 UTC, sessions = 2.00 hours It is OK to use 0000 
for contest start time if it starts in the beginning of any other hour and sessions are < or = 60 
minutes. Dupes will be allowed when new session starts. Dupes will be allowed when new session 
starts and the Multiplier window will be cleared upon first contact in the new session.  

/ResetMultsEverySession/ = 0*  
When MultipleSessions is used, this parameter will allow multipliers to be reset in the beginning of 
every new time  
session, if set to 1.  

/CabrilloVersion/ = 2.0*  
When set to 3.0 the log file will be saved using version 3.0 of Cabrillo format. Also new fields will show 
up in the contest configuration window. Any other value or if left empty will turn on Cabrillo version 

2.0  

/MultMult/ = 1*  

/MultMult2/ = 1*  

/MultMult3/ = 1*  

When any of these 3 values is changed to 0, the multiplier will not be used for dcore calculation. This 
is useful when you need to use multipliers for display purposes only (Band Maps and Available 
windows).  

 
 

 

2.1.3.7 My Contest Isn't Here. What Can I Do? 

 
If the contest is not currently supported by the program there are four options:  



 Use the 'User Defined Contest' capability introduced in version 10.3.4 to create a new contest 

template.  
o This capability is still under development and may undergo further change. See the 

User Defined Contest Editor section.  

 Find another contest with a similar exchange and similar rules. If the only difference is in the 

scoring, you can run the contest and create the Cabrillo file, then edit the Cabrillo file to 
change the contest name. You can either score the contest manually after the contest, or 
enter a claimed score of zero and let the contest sponsor calculate the multipliers and points  

 Use a 'general' contest like DXSERIAL, DX, etc. Run the contest and do the log creation after 
the contest using Notepad or a similar text editor. When Cabrillo is the log requested, create 

the Cabrillo log and update the header. The contest sponsor will calculate the multipliers and 
points. This is the easy way to go for many small, mostly local, contests  

 Request that the contest become one of the supported contests  
o Whenever someone requests support for a particular contest, it would be good to have 

an indication of the number of entries the contest received during the previous year's 
running. This is not to suggest that there is a threshold below which contests will not 

be supported, but that knowing this is helpful in prioritizing for the people who do the 
work. In the past we have had requests to support contests that had fewer than 10 
entries the previous year  

o Since the programmers do not have unlimited time to respond to last-minute requests, 

set yourself a target date (for example, a minimum of three months prior to the next 
running of the contest) to allow time for programming and proper testing  

o It is part of the nature of the N1MM Logger project that users, and particularly those 
users requesting support for a particular contest, are the people who are relied upon 
to test and be sure the contest module does what it is supposed to do. It is particularly 
important to test far enough in advance of the running of a contest so that any 
problems can be identified and fixed. Users will do well to check each contest as it is 

coming up, to make sure that any rule changes are reported to the programmers in 
time for changes to be made.  

 
If you identify bugs or propose contest-specific features during the running of a contest, don't 

expect an immediate response. Contest-specific things are on a calendar to be addressed before the 
next running. Of course, defects in Cabrillo output are an exception, since they need to be fixed in 
time for score submission and can be done in the weeks after the contest.  

 

2.1.4 Contest Setup Instructions 

 1 Setup General Contest Logging - All Modes 

 2 Setup HF Contests - CW and SSB 

 3 Setup QSO Parties - CW and SSB 

 4 Setup VHF Contests - CW and SSB 

 5 Setup RTTY and PSK Contests 

 6 Setup User Defined Contests 

 

2.1.4.1 Setup General Contest Logging 

 2.1.3 Supported Contests  

 2.1.3.1 General Contest Logging (all modes)  

 2.1.3.2 Supported HF Contests - CW and SSB  

 2.1.3.3 QSO Parties (CW/SSB)  

http://n1mm.hamdocs.com/tiki-index.php?page=The+User+Defined+Contest+Editor&structure=N1MM+Logger+Documentation
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+General+Contest+Logging+-+All+Modes&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+User+Defined+Contests&structure=N1MM+Logger+Digging+Deeper


o 1. United States  

o 2. Canada  
o 3. Other QSO Parties  

 2.1.3.4 Supported VHF CW and SSB Contests  

 2.1.3.5 Supported RTTY/PSK Contests  

 2.1.3.6 Supported User Defined Contests  

 1.3.6.1 The User Defined Contest Editor  

 1. List of User Defined Contests  
 2. The UDC Editor  
 3. Editing Tips  
 4. Running a User Defined Contest  
 5. The UDC File  

 5.1. File Format with Explanations  

 2.1.3.7 My Contest Isn't Here. What Can I Do?  

 2.1.4 Contest Setup Instructions  

 2.1.4.1 Setup General Contest Logging  

o 1. General Information  
o 2. Generic Contest Types  

 2.1. DX Log  
 2.2. DXpedition  

 2.3. DX Serial  
 2.4. DX Satellite  
 2.5. VHF DX  
 2.6. VHF Serial  

o 3. Deleted QSOs  

1. General Information 

When a contest has a specific mode (SSB, CW or RTTY) then the Mode Category is automatically 
changed to that mode. So when you select CQWWSSB for the CQ World Wide SSB contest the Mode 
Category will be set by the program to SSB. You can change this but that will give wrong Cabrillo 

output and maybe even erroneous behavior of the program, so don't!!  

If the selected contest doesn't have a specific mode the program will set the Mode Category to MIXED.  
Also the radio will be set on all bands to the mode set. The frequency though is not being changed to 
the CW/SSB/RTTY section of the band.  

This is a contest program but for general logging you can use DX as the selected contest if you want. 
Dupes are allowed and an exchange is not necessary.  
To import a contest into your regular logging program use ADIF export (and ADIF import in your 
general logging program).  

When going through the possible contests you will see a "contest" DELETEDQS.  
This is not a contest but deleted QSOs will be put in here by the program, this is especially for multi-
user support. Deleted QSOs in this contest can be exported.  

The maximum receive number is 99999 (for serial number contests). Check out info about the serial 
number server in the Contest Setup Dialog chapter .  

Read the Contest Instructions! 

Always read the instructions from the contest committee prior to the contest. Then you know how to 
set up the program, what exchange to give and what to expect in return, which hours to operate etc. 

2. Generic Contest Types 

http://n1mm.hamdocs.com/tiki-index.php?page=The+Contest+Setup+Dialog


 
 

2.1. DX Log 

Window: Select Log type  

 Log Type: DX  

 Mode Category: MIXED If you want to have the possibility of making SSB and CW contacts  

For general or DX logging.  

 Entered QSOs in General log (or DX log) don't need to have an exchange  

 Dupes are shown by the word Dupe! but the qso can be logged  

 
 

2.2. DXpedition 

Window: Select Log type  

 Log Type: DXPEDITION  

 Mode Category: MIXED If you want to have the capability of logging SSB and CW contacts  

For DXpedition logging  

 Entered QSOs in the DXPEDITION log don't need to have an exchange  

 Dupes are shown by the word Dupe! but the QSO can be logged  

 
 

2.3. DX Serial 

Window: Select Log type  

 Log Type: DXSERIAL  

 Mode Category: MIXED If you want to have the possibility of making SSB and CW contacts.  

For general Serial Number contest logging  

 Entered QSOs in DXSERIAL don't need to have an comment  

 Dupes are shown by the word Dupe! but the QSO can be logged  

 'Standard' points calculation; 1 point per qso, DXCC countries are counted  

o All other kind of multiplier and point calculations have to be done by hand  
o This for all not supported serial number contests  

 
 

2.4. DX Satellite 



Window: Select Log type  

 Log Type: DXSATELLIT  

 Mode Category: MIXED If you want the capability of logging SSB and CW contacts  

For Satellite logging.  

 Entered QSOs in the DXSATELLIT log don't have an exchange and don't need to have a grid  

 When a grid is entered it needs to be 4 or 6 characters long  

 Dupes are shown by the word Dupe! but the QSO can be logged  

 
 

2.5. VHF DX 

Window: Select Log type  

 Log Type: VHFDX  

 Mode Category: MIXED If you want to log both SSB and CW contacts  

For VHF and up logging.  

 Entered QSOs in VHFDX don't need to have a grid  

 When a grid is entered it needs to be 4 or 6 characters long  

 Dupes are shown by the word Dupe! but the qso can be logged  

 Bearing info is shown in the log window and saved in the Misc field  

 Distance info is shown in km in the log window and saved in the Points field  

 
 

2.6. VHF Serial 

Window: Select Log type  

 Log Type: VHFSERIAL  

 Mode Category: MIXED If you want to log both SSB and CW contacts  

 
Comments needs to be added using Ctrl+N. There is no room left in the Entry Window to add a 
separate field for it. Comments will be shown in the log window and added to the Cabrillo and generic 
output reports  

For VHF and up logging  

 Entered QSOs in VHFSERIAL don't need to have a grid  

 When a grid is entered it needs to be 4 or 6 characters long  

 Dupes are shown by the word Dupe! but the QSO can be logged  

 Bearing info is shown in the log window and saved in the Misc field  

 Distance info is shown in km in the log window and saved in the Points field  



 
 

3. Deleted QSOs 

DELETEDQS "contest"  

QSOs which are deleted from other logs using 'Edit Contact' are moved to this 'contest'.  
This is especially important for multi-user support. The moved QSOs can be exported.  

 

2.1.4.2 Setup HF Contests - CW and SSB 

 2.1.4.2 Setup HF Contests - CW and SSB  

o 1. 9A CW contest  
o 2. AGCW  
o 3. All Asian CW / SSB  

o 4. Asia Pacific Sprint CW / SSB  
o 5. Asiatic Russia Championship  
o 6. ARCI QRP Contests & Michigan QRP Contest  
o 7. ARI International DX Contest  
o 8. ARRL 10 Meter contest  
o 9. ARRL 160 Meter contest  
o 10. ARRL Field Day contest  

o 11. ARRL International DX contest CW / SSB  
o 12. ARRL November Sweepstakes CW / SSB  

 1. Entering Exchanges  
 2. Correcting what you copied  

o 13. ARRL Rookie Roundup  
o 14. Asia Pacific Sprint Contest CW / SSB  

o 15. Baltic contest  
o 16. Black Sea Cup International  
o 17. CNCW Spanish contest  
o 18. CQ M International DX contest  
o 19. CQSA SSB Contest  
o 20. CQ 160 Meter DX contest CW / SSB  
o 21. CQ World Wide DX contest CW / SSB  

o 22. CQ World Wide WPX contest CW / SSB  
o 23. CIS contest - CW / SSB  
o 24. Cup of the Russian federation RFC contest CW / SSB  
o 25. CWops Mini CWT  
o 26. CWops CW Open  
o 27. DARC 10 meter contest  
o 28. DARC Weihnachtswettbewerb XMAS contest  

o 29. DIG contest CW / Phone  

o 30. Elecraft QSO Party  
o 31. European Sprint CW/ SSB  
o 32. EU HF Championship  
o 33. Field Day Region 1  
o 34. First Class Operators Club (FOC) Marathon - members only  

o 35. First Class Operators Club (FOC) QSO Party  
o 36. GACW WWSA CW DX contest  
o 37. Gagarin Cup  
o 38. HA DX Contest  
o 39. Helvetia Contest  
o 40. High Speed CW Contest  



o 41. Holyland Contest  

o 42. IARU Radiosporting contest HF  
o 43. IOTA Islands On The Air Contest  
o 44. International Naval Contest  

o 45. JA domestic contests  
o 46. JIDX contest  
o 47. JT DX Contest  
o 48. King of Spain Contest  
o 49. Logbook of the World Contest CW / SSB  
o 50. LZ DX Contest  
o 51. LZ Open and LZ Sprint Contests  

o 52. Manchester Mineira Contest  
o 53. Michigan QRP Contest  
o 54. MiniTest CW Test  
o 55. NA Sprint CW / SSB  
o 56. SprintNS and Sprint Ladder  
o 57. NAQP North American QSO Parties CW / SSB  

o 58. NRAU Baltic Contest  
o 59. Oceania Contest  
o 60. OK OM DX contest  
o 61. PA beker contest  
o 62. PACC contest  
o 63. Portugal Day Contest  
o 64. QCWA QSO Party  

o 65. RAC Canada Day Contest / RAC Canada Winter Contest  
o 66. RAEM CW contest  
o 67. REF contest CW / SSB  
o 68. RF Championship  
o 69. RSGB 160 Meter CW Contests  
o 70. RSGB 21/28 MHz contest  
o 71. RSGB 80 Meter Club Championship  

o 72. RSGB Affiliated Societies Team Contests AFS  
o 73. RSGB Club Calls contest  

o 74. RSGB Commonwealth contest  
o 75. RSGB SSB Field Day & RSGB National Field Day  
o 76. RSGB Low Power Field Day  
o 77. RSGB ROPOCO  

o 78. Russian District Award contest  
o 79. Russian DX contest  
o 80. Russian Radiosport Team Championship  
o 81. Russian YL/OM contest  
o 82. SAC contest CW / SSB  
o 83. Spanish Towns contest  
o 84. SPDX contest  

o 85. Stew Perry Topband Distance Challenge  
o 86. Scandinavian Young Ladies Radio Association SYLRA  
o 87. UA1DZ Memorial Cup  
o 88. UBA contest CW / SSB  

o 89. UBA ON contest  
o 90. UBA Spring  
o 91. UBA Low Band Winter  

o 92. Ukrainian Championship  
o 93. Ukrainian DX contest  
o 94. UN DX Contest  
o 95. Independence of Venezuela Contest  
o 96. WAEDC contest CW / SSB  

 96.1. Introduction to WAE DX CW/SSB - based on an article originally written 

by Franki, ON5ZO  
 96.2. WAE from Europe (ON5ZO as an example)  



 96.3. WAE from the DX (non-Europe) side  

 96.3.1. Special considerations for SSB  
 96.4. Both sides  

o 97. WAG contest  

o 98. World Wide Iron Ham Contest  
o 99. World Wide Peace Messenger Contest  
o 100. WRTC contest  
o 101. YO HF DX contest  

1. 9A CW contest 

The 9A (Croatian) CW contest is a CW only contest.  

 Window: Select Log type  
o Log Type: 9ACW  
o Mode Category: CW  
o Sent Exchange: 001  

 
 

2. AGCW 

CW-only, on New Year's Day  

 Window: Select Log Type  

o Log Type: AGCW  
o Mode Category:CW  
o Sent Exchange: RST + Serial Nr + AGCW Member Nr.  

 
 

3. All Asian CW / SSB 

The All Asian contest can be used by Asian stations and DX stations.  

 Window: Select Log type  

o CW  
 Log Type: ALLASIACW  
 Sent Exchange:Your age Example: 34  

 XYL and YL stations may give 00  
o SSB  

 Log Type: ALLASIASSB  
 Sent Exchange:Your age Example: 34  

 XYL and YL stations may give 00  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an Asian station or a non-Asian station.  
 

4. Asia Pacific Sprint CW / SSB 



The Asia-Pacific Sprint contest can be used by Asia-Pacific stations and DX stations.  

 Window: Select Log type  
o CW  

 Log Type: APSCW  

 Sent Exchange:001  
o SSB  

 Log Type: APSSSB  
 Sent Exchange:001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an Asia-Pacific station or a DX station.  

5. Asiatic Russia Championship 

 For Asiatic Russian stations only.  

 Exchange consists of 2-digit location (lat/long rounded up to nearest 10 degrees e.g. 59N 81E 

> 69) plus serial number  
o Use 001 for Sent Exchange, incorporate location in F2 message e.g. "69 {EXCH}"  

 
 

6. ARCI QRP Contests & Michigan QRP Contest 

The ARCI contest supports 7 ARCI QRP Contests. The Michigan QRP Contest has almost the same 
rules. Several other QRP contests use the same exchange type, although the scoring may be different.  

 Window: Select Log type  

o Log Type: ARCI  

o Mode Category:  
 CW  

 for Spring QSO party ; HootOwl Sprint ; Summer Homebrew Sprint ; 
Fall Qso Party ; Holiday Spirits ; Michigan QRP Contest  

 SSB  
 for Winter Fireside  

 MIXED  

 for Topband Sprint  
o Sent Exchange:  

 First Part  
 State abbreviation for USA stations. Example: CT  
 Province abbreviation for VE stations. Example: ONT  
 Country abbreviation for non US or VE stations. Example: DL  

 Second Part  

 ARCI number for ARCI members  
 Sent power for non-ARCI members  

 Log Window: Mult = DXCC Mult2 = Section (State or Province) Example: CT  

 Power is recognized by containing a non numeric character. Example: 100W is power, 100 is a 

member number  

 There is a check on provinces and states, no check on countries. The program will give a 
proposal for the country prefix if non VE or K  

 No calculations made for power multi or Bonus Points, this has to be done by the operator 

after the contest on the summary sheets  



 Select CW, SSB or MIXED as 'mode Category 'to have the multiplier window work correctly  

 It is allowed by the program that stations work each other in the contests in both modes even 
when only CW or SSB is allowed according the rules. We assume the operator knows the 
rules...  

 
 

7. ARI International DX Contest 

The ARI International DX contest can be configured for Italian stations and DX stations.  

 Window: Select Log type  
o Log Type: ARIDX  
o Sent Exchange:  

 001 for non-Italian stations  
 Your Province for Italian stations  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an Italian station or a DX station.  

8. ARRL 10 Meter contest 

The ARRL 10M contest can be used by K/VE stations and DX stations.  

 Window: Select Log type  

o Log Type: ARRL10M  
o Sent Exchange:  

 Your state/province - for K/VE stations Example: NY  
 001 - for DX stations (non K/VE)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX station or a W, KH6, KL7, VE station.  

All non-28 MHz spots are marked as unworkable.  

9. ARRL 160 Meter contest 

The ARRL 160M contest can be used by K/VE stations and DX stations.  

 Window: Select Log type  
o Log Type: ARRL160 (not ARRL160M if shown)  

o Mode Category: CW  
o Sent Exchange:  

 ARRL/RAC section - for ARRL/RAC stations Example: VI  
 DX stations should enter their prefix or "DX" here. By this contest's rules, DX 

stations only send a report, no further exchange, but this is needed 
nonetheless to ensure a correct Cabrillo file for submission to the contest 
sponsors. This means that you should not use the {EXCH} macro in your 

messages for this contest, so if you are using the default CW messages, they 
will need to be edited.  



 

The callsign in the Station Information dialog (>Config >Change Your Station Data >Call) determines 
if you are a DX station or an ARRL/RAC station.  
The ARRL/RAC stations can be found at http://www.arrl.org/contests/sections.abv.html  

 
The contest module accepts for /MM and /AM stations as ITU zones: R1, R2 or R3. 
 
All non-160 meter spots are marked as unworkable.  

10. ARRL Field Day contest 

The ARRL Field Day contest can only be used by US (K, KL and KH) & Canada stations (i.e. there are 
more FD contests outside the US & Canada which are not supported).  

 Window: Select Log type  
o Log Type: FD  

o Sent Exchange:  
 Your Class Your section  

 

Here is word from Dan Henderson from the ARRL contest branch on using Cabrillo for your log 
submission.  

Field Day is not included in the Cabrillo format. It has no way to mark/indicate power sources, GOTA 
station callsigns, bonus points, NTS traffic messages, etc. Also, Field Day only requires Dupe Sheets, 
not full logs. It is perfectly acceptable to include the Cabrillo log in lieu of the Dupe Sheets, but Field 
Day must have a completely filled out Summary sheet that includes all necessary information. This 
can be done with a "reasonable facsimile" electronically. However, since "proofs of bonus" (i.e. copies 
of letters to newspapers, visitor logs, photos, etc) are abundantly provided, most people find it easier 
to do Field Day via the regular mail - and use a combined system of part-electronic added to the paper 

summaries. Anything received electronically for Field Day will be receipted but we may have to 
manually follow up if we can't get the basic required information from the email.  

73' Dan Henderson, N1ND  

Here are some logging tips from Jim, VE7FO  

Q: I always have a problem with the FD GOTA log. Besides just logging the QSO, I also need to ID the 
operator, the operators age and the GOTA coach. This has always been difficult to reconstruct after 
the fact. Any body else seen this?  

A: Just give the GOTA coach the following responsibilities: When a new op comes on have him hit 
CTRL-O and enter his call or name followed by a space and his age. This gets two of the vital pieces of 

info into the log. Require the coach to keep a log of his on and off times at the GOTA position; or you 
could add the coach's call at the end of the CTRL-O stuff too. You'll have to increase the width of the 
operator column in the log in order to see all this.  

 

Changing from HF to VHF (and back) 

ARRL Field Day is unusual because it includes both HF and VHF bands. Switching bands with Ctrl+ 
PgUp/Dn won't work for band changes across the HF/VHF divide, but you can operate, dupe and log 
on the right band by one of two methods:  

 if your radio is interfaced, just change bands on the radio and your log will follow.  



 If your radio is not interfaced, just type an appropriate frequency in KHz (such as 50125 for 6 

meters) in the Entry window's callsign field) and press Enter.  

In either case, the upper part of the Available Window will continue to display the HF bands, without 
data, but the lower part of that window, as well as your bandmaps, will display spots for the band you 
have selected.  

 
 

11. ARRL International DX contest CW / SSB 

 Window: Select Log type  
o CW  

 Log Type:ARRLDXCW  

 Mode Category: CW  
 Sent Exchange: Your state/province - for K/VE stations Example: NY  
 Sent Exchange: Power - for DX stations (non K/VE) Example: 200  

o SSB  
 Log Type:ARRLDXSSB  
 Mode Category: SSB  

 Sent Exchange: Your state/province - for K/VE stations Example: NY  
 Sent Exchange: Power - for DX stations (non K/VE) Example: 200  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 

if you are a DX stations or a W/VE station.&&&  
The default power for DX stations is:  

 100 Watts - Default  

 200 Watts - For the following countries: UA, UA2, UA9, UK, UN, UR, R1FJ, R1MV  

 400 Watts - For the following countries: G, GM, GI, GD, GM, GM/s, GW  

 500 Watts - For the following countries: I, IS, IT9  

 
Give 'Space' when the cursor is in the callsign field to have the 'Power' field filled with the default 

power. The default power will only be entered when the Power filed is empty. If you type another 
power level, it will replace the default power that the program put in there.  

Some stations give K or KW for 1000 watts. You don't have to enter 1000, just type K. The log 
checking software from the contest committee will understand.  

Call History for DX stations: When Call History is selected and a file is imported with US callsigns 
and States, the bandmap will be checked against the log and the callhistory and colored for mults 

when needed. So incoming spots will be colored when they are a qso, dupe or mult and found in the 
log or callhistory.  

12. ARRL November Sweepstakes CW / SSB 

 Window: Select Log type  
o CW  

 Log Type: SSCW  

 Mode Category: CW  



 Sent Exchange box: Precedence Year first licensed ARRL/RAC section Example: 

B 70 EMA (and in this order!) (NOTE: This is not what you should send over 
the air; it's what you must enter into the Sent Exchange box in order to create 
a valid Cabrillo file)  

 F5 key: !  
 F2 key: Right click on the CW message buttons and change F2 to: # B 

* 70 EMA.  

If you have separate run & S&P buttons, you may have to do it twice.  

o SSB  
 Log Type: SSSSB  
 Mode Category: SSB  
 Sent Exchange box: Precedence Year first licensed ARRL/RAC section Example: 

B 70 EMA (and in this order!) (NOTE: This is not what you should send over 
the air; it's what you must enter into the Sent Exchange box in order to create 

a valid Cabrillo file)  

 F5 key: !  
 F2 key: Normally, you should plan on saying callsigns and serial 

numbers and then pressing F2 for the rest of a pre-recorded exchange 
message, beginning with your precedence, then your call sign, your 
check (year licensed) and your section.  

 

Don't put a serial number in the Sent Exchange box 

Sweepstakes is unlike other serial number contests in that it does not require you to enter "001" in 
the Sent Exchange. In fact, you must not do that. Instead, use the # macro in F2 on CW, and nothing 

about the serial number in the Sent Exchange box. Also, do not use the {EXCH} macro in your 
Sweepstakes exchange messages. 

 

We do not recommend using voicing of serial numbers in SSB contests, because experience has shown 
that serial numbers enunciated as "one two three one", no matter how skillfully recorded, are never as 
easily understood as "one thousand two hundred thirty one." However, if you want to explore voicing 
of serial numbers or callsigns, click here.  

1. Entering Exchanges  

Entering the exchange in Sweepstakes is different than for any other contest because SS uses a five 

part exchange (nr, prec, call, ck, section). After you enter the call and move to the Exchange window 
(either by ESM or by pressing the Space Bar) you can enter all five in one window, and the program 
will do its best to interpret what you enter.  

If you use a Call History file in Sweepstakes (don't forget to check Call History Lookup on the Config 
menu), when you enter a callsign that is in the file, it will pre-fill the Check (CK) and Section (SEC) for 

you and position the cursor one space behind the pre-filled information. All you need to do, then, is 

type the Serial Number and Precedence as you copy them. They look like they are in the wrong order, 
but look above the Exchange textbox for the line of small black type. You'll see it in the correct order, 
as it will be entered in your log.  

You do not need to type the call again unless you had it wrong the first time, in which case you'll see 
the program magically correct it (again in the small black type. If the program thinks there may be a 
problem, it tries to signal that by changing the type color to blue, so be aware of that. If something is 
screwed up, we recommend backspacing to the point where the exchange (or part of one) looks right 
again, and then re-entering the information. You should never have to wipe, or highlight and hit 
Delete.  

http://n1mm.hamdocs.com/tiki-index.php?page=Using+Stored+Messages+in+Contests+-+and+the+Function+Key+Message+Editor&structure=N1MM+Logger+Documentation#SSB_Function_Keys


There are a couple of important rules. You must always enter the Serial Number and Precedence as a 

single element - e.g. "23B" not "23 B". This helps the program tell a check from a serial number. 
Otherwise, you should put a space between elements. This is probably a good habit to get into, 
because when you need to correct something you have copied (see below) you'll need to do this.  

Example of playing WAV files using ESM.  

Put a single space in the message column of the F5 line of the SSB function key table.  

Speak the callsign of the station you're working and press Enter. Your exchange.wav file should be 
something like "Bravo, N1MM, Check 61 Connecticut"  

2. Correcting what you copied  

This is where N1MM Logger gives you a real advantage in Sweepstakes. The basic idea is that you 

never have to tab or space back to the Callsign field, or to space back in the Exchange field, to make 
corrections. The basic rule is simply to type your correction at the end of the Exchange string you 
have already copied. This includes callsigns.  

You can confuse the parser (the routine that generates the black type above the Exchange window). 
Here are easy rules you can apply to help with proper parsing:  

 When you are correcting a Callsign in the Exchange field - make sure you set it off with 
spaces.  

 If you need to enter or correct a Serial Number, enter it with the Precedence, without a 
space between - e.g "99B", not "99 B". Similarly, enter the Check and Section as another 
"couplet" - e.g., "54WV", not "54 WV". If you do this, we don't think you will be able to make 
the parser get it wrong.  

 
 

13. ARRL Rookie Roundup 

Rookies (operators licensed 3 years or less) work everyone; non-rookies work only rookies. Rookie 
status is determined by the 2-digit licensing year as entered in the Sent Exchange field of the Contest 
Setup Window (reached by File > New Log in Database or Open Log in Database). BOB 08 WV in the 
Sent Exchange field tells the program Bob's a rookie; BOB 54 WV tells it he's not.  

You do not need any special suffix on rookie calls (do not use /ROK. This is a rule change since the 

first running). Rookies are encouraged to call "CQ Rookie Roundup" on phone and "CQ RR" on CW and 
digital modes. Non-rookies should call "CQ Rookies" on phone and "CQ R" on CW or digital modes. A 

sample CW function key definition (macro) file is here . The macros are set for Rookies, non-rookies 
will need to change the CQ RR to CQ R.  

Log the exchange in order — name, 2-digit year, and state. Check the space immediately above the 
exchange field, where the program will indicate how it has "parsed" the exchange, and correct if 
necessary. 4-digit years should not be sent or logged - it will only cause confusion  

Score summaries are due within 72 hours of the end of the contest - 2359 Wednesday evening UTC, 

or 1859 EST. Use the "Submit your score" link under "Score submission" at the ARRL web page  for 
the RR. ARRL says logs are not required or accepted.  

 Window: Contest Setup  

http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=12
http://www.arrl.org/rookie-roundup


o Make sure that you have entered your 2-digit licensing year in the Sent 

Exchange field.  

 Select Log Type  

o Log Type: RRSSB, RRRTTY, RRCW (pick the appropriate one)  
o Sent Exchange: Name, two-digit check (year first licensed), and State or Canadian 

Province, Mexican call area (XE1-4), or DC (examples: PETE 54 WV, BOB 67 XE1, 
MARY 09 NU, ANN 10 DX  

 
 

14. Asia Pacific Sprint Contest CW / SSB 

 Window: Select Log type  

o CW  
 Log Type: APSCW  

 Mode Category: CW (spring and fall)  
 Sent Exchange: 001  

o SSB  
 Log Type: APSSSB  
 Mode Category: SSB (summer)  
 Sent Exchange: 001  

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX stations or an Asia-Pacific station.  

15. Baltic contest 

The Baltic contest can be configured for stations from the Baltic countries (ES, YL, LY) and DX 
stations.  

 Window: Select Log type  

o Log Type: BALTIC  
o Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX station or a Baltic station.  

16. Black Sea Cup International 

 Window: Select Log type  

o Log Type: BSCI  
o Mode Category: MIXED  

o Sent Exchange: ITU Zone  
 HQ stations: IARU society abbreviation  
 BSCC members: membership number, e.g. BS17  

 
 
 

17. CNCW Spanish contest 



The CNCW contest (EA CW NATIONAL CONTEST) is only for Spanish stations operating inside the 
national territory.  

 Window: Select Log type  
o Log Type: CNCW  

o Mode Category: CW  
o Sent Exchange: Spanish Province letters Example: SG  

 
 

18. CQ M International DX contest 

 Window: Select Log type  
o Log Type: CQM  

o Mode Category: Select what category you enter (SSB, CW or Mixed)  
o Sent Exchange: 001  

 

Special country file needed 

The CQM contest uses a special country list. In order to score properly, you need to import that 

country list into the database you will be using. First download the file by selecting >Files >Additional 
Support Files and copying the file Cty-CQM.dat to your N1MM Logger directory. Then, from the Tools 
menu, select Import Country List from Downloaded File, and select the special Cty-CQM.dat file. 
Import it, and you're good to go.  

After the contest, don't forget to re-import the wl_cty.dat file to restore the normal country list.  

If you discover after the contest that you skipped this step, just be sure to submit your log in Cabrillo 
format, and the organizers will re-score it for you. Alternatively, you can import this special country 

list and re-score the contest (Tools > Rescore), but if you do that be sure to back up the 
database first, just in case.  

 
 

19. CQSA SSB Contest 

 This contest uses the Cabrillo 3.0 log file format so be careful to check the Contest Setup 
Window (File > Open Contest) to make sure you have filled in appropriate entry class, etc.  

 
 

20. CQ 160 Meter DX contest CW / SSB 

 Window: Select Log type  

o CW  
 Log Type: CQ160CW  
 Mode Category: CW  

o SSB  
 Log Type: CQ160SSB  

 Mode Category: SSB  
 Sent Exchange:  



 Your state/province - for K/VE stations Example: NY  
 Your country abbreviation - for DX stations (non K/VE)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX stations or a W/VE station.  

All non-160 meter spots are marked as unworkable. Spots are marked with state from call history 
lookup as mults (if needed) in Bandmap and Available windows.  

21. CQ World Wide DX contest CW / SSB 

 Window: Select Log type  

o CW  
 Log Type: CQWWCW  

 Mode Category: CW  
 Sent Exchange: Your zone Example: 14  

o SSB  
 Log Type: CQWWSSB  
 Mode Category: SSB  

 Sent Exchange: Your zone Example: 14  

 The default zone values for US (K,N,W,A) stations are  
o Zone 3 - If number in callsign is 6 or 7  
o Zone 4 - If number in callsign is 5 or 8 or 9 or 0  

o Zone 5 - If number in callsign is 1 or 2 or 3 or 4  

 The default zone values for Canadian (VE) stations are  
o Zone 1 - If callsign starts with: VY1  
o Zone 2 - If callsign starts with: VE2, VO2  

o Zone 3 - If callsign starts with: VE7, VC7  
o Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6, VA3  
o Zone 5 - If callsign starts with: VO1, VE1, XJ1, VY2  

 Give 'Space' when the cursor is in the 'Callsign' field to have the 'Zone' field filled with the 

default value  

 The default zone will be selected, so that if you type another zone, it will replace the numbers 
that the program put in there  

 For US users, Ctrl+Up/Ctrl+Dn doesn't stop at US stations  

 US spots are not grayed out for Canadian users  

 Don't show and count own countries as workable in the Bandmaps and the Available window  

 A new zone will be shown in red in the Entry window  

 Band changes  

o The allowed band changes are 8 for all CQ Contests  
o The band change counter is reset to 0 on first contact after the top of the hour  

 The program will look up the zone if the call has been changed, provided no zone was typed 
by the user  

 
 

22. CQ World Wide WPX contest CW / SSB 

 Window: Select Log type  
o CW  

 Log Type: CQWPXCW  
 Mode Category: CW  

 Sent Exchange: 001 i.e Serial number Example: 001  



o SSB  

 Log Type: CQWPXSSB  
 Mode Category: SSB  
 Sent Exchange: 001 i.e Serialnumber Example: 001  

 Leading zeros are being forced on sent & received serial numbers  

 Multi-Single and Multi-Two entries have a single set of serial numbers across all bands; per 

the rules, in multi-single a single sequence of serial numbers is generated regardless of band.  

 Band changes (per hour)  
o The allowed band changes are 8 for all CQ Contests  
o The band change counter is reset to 0 on first contact after the top of the hour  

23. CIS contest - CW / SSB 

The Commonwealth of Independent States Contest where everybody can work everybody for QSO and 
multiplier credit.  

 Window: Select Log type  

o Log Type:  
 CW: CISCW  
 SSB: CISSSB  

o Sent Exchange:  
 CIS stations: CIS area code Example for Moscow City: RU11  
 Non-CIS stations: 001  

 
 

24. Cup of the Russian federation RFC contest CW / SSB 

The RFC Contest is an internal Russian contest only between Russian stations.  

 Window: Select Log type  

o Log Type:  
 CW: RFCCW  
 SSB: RFCSSB  

o Sent Exchange:Grid Example: 115  

 
 

25. CWops Mini CWT 

Several 1-hour mini-contests each month. Each 1-hour segment is a separate contest.  

 Window: Select Log type  
o Log Type: CWOPS  
o Mode Category: CW  
o Sent Exchange:  

 Name and membership no. (members)  
 Name and state/province/country (non-members)  

 
Call history lookup for member numbers in the Sect or Exch1 field of the call history file is supported.  



26. CWops CW Open 

Three four hour contests - August 31 (UTC) in 2013  

 Window: Select Log type  
o Log Type: CWOPSOPEN  
o Mode Category: CW  

o Sent Exchange:  
 Serial no. and name (e.g. 001 JOHN)  

 
 

27. DARC 10 meter contest 

 Window: Select Log type  

o Log Type: DARC10M  
o Mode Category: MIXED or CW (depends on the entry class)  
o Sent Exchange:  

 DL stations:DOK Example: A12  
 non DL stations: empty  

 

Call history lookup for DOK's is supported. Make a text file with Call and DOK and import this in the 
program. See the chapter Before the Contest for information how to use Call History and how to 
create the text file. During the contest "Call History Lookup" has to be enabled under the Config 
menu. When a station (which is in the Callhistory lookup table) is entered, pressing SPACE when the 
cursor is in the callsign field will enter the DOK in the section field.  

The contest manager from the DARC 10 meter contest approved and will accept the files made by 
N1MM logger and likes to receive:  

File  How to make...  Exported 

Log file  
>File >Export >Export to File (Generic) >Generic File Output sorted by 
time  

[callsign].txt 

Summary 
sheet  

>File >Export >Print Score Summary to File  [callsign].sum 

 Send the "Generic File Output sorted by time" as a txt-File named with your call like 
DL8WAA.TXT  

 Don't forget your used own call, category and if you are a DL station: own sent DOK. This can 
be put in the Email or sent in the Cabrillo file.  

 
 

28. DARC Weihnachtswettbewerb XMAS contest 

The DARC Weihnachtswettbewerb is a contest on December 26 from 08.30-10.59 UTC between any 
station on 40 and 80 meters.  
The DARC contest manager for the Xmas contest accepts the standard generic file as log together with 
the summary sheet..  



 Window: Select Log type  

o Log Type: XMAS  
o Mode Category: MIXED  
o Sent Exchange:  

 DL stations:Serial number + DOK Example: 001 A12  
 Non-DL stations: Serial number Example: 001  

 
During the contest info about suspicious DOK's are shown in the info bar and written to the Notes 
filed.&&&  
After the contest check >View >Notes for the following situations:  

 "DL station non DARC member" - no DOK is given (DL station who is not a DARC member)  

 "DL station with DOK length 1" - DOK length is only one  

 "DOK with only numbers" - no letters in DOK  

 
 

29. DIG contest CW / Phone 

 Window: Select Log type  

o Log Type:  
 CW: DIGCW  
 SSB: DIGSSB  
 Sent Exchange: anything as it is not being used (DIG members could enter 

their DIG number here)  

 
 

30. Elecraft QSO Party 

 Window: Select Log type  

o Log Type: EQSO  
o Mode Category: Mixed  
o Exchange: State/Province/Country, Rig code + Rig serial number, or Power (non-

elecraft rigs)  
 e.g. K3 serial #1234 would send 31234  

 
 

31. European Sprint CW/ SSB 

 Window: Select Log type  

o CW  
 Log Type: EUSCW  
 Mode Category: CW  
 Sent Exchange: Serialnumber & Operator name Example: 001 Tom  

o SSB  
 Log Type: EUSSSB  

 Mode Category: SSB  
 Sent Exchange: Serialnumber & Operator name Example: 001 Tom  



 

Example: The Exchange key (F2) can look like this: de * # {Exch} where "#" is current QSO Number 
and "{Exch}" is the Operator name.  

32. EU HF Championship 

 Window: Select Log type  

o Log Type: EUHFC  
o Sent Exchange: Last two digits of the year of operator's first official amateur radio 

license Example: 82 (for 1982)  

 
 

33. Field Day Region 1 

The Region I field day contest can be configured for Region 1 stations and DX stations. Supported are 
the rules for stations in Belgium, Germany, United Kingdom (**), Netherlands, Switzerland, Ireland 
(only CW), Italy, Slovenia (S5) and Russia (UA, UA2, UA9).  

 Window: Select Log type  
o Log Type: FDREG1  
o Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call) determines 
if you are a Region 1 supported station or not and if you are /P etc. or not..  

N1MM Logger checks whether the callsign used is a portable or a fixed station by checking the callsign 
in the Station dialog under config! So using a /P, /M etc there could make a difference in scoring!  

United Kingdom: The ModeCategory selects the CW or the SSB version of the contest. The rules 
between the CW and the SSB version are very different.  

34. First Class Operators Club (FOC) Marathon - members only 

 Window: Select Log type  

o Log Type: FOCCW  
o Sent Exchange:membership number  

 
The calculation of bonus points for working the same station on 5 (10 additional points) or on 6 bands 
(an extra 5 points) is not supported by the program. 
 

Martin/OK1RR and John/G3WGV have posted contest routines to rescore the contest from a Cabrillo 
file to a fully correct (including the 5/6 band bonuses).  

35. First Class Operators Club (FOC) QSO Party 

 Window: Select Log type  

o Log Type: FOCBWQP  
o Sent Exchange:  

 FOC members: RST, Name and FOC Number  
 Non-members: RST and Name  



 
 

36. GACW WWSA CW DX contest 

The GACW WWSA CW DX contest can used by South American stations and DX stations.  

 Window: Select Log type  
o Log Type: GACW  
o Mode Category: CW  

o Sent Exchange: Your zone Example: 14  

 The rules are almost equal to the CQWW contests.  

 Default zones for US (K,N,W,A) and Canadian (VE) stations apply  

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a SA station or a DX station.  

37. Gagarin Cup 

 Window: Select Log Type  

o Log Type: GCUP  
o Mode Category: CW  
o Sent Exchange: Your ITU zone (not CQ zone e.g., 8 rather than 5 for eastern USA)  

 

Special country file needed 

The Gagarin Cup contest uses a special country list. In order to score properly, you need to import 

that country list into the database you will be using. First download the file by selecting >Files 
>Additional Support Files and copying the file Cty-CQM.dat to your N1MM Logger directory. Then, 

from the Tools menu, select Import Country List from Downloaded File, and select the special Cty-
CQM.dat file. Import it, and you're good to go.  

After the contest, don't forget to re-import the wl_cty.dat file to restore the normal country list.  

If you discover after the contest that you skipped this step, just be sure to submit your log in Cabrillo 
format, and the organizers will re-score it for you. Alternatively, you can import this special country 
list and re-score the contest (Tools > Rescore), but if you do that be sure to back up the 
database first, just in case.  

 
 

38. HA DX Contest 

The Hungarian DX Contest can be configured for HA stations and DX stations.  

 Window: Select Log type  
o Log Type: HADX  

o Sent Exchange:  
 non-HA stations: 001  
 HA stations  

 HADXC members: HADXC membership number Example: 101  
 Other HA stations: two letters county code. Example: GY  



 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a HA station or a DX station.  

39. Helvetia Contest 

The Helvetia Contest can be configured for HB stations and DX stations.  

 Window: Select Log type  
o Log Type: HELVETIA  

o Sent Exchange:  
 001 for non-HB stations  
 001 Your Canton Example: ZH for HB-station  

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX station or a HB station.  

40. High Speed CW Contest 

The HSC CW contest can be configured for members and non-members.  

 Window: Select Log type  
o Log Type: HSCCW  
o Mode Category: CW  
o Sent Exchange:  

 Non-members: NM  
 Members: HSC-Membershipnumber  

 

 

41. Holyland Contest 

The Holyland Contest can be configured for 4X stations and DX stations.  

 Window: Select Log type  

o Log Type: HOLYLAND  
o Sent Exchange:  

 001 for non-4X stations  
 Your Area Example: E15RH  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX station or a 4X station.  

42. IARU Radiosporting contest HF 

 Window: Select Log type  

o Log Type: IARU  
o Mode Category: CW or SSB or MIXED  
o Sent Exchange: IARU member society abbreviation for IARU member society HQ 

stations and IARU International Secretariat club station  
 AC for IARU Administrative Council  



 "R1," "R2," and "R3" for the three IARU regional Executive committees  
 ITU zone for all other stations Example: 27  

 
The zone is prefilled while typing the callsign to allow multipliers to be shown while typing the callsign.  

Call history lookup for HQ multipliers is supported. Correct format is: W1AW,,,,ARRL,,,  

 Starting with program version 11.07.02, a Reverse Call History Lookup feature has been 
implemented for HQ multipliers in this contest  

o If Call History Lookup is enabled, and a Call History file containing HQ multipliers has 

been loaded, then when an HQ multiplier or partial HQ multiplier (at least two letters) 
is entered into the exchange field and there is no call sign in the call sign field, the 
Check window will display all call signs in the Call History file with that same HQ 
multiplier  

o The call signs are entered in magenta color, and can be clicked on with the mouse to 

transfer one of them to the call sign window  
o If there is a partial call sign in the call sign field, possibly using wild cards for missing 

characters, the list of call signs displayed will be limited to those matching the partial 
call sign  

 
 

43. IOTA Islands On The Air Contest 

 Window: Select Log type  
o Log Type: IOTA  
o Sent Exchange:001 NA123 (default exchange) Be sure to delete the "NA123" from 

the Sent Exchange field in the Contest Setup dialog if you are not an island 
station, because otherwise the program's scoring will be incorrect.  

 Your own IOTA reference must be in the form XXYYY where XX = letters and 
YYY = numbers.  

As of March 29, 2012, RSGB has announced some significant rule changes. Corresponding 
changes in N1MM Logger have been implemented.  
NB: The syntax for the sent IOTA reference must be in the form XXYYY where XX = letters and YYY = 
numbers. Example: 001 EU001 and not 001 EUTT1 or 001 EU1. If you wish to transmit your exchange 
with cut numbers or without leading zeros in the IOTA reference, you will have to hard-code your 
desired exchange in your exchange messages instead of using the {EXCH} macro  

 The received IOTA reference does not need the dash (-) when logged. Example: Enter EU123 

in the IOTA field, not EU-123. The Cabrillo output will have the - added automatically  

 The IOTA contest has many multipliers and therefore the program will only show worked IOTA 
references and add a new IOTA reference when a new multiplier is worked. In the Multiplier 

window, choose the "Sect" tab  

o If Call History Lookup is enabled, and a Call History file containing IOTA references has 
been loaded, then when an IOTA reference or partial IOTA reference is entered into 
the exchange field and there is no call sign in the call sign field, the Check window will 
display all call signs in the Call History file with that same IOTA reference  

o The call signs can be clicked on with the mouse to transfer one of them to the call sign 
window  

o If there is a partial call sign in the call sign field, possibly using wild cards for missing 
characters, the list of call signs displayed will be limited to those matching the partial 
call sign  



 Starting with program version 11.07.03, if your Call History file contains a list of country 

prefixes and island codes for those DXCC countries that are entirely on islands (e.g. G, VK), 
then entering a call sign from one of these countries will automatically pre-fill the IOTA 
reference field with the most common IOTA code for that country (see the IOTA Call 
History.txt file distributed with the program - country references are at the end of the file)  

o Since in many cases there is more than one IOTA reference for the same country, you 
must be prepared to override this code; when the cursor is moved to the IOTA field, 
the second (numerical) part of the IOTA reference code is highlighted to make it easy 
to override the default number  

 
Note for multi-operator stations:  

 The IOTA contest allows multi-operator stations to use two radios, one of which is only allowed 

to work new multipliers. This is similar to the Multi-Single category in the CQ WW and CQ WPX 
contests; note that in this contest, the two stations are allowed to transmit simultaneously  

o If you wish to make use of two radios, in the contest setup window choose the MULTI-
ONE category (Operator category MULTI-OP and Xmtr category ONE). Select 
Networked-Computer Mode on both computers (see the Networked-Computer Support 

section of the manual for detailed instructions)  
 At the multiplier-only station, check the following options under Config > 

Networked-Computer Tools: Is Mult Station, and Don't work non-mults  
 If you wish to allow simultaneous transmitting at both stations, check the 

Block my Tx Only if Other Stn Transmitting on Same Band&Mode (Multi-One) 
option. This will allow both transmitters to operate simultaneously. This option 

is not "sticky", i.e. you will have to check it every time you restart the 
program, otherwise your radio will be blocked from transmitting whenever the 
other radio is transmitting. WARNING: DO NOT rely on the software 
lockout to protect your radios - the lockout is intended only to facilitate 
compliance with contest rules, and should not be relied upon to protect against 
damage  

 
 

44. International Naval Contest 

 Window: Select Log type  

o Log Type: NAVAL  
o Sent Exchange:  

 Club+Membership number for Naval Club member, e.g. PN007  
 001 for non-Naval Club member  

 

2009 contest rules: are here .  

2010 dates: 8 / 9 May - CW and SSB, 15/16 May - PSK and RTTY;  

45. JA domestic contests 

This is a general contest class for Japanese domestic contests and only for use by JA stations.  

 Window: Select Log type  

o Log Type: JAdomestic  
o Sent Exchange: Section + class Example: 25M or 10L  

http://www.nra.pt/php/bdContestRules.php?lang=en


 
General rules:  

 Japanese stations may only work Japanese stations  

 Example exchange numbers in ALL JA contest with assuming as follows.  

o I am in Osaka with 100W output and another party is in Tokyo with 10W.' 
send:59925M receive:59910L  

o I am in Okinawa with 1KW output and another party is in Sapporo in JA8 with 50W. 
send:59947H receive:599106M  

 Dupe and multiplier examples  
o 20 mtr JE1CKA 10H SSB 1 point + multiplier  
o 20 mtr JE1CKA 10H CW 0 points dupe, no multiplier  
o 20 mtr JE1CKA 10H SSB 0 points dupe, no multiplier  

 Same station should counts for 1 point only once on each band regardless of mode.  

 The multiplier counts once on each band regardless of mode.  

 When the SentExchange does not end on H, L, M or P then there is no Powercode check.  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a JA station.  

46. JIDX contest 

This JIDX contest contest can be configured for Japanese stations and DX stations.  

 Window: Select Log type  

 CW  

o Log Type: JIDXCW  
o Mode Category: CW  
o Sent Exchange:  

 non-JA stations: CQ Zone number Example: 14 (01 to 40)  
 JA stations: Your Prefecture Example: 34 (01 to 50)  

 SSB  
o Log Type: JIDXSSB  
o Mode Category: SSB  
o Sent Exchange:  

 non-JA stations: CQ Zone number Example: 14 (01 to 40)  
 JA stations: Your Prefecture Example: 34 (01 to 50)  

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a JA or a DX station.  

47. JT DX Contest 

 Window: Select Log Type  
o Log Type: JTDX  
o Mode Category: CW or SSB, select one only  
o Sent Exchange: CQ Zone (e.g., 5, 14, 23, etc.)  

 
 

48. King of Spain Contest 



The King of Spain contest can be configured for EA stations and DX stations.  

 Window: Select Log type  
o CW  

 Log Type: KINGEACW  

 Mode Category: CW  
 Sent Exchange:  

 non-EA stations: 001  
 EA stations:Your Province Example: AV  

o SSB  
 Log Type: KINGEASSB  

 Mode Category: SSB  
 Sent Exchange:  

 non-EA stations: 001  
 EA stations:Your Province Example: AV  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX station or a EA station.  

49. Logbook of the World Contest CW / SSB 

 Window: Select Log type  
o Log Type:  

 CW: LOTWCW for the Digital part of the contest (LOTWRTTY)  
 SSB: LOTWSSB  

o Sent Exchange:  
 For North American stations: State/Province abbreviation Example: CT  
 For non North American stations: Countryprefix  

 
 

50. LZ DX Contest 

The LZDX contest can be configured for LZ stations and DX stations.  

 Window: Select Log type  
o Log Type: LZDX  
o Sent Exchange:  

 non-LZ stations: ITU zone  
 LZ stations:Your District abbreviation Example: BU  

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX station or a LZ station.  

51. LZ Open and LZ Sprint Contests 

Supports all three versions of the contest (LZ Open contest, LZ Open 40 meter Sprint contest and LZ 
Open 80 meter Sprint contest)  

 Window: Select Log type  
o Log Type: LZOPEN  
o Sent Exchange: 001  



o Select LZOPEN contest. The Sent Exchange in the "contest selection window" is 001 or 

#.  
o Your F2 exchange message should be: {EXCH}{LASTEXCH} or #{LASTEXCH}  
o Since it is required, the program will always send leading zeros for this contest. 

Unchecking the leading zeros box in Configurer will have no effect  
o When a callsign is in the Entry Window, the Info Window displays the time since you 

last worked the station  
o If you have a radio interface enabled, the bandmap colors of the callsigns will update 

when you can work the station again for points  
 Set the Bandmap Packet Spot Timeout greater than 30 minutes  

o Do not enter received cut letters into the exchange box. They will not be converted to 

numbers  
o Read the contest rules  
o Submit the contest results with the Cabrillo output  

 
The 30 minute time period is computed per the organizers instructions. That is to ignore the seconds 

of the logged QSO when computing the 30 minute interval. The 30 minute interval is computed from 
the last QSO on the current band so it is not recommended to log a contact that will not produce any 
points.  

LZ Open and LZ Sprint contests display the sent exchange on the Entry Window status line. This 
addition expects that the {LASTEXCH} macro is used as required by these contests.  

52. Manchester Mineira Contest 

The Manchester Mineira Contest by CWJF is the major CW contest in South America. Since 2011 this 
contest is now open to stations anywhere in the world.  

 Window: Select Log type  

o Log Type: CQMMDX  

o Mode Category: CW  
o Sent Exchange: Continent (e.g. NA), or Continent + M (member), Y (YL), Q (QRP) or 

G (multi-operator group)  

 
 

53. Michigan QRP Contest 

See the ARCI contest which uses almost the same rules. 
 
Supported are: January CW Contest ; Memorial Day CW Sprint ; July 4th CW Sprint ; Labor Day CW 
Sprint  

54. MiniTest CW Test 

Almost every week on Wednesday at 18 GMT and lasts only one hour. It has 6 time periods  
(10 minute each). Band: 3520 - 3570 kHz, mode: CW, exchange: RST+serial.  
Every QSO gives 1 point, multiplier: the number of unique calls during this hour of the contest. 
Classes: 1- club station, 2 - SO, A- power > 100 W, B - power <= 100 W, 3 - SWL. The results can be 

submitted at 19.00 GMT on 3720 KHz (SSB) or on 3541 KHz (CW).  
The submitted information (QSO number, multiplier, class) will look like this: "125 36 A". The results 
are published here:  
http://www.minitest.narod.ru/2009/2009.htm  

http://n1mm.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Documentation#ARCI_QRP_Contests_REAL_AMP_Michigan_QRP_Contest


55. NA Sprint CW / SSB 

 Window: Select Log type  
o Log Type:  

 CW: SPRINTCW  
 SSB: SPRINTSSB  

o Sent Exchange: 001 Tom CT  
 Serial number, your name and your location (state, province or country) 

Example: PA1M DE N1MM 123 TOM CT K  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a North American station or a non-North American station.  

 Example function keys can be found in the Example Function Keys chapter  

 Check out the Macros chapter. The {PGUP} and {PGDN} macros are useful in the Sprint.  

o By Tom - W4BQF: Open config - Confiigure Ports.... - Other. Under the 'Other' tab, 
look at the right-most column, where you will see "CW Up/Down Arrow" and 

"PgUp/PgDown". These can be configured to QSY. Configure the Up/Down Arrow keys 
to QSY, say 2 kHz each time you press your keyboard up or down arrow keys. 
Configure PgUp/Down to QSY 'x' kHz, and then use {PGUP} or {PGDN} as a macro 
assigned to any of the function keys. Example: F10 Freq UP, {PGDN} {run} F11 Freq 
DN, {PGUP}{run} 
In my case "PgUp/Down" will move my frequency 5.5 kHz and the "CW UP/Down 
Arrow" keys set to QSY 1.5 kHz. A little tricky because {PGDN} actually moves you UP 
in frequency, but it works very well.  

 

 
N1MM Logger Sprint Survival Tips - Version 1.7, by N2IC  

I thought I would share what I have learned about customizing N1MM Logger for  
this contest.  

I'm not going to try to explain how to operate the Sprint - for this, there is  

an excellent writeup by Tree, N6TR here .  

What I will do is describe how to get the most out of N1MM Logger in the Sprint.  
My operation is SO2R, and my configuration is optimized for that mode. However,  
I'm sure you SO1R guys will pick up a few tricks from what I have done for SO2R.  

The most important thing is to get your options, windows and function keys set  
up correctly before the Sprint starts.  

The Options...  

Start up N1MM Logger using version 12.1.0 or later, and create a new SPRINTCW  
contest.  

I assume that your radio(s) are interfaced to N1MM Logger, so that N1MM Logger will automatically 

track the frequency of each radio. If you do not have interfaced radios, this configuration and function 
key assignment will not work correctly for the Sprint.  

In the Config menu, select the following options:  
- Enter sends message (ESM)  

http://n1mm.hamdocs.com/tiki-index.php?page=Function+Key+Examples
http://n1mm.hamdocs.com/tiki-index.php?page=Macros&structure=N1MM+Logger+Documentation
http://www.kkn.net/n6tr/sprint.html


- QSYing wipes the call & spots QSO in bandmap  

- Do Not Automatically Switch to Run on CQ Frequency  

- Show non-workable spots  

- SO2R->Toggle CTRLFx Macro  

The "Toggle CTRLFx Macro" can also be toggled using Ctrl+Shift+L. This is handy  
if you need to turn off {CTRLFx} during the contest.  

The Windows...  

These are the only windows I have on my screen:  

- Entry Window (one for each radio)  

- Visible Dupesheet (one for each radio)  

- Info  

- Log  

- Score Summary  

They all fit nicely on my small monitor. My screen layout is shown at  
http://www.kkn.net/~n2ic/sprint.bmp .  

The Visible Dupesheet is really nice once you get used to it. To see if a  

station is a dupe, you just scan the dupesheet with your eyes, rather than  
frantically type a call into the Entry Window.  

Open a Bandmap window. Right  
click and select "Packet Spot Timeout". Change the packet spot timeout to 1  
minute. That's right....1 minute. Hit OK. Now close the Bandmap window. Don't  
reopen it. It is of no value in Sprint, but it is important to change the packet  

spot timeout value to 1 minute. (Side note: This option should really be called  
"Bandmap Timeout" not "Packet Spot Timeout". It controls how long calls stay on  
the bandmap and the appearance of calls in the "on deck" frame of the Entry  
Window. We're obviously not using packet in the Sprint.)  

Notice that I do NOT have the "Available Mults & Q's" nor the Bandmap windows open.  

Function Keys ....  

Here are my function key definitions. I'll explain a few that aren't obvious.  

F1 CQ,{JUMPRX}cq na cq na * na  

F2 Exch,* # steve nm  

F3 TU,{CLEARRIT}t{END}{CONDJUMP}{STOPTX}  



F4 {MYCALL},*  

F5 Call,!  

F6 QSO B4,qso b4 *  

F7 Other Short,{CTRLF10}  

F8 Other Long,{CTRLF11}  

F9 GoS&&P,{S&P}  

F10,cq na * * na {RUN}  

F11 Long CQ,cq na cq na * * na {RUN}  

F12,-  

F1 S&&P CQ,{JUMPRX}cq na cq na * na  

F2 S&&P Exch,! # steve nm * {RUN}  

F3 S&&P tu,tu  

F4 S&&P,*  

F5 S&&P his call,!  

F6 S&&P,-  

F7 S&&P Other Short,{CTRLF10}  

F8 S&&P Other Long,{CTRLF11}  

F9 GoRun,{RUN}  

F10,cq na * * na {RUN}  

F11 Long CQ,cq na cq na * * na {RUN}  

F12,-  

-------  

 
With the Run F3 key, my "thank you" message is sent. When you QSY, you will  
automatically be changed to S&P mode. Do not include the {S&P} macro here - it  
will cause the last station worked to get "stuck" in the on-call frame of the  
Entry Window.  

With the S&P F2 key, as soon as I send my exchange, it immediate switches to Run  
mode.  



I can also force myself into Run and S&P modes with the F9 key.  

The F7 and F8 keys send CQ's on the "other" radio. This is very useful when the  
other station is sending his exchange, and you are going to lose the frequency  
(i.e. it will become "his" frequency). You can send a CQ on the other radio,  
while he is sending his exchange. Then, when he finishes sending his exchange  
and you need to send your "thank you" message to finish the QSO, all you have to  

do is hit Enter, which will stop the CQ on the other radio, and send your Run F3  
message on the active radio. After the "thank you" message is sent, the {CONDJUMP} macro in the 
Run F3 message will move your entry focus to the "other" radio, so that you will be ready to copy a 
new caller on the radio you were CQing on.  

When I'm CQing on the active radio, but simultaneously doing S&P on the other  
radio, and hear a new station, I can hit the Enter key. This will stop the CQ, and send my call on  
the other radio.  

One thing you need to do is keep an eye on where your transmit and receive focus  
is (the red and green dots on the Entry Window). When you're doing SO2R in the  
Sprint, there will be times where your focus is not where you might expect it,  
or want it. Always be ready with the \ and Pause keys to jump between radios.  

Yes, this takes lots of practice, and you will make mistakes. The Thursday night  
NCCC Sprints are good practice for this.  

NA Sprint CW by Kenny, K2KW  

North American Sprint CW is just a few hours away, and thought I would take a moment to help 
others get their CW messages ready. Your messages may differ slightly from mine, but I just wanted 

to highlight what's happening on the F2 and F3 messages which are the key setup items for Sprint. 
The F2 exchange is set up to give you the correct sequence for this contest using ESM, and the 
exchange sequence varies based on if you are Calling CQ, or you answered someone while S&P. F3 is 
used to confirm the message, and change your state from S&P to Running, or Running to S&P. The 

{RUN} and S&P} macros are inserted at the end of the F3 message, and will automatically change 
your state, and thus exchange sequence.  

I have also changed the Up/Down Arrow to move 1.5 kHz, giving you an "instant QSY" per the rules. 
You may choose to use a wider QSY increment, but the goal was to offer you an idea for QSYing so 
you can abide by the rules.  

If you are not aware of the uniqueness of the Sprint exchange and QSY rule, check out: 
http://n6tr.jzap.com/sprint.html and http://www.ncjweb.com/sprintrules.php  

73 and CU in the contest,  

 Set the Exchange:  

o >File >Choose Which Contest to Log >Sent Exchange  
 # yourname yourstate  

 Example: # KEN CA  

 Set QSY distance:  

o In the >Config >Configurer >Other window, change the CW Up/Down Arrow Incr = 
1.5  

 That gives me an instant QSY somewhat greater than the minimum QSY 
required after you leave a frequency. Any value over 1 kHz is recommended  

 
 



56. SprintNS and Sprint Ladder 

Window: Contest Setup  

These contests are identical except for the dupe rule that is incorporated. SPRINTNS does not allow no 
in-band dupes, while SPRINTLADD allows dupes with one intervening QSO.  

 Log Type:  
o SPRINTLADD. SPRINTNS  

 Sent Exchange: 001 Tom CT  

o Serial number, your name and your location (state, province or country) Example: 
PA1M DE N1MM 123 TOM CT K  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a North American station or a non-North American station.  

See NA Sprint above for more information (rules for the NS Sprint and Sprint Ladder are derived from 
but slightly different than NA Sprint, so be advised!).  

57. NAQP North American QSO Parties CW / SSB 

 Window: Select Log type  
o CW  

 Log Type: NAQPCW  
 Operator Category: SINGLE-OP or MULTI-TWO  

 For Multi-Two see the extra info below!  
 Mode Category: CW  
 Sent Exchange:  

 For North American stations - Operator name and station location 

(state, province, or country) Example: Tom CT  
 For non-North American stations - Operator name only Example: 

Thomas  
o SSB  

 Log Type: NAQPSSB  
 Operator Category: SINGLE-OP or MULTI-TWO  

 For Multi-Two see the extra info below!  

 Mode Category: SSB  
 Sent Exchange:  

 For North American stations - Operator name and station location 
(state, province, or country) Example: Tom CT  

 For non-North American stations - Operator name only Example: 
Thomas  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a North American station or a non-North American station.  

MULTI-TWO operating: When changing operator you have to use Ctrl+O to set the NAME (not Call) of 
the operator. This name set with Ctrl+O will be used in the Cabrillo file. So from the Sent Exchange 

only the state is being used but the name is needed. (Example: Tom CT). The macro {OPERATOR} 
can be used to automatically switch WAV files (in SSB), for more info see the Macro section.  

58. NRAU Baltic Contest 



This contest is only for stations from the following countries: ES, JW, JX, LA, LY, OH, OH0, OX, OY, 
OZ, SM, TF, and YL  

 Window: Select Log type  
o Log Type:  

 CW: NRAUCW  
 SSB: NRAUSSB  

o Sent Exchange: Section Example: AA  

 
When a station is logged the following checks are made:  

 Is the logged station from a valid country ( ES, JW, JX, LA, LY, OH, OH0, OX, OY, OZ, SM, TF, 
and YL)  

 Is the entered section a valid section (from NRAU.sec)  

 A warning is given when a qso is made an another band than 7 or 3,5 MHz. A note is made 
with the logged qso.  

 
 

59. Oceania Contest 

Supported are the CW and SSB version of the contest  

 Window: Select Log type  

o Log Type:  
 CW: OCEANIACW  
 SSB: OCEANIASSB  

o Sent Exchange: 001  

 
Note: The rules have special instructions for not complete portable callsigns so a prefix can not be 
deduced normally. Adding numbers like the rules state is not supported and should be done by editing 
the log file (afterwards). Example: N8BJQ/PA would be PA but is not a valid prefix and should become 
PA0 (add the zero).  

60. OK OM DX contest 

The OK-OM DX contest can be configured for OK/OM stations and DX stations.  

 Window: Select Log type  

o Log Type: OKOMDX  
o Mode Category: CW (it is a CW only contest)  
o Sent Exchange:  

 Non-OK/OM stations: 001  
 OK/OM stations: district abbreviation Example: BPZ  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an OK/OM station or a DX station.  

61. PA beker contest 



The PA-beker contest is a local Dutch contest on 40 and 80 meters. The text below is in Dutch.  

 Window: Select Log type  
o Log Type:  

 CW: PABEKERCW  

 SSB: PABEKERSSB  
o Sent Exchange:  

 QSL regio Voorbeeld: 27 (en niet R27)  

 QSL regio ingeven en invoeren zonder R dus 27 en geen R27  

 Log, Entry en Score summary geven de juiste scores.  

 De multiplier window (Ctrl+J) geeft onder 'Sect' de gewerkte QSL regios alleen daar wordt de 
eigen regio wel getoond indien gewerkt.  

 Er zit geen beperking op banden (dus let op dat je op 40 en 80 meter logt).  

 In te zenden log bestanden:  

File  How to Make...  Exported 

Log file  >File >Export >Export to File (Generic)  [callsign].txt 

Summary sheet  >File >Export >Print Score Summary to File  [callsign].sum 

 
 

62. PACC contest 

The PACC contest can be configured for PA stations and DX stations.  

 Window: Select Log type  
o Log Type: PACC  

o Sent Exchange:  
 Non-PA stations: 001  
 PA stations: Your province Example:DR  

 
PA stations ONLY have to import an adapted CTY.DAT file for the PACC contest so the right multipliers 
will be used. In the 'Entry window' go to 'Tools', and select 'Import country list from downloaded file'. 
This adapted country file can be downloaded from the N1MM website, under 'Files', select in the 
menu: 'Additional Support Files'. Don't forget importing the original CTY.DAT file again when entering 
other after the PACC contests.  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX station or a PA station.  

The PACC contest committee approved and will accept the files made by N1MM logger and likes to 
receive:  

File  How to Make...  Exported 

Cabrillo Log file  >File >Generate Cabrillo File  [callsign].log 



 

Note icon PA stations: Vergeet niet in de cabrillo log file te vermelden de klasse waarin je mee doet 
en de afdeling voor het afdelingsklassement!  
Note icon PA stations kunnen tijdens de PACC contest op 160 meter gelijktijdig meedoen aan de RSGB 

1.8 MHz CW contest in de avonduren. N1MM accepeteert na het volgnummer ook de districtscode. 
Voorbeeld: 599 123AA (NB, geen spatie tussen het ontvangen volgnummer en de district code)  

63. Portugal Day Contest 

The Portugal Day contest can be used for Portuguese stations (CT, CT3 or CU) and DX stations.  

 Window: Select Log type  

o Log Type: PORTUGAL  
o Exchange:  

 District or Autonome Region for Portuguese stations  
 001 for DX stations (serialnumber)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Portuguese station or DX.  

64. QCWA QSO Party 

 Window: Select Log type  

o Log Type: QCWAQSO  
o Mode Category: Mixed  
o Exchange: Year licensed, Name, Chapter (or state/province/country)  

 The unique scoring for operating within 50 miles of the special events station and the one QSO 
rule for your home chapter are not supported.  

65. RAC Canada Day Contest / RAC Canada Winter Contest 

With the same set of rules both contests are supported. These RAC contests can be used for VE 
stations and DX stations.  

 Window: Select Log type  

o Log Type: RAC  
o Exchange:  

 Province or territory for stations in Canada  
 001 for VE0 stations and stations outside Canada (serialnumber)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are from Canada, VE0 or outside Canada.  

66. RAEM CW contest 

The RAEM Contest is CW only and has no multipliers, only points. These points are calculated based on 
QSO points and distance between the stations (based on exchanged coordinates). Extra points are 

added for polar stations. Extra bonus points for RAEM memorial stations are not added because the 
call RAEM has no number is will not be accepted by the program. Use RAEM99 or so and update the 
log and score (300 additional points) after the contest. 10 band changes per hour are permitted, and a 
band change counter is activated when this contest is selected.  



 Window: Select Log type  

o Log Type: RAEM  
o Mode Category: CW (it is a CW only contest)  
o Sent Exchange: 001 & Coordinates Example: 001 53N6O  

 The own coordinates is the second token in Sent Exchange without spaces 
(one 'word')  

 
Coordinate rules: These rules apply for the 'Sent Exchange' and also when entering a coordinate in the 
Entry Window.  

 Own coordinates: Second token in Sent Exchange without spaces (one 'word')  

 First part is the Longitude with at the end N or S Example: 53N  

 Second part is the Latitude with at the end W or O (not E) Example: 6O  

 As a total this makes: 53N6O  

 
Log and rescore: To generate the log use the Generic log file and the Score summary. Always 
rescore and check the log. If a qso has 1 point then the Received exchange is not correct. If there are 
QSOs who have gotten 2 points then your Sent Exchange is not correct. Update your Sent Exchange in 
the contest setup and rescore. Check again.  

Call History: The call history can be used but... the coordinates have to be entered in the Name field 
of the Call History table. This is the only field which is capable of handling all different coordinates 
1N2W but also 67N169O  

 
 

67. REF contest CW / SSB 

The REFContest can be configured for stations in REF countries and DX stations.  

 Window: Select Log type  

o Log Type:  
 CW: REFCW  
 SSB: REFSSB  

o Sent Exchange:  
 For DX stations: 001  
 For stations in REF countries - Department (F and TK) or Prefix (all other REF 

countries)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX station or a station in a REF country.  

68. RF Championship 

The RF Championship is a contest for stations of the Russian Federation only.  

 Window: Select Log type  

o Log Type: RFCHAMP  
o Mode Category: Select mode used in contest (CW, SSB)  
o Sent Exchange: 001  



 

Please add the zone to sent in the Function keys. The points are calculated based on your callsign and 
the callsign received.  

69. RSGB 160 Meter CW Contests 

The RSGB 1.8MHz CW Contests can be configured for RSGB stations and DX stations.  

 Window: Select Log type  
o Log Type: RSGB160CW  

o Mode Category: CW (it is a CW only contest)  
o Sent Exchange:  

 For DX stations: 001  
 For stations in the UK - 001 & District Example: 001 ZE  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are in the UK or not.  

Serial numbers must be logged from UK stations.  
There is no check by the program if a serial number is entered for non-UK stations. This because there 
are often several other EU contests going on at the same time and an entrant in those may not sent a 
serial number just an area code like DR (PACC) or a French department like 78. If a non UK station 

sends a serial number it must be logged in the received serial nr field, if it sends a code like DR is 
must be logged in the districts field.  

70. RSGB 21/28 MHz contest 

The RSGB 21/28 MHz CW Contests can be configured for RSGB stations and DX stations  

 Window: Select Log type  

o Log Type: RSGB2128  
o Sent Exchange: 001  

 
 

71. RSGB 80 Meter Club Championship 

The RSGB 80 Meter Club Championship can be configured for RSGB stations and DX stations  

 Window: Select Log type  

o Log Type: RSGB80MCC  
o Sent Exchange: 001  

 
 

72. RSGB Affiliated Societies Team Contests AFS 

The RSGB Affiliated Societies Team Contests can be configured for RSGB stations and DX stations  

 Window: Select Log type  



o Log Type:  

 CW: RSGBAFS-C  
 SSB: RSGBAFS-S  

o Sent Exchange: 001  

 
 

73. RSGB Club Calls contest 

The RSGB Club Calls contest can be configured for RSGB stations and DX stations  

 Window: Select Log type  

o Log Type: RSGBCLUB  
o Sent Exchange: 001  

 
 

74. RSGB Commonwealth contest 

 Window: Select Log type  

o Log Type: RSGBBERU  
o Exchange: 001 (HQ stations enter 001 HQ in this box, with a single space 

between the 001 and the HQ)  

 
This contest is for British Commonwealth stations only. The callsign in the Station Information dialog 
(Config >Change Your Station Data >Call) determines whether you are in the Commonwealth or not.  

There are no multipliers in this contest. Contacts with Commonwealth stations outside your own 
Commonwealth Call Area (CCA) are worth 5 points; contacts within your own call area or with non-
Commonwealth stations are worth zero points. There are bonus points for the first 3 contacts on each 

band in each CCA (25 points instead of 5 points). HQ stations send HQ after the serial number in the 
exchange (enter HQ in the HQ block in the entry window when you work one of these), and are also 
worth 25 points. You can work one HQ station plus 3 bonus stations in each CCA on each band for 25 
points each; any additional contacts in that CCA are worth 5 points each. You can work the HQ station 
in your own call area for bonus points. HQ stations can work all CCAs including their own.  

Bonus stations (first three contacts in a CCA, and HQ stations) are shown in red in the Entry window; 
other Commonwealth stations are in blue. Non-Commonwealth stations and stations in your own CCA 
are shown in grey (including the HQ station in your CCA until the HQ box in the Entry window is filled 
in). If you wish to work and log a zero-point QSO, use Ctrl+Alt+Enter to force-log the contact.  

To have the Multiplier window show only Commonwealth Call Areas, go to the Files > Additional 

Support Files on this web site and download file cty-BERU-20100315.dat or cty-BERU-20110301.dat 

into your N1MM Logger program folder, then use the Logger's Tools > Import country list from 
downloaded file menu item to import this list into the database. You will have to close and reopen the 
Multiplier window for this change to take effect. The Multiplier window only shows whether one station 
has been worked in that CCA; to see whether a station would score bonus points on other bands, see 
the next paragraph. Remember to reload the normal wl_cty.dat file into the database after 
the contest is over and your log has been exported!  

If you have the Available Mults and Qs window and the Check window both open, the Check window's 
title bar will indicate the QSO and Bonus status of stations on all bands as they are entered in the 



Entry window. For example, MUL: 160 80 10 Q: 40 would indicate that the station in the Entry window 

would be a bonus station (25 points - first three QSOs in a CCA) on 80m and 10m, a new QSO (5 
points) on 40m, and it has already been worked on 20m and 15m (ignore the indication for 160m; 
that's not valid in this contest). The Available window does not need to be visible, i.e. it can be hidden 
behind another window, but the Check window title bar must be visible to make use of this feature.  

Call History Lookup should be turned off in this contest to prevent state/section information for other 
contests from prefilling the HQ box.  

HQ stations are recorded in the "Sect" column in the log. Call areas are recorded in the "Exch" column. 

In the Score Summary window, the "Cty" column indicates the number of bonus-point QSOs (first 
three QSOs in a CCA), and the "Sec" column indicates the number of HQ stations worked.  

Contest Type 

Note: The old RSGBJUBILE log type that was formerly used for this contest has been discontinued as 

of Logger version 10.3.0 - use RSGBBERU instead. 

 
 

75. RSGB SSB Field Day & RSGB National Field Day 

The Region I field day contest can be configured for RSGB and DX stations.  

 Window: Select Log type  

  

o Log Type: FDREG1 <----  
o Mode Category: The ModeCategory selects the CW or the SSB version of the contest. 

The rules between the CW and the SSB version are very different..  
 CW for the CW Field day contest  

 SSB for the SSB Field day contest  
o Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a RSGB station or not and if you are /P etc. or not..  

N1MM Logger checks whether the callsign used is a portable or a fixed station by checking the callsign 
in the Station dialog under config ! So using a /P, /M etc there could make a difference in scoring!  

76. RSGB Low Power Field Day 

The RSGB Low Power Field Day can be configured for RSGB stations and DX stations  

 Window: Select Log type  

o Log Type: RSGBLP  
o Mode Category: CW (it is a CW only contest)  
o Sent Exchange: 001 Power Example: 001 2W5  

 
 

77. RSGB ROPOCO 



The RSGB ROPOCO is an internal RSGB contest and only available for G ,GD ,GI ,GJ ,GM ,GU and GW 
stations.  

 Window: Select Log type  
o Log Type: ROPOCO  

o Mode Category: CW (it is a CW only contest)  
o Sent Exchange: Your postcode (taken from station info)  

 
NOTE. Use the macro {LASTEXCH} to send the postcode from the previous qso. Example F2 key: 
<<<5nn>>>{LASTEXCH}  

78. Russian District Award contest 

The Russian District Award contest can be configured for Russian stations and DX stations.  

 Window: Select Log type  

o Log Type: RDAC  
o Sent Exchange:  

 Non-Russian stations: 001  
 Russian stations: District code by RDA list (for example TB02)  

 Call History exchange field: Exch1  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Russian station or a DX station.  

79. Russian DX contest 

The Russian DX contest can be configured for Russian stations and DX stations.  

 Window: Select Log type  
o Log Type: RUSSIANDX  
o Sent Exchange:  

 Non-Russian stations: 001  
 Russian stations: Your oblast code (two letters)  

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Russian station or a DX station.  
Example: Default RU1A would have SP, in the call hisotry RU1A could be added so it will give the 
correct exception LO.  
When a station is found in Call history it will use the section/oblast from it. IIf not found in Call history 
it will use the default oblast.  

Example Call history 
 
RA1AR,,,, LO 

 
RU1A,,,,LO 
 
RU6FA,,,,KM  

Log submission notes:  



'CATEGORY-OVERLAY'. In the RDXC you can submit one log and have it scored as two single band 

entries. Like operating 10m during day time and 160m at night. Now, this is particular to this contest 
and you need to submit your log like this:  

CATEGORY-OVERLAY: [operator-cat] [band-cat] [power-cat] [mode-cat] The category overlay of the 
log submission when appropriate. In RDXC, two single band entries are allowed from one participant. 
In this case, one entry must be listed under CATEGORY tag, the other one under CATEGORY-
OVERLAY, such as:  

 CATEGORY: SINGLE-OP 80M HIGH MIXED  

 CATEGORY-OVERLAY: SINGLE-OP 15M HIGH MIXED  

 
 

80. Russian Radiosport Team Championship 

 Window: Select Log type  

o Log Type:  
 RRTCT (invited teams)  
 RRTC (everyone else)  

o Sent Exchange:  
 three-letter code (teams)  
 ITU zone (others)  

 
 

81. Russian YL/OM contest 

 Window: Select Log type  

o Log Type: RUSYLOM  
o Sent Exchange:  

 73 for male stations (OM)  
 88 for female stations (YL)  

 
YL stations (female) may only work OM stations (male) and vice versa.  

82. SAC contest CW / SSB 

The Scandinavian Activity Contest can be configured for Scandinavian stations and DX stations.  

 Window: Select Log type  

o CW  
 Log Type: SACCW  
 Sent Exchange: 001  

o SSB  
 Log Type: SACSSB  
 Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Scandinavian station or a DX station.  



83. Spanish Towns contest 

The Spanish Towns contest can be configured for EA stations and DX stations.  

 Window: Select Log type  
o Log Type: CME  
o Mode Category: SSB  

o Sent Exchange:  
 non-EA stations: 001  
 EA stations: Your INE code Example: 18145  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX station or a EA station.  

84. SPDX contest 

The SPDX contest can be configured for Polish stations and DX stations.  

 Window: Select Log type  
o Log Type: SPDX  
o Multi-Op set Operator Category = MULTI-ONE  
o Sent Exchange:  

 001 for non-SP stations  
 Your province Example: B for Lubuskie  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Polish station or a DX station.  
The band and mode change counter is shown in the Info window.  

85. Stew Perry Topband Distance Challenge 

The Stew Perry contest is CW only.  

 Window: Select Log type  

o Log Type: STEWPERRY  
o Power category:  

 HIGH when > 100 Watt  
 LOW when 10 - 100 Watt  

 QRP when less than 10 Watt  
o Sent Exchange:  

 Your four character grid Example: JO33  

 
The point calculation in the log is multiplied by a power multiplier for each qso point value. This factor 

depends on the selected Power category chosen. HIGH is multiplied by a factor 1, LOW by a factor 2 
and QRP by a factor 4.  

86. Scandinavian Young Ladies Radio Association SYLRA 

 Window: Select Log Type  
o Log Type:SYLRA  

o Mode: Mixed+Dig  
o Sent Exchange: 88 for YLs, 73 for OMs  



 
 

87. UA1DZ Memorial Cup 

The UA1DZ Memorial Cup can be used by St.-Petersburg and Leningrad region stations and DX 
stations.  

 Window: Select Log type  
o Log Type: DZCUP  

o Mode Category: Select mode used (CW, Mixed, SSB)  
o Sent Exchange:  

 For non-St.-Petersburg and Leningrad region stations: 001  
 For St.-Petersburg and Leningrad region stations: RDA (administrative area)  

 
 

88. UBA contest CW / SSB 

The UBA DX Contest can be configured for ON stations and DX stations.  

 Window: Select Log type  
o Log Type:  

 CW: UBACW  
 SSB: UBASSB  

o Mode Category: CW  
o Sent Exchange:  

 For non-ON stations:001  
 For ON stations: 001 + Your province Example: 001 OV  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an ON station or a DX station.  

Log submitting for non Belgian stations:  

Before submitting your log look at this page  from Franki, ON5ZO  
 
The information tells how to update the category in the Cabrillo file so you are placed in the right 
category.  
The UBA contest manager approved and will accept the Cabrillo output made by N1MMLogger.  

IMPORTANT NOTE quoted from the rules as found on the UBA website, regarding log submission:  

Log submission info from UBA: The UBA likes to receive a Cabrillo file  

Special Setup for Belgian participants:  

How to include your province abbreviation in the Cabrillo output?  
This MUST be done for both SSB and CW contests! Go to Config > Change your Station Data > State 
field: fill in the abbreviation for your province (OV, VB etc). It is VERY IMPORTANT to do this, as it will 
determine what you have sent in the log (Cabrillo output), and it is needed by the UBA Contest Team. 
The official abbreviation (2 letters) for the Belgian Provinces is to be found on the UBA site, under the 

http://www.on5zo.be/2012/02/12/how-to-edit-your-cabrillo-for-the-uba-dx-contest/


rules for HF contests.  
Non-Belgian participants can leave this field 'as is', it is only used for Belgian contesters.  

How to send your province abbreviation after the serial number in CW?  
When you have selected to begin a new log for the UBA DX CW contest, you must change the F2 
button message to send your province.  
This is done like this; go to: Config > Change Packet /CW/SSB/Digital Message buttons > Change CW 

buttons In the right column, second row, there is:<<<5nn>>>{EXCH} This means the incrementing 
serial number. Now you have to add your province abbreviation, preceded by a slash (/). It should 
look like this: <<<5nn >>>{EXCH}/OV or <<<5nn >>>{EXCH}/AN  

WARNING: Never change the '001' as the Sent Exchange value in the Select Log Type window, as the 
software will no longer send serial numbers!!!  

89. UBA ON contest 

The UBA ON Contests (4 in total) can be configured for ON stations and DX stations.  

 Window: Select Log type  

o Log Type: UBAON  
o Mode Category: Select mode used (CW, Mixed, SSB)  
o Sent Exchange:  

 For non-ON stations:001  
 For ON stations - Serial + Your UBA gewest Example: 001 AAA  

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an ON station or a DX station.  

90. UBA Spring 

The UBA Spring contest (4 in total) can be configured for ON stations and DX stations.  

 Window: Select Log type  

o Log Type: UBASPRING  
o Mode Category: Select mode used (CW, Mixed, SSB)  
o Sent Exchange:  

 For non-ON stations: 001  
 For ON stations - Serial + Your UBA gewest Example: 001 AAA  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an ON station or a DX station.  

91. UBA Low Band Winter 

The UBA Low Band Winter contest (4 in total) can be configured for ON stations and DX stations.  

 Window: Select Log type  

o Log Type: UBAWINTER  
o Mode Category: Select mode used (CW, Mixed, SSB)  
o Sent Exchange:  

 For non-ON stations:001  
 For ON stations - Your UBA gewest Example: AAA  



 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an ON station or a DX station.  

92. Ukrainian Championship 

The Ukrainian Championship is run on CW, SSB and RTTY.(for Ukrainian stations only)  

 Window: Select Log Type  
o Log Type: UKRCHCW, UKRCHSSB, UKRCHRTTY  
o Sent Exchange: two-letter district designator, plus serial number - e.g., KV 001  

 
 

93. Ukrainian DX contest 

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian stations.  

 Window: Select Log type  

o Log Type: UKRAINDX  
o Mode Category: MIXED  
o Sent Exchange:  

 Oblast for Ukrainian stations Example: CH  
 001 for non-Ukrainian stations  

 
Note: Countries are counted per band for SSB, CW and RTTY, because RTTY is in a separate contest 
module they won't be counted correct when a station makes next to SSB and CW also RTTY q's or the 
other way around...  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an Ukrainian station or a non-Ukrainian station.  

94. UN DX Contest 

Kazakhstan Open Championship  

 Window: Select log type  

o Log Type: UNDX  
o Mode Category: Mixed  
o Sent Exchange:  

 District code for Kazakhstan stations Example: L17  
 001 for non-Kazakhstan stations  

 
 

95. Independence of Venezuela Contest 

 Window: Select Log type  
o Log Type: YV  
o Sent Exchange: 001  



 
The YV call areas are shown in the Multiplier window, choose the tab "Sect".  

96. WAEDC contest CW / SSB 

The WAEDC Contest can be configured for European stations and non-European stations.  

 Window: Select Log type  
o Log Type:  

 CW: WAECW  

 SSB: WAESSB  
o Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a European station or a non-European station.  

96.1. Introduction to WAE DX CW/SSB - based on an article originally written by Franki, ON5ZO 

WAE has something no other contest has, that you'll either love or hate - the exchange of information 
on past contacts in the contest, or QTC. Except in WAE RTTY, a QTC is a piece of traffic that can only 

be sent from stations outside EU to EU stations. EU stations will beg to get them. Why? Simply 
because for both sides each QTC is added to the QSO total. If N1MM makes a QSO with ON5ZO, then 
they both get 1 point for the QSO. If they decide to exchange 10 QTCs during this QSO, they each 
earn 11 points, 1 QSO + 10 QTCs. If, after the contest, ON5ZO made 300 QSOs, during which he got 
500 QTCs, his total count will be 800, multiplied by the number of multipliers.  

Each QTC has three main parts - time, call and received serial number of a QSO from the DX (non-
European) station's log. Suppose that N1MM logged ON5ZO at 0123UTC, and ON5ZO gave '012' as his 
serial number. Later in the contest, N1MM can send the QTC to 9A7P, for example.: He would send 
0123 ON5ZO 012.  

The rules say that a DX station can only send a total of 10 QTCs to a EU station, and that previous 
QSOs with the receiving station cannot be included in the batch of QTCs sent. Each QSO can only be 

sent once as a QTC, so a DX station can never have more QTCs sent than QSOs logged. A EU station 
however, can have many more QTCs than QSOs, as each non-duplicate QSO can yield up to 10 QTCs.  

A DX station can choose to send 10 QTCs to a single recipient during a single QSO, or piecemeal. In 
addition, QTCs do not have to be exchanged only during a non-dupe QSO. Suppose that early in the 
contest, ON5ZO is running, and N1MM calls on 20m. They have a regular QSO and exchange serial 
numbers. ON5ZO asks 'QTC?' but N1MM wants to make some QSOs first, so he declines. Towards the 
end of the contest, N1MM is running on 20m and ON5ZO finds him, ON5ZO sees that N1MM is a dupe 
because they QSO'd at the beginning of the contest. However, they didn't pass QTCs, so ON5ZO asks 
'QTC? de ON5ZO'. N1MM sees that they have worked but indeed: there were no QTCs sent then, and 

N1MM is now eager to send 10 of his QSOs as QTCs. They do it, and both go away happy. The second 
QSO doesn't count, of course, but the QTCs do.  

Each set of QTCs must be numbered. The sending station initiates the series of QTCs with a "batch" 
number like 'QTC 11/10', which means that it is the 11th batch sent by the DX station, and there will 
be 10 QTCs in the batch.  

All this sounds terribly complicated, doesn't it?. Fortunately, N1MM Logger takes care of all the clerical 
work. Let's look at how it works in detail, starting with  

96.2. WAE from Europe (ON5ZO as an example) 



 

After completing the QSO, where both stations exchange serial numbers, ON5ZO goes into QTC mode 
by pressing Ctrl+Z. On CW, this triggers the program to send 'QTC?' , to ask N1MM if he wants to 
send QTCs. In SSB, he would ask the other station "Do you have QTCs for me?" before pressing 
Ctrl+Z.  

The entry window then changes to this.  

 

The cursor starts in the N/N field, and ON5ZO logs the QTC batch number sent by N1MM, like '12/5'. 
ON5ZO then hits Space, moving the cursor to the next window. He sends 'QRV' (with his paddle) so 
N1MM knows he's ready to copy the QTCs. Each time he copies a part of the QTC, he presses Space. 
When the QTC is complete, he presses Enter and the program logs the QTC and sends a confirming 
'R', so N1MM knows ON5ZO got it OK and he can start transmitting the next QTC. In SSB, he would 

say "ready" or "Roger" at the appropriate times. When the series of QTCs is copied, ON5ZO presses 
F3, which is the Thank You message, the program will send this TU message and close the QTC-mode, 
returning to normal QSO mode.  

Note: Sometimes DX stations don't repeat the two digits representing the hour in the time part of the 
QTC. They just send the minutes, because the hour is the same for a bunch of QSOs. For example, the 
DX station might send '1134' for the time of the first QTC, but then send 35 and 36 for the next two.  

When copying QTCs at 36 wpm or faster, you don't have the time to do anything but type what you 
copy. If you copy two numbers, and the next character is a letter, you usually know you need to press 
Space and begin typing the callsign. N1MM Logger will automatically add the two hour digits to your 
log. This doesn't work so well with number prefixes like 5B or 4Z unless the sending station is careful 
with his spacing, and we'd welcome suggestions on a better approach.  

The QTC process works in either Run or S&P mode. The same keystroke, Ctrl+Z, turns it on and off (in 
case you need to abort QTC mode).  

96.3. WAE from the DX (non-Europe) side 

 
The process is even easier from the non-European (DX) side. If you want to send QTCs, you simply 
press Ctrl+Z. If you've forgotten to log the QSO first, Ctrl+Z will do it for you. A pop-up window 
opens, asking you how many QTCs you want to send to the EU station. The pop-up defaults to the 
maximum number you can send that station, but if you want to send fewer, you can just type in the 

new number over the old one. On CW, hitting Enter will send the 'QTC xx/yy' message. In SSB, you 



will have to say it. Once the EU-station indicates he's ready, usually with 'QRV' in CW, you hit Enter 

again to send (in CW) and log the first QTC. In SSB you will have to say the QTC. After pressing Enter 
to move the first (next) QTC into the Log window, the data items you will need to say in SSB, or that 
were just sent in CW, are in the SNT, RCV and Sent columns in the last (highlighted) line in the top 

part of the Log window. After each new QTC, hit Enter once more. This will place the next QTC into the 
highlighted line at the bottom of the top part of the log window and in CW, send it. When you're done, 
the program will stop sending. As soon as the European station acknowledges the QTC batch, you can 
press Ctrl+Z again to return to regular QSO mode, or you can press F3 to send your TU message and 
return to QSO mode.  

One important additional feature (CW) - Alt+Enter will repeat the last QTC sent, or if you're still in the 
'N/N' stage, it'll resend this information. So will the "=" key, which re-sends the last transmission 
regardless.  

96.3.1. Special considerations for SSB  

On SSB, you will have to say the QTC batch number and the contents of each QTC, and the guy on the 

receiving side will use that to fill in each window. This is the Entry window during receipt of a batch of 
QTCs by a European station.  

 

Note the color coding of the callsign field, which lists the sending station's callsign. This is a backup for 
the blue numbers, and helps receiving stations to make sure they are eligible to receive that number 
of QTCs from the sending station. The color scheme is the same as in the Bandmap. The receiving 
station must fill in the batch number and then fill in each field in turn, spacing between them and 
hitting enter when each QTC is complete.  

On the sending side, the same color coding is operative, but it is the receiving station's callsign that 
appears. To send a QTC, you look down at the Log window, specifically at the last (highlighted) line 

above the bar, at the columns headed SNT, RCV and Sent. The SNT column contains the time the 

original QSO was logged (the time part of the QTC); the RCV column contains the call sign; and the 
Sent column contains the serial number that the other station sent during the QSO. These column 
labels are really for QSOs, not QTCs, but making them do double duty like this avoids the need for 
extra columns in the log window. Do not send the other station the time in the TS column; that's the 
time the QTC was logged, not the time that is part of the data in the QTC.  



 

Once you have sent a QTC and got the acknowledgment from the other station, press Enter to display 
the next QTC to be sent. When there are no more QTCs to be sent, pressing Enter will no longer 
display a new QTC in the log window; press Ctrl+Z to exit QTC mode and return to normal logging.  

It's a good idea to make the lower pane big enough to accommodate 10 lines, because you will often 
be giving a 10-QTC batch, and when the receiving station asks you for a fill on the first QTC after you 

have just sent number 10, you'll be glad you did. However, the blue bar in the upper pane always 
shows the QTC you are currently sending, so you may find it easier to find in a hurry.  

96.4. Both sides 

After you enter the callsign of the other station in the entry window, a new line in blue type will 
appear in the bottom part of the Entry Window to tell you the QTC status.  

 

This line will appear regardless of whether you have worked the station yet, or not. The left-most 
number tells me how many QTCs we have exchanged. The center number tells me how many QTCs I 
still have available to send (up to the maximum of 10), and the last number tells me the total number 
available.  



The Entry Window and the Bandmap window contains visual cues about the QTC status of stations 

spotted in the bandmap. A special color scheme for spotted call signs has been implemented, as 
follows:  
RED: the station is a new multiplier on this band (same as in other contests)  

GREEN: this is a new station on this band, and you can also exchange QTCs with him (you are on 
different continents and you have not yet exchanged 10 QTCs with this station)  
BLUE: this is a new station on this band, but you have no more QTC's available that can be exchanged 
with this station (same continent, or you have already exchanged 10 QTCs)  
BLACK: this station is a dupe on this band, but you still could exchange QTCs with him for QTC points  
GREY: dupe, and there are no QTC that can be exchanged - this station is non-workable for any kind 
of credit, so just pass him by  

 
 

97. WAG contest 

The WAG contest is for German stations and non German stations.  

 Window: Select Log type  

o Log Type: WAG  
o Sent Exchange:  

 non-DL stations: 001  
 DL stations:  

 DARC member:DOK (example: V11)  
 non-DARC member:001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a German station or a non-German station.  

Non DL stations may only give a number.  
DL stations give a DOK (DARC members) or a number (non DARC members)  
For stations not giving an exchange put 000 in the exchange field  

- minimal DOK length is 2  
- 0 is allowed to be entered  

Note: When updating a DOK in the log window you have to update not only the Exchange but also the 
Section by hand....only when the qso is in the Entry window the program strips the Section (V) from 

the Exchange (V11) automatically.  
 

98. World Wide Iron Ham Contest 

 Window: Select Log type  
o Log Type: WWIH  
o Sent Exchange: RS/RST and CQ Zone  

Note: The contest allows CW, SSB and RTTY, but there are specific limitations on how often a station 
may change modes. See the rules for complete details.  

99. World Wide Peace Messenger Contest 



The Peace Messenger Contest can be configured for Peace Messenger Contest stations and non Peace 
Messengerstations  

 Window: Select Log type  
o Log Type: WWPMC  

o Mode Category: CW, SSB or Mixed  
o Sent Exchange PMC station: 001 PMC abbreviation Example: 001 ABI  
o Sent Exchange non PMC station: 001 NON Example: 001 NON  

 
 

100. WRTC contest 

The World Radiosport Team Championship (WRTC) contest is fully supported for use by on-site 
participant teams  

 Window: Select Log type  
o Log Type: WRTC  
o Sent Exchange: 001 i.e Serialnumber Example: 001  

 
The WRTC follows the rules for the WPX contest (please check above) with some additional WRTC 
specific changes below.  

 Check Partial is disabled from master.dta for this contest only.  

 Displaying "Unique" is disabled in the Check Partial window for this contest only.  

 
 

101. YO HF DX contest 

The YO HF DX contest can be used by Romanian stations and non Romanian stations.  

 Window: Select Log type  
o Log Type: YOHFDX  
o Sent Exchange:  

 non-YO stations: 001  
 YO stations: Romanian county abbreviation (two letters) Example: AR  

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Romanian station or a non-Romanian station.  

 

2.1.4.3 Setup QSO Parties - CW and SSB 

 2.1.4.3 Setup QSO Parties - CW and SSB  

o 1. Same weekend: 7QP, Indiana QSO Party, New England QSO Party  
o 2. Same weekend: NE, ND, and SD QSO Party 2013  
o 3. FL QSO party  
o 4. PA QSO party  



o 5. MARAC QSO Party  

o 6. Modifying and importing the QSO party county abbreviations  
o 7. Rover, Mobile, and County Line Support  

 7.1. Rover/Mobile Operation  

 7.2. QSO Party County Line Operation  
 Logging QSO Party County Line Stations  
 Operating From a County Line  

The program supports many US and Canadian QSO parties. Depending on the complexity of the rules, 
there may be minor scoring anomalies.  

 It is very important for proper operation of the program in QSO parties that the program 
"know" whether you are an in-area (state or province) or out-of-area participant. All QSO 
parties require different program operation and scoring rules for in-area and out-of-area 
participants.  

 
The program determines which you are from the ARRL Section that you have entered in the Station 

Data dialog (under the Config menu). When creating a new log for a QSO party, a message box will 
inform you whether the program thinks you are an in-state, or out-of-state participant, based on your 
ARRL section, so that you can correct things if anything is wrong.  

Non-US/VE stations should enter "DX" in the ARRL SECTION field. If you enter an ARRL section with a 
non-US/VE callsign, you will be warned to correct your Station Data before continuing.  

Effective with version 13.4.2, N1MM Logger offers greatly enhanced support for county-line 
operations, whether you are the in-state Rover on a county line or an out-of-state station 
wanting an easy way to log a QSO with a county-line rover. Full details are in the 
Mobile/Rover Support section below.  

 Window: Select Log type  

o Log Type: QSOPARTY  
 After selecting QSO Party, a list box shows up in the right-hand part of the 

contest selection dialog box, with buttons below it for importing and editing 
the section list. Click on the down arrow to choose the QSO Party you want 
(example image shows Hawaii HI) . When in doubt, do the import, to make 
sure you pick up any changes in the official abbreviations since the last 
running.  

 Example: The entry in the list of QSO Parties for the New England QSO Party is 
"NEWE" ("NE" is for the Nebraska QSO Party). Most of the entries in this list 
are states or provinces, except for the NEWE (New England) and MAQP (Mid-
Atlantic) entries.  

 
 
 

o Mode Category: MIXED  

o Sent Exchange:  



 The exchange depends on the QSO party. Most use county for in-area 

participants and state for those out of the area. Some use serial numbers as 
well.  

 Inside the selected State/Province - See contest instructions  

 Outside the selected State/Province - See contest instructions  
 if you need to send a serial number, enter 001 and the abbreviation for your 

location in the Sent Exchange field, to automatically increment the serial 
number for each QSO.  

 QSO Party Bonus Station Support - A few state QSO parties have "bonus stations", which you 
can work for extra point credit. When the state party has bonus station(s), the program will 
display the bonus station callsign list on program start and upon exiting the contest dialog.  

 

 

This list of bonus stations can be modified by the user by entering the command BONUS + Enter in 
the Entry Window callsign box.This will pop up a window where you can enter a revised list.  

Each callsign, and each variation (CALL, CALL/M, CALL/CTY) must be on the list in order to get credit 
for the bonus station(s).  

Note: The program does not store bonus station callsign changes, so if there are changes, you will 

need to re-enter the complete list each time you re-start the program or change logs to that QSO 
party. You can't simply enter the changes.  

To view the QSO's logged, enter the bonus station callsign in the Entry window and look at the lower 
portion of the Log window. To view the number of bonus stations counted in the score, export the 
Score Summary to a file.  

 

Help Keep Your Favorite QSO Party up to Date 

You can help keep N1MM Logger up to date for your favorite QSO Party by notifying the N1MM team of 
and changes in scoring, bonus stations, etc. Just post the changes in the N1MM Reflector, or send a 
Feature Request. Obviously, earlier is better. 

 Simple Call History Procedure - The steps for generating a Call History file from a previous 

QSO party are as follows:  
o Using program version 12.09.02 or newer.  
o Open last years QSO party contest log.  
o Click Tools, Clear Call History then Update with Current Log  

o Click File, Export Call History and export the data into a file.  
o Using NotePad add any new stations to the end of this file. The UserText field will 

allow you to make personal notes for specific callsigns. This display line appears below 
the Bearing information line. Make the height of the Entry Window taller to enable the 
display of this information.  



o Open the new QSO party contest log for the current year. Associating the saved call 

history file with this state party is possible using the Associated Files tab. Alternately, 
click on File, Import Call History after the contest is open.  

o Click on Config and place a checkmark in front of Call History Lookup.  

o The call history data is stored in the database. If you open a different contest and 
have Call History Lookup enabled, the program will use this data. So uncheck this 
option after the contest.  

o Users can combine exported call history files from several years. The recommended 

editor is NotePad. Some editors place non-ACSII characters in the file and this will 
cause import issues. Place the oldest contest at the top of the merged file. The import 
routine will merge the data and deal with duplicate entries. You can look at the result 
by exporting the call history and viewing it with NotePad.  

 
 

1. Same weekend: 7QP, Indiana QSO Party, New England QSO Party 

Three QSO parties - the 7QP (7th Call Area QSO Party), Indiana QSO Party, and New England QSO 
Party - are all on the same weekend. Since 2010, the program software allows users to log stations 
active in all three QSO parties and automatically determine the state multiplier from the received 
exchange (other contest county exchange). Log the exact exchange that is received and send the 
same Cabrillo output to all four contest sponsors. If you are an "in-state" user of one of these QSO 
parties, select the appropriate state party option in the QSO party contest selector. If you are "out-of-

state" for all contests this weekend, select the IN7QPNE option in the dropdown state selector. The 
instructions are the same, log the exchange that you receive and send the same Cabrillo file without 
editing to all three sponsors. All sponsors re-calculate the score of all submissions.  

N1MM supports the 7QP shorthand county exchanges (e.g.,"ORDES/JEF" or "IDFRA/UTCAC") and will 
log one QSO for each valid exchange.  

2. Same weekend: NE, ND, and SD QSO Party 2013 

For 2013 the ND, NE, and SD QSO Parties are held the same weekend but there are identical county 
abbreviations. After this is resolved and the sponsors accept combined logs and rescore, a combined 
QSO Party contest will be considered.  

3. FL QSO party 

For in-state users, the software automatically counts the first FL QSO as the FL multiplier.  

4. PA QSO party 

For in-state stations, the first EPA and WPA county worked will count both the county and the section 

multiplier in the score. Likewise, the first DXCC station worked counts as the single DX multiplier. See 
the information in the general section above for working bonus stations and county line stations. It it 
not necessary to include a Dupe Sheet with the contest submission when N1MM Logger is used for the 
PA QSO Party logging.  

5. MARAC QSO Party 



Sponsored by MARAC and also known as the U.S.Counties QSO Party. This QSO party has 3077 US 

county multipliers. Because of the screen area required, it is not recommended to display the counties 
in the Multiplier window. See the MARAC website for the county abbreviations.  

6. Modifying and importing the QSO party county abbreviations 

It is not expected that users will need to manually update or edit the county abbreviation list. It is 
easy to make a change that will effect the program operation or eliminate secondary information 
stored in other database fields during QSO logging. This is expecially true for the 7QP, IN, IN7QPNE, 

NEWE, and PA QSO parties. Please report any changes made by the QSO party sponsors to the 
development team several weeks prior to the contest.  

The county abbreviations stored in the database can be editted by opening the contest dialog (File, 

Open Log in Database) and select 'Edit Section List'. A sample edit window is shown below. The 
modification will remain in the current database until the developers make a change to any QSO party 
county abbreviation.  

 
 
 

To revert back to the original county and state abbreviation list provided by the developers, manually 
import the original files into the database with this procedure. Open the contest dialog (File, Open Log 

in Database) and select 'Import Section List'. It is not recommended that the user edit the state and 
county files provided by the developers.  

7. Rover, Mobile, and County Line Support 

N1MM Logger supports Rover/Mobile and County Line operation and for QSO party contests, the 
software contains features allowing the home station to quickly log the County Line station.  

7.1. Rover/Mobile Operation 

N1MM logger supports Rover or Mobile operation in the ARRL VHF contests and all QSO parties. It 
gives a Rover entrant a quick, easy way of changing counties, re-programming F-key messages in one 
step, and produce a single composite log for the entire event.  

Rover mode is enabled when one of these selections is made in the Contest Setup dialog: Operator 
Category = Rover or Station Category = Rover, Mobile, Expedition. The option that appears in the 



Contest Setup dialog will depend on the Cabrillo version requested by the sponsor. When Rover mode 
is enabled, the Entry Window title bar will include the RoverQTH as shown in the snapshot below.  

 

The operating location or RoverQTH can be set:  

 in the Station Data window, RoverQTH box. This box will automatically update when you use 

any of the other methods of setting RoverQTH below.  

 by right clicking on the county or grid in the Multiplier window and selecting "Set RoverQTH"  

 by typing CTRL+H  

 or by typing ROVERQTH in the Entry Window callsign box and pressing Enter. This opens a 
window to input the county designator, typically 3 or 4 characters.  

 
If the RoverQTH is typed when a QSO party is selected, one of the approved county abbreviations 
must be entered. When the RoverQTH is changed, the Entry Window title bar is updated and the 
Station Data, RoverQTH box is updated. This saves the RoverQTH for program restart.  

The {ROVERQTH} macro, when placed in your F-key messages will alway send the current RoverQTH 
string. If, for example, your F2 key is defined as "5NN{ROVERQTH}", the macro will substitute the 
RoverQTH operating location in place of {ROVERQTH}. The operating location will also appear in the 
Log window for each QSO. If the {COUNTYLINE} macro (explained below) is included in the F-key 
message it will be ignored when the program is in rover mode. This allows a station to operate as a 
rover and county line station during the same QSO party without editing the F-key messages.  

RoverQTH can be 10 characters long but most Cabrillo output is limited to five or six characters.  

When a new ROVERQTH is set in the Entry window, the program checks with the list of accepted 

county designators for the current QSO party. If for some reason an unlisted county designator is 
required, it can be entered in the RoverQTH Field of your Station Data page.  

7.2. QSO Party County Line Operation 

County line operation is popular with in-state operators in QSO parties because you can give out more 
than one county designator from a single location. The out-of-state operators receive two or more 
counties - often rare ones - in a single QSO, and earn multiplier credit for each county. If the QSO 
party exchanges serial numbers, be sure to read the QSO party rules to determine if the county line 
QSO's need to be logged with incrementing serial numbers.  



Logging QSO Party County Line Stations  

Regardless of whether you are an in-state or out-of-state participant, if you work a county-line 

station, simply log it using the DAD/JEF/WAL format in the Exchange field. Separate QSOs will appear 
in your log, one for each county.  

If the QSO party exchanges serial numbers, the same received serial number will be used when 
logging the separate QSO's. If the sending station sends a different serial number for each QSO you 
can Quick Edit the QSO and change the received serial number. It is also acceptable to manually log 
indivdual QSO's without the compound exchange (DAD/JEF/WAL) entry.  

A limitation of county line logging with the multiple county exchange is that the 'same callsign' can not 
be logged again on any band or mode until the computer clock advances beyond the time stamp of 
the last logged QSO. This will unlikely be an issue for the home station.  

Operating From a County Line  

Begin by selecting Operator Category = Rover or Station Category = Rover, Mobile, Expedition in the 

Contest Setup dialog. The county line mode is enabled by entering the word COUNTYLINE (note, no 
space) in the callsign field of the Entry window and pressing Enter. A pop-up box will appear, asking 

you to enter the county abbreviations, separated by commas. If the QSO party exchanges serial 
numbers, a prompt will appear asking if the serial numbers of the subsequent logged QSO's should be 
incremented. The answer to this is dependent on the QSO party rules. The simplest operation for 
everyone involved is no incrementing serial numbers for county line QSOs. There is additional 
information about the selection to increment serial numbers below but when the entry is complete, the 
counties will appear in the title bar of the Entry window so you can be sure they will be right in the 
log.  

 

You must enter the standard abbreviations specified by the contest sponsors. If you can't remember, 
Windows > Multipliers > Other selection will display a complete list for the current QSO party. Unlike 

your RoverQTH, which becomes part of your Station Data page, in County Line mode you will need to 



re-enter the string of counties if you restart the program.  

 

The use of stored messages, for CW or digital modes is simplified with the use of the {COUNTYLINE} 
macro which sends the string of counties seperated with a "/" character. Simply use the 
{COUNTYLINE} macro in place of the {EXCH} macro normally used in Run F2 and S&P F2. If the 
{ROVERQTH} macro (explained above) is included in the F-key message it will be ignored when the 
program is in county line mode. This allows a station to operate as a rover and county line station 

during the same QSO party without editing the F-key messages.  

 



Now you're ready to go. Each time you work a station from a county line, the program will transmit all 

the county abbreviations you have entered, separated by a "/" - in this example, "DAD/JEF/WAL". It 
will also enter a QSO in the log for each county line county listed under the Rover QTH column in the 
Log window. A Log window example is shown below operating from the DAD/JEF/WAL county line. 

Three stations were logged W1AW - CT, W4ZZ-BAK, and another county line station W4AAA at 
LEO/PAS/WAL producing 15 logged contacts.  

 

If you work a county-line station, you log it by simply by entering the received county abbreviations 
separated by a "/", as explained in the next section below. The logged result will be separate logged 
QSOs, one for each county combination.  

If incrementing sent serial numbers was selected when entering the county line counties, the following 
information is important. The program uses a serial number reservation system to insure that serial 
number does not change after it is reserved by a VFO, radio, or multi-user station. If a county line 

station chooses incrementing serial numbers and reserves a serial number on more than one VFO, 
radio, or multI-user station at the same time, the logged county line serial numbers will not be in 
sequential order. If the QSO party sponsor requires incrementing county line serial numbers and that 
they be in sequential order, the county line operation will be limited to one station, radio, and VFO. 
Contact the QSO party sponsor for the expectations of the sent and received county line QSO serial 
numbers.  

One limitation of county line logging is that the 'same callsign' can not be logged again on any band or 
mode until the computer clock advances beyond the time stamp of the last logged QSO. This will only 
be a concern when moving a station to another band or mode, operating from more than two county 
lines, and working another county line station.  

 

2.1.4.4 Setup VHF and Up Contests - CW and SSB 



 2.1.4.4 Setup VHF and Up Contests - CW and SSB  

o 1. ARRL August UHF Contest  
o 2. ARRL January VHF Sweepstakes  
o 3. ARRL June VHF QSO Party  
o 4. ARRL September VHF QSO Party  
o 5. CQ WW VHF Contest  
o 6. IARU Region 1 contesting - 50 MHz, VHF, UHF/Microwaves  
o 7. Marconi CW contest  

o 8. NAC Activity Contest  
o 9. REF Departments contest 50 Mhz  
o 10. VHF/UHF Helvetia 26 contest  
o 11. VHF HG OB contest  
o 12. VHF UA1DZ Cup  
o 13. VRZA - Nederlandse Locator Contest - WANLC  
o 14. YU DX Contest  
o 15. UKSMG sporadic-E competition  

In VHF and up contest it is the norm to give accurate signal reports. Use the Tab to go from the 

callsign filed to the signal report fields. You will note that it highlights the strength to allow quick 
modification of that.  

 

Feature 

When a grid is entered but no call, all QSOs with that grid will show in the lower part of log window 

 
 

1. ARRL August UHF Contest 

 Window: Select Log type  
o Log Type: ARRLUHFAUG  
o Sent Exchange: Your four character grid Example: JO33  

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only. 

 
Stations can be logged more than once from a different grid without being a dupe (for Rover stations). 
 
Dupe check on first 4 characters of grid. 
 
The score for Rover stations is not being calculated by the program!  

2. ARRL January VHF Sweepstakes 

 Window: Select Log type  

o Log Type: ARRLVHFJAN  
o Sent Exchange: Your four character grid Example: JO33  

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only. 
 
Stations can be logged more than once from a different grid without being a dupe (for Rover stations). 
 
Dupe check on first 4 characters of grid. 



 
The score for Rover stations is not being calculated by the program!  

3. ARRL June VHF QSO Party 

 Window: Select Log type  
o Log Type: ARRLVHFJUN  
o Sent Exchange: Your four character grid Example: JO33  

 

Exchange of signal report is optional. Foreign stations work W/VE amateurs only. 
 
Stations can be logged more than once from a different grid without being a dupe (for Rover stations). 
 
Dupe check on first 4 characters of grid. 
 
The score for Rover stations is not being calculated by the program!  

4. ARRL September VHF QSO Party 

 Window: Select Log type  

o Log Type: ARRLVHFSEP  
o Sent Exchange: Your four character grid Example: JO33  

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only. 
 
Stations can be logged more than once from a different grid without being a dupe (for Rover stations). 
 
Dupe check on first 4 characters of grid. 

 
The score for Rover stations is not being calculated by the program!  

5. CQ WW VHF Contest 

 Window: Select Log type  
o Log Type: CQWWVHF  
o Sent Exchange: Your four character grid Example: JO33  

 
Exchange of signal report is optional. 
 
Rover stations can be logged more than once from a different grid without being a dupe. 

 
Dupe check on first 4 characters of grid. 

 
The score for Rover stations is not calculated by the program.  

 Starting with program version 11.07.02, a Reverse Call History Lookup feature has been 
implemented for this contest  

o If Call History Lookup is enabled, and a Call History file containing grid squares has 
been loaded, then when a grid square or partial grid square (at least two characters) 
is entered into the exchange field and there is no call sign in the call sign field, the 
Check window will display all call signs in the Call History file with that same grid 
square  



o The call signs are entered in magenta color, and can be clicked on with the mouse to 

transfer one of them to the call sign window  
o If there is a partial call sign in the call sign field, possibly using wild cards for missing 

characters, the list of call signs displayed will be limited to those matching the partial 
call sign  

 

 
 

6. IARU Region 1 contesting - 50 MHz, VHF, UHF/Microwaves 

Region 1 contesting uses a serial number and gridsquare as exchange. The points per qso is the 
calculated distance between your sent gridsquare and the received gridsquare.  

 Station Information ('Config | Change Your Station data')  

o Grid Square: <gridsquare> Example: JO33fd  
 This grid square is used in calculating the distance between the stations (and 

is part of the exchange)  

 Window: Select Log type ('File | Choose Which Contest to Log')  

o Log Type: VHFREG1  
o Sent Exchange: 001 <gridsquare>  

 Example: 001 JO33fd  
 The sent exchange is not used by this specific contest otherwise the use in the 

macros for the function keys.  

 

This contest type has the possibility to use the CallHist table in which information can be stored which 
can be easy to have during a qso like name and gridsquares used in previous contests. This specific 
contest type uses the Name, Locator1 and Locator2 fields from the CallHist table. Entering any 
information in this table is not necessary for the contest module to work but can be very handy. For 

this to work information has to be imported in the Call History table ('File | Import | Import Call 
History'), also this feature has to be enabled to work ('Config | Call History Lookup').  

 When a callsign is entered and the SPACE or TAB key is pressed the program will check next 

to the normal things like dupe check the following:  
o Check the log if the callsign is known and if already worked the gridsquare is entered 

from the log in the Entry Window grid square exchange field.  
o If not found in the log file it will check the CallHist table. If the callsign is found it will 

place the content from Locator1 in the Entry Window grid square exchange field. The 
callsign is 'normalized' before searching in the CallHist table which means that /P, /A, 

/2 etc. will be removed before searching. Information in the CallHist table should be in 
its normalized form.  

 Information from the CallHist table i.e. Locator1, Locator2 and the name field will be shown 
below the function keys.  

 Normally this feature is not turned on (it gives a very short delay while searching the table), 

to turn it on select:'Config | Call History Lookup'  

 Note: Any information already typed in the grid square exchange will not be overwritten by 

the log file or CallHist table search. So first entering a grid square and afterwards a callsign is 
possible without overwriting the already entered grid square information. A callsign already 
worked will be shown in the bottom pane of the log window and marked with the dupe 
message. If the station is not worked before and is present in the CallHist table, this 
information will always be shown below the function keys.  

 More information about importing information in the CallHist table can be found in chapter VHF 

and Up contesting. A zip file with an import file for the 'Call history' lookup function and a 
ready master file with known calls can be downloaded from the N1MM website, select 'Other 



Files' under 'Downloads'. Don't forget to turn on the lookup function under 'Config | Call 

History Lookup'  

 More information about VHF related contesting and features can be found in chapter VHF and 
Up contesting  

 
A QSO can not be entered when 

 The serial number is missing  
o Warning: "Missing Serial Number!"  

 The grid length is not 6  

o Warning: - "6 character grid required!"  

 The grid format is not correct.  
o Warning: - "Wrong format grid. Format = AA##AA"  

 
These checks will (only) be done: when trying to log the qso (mostly by pressing Enter)  

How VHFREG1 looks for a known grid square 

 Look in the log if the station has been worked before (on any band)  

o If found show the grid and calculate distance and bearing  

 If not found look for the call sign in the 'call history' table including any /P /3 etc when 
applicable.  

o If found show the grid and calculate distance and bearing  

 If not found look for the call sign in the 'call history' table with the /P /3 etc removed 
(normalized callsign)  

o If found show the grid and calculate distance and bearing  

 If not found add the 'big grid' from the country when known by VHFREG1  

o If found show 'big grid' (no calculations done)  

o If not show nothing in grid square field  

 The check will (only) be done: When space is pressed and the cursor is in Callsign field  

 
Bearing and distance calculations 

 When space is pressed and the cursor is in Callsign field  

 When trying to log the qso (mostly by pressing Enter)  

 The grid square length has to be 4 or 6 digits.  

 Bearing info is shown in the log window and saved in the Misc field.  

 Distance info is shown in km in the log window and saved in the Points field.  

 Use Rescore to have the bearing and distance (re)calculated.  

 
Check Grid with country 

 When a grid is entered the program will check if the 'big grid' is a possible grid for the entered 

callsign.  
o Example: A Dutch station is always in JO.  

 When the callsign is entered with /MM the check will not be done.  

 The check will (only) be done:  
o When space is pressed and the cursor is in Callsign field  
o When trying to log the qso (mostly by pressing Enter)  



 
Add 'big grid' to 4 digit grid (if last 4 digits entered) 

 When a 4 digit grid is entered the program checks if these are the last four characters from a 
6 digit grid. If so it will add the 'big grid' from the country (for a Dutch station it will add JO).  

 The check will (only) be done:  
o When space is pressed and the cursor is in Callsign field  
o When trying to log the qso (mostly by pressing Enter)  

 
Add 'big grid' when no grid is found (from log or 'call history' table) 
 

When a station is entered in the callsign pressing SPACE will search the 'call history' table. When the 
entered callsign is not found the program will try to add the 'big grid' who belongs to that country. If 
more grids are possible it uses the grid which occupies the most space in the country (IO in England) 
or is the easiest workable grid from Western Europe (JP for Norway, most south grid. The Netherlands 
will always give JO because this is the only grid possible for PA.  

 The check will (only) be done:  
o When space is pressed and the cursor is in Callsign field  

 
For DL stations: The German contest manager hat informiert dass er die Logeinsendungen von 

N1MM gerne akzeptiert. Wie immer akzeptiert er den postalischen Versand des Logs, jedoch auch 
Email ist möglich, lediglich müssen die Daten druckfähig sein.  
Vorab also einige Hinweis:  

1. Jedes Log muß mit dem Generic-File-Output als TXT-Format sortiert nach Zeit abgespeichert 
werden und als Bezeichnung "CALLBAND.TXT" lauten. Also DH5HV2m.txt zum Beispiel für 
einen Contest unter DH5HV auf 2m.  

2. Bei der Einsendung mehrerer Bänder sollte man diesbezüglich den Generic-File erstellen mit 

"sorted by Band" und dann mit einem Editor kurz bearbeiten, sodass man als Beispiel eine 

2m-Datei, eine 70cm-Datei, eine 23cm-Datei, etc. hat. Auch hier natürlich dann DH5HV2m.txt 
und DH5HV70cm.txt und DH5HV23cm.txt erstellen bzw. benennen.  

3. Und wie bisher auch üblich wird für jedes Band ein seperates Deckblatt benötigt, was nur 
komplett ausgefüllt gewertet werden kann. Man findet dies unter 

http://www.darc.de/referate/ukw-funksport/index.html  ganz unten als PDF- oder 
DOC-File.  

7. Marconi CW contest 

The Marconi CW contest is CW only. For settings see the VHF Region 1 contest.  

 Window: Select Log type  
o Select: Log Type: VHFREG1  

 
 

8. NAC Activity Contest 

As there is no serial number needed in the NAC contest exchange serial numbers are not shown and 
not added to the EDI output (opposed to VHFREG1).  
In the EDI output the scoring, bonus and multipliers are calculated. The grid locator from the station 

http://www.darc.de/referate/ukw-funksport/index.html
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Documentation#IARU_Region_1_contesting_-_50_MHz_VHF_UHF_Microwaves


information is used in the calculations. Also the antennas, heights etc. are taken from this dialog.  
For more settings and possibilities see the VHF Region 1 contest.  

 Window: Select Log type  
o Select: Log Type: VHFNAC  

o Sent Exchange: Nothing specific needed but the 6 digit grid would be fine to used it in 
the Sent Exchange macros.  

 
 

9. REF Departments contest 50 Mhz 

 Window: Select Log type  
o Log Type: DDFM50  
o Sent Exchange: Serial Number + Your four character grid Example: 001 JO33  

 
 

10. VHF/UHF Helvetia 26 contest 

 Window: Select Log type  
o Log Type: VHFHELV26  
o Sent Exchange: 001  

 

Local Swiss VHF/UHF and up contest. Uses almost the same rules as VHFREG1 but with an added field 
for Swiss stations for exchanging Cantons which are also multipliers for the contest All features 
mentioned above for VHFREG1 can be used in this contest. Use in the Multiplier sheet the Sect tab to 
view the worked Cantons (select VHF and auto).  

11. VHF HG OB contest 

 Window: Select Log type  
o Log Type: VHFHGOB  
o Sent Exchange: 001  

 
Local Hungarian VHF contest. Uses almost the same rules as VHFREG1 but dupes per mode CW or 

FM/SSB (station may be worked twice per band). All features mentioned above for VHFREG1 can be 
used in this contest.  

12. VHF UA1DZ Cup 

 Window: Select Log type  

o Log Type: VHDZCUP  
o Sent Exchange: 001 gridsquare Example: 001 KO94BD  

 
Russian VHF contest. Exchange is RST + serial number + grid square.  

13. VRZA - Nederlandse Locator Contest - WANLC 



 Window: Select Log type  

o Log Type: REGIOVHF (is dus nu de WANLC contest)  
o Sent Exchange: 001  

 
Only for Dutch stations.  

Noot: Deze contest kent een aantal mogelijkheden om extra multipliers te halen middels een soort 

'Rover' stations. Dit wordt niet ondersteund door het programma en deze stations worden een DUPE! 
Ofwel: De multipliers en punten voor /M en /P stations gewerkt voor een tweede keer worden NIET 
door het programma automatisch bepaald. Deze dupes dus WEL loggen en achteraf de score en 
multiplier aanpassen op 'generic log' en de 'summery sheet'.  

Cabrillo output wordt ondersteund (File, Export, Cabrillo).  

Voor stations in de secties B en J (Single Operator / Mixed mode)  

- Selecteer SINGLE-OP-ASSISTED (onder File, Choose Which Contest to Log, Operator Category) voor 
een doorlopende nummering over de banden heen!  

14. YU DX Contest 

 Window: Select Log Type  
o Log Type: YUDX  
o Sent Exchange: your ITU zone. (remember also to put RST in your exchange 

messages)  

 
 

15. UKSMG sporadic-E competition 

 Window: Select Log type  

o Log Type: UKSMG  
o Sent Exchange: Your four character grid Example: JO33  

 
Only the 6 meter band is shown in the Multiplier window.  
A 4 digit grid is required and 6 digit grid is allowed to enter.  

 

2.1.4.5 Setup Digital Contests - RTTY and PSK 

 2.1.4.5 Setup Digital Contests - RTTY and PSK  

o 1. ANARTS WW RTTY contest  
o 2. ANATOLIAN RTTY contest  

o 3. ARRL Rookie Roundup RTTY  
o 4. ARRL RTTY Roundup  
o 5. BARTG Spring RTTY contest  
o 6. BARTG RTTY Sprint contest  
o 7. BARTG Sprint75 RTTY contest  
o 8. CQ World Wide DX contest - RTTY  

o 9. CQ World Wide WPX contest - RTTY  
o 10. CIS contest - RTTY  



o 11. DL DX RTTY contest  

o 12. DMC RTTY contest  
o 13. DRCG Long Distance RTTY contest  
o 14. EA PSK31 contest  

o 15. EA RTTY contest  
o 16. EPC PSK63 QSO party  
o 17. EPC PSK World Wide DX contest  
o 18. EU PSK DX contest  
o 19. JARTS WW RTTY contest  
o 20. JT RTTY DX Contest  
o 21. Makrothen RTTY Contest  

o 22. Logbook of the World Contest - RTTY/Digital  
o 23. NA Sprint RTTY  
o 24. North American QSO Parties RTTY - NAQP  
o 25. OK DX RTTY Contest  
o 26. Quick PSK63 Contest  
o 27. Russian PSK DX Contest  

o 28. Russian DX RTTY contest  
o 29. Russian Cup RTTY contest  
o 30. SARTG New Year RTTY Contest  
o 31. SARTG WW RTTY Contest  
o 32. SCC RTTY Championship  
o 33. SP DX RTTY contest  
o 34. TARA Grid Dip contest  

o 35. TARA PSK Rumble  
o 36. TARA RTTY Melee  
o 37. TARA Skirmish  
o 38. Ukrainian DX Classic RTTY contest  
o 39. Ukrainian Open RTTY Contest  
o 40. Ukrainian RTTY contest  
o 41. Ukrainian DX DIGI Contest  

o 42. United Kingdom DX contest RTTY  
o 43. VOLTA RTTY Contest  

o 44. WAEDC RTTY contest  
o 45. XE RTTY Contest  

When doing RTTY and PSK contests always check the Mode tab in Configurer for correct settings!  

{TIME2} - how it works  

The time will be set if  

 You have a call sign in the Entry Window  

 The contents of the database field that holds the time is empty for that callsign, and one of 
the following conditions is met:  

 F2 is pressed or sent  

 Insert is pressed and the code that is run from the insert key sends the contents of the F2 
macro  

 {TIME2} is contained in the macro string that is sent  

 
If you do not have a call in the Entry Window or the database field is not empty, the {TIME2} macro 
will be replaced by the Last Sent Time. So if you have not sent the time and you are trying the macro 
out you will see 0000 printed on the screen. But if 0512 was the last time sent then that is what the 
{TIME2} macro will send. {TIME2} stays locked until the contact is logged or the callsign wiped.  



1. ANARTS WW RTTY contest 

The last running of this contest was in June 2009. It has been replaced by the DRCG Long Distance 
contest (DLDCRTTY).  

 Window: Select Log Type  
o Log Type: ANARTSRTTY  
o Sent Exchange: Zone Example: 14  

2. ANATOLIAN RTTY contest 

 Window: Select Log Type  

o Log Type: ANATOLRTTY  
o Sent Exchange: 001  

 
 

3. ARRL Rookie Roundup RTTY 

To create the Rookie Roundup log in your database:  
Select >File >New log in database  

 Window: Select Log Type  
o Log Type: RRRTTY  
o Sent Exchange: <your name> space <two digit year licensed> space <US 

state/Canadian province/Mexican call area> or "DX"  
 Examples:  

 JOHN 68 OH (non-rookie station, John, licensed in 1968, from Ohio)  
 JOSE 10 XE1 (rookie station, JOSE, licensed in 2010, from Mexican 

XE1 call area)  
 JEAN 09 DX (rookie station, Jean, licensed in 2009, from "DX" - 

outside of North America)  

 
Any licensed ham can run the ARRL Rookie Roundup RTTY, but scoring and log submission is limited to 
Rookie stations licensed within the last 3 years.  

Score summaries are due within 72 hours of the end of the contest - 2359 Wednesday evening UTC, 

or 1859 EST. Use the "Submit your score" link under "Score Submission" at the ARRL web page  for 
the RR. ARRL says logs are not required or accepted.  

Calling CQ  

 Use your standard callsign during the contest - no speical suffix (do not use /ROK. This is a 

rule change since the first running). Rookies are encouraged to call "CQ RR"; non-rookies 
should call "CQ R." RTTY Rookies might want to download and use a Sample Macro file created 
specifically for the RRRTTY contest. See the website under >Files >Sample Macros files "ARRL 
RRRTTY.MC." The macros are set for Rookies, non-rookies will need to change the CQ RR to 
CQ R.  

 
Contest Exchange  

http://www.arrl.org/rookie-roundup


 Your name, year licensed (last two digits, example: 09), state/province abbreviation - for 

K/VE/XE stations (example: NY) or "DX" for other stations. The two digit year in your Sent 
Exchange automatically determines your status as a Rookie or a non-Rookie station. The 2 
digit year in the Received Exchange determines the status of the station you are working. Do 
not use 4 digit years, it will only cause confusion for both Rookies and logging software.  

 
 

4. ARRL RTTY Roundup 

The ARRL RTTY Roundup can be used by K/VE stations and DX stations.  

 Window: Select Log Type  
o Log Type: ARRLRTTY  

o Sent Exchange:  
 Your state/province - for K/VE stations Example: NY  
 001 - for DX stations (non K/VE)  

o Sample Function Key file available: see ARRLRTTY.MC  

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a DX stations or a W/VE station.  

Note: US stations who work US "/MM" stations are also allowed to log serial numbers.  

5. BARTG Spring RTTY contest 

 Window: Select Log type  

o Log Type: BARTGSRTTY  

o Sent Exchange in the Contest setup:001  

 Sample Function Key file available: see BARTGSRTTY.MC  

 
Be careful not to confuse this contest with the BARTG RTTY Sprint contest.  

The actual sent exchange includes a signal report, serial number and the UTC time. Program this into 
your Exchange messages using the {TIME2} macro, e.g.: {TX} 599 {EXCH} {TIME2} {RX}, or {TX} 
599 # {TIME2} {RX}.  

Testing the {TIME2} macro 

If you test out the Exchange message using the {TIME2} macro without first entering a call sign into 

the Entry window, the Exchange message will send "0000". This is expected, and it does not mean 
there is something wrong with your Exchange message. The time sent by the {TIME2} macro will be 

initialized only after a valid call sign has been entered into the call sign box and the cursor has been 
moved into the exchange box. 

 
Needed W,VE,JA,VK call area mults in bandmap and available window are highlighted.  

Added EXPERT to list of overlay categories choices. The EXPERT overlay category must be selected for 
the 5 minute band change counter to not be active for SINGLE-OP  

6. BARTG RTTY Sprint contest 

http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=26
http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=26


 Window: Select Log type  

o Log Type: BARTGRTTYS  
o Sent Exchange:001  

 Sample Function Key file available: see BARTGRTTYS.MC  

 
Be careful not to confuse this contest with the BARTG Spring RTTY contest.  

Note that there is no signal report in the sent exchange, just a serial number.  

Needed W,VE,JA,VK call area mults in bandmap and available window are highlighted.  
Added EXPERT to list of overlay categories choices. The EXPERT overlay category must be selected for 
the 5 minute band change counter to not be active for SINGLE-OP.  

7. BARTG Sprint75 RTTY contest 

 Window: Select Log type  
o Log Type: BAR75RTTYS  
o Sent Exchange:001  

This contest type is used for the BARTG 75 baud sprints in April and September. For information on 

setting up MMTTY and N1MM Logger for 75 baud RTTY, see the section on Using MMTTY for 75 baud 
RTTY at the end of the Using MMTTY section in the Digital Modes chapter.  

8. CQ World Wide DX contest - RTTY 

 Window: Select Log type  

o Log Type: CQWWRTTY  
o Mode Category: RTTY  
o Sent Exchange:  

 North American/Canadian stations - Your zone plus the STATE or PROVINCE 

Example: 05 NY  
 NB For cabrillo log submission the order must be: Zone first, then 

state (or province) with no leading spaces, and ONLY ONE space 
between the zone and the state.  

 Other stations - Your zone Example: 14  

The default zone values for US (A,K,N,W) stations are  

 Zone 3 - If number in callsign is 6 or 7  

 Zone 4 - If number in callsign is 5 or 8 or 9 or 0  

 Zone 5 - If number in callsign is 1 or 2 or 3 or 4  

The default zone values for Canadian (VE) stations are  

 Zone 1 - If callsign starts with: VE8, VY1  

 Zone 2 - If callsign starts with: VO2, VY0  

 Zone 3 - If callsign starts with: VE7  

 Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6  

 Zone 5 - If callsign starts with: VE1, VE2, VE9, VO1, VY2  

 Press the Space bar when the cursor is in the Callsign field to have the Zone field filled with 

the default value.  

 The province code is pre-filled for Canadian stations based on the call sign prefix.  

http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=26
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+MMTTY+for+RTTY+Support#Using_MMTTY


 The state field for US stations is pre-filled if you have worked that station on another band, or 

if you are using a Call History file.  

 When typing the section and the entered section is new the call sign will be shown in RED. 
The Available window will also show if a section multiplier is needed on other bands  

 When pressing Space and the entered callsign is not US or VE, the cursor will skip the 

state/section field.  

 When submitting your log to the contest robot make sure you have in the Sent Exchange the 
correct order: Zone first, then state (or province).  

 

Cabrillo output  
The Cabrillo file must be in the order zone, state because that's how the official Cabrillo template for 
CQ WW RTTY is defined. However, this has *nothing* to do with how you operate during the contest, 
it only applies to the post-contest log submission. During the contest, you can send in either order; all 
the rules say is you must send both. 
 

A lot of people seem to send zone, state. However, the order state, zone is easier for people using 

N1MM because that's the order in the entry window. It's also easier for people using software that 
calculates the zone from the state (like N1MM logger does). 
 
So: put zone, state in the contest setup dialog to ensure your Cabrillo file is OK, but you can please 
yourself about the order in your exchange macros; state, zone (e.g. 599 ON ON 04-04) will make it 
easier for fellow N1MM users, so it's the recommended order on this reflector!  

Call History in CQWWRTTY 

If you like to use Call History Lookup and you plan to use a generic call history file that contains state 

information for W stations, you should be aware of a potential problem with call signs from AK and HI. 
If you invoke a call history lookup for a call sign in AK or HI, the call sign is in the file, and there is an 
entry for the state for that call sign in the file, the state/province field in the Entry window will be pre-
filled, even though under the rules for this contest the state field should be blank. This in turn may 
lead to an error in logging the contact; you may have to edit that entry in the log to remove the 

unwanted state code. You can avoid this by removing the state codes from the call history file for call 
signs in AK and HI, or more simply by turning Call History Lookup off for this contest. 

 
 

9. CQ World Wide WPX contest - RTTY 

 Window: Select Log type  

o Log Type: CQWPXRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001 (set Send Leading Zeroes in Configurer >Function Keys)  

 Sample Function Key file available: see CQWPXRTTY.MC  

 
 

10. CIS contest - RTTY 

The Commonwealth of Independent States Contest where everybody can work everybody for QSO and 
multiplier credit.  

 Window: Select Log type  

http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=26


o Log Type: CISDXRTTY  

o Sent Exchange:  
 CIS stations: CIS area code Example for Moscow City: RU11  
 Non-CIS stations: 001  

 
 

11. DL DX RTTY contest 

 Window: Select Log type  

o Log Type: DLDXRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001  

Note that PSK31 and/or PSK63 may also be used in this contest.  

12. DMC RTTY contest 

 Window: Select Log type  
o Log Type: DMCRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001  

 
 

13. DRCG Long Distance RTTY contest 

This contest has replaced the ANARTS RTTY contest.  

 Window: Select Log type  
o Log Type: DRCGWWRTTY  

o Mode Category: RTTY  
o Sent Exchange: Zone Example: 14  

 
The actual sent exchange includes a signal report, your CQ zone, and the UTC time in the format 
HHMM (NOTE: no parens ":" between hours and minutes). Program this into your Exchange messages 
using the {TIME2} macro, e.g.: {TX} {SENTRST} {EXCH} {TIME2} {RX}. A sample macro file is 
available under >Files >Sample Macro Files >Digital.  

Testing the {TIME2} macro 

If you test out the Exchange message using the {TIME2} macro without first entering a call sign into 

the Entry window, the Exchange message will send "0000". This is expected, and it does not mean 

there is something wrong with your Exchange message. The time sent by the {TIME2} macro will be 
initialized only after a valid call sign has been entered into the call sign box and the cursor has been 
moved into the exchange box. 

 
See contest sponsor website for new contest times and bandchange restrictions.  

14. EA PSK31 contest 



 Window: Select Log type  

o Log Type: EAPSK  
o Mode Category: PSK  
o Sent Exchange:  

 For Spanish stations - Province Example: AL  
 For non-Spanish stations - Serialnumber Example: 0001  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Spanish station or a non-Spanish station.  

15. EA RTTY contest 

 Window: Select Log type  
o Log Type: EARTTY  

o Mode Category: RTTY  
o Sent Exchange:  

 For Spanish stations - Province Example: AL  
 For non-Spanish stations - Serialnumber Example: 0001  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Spanish station or a non-Spanish station.  

16. EPC PSK63 QSO party 

 Window: Select Log type  

 Log Type: EPCPSK63QP  

 Sent Exchange:  
o EPC member stations: EPC membership number Example: EPC0001  
o Non-EPC member stations: 001  

 
 

17. EPC PSK World Wide DX contest 

 Window: Select Log type  

 Log Type: EPCWWDX  

 Sent Exchange:  

o EPC member stations: EPC membership number Example: EPC0001  
o Non-EPC member stations:  

 
 

18. EU PSK DX contest 

 Window: Select Log type  
o Log Type: EUPSKDX  
o Sent Exchange: 001  

 
 



19. JARTS WW RTTY contest 

 Window: Select Log type  
o Log Type: JARTSWWRTY  

o Sent Exchange:Your age Example: 34  
 XYL and YL stations may give 00  
 Multi-operator stations must send 99 as a operator age.  

 
 

20. JT RTTY DX Contest 

 Window: Select Log Type  
o Log Type: JTDXRTTY  

o Mode Category: RTTY  
o Sent Exchange: CQ Zone (e.g., 5, 14, 23, etc.)  

 
 

21. Makrothen RTTY Contest 

 Window: Select Log type  

o Log Type: MAKRORTTY  
o Mode Category: RTTY  
o Sent Exchange: 4 digit grid Example: JO33  

 
 

22. Logbook of the World Contest - RTTY/Digital 

 Window: Select Log type  
o Log Type:  

 LOTWRTTY  

o Sent Exchange:  
 For North American stations: State/Province abbreviation Example: CT  
 For non North American stations: Countryprefix  

 
 

23. NA Sprint RTTY 

 Window: Select Log type  
o Log Type: SPRINTRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001 Tom CT  

 Serial number, your name and your location (state, province or country) 
Example: PA1M DE N1MM 123 TOM CT K  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a North American station or a non-North American station.  



24. North American QSO Parties RTTY - NAQP 

 Window: Select Log type  
o Log Type: NAQPRTTY  

o Operator Category: SINGLE-OP or MULTI-TWO  
 For Multi-Two see the extra info below!  

o Mode Category: RTTY  
o Sent Exchange:  

 For North American stations - Operator name and station location (state, 
province, or country) Example: Tom CT  

 For non-North American stations - Operator name only Example: Thomas  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a North American station or a non-North American station.  

MULTI-TWO operating: When changing operator you have to use Ctrl+O to set the NAME (not Call) 

of the operator. This name set with Ctrl+O will be used in the Cabrillo file. So from the Sent Exchange 

only the state is being used but the name is needed. (Example: Tom CT). The macro {OPERATOR} 
can be used to automatically switch WAV files (in SSB), for more info see the Macro section.  

25. OK DX RTTY Contest 

 Window: Select Log type  
o Log Type: OKDXRTTY  
o Mode Category: RTTY  
o Sent Exchange: CQ zone  

26. Quick PSK63 Contest 

The contest uses the same rules as the SARTG WW RTTY contest so select that contest (SARTGRTTY).  

After the contest the Cabrillo output has to be updated (take SARTG WW out and replace with Quick 
PSK63)  

27. Russian PSK DX Contest 

 Window: Select Log type  

o Log Type: RUSDXPSK  
o Mode Category: PSK  
o Exchange:  

 Russian stations: Two-letter oblast code, e.g. MA  
 Others: 001  

 
 

28. Russian DX RTTY contest 

 Window: Select Log type  

o Log Type: RUSDXRTTY  
o Mode Category: RTTY  
o Sent Exchange:  

 Non-Russian stations: WAZ zone Example: 14 for Western Europe  
 Russian stations: Your oblast code (two letters)  



 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Russian station or a DX station.  

29. Russian Cup RTTY contest 

 Window: Select Log type  

o Log Type: RUCUPRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001  

 
This contest is for Russians only.  

30. SARTG New Year RTTY Contest 

 Window: Select Log type  
o Log Type: SARTGNYRTY  
o Mode Category: RTTY  
o Sent Exchange: 001 Name  
o Soap Box Comments: "Happy New Year" in your native language  

o Add "Happy New Year" in your native language to the Function Key macro. Do not add 

it to the Sent Exchange. If you do, the Cabrillo output and General Log output may not 
be correct.  

 
Logging an exchange with spaces is not supported and logging of the Happy New Year greating is 
*not* required. If you want to record the Happy New Year greeting it can be added *without* spaces 
after the name preceeded by a "/". Example: Jim/HappyNewYear. If added, the Cabrillo output 
generator will removed the "/" and everything that follows when generating the output file.  

The sponsor informed the developers that as of December 21, 2013 they will accept Cabrillo 3.0 
formated logs. It is necessary to use program revision 13.12.02 or newer and follow the Sent 
Exchange & Soap Box instructions above to export a Cabrillo file. The Happy New Year message that 
you sent will appear in the Cabrillo Soap Box Comment.  

31. SARTG WW RTTY Contest 

 Window: Select Log type  

o Log Type: SARTGRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001  

o Sample Function Key file available: see SARTGRTTY.MC  

 
 

32. SCC RTTY Championship 

 Window: Select Log type  
o Log Type: SCCRTTY  
o Mode Category: RTTY  
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o Sent Exchange: four-digit number of the year the amateur radio license was FIRST 
officially issued (e.g. 1983) to the operator.  

The score Summary window only shows your total score and the number of mults you have worked 
per band. There is no breakdown by points. In SCC there is one extra column of mults but that had to 
be there as the way things are setup to calculate the first multiplier (different years). Thus the name 
of the second mult is "N/A" . The only way to do a breakdown on points is to go through your log and 
manually do it.  

33. SP DX RTTY contest 

 Window: Select Log type  

o Log Type: SPDXRTTY  
o Mode Category: RTTY  
o Sent Exchange:  

 001 for non-SP stations  
 Your province Example: B for Lubuskie  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Polish station or a DX station.  

34. TARA Grid Dip contest 

 Window: Select Log type  

o Log Type: TARAGRID  
o Mode Category: RTTY or PSK  
o Sent Exchange: name + 4 digit grid locator Example: Tom FN12  

 
 

35. TARA PSK Rumble 

 Window: Select Log type  
o Log Type: TARAPSK  
o Mode Category: PSK  
o Sent Exchange: Name and Call Area Example: Tom W1  

 
 

36. TARA RTTY Melee 

 Window: Select Log type  

o Log Type: TARARTTY  
o Mode Category: RTTY  
o Sent Exchange:  

 State for USA stations Example: CT  
 Province for Canadian stations Example: NB  
 001 for all other stations (serial number)  

 
 



37. TARA Skirmish 

 Window: Select Log type  
o Log Type: TARAPSK, or SKIRMRTTY (requires that you download the SKIRMRTTY.udc 

user-defined contest file)  
o Mode Category: DIGITAL  
o Sent Exchange: Name and Prefix Example: Tom N1  

Note: Download the SKIRMRTTY.udc file into your UserDefinedContests folder and use SKIRMRTTY. If 
you do not want to use the udc file, the TARAPSK contest will also work for the Skirmish, but the 
scoring of multipliers will not be correct. Use the Tara on-line log submission page and enter the 
correct prefix multiplier count there. If you use more than one digital mode during the contest, submit 
a separate entry for each mode as per the contest rules.  

38. Ukrainian DX Classic RTTY contest 

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian stations.  

 Window: Select Log type  
o Log Type: UKRAINDX  

o Mode Category: RTTY  
o Sent Exchange:  

 Oblast for Ukrainian stations Example: CH  
 001 for non-Ukrainian stations  

o Sample Function Key file available: see UKRAINDX.MC  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an Ukrainian station or a non-Ukrainian station.  

39. Ukrainian Open RTTY Contest 

 Window: Select Log type  
o Log Type: UKRRTTYOPEN  
o Mode Category: RTTY  
o Exchange: 2-letter province code + 3-digit serial number  

 
 

40. Ukrainian RTTY contest 

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian stations.  

 Window: Select Log type  
o Log Type: UKRAINRTTY  

o Mode Category: RTTY  
o Sent Exchange:  

 Oblast for Ukrainian stations Example: CH  
 001 for non-Ukrainian stations  

 

Country Count 
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Countries are counted per band for SSB, CW and RTTY, because RTTY is in a separate contest module 

they won't be counted correct when a station makes next to SSB and CW also RTTY q's or the other 

way around. 

 

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an Ukrainian station or a non-Ukrainian station.  

41. Ukrainian DX DIGI Contest 

75 baud RTTY and PSK63 modes  

 Window: Select Log type  

o Log Type: UKRAINDIGI  
o Sent Exchange:  

 Oblast for Ukrainian stations Example: CH  
 001 for non-Ukrainian stations  

 
 

42. United Kingdom DX contest RTTY 

The UK DX contest can be configured for UK stations and non-UK stations.  

 Window: Select Log type  

o Log Type: UKDXRTTY  
o Sent Exchange:  

 Area code for UK stations Example: BS  
 001 for non-UK stations  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an UK station or a non-UK station.  

43. VOLTA RTTY Contest 

 Window: Select Log type  
o Log Type: VOLTARTTY  
o Mode Category: RTTY  
o Sent Exchange: RST + QSO number + Your CQ Zone. Example: 599 001 15  

The four Band Multiplier count for this contest is displayed on info window.  

44. WAEDC RTTY contest 

The WAEDC RTTY Contest can be configured for European stations and non-European stations.  

 Window: Select Log type  
o Log Type: WAERTTY  
o Sent Exchange: 001  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are an European station or a non-European station.  



Making QSOs in WAE RTTY:  

To start with, a QSO in WAE is just like a QSO in CQ WPX or SARTG, and I would suggest using the 
same function-key set. The special feature of WAE is QTCs, which are reports of previous QSOs that 
can be exchanged for additional points.  

In CW and SSB WAE, QTCs can only be sent from non-EU to EU, but in RTTY there are many more 
possibilities. QTCs can be sent in either direction between any two continents (not with a station in the 
same continent). This makes WAE RTTY quite a bit more complex than WAE CW. The user interface for 
QTCs in N1MM Logger is completely different for RTTY versus CW/SSB.  

The Logger has features to automate the sending and receiving of QTCs. There is also information in 
the Entry and Bandmap windows to tell you whether the rules permit you to exchange QTCs with 
another station. In the bottom part of the Entry window, while you are in QSO with a station 
information about the number of QTCs you have available to exchange with him is displayed.  

Starting with version 11.11.01, the Bandmap window contains visual cues about the QTC status of 

stations spotted in the bandmap. A special color scheme for spotted call signs has been implemented, 
as follows:  
RED: the station is a new multiplier on this band (same as in other contests)  
GREEN: this is a new station on this band, and you can also exchange QTCs with him (you are on 
different continents and you have not yet exchanged 10 QTCs)  
BLUE: this is a new station on this band, but you have no more QTC room available (same continent, 

or you have already exchanged 10 QTCs)  
BLACK: this station is a dupe on this band, but you still could exchange QTCs with him for QTC points  
GREY: dupe, and there is no QTC room either - this station is non-workable for any kind of credit, so 
just pass him by  
Note that this special color scheme only applies to the Bandmap and Entry windows; the colors in the 
Digital Interface and Available Mults and Qs windows use the normal color scheme, the same as in 
other contests.  

OK, let's look at the process. First, let's suppose you are CQing. If you have a good run going and you 
are getting new multipliers calling in, you may not want to break your rhythm for QTCs. As long as 

there are people waiting to work you when you CQ, you may decide you will be best off adding to your 
QSO and multiplier counts rather than adding a quick 10 QTCs, which increases your net QSO+QTC 
point count but does nothing for your multiplier points.  

However, especially later in the contest, you might want to pick up your score with some QTCs. In 
fact, you can even call someone who is a dupe just so you can exchange QTCs; the extra QSO will not 
count for points, but the QTCs will.  

First, let's look at the case where you do not have many unsent QTCs to send (that's previous QSOs 
that you have not already sent as QTCs). In this case, if you work someone who has a good clear 
signal (you won't want to do this with someone you have trouble copying) and you have not yet 
exchanged QTCs with him, you may want to receive some. You can see how many QTCs you have 
exchanged with him and how many unsent QTCs are remaining in your log near the bottom of the 

Entry window while the cursor is in the exchange (Nr) field.  

Start by asking him if he has any QTCs for you ("QSL TNX. ANY QTCS FOR ME?"). If he says yes, 
press Ctrl+Z once. That gets you to the RQTC window for receiving QTCs (it's in the right half of the 

Digital Interface window). After you tell him you are ready with the RX Ready button, he will send you 
a message whose first line is something like "QTC: 22/10 QTC: 22/10". The first number is the group 
number (the 22nd group he has sent), the second is the number of QTCs in the group (maximum 10, 
and especially in RTTY it is most efficient to send only large groups). If you click on this in the RX 
window, it should transfer to the RQTC window for recording in your log.  



The heart of his message will be a set of up to 10 QTCs. Each QTC contains three elements: the time, 

the call sign, and the serial number. Each time you receive a QTC, left-click on it and the entire QTC 
should transfer into the corresponding panes in the RQTC window. You can also enter or edit elements 
by hand, or you can right-click on a single element and then left-click in the box where you want it to 

go. After you have received all the QTCs in the group, it may help to click on the green bar at the left 
of the RX window so you can freeze the RX window, scroll back and complete or fix any missing or 
garbled elements. Remember to click on the yellow bar when you are done so you can receive again.  

There are buttons in the RQTC window for asking for repeats for individual QTCs or for the whole 
series. Once you have them all, press Save QTC which will send an acknowledgement message to him 
and log the QTCs, and then you can start CQing again.  

Suppose instead that you do have a bunch of unsent QTCs ready to go. Then what you may want to 
do at the end of a QSO with a station with a good clear signal (if you have trouble copying someone's 
signal, you probably will not want to try QTCs with him) is to ask if he wants to receive QTCs ("QSL 
TNX. DO YOU WANT QTCS?"). If he says yes, press Ctrl+Z twice to get to the SQTC window. The 

buttons in this window should be self-explanatory; the main one is Send All, but if he asks for a repeat 

of #3, 7 and 9 you can resend them by pressing Snd #3, Snd #7 and Snd #9. Once he acknowledges 
them all, press Save QTC and go back to CQing.  

If you get into the wrong QTC window by mistake, you can either press Cancel or just keep pressing 
Ctrl+Z until you get back to the normal Digital Interface receive window. Note also that if you aren't 
able to exchange QTCs with a station (you're on the same continent, or you have already filled your 
quota of 10), the QTC window will not open. If you are able to receive QTCs but don't have any QTCs 
to send, the RQTC window will open, but the SQTC window will not.  

S&Ping works much the same. The color coding in the Bandmap window (version 11.11.01 and newer) 
can let you know whether you will be able to exchange QTCs even before you start a QSO, or once 
you are in QSO the detailed QTC status is visible in the Entry window. Often you will let the running 
station decide if he wants to do QTCs or not, depending on how well his run is going, but sometimes 
you may want to initiate the process yourself, as described above.  

If the other station wants to send QTCs to you, you can either reply "SRI QRU" (not quite correct, but 

he will get the message) or you can press Ctrl+Z once to get the RQTC window and press the RX 
Ready button to tell him you are ready, then receive QTCs the same as described above. If he asks 
you whether you have QTCs for him, you have three options: press Ctrl+Z twice and press the R U 
QRV button to give him the cue to get ready; send "SRI QRU"; or send a message telling him you 
don't have any but are willing to receive some ("SRI QRU. ANY QTCS FOR ME?").  

Most of the basic QTC messages are sent by buttons in the SQTC and RQTC windows. You can 
program the messages in these buttons from the Setup -> Settings menu in the digital interface 
window, under the third tab ("WAE RTTY Configuration").  

There are a few additional messages you may want to program into the buttons at the bottom of the 
Digital Interface window, such as:  
{TX} QSL TNX. GOT ANY QTCS FOR ME? {RX}  

{TX} QSL TNX. DO YOU WANT QTCS? {RX}  
{TX} SRI QRU {RX}  
{TX} SRI QRU. ANY QTCS FOR ME? {RX}  

You may think of more - that's OK, there are up to 24 clickable message buttons in the Digital 
Interface window. I often find myself changing them on the fly during a contest. You can get to the 
programming window by right-clicking on the button you want to change.  



NB. The QTC window for the RTTY contest is in the Digital Interface window. Once you have entered 

the QTC send/receive process for WAE RTTY using Ctrl+Z, you should not be looking at the Entry 
window. This is different from WAE CW/SSB.  

The first time you press Ctrl+Z the Receive QTC window opens up in the right side of the Digital 
Interface. Down the right side you will see buttons labeled RX Ready, All AGN, AGN #1, AGN #2, ..., 
AGN #10, and across the bottom are Cancel, Save QTC and Clear buttons.  

If you want to send QTCs instead of receiving them, just press Ctrl+Z again and the Send QTC window 
takes the place of the Receive QTC window. The top two buttons change to R U QRV and Send All, and 
the rest stay the same. The data windows are automatically filled from your log.  

If you have used up your QTC quota with the station whose call sign is in the entry window, pressing 
Ctrl+Z the first time leaves you in QSO mode and does not open the QTC window. If you have not 

used up your quota with him but you do not have any QTCs ready to be sent, then pressing Ctrl+Z the 
first time displays the Receive QTCs window, and pressing it the second time returns you directly to 
QSO mode.  

 QTC Lines on the frame are broken up into separate boxes. This was done to allow error 
checking of any data that is input by hand and clicking on data in RX window.  

 If you click on data or enter data in the QTC windows if the routines detect bad data it will flag 

that data in red. So when you are receiving QTCs and you get one that is garbled, Click on it 
anyway and it will get placed into the QTC area. The boxes for that QTC will turn red.  

 Upon completion of the sending QTC's all you have to do is look at the QTC window and it will 

tell you by the red colors what QTC you need to RX again. You press the AGN # button and it 
sends your message out. At the same time your message is going out the QTC line is cleared. 
Now when the station sends the repeat of the QTC you requested and you click on it and it will 
then be placed into that blank line that was just cleared.  

 When saving QTC if any of the data still hasn't been corrected it will send the received ok 

message but if there is an error in the Time or the Callsign the program will let you save the 
QTC and not care about it. But if there is an error in the serial number (If it contains anything 

besides a number) it will not let you save it. The reason for this is in the program the serial 
number needs to be a certain type of variable(numeric) and if it is not a numeric variable it 
will not save it. So the flow of it if there is an error in the serial section and you press Save is:  

A. Sends the confirm string you have setup  
B. Tells you on the entry window there is a Format error  

C. Waits for you to fix it.  
D. So now you would have to scroll back to see what was sent of take out the extra letter your finger 
hit then hit save.  
By doing it this way you are not slowing down the other station  

 The program will not save info into the log until the bad data is fixed. Once fixed just click 
Save again and it will save the data without sending the received message. A warning 

message is given in the Entry window status bar.  

 Sometimes a call sign reported in a QTC will not pass the call sign recognition routines and the 

QTC will be displayed in red. If it was a special call sign, not a copying error, and you want to 
log it anyway, you can "force-log" the QTC by Ctrl+clicking on the Save button  

 To select whole lines of received QTC just place the cursor over the line and left click.  

 To select individual QTC sections place the cursor over the item you want to select and right 

click on it. After the data is selected place the cursor over the text box you want the data to 
go into and left click it will be placed into it.  

 When pressing Ctrl+Z to switch modes the program will display the total QTC sent and 
received from the station being worked. When the QTC frame opens on the DI only the 

Needed amount of QTC boxes will be enabled. Example(if I have worked UT5XXX and received 



5 QTCs from him, the next time I work him and I open up the Receive QTC frame only 5 QTC 

lines will be enabled to reach maximum QTC amount .  

 When pressing Ctrl+Z to switch modes if you have reached the MAX amount of QTC the QTC 

frame will close and give a warning message in Entry windows status bar.  

 When left clicking on a Received QTC line will split data on " ","/","-" separators if the routines 

can't split the data it will not copy the data over. You will have to click each item separate or 
hand type it in.  

 Selecting of individual QTC items can be done by right clicking on item. Left clicking on the 
box where the data to be placed places text.  

 Ctrl+Z cycles through QSO, receive QTC and send QTC modes. After you enter a callsign in 

the entry window pressing Ctrl+Z will cycle through the RQCT and SQTC modes. If you are 
receiving QTC press Ctrl+Z once and as the QTC appears in the digital window just click on it 
one time and it will transfer over to the QTC entry window. To send a QTC press Ctrl+Z one 
more time and it will show you all the QTCs you have available to send.  

 The status line in the Info window shows the total QTC Sent and Received from the station 
being worked.  

 Upon entering a callsign in the entry window and pressing the spacebar, the number of total 

QTC's exchanged with that callsign and the Total of all unsent QTC is displayed on the entry 
window so you should be able to keep track easier of what your QTC numbers are  

 If you work a station that is on your same continent and try to send them QTC or try to 

receive QTC from them the program will tell you you can not do that. Press Enter and move 
on......  

 On the WAE Tab located in the settings area will allow you to set the maximum number of QTC 
you want to send. Whatever this setting is set to is the number that will send unless you do 

not have that many QTC to send. This defaults to 10.  

 The total unsent QTC's is displayed along with # of QTC's exchanged with current callsign on 
the Entry window  

 Continent is checked when sending and receiving QTC's  

 Default number of QTC to send can be entered on the Tab WAE RTTY configuration under 

Settings in the menu from the DI interface.  

 The number of QTC sent and total QTC available ois shown in the Entry window upon Entering 
Callsign  

 Hover mode is disabled if the QTC window is open  

 The number of CR's between QTC's sent is configurable (Setup QTC)  

 Placing a QTC into the QTC window is possible by clicking in line of QTC boxes where you want 

QTC to be placed into.  

 When tuning in the bandmap the Entry Window will show the QTC status of the tuned callsign; 

starting with version 11.11.01, the color in the Bandmap window also shows the status  

 Warning: In this contest it is allowed to log a contact with a zero serial number (such as a 
non-contest DXpedition you work during the contest). Therefore the normal ESM flow is 
altered; F8 (Agn?) is not highlighted when the exchange box is empty during a QSO. In a 

normal QSO where you receive a serial number, you have to be careful not to hit Enter too 
soon and forget to log the received serial number; make sure to enter the serial number 
before you hit Enter to finish the QSO!  

 
For those who are familiar with WAE CW/SSB, note that the Logger's user interface for QTCs is 

different in RTTY, and that there are fundamental differences in the contest rules between the RTTY 
and the SSB/CW version of the contest:  

1. Everyone can work everyone, so DX can work DX and EU can work EU  
2. Everyone can both send and receive QTCs, however they can only be exchanged between stations 
in a different continent  

How do I know how many QTCs I can receive from a station or how do I know the number 
to send to them?  



The program will do all this for you in a number of ways...  

 The first number that is displayed on the entry window by the QTCs title is the total number of 
QTC's you have exchanged with that station. If it says 8 then you can either receive or send 2 
more  

 When you press Ctrl+Z to switch to RQTC mode the program already knows how many QTC 
you can receive and will only enable that many entry points on the QTC frame  

 When you press Ctrl+Z to switch to SQTC mode the program will either set the maximum 

number you want to send or however many QTC's you are still allowed to send to that station. 
(Whichever is smaller)  

 
 

45. XE RTTY Contest 

 Window: Select Log type  
o Log Type: XERTTY  
o Mode Category: RTTY  

o Sent Exchange:  
 Mexico: State. Example: AGS  
 Non-Mexico: 001  

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines 
if you are a Mexican station or a non-Mexican station.  

 

2.1.4.6 Setup User Defined Contests 

 

 2.1.4.6 Setup User Defined Contests  

o Installation Instructions for a User Defined Contest (UDC)  
o 1. PODXS Valentine Sprint Contest  
o 2. ACHAMPCW  
o 3. ARKTIKA-SPRING  
o 4. AEGEAN RTTY Contest  

o 5. AGB  
o 6. AGB NYSB/NEMIGA/PARTY  
o 7. AGB Party  
o 8. Alaska QSO Party  
o 9. ARI RTTY 80/40m  
o 10. ARKTIKA Polar Radioman  

o 11. ARRL-EME  

o 12. ARR PSK63  
o 13. Belgian Data Modes WW Contest  
o 14. Brazil Independance Day Contest  
o 15. Bucuresti Contest  
o 16. Worked All China Provinces  
o 17. Worked All China Provinces  

o 18. CA HF  
o 19. CQ WE  
o 20. CSA-VHF  
o 21. CUCALAMBE Contest  



o 22. DIG_PA Contest  

o 23. DNIEPER CUP  
o 24. The Day of YLs  
o 25. CONCURSO NACIONAL FONIA  

o 26. 50RS VHF  
o 27. Suffixes XXIX National  
o 28. EPC Ukrainian DX  
o 29. ES OPEN HF  
o 30. EUCW Frat Party  
o 31. EUCW ON5ME-160  
o 32. FGUP 2011  

o 33. PSK 31 Flavors  
o 34. Flight of the Bumblebees  
o 35. GEDEBAGE  
o 36. GENERIC  
o 37. GENERIC2  
o 38. GENERIC RTTY  

o 39. HA3NS Memorial Contest  
o 40. International Lighthouse Week 2010  
o 41. IRTS80M  
o 42. IRTS CQIR  
o 43. JW-FD  
o 44. Kanagawa  
o 45. KCJ  

o 46. Keymens Club of Japan  
o 47. KT Serbia Cup  
o 48. Lighthouse Christmas Lights 2010  
o 49. Lighthouse Spring Lites 2010  
o 50. LY WAL Contest  
o 51. Moscow-Championship  
o 52. Marconi Memorial Contest  

o 53. MOON CONTEST  
o 54. MULAN WAP  

o 55. North American QRP CW Club Sprints.  
o 56. NRL Cup  
o 57. NRRL TELEFONITEST  
o 58. OBLAST  

o 59. OH-PARKS  
o 60. OK-OM DX SSB  
o 61. Old New Year  
o 62. Original QRP  
o 63. OZ ACTIV Contest  
o 64. OZCHR-VHF  
o 65. PARLA  

o 66. SP PGA Contest  
o 67. SP PGA Contest  
o 68. Podxs 070 Contest  
o 69. Podxs 070 St. Patrick's Day Contest  

o 70. Popov Memorial  
o 71. POPOV-VHF  
o 72. PW 144 and 70Mhz  

o 73. QRP HF RTTY  
o 74. R3E-SC  
o 75. R4C Champ  
o 76. R4W (Udmurtia, Russia) Open Championship  
o 77. R6H Champ  
o 78. Championship of Astrahan oblast  

o 79. REGION-NR  
o 80. RUSSIAN160  



o 81. SALMON-RUN  

o 82. SARA Spring Sprint  
o 83. SARA Spring Sprint (OM)  
o 84. SCAG SPRINT  

o 85. Seanet Contest  
o 86. TA VHF UHF  
o 87. TARA SKIRMISH  
o 88. SMIRK  
o 89. SKMEM  
o 90. SP WW EPC BPSK63  
o 91. SPAR Winter FD  

o 92. SRR JR  
o 93. International 2010  
o 94. SV Triathlon  
o 95. TenTen QSO Parties  
o 96. Tesla HF Memorial Contest  
o 97. UFT HF Contest  

o 98. UK DXC BPSK63  
o 99. URAL CUP  
o 100. RSGB VHF Contests  
o 101. WAB Contests  
o 102. USi W/VE Islands Qso Party  
o 103. UT5EU-MEMORIAL-VHF  
o 104. DigiFest  

o 105. RSGB UKAC (VHF)  
o 106. VHF GRIDS  
o 107. RSGB VHF Contests  
o 108. Vytautas Magnus trophy  
o 109. VU Himalayan Contest  
o 110. VU International DX Contest  
o 111. VU Summer (Internal) Contest  

o 112. WSEM minitest  
o 113. World Lighthouse OTA  

o 114. YACHAMP  
o 115. YL-OM  
o 116. YO PSK31  
o 117. ZOMBIE  

The User Defined Contests listed below have been developed by users of N1MM Logger, and should 
work as described although they are not officially supported by N1MM Logger.  

There are probably additional details within the .UDC file regarding contest setup and exchange. Use a 
text editor to examine the file after downloading from the >Files >User Defined Contests gallery. Be 
advised that there are known scoring anomalies with some of the UDC contests.  

Installation Instructions for a User Defined Contest (UDC) 

o A list of User Defined Contests is located on the >Documentation >Digging Deeper 

>Supported User Defined Contests page  
o The UDC files themselved are located under >Files >User Defined Contests  
o To enable a UDC contest and select it in the contest configuration dialog window  

1. Locate the desired UDC file on the >Files >User Defined Contests page  
2. Download the .UDC file to your computer's hard drive in the /N1MM 

Logger/UserDefinedContests directory  

3. Restart N1MM Logger  
4. Within N1MM Logger, select >File >New Log in Database >File Type  
5. Choose the UDC contest name you downloaded (without the .UDC file suffix). 

It will be included in alphabetic order among the list of all other supported 
contest names. NOTE: if you do not see the contest in that list, use a text 

http://n1mm.hamdocs.com/tiki-index.php?page=Supported+User+Defined+Contests
http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=18


editor (Notepad) to open the UDC file. Find the "Name =" statement (around 

line 10 of the file) which defines the actual contest name. In some instances 
the Name= statement may not match the Windows .UDC file name.  

 
 
 

1. PODXS Valentine Sprint Contest 

PODXS070 Club Valentine Sprint. Select log type: 070VSRTTY. Exchange Call, Name, OM/YL and 
State/Province/DXCC Entity.  
After the contest, edit "YL"s to 2 points. Complete Contest name in log.  

 See the UDC file for more details  

 Filename: 070VSRTTY.udc  

 
 

2. ACHAMPCW 

Asiatic Russia (UA9) Championship CW  

 See the UDC file for more details  

 Filename: ACHAMPCW.UDC  

 
 

3. ARKTIKA-SPRING 

ARKTIKA-SPRING contest file  

 See the UDC file for more details  

 Filename: AC-SPRING.UDC  

 
 

4. AEGEAN RTTY Contest 

Generic - RST and Serial Nr. Runs OK with a fixed amount of points per qso.  
Select log type: AEGEANRTTY  

 See the UDC file for more details  

 Filename: AEGEANRTTY.udc  

 
 

5. AGB 



AGB-NEMIGA Contest. Third Friday of September (16 Sep 2011) 2100 - 2400 UT  

 See the UDC file for more details  

 Filename: AGB.udc  

 
 

6. AGB NYSB/NEMIGA/PARTY 

AGB NEMIGA, Allows RY and PSK modes. Select "MIXED+DIG" for "Mode Category"  

Exchange: RS(T) + Serial Nr and AGB Member Nr (if a member)  
Complete Contest name in log.  

 See the UDC file for more details  

 Filename: AGB_RTTY.UDC  

 
 

7. AGB Party 

AGB-PARTY (Activity Group of Belarus) Contest. Third Friday of December (16 Dec 2011) 2100 - 2400 
UT  

 See the UDC file for more details  

 Filename: AGBPARTY.UDC  

 
 

8. Alaska QSO Party 

If using SSB/CW plus Digital, Select MIXED+DIG in the Contest Setup Window. Enter QSO points on 
logging line.  
Select file name: AKQP_RTTY  
Exchange: Serial Nr, Name and Grid Square  

 See the UDC file for more details  

 Filename: AKQP_RTTY.UDC  

 
 

9. ARI RTTY 80/40m 

(Set up for Italian domestic) ARI 80/40m RTTY Contest  
Select file name: ARIRTTY  
Exchange: Your Area Code  

 See the UDC file for more details  

 Filename: ARIRTTY.UDC  



 
 

10. ARKTIKA Polar Radioman 

Exchange: RST + Arktika Club Member Number e.g. 599 AC999. Non-members send RST + Serial 
Number. Club member numbers are mults, once only.  

 See ARKTIKA_read-me.txt  

 Filename: ARKTIKAPR.zip.  

 
 

11. ARRL-EME 

VHF/UHF only, signal report as exchange, dupes are not allowed on same band CW, SSB and FM 
modes  

 See the UDC file for more details  

 Filename: ARRL_EME.udc  

 
 

12. ARR PSK63 

ARR PSK63 contest.  
Select log type: ARR_RTTY. Exchange RST and Serial. Multipliers are DXCC and "CT" Callsigns.  

 See the UDC file for more details  

 Filename: ARR_RTTY.udc  

 
 

13. Belgian Data Modes WW Contest 

Belgian Data Modes WW Contest. If using AFSK, Select DIGITAL in the Contest Setup Window.  

 See the UDC file for more details  

 Filename: BDMWWRTTY.udc  

 
 

14. Brazil Independance Day Contest 

Brazilian Independance Day PSK31 Contest. Select DIGITAL in Setup Window. v1.0.1,  

 See the UDC file for more details  

 Filename: BRAZ_IRTTY.udc  



 
 

15. Bucuresti Contest 

Generic, Serial # and YO District or Country WEB Identifier (e.g. Belgium=BE, Sweden=SE) as 
exchange.  
If using Mixed modes, select MIXED+DIG in the Contest Setup Dialogue.  

 See Bucuresti_Read_Me.txt file for more details (In Bucuresti.zip)  

 Filename: BUCURRTTY.udc  

 
 

16. Worked All China Provinces 

Worked All Provinces of China contest (for BY stations)  
Select log type: BY_WAPC_BY  
Contest Exchange: RS(T) and your Province i.d. DX send RS(T) and Serial Nr.  

 See the UDC file for more details  

 Filename: BY_WAPC_BY.udc  

 
 

17. Worked All China Provinces 

Worked All Provinces of China (for DX stations)  

Select log type: BY_WAPC_DX  
Contest Exchange: RS(T) and Serial NR, Chinese Stations send RS(T) and 2 figure Province Code.  

 See the UDC file for more details  

 Filename: BY_WAPC_DX.udc  

 
 

18. CA HF 

Central America contest. Contact Argentinean & Nearby countries. Exchange RST and Serial. Provinces 
are mulpliers,  

 See the UDC file for more details  

 Filename: CAHF.udc  

 
 

19. CQ WE 



CQ Western Electric Contest. Contact Employees, Retired Employees or other Amateurs. Exchange 

Name, WE Locator and years of service. Non-employees give number of CQ WE Contests entered (1 if 
current is the first, can be 1-6) If using all modes, be sure to select 'MIXED+DIG' on contest set-up 
page.  

 See the rules for full details.  

 Filename: CQWE_RTTY.udc  

 
 

20. CSA-VHF 

South American VHF contest  

 See the UDC file for more details  

 Filename: CSA-VHF.udc  

 
 

21. CUCALAMBE Contest 

National Cuban contest \Cucalambe  
Select log type: CUCALAMBE  

Exchange: AREA Code  
Import Section file (CUCALAMBE.sec required in N1MM main folder)  

 See the UDC file for more details.  

 Filename: CUCALAMBE.udc  

 
 

22. DIG_PA Contest 

DIG_PA Contest  
Select log type: DIG_PA  
Exchange: RS(T) and Member Number or just RS(T) if not a member.  

 See UDC file for more details.  

 Filename: DIG-PA.udc  

 
 

23. DNIEPER CUP 

DNIEPER CUP. Send and receive two-letter AREA + Serial Nr. Start new contest each Session (Set 
correct Mode in Contest Setup Window,  
Select file name: DNIEPERTTY.  
Exchange: Serial Nr (must be first) and a two letter Area or District or County Code.  



 See the UDC file for more details  

 Filename: DNIEPERTTY.UDC  

 
 

24. The Day of YLs 

\Days of YLs\(YL/OM party) - Exchange: RS(T) + YL or OM. Work same station each band and mode.  
Select log type DOYLSRTTY  
Mode Select: If using all modes, select MIXED+DIG  
Exchange: OM or YL  

 See the UDC file for more details  

 Filename: DOYLSRTTY.udc  

 
 

25. CONCURSO NACIONAL FONIA 

Spanish National Phone Contest (RADIO CLUB SEVILLA)  

 See the UDC file for more details  

 Filename: EACNF.UDC  

 
 

26. 50RS VHF 

50MHz RASE DX Sprint.  
",  

 See the UDC file for more details  

 Filename: EARSVHF.udc  

 
 

27. Suffixes XXIX National 

Suffixes XXIX National (EA). RS and Province as exchange.  

 See the UDC file for more details  

 Filename: EASUFF29.zip  

 
 

28. EPC Ukrainian DX 



Set of files for EPC Ukraine DX Contest (for participants outside of Ukraine). See the post on 
11/29/2011 in N1MMLogger-Digital@yahoogroups.com for installation instructions  

 See the UDC file for more details  

 Filename: EPCUkrDX_FOR_DX.zip  

 
 

29. ES OPEN HF 

ES Open HF Championship (see files for versions 1.0 AND 1.1.0),  

 See the UDC file for more details  

 Filename: ES_Open_HF.udc  

 
 

30. EUCW Frat Party 

EUCW Fraternizing Party. Whatever is entered in Comment (Club Name) is a multiplier.  
Select log type: EUCWFP  
Exchange: Your name, (Club name), Member Nr. or NM  

 See the UDC file for more details  

 Filename: EUCWFP.udc  

 
 

31. EUCW ON5ME-160 

EUCW ON5ME-160 Party. Whatever is entered in Comment (Club Name) is a multiplier.  
Select log type: EUCW160  
Exchange: Your name, (Club name), Member Nr. or NM  

 See rules for more details.  

 Filename: EUCW160.udc  

 
 

32. FGUP 2011 

"Generic" contest, RS(T) and Serial Nr Exchange, All Callsigns are Multipliers.  

 See the UDC file for more details  

 Filename: FGUP-2011.UDC  

 
 



33. PSK 31 Flavors 

31 FLAVORS CONTEST (PODXS). Former name - FLAVORSPSK.udc,  
Select file type: FLAVORRTTY  
Exchange: State/Province or DXCC Entity + 070 member number/Name, if not member  

 See the UDC file for more details  

 Filename: FLAVORRTTY.udc  

 
 

34. Flight of the Bumblebees 

Flight of the Bumblebees contest.  

Select file name: FLTOTBBS  
Exchange: State/Province/DXCC Entity and Power or Bumblebee Nr.  

 See the UDC file for more details  

 Filename: FLTOTBBS.udc  

 
 

35. GEDEBAGE 

Generic, RS(T) + Serial Nr. WPX Prefix Mult.  

 Filename: GEDEBAGE.udc  

 
 

36. GENERIC 

Template for Serial # and State(Prov) as exchange. One multiplier - Section  

 See the UDC file for more details  

 Filename: Generic.udc  

 
 

37. GENERIC2 

Template for Serial # and State(Prov) as exchange. 2 multipliers: Section and Country  

 See the UDC file for more details  

 Filename: Generic2.udc  

 
 



38. GENERIC RTTY 

Generic, Serial # and State(Prov) as exchange  

 See the UDC file for more details  

 Filename: GenericRTTY.udc  

 
 

39. HA3NS Memorial Contest 

Exchange RST and HACWG Member Nr or NM  

 See the UDC file for more details  

 Filename: HA3NS.udc  

 
 

40. International Lighthouse Week 2010 

International Lighthouse Week (Serial#, Name, Member# as applicable, Lighthouse# as applicable, 
State(Prov), as exchange)  

 See the UDC file for more details  

 Filename: ILLW-2010.udc  

 
 

41. IRTS80M 

IRTS 80 Metres Counties Contest. CW/SSB, 80m only, Serial # and County as exchange  

 See the UDC file for more details  

 Filename: IRTS80M.udc  

 
 

42. IRTS CQIR 

IRTS CQIR Contest  
Select File name: IRTSCQIR  
Exchange: Irish - Serial and County Code, Others - only Serial  

 See the UDC file for more details  

 Filename: IRTSCQIR.udc  

 
 



43. JW-FD 

JOCK WHITE MEMORIAL FIELD DAY (NZART). 80/40m, SSB/CW, Report/Serial #/Branch # as 
exchange, 1 hour sessions  

 See the UDC file for more details  

 Filename: JWFD.udc  

 
 

44. Kanagawa 

Internal JA contest  

 See the UDC file for more details  

 Filename: kanagawa.udc  

 
 

45. KCJ 

KCJ(Keymen's Club of Japan) contest. Version for the rest of the world (not JA), Prefecture as 
exchange  

 See the UDC file for more details  

 Filename: KCJ.udc  

 
 

46. Keymens Club of Japan 

KCJ (Keymen's Club of Japan Contest).  
Select file type: KCJ_JA or KCJ_DX as appropriate.  
Exchange: JA - Prefecture or District Code, Others, Continent Code e.g. EU  
See KCJ-DX.UDC for Non-JA entrants. v1.0.2; KCJ_JA.UDC for JA entrants  

 See the UDC file for more details  

 Filename: KCJ_DX.udc  

 
 

47. KT Serbia Cup 

KT Serbia Cup Contest  

 See KTKUP.txt in KTKUP.zip  

 Filename: KTKUP.udc or KTKUP_YU.udc  



 
 

48. Lighthouse Christmas Lights 2010 

Lighthouse Christmas Lights 2010  

 See the UDC file for more details  

 Filename: LCL-2010.udc  

 
 

49. Lighthouse Spring Lites 2010 

Lighthouse Spring Lites 2010,  

 See the UDC file for more details  

 Filename: LightHouseEvent.udc  

 
 

50. LY WAL Contest 

LY WAL Contest (Worked All Lithuania)  
Select file type: LYWAL  
Exchange: LY - WAL Area, Others, DX  

 See the UDC file for more details  

 Filename: LYWAL.udc  

 
 

51. Moscow-Championship 

Moscow Championship. Oblast(Rus) and Serial # as exchange. Oblast and every Moscow (MA) callsign 
is multiplier  

 See the UDC file for more details  

 Filename: Moskwa_Champ.udc  

 
 

52. Marconi Memorial Contest 

Marconi Memorial Contest. Generic, RST+Serial NR Exchange, CQWW-type Country Prefix as Multiplier  

 See the UDC file for more details  

 Filename: MARCONIMEM.udc  



 
 

53. MOON CONTEST 

MOON CONTEST  
Select file type: MOONRTTY  
Exchange: Serial Nr + 6 Character Locator + Name of QTH  
Note =Use for all - restrict Band to suit. Generate correct claimed score after contest by editing qso 
points - do not rescore when prompted.  

 See the UDC file for more details  

 Filename: MOONRTTY.udc  

 
 

54. MULAN WAP 

MULAN DX Contest. 80,40,20,15,10m SSB/CW,Serial/Province  

 See the UDC file for more details  

 Filename: MulanDXC.udc  

 
 

55. North American QRP CW Club Sprints. 

Exchange: RST, State/Province/DXCC and Member Nr. or Power (include the 'W')  

 See the rules for more details.  

 Filename: NAQCC.udc  

 
 

56. NRL Cup 

(Russian internal contest).  

 See the UDC file for more details  

 Filename: NRLC.UDC  

 
 

57. NRRL TELEFONITEST 

NRRL (Norsk Radio RelÃƒÆ’Ã†â€™Ãƒâ€šÃ‚Â¦ Liga) TELEFONITEST  
(Internal Norwegian Contest)  



 See the UDC file for more details  

 Filename: NRRLTELE.udc  

 
 

58. OBLAST 

Use as a template - serial # and Oblast(Rus) as exchange. Oblast is multiplier  

 See the UDC file for more details  

 Filename: Oblast.udc  

 
 

59. OH-PARKS 

OHIO State parks are multipliers. 1 point per every QSO  

 See the UDC file for more details  

 Filename: OH-Parks.udc  

 
 

60. OK-OM DX SSB 

OK-OM DX SSB Contest. OK-OM Stations send RS + County Code, Others send RS + Serial Nr. CQWW 
and County Codes are Mults.  

 See OKOM DX SSB.txt in OKOM DX SSB.zip  

 Filename: OKOMDXS.udc or OKOMDXS_DX.udc  

 
 

61. Old New Year 

RS(T) and NR (Age of OP. plus Years of Experience) as exchange  
Select file name: OLDNEWYEAR  
Exchange: Serial Nr and (Total of your Age + Number of Years YOU have held Licence).  

 See the UDC file for more details  

 Filename: OLDNEWYEAR.udc  

 
 

62. Original QRP 

O R I G I N A L - Q R P - C O N T E S T. Serial # and Category (VLP, QRP or MP) as exchange  



 See the UDC file for more details  

 Filename: OQRP.udc  

 
 

63. OZ ACTIV Contest 

(Danish Internal Contest?)  
OZ Activity Contest (Serial # and Post Code (first digit) as exchange)  

 See the UDC file for more details  

 Filename: OZACTIV.udc  

 
 

64. OZCHR-VHF 

OZCHR-VHF (Russian VHF contest). ?????? ?????? ??? ???????. VHF bands only, 6 char. GriqSquare as 
exchange, dupes are not allowed on same band different modes  

 See the UDC file for more details  

 Filename: OZCHR_OCHN.udc  

 
 

65. PARLA 

PARLA(EA) CW CONTEST  

 See the UDC file for more details  

 Filename: PARL.UDC  

 
 

66. SP PGA Contest 

Polish PGA-Test, Non-SP Stations",  

 See the UDC file for more details  

 Filename: PGATEST-DX.udc  

 
 

67. SP PGA Contest 

Polish PGA-Test, for Polish Stations",  

http://n1mm.hamdocs.com/tiki-print_multi_pages.php??????%20??????%20???%20???????


 See the UDC file for more details  

 Filename: PGATEST-SP.udc  

 
 

68. Podxs 070 Contest 

Use for several PODXS070 Club contests. Exchange Call, RST and State/Province or DXCC Entity. Use 
for PSK Festival, Jay Hudak Memorial, Pumpkin Sprint and Firecracker  

 See the UDC file for more details  

 Filename: PODXS1RTTY.udc  

 
 

69. Podxs 070 St. Patrick's Day Contest 

Use for PODXS070 Club St. Patrick's Day Contest. Exchange Call, Name, State/Province or DXCC 
Entity and Member Nr.  

 See the rules for more details  

 Filename: PODXS2RTTY.udc  

 
 

70. Popov Memorial 

POPOV MEMORIAL CONTEST - RS(T) and NR (Years of Experience) as exchange  

 See the UDC file for more details  

 Filename: PopovMemorial.udc  

 
 

71. POPOV-VHF 

(Russian internal VHF contest). 2M only, serial # and GriqSquare as exchange, dupes are not allowed 
on same band CW, SSB and FM modes  

 See the UDC file for more details  

 Filename: Popov_Cup_VHF.udc  

 
 

72. PW 144 and 70Mhz 



PW 144 and 70Mhz.  

Select file name: PW_144_70  
Exchange: Locator. 4 Character Square  

 See the UDC file for more details  

 Filename: PW_144_70.UDC  

 
 

73. QRP HF RTTY 

QRP HF RTTY Contest.  

Exchange: RST and CQ Zone  

 See the UDC file for more details  

 Filename: QRPHFRTTY.UDC  

 
 

74. R3E-SC 

Russian internal contest (\????? ?????????\"").""",  

 See the UDC file for more details  

 Filename: R3E-SC.UDC  

 
 

75. R4C Champ 

Russian internal contest (???????? ?????????? ??????????? ???????)  

 See the UDC file for more details  

 Filename: R4C-Champ.UDC  

 
 

76. R4W (Udmurtia, Russia) Open Championship 

Russian internal contest  

 See the UDC file for more details  

 Filename: r4w-champ.udc  

 
 



77. R6H Champ 

Russian internal contest (???????? ????????? ??????????????? ????)  

 See the UDC file for more details  

 Filename: R6H-Champ.UDC  

 
 

78. Championship of Astrahan oblast 

Russian internal contest (???????? ????????? ???????????? ???????)  

 See the UDC file for more details  

 Filename: R6U-Champ.udc  

 
 

79. REGION-NR 

Russian internal contest (????????? ?????????? ???????)  

 See the UDC file for more details  

 Filename: REGION-NR.udc  

 
 

80. RUSSIAN160 

RUSSIAN 160 m contest (Contest Board will calculate points)  

 See the UDC file for more details  

 Filename: RUSSIAN160.UDC  

 
 

81. SALMON-RUN 

This contest is published for learning purposes only. WA QSO party (aka Salmon Run) is fully 
supported by the logger  

 See the UDC file for more details  

 Filename: Salmon_Run.udc  

 
 

82. SARA Spring Sprint 



SARA Spring Sprint. Exchange: RST, Locator and Class, Locator and WPXprefix are Mults  

Select file name: SARA  
Exchange: Your Locator and Class of entry.  

 See the UDC file for more details  

 Filename: SARA.UDC  

 
 

83. SARA Spring Sprint (OM) 

SARA Spring Sprint (for OM stations). Exchange: RST, Locator and Class, Locator and WPXprefix are 
Mults  
Select file name: SARAOM  
Exchange: Your Locator and Class of entry.  

 See the UDC file for more details  

 Filename: SARAOM.udc  

 
 

84. SCAG SPRINT 

SCAG Sprint Cup (v1.0.2 2012-08-28),  
Select file name: SCAG  
Exchange: Name + Member (SCAG Club) Nr or NM  

 See the UDC file for more details  

 Filename: SCAG.udc  

 
 

85. Seanet Contest 

Seanet Contest , RST + Serial as exchange, DXCC Countries as Multipliers.  

Seanet Countries use SEANETRTTY.UDC; Non Seanet countries use SEANETRTTY2.UDC (Rename to 
SEANETRTTY.udc after copying to N1MM\UDC folder)  

 See the UDC file for more details  

 Filename: SEANETRTTY.udc  

 
 

86. TA VHF UHF 

TA VHF UHF Contest. Exchange: RS(T) Serial Nr. (Start at 001 on each band) Full Locator. Select 
MIXED in the Contest Setup Dialogue Window.  

 Filename: VHF_UHF_TA.udc  



 
 

87. TARA SKIRMISH 

TARA SKIRMISH Contest. Exchange: Name and Prefix (Area locator),  

 See the UDC file for more details  

 Filename: SKIRMRTTY.udc  

 
 

88. SMIRK 

Six Meter International Radio Klub contest. Exchange: SMIRK number, if the station worked has one, 
and grid  

 See the UDC file for more details  

 Filename: SMIRK.udc  

 
 

89. SKMEM 

Silent Key Memorial Contest. Exchange RST+ITU Zone or RST+a Silent Key Callsign.  

 Correct claimed score by deducting 1 point x Nr of Mults for each ITU Zone exchange received.  

 Filename: SKMEM.udc  

 
 

90. SP WW EPC BPSK63 

SP WW EPC BPSK63 Contest.  
Exchange: RST+Serial or SP Province Code. Province and DXCC are Multipliers.  

 See SPEPC_RTTY.text in SPEPC_RTTY.zip  

 Filename: SPEPC_RTTY.udc or SPEPCORTTY.udc  

 
 

91. SPAR Winter FD 

SPAR (Society for the Preservation of Amateur Radio) Winter Field Day,  

 See the UDC file for more details  

 Filename: SPAR_FD.udc  



 
 

92. SRR JR 

SRR (Russia) youth hams contest  

 See the UDC file for more details  

 Filename: SRRJR.UDC  

 
 

93. International 2010 

SWL template, both Callsigns, RS(T) and Serial numbers are logged  

 See the UDC file for more details  

 Filename: SWL.udc  

 
 

94. SV Triathlon 

Exchange: RS(T) and Serial. Entrants using all three modes select MIXED + DIG in the Contest Setup 
Window. After the contest, edit Cabrillo file CONTEST: name to TRIATHLON-DX-CONTEST. Correct 
claimed score - multiply 'B3' number by 3, then by number of multipliers, add to previous claimed 
score.  

 FIlename: TRIATHRTTY.udc  

 
 

95. TenTen QSO Parties 

Exchange: Name, TenTen #, & State(Prov. or Country). Use for all QSO parties - restrict mode to suit.  

 See the UDC file for more details  

 Filename: TENTENRTTY.udc  

 
 

96. Tesla HF Memorial Contest 

Exchange: RST, Serial Nr. and 4 Character Grid. After contest, edit own square contacts to 90 points.  

 Filename: TESLA_VHF.udc  

97. UFT HF Contest 



Exchange RST, Member Number or NM  

 Filename: UFT-HF.udc (in UFT-HF.zip)  

 
 

98. UK DXC BPSK63 

Exchange Real RSQ, Serial Nr. and your DXDA Number.  

 See UKDX63.txt in UKDX63RTTY.zip  

 Filename: UKDX63RTTY.udc  

 

 

99. URAL CUP 

Ural Cup (Kubok Urala)  

 See the UDC file for more details  

 Filename: Ural_Cup.udc  

 
 

100. RSGB VHF Contests 

This one Generic, Exchange RS(T), Serial Nr and Full Locator. 1 Point/Kilometer. No Multipliers.  

 See VHF_RSGB_ReadMe.txt in VHFRSGB.zip for other RSGB VHF Contests covered.  

 Filename: VHFRSGB.udc  

 
 

101. WAB Contests 

Worked All Britain Contests  

 See WAB ReadMe in WAB.zip  

 Filename: WAB.udc  

 
 

102. USi W/VE Islands Qso Party 

USi W/VE Qso Party  
If a station is going to use all three modes, in the contest set-up window select Mixed+Digi.  
Island stations should start a new log for each location (to re-start Serial Nr)  



Select file name: USI_QPRTTY  
Exchange: Island Designator(If Island station) and/or State/Province or DXCC Entity.  

 See the UDC file for more details  

 Filename: USI_QPRTTY.udc  

 
 

103. UT5EU-MEMORIAL-VHF 

VHF only, serial # and GriqSquare as exchange, dupes are not allowed on same band CW, SSB and FM 
modes  

 See the UDC file for more details  

 Filename: UT5EU_Memorial_VHF.u  

 
 

104. DigiFest 

Digifest Contest. Exchange: RSQ and Locator(4 digits) Locator is mult (once only). Work Station each 
band and mode. Note1 - In the 'Set up Contest Window' Set the Mode Category to 'DIGITAL'. Note2 - 
not all digital modes allowed in the contest are supported in MMVARI.  

 See the UDC file for more details  

 Filename: VHF_DFRTTY.UDC  

 
 

105. RSGB UKAC (VHF) 

RSGB UKAC (VHF). VHF+ only,Points per Km and UK GriqSquare multiplier ",  

 See the UDC file for more details  

 Filename: VHF_Paul4.UDC  

 
 

106. VHF GRIDS 

Worked All Provinces of The Netherlands: Exchange RS(T), Serial NR and Grid, Dutch Stations send 

RS(T), Serial NR and 2 figure Province Code. Unzip the file (there will be 2 files - udc and txt), import 
CallHist_VHF_WAP.txt and turn Call History Lookup on.  

 See the UDC file for more details  

 Filename: VHF_WAP.zip  



 
 

107. RSGB VHF Contests 

6 VHF RSGB contest files, RSGB.sec file and short description in VHF_RSGB_Read_Me.txt file",  

 See the UDC file for more details  

 Filename: VHFRSGB.zip  

 
 

108. Vytautas Magnus trophy 

Vytautas Magnus Trophy (v1.0.2) Held the first Sunday AFTER the new year. 80m and 2m. CW and 
Phone. Exchange RS(T), Serial Nr and full Locator(Multipliers)  

 See the UDC file for more details  

 Filename: VMTROPHY.udc  

 
 

109. VU Himalayan Contest 

Indian Stations send RS(T) and 2 figure State or Union Territory Code. Others RS(T) and Power  
Use the correct UDC file for your location.  

 See VU_Read-Me.txt in VU.zip for more details.  

 Filename: VU_HIMA_DX.udc or VU_HIMA_VU.udc (in VU.zip)  

 
 

110. VU International DX Contest 

Indian Stations send RS(T) and 2 figure State or Union Territory Code, others RS(T) and Serial 
Number.  
Use the correct UDC file for your location. Select log type: VU_DX_ VU=VU Stations, DX=Non-Asian 
Stations, ASIA=Non-VU Stations.  

 See VU_Intl_Read-Me.txt in VU.zip for full details.  

 Filename: VU_DX_VU.udc or VU_DX_ASIA.udc or VU_DX_DX.udc  

 
 

111. VU Summer (Internal) Contest 

Exchange: RS(T) and Serial Number  



 Select correct Mode Category in the Contest Set up Dialogue Window, e.g. MIXED+DIG if 

working all three modes.  

 Filename: VUSUMMRTTY.udc (in VU.zip)  

 
 

112. WSEM minitest 

This contest is already implemented as MINITESTCW in the logger. Use this udc file for learning only. 
RST, Serial Nr, 80 metres only. Note=Contest is every Wednesday, 1800-1900 GMT, six periods, work 
each station each 10 minutes, each call is mult once ",  

 See the UDC file for more details  

 Filename: WESM.udc  

 
 

113. World Lighthouse OTA 

World Lighthouse OTA. Exchange: RS(T) Serial Nr, plus Lighthouse Expeditions send Reference Nr 
(Lxxxx)  

 See the UDC file for more details  

 Filename: WLOTARTTY.udc  

 
 

114. YACHAMP 

YAKUTIA CHAMPIONSHIP (???????? ????????? ??????)  

 See the UDC file for more details  

 Filename: YA CHAMP.UDC  

 
 

115. YL-OM 

The YL-OM Contest is scheduled (1400 UTC Feb-11-2011 thru 0200 UTC Feb-13-2011)  
Exchange: Station Worked, QSO Number, RST, ARRL/RAC Section or DX Country",  

 See the UDC file for more details  

 Filename: YLOM.udc  

 
 

116. YO PSK31 



YO PSK31 contest. RST, Serial NR and Country ID (e.g. G) - YO send County Code as exchange  

Select file name: YORTTY  
Exchange: Serial Nr and Your Country Prefix - YO Stations: Serial Nr and County Code  

 See the UDC file for more details  

 Filename: YORTTY.udc  

 
 

117. ZOMBIE 

Exchange: S/P/C + Zombie NR/Phone 3 digit area code + Name + Years held Licence. CW only.  
Select file name: ZOMBIE  
Exchange: State/Province/Country I.D. and your Zombie Member Nr or 3 Digit phone area code and 

your Name and Number of years you have held Licence.  
Work out your score. (See rules)  

 See the UDC file for more details  

 Filename: ZOMBIE.udc  

 

 

2.1.5 Call History and Reverse Call History Lookup 

1. Call History Lookup 

Call History Lookup is a feature that can be used to pre-fill the exchange during a contest to save 
typing, or to display user comments or notes for specific call-signs. The sources of Call History data 
can be previous contest logs, files from other users, or hand-generated data files of your own.  Your 

club may generate Call history files for Sweepstakes, for example, or you may choose to generate 
your own from last year's log.  You might choose to harvest names and call-signs from your general 
log, so that you can recognize people by name on the air.  

Before using the Call History Lookup feature, Call History Lookup must be selected on the Entry 
Window's Config menu, and  the user must import a text file containing comma-separated data into 
the current database. Whenever a Call History text file is imported into the database by either means, 
the new Call History data completely replace the existing data.  

There can be only one Call History table present in a given database at a time, and it remains in the 
database unless replaced with another. The Call History text file can be imported manually or 
associated with a specific contest in the Contest Setup dialog, on the Associated Files tab. This way, 
whenever that specific contest is loaded, the Call History data for that contest will also be loaded.  

When a callsign is typed into the Entry window and the Space bar is pressed (or Enter, in the ESM 
case), the Call History database is searched. If the callsign is found, the associated Call History data is 

displayed on the "beam heading" line in the Entry window. If the contest exchange fields are blank, 
the data retrieved from the database are also used to pre-fill any relevant  exchange field(s) in the 
Entry window. Finally, if the Entry window height is large enough, the data found in the UserText field 
are displayed below the bearing line. It is not necessary for Call History to be enabled in the Config 
menu to display the UserText information.  



The Call History Lookup function adds the UserText field to the Call History database. The data in the 

UserText field is displayed below the Bearing line in the EntryWindow if the window height is 
increased. The Call History function does not need to be enabled in the Config menu for the UserText 
information to be displayed.  

Here are some Entry window examples. The second snapshot includes the UserText display.  

 

 

 

In VHF contests, the grid square from the Call History table is used to calculate the beam heading 
reported in the Bandmap.  



 

1.1. The Call History Text File 

The best source of data for a given contest is a previous contest log from the same contest. Simply 
open the old log, click > Tools > Clear Call History to empty the Call History database table, then click 
Update with Current Log.  

If you want to draw on multiple logs for the same contest, you can repeat these steps with each one. 
Using a text-only editor like NotePad, combine the files into one, with the oldest contest data at the 

top of the file. It is not necessary to remove any of the exported lines when combining multiple 
exported Call History text files. Comments can be inserted in the file if you want - simply place 
a   #   character at the beginning of every comment line.  

This single-log or multiple-log combined file can be imported into the Call History table in your current 
data base with > File >Import > Import Call History.  Enable the Call History option in > Config and 
the task is complete.  

You can also use data from other contests or sources to populate the Call History database.  You can 
move or exclude columns of data, map ARRL section to State, map State to ARRL section, or truncate 
a six character grid square to four characters.  

This is accomplished with the use of import directive commands, which are surrounded  with "!!" , to 
tell the program that they are instructions, not data. When an import directive command is read, the 
import routine follows that instruction until another import directive command is read or all data is 
imported. Import directive commands can be repeated if the data structure or field order changes in 
the data.  

Here is a list of the import directive commands that can be used in a Call History text file:  

  !!Order!! - defines the order of the comma separated input data that follow  
  !!MapStateToSect!! - populate empty Sect field from the State information  
  !!FourCharGridSq!! - truncates 6 character grid squares to 4 character grid squares  

  !!AppendUserText!! - append additional user text into the UserText field (default)  
  !!NoAppendUserText!! - do not append user text into the UserText field, new data replaces prior  
  !!Validate50State!! - ignore all state data that isn't one of the 50 states  
!!NoLoc2AltGrid!! - do not move the existing Loc1 grid into Loc2 for an alternate grid location  



Every exported Call History text file lists the import directives, the field names, and the maximum 

size. Here are the Call History field names along with the maximum size. The import routine will 
truncate any field that exceeds the maximum, discard any CK value that is not a number, and discard 
any Birthdate that is not a date.  

  Call(15), Name(20), Loc1(6), Loc2(6), Sect(8), State(8), CK(#), Birthdate(date), Exch1(12), 
Misc(15), UserText(60),  

If an  !!Order!! input directive is not read during file import, the routine expects the data to be in this 
comma separated order:  

Call, Name, Loc1, Loc2, Sect, State, CK, BirthDate, Exch1, Misc, UserText  

Here's an example of Call History data that will import without an import directive:  

K3CT, JOHN , , , ,PA , , ,NHA, , N1MM Program Developer  

As you can see, each comma denotes a field.  Successive commas mean empty fields. Spaces can be 
added to make it easier to count the number of commas. If this single line file was imported into the 
Call History database and the Call History Look Up option is enabled, the Entry window for the PA QSO 
Party would appear like this when the callsign K3CT was entered and spacebar pressed (or Enter with 
ESM):  

 

 
As you can imagine, making sure you have the right number of commas between actual data in the 

text file can be a problem.  Fortunately, the !!Order!! command offers a simple solution. For example, 

you create a text file that looks like this:  
!!Order!!, Call, Name, CK, Sect  
N4ZR, Pete ,54 ,WV  
N3OC, Brian, 67, MDC  

When you load it into the Call History database, the data will be put in their proper places in the Call 
History table, and when you operate in Sweepstakes, for example, with Call History Lookup enabled, 
the program will pre-fill the check and section in the Exchange field, and will display the name and all 
the other data in the Bearing line of the Exchange Window.  This redundancy is deliberate, because if 



you set out to edit the Exchange and then realize that the pre-filled data were correct, they are there 
for ready reference.  

What this change has done is to make it much easier to generate Call History text files for importing 
into the Call History database. For example, you could generate a file that contains calls, names, 
checks and sections for everyone you worked last year in Sweepstakes, and by writing the correct 
!!Order!! line, like this:  
!!Order!!,Call,Name,CK,Sect  

The !!Order!! import directive can also be used to ignore columns of data. For instance, if the data file 

contains additional columns as shown below:  
DD3JN, 70 23, GERD, JO42AI,JO31OE  
PA1M, 144 70, Carel, JO33FE, JO33II  

The second column can be ignored with the import directive prior to the data.  
!!Order!!, Call,, Name, Loc1, Loc2  

DD3JN, 70 23, GERD, JO42AI,JO31OE  
PA1M, 144 70, Carel, JO33FE, JO33II  

Alternately, the second column of data can be placed in the UserText field with the following import 
directive:  
!!Order!!,Call,UserText,Name,Loc1,Loc2  
DD3JN, 70 23, GERD, JO42AI,JO31OE  
PA1M, 144 70, Carel, JO33FE, JO33II  

The Supported Contests section of this manual may include the Call History field(s) used for exchange 
information. If the field information is not listed in this section follow this procedure to determine 
which Call History field to populate.  

 Open a new contest log.  

 Log some dummy QSO's that contain the exchanges of interest.  

 Click Tools, Clear Call History then Update with Current Log.  

 Export the Call History (File, Export, Export Call History) and examine the exported QSO text.  

 Place the exchange data in the populated call history field. The coding of some contests is 
complex. It is not unusual to find that contests that store information in fields for points 
calculation, determining multipliers, or exporting Cabrillo. Therefore, it may not be necessary 
to populate all of the Call History fields.  

 
If your Call History file import doesn't function correctly, review the import directive(s) to make sure 

they match the field names. For example, you must use Sect, not sec or Sec, and Ck, not Check. 
Field name case is not important. All of these field names will import data into the Sect field: Sect, 
SECT, sect, sEcT, SeCt. If problems continue, post a message on the N1MM Logger email reflector 
asking the other users for help.  

1.2. Related Menu Options 

 >Config >Call History Lookup  
o Check to enable Call History Lookup.  

 >File >Import  >Import Call History  

o Select the file to be imported.  All information in the Call History table in the database 
is erased, and the imported information substituted.  

 >Tools >Update Call History with Current Log  

o Update the call history table in the current database with the QSOs from the current 
log. Contacts will be added when new or updated when already in the call history 



table. For the 2 grid fields the behavior is a bit different. When both grid fields are 

filled and a new third grid has been logged, the second grid (oldest) will be removed, 
and replaced by the contents of the first field. The new grid will be added to the first 
position. The same change in position will happen when only the first grid is filled and 

a new grid has to be added from the log. A 4 digit grid will be overwritten by a 6 digit 
grid when the first 4 characters are the same.  

 > Tools > Clear Call History then Update with Current Log  
o As above, except clears the call history table before adding contacts from the current 

log. Can be used to start a new Call History table  

 >File >Export >Export Call History  
o Exports the information in the Call History table. It is very important, particularly if 

you have changed the Call History table, to re-export the data as a Call History text 

file.  Otherwise, any changes will be lost.  You are given the opportunity to rename the 
text file so that, for example, a 2008 SS file can be renamed 2009 SS, to indicate that 
it has been updated.  

You can import any Call History file that you formerly used without an !!Order!! directive.  When you 
export a Call History text file, the program fills in the commas that are necessary to fit the default 
order, as well as -1 for each empty CK and 1900-01-01 for each empty Birthdate.  This is necessary to 
ensure compatibility with your old Call History files.  

2. Reverse Call History Lookup 

In addition to the regular Call History lookup, where you type a call sign into the Entry window and the 
program pre-fills the exchange based on the data in the Call History file, there is also a Reverse Call 
History lookup feature, where you can enter an exchange into the Entry window and the program will 
search the log and the Call History file for callsigns that correspond with that exchange. This does not 

work in all contests (for example, it makes no sense for serial numbers and it doesn't work for 
Sweepstakes because of the complicated exchange). If the Call History lookup option is selected, the 
Reverse lookup feature will search the Call History file as well as the log.  

The Reverse lookup feature is enabled using a pop-up (right-click) menu item in the Check window. If 
the Reverse lookup feature is not available for that contest, the menu item will be greyed out. Once 
the Reverse lookup feature has been enabled, you can type an exchange, or a partial exchange, in the 
exchange box in the Entry window, and if the number of characters typed in is equal to or greater 
than the threshold (which you can set with another pop-up menu item), the program will search in the 
log and the Call History table for callsigns whose exchange matches the typed-in exchange. Up to 100 

matching callsigns will be displayed in the Check window. Once you have determined which of the 
matching callsigns is the correct one, you can click on it in the Check window and the callsign and 
exchange will be transferred into the Entry window.  

If there was a full or partial call sign entered into the callsign box in the Entry window before entering 
the exchange, only call signs from the log or Call History file that match the partial call sign in the 
Entry window will be displayed in the Check window, and they will appear below the regular matching 
callsigns that were filled in from the log and the SCP file.  

You can also control whether the matches for the partial exchange can be found anywhere in the 
exchange field in the log and Call History file, or if the match must begin with the first character (that 
is, whether BC will match all of AABCD, ABC, BC, BCDE, etc. or whether it will only match BC, BCDE, 
etc.). Limiting the match to the first characters and/or increasing the threshold for the number of 
characters matched will result in faster lookups and smaller numbers of matching callsigns found.  

 

Note 

Both for prefilling the exchange and for reverse lookup, the name of the field in which the data is 

stored in the Call History file must match the name of the field that is used in that particular contest. 

http://n1mm.hamdocs.com/tiki-index.php?page=Check+Window


For example, if the state/province is part of the exchange, depending on the contest that part of the 

exchange might match the State, Sect or Exch1 field in the Call History file. You can use the !!Order!! 
directive to ensure that data in the Call History file is associated with the appropriate field name for 
the contest. For example, if you have a Call History file for the NAQP that looks like this:  

!!Order!!,Call,Name,State  
K3CT,John,PA  

then to use this same data file in a state QSO Party, you might have to change the first line of the file 
to!!Order!!,Call,Name,Exch1while leaving the rest of the data unchanged.You can determine which 

fields are used in a given contest type by creating a dummy instance of the contest, entering some 
typical fake contacts, using the Tools > Clear Call History then Update with Current Log menu item, 
exporting the Call History file to a temporary text file, and then examining that file with a text editor 
to see which field names are used for which exchange fields in that contest type. For some contest 
types, you may find the same exchange data in two fields in the Call History file. In such cases you 
may have to experiment to determine which of the fields is/are used for reverse lookup. 

 

2.2 Supported Radios 

 2.1.5 Call History and Reverse Call History Lookup  

o 1. Call History Lookup  
 1.1. The Call History Text File  
 1.2. Related Menu Options  

o 2. Reverse Call History Lookup  

 2.2 Supported Radios  

o 1. General Information  
o 2. Manual Mode - No Radio Selected  
o 3. Digital Mode Mapping  
o 4. Alinco  
o 5. Elecraft  

 5.1. K2  

 5.2. K3  
 5.3. KX3  

o 6. FlexRadio  
 6.1. Flex-5000A with RX2  
 6.2. Flex-1500, Flex-3000, Flex-5000A without RX2  
 6.3. SDR-1000 and SDR-5000A (using Kenwood settings)  

o 7. Icom  

 7.1. General Icom Information (all Icom owners please read)  
 7.2. IC-271 / IC-471 / IC-1271  
 7.3. IC-275A/E/H using address 10 hex.  
 7.4. IC-375 / IC-575 (all versions)  
 7.5. IC-475A/E/H using address 14 hex.  
 7.6. IC-703 using address 68 hex.  

 7.7. IC-706 using address 48 hex.  

 7.8. IC-706MKII using address 4E hex.  
 7.9. IC-706MKIIG using address 58 hex.  
 7.10. IC-718 using address 5E hex.  
 7.11. IC-725 using address 28 hex.  
 7.12. IC-728 using address 38 hex.  
 7.13. IC-729 using address 3A hex.  

 7.14. IC-735 using address 04 hex.  
 7.15. IC-736 using address 40 hex.  
 7.16. IC-737/737A using address 3C hex.  
 7.17. IC-738 using address 44 hex.  
 7.18. IC-746 using address 56 hex.  



 7.19. IC-746 PRO using address 66 hex.  

 7.20. IC-751/751A using address 1C hex.  
 7.21. IC-756 using address 50 hex.  
 7.22. IC-756 PRO using address 5C hex.  

 7.23. IC-756 PRO II using address 64 hex.  
 7.24. IC-756 PRO III using address 6E hex.  
 7.25. IC-761 using address 1E hex  
 7.26. IC-765 using address 2C hex.  
 7.27. IC-775/775DSP using address 46 hex.  
 7.28. IC-781 using address 26 hex.  
 7.29. IC-821H using address 4C hex.  

 7.30. IC-910H using address 60 hex.  
 7.31. IC-1275A/E using address 18 hex.  
 7.32. IC-7000 using address 70 hex.  
 7.33. IC-7200 using address 76 hex.  
 7.34. IC-7400 using address 66 hex.  
 7.35. IC-7410 using address 80 hex  

 7.36. IC-7600 using address 7A hex  
 7.37. IC-7700 using address 74 hex.  
 7.38. IC-7800 using address 6A hex.  
 7.39. IC-9100 using address 56 hex.  

o 8. Kenwood  
 8.1. General Kenwood information  
 8.2. TS-480  

 8.3. TS-570  
 8.4. TS-590  
 8.5. TS-850  
 8.6. TS-870  
 8.7. TS-950sdx  
 8.8. TS-50, TS-140, TS-440, TS-680,TS-711,TS-790,TS-811,TS-940  
 8.9. TS-2000  

 8.10. N1MM logger loses communication with the radio (TS-850, TS-950 etc.)  
o 9. TenTec  

 9.1. General TenTec information  
 9.2. ARGONAUT V  
 9.3. ARGONAUT VI  
 9.4. JUPITER  

 9.5. OMNI-VI  
 9.6. OMNI-VII  
 9.7. Orion  
 9.8. Eagle  

o 10. Yaesu  
 10.1. General Yaesu information  
 10.2. FT-80C  

 10.3. FT-100(D)  
 10.4. FT-736  
 10.5. FT-450  
 10.6. FT-747GX  

 10.7. FT-757  
 10.8. FT-757GXII  
 10.9. FT-767 / FT-767GX  

 10.10. FT-817  
 10.11. FT-840  
 10.12. FT-847  
 10.13. FT-857, FT-857D  
 10.14. FT-890  
 10.15. FT-897  

 10.16. FT-897D  
 10.17. FT-900  



 10.18. FT-920  

 10.19. FT-950  
 10.20. FT-990  
 10.21. FT-1000(D)  

 10.22. FT-1000MP (Mark-V)(Field) (Not for use with SteppIR antenna 
controller)  

 10.23. FT-1000MPSteppIR  
 10.24. FT-1000 series, FT-990 and FT-920 Setting filters  
 10.25. FT-2000  
 10.26. FTDX-1200  
 10.27. FTDX-3000  

 10.28. FTDX-5000  
 10.29. FTDX-9000  

o 11. Unsupported Radios  
o 12. Other Models  

Note: Known settings for specific transceivers, as well as program features that they do not support 
are mentioned below as far as we know them. Please advise us of any corrections or needed changes.  

1. General Information 

 When using a home-brew self-powered interface set the handshaking to:  

o DTR - Always On  
o RTS - Always On  
o Like when using ICOM clone cables  

 All radios: Band change is not allowed while transmitting  

 All radios: Timeout for all radios is default set to 10 seconds (user settable). Users generally 
increase this value to 13 - 15 seconds.  

o Some radios require initialization commands for configuration. These are sent to the 
radio when the program starts. Users should have the radio and interface powered 

prior to starting the program so this can occur. If the radio needs to be power cycled 

after the program has initialized, right click in the Bandmap and select Reset Radio to 
perform this initialization again.  

o A warning message will be displayed when no response received from the radio and 
the radio will be changed to a manual radio by the program.  

o To restart the radio radio interface polling select in the right-click menu from the 

bandmap "Reset radios"  
o When the radio control gives a warning 10 seconds after you start the logger, then 

you never had radio control at all, and you should check your hardware, and serial 
port settings. Consult the manual from your radio and also read below.Some radios 
require initialization commands for configuration. These are sent to the radio when the 
program starts. Users should have the radio and interface powered prior to starting 
the program so this can occur. If the radio needs to be power cycled after the program 

has initialized, right click in the Bandmap and select Reset Radio to perform this 
initialization again  

 Polling of radios while sending CW is supported for all radio except for FT-1000.  

 It may appear that the Up Arrow, Down Arrow, Page Up or Page Down are not working when 

incrementing or decrementing the current frequency with these keys.  
o The VFO frequency will not change if the incremented/decremented amount is smaller 

than the frequency deltas supported by your rig. This is not always well documented 
by the manufacturer. Icom 751 rigs for example do support 10 Hz steps but only show 

100 Hz steps on the display.  
o The keys mentioned above have to be set higher than the minimum step size 

supported by the radio.  
o It's easy to test if it is the keys are working. Check the frequency while pressing the 

keys mentioned above. If the frequency moves nothing has to be changed.  



o The default increment/decrement for CW is 10 Hz. If this doesn't work, try changing it 

to 100 Hz, under the Configurer, Other tab.  
o This only applies to the keys that increment/decrement the current frequency.  

 Memory mode - most modern radios have a kind of memory mode. In this mode, the radio will 

not provide the correct polling data to the program. VFO mode is required.  

 When SO1V mode is selected, VFOB is not defined for receiving. The second Bandmap and 

Entry window are automatically closed.  

 Sending CW characters via radio command (CAT) is not supported due to the limitations and 
contesting requirements. A COM, LPT, WinKey, or similar interface built into the radio (Elecraft 
K3) is required to send CW.  

 USB and USB to COM interfaces:  
o Do not turn off radios while the program is running if the radio is connected via USB 

port. Exit the program first.  
o Do not unplug a USB to COM converter while the program is running. Exit the program 

first.  
o The device driver will remove the COM port from the hardware table and the program 

will hang then eventually timeout. Programs written in Visual Basic and use MSCOMM 
control can not detect a COM port that is removed from the hardware device table. 
This is a Microsoft bug.  

2. Manual Mode - No Radio Selected 

In manual mode no radio is selected and attached to the program. If possible always connect a radio 
using the CAT interface or serial port. Older radios (or very new not supported radios) can still be used 

with the program by selecting Manual but many functions in the program will not work as easy as they 
could or will not work at all. When a radio is not configured, it is the user's responsibility to make sure 
the mode and band are correct when logging contacts. When no radios are selected in Configurer, the 
program will attempt to set the initial operating mode and frequency in single mode contests when the 
program starts or a new contest is opened. The program uses information from the contest selection 
and the mode tab settings in Configurer.  

3. Digital Mode Mapping 

Below information by Rick, N2AMG and John, K3CT regarding supported Digital configurations by 
N1MM logger.  

 

Radio Modes Corresponding to N1MM Logger Digital Mode Designations 

Column Headings = Mode names used in N1MM Logger 

Radio RTTY RTTY-R AFSK AFSK-R PSK PSK-R 

Flex 
  

DIGL DIGU 
  

FT990/1000/1000MP RTTY-L RTTY-U 
PKT-

LSB 
(4)  

  

FT100 
  

Dig(3) 
   

FT950/2000/3000/5000/9000 
FSK(RTTY-
LSB) 

FSK-R(RTTY-
USB) 

PKT-
LSB 

PKT-
USB   

FT450 RTTY-L RTTY-U User-L User-U 
  

FT817/857/897 
  

Dig(3) 
   

FT920 Data-LSB(2) Data-USB(2) 
    

IC7600/7700/7800 RTTY RTTY-R LSB-D1 USB-D1 PSK PSK-R 



Radio RTTY RTTY-R AFSK AFSK-R PSK PSK-R 

IC746Pro/756Pro/7200/7410/9100 RTTY RTTY-R LSB-D USB-D 
  

Other Icom RTTY RTTY-R 
    

Orion/OmniVI/OmniVII FSK 
     

K2 
  

RTTY RTTY-R 
  

K3 FSK D FSK D-R AFSK A 
AFSK A-
R 

DATA 
A 

DATA 
A-R 

TS2000 FSK (1) 
    

TS480/590/Other Kenwood FSK FSK-R 
    

 

(1) = radio menu selection 
 

(2) = FSK/AFSK selected by a rear panel switch 

 
(3) = Radio menu programmable for RTTY, RTTY-R, PKT-L, PKT-U 
 
(4) = FT990/1000/1000MP selection does not support PKT-USB  

If your radio does not have an entry under AFSK or PSK, use LSB or USB (e.g. 
Argonaut/Jupiter/FT840/847/890/900/757GXII). If there is an entry under AFSK-R but not under PSK, 
try using AFSK-R for PSK31 and other digital modes.  

4. Alinco 

 DX-77 - supported  

5. Elecraft 

 Elecraft USB-serial converter issues and N1MM logger  
o Situation: Setting up Elecraft K3 to work with N1MM logger and simply key CW with 

DTR line of CAT port.  
o Results: CAT works fine, but every time I try to send CW there appears an error 

window "CommPortDev_OnComm 4 - 2147417856"  
 N1MM is totally blocked and has to be killed using task manager.  

o Solution: Early Elecraft USB-serial converters used a Prolific chip, and the (Win2K) 
Prolific driver doesn't work correctly for CAT and DTR-CW-keying using the same port. 
Elecraft has since that time switched to an FTDI USB-serial converter, and newer 
Elecraft USB-to-serial adapters don't have this problem  

 A USB-serial converter using a FTDI-chip and the FTDI drive is working fine, 
CAT ok, fast CW keying, ESC immediatly interrupts message ...  

 All ufb now :- Tnx Thomas DK3DUA  

5.1. K2 

o Uses Kenwood-style commands but has its own radio selection. Only the KY command 
which is Elecraft specific is not supported.  

o Use default Kenwood parameters but sometimes one (1) stopbit only works (contrary 
to the K2 KPA100 manual saying that 2 stop bits should also work).  

o N1MM Logger does not support the K2 "virtual keying" feature using commands sent 
to the K2 serial port.  

o Setting the "Wide" and "Narrow" filter codes.  



 Remember to set the filter codes for both VFOs. Get the appropriate N1MM 

Logger screen menu prompt by left clicking when your cursor is over the 
active VFO window.  

 Substitute this code for the complete Kenwood "FL" code that comes up by 

default: K22;FW99991;K0; (no spaces, all caps, include the ";"'s) This will set 
the filter to "FL1" on the K2. If you put this code in the SSB "Wide" section for 
the filter code, it will give you FL1 for SSB - if you put this in the CW "Wide" 
section, it will give you FL1 for CW. Remember that the actual bandwidth of 
the filter will depend on how you have set FL1 on your K2. The same is true 
when you substitute this string for the "Narrow" settings. If you want a filter 
other than FL1 in either mode, just change the "1" after the 9999 to the 

number of the filter you want to invoke ie: 1,2,3 or 4. As an example, 
K22;FW99993;K0; placed in the code section for CW "Narrow" would invoke 
FL3 when the switch is set to "Narrow" and you are on CW.  

 Briefly, "K22" tells the K2 that this is an "extended command mode" - the ";" 
tells the K2 that this command is finished - the "FW" tells the K2 that this is a 
command to set the filter width - the 9999 number is ignored in the string but 

is necessary to include (it can be any set of four numbers between 0 and 9999 
- I just picked 9999) - the "1" is the number of the filter to invoke (1 - 4) - the 
"K0" (that is "K" zero) tells the K2 to go back to the "normal command mode."  

 Use the same technique to set the RTTY filters as well. Have fun es 73, Don 
N4HH  

o Please check out the feature which works great with the K2 and TS850 etc that don't 
have RIT clear IF you are Running (doesn't work for S&P). Put the rig into split, and 

use VFO B as your "RIT". Then go into Config, and turn on "Reset RX Freq when 
Running Split". Using VFO B for RIT, tune in a caller off freq, work him, and at the end 
of the QSO VFO B will be set to VFO A freq. Neat feature, and specifically designed for 
this situation.  

5.2. K3 

o When using program version 10.3.6 or newer, the radio firmware must be version 
3.46 or newer for proper operation.  

o The K3 contains a firmware bug that was reported several times and never been fixed 
which affects users that would like to use PTT via radio command. If the Esc key is 
pressed when a CW transmission begins and you are using PTT via radio command, 
the radio may not return to RX. The radio RX issue doesn't occur if the owner 

disconnects the CW jack from the rear of the K3 radio and doesn't change any N1MM 
Logger setting. Similar issues have been reported on other modes. Delay has been 
added to the N1MM Logger program when Esc is pressed but the problem still occurs 
intermittently. The problem seems to be worse with the very early K3 radios. Until this 
firmware issue is corrected, users may notice that the radio does not return to RX 
intermittently when using PTT via radio command. When this occurs, make another 
transmission and end it with the ESC key.  

o Radio control issues have been reported when running other K3 utility software (such 

as LP-Bridge) in conjunction with N1MM Logger. Please test with only N1MM Logger 

running before reporting a radio control issue, in order to eliminate other software as a 
possible source of the problem.  

o A single receiver K3 can be used in SO1V or SO2R mode. A dual receiver K3 can be 

used in all program modes, including SO2V  
o The stereo (grave accent - ` key, at the left end of the number keys row on many 

keyboards) toggles Sub on and off. It is identical to pressing the SUB radio button. To 
leave SUB on all the time, select Configurer>Dual RX always on  



 If you have selected Diversity mode on the radio, toggling Sub off and on via ` 

or Alt+F12 will turn Diversity mode off  
 Logger preserves diversity reception on the K3 unless RX Focus changes to 

vfoB at which time the subrx will switch to vfoB  

o K3 Subrx ON/OFF control by Logger  
 Independent of the state of Dual RX Always On:  

 changing RX Focus to vfoB turns the subrx ON  
 Ctrl+Shift+Up/Dn does not change the state of the subrx  
 Alt+F12 or ` toggles subrx ON/OFF if RX Focus is on vfoA (action 

disabled if RX Focus on vfoB)  
 Dual RX Always On checked:  

 clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the 
subrx ON  

 changing RX Focus turns the subrx ON  
 if dual rx always on was unchecked and the user checks it, subrx is 

turned ON  
 Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \ 
keystroke), the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on 
VFOA (PAUSE, CTRL+Left or vfoA Bandmap/Available window spot 
click ), the subrx is turned OFF  

 if dual rx always on was checked and the user unchecks it, subrx is 
turned OFF  

o Ctrl+Alt+D command action:  
 If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" 

to OFF and leave the Sub RX ON  
 If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" 

to OFF and leave the Sub RX OFF  
 If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" 

to ON and leave the Sub RX ON  

 If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  
o Alt+F12 command action:  

 If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  
 If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF 

unless RX Focus is on vfoB  
o Digital radio modes FSK D, AFSK A and DATA A are supported  

 FSK D, AFSK A and DATA A are displayed in N1MM as RTTY, AFSK and PSK 
respectively  

 If the current contest allows digital modes, typing RTTY into the Entry window 
will put the radio into either RTTY (FSK D) or AFSK (AFSK A) mode depending 
on the selection in the Configurer's Digital Modes tab for the current digital 
engine  

 If the current contest allows digital modes, typing PSK into the Entry window 

will put the radio into PSK (DATA A) mode  
 PSK D is not supported by N1MM; the digital engines in N1MM cannot transmit 

PSK using the PSK D sub-mode  
 The K3's data sub-mode is stored in the firmware on a per-band basis  

 If VFO B and VFO A are on the same band, the data sub-mode will be 
the same in both VFOs  

 If VFO B and VFO A are on different bands, their data sub-modes can 

be different, but the firmware does not provide a way to poll the K3 for 
the VFO B data sub-mode. N1MM Logger will assume that the VFO B 
sub-mode is the same as in VFO A when the two VFOs are on different 
bands  

 Adjust audio levels in AFSK A and DATA A to give 4-5 bars on the K3's ALC 
meter. This allows the K3's firmware ALC to control power without clipping 

peaks and causing IMD. In PSK31 and other digital modes requiring high 



linearity, keep the requested power setting below 60 watts (AFSK RTTY can be 

safely used at 100 watts)  
o RIT control - When in RUN mode, the Up/Dn arrow keys change the RIT frequency (if 

the K3's RIT is turned on). When in S&P mode the radio frequency is changed  

o Using the program as a voice keyer with a K3 on SSB:  
 Option 1  

 Connect your microphone to the mic input of the sound card and the 
Line Out of the sound card to the Line In on the back of the K3  

 Set soundcard program to drive Line In  
 Select LINE IN with MENU:MIC SEL  
 Command Tx (or PTT or...) and adjust the MIC GAIN (which is now 

LINE IN gain) for proper audio level  
 Option 2  

 Connect microphone to desired microphone connection on the K3  
 Select MIC with MENU:MIC SEL  
 PTT and set Mic Gain  
 Connect sound card as described under Option 1  

 Now, if you set MIC+LINE ON then both audio sources will drive the 
K3. The MIC GAIN control will control the MIC GAIN only. LINE IN 
GAIN must be set when LINE IN is the selected source via MENU:MIC 
SEL  

o The K3 can accept PTT switching from several sources, including: a keying circuit from 
a serial or parallel port to the K3's PTT IN; PTT from a Winkeyer; RTS (pin 7) on the 
radio control port; or using "Radio PTT via command"  

 Do NOT use multiple methods of PTT control in parallel; in some cases doing 
so can leave the K3 stuck in transmit at the end of function-key messages. In 
particular, do NOT check "Radio PTT via command" if you are using RTS on the 
radio control port, or any other hardware PTT connection, to control PTT. Using 
"Radio PTT via command" together with hardware PTT control can cause the 
K3 to get hung up in transmit, so don't do it!  

 Procedure for configuring RTS on the radio control port: Start with the K3's 

CONFIG:PTT-KEY set to OFF-OFF; configure N1MM to control PTT from RTS on 
the radio control port (Port setup); set the K3's CONFIG:PTT-KEY to RTS-OFF  

 Warning: leaving RTS set to Always on with the K3's CONFIG:PTT-KEY set to 
RTS-OFF or RTS-DTR will cause the K3 to be permanently in transmit  

o The K3 accepts CW keying on DTR (pin 4) of the same COM port you're using to 
control the K3. This method can be used when other methods (e.g. Winkeyer or a 

keying circuit on a separate COM or LPT port) are not available  
 CW and radio control on the same COM port do NOT work in SO2R mode  
 CW on DTR does NOT work with some USB-to-serial adapters (e.g. Prolific 

chipset)  
 CW on DTR may be missing some capabilities and may have other undesired 

side effects - use at your own risk  
 Procedure: Start with the K3's CONFIG:PTT-KEY set to OFF-OFF; check the 

CW/Other box beside the radio control port in the Configurer and configure 
N1MM to use DTR for CW on that port; set the K3's CONFIG:PTT-KEY to OFF-
DTR  

 Warning: leaving DTR set to Always on with the K3's CONFIG:PTT-KEY set to 

OFF-DTR or RTS-DTR will cause a permanent "key-down" condition  

 Cat Macro strings used to play back Radio # 1 internal K3 CW/data messages or DVR voice 

keyer messages  
o M1 = {CAT1ASC SWT21;}  
o M2 = {CAT1ASC SWT31;}  
o M3 = {CAT1ASC SWT35;}  
o M4 = {CAT1ASC SWT39;}  

 It is not necessary to include the K31; command in any K3 Cat Macro. The radio is in K31 
mode all the time and sending this command just adds delay.  



5.3. KX3 

 Radio control issues have been reported when running other K3 utility software (such as LP-

Bridge) in conjunction with N1MM Logger. Please test with only N1MM Logger running before 
reporting a radio control issue, in order to eliminate other software as a possible source of the 
problem  

 The KX3 does not have an FSK keying input, so the digital engine (e.g. MMTTY) cannot 
transmit in FSK. To do RTTY, put the KX3 into AFSK A mode and configure the Logger and the 
digital engine for AFSK  

 The digital engines (MMVARI and Fldigi) cannot transmit in PSK D. To do PSK, put the KX3 into 
DATA A mode and configure the Logger and the digital engine for PSK  

 Cat Macro strings used to playback Radio # 1 internal KX3 DVK voice keyer  

o M1 = {CAT1ASC SWT11;SWT19;}  
o M2 = {CAT1ASC SWT11;SWT27;}  

 Cat Macro strings for other functions are listed below as examples  

o To tune the ATU {CAT1ASC SWT44;}  
o To enable VOX {CAT1ASC SWH29;}  

6. FlexRadio 

o Flex VAC is required for digital or to send/record audio files to the radio without 
cables. The radio's VOX does not function when VAC is enabled. See the setup at: 
http://kc.flexradio.com/KnowledgebaseArticle50230.aspx  

o Radio control  
 Third party COM port mapping software is required to create a virtual COM 

port for radio control. See the Flex documentation for computer and radio 

configuration.  
 Software was tested with COM port settings: 38400, N, 8, 1, DTR=Always Off, 

RTS=Always Off  
o CW sending  

 Depending on your computer hardware and system DPC latency, users may 
find that CW generated by the N1MM Logger program or with external devices 

like WinKey may not be acceptable. Contact Flex Radio for CW sending issues.  
o Glitches or pops in audio  

 Users experiencing intermittent glitches or popping sounds in the receiver 
audio while radio polling is enabled should contact Flex Radio.  

o PowerSDR  
 The code was tested with public version PowerSDR 2.0.22.  

 There may be some interaction between the PowerSDR radio "model" and the 
requirements for SO2V operation. Generally, controlling split, RX2 On/Off, or 
MultiRx (Non-RX2 models) from the N1MM program is recommended.  

o Digital Modes  
 Both Flex digital modes are supported. They are mapped to the N1MM Logger 

program selections of AFSK and AFSK-R. Open Config, Mode Control tab, and 
set Mode Sent to Radio for RTTY and PSK. Most users will likely select RTTY to 

AFSK and PSK to AFSK-R.  
 VAC does not allow the RX2 to be used with multiple Digital Interfaces. This is 

not a program limitation.  
o The Flex5000 RX2 radio selection is intended for use with the Flex 5000 with the 

optional RX2 receiver. The Flex radio selection is intended for use with the Flex 1500, 
3000, and the 5000 without the RX2. The Flex5000 RX2 option implements SO2V 
using the RX2 for VFOB and the Flex selection implements SO2V using the MultiRx 



feature. There are limitations to the tuning range of the MultiRx and how the radio 
reacts when it's instructed to change to a frequency outside of this operating range.  

6.1. Flex-5000A with RX2 

o Program Feature Set  
 The Flex5000 RX2 radio selection supports all of the standard program 

features including Reverse CW, Mute Mic, Audio Muting Macros, Antenna 
Macros, and Advanced SO2V. The three program options SO1V, SO2V, and 

SO2R are supported.  
o SO2V  

 The RX2 option is required for SO2V operation.  
 Users are able to have a repeating CQ running on VFOA and tune the band 

with VFOB. Start the repeating CQ then press the \ key to switch RX focus to 
the VFOB Entry window. If a station is called using the Function keys, the TX 

focus will switch, the message will be sent, and the repeating CQ will not 

restart. Shift-F# can be used to send a message on VFOA (example: Shift F1 
to restart the CQ again). PAUSE or CTRL+Right/LeftArrow keys can be used to 
switch both RX and TX focus together.  

 Users can program VFOB with the next Bandmap spot without changing focus 
using Ctrl+Shift+Up/Dn. The state of the RX2 is unchanged. This allows users 
to program the VFOB frequency and toggle the RX2 On/Off with various 

keyboard commands when the VFOA frequency is not busy.  
 The RX2 can be programmed to be On all the time. See the Config option Dual 

RX Always On.  
 The RX2 state can be toggled with the stereo key (`) and the VFO frequencies 

swapped with ALT+F10. See other features below.  
 If Diversity mode is enabled on the radio, toggling Sub off and on via ` or 

Alt+F12 will turn Diversity mode off.  

 Logger preserves diversity reception unless RX Focus changes to VFOB at 
which time the RX2 will switch to VFOB.  

 Subrx ON/OFF control by N1MM Logger is independent of the state of 

Config>Dual RX Always On.  
 Changing RX Focus to VFOB turns the RX2 ON.  
 Ctrl+Shift+Up/Dn does not change the state of the RX2.  

 Alt+F12 or the stereo key (`) toggles RX2 ON/OFF if RX Focus is on 
VFOA (action disabled if RX Focus on VFOB).  

 Dual RX Always On checked:  
 Single clicking in any VFO Bandmap, on an Available window 

spot, or Ctrl+Up/Dn turns the RX2 ON.  
 Changing the RX Focus turns the RX2 ON.  
 If Dual Receive Always On is unchecked and the user checks it, 

the RX2 is turned ON.  
 Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX focus changes to 
VFOA ( \ keystroke), the RX2 stays ON.  

 If the TX & RX Focus is initially on VFOB and then RX & TX 
Focus is switched to VFOA (PAUSE, CTRL+Left or VFOA 

Bandmap/Available window spot click ), the RX2 is turned OFF.  

 If Dual Receive Always On is checked and the user unchecks it, 
the RX2 is turned OFF.  

 Ctrl+Alt+D command action:  
 If "Dual RX Always On" is ON and the RX2 is ON, change "Dual RX 

Always On" to OFF and leave the RX2 ON.  
 If "Dual RX Always On" is ON and the RX2 is OFF, turn "Dual RX 

Always On" to OFF and leave the RX2 OFF.  
 If "Dual RX Always On" is OFF and the RX2 is ON, turn "Dual RX 

Always On" to ON and leave the RX2 ON.  



 If "Dual RX Always On" is OFF and the Sub RX is OFF, turn both ON.  

 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX 
Always On" state:  

 If the RX2 is OFF - check "Dual RX Always On" and turn the RX2 ON.  

 If the RX2 is ON - uncheck "Dual RX Always On" and turn the RX2 OFF 
unless RX focus is on VFOB.  

6.2. Flex-1500, Flex-3000, Flex-5000A without RX2 

o Program Feature Set  
 The Flex radio selection supports all of the standard program features 

including Reverse CW, Mute Mic, Audio Muting Macros, Antenna Macros, and 
SO2V. The three program options SO1V, SO2V, and SO2R are supported.  

o SO2V  
 The MultiRx is used for VFOB. Frequency and mode limitations of VFOB and 

how the radio responds to frequencies outside this range are controlled by the 

radio.  
 Given this, users are able to have a repeating CQ running on VFOA and tune 

the band with VFOB. Start the repeating CQ then press the \ key to switch RX 
focus to the VFOB Entry window. If a station is called using the Function keys, 
the TX focus will switch, the message will be sent, and the repeating CQ will 
not restart. Shift-F# can be used to send a message on VFOA (example: Shift 

F1 to reastart the CQ again). PAUSE or CTRL+Right/LeftArrow keys can be 
used to switch both RX and TX focus together.  

 Users can program VFOB with the next Bandmap spot without changing focus 
using Ctrl+Shift+Up/Dn. This allows users to program the VFOB frequency and 
toggle MultiRx On/Off with various keyboard commands when the VFOA 
frequency is not busy.  

 The MultiRx can be programmed to be On all the time. See the Config option 

Dual RX Always On.  
 The MultiRx state can be toggled with the stereo key (`) and the VFO 

frequencies swapped with ALT+F10. See other features below.  

 MultiRx ON/OFF control by N1MM Logger is independent of the state of 
Config>Dual RX Always On.  

 Changing RX Focus to VFOB turns the MultiRx ON.  

 Ctrl+Shift+Up/Dn does not change the state of the MultiRx.  
 The stereo key (`) or Alt+F12 toggles MultiRx ON/OFF if RX Focus is 

on VFOA (action disabled if RX Focus on VFOB).  
 Dual RX Always On checked:  

 Single clicking in any VFO Bandmap, on an Available window 
spot, or Ctrl+Up/Dn turns MultiRx ON.  

 Changing the RX Focus turns MultiRx ON.  

 If Dual Receive Always On is unchecked and the user checks it, 
MultiRx is turned ON.  

 Dual RX Always On unchecked:  
 If the TX & RX Focus is on VFOB and the RX focus changes to 

VFOA ( \ keystroke), MultiRx stays ON.  
 If the TX & RX Focus is initially on VFOB and then RX & TX 

Focus is switched to VFOA (PAUSE, CTRL+Left or VFOA 

Bandmap/Available window spot click ), MultiRx is turned OFF.  
 If Dual Receive Always On is checked and the user unchecks it, 

MultiRx is turned OFF.  
 Ctrl+Alt+D command action:  

 If "Dual RX Always On" is ON and MultiRx is ON, change "Dual RX 
Always On" to OFF and leave MultiRx ON.  

 If "Dual RX Always On" is ON and MultiRx is OFF, turn "Dual RX Always 
On" to OFF and leave MultiRx OFF.  



 If "Dual RX Always On" is OFF and MultiRx is ON, turn "Dual RX Always 

On" to ON and leave MultiRx ON.  
 If "Dual RX Always On" is OFF and MultiRx is OFF, turn both ON.  

 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX 

Always On" state:  
 If MultiRx is OFF - check "Dual RX Always On" and turn MultiRx ON.  
 If MultiRx is ON - uncheck "Dual RX Always On" and turn MultiRx OFF 

unless RX focus is on VFOB.  

6.3. SDR-1000 and SDR-5000A (using Kenwood settings) 

o By: Rob AB7CF  
o Some setup details are not really needed but are included for completeness. One thing 

I notice different is in PowerSDR Cat setup I use ID as: "PowerSDR" though it 
shouldn't make a difference. Probably the most common Vcom mistake is a failure to 

click Update Driver and following the procedure after making a change in Vcom 

configuration..  
o Example: using VCom configurator using ports 4-5 defines and VAC  
o Check your VCom configurator to make sure you have a check box in the COM4 - 

COM5 pair and you have clicked Save Configuration. MAKE SURE you click the Update 
Driver and follow the instructions. Close VCom configurator. Click on Window's Start 
Button, Click on ControlPanel, Click System, Click on the Hardware Tab, Click on 

Device manager.  
o In Device manager make sure there ISN'T a yellow question mark on the entry labeled 

"Multi-port serial adapters." If there is no yellow question mark your Vcom virtual 
cable should be working properly. If there is an yellow question mark there is a 
problem with your Vcom installation which needs attention. Assuming no problem, 
Close ControlPanel.  

o Now check PowerSDR. Open PowerSDR Setup and click on the CAT Control tab. In CAT 

Control make sure Enable CAT is checked. Under PTT make sure Port 4 is selected and 
RTS and DTR are unchecked. Select ID as: PowerSDR. Click Apply. Close PowerSDR 
Setup.  

o Now check N1MM. Click Config. Select "Configure Ports, Telnet Address,Other" Under 
Com-5 select Kenwood. Make sure CW/PTT is unchecked. Now click Set. In the popup 
box the settings should be: Speed 4800, Parity: N DataBits: 8, Stop Bits: 1 DTR (pin 

4) = Handshake. RTS (pin 7) =Handshake, 1 selected in Radio/VFO. Leave the "Radio 
PTT via command" check box UNCHECKED. Check the "Allow external interrupts" 
check box. Click Okay (twice) to back out.  

o Now you should be communicating with your SDR. Check that clicking a new 
frequency in the Panadapter changes frequency in N1MM. With the focus in N1MM 
check that the keyboard up and down arrows change the PowerSDR frequency.  

7. Icom 

7.1. General Icom Information (all Icom owners please read) 

o Almost every Icom rig requires an ICOM CT-17 CI-V interface or compatible. If your 

Icom radio has a USB computer interface (IC-7200, IC-7600, etc), install the latest 
driver for the virtual COM port and audio codec.  

o Icom rigs use software handshaking. That means they do not use DTR and RTS. 
However, interfaces that get their power from the RS232 port require you to set DTR 
and/or RTS to "Always On" to supply power to the interface. Check your interface 
manual to see how DTR and RTS must be set.  

o Set N1MM Logger and the rig to:  

 Address - see specific rig information below  



 Baud Rate - 9600 or 19200 (see specific rig maximum rates below). When a 

slower baud rate is selected, the program will disable CI-V acceleration 
features added for radio programming and keyboard tuning.  

 Data Bits - 8 bits  

 Parity - None  
 Stop Bits - 1 bit  

o On your rig, set:  
 "CI-V Transceive" to OFF - If CI-V is set to ON, the Bandmaps will not update 

as the VFO is turned.  
 "Some Icom rigs have a "4 or 5 Byte Data" or "Frequency Data Length" 

interface option. Set the radio to use 5 data bytes for the frequency.  

o Due to the limited Icom radio control, the user needs to control the radio from the 
keyboard. This means that the user can not press these buttons on the radio: SPLIT 
(most radios), DUALWATCH, CHANGE, VFO/MEMO, A=B, A<>B, or MAIN/SUB. Icom 
radios only report the VFO frequency of the active VFO. Because of this, the program 
will select each VFO to read the frequency during initialization. During 2011, Icom 
added a firmware command to poll the radio split to the latest firmware updatable and 

new radios. Those radios that are capable or reading the split have been updated in 
program versions 12.03.01 or newer. See the specific radio text for the firmware 
revision. When using these radios with the proper firmware and program version 
12.03.01 or newer, users can change the radio split by pressing the radio button and 
the program will track.  

o To set and clear split under program control, use ALT+F7 or one of the other keyboard 
commands. Split is correctly set/cleared when clicking in the Bandmap or Available 

windows. To select VFOB (SO2V mode only), use the PAUSE, "\", or CTRL+Right/Left 
Arrow keys. In SO2V mode, the VFO is also selected with a Right or Left click on the 
band buttons in the Available window.  

o Frequencies > 2 GHz are ignored and not sent to the radio.  
o For CW sending, a seperate CW interface cable is needed between the radio and the 

computer. This interface maybe serial or parallel port or a WinKey. The CI-V cable or 
serial cable to the radio alone is not enough to do CW.  

o The ALT+F10 swap VFO frequency command is disabled during SO2R for Icom radios 
that lack a swap VFO CAT command. This is because the program is unaware of Icom 

VFO B frequency in SO2R mode.  
o The Icom command set (CW via CAT control) is not supported. A COM, LPT, or WinKey 

is required to send CW.  

 The models below are supported:  

7.2. IC-271 / IC-471 / IC-1271 

 Select IC-706 and set the radio address to hex 48 or program the default radio 
address in the program setup window. Please report on program functionality.  

 There are several limitations caused by the lack of several CI-V commands. 
VFO select and split commands are not supported. This will prevent the 
program from controlling the radio split and reading or programming VFOB 
frequency. SO2V mode should not be attempted and VFOB's Bandmap and 
Entry windows can be closed.  

7.3. IC-275A/E/H using address 10 hex. 

 The CI-V command set lacks split ON/OFF commands. This prevents the 
program from controlling the radio split.  

7.4. IC-375 / IC-575 (all versions) 



 Select IC-706 and set the radio address to hex 48 or program the default radio 

address in the program setup window. Please report on program functionality.  
 The CI-V command set lacks split ON/OFF commands. This prevents the 

program from controlling the radio split.  

7.5. IC-475A/E/H using address 14 hex. 

 The CI-V command set lacks split ON/OFF commands. This prevents the 
program from controlling the radio split.  

7.6. IC-703 using address 68 hex. 

7.7. IC-706 using address 48 hex. 

 This radio firmware does not include a CAT command to key the radio. This 

causes the radio command PTT options to be non-functional.  

7.8. IC-706MKII using address 4E hex. 

 This radio firmware does not include a CAT command to key the radio. This 
causes the radio command PTT options to be non-functional.  

7.9. IC-706MKIIG using address 58 hex. 

 This radio firmware does not include a CAT command to key the radio. This 
causes the radio command PTT options to be non-functional.  

7.10. IC-718 using address 5E hex. 

 Set N1MM Logger to 19200 bps and the radio to "AT" (AuTo).  

7.11. IC-725 using address 28 hex. 

7.12. IC-728 using address 38 hex. 

7.13. IC-729 using address 3A hex. 

7.14. IC-735 using address 04 hex. 

 The CI-V command set lacks split ON/OFF commands. This prevents the 
program from controlling the radio split.  

 When the IC-735 is used with factory settings (1200 baud, transceive ON), the 

bandmap response of N1MM is extremely slow. Jumpers J22 located on the PL-
unit board (upper side under PA unit) allow baud-rate, address and CI-V 
transceive to be changed. But.. the jumpers are not labeled and not in the 

order as stated in the Service manual. In fact transceive ON/OFF is the last 
one (front panel toward you, tarting from left) this one should be removed to 
turn transceive OFF. The 2 first ones set the baud-rate (move the second one 
to the first position to switch from 1200 to 9600 baud) the 3 remaining ones 
are the CI-V address - default 04; is with last the last one of this group of 3 - 
ON.  



 

Jumper J22 settings for 9600 baud, transceive OFF and default address 04 - from left to right with 
front panel toward you...  

1 2 3 4 5 6 

ON OFF OFF OFF ON OFF 

Baud rate Baud Rate Address Address Address CI-V transceive 

These settings make the 735 operable with N1MM (trx IC735 / baud rate 9600 / 8 data bits / no parity 

/ 1 stop bit). DTR and/or RTS are not used by the Icom CI-V (no handshake) so does not matter. 
However, they should be turned to "always ON" if using an interface powered though those pins. 

Alternatively, they can be used for CW and PTT, for example if you are limited by the number of COM-
ports on your machine. 73' Patrick F6IRF  

7.15. IC-736 using address 40 hex. 

7.16. IC-737/737A using address 3C hex. 

 The CI-V command set lacks split ON/OFF commands. This prevents the 
program from controlling the radio split.  

7.17. IC-738 using address 44 hex. 

7.18. IC-746 using address 56 hex. 

 VFO-B is a virtual VFO as long it isn't activated. The scale is not controlled by 
the VFO-B of the transceiver. It becomes an active VFO when it is activated. 

The IC-746 is switched to VFO-B and set to the frequency shown in the VFO-B 
bandmap.  

7.19. IC-746 PRO using address 66 hex. 

 USB-D / LSB-D digital modes supported.  

7.20. IC-751/751A using address 1C hex. 

 There are several limitations caused by the lack of some CI-V commands. VFO 
select and split commands are not supported. This will prevent the program 
from controlling the radio split and reading or programming VFOB frequency. 
SO2V mode should not be attempted and VFOB's Bandmap and Entry windows 
can be closed.  

To communicate with the radio, the baud rate, CI-V Transceive, and number of bytes of frequency 

data must be set correctly. This is set via a DIP switch on the Icom UX-14 interface board. Using the 
DIP switch S1 location in the beginning of the manual (page 11 has the DIP switch positions reversed) 
set S1 to the following:  
1-------------6  
On - Off - Off - Off - Off - On  
This will set the baud rate to 9600, the length of the frequency information to 5 bytes, and turn CI-V 
Transceive OFF.  

If the radio contains the Piexx UX-14 CI-V board, set the DIP switches per the Piexx manual for the 
same configuration  



7.21. IC-756 using address 50 hex. 

 Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' 
in the Config menu.  

7.22. IC-756 PRO using address 5C hex. 

 Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' 
in the Config menu.  

7.23. IC-756 PRO II using address 64 hex. 

 Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' 
in the Config menu.  

 USB-D / LSB-D digital modes supported.  

7.24. IC-756 PRO III using address 6E hex. 

 Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' 
in the Config menu.  

 USB-D / LSB-D digital modes supported.  

7.25. IC-761 using address 1E hex 

 There are several limitations caused by the lack of some CI-V commands. VFO 
select and split commands are not supported. This will prevent the program 
from controlling the radio split and reading or programming VFOB frequency. 
SO2V mode should not be attempted and VFOB's Bandmap and Entry windows 
can be closed.  

To communicate with the radio, the baud rate, CI-V Transceive, and number of bytes of frequency 
data must be set correctly. This is set via a DIP switch inside the radio. Set the baud rate to 9600, the 
length of the frequency information to 5 bytes, and turn CI-V Transceive OFF.  
The manual lacks the details but it is suspected that DIP S1 should be set to the following:  

1-------------6  
On - Off - Off - Off - Off - On  
If the radio contains the Piexx UX-14 CI-V board, set the DIP switches per the Piexx manual for the 
same configuration.  

7.26. IC-765 using address 2C hex. 

7.27. IC-775/775DSP using address 46 hex. 

 The IC-775 firmware is limited and lacks commands to select Main or Sub. It is 
also not possible to read the frequency of the Sub VFO without moving it into 
the Main VFO and polling. This is done at program start, Configurer exit, and 
Reset Radios. Because of this radio limitation, the SO2V functionality is 

limited. This radio is better suited for SO1V or SO2R use.  
 The radio firmware lacks the ability to poll the VFOB frequency. Frequency 

changes to the SUB made by tuning the SUB VFO knob will not be sensed and 
tracked by the program in SO2V mode.  

 Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' 
in the Config menu.  



7.28. IC-781 using address 26 hex. 

 Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' 
in the Config menu.  

7.29. IC-821H using address 4C hex. 

 The ALT+F12 radio specific command swaps MAIN and SUB using the CAT 
radio command.  

 The ALT+F10 command swaps the VFOA/B frequency and mode only in SO1V 
and SO2V program modes.  

7.30. IC-910H using address 60 hex. 

 The ALT+F12 radio specific command swaps MAIN and SUB using the CAT 

radio command.  
 The ALT+F10 command swaps the VFOA/B frequency and mode only in SO1V 

and SO2V program modes.  

7.31. IC-1275A/E using address 18 hex. 

 The CI-V command set lacks split ON/OFF commands. This prevents the 
program from setting or clearing the radio split.  

7.32. IC-7000 using address 70 hex. 

7.33. IC-7200 using address 76 hex. 

 Radio control via USB with Icom driver or CI-V interface.  
 The IC-7200 USB codec is supported. IC-7200 users can use the USB cable 

with the Icom drivers for radio control, AFSK RTTY, PSK, voice message 
playback, and recording QSOs. IC-7200 users can not record messages on the 
fly. In CW, only the received portion of the QSO is recorded. This is a radio 

limitation.  
 Detailed instructions for setting up USB communications with this radio may 

be found under >Files >Supplementary Information.  

7.34. IC-7400 using address 66 hex. 

 Select the IC-746 PRO as radio.  
 USB-D / LSB-D digital modes supported.  

7.35. IC-7410 using address 80 hex 

 Program releases 12.03.01 and later support polling the radio for split status  
 Radio control via USB with Icom driver or CI-V interface.  
 USB-D / LSB-D digital modes supported.  
 The audio codec is supported. Users with the Icom drivers can use the USB 

cable for radio control, AFSK RTTY, PSK, recording voice messages on the fly, 

voice message playback, and recording QSOs. In CW, only the received 
portion of the QSO is recorded. This is a radio limitation.  

 Detailed instructions for setting up USB communications with these radios may 
be found under >Files >Supplementary Information.  

http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=5
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7.36. IC-7600 using address 7A hex 

 Program releases 12.03.00 or newer require radio firmware that contains the 
get split command (firmware 1.11 or newer).  

 Radio control via USB with Icom driver or CI-V interface.  

 USB-D / LSB-D digital modes supported.  
 The IC-7600 and IC-9100 audio codecs ares supported. Users with the Icom 

drivers can use the USB cable for radio control, AFSK RTTY, PSK, recording 
voice messages on the fly, voice message playback, and recording QSOs. In 
CW, only the received portion of the QSO is recorded. This is a radio limitation.  

 Detailed instructions for setting up USB communications with these radios may 
be found under >Files >Supplementary Information. The file is titled 
"IcomUSBCodecInstructions 2011-10-2.pdf"  

7.37. IC-7700 using address 74 hex. 

 Program releases 12.03.00 or newer require radio firmware that contains the 

get split command (firmware 1.20 or newer).  
 USB-D / LSB-D digital modes supported.  

7.38. IC-7800 using address 6A hex. 

 Program releases 12.03.00 or newer require radio firmware that contains the 
get split command (firmware 2.30 or newer).  

 Please see also Key Assignments (Alt+F12) and the setting 'Dual Rx always on' 
in the Config menu.  

 USB-D / LSB-D digital modes supported.  

7.39. IC-9100 using address 56 hex. 

 Program releases 12.03.01 or newer require radio firmware that contains the 
get split command (firmware E1 or newer).  

 USB radio control and audio CODECS are supported. Detailed instructions for 

setting up USB communications may be found under >Files >Supplementary 
Information. The file is titled "IcomUSBCodecInstructions 2011-10-2.pdf"  

8. Kenwood 

8.1. General Kenwood information 

o All models are supported  
 Newer models connect directly via a serial port cable or USB port. The use of 

the USB port requires a Kenwood driver be installed.  
 Older models need the Kenwood IF-10 and/or the IF-232C interface (or 

compatible). Please check the radio's manual.  

 Almost any of the earlier generation Kenwood radios need some sort of 
level conversion, and at least some also come without the necessary 
chip set. Radios like the TS-940S, TS-440S, TS-811, TS-711 need both 
a chip and a level converter.  

 PIEXX (www.piexx.com) makes a combined level converter and chip 
set replacement for the TS-940, as well as a complete replacement 

microprocessor for the TS-930 to provide communications.  
o Hardware handshaking is mostly being used. This means that DTR= Always on or 

handshake and RTS = Always on or handshake.  
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 Unless you make up a special loop back cable for it so you can use DTR and 

RTS for CW and PTT.  
o The stock Kenwood interfaces (IF-232 for the older -x40 and -x50 series transceivers) 

and a bare RS-232 cable for the more recent TS-480/570/870/2000 require 

handshake. Except for the TS-570. the solution is to install a jumper between CTS/RTS 
pins at the RS-232 input of the Kenwood interface (in the case of the -40 and -50 
transceivers) or transceiver (TS-480/870/2000). The TS-570 can lock-up if RTS is 
connected to CTS and requires RTS=always high to be reliable.  

o Using the jumper ("over-ride hardware handshaking") will free RTS for PTT in addition 
to DTR for CW. The alternative to over-riding the hardware flow control is to set 
RTS=Always On and use DTR for PTT or CW as necessary (DTR is not connected in the 

radio/interface).  
o RX/TX information from the radio is ignored while sending is in progress to avoid 

glitches in sending.  
o Typical Kenwood radio defaults:  

 Speed: 9600 Baud; Parity: N ;Databits: 8; Stopbits: 2 and "hardware 
handshaking" (RTS and DTR set to "Handshake"). It is recommended by the 

developers to use a baud rate above 9600 baud if possible. The radio menu 
and the program setup must be changed together.  

o When setting split both VFOs are forced in the same mode.  

o Assigning these basic example macros to Function Keys will allow you to play and stop 
the internal DVK (voice keyer) on radio #1. Other macro strings can be inserted to 
playback on radio #2 or both radios. See the Macros section of the manual.  

 Message1 = {CAT1ASC PB1;}  
 Message2 = {CAT1ASC PB2;}  
 Message3 = {CAT1ASC PB3;}  

 Stop Playback = {CAT1ASC PB0;}  
 The TS-590 DVK stop command is sent to the radio when the ESC key is 

pressed.  

o The Kenwood KY command set (CW via CAT control) is not support due to the 
limitations. A COM, LPT, or WinKey is required to send CW.  

8.2. TS-480 

 Select: Kenwood. Note that handshaking options may vary - 
check your manual  

 "AFSK" via the data jack with software PTT is supported. Check 
the "Digital Modes Acc Jack Radio Command PTT" and the 
"Software PTT Via Radio Command - Digital" in the radio COM 
port setup window.  

8.3. TS-570 

 Select: Kenwood  

 When using the ACC2 port on the back, you must send both 
the audio signal and the PTT signal to the ACC jack.  

 You can't use the normal PTT connection from the MIC jack if 
you are inputting audio into the ACC jack.  

 SO2V: 9600,N,8,1,handshake,handshake,radio/VFO=1  

8.4. TS-590 

 Select: Kenwood  



 Follow the Owners Manual for port speed, parity, number of 

databits, and stopbits  
 Make sure the COM port speed set in N1MM Logger is the 

same as the speed in TS-590 menu item 62. 57600 bps is 

recommended. After changing the speed in menu item 62, you 
must power off the TS-590 AND the 12 volt supply powering 
the 590. Make sure the power supply has completely 
discharged before turning the power supply and 590 back on.  

 When using the TS-590S radio codec as a sound card for a 
DVK, the live microphone has priority over the codec. This 
means that if live audio is being sent from the microphone, a 

.wav file cannot be sent over the codec at the same time. 
Starting of the .wav file will be blocked, even if the microphone 
VOX drops shortly thereafter. So, if you're running, and using 
the microphone to say callsigns, but F2 to send the exchange, 
you have to wait until the VOX drops before pressing F2.  

 When using the ACC2 radio jack, there are three PTT options. 

PTT for digital modes (pin 9), PTT for none digital modes (pin 
11), and software PTT (PTT via radio command by mode). The 
ACC2 pin 13 PTT is exactly the same as the Remote connector 
pin 3 PTT. If you use Remote connector pin 3 PTT while using 
the internal radio codec, there will be no RF output. To use the 
ACC2 for digital modes with software PTT, check "Digital 
Modes Acc Jack Radio Command PTT" and the "Software PTT 

Via Radio Command - Digital" in the setup window of the COM 
port used for radio control.  

 ARCP-590 or ARUA-10 are not needed when using N1MM 
Logger with the TS-590.  

 Detailed instructions for setting up USB communications with 
this radio may be found under >Files >Supplementary 
Information. The file is titled "KenwoodTS-590SCodec 2011-
04-02.pdf".  

8.5. TS-850 

 Select: Kenwood  
 Turn off AI on init  
 Speed: 4800 Baud; Parity: N ;Databits: 8; Stopbits: 2 (!)  
 Check out the possible communications issue below with this 

radio.  

8.6. TS-870 

 Reportedly works well; further information on setup would be 
welcome  

8.7. TS-950sdx 

 Select: Kenwood  
 Some (older) TS-950sdx radios drop power when polled by a 

logging program. It's pretty obvious on either CW or SSB.  

 The problem is not the program but the ROM firmware 
chip. The big one one the digital board of the 950sdx.  

 Just replace the chip, the problem should go away. 
Costs about $27.00 - and very easy to install (about 
10 minutes)  
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 Order a battery if you haven't replaced it already - it's 

right next to the chip on the same board....  
 Speed: 4800 Baud; Parity: N ;Databits: 8; Stopbits: 2 

(!)  

 Check out the possible communications issue below 
with this radio.  

8.8. TS-50, TS-140, TS-440, TS-680,TS-711,TS-790,TS-811,TS-940 

o The radio firmware revision of some of these radios may require the use of Kenwood-
Slow rather than Kenwood.  

8.9. TS-2000 

o Use the radio selection TS-2000. It was added to allow control of RX antenna input.  

o Use the highest baud rate possible, something above 9600 baud. The window 
selections should be No Parity, 8 Databits, 2 Stopbits, DTR = Handshake, and RTS = 
Handshake. The radio default baud rate can be changed with radio menu 56. Since 
hardware hand shaking is used by the TS-2000, the serial cable needs to contain wires 
for the hardware flow control pins.  

o Do not use the radio function called "auto-mode". This function automatically changes 
the radio mode and changes the radio mode set by N1MM logger.  

o Radio NB: This may produce AFSK RTTY (LSB) problems when changing between the 
higher (USB) and lower (LSB) bands.  

o Do not use the radio in memory mode, use VFO mode. The program will not function 
when in memory mode with the program.  

o The radio control works for frequencies above 6 meters.  

8.10. N1MM logger loses communication with the radio (TS-850, TS-950 

etc.) 

o This problem is based in the radio's firmware. Some Kenwood radios are not capable 
of communicating with N1MM Logger while the VFO knob is being turned. If you turn 
the VFO knob smoothly and continuously, no matter how slowly, the radio will not 
respond to radio polls and the link will time out. For these radios there are two 
choices, pause when tuning the VFO so the radio will answer the program polling 

requests or increase the 'transceiver timeout time'. The transceiver timeout time is set 
by right-clicking in the Bandmap window. This is a radio firmware limitation, not a 
software issue. Using Kenwood-Slow will *not* solve this firmware limitation.  

9. TenTec 

9.1. General TenTec information 

 The models below are supported, other models are not supported.  

9.2. ARGONAUT V 

 Use the Argonaunt radio selection.  

9.3. ARGONAUT VI 



 Use the Eagle radio selection. The Argonaut V and Argonaut VI radio 

commands are different.  
 This radio is NOT capable of SO2V operation. Select SO1V or SO2R program 

operation.  

 The radio firmware requires a 200ms delay after every Set-type command. 
Users may notice this delay when the program is setting the frequency, mode, 
or split.  

9.4. JUPITER 

 Uses 1 stopbit and DTR and RTS 'Always on'. Do NOT check the CW check box 
on the port setup screen for this com port.  

9.5. OMNI-VI 

o The Omni VI+ the "Cde" item under menu 2 should be set to "off". Otherwise there 
will be collisions between the data sent from the rig when N1MM polls for data and the 
data that is being continuously sent by the radio which will cause erratic behavior.  

o In the COM port setup window for the radio, the "Icom Code" box should be set to 4. 
This radio uses the Icom protocol for radio communications.  

9.6. OMNI-VII 

 The Omni-VII does not support antenna switching in "radio" mode. It is only 
possible in "remote" mode. So owners of the Omni-VII can not use the 

antenna switch macros.  
 Alt+F10 (exchange VFO) and CW-Reverse operation supported  
 The Omni-VII can not receive on VFOB.  

9.7. Orion 

 Uses default 56000 Baud and 1 stopbit and hardware handshaking; From 
Version 11.10.02 forward, handshaking requires that CTS is connected per the 
Orion manual.  

 Firmware version 1.363 or greater needed.  
 Note that the Orion does not support PTT on CW via computer command. This 

does work on SSB, but on CW, you need to set a parallel or serial port to 
assert PTT for that radio. Then use a cable from that adapter to pin three 
(PTT) of the aux port on the Orion. This is the black RCA Phono connector on 
the aux cable. By use of a Y connector, you can parallel your footswitch and 
this CW PTT cable.  

 When using PTT and CW lines off a serial or parallel port. Be sure to go into 
the Orion CW menu and set "PTT in CW as" to the value "Mox".  

 Defaults bandwidths: CW: 300/800; SSB: 2000/2800; RTTY 250/400  
 CW on main receiver is LCW.  

 Supports Digital Voice Keying (DVK) via the AUX port. Audio should be fed to 
the AUX port and NOT the microphone.  

 When no DVK is specified the front microphone gain will normally set 
to 0  

 Microkeyer users: check out the Supported Hardware chapter 
regarding muting of the ORION microphone audio input.  

 When a DVK is specified for that radio the microphone gain will not 
change (mostly fed to the front microphone).  

 When up/down pressed, turn on RIT if in S&P, turn off RIT if in running mode.  
 Clear RIT by setting to 1 Hz not 0. Avoids turning off RIT.  



 Narrow SSB bandwidth set to 1990 Hz to force the use of 2.4 kHz filter in auto 

mode.  
 RIT can be changed using the up/down keys if RIT on. Note that you must turn 

on RIT from within the program!  

 Swap VFOs using Alt+F10. This will replace the contents of memories 199 and 
200  

 Example Setup FSK/CW/SSB  
 In FSK or SSB mode the program uses the PTT input to key the rig.  
 In CW mode the program uses the PTT as the CW key.  

 Digital setup and MMTTY.  
 N1MM Config / Config Ports / Hardware Tab.  

 Set the CW menu choice for the interface com 
port to DTR (Pin 4).  

 MMTTY Setup / Setup MMTTY / TX Tab / Radio 
command button.  

 Checked the PTT button under DTR/RTS.  
 Interface information  

 LINE OUT (74) is fixed level output (RCA connector)  
 Should be fed to LINE IN on the soundcard.  
 Yellow phono plug on Pin 4 of the AUX I/O cable assembly  
 NB this is a combined output for both receivers, use the AUX 

I/O port for separated outputs (pin 4 and 6)  
 AUX I/O port (80): AUX IN (pin 1) for transmit audio from the 

soundcard  

 Should be fed to LINE OUT on the Soundcard.  
 The AUX gain can be set under the SSB menu  
 Set the AUX gain to 65 and use the computer audio setting to 

drive the rig to 100 watts for RTTY.  
 AUX port: PTT (pin 3)  

 A transistor switch is needed from a serial or parallel port.  
 Works fine for digital modes but also for recording and the voice keyer.  
 Switch between MIKE and AUX via the menu.  

 
This is a summary of the SO2V features for the Orion.  

o The stereo (grave accent - `) key toggles Sub audio On and Off. To leave SUB audio 

selected all the time, select Configurer>Dual RX always on  
 If you are using Diversity mode on the radio, toggling Sub off and on via ` or 

Alt+F12 will turn Diversity mode off  
 Logger preserves diversity reception unless RX Focus changes to vfoB at which 

time the subrx will switch to vfoB  
o Subrx ON/OFF control by Logger  

 Independent of the state of Dual RX Always On:  

 changing RX Focus to vfoB turns the subrx ON  
 Ctrl+Shift+Up/Dn does not change the state of the subrx  
 Alt+F12 toggles subrx ON/OFF if RX Focus is on vfoA (action disabled if 

RX Focus on vfoB)  

 Dual RX Always On checked:  
 clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the 

subrx ON  
 changing RX Focus turns the subrx ON  
 if dual rx always on was unchecked and the user checks it, subrx is 

turned ON  
 Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \ 
keystroke), the subrx stays ON  



 If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on 

VFOA (PAUSE, CTRL+Left or vfoA Bandmap/Available window spot 
click ), the subrx is turned OFF  

 if dual rx always on was checked and the user unchecks it, subrx is 

turned OFF  
o Ctrl+Alt+D command action:  

 If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" 
to OFF and leave the Sub RX ON  

 If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" 
to OFF and leave the Sub RX OFF  

 If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" 

to ON and leave the Sub RX ON  
 If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

o Alt+F12 command action:  
 If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  
 If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF 

unless RX Focus is on vfoB  

9.8. Eagle 

 This radio is NOT capable of SO2V operation. Select SO1V or SO2R program 
operation.  

 The radio firmware requires a 200ms delay after every Set-type command. 
Users may notice this delay when the program is setting the frequency, mode, 
or split.  

10. Yaesu 

10.1. General Yaesu information 

 The models below are supported, other models are not supported.  
 Required interfaces  

 Newer models connect directly via a serial port cable.  
 Older models need the Yaesu FIF-232C CAT interface (or compatible).  

 Software handshaking is being used for all models.  
 Yaesu uses by default:  

 Speed: 4800 Baud Parity: N Databits: 8 Stopbits: 2  

10.2. FT-80C 

 It has been reported that this radio will not transmit key CW or MIC audio 
while it is sending the radio polling data to the computer. The radio polling 
string is fixed by the radio firmware and it requires over 800ms to send the 
data to the computer at 4800 baud. This radio should only be used without 
radio control. This operation just isn't practical for contesting.  

10.3. FT-100(D) 

 The FT-100D has an internal jumper for either CAT/TUNER or LINEAR. This 
should be set for CAT/TUNER.  

 Configure the radio as FT-100, 4800, N, 8, 2, Handshake, Tx=1, DTR=Always 
on or off, RTS=Always on or off.  

 Needs a standard FT-100 CAT cable (CT-62).  



10.4. FT-736 

 Not supported and probably never will be. It seems that once the radio is 
controlled by CAT it can't be controlled by hand anymore.  

10.5. FT-450 

 When using a 3 wire cable (TX, RX and ground) set CAT RTS=disable on radio (default is 

enable). This cable does not have DTR or RTS connected. The radio settings CAT TOT should 
be set to 1000 and CAT RATE must match the program configuration. A three wire cable 
should also work with USB serial adapters.  

 There are other forms of the CATMacros for SO2R use but a basic form to play the internal 

radio voice memory 1 & 2 and stop the message are:  
o {CAT1ASC PB1;}  
o {CAT1ASC PB2;}  

o {CAT1ASC PB0;}  
 The DVK stop command is sent to the radio when the ESC key is pressed.  

10.6. FT-747GX 

 It has been reported that this radio will not transmit key CW or MIC audio 
while it is sending the radio polling data to the computer. The radio polling 
string is fixed by the radio firmware and it requires over 800ms to send the 

data to the computer at 4800 baud. This radio should only be used without 
radio control. This operation just isn't practical for contesting.  

10.7. FT-757 

 Select FT-757GXII as radio and disable the radio communications timeout via 
the bandmap menu option (set it to 0).  

 The FT-757GX does NOT send anything to the computer and the radio mode 
can not be set by the program so the radio control functionality will be limited.  

10.8. FT-757GXII 

 Supported  

10.9. FT-767 / FT-767GX 

 There are no plans to support this radio.  

10.10. FT-817 

 19200, N, 8, 1, Handshake, Handshake. FT-817 CI-V Baud "Hi". When using a USB/Serial 
adapter set DTR to 'Always on' and RTS 'Always off'.  

 There are some limitations in the radio control provided by Yaesu.  

o The best way to understand what is possible is to take few minutes and review the 
available CAT Commands on page 72 of your operating manual.  

o VFO A/B : It is only possible to switch from one VFO to the other but there is no way 
to know by the program if the radio is on VFO A or VFO B.  

o Narrow CW Filter : There is no CAT Command to set Filters on the radios.  

10.11. FT-840 



 Supported  

10.12. FT-847 

 Split operation via the program is not functional due to Yaesu radio control limitations. Split 
needs to be set/cleared manually by the operator.  

10.13. FT-857, FT-857D 

 There has been a confirmed change in the radio firmware in the newer model FT-857 radios. 
This operational change removed the radio control VFOA/B selection indicator which has 
broken SO2V operation. This is a radio limitation, not a program limitation. The newer model 

FT-857 radios can only be used in SO1V or SO2R program modes. If you own an older model 
radio, SO2V operation will function when selecting the FT-897 radio in the program menu.  

10.14. FT-890 

 Supported  

10.15. FT-897 

 The radio control provided by Yaesu is limited. All operating modes (SO1V, SO2V, SO2R) are 
supported.  

 The PTT line in the DATA jack on the rear of the radio cannot be used for CW, because when it 

is asserted, the radio sends a continuous key-down tone. To actuate PTT from the program 
using RTS or DTR, the interface must be wired to the front-panel microphone jack's PTT pin.  

10.16. FT-897D 

 The radio control provided by Yaesu is limited.  

 If you are having problems with the SO2V radio control with a newer model FT-897D radio, 
this is likely caused by a change made to the radio firmware. The solution is to select the FT-
857 radio model and use the SO1V or SO2R program modes. See the comment in the FT-857 
text about the confirmed operational change in the radio. This is a radio limitation not a 

program limitation.  

 The PTT line in the DATA jack on the rear of the radio cannot be used for CW, because when it 
is asserted, the radio sends a continuous key-down tone. To actuate PTT from the program 
using RTS or DTR, the interface must be wired to the front-panel microphone jack's PTT pin.  

10.17. FT-900 

 Supported  

10.18. FT-920 

 The radio control provided by Yaesu does not include an indicator in the polling data to 
indicate which VFO is selected or active. If the user changes the VFO by pressing the radio 
buttons, the program can not detect this change. This is a radio limitation, not a program 
limitation. It is recommended to use this radio in SO1V or SO2R mode.  

10.19. FT-950 



 The radio menu CAT TOT should be set to 1000 or higher.  

 The radio menu CAT RATE must match the program COM port baud rate. The suggested baud 
rate is 38400 (38400, N, 8, 2).  

 When using a COM port cable that contains data and signaling wires, verify that the radio 

menu CAT RTS = ENABLE (default) and the program radio COM port RTS to Handshake or 
Always ON.  

 When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = 

DISABLE on the radio menu and set the program radio COM port RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play the internal 
radio voice memories are:  

o {CAT1ASC PB0#;} (where # is a number 1 - 5 for message 1 - 5)  

o {CAT1ASC PB00;} (stop)  
 The DVK stop command is sent to the radio when the ESC key is pressed.  

10.20. FT-990 

 FT-990 and early FT-1000 had a design problem in the CAT interface. It used an open emitter 
transistor on the serial out line. That worked fine for TTL HIGH (+5 V) but some TTL to RS232 
interfaces did not have enough load to cause the output to go low ... the interface would 
"float" in the undefined logic state between .3 and 3.5 volts. The solution is to add a 1.5K 

Ohm resistor from "serial out" to ground. When using the ARRL handbook design the 1.5k 
resistor needs to be added between pin 1 of the 7417 (which is pin 2 of the DIN) to ground.  

 The radio control provided by Yaesu does not include an indicator in the polling data to 
indicate which VFO is selected or active. If the user changes the VFO by pressing the radio 

buttons, the program can not detect this change. This is a radio limitation, not a program 
limitation. It is recommended to use this radio in SO1V or SO2R mode.  

10.21. FT-1000(D) 

 Cat control will not work with FT-1000D internal software version lower than 

v6....most older ft1000d's have version v5.8... you need an update!  
 Older versions do have a CAT control problem. Check out the infromation with 

the FT-990 (above).  
 If the bandmap/frequency is not updating, the radio probably is in Mem/Tune 

mode. Deselect using the VFO/MEM switch.  
 The program forces the radio at startup from Mem/Tune mode in VFO 

mode to avoid this problem.  
 For filter settings see below  

o The stereo (grave accent - `) key toggles Sub on and off. It is identical to pressing the 
SUB radio button. To leave SUB on all the time, select Configurer>Dual RX always 
on  

o Subrx ON/OFF control by Logger (SO2V mode)  

 Independent of the state of Dual RX Always On:  
 Changing RX Focus to VFOB turns the subrx ON  
 ` or Alt+F12 toggles subrx ON/OFF if RX Focus is on VFOA (action 

disabled if RX Focus on VFOB)  

 Dual RX Always On Checked:  
 Clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the 

subrx ON  

 Changing RX Focus turns the subrx ON  
 If dual rx always on was unchecked and the user checks it, subrx is 

turned ON  
 Dual RX Always On Unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \ 
keystroke), the subrx stays ON  



 If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on 

VFOA (PAUSE, CTRL+Left or VFOA Bandmap/Available window spot 
click ), the subrx is turned OFF  

 If dual rx always on was checked and the user unchecks it, subrx is 

turned OFF  
o Ctrl+Alt+D command action:  

 If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" 
to OFF and leave the Sub RX ON  

 If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" 
to OFF and leave the Sub RX OFF  

 If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" 

to ON and leave the Sub RX ON  
 If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

o Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX Always On" 
state:  

 If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  
 If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF 

unless RX Focus is on VFOB  

10.22. FT-1000MP (Mark-V)(Field) (Not for use with SteppIR antenna 

controller) 

 The program can't send CW via the MP's serial cable. See the help for how to 
build a CW interface  

 If the bandmap/frequency is not updating, the radio probably is in Mem/Tune 
mode. Deselect using the VFO/MEM switch.  

 The program forces the radio at startup from Mem/Tune mode in VFO 

mode to avoid this problem.  
 The indicator should show VFO.  

 Use a straight serial cable  
 4800,N,8,2 and DTR and RTS set to "Always Off"  
 A big issue with the FT-1000MP is that you cannot set the radio to split with 

VFO-B as the RX. Well, you can, but you cannot control whether you are 
listening dual, or just VFO-B from the computer. You can detect it, but not set 

it. The user will have to press the main RX button to turn off the main receiver 
when split from VFO-B. Note that Alt+F10 will swap VFO A & B frequencies. 
That is very useful in this case.  

 Optimum configuration for those who wish to operate AFSK and/or PSK. There 
will be an 85 Hz display offset between RTTY and PSK but that is minor.  

 PKT is LSB with the frequency display shifted by 2.125 KHz (or other user 

defined offset at menu 6-4). It also selects audio input from the PACKET jack 
on the rear of the radio, disables the processor and mutes the microphone. 
Finally, it offsets the filters so the narrow filters are properly placed (centered 
as specified in menu 6-5).  

 Using QMB memories  
 When doing a QMB RCLl press M>A until it transfers the QMB 

frequency to the VFO. After this it should work as normal, but you lose 

the original frequency that was in VFO-A.  
 For filter settings see below  

o The stereo (grave accent - `) key toggles Sub on and off. It is identical to pressing the 
SUB radio button. To leave SUB on all the time, select Configurer>Dual RX always 
on  

o Subrx ON/OFF control by Logger (SO2V mode)  
 Independent of the state of Dual RX Always On:  

 Changing RX Focus to VFOB turns the subrx ON  
 The ` key or Alt+F12 toggles subrx ON/OFF if RX Focus is on VFOA 

(action disabled if RX Focus on VFOB)  
 Dual RX Always On Checked:  



 Clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the 

subrx ON  
 Changing RX Focus turns the subrx ON  
 If dual rx always on was unchecked and the user checks it, subrx is 

turned ON  
 Dual RX Always On Unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \ 
keystroke), the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on 
VFOA (PAUSE, CTRL+Left or VFOA Bandmap/Available window spot 
click ), the subrx is turned OFF  

 If dual rx always on was checked and the user unchecks it, subrx is 
turned OFF  

o Ctrl+Alt+D command action:  
 If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" 

to OFF and leave the Sub RX ON  
 If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" 

to OFF and leave the Sub RX OFF  
 If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" 

to ON and leave the Sub RX ON  
 If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

o Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX Always On" 
state:  

 If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  

 If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF 
unless RX Focus is on VFOB  

10.23. FT-1000MPSteppIR 

 Select this FT1000mp when using a SteppIR antenna.  
 This selection is optimized for the combination of an FT1000MP and the 

SteppIR antenna. It sends radio commands one at a time, paced with the 
command delay. Otherwise, it is identical to the FT-1000MP  

10.24. FT-1000 series, FT-990 and FT-920 Setting filters 

Simply right-click on the bandmap and you will get a menu which includes "Set transceiver filter 
codes" ... there are six submenus: CW Wide, CW Narrow, SSB Wide, SSB Narrow, Digi Wide and Digi 
Narrow. In my case the commands for SO2V are:  

 The settings below will work for the FT-1000, FT-1000D, the FT-1000MP, the 
FT-1000MP/MKV and the FT-1000MP/MKV Field (or any combination of two FT-
1000 "family" of rigs in SO2R).  

BandWidth VFO-A (main) VFO-B (sub) Filter Remarks  

2.4 kHz 0 0 0 0 140 0 0 0 128 140 SSB Wide or Digi Wide —  

2.0 KHz 0 0 0 1 140 0 0 0 129 140 SSB Narrow or Digi Narrow will use 2.4 kHz on VFO-B  

500 Hz 0 0 0 2 140 0 0 0 130 140 CW Wide or Digi Wide —  

250 Hz 0 0 0 3 140 0 0 0 131 140 CW Narrow or Digi Narrow will use 500 Hz on VFO-B  

6.0 KHz (thru) 0 0 0 4 140 0 0 0 132 140 —  -- 

 The VFO-B (sub) only supports bandwidths of 6.0 KHz, 2.4 KHz and 500 Hz.  

 For SO2R (two rigs) configure the two bandmaps the same.  



 Some notes:  

 "Duplicates default filter settings" is appropriate to the FT-1000 MK/V 
and Field only. The FT-1000/D/MP permit more flexible filter selection.  

 The FT-920 does not support 2.0 KHz and 250 Hz filters ... it might 

make more sense to revise CW and Digi settings for 2.4/500 Hz (0 0 0 
0 140 and 0 0 0 2 140) filters.  

 Even though the FT-920 lacks the second receiver, the FT-920 permits 
selecting different bandwidths for each VFO. The CAT commands are 
the same as those for the second receiver in the "1000" series: 0 0 0 
130 140 selects 500 Hz and 0 0 0 128 140 selects 2.4 KHz.  

 The FT-990 commands are the same as those for VFO A in the "1000" 
series of radios.  

10.25. FT-2000 

 A user has reported communications issues when using firmware version 11.54 1.55. It's 

unclear if a CAT menu has been changed or added. The user reported no issues when using 
firmware 11.53 1.50.  

 The radio menu CAT TOT should be set to 1000 or higher.  

 The radio menu CAT RATE must match the program COM port baud rate. The suggested baud 
rate is 38400 (38400, N, 8, 2).  

 When using a COM port cable that contains data and signaling wires, verify that the radio 
menu CAT RTS = ENABLE (default) and the program radio COM port RTS to Handshake or 
Always ON.  

 When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = 

DISABLE and the program radio COM port RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play the internal 

radio voice memories are:  
o {CAT1ASC PB0#;} (where # is a number 1 - 5 for message 1 - 5)  
o {CAT1ASC PB00;} (stop)  

 The DVK stop command is sent to the radio when the ESC key is pressed.  

 The stereo (grave accent - `) key toggles Sub RX On and Off. To leave SUB On all the time, 
select Configurer>Dual RX Always On  

 Subrx ON/OFF control  
o Independent of the state of Dual RX Always On:  

 Changing RX Focus to VFOB with \, PAUSE, or CTRL+RightArrow turns the 
subrx ON  

 Ctrl+Shift+Up/Dn used to store the next Bandmap spot in the Sub does not 
change the state of the subrx  

 The ` key or Alt+F12 toggles subrx ON/OFF when RX Focus is on VFOA. This 
action is disabled if RX Focus on VFOB.  

o Dual RX Always On checked:  
 Clicking any VFO, Bandmap, or Available window spot or Ctrl+Up/Dn turns the 

subrx ON  

 Changing RX Focus with \ turns the subrx ON  
 If Dual RX Always On was unchecked and the user checks it, subrx is turned 

ON  
o Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA with the \ 
keystroke, the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on VFOA 

(PAUSE, CTRL+Left or VFOA Bandmap/Available window spot click ), the subrx 
is turned OFF  

 If Dual RX Always On was checked and the user unchecks it, subrx is turned 
OFF  

 Ctrl+Alt+D command action:  



o If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" to OFF 

and leave the Sub RX ON  
o If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" to OFF 

and leave the Sub RX OFF  

o If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" to ON 
and leave the Sub RX ON  

o If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX Always On" state:  

o If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  
o If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF unless RX 

Focus is on VFOB  

 Also see the Advanced SO2V for Radios with Separate Sub-Receivers? section of this manual.  

10.26. FTDX-1200 

 The N1MM Logger developers are busy with the program re-write in VB.NET. Until changes can 
be made to the program, use the FTDX-3000 radio selection. Follow the menu instructions for 
that radio. Report any radio control issues to K3CT.  

10.27. FTDX-3000 

 The radio menu settings:  
o CAT TOT should be set to 1000 or higher.  
o CAT SELECT must be set to USB if you wish to use the internal USB port for CAT 

control.  

o PC KEYING must be set to DTR to send CW with a COM port or with the USB port on 
the radio.  

o CAT RATE must match the program COM port baud rate. The suggested baud rate is 
38400 (38400, N, 8, 2).  

 When using a COM port cable that contains data and signaling wires, verify that the radio 

menu CAT RTS = ENABLE (default) and the program radio COM port RTS to Handshake or 
Always ON. When using a COM port cable with only three wires (TX, RX and ground) set CAT 
RTS = DISABLE on the radio menu and set the program radio COM port RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play the internal 

radio voice memories are:  
o {CAT1ASC PB0#;} (where # is a number 1 - 5 for message 1 - 5)  
o {CAT1ASC PB00;} (stop)  

 The DVK stop command is sent to the radio when the ESC key is pressed.  

10.28. FTDX-5000 

 The radio menu CAT TOT should be set to 1000 or higher.  

 The radio menu CAT RATE must match the program COM port baud rate. The suggested baud 

rate is 38400 (38400, N, 8, 2).  

 When using a COM port cable that contains data and signaling wires, verify that the radio 

menu CAT RTS = ENABLE (default) and the program radio COM port RTS to Handshake or 
Always ON.  

 When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = 

DISABLE and the program radio COM port RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play the internal 
radio voice memories are:  

o {CAT1ASC PB0#;} (where # is a number 1 - 5 for message 1 - 5)  
o {CAT1ASC PB00;} (stop)  

 The DVK stop command is sent to the radio when the ESC key is pressed.  

http://n1mm.hamdocs.com/tiki-editpage.php?page=SO2V


 The stereo (grave accent - `) key toggles Sub RX On and Off. To leave SUB On all the time, 

select Configurer>Dual RX Always On  

 Subrx ON/OFF control  
o Independent of the state of Dual RX Always On:  

 Changing RX Focus to VFOB with \, PAUSE, or CTRL+RightArrow turns the 

subrx ON  
 Ctrl+Shift+Up/Dn used to store the next Bandmap spot in the Sub does not 

change the state of the subrx  
 The ` key or Alt+F12 toggles subrx ON/OFF when RX Focus is on VFOA. This 

action is disabled if RX Focus on VFOB.  
o Dual RX Always On checked:  

 Clicking any VFO, Bandmap, or Available window spot or Ctrl+Up/Dn turns the 

subrx ON  
 Changing RX Focus with \ turns the subrx ON  
 If Dual RX Always On was unchecked and the user checks it, subrx is turned 

ON  
o Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA with the \ 
keystroke, the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on VFOA 
(PAUSE, CTRL+Left or VFOA Bandmap/Available window spot click ), the subrx 
is turned OFF  

 If Dual RX Always On was checked and the user unchecks it, subrx is turned 
OFF  

 Ctrl+Alt+D command action:  

o If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" to OFF 
and leave the Sub RX ON  

o If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" to OFF 
and leave the Sub RX OFF  

o If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" to ON 

and leave the Sub RX ON  
o If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX Always On" state:  
o If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  

o If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF unless RX 
Focus is on VFOB  

 Also see the Advanced SO2V for Radios with Separate Sub-Receivers? section of this manual.  

10.29. FTDX-9000 

 The radio menu CAT TOT should be set to 1000 or higher.  

 The radio menu CAT RATE must match the program COM port baud rate. The suggested baud 

rate is 38400 (38400, N, 8, 2).  

 When using a COM port cable that contains data and signaling wires, verify that the radio 

menu CAT RTS = ENABLE (default) and the program radio COM port RTS to Handshake or 
Always ON.  

 When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = 
DISABLE and the program radio COM port RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play the internal 
radio voice memories are:  

o {CAT1ASC PB#;} (where # is a number 1 - 5 for message 1 - 5)  
o {CAT1ASC PB0;} (stop)  

 The DVK stop command is sent to the radio when the ESC key is pressed.  
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 The stereo (grave accent - `) key toggles Sub RX On and Off. To leave SUB On all the time, 

select Configurer>Dual RX Always On  

 Subrx ON/OFF control  
o Independent of the state of Dual RX Always On:  

 Changing RX Focus to VFOB with \, PAUSE, or CTRL+RightArrow turns the 

subrx ON  
 Ctrl+Shift+Up/Dn used to store the next Bandmap spot in the Sub does not 

change the state of the subrx  
 The ` key or Alt+F12 toggles subrx ON/OFF when RX Focus is on VFOA. This 

action is disabled if RX Focus on VFOB.  
o Dual RX Always On checked:  

 Clicking any VFO, Bandmap, or Available window spot or Ctrl+Up/Dn turns the 

subrx ON  
 Changing RX Focus with \ turns the subrx ON  
 If Dual RX Always On was unchecked and the user checks it, subrx is turned 

ON  
o Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA with the \ 
keystroke, the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on VFOA 
(PAUSE, CTRL+Left or VFOA Bandmap/Available window spot click ), the subrx 
is turned OFF  

 If Dual RX Always On was checked and the user unchecks it, subrx is turned 
OFF  

 Ctrl+Alt+D command action:  

o If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" to OFF 
and leave the Sub RX ON  

o If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" to OFF 
and leave the Sub RX OFF  

o If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" to ON 

and leave the Sub RX ON  
o If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX Always On" state:  
o If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  

o If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF unless RX 
Focus is on VFOB  

 Also see the Advanced SO2V for Radios with Separate Sub-Receivers? section of this manual.  

11. Unsupported Radios 

 JRC JST-145 & JST-245 - These radios are unsupported because they lack commands to 

determine if the radio is in split, no means to set or clear split, the VFO can not be selected, 
and they lack an indicator to determine which VFO is active.  

12. Other Models 

 Submit a Feature Request along with a URL for the developers information for the computer 
interface. Radios with limited radio control or very long data exchanges are not well suited for 
this software application.  
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2.3 Key Assignments (Keyboard Shortcuts) 

 2.3 Key Assignments (Keyboard Shortcuts)  
 1. Key Assignments Short List  
 2. General Key Assignments  
 3. Active Radio/Bandmap Control Key Assignments  

 3.1. Jump to Spots  

 3.2. Jump to CQ Frequencies  
 3.3. Tune the Radio  
 3.4. Change Keyboard & Radio Focus  
 3.5. Other Nifty Tricks  

 4. Non-Active Radio/Bandmap Control Key Assignments  
 4.1. Jump to Spots  

 4.2. Tune the Radio  
 5. Logging Key Assignments  
 6. Callsign/Exchange Editing Features  

 7. Message Key Assignments  
 8. CW Key Assignments  
 9. Multipliers by Band window Key Assignments  
 10. Multi-User Key Assignments  

 11. 'Enter Sends Message' mode (ESM)  
 12. Packet/Telnet Key Assignments  
 13. Available Window Key Assignments  
 14. SO2R Key Assignments  
 15. RTTY Key Assignments  
 16. Gridsquare Key Assignments (VHF and up)  
 17. Rotator Key Assignments  

 18. Window Key Assignments  
 19. Lookup Table Edit  
 20. QTC Keys (for WAE contests)  

1. Key Assignments Short List 

Key Assignments Short List 

Running keys S&P Keys 

F1 = CQ Shift+F1 = Call CQ and switch to run 

; or insert = Send call and report Alt+U= Toggle S&P/Run. Set CQ-frequency for pass 

' = Send TU message and enter in log Alt+Q = Return to CQ-frequency 

Alt+R or left click on red dot = Enable CQ 
repeat 

Ctrl+Up/Dn arrow = Grab next qso from 
bandmap 

Ctrl+R or right click on red dot = Set repeat 
time 

Ctrl+Alt+Up/Dn arrow = Grab next mult from 
bandmap 

Esc = Stop sending, stop repeat - 

General keys Radio control 

Ctrl+O = Set operator call (or OPON in Callsign 
field) 

Alt+F10 = Swap VFOs 

Ctrl+N = Add note to log Alt+Q = Return to CQ frequency 

Ctrl+W or Alt+W = Wipe entry fields, or unwipe 
a previously wiped contact. Release a reserved 
serial number 

Alt+F8 = Return to last frequency 

SPACE or TAB = Move between logging fields Ctrl+PgUp/PgDn = Up/Down a band 



ENTER = Log it (see ESM mode) 
Type CW/USB/LSB/RTTY = Change mode Type 

frequency in KHz = Change frequency or band 

Ctrl+Q/A = Quick edit previous or next call 
Ctrl+S = Set radio into split Ctrl+Alt+S - Toggle 
split mode 

Ctrl+D = Delete last qso! Ctrl+Enter = Set split frequency 

Alt+H = Show help 
Alt+F7 = Set split frequency or offset to specified 

frequency 

Alt+K = Edit message buttons Alt+' = Toggle between the wide and narrow filters 

Ctrl+Alt+Enter = Log a not accepted 'invalid' 
qso 

Alt+F12 - Copy frequency and mode to other 
radio/VFO or swaps MAIN and SUB using the CAT 
radio command 

- 
Backslash ( \ ) = Change Receive (RX) focus 

(VFO/Radio) 

DX Spots and Band Map ESM Mode 

Mouse wheel = Zoom in/out bandmap Ctrl+M = Turn on/off 

Keypad +/- = Zoom in/out bandmap Insert or ; = Send call and exchange 

Alt+D = Remove spot Enter = Send TU and log it 

Alt+P = Send spot Enter = Start CQ again... 

Ctrl+P = Send spot with comment Alt+Enter = Log without sending anything 

Ctrl+Tab = Toggle to/from packet window Multi-User Mode 

Alt+O = Store contact in the Bandmap 
Alt+Z = Set pass frequency (broadcast to all 
computers) 

Alt+Q = Jumps to the CQ frequency on this 
band 

- 

SO2R Specific radios / Rotor control 

Backslash ( \ ) - Two radios = Change Receive 

(RX) focus 

FT-1000MP + FT1000D + some Icom Dual 

Watch radios Alt+F12= Dual Receive toggle 

Pause = Swap both Transmit and 
Receive/Keyboard focus  

Ctrl+Enter = Send next ESM state on alternate 
radio 

TenTec Orion Alt+F12 = Toggle Main/left 
Sub/Right and Active in both ears. 

Ctrl+F1 to F12 = Send message on alternate 

radio  

Ctrl+B = Dueling CQ's 
Rotor control for the callsign in the Entry 

window 

` (Back-quote) = Toggle Stereo/Mono ( LPT pin 
5) 

Alt+J - Turn rotor to bearing 

Ctrl+I - Toggle through sound card SO2R 
supported modes ($5SO2R) 

Alt+L - Turn rotor to long path bearing 

- Ctrl+Alt+J - Stop turning the rotor 

CW SSB RTTY VHF 

Page Up = speed up Ctrl+Shift+F1 =Record CQ 
Alt+G = Grab call 
from stack 

Alt+minus = Toggle 
grids 

Page Down = speed 
down 

Ctrl+Shift+F* =Record F-
key message 

Alt+T = RX/TX toggle 
Ctrl+E = Send message 
to stations 

= = send last Fkey 

again 

NB. Same keys again to stop 

recording 

Ctrl+Arrows = 

Swaps DI 
- 

Shift +Fx = send 
opposite mode Fx 

Same Same Same 



CW SSB RTTY VHF 

Ctrl+K = CW window - 
Ctrl+K = manual 

window 

Alt+Z = Set pass 

frequency 

Esc = Stop sending --- Esc = Stop sending - 

Note 

The keys below work from all main windows 

2. General Key Assignments 

 Space - The spacebar will jump from field to field filling in defaults like the callsign from the 

frame, 59/599, and information from previous contacts with this station. SPACE IS THE 
PREFERRED TAB CHARACTER.  

 Tab - Jump to the next entry field in the Entry Window.  

 Shift+Tab - Jump to the previous entry field in the Entry Window.  

 Alt+H - open Internet help. Most windows have contest-specific help accessible from their 

right-click menus.  

 Ctrl+Tab - Toggle between the Entry window and the Packet window.  

 Alt+F9 - toggle through all the antennas for that band. The selected antenna will show in the 
status pane.  

 Alt+F4 - Quit the program. If two Entry windows (SO2R) the program will not exit. You are 
being asked if you are sure.  

3. Active Radio/Bandmap Control Key Assignments 

3.1. Jump to Spots 

Note 

If you are operating single mode, your mode won't change when jumping between spots. 

 Ctrl+Down Arrow - Get next spot higher in frequency.  

 Ctrl+Up Arrow - Get next spot lower in frequency.  

 Ctrl+Alt+Down Arrow - Get next spot higher in frequency that is a multiplier.  

 Ctrl+Alt+Up Arrow - Get next spot lower in frequency that is a multiplier.  

 Shift+Alt+Up Arrow - Get next spot lower in frequency that is self-spotted.  

 Shift+Alt+Down Arrow - Get next spot higher in frequency that is self-spotted.  

3.2. Jump to CQ Frequencies 

 Alt+Q - Jumps to the last CQ frequency on this band (active bandmap) and will clear all 
textboxes in the Entry Window.  

 Shift+Alt+Q - Jumps to the last CQ frequency on other band (non-active bandmap).  

 Ctrl+Alt+Q - Jumps to your last used CQ frequency on any band and tune active bandmap to 

that frequency.  

 Alt+F8 - Return to your previous frequency (you can use this to "undo" Alt+Q).  

3.3. Tune the Radio 

 Ctrl+Page Up - Go up one band. WARC bands are skipped while logging for a contest.  

 Ctrl+Page Down - Go down one band. WARC bands are skipped while logging for a contest.  

 Up Arrow - Tune radio down 100 Hz on SSB, 20 Hz on CW (adjustable in the configurer).  
o FT-1000MP, FT-890, FT-920, FT-990 and FT-1000 and all Kenwood radios  



 In S&P - pressing the up/down arrows will turn off RIT and tune your main 

VFO.  
 In Running mode - it will turn on your RIT and tune the RIT.  

 Down Arrow - Tune radio up 100 Hz on SSB, 20 Hz on CW (adjustable).  

o See Up Arrow information above  

  

 Alt+F7 - Set split frequency or offset from current frequency for the active radio. When 
hitting Enter or click OK with nothing on the line split will be cleared. Press ESC or click Cancel 
to exit. More information about working split can be found in the Single Operator Split 
Operation chapter.  

 Ctrl+Enter - Entering a frequency or offset in the callsign field and entered with Ctrl+Enter 
will set a split frequency.  

 Alt+S - When your rig is in the split mode, Alt+S will reset the RX frequency back to your 

transmit frequency, but the split mode is preserved. "Reset RX frequency when running split" 
is associated with Alt+S. When invoked, the program will automatically do an Alt+S as you log 
each QSO. Operates on VFO-A only!  

 Ctrl+S - Set radio to split operation, if not in split mode already.  

 Ctrl+Alt+S - Toggle Split mode on the radio. 'Split' will be shown in the Entry window.  

  

 Alt+F5 - Swap radio frequency, mode, and callsigns between VFOs (SO2V) or radios (SO2R). 
In SO2R, the receive focus changes to the non-active radio.  

 Alt+F6 - Identical to Alt+F5 except the receive focus does not change.  

 Alt+F8 - Jump to your last frequency.  

 Alt+' (Alt+singlequote) - toggle between the wide and narrow filter for the selected mode 
(SSB, CW and Digi modes).  

 Ctrl+Alt+D - Allows the SO2V user to enable CQ repeat, call CQ on VFOA, and tune the sub-

receiver (VFOB) between CQ's. Currently, this feature is only enabled for the K3, IC756, 
IC756Pro, IC756Pro2, IC756Pro3, IC7800, and IC7600.  

o If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always On" to OFF 
and leave the Sub RX ON  

o If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX Always On" to OFF 

and leave the Sub RX OFF  
o If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX Always On" to ON 

and leave the Sub RX ON  
o If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

3.4. Change Keyboard & Radio Focus 

 Ctrl+Left arrow - Move both TX and RX/Keyboard focus to VFO A or in SO2R to left radio  

 Ctrl+Right arrow - Move both TX and RX/Keyboard focus to VFO B or in SO2R to right radio  

 Alt+F10 - Swap between VFOs when using one radio (VFO A-B). On Icom 756 and 7800 
toggle between Main and Sub frequencies.  

o Command is disabled during SO2R for Icom radios that lack a swap VFO CAT 
command. This is because the program is unaware of Icom VFO B frequency in SO2R 
mode.  

 Pause - Swap radios and match keyboard to radio.  

 Backslash ( \ ) - Move RX focus and launches a second Entry Window if only one Entry 

window is open (not supported for SO1V).  
o SO2V - One radio - 2 VFOs - Moves RX focus between the 2 VFOs on the radio.  
o SO2R - Two radios - Moves RX focus between the 2 radios.  

3.5. Other Nifty Tricks 

 Mouse wheel - Zoom in or out the bandmap which has KEYBOARD focus.  

 Numeric keypad + (plus) - Zoom in the bandmap which has KEYBOARD focus to show 
fewer stations (less bandwidth).  

http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Split+Operation
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 Numeric keypad - (minus) - Zoom out the bandmap which has KEYBOARD focus to show 

more stations (more bandwidth).  

 Ctrl+T - Turn on the radio and send continuous CW (tune). Ctrl+T again or the Escape key 
ends the transmission.  

 Alt+F11 -Toggle the setting of the run box. Toggle whether to go into S&P when you QSY, or 

stay in Run mode when the frequency is changed (DXpedition mode).  

 Alt+F12 - Most radios use this command to copy frequency and mode to other radio/VFO.  

o A few radios use Alt+F12 for specific features and then mostly swaps MAIN and SUB 
using the CAT radio command  

o FT-1000MP + FT1000D + Elecraft K3 + Icom IC-756 series, IC-781 ,IC-775 
and IC-7800 only  

 Dual Receive toggle. NB. Only turn Dual Receive on/off from the keyboard so it 
stays in sync with the program.  

o TenTec Orion  

 Toggle between Main/left Sub/Right and Active in both ears.  

 ` (backquote or grave accent)  

o SO2R mode,Toggle Stereo/Mono ( LPT pin 5). If MK2R or OTRSP is enabled send 
stereo commands to the external SO2R controller.  

o SO2V mode, some radios containing Dual Rx have specific functions assigned to this 
key. See the Supported Radios section for the specifics.  

o SO1V mode, disabled.  
o Backquote (grave accent) can be found on US keyboard as the unshifted tilde ~  

 = (equal key) - Will send the last message key (F1-F12) again.  

 Alt+F11 Staying in Run Mode. During DXpeditions it could be very useful to stay in Run mode 
all the time and not jump inadvertently to S&P mode when you QSY. This behavior can be 
toggled using the Alt+F11 key. The following message will be given in the statusbar when 

DXpedition mode is ensabled "Run/S&P auto-toggle disabled". Back to normal shows the 
message "S&P and Run Mode enabled"  

 
 

4. Non-Active Radio/Bandmap Control Key Assignments 

4.1. Jump to Spots 

 Ctrl+Shift+Down Arrow - Get next spot higher in frequency and will skip over CQ-

Frequency when radios/VFOs are on the same band. Proper keystroke operation is radio 
dependent. Disabled for SO1V.  

 Ctrl+Shift+Up Arrow - Get next spot lower in frequency and will skip over CQ-Frequency 

when radios/VFOs are on the same band. Proper keystroke operation is radio dependent. 
Disabled for SO1V.  

 Shift+Ctrl+Alt+Down Arrow - Get next spot higher in frequency that is a multiplier. If you 

are operating single mode, your mode won't change when jumping between spots. Disabled 
for SO1V.  

 Shift+Ctrl+Alt+Up Arrow - Get next spot lower in frequency that is a multiplier. If you are 

operating single mode, your mode won't change when jumping between spots. Disabled for 
SO1V.  

 Shift+Alt+Q - Jumps to your last CQ frequency on the inactive VFO/radio.  

4.2. Tune the Radio 

 Ctrl+Shift+Page Up - Go up one band.  

 Ctrl+Shift+Page Down - Go down one band.  

 Shift + Numeric keypad + (plus) - Zoom in the inactive bandmap  



 Shift + Numeric keypad - (minus) - Zoom out the inactive bandmap  

5. Logging Key Assignments 

 Enter  

o Log contact, when 'Enter sends message' is off in config menu.  
o Sends message when 'Enter sends message' is on in config menu. The send messages 

depend on the field values i.e. in which field the cursor is in the Entry Window. Check 
the highlighted keys.  

 Space - Preferred character to move sequentially through Entry Window fields .  

o Jumps from callsign to Exchange field or vice versa.  
o Other fields' default values will be filled in  
o If there is a call on the callsign frame and if the callsign field is empty, the call from 

the frame will be placed in the callsign textbox.  

 Alt+Enter - Send End of QSO message key and log the contact. In ESM it just logs the 
contact (nothing sent).  

 Insert or ; - Sends His Call key followed by the Exchange key.  

 ' - Send End of QSO message and enter in log .  

 Alt+W or Ctrl+W (Alt+W = Ctrl+W)  

o Wipe Out Entry Fields, clear information about the current contact in this window  
o If all of the entry fields are blank, this restores the last wiped contact ("unwipe" 

function)  
o Serial number contests: Release a reserved serial number after it has been reserved  

 Ctrl+Shift+W - Wipe out other window's contact information.  

 Ctrl+Alt+Enter - Log a not accepted 'invalid' qso (invalid exchange etc.). It will prompt for a 
comment. Use 'View | Notes' to correct later.  

o When no comment is entered "Forced QSO" will be added to the comment field.  

 Ctrl+Y - Edit last contact.  

 Ctrl+D - Delete the last contact.  

 Alt+O - Store contact in the bandmap.  

 Alt+M - Mark this frequency in the bandmap as being in use.  

 Alt+D - Removes the spot from the bandmap which is on the callsign frame or in the callsign 
field in the Entry window when S&P or CQ-frequency when Running.  

 Alt+P - Spot the contact on the current Packet/Telnet connection.  

 Ctrl+F - Find the callsign entered in the callsign field in the log. Pressing Ctrl+F again will find 

the next instance.  

 Ctrl+M - Enable/disable 'Enter sends message' mode.  

 Ctrl+N - Add a note/comment to your last or current contact.  

 Ctrl+Q - Quick Edit mode, go back one qso in the log. Enter logs and Escape discards the 
changes made. No content checking!  

 Ctrl+A - Quick Edit mode, go forward one qso in the log. Enter logs and Escape discards the 

changes made. No content checking!  

 Ctrl+U - Increase the number in the exchange field by 1.  

 Alt+U - Toggles "Running' box". When running is checked, the behavior of Enter Sends 
Messages mode changes appropriately. Additionally contacts are logged as being part of a run.  

 Alt+K - Change the contents of the Packet/CW/SSB/Digital message buttons.  

 Alt+Y - Will "yank" the first call from the Check window in the Entry window callsign field.  

 Ctl+G - Cut number mode toggle.  

 Ctrl+Alt+G - to stack additional callsigns in all modes. Same as the macro {STACKANOTHER}  

 Ctrl+Shift+M - Used to set the Autosend threshold. Autosend will start sending the callsign 

before you have finished copying a full callsign. i.e. starting after a certain number of 
characters has been typed AFTER the last number in the callsign. The minimum threshold is 1. 
Zero will turn off the feature. Only when in RUN mode. 

o The Autosend rules are: 

 Find the first letter in the call  



 Find the last number after the first letter  

 Find the Nth letter after step 2  
 For example: Threshold set to 2 

 W4WYP would start sending at Y  

 S57AD would start sending at D  
 KH6/WA4WYP would start sending at Y (using the "/" rule as well)  
 WA4WYP/4 would start at Y (/4 will not be looked at)  

 WYP, WWYP and WAWYP do not meet the criteria for autosend to begin.  
 Prefixes like KH6/ are ignored and do not themselves trigger the autosend 

threshold.  

Key  Send function key(s) Action(s) 

Insert His Call Key & Exchange Key Send his call followed by the Exchange. 

;  His Call Key & Exchange Key Send His call followed by the Exchange. 

Alt+Enter 
 

Log the contact. 

' End of QSO Key & Log contact Send the End of QSO message and log the contact. 

6. Callsign/Exchange Editing Features 

 Space Bar - Moves cursor to the position the last position the cursor was in prior to leaving 

the Callsign or Exchange fields.  

 Tab - Move to the next field.  

 Shift+Tab - Move to the previous field.  

 Home - Moves cursor to beginning of the field it's in.  

 End - Moves cursor to end of the field it's in.  

 Question mark (?) - Sends a ?, and will cause the ? to be highlighted when you reenter the 

field . E.g. N?MM will send what is typed, but automatically highlight the ? so you can replace 
it. A double ?, as in DL?K?A will highlight all text in between and including the ? marks. The 

first keystroke entered will replace all three characters.  

 Left/Right Arrow - Moves cursor to left or right one position within the field it's in.  

 Backspace - Delete character to the left.  

 Delete - Delete character to the right.  

 Shift+Home - Will highlight from the cursor insertion point to the home (beginning) of the 
textbox.  

 Shift+End - Will highlight from the cursor insertion point to the end of the textbox.  

 Shift+arrow key - Will highlight as you press the keys. When you type the first character, it 
will delete the highlighted character.  

7. Message Key Assignments 

 

There are two sets of messages stored for F1 through F12, one for Running mode and one for Search 
and Pounce mode. However, you can send the message from the opposite mode by pressing Shift+Fx. 
The assignments below apply to both modes.  

Below is a table of the function keys with their associated default messages. Note that the CQ key 
always switches the program to Running mode regardless of which mode it was in at the time. All of 
the keys named in the table are used by ESM. The His Call key, Exchange key and End of QSO key are 
called up by logging key shortcuts (Insert or ; key and' key) regardless of whether the Enter Sends 
Messages (ESM) feature is used or not. The function keys can be remapped to others on the Function 
Keys tab in the Configurer, but be very careful in doing so, because if you do, you may disrupt 
the functioning of the Enter Sends Messages (ESM) feature.  



Default Function Keys 

F1 CQ key F2 Exchange key F3 End of QSO Key F4 My Call Key 

F5 His Call Key F6 QSO B4 Key F7 - F8 Again Key 

F9 - F10 - F11 - F12 - 

 Esc - Stop sending CW or wav. file.  

 Ctrl+R - Set CQ repeat time in seconds or milliseconds (Example: 1.8 or 1800)  

 Alt+R - Toggles repeat mode. Hit Esc or begin entering a callsign to stop repeat temporarily  

 Shift+Fx - Sends the contents of the function key definition for the opposite mode. If you are 

in Run mode and press Shift+Fx, the program sends S&P Fx. The reverse is also true.  

 Ctrl+Shift+Fx - Record SSB message for the selected function key. Pressing Ctrl+Shift+Fx 
again stops the recording. Fx can be F1 to F12 in either the Run or S&P lists of function key 

definitions. Make sure that the program is in the correct mode (either Run or S&P), and that 
you have filled in filenames in rows Filenames must be entered in at least the first 12 function 
key slots (right-click on the message buttons in the Entry window to edit); if names are only in 
the first 12, then the program will play those messages when the corresponding function keys 
are pressed, regardless of whether you are in Run or S&P mode.  

 Ctrl+Alt+Fx - Record external DVK memories 1 to 4, only on the W9XT card or other 
DVKs that emulate it  

8. CW Key Assignments 

 PgUp/PgDn - Adjust CW speed Up/Down active radio using Primary CW Speed Step (Other 
tab in Configurer).  

 Shift+PgUp/PgDn - Adjust CW speed Up/Down active radio/VFO using Secondary CW Speed 

Step (Other tab in Configurer) in SO2R/SO2V mode.  

 Alt+PgUp/PgDn - Adjust CW speed Up/Down inactive radio/VFO using Secondary CW Speed 

Step (Other tab in Configurer) in SO2R/SO2V mode.  

 Ctrl+K - This will open the CW window to send manual CW. Pressing Ctrl+K again will close 
the window  

o Pressing Ctrl+K within the CW window closes the CW window and any remaining 

characters in the buffer will be sent  
o Pressing Escape (or Enter) closes the CW window and stops sending immediately. No 

remaining characters in the buffer will be sent  

 Ctrl+Shift+R - Toggle CW Reverse/No Reverse.  

9. Multipliers by Band window Key Assignments 

 Ctrl+J - Toggle through the Countries, Zones, Sections & Other windows (if the window is not 

open, it will be opened)  

 Ctrl+Shift+J - Opens or closes the Multiplier-by-band window  

10. Multi-User Key Assignments 

 Ctrl+E - Talk, send a message to another station in the network.  

 Ctrl+O - Change operator callsign (Multi-user).  

 Alt+Z - Set pass frequency which is broadcasted to all connected computers.  

 Ctrl+Alt+M - Change the RUN/MULT status (only when Operator Category = Multi-One)  

11. 'Enter Sends Message' mode (ESM) 



 Ctrl+M - Toggle 'Enter Sends Message' mode  

 Alt+Enter - Log without sending anything  

 Ctrl+Alt+Enter - Log even if exchange is invalid or missing  

 
Note: ESM is affected by two options in the Configurer under the Function Keys tab:  

 the "ESM sends your call once in S&P, then ready to copy received exchange" check box 

(sometimes called the "Big Gun" option)  

 the "Work dupes when running" check box (recommended)  

ESM Mode Enter Key Actions 

Callsign field 
Exchange 

field 
In Run Enter sends In S&P Enter sends 

Empty Empty CQ (F1) My Call (F4) 

New Call (1st time) 
Empty or 
invalid 

His Call + Exch(F5 + 
F2) 

My Call (F4) 

New Call (repeat) 
Empty or 
invalid 

Again? (F8) My Call (F4) 

New Call (repeat) - ESM sends call 
once... checked 

Empty or 
invalid 

Again? (F8) Again? (F8) 

New Call (before sending exchange) Valid 
His Call + Exch(F5 + 
F2) 

Exchange + Log(F2 + 
Log It) 

New Call (after sending exchange) Valid 
End QSO + Log(F3 + 
Log It) 

Log(Log It) 

Duplicate Call 
Empty or 
invalid 

QSO B4 (F6) do nothing 

Duplicate Call (before sending 
exchange) 

Valid 
His Call + Exch(F5 + 
F2) 

Exchange + Log(F2 + 
Log It) 

Duplicate Call (after sending exchange) Valid 
End QSO + Log(F3 + 

Log It) 
Log(Log It) 

Dupe (1st time) - Work Dupes checked 
Empty or 
invalid 

His Call + Exch(F5 + 
F2) 

do nothing 

Dupe (repeat) - Work Dupes checked 
Empty or 
invalid 

Again? (F8) do nothing 

Dupe (before sending exchange) - Work 
Dupes checked 

Valid 
His Call + Exch (F5 + 
F2) 

Exchange + Log(F2 + 
Log It) 

Dupe (after sending exchange) - Work 
Dupes checked 

Valid 
End QSO + Log (F3 + 
Log It) 

Log(Log It) 

12. Packet/Telnet Key Assignments 

 Ctrl+P - Spot the station entered in the callsign field as a spot to the active cluster 

connection, either packet or telnet. You will be prompted for a comment. If no station is 
entered in the callsign field, the last station worked this session will be spotted.  

 Left-click - Tune the active radio to the frequency of the spot.  

 Shift+Left-click - Tune the inactive radio to the frequency of the spot.  

 SH/DX - Entered in Entry window Callsign field will be passed through to active Packet 
window for processing.  



13. Available Window Key Assignments 

 Left-click - Mostly tunes the active radio to the frequency of the spot. Behavior depends on 

SO1V, SO2V or SO2R and on options in the right-click menu in the Available window.  

 Shift+Left-click - Mostly tunes the inactive radio to the frequency of the spot. Behavior 
depends on SO1V, SO2V or SO2R and on Available window right-click options.  

 Double click - Go to the frequency with the active VFO.  

14. SO2R Key Assignments 

 Ctrl+Enter - Send next ESM state on alternate radio (assuming ESM turned on).  

 Ctrl+F1 to F12 - Send Fn message on alternate radio.  

 Ctrl+Left Arrow - In SO2R move both Transmit and Receive/Keyboard focus to left radio, or 
in SO2V move both TX and RX/Keyboard focus to VFO A.  

 Ctrl+Right Arrow - In SO2R move both Transmit and Receive/Keyboard focus to right radio, 

or in SO2V move both TX and RX/Keyboard focus to VFO B.  

 Pause - Move both TX and RX Keyboard focus to other radio (or other VFO in SO2V). If TX 

and RX focus are split when you hit pause, TX focus will move to where the RX focus is.  

 Ctrl+B - Dueling CQ's will send CQ (without delay) alternately on each radio. If Dueling CQ's 
is turned on, both radios become run radios. Dueling SSB and CW CQ's are supported too.  

 Grave accent, backquote, or unshifted tilde key (~) Toggle STEREO mode on/off, or 

toggle Auto/PTT modes with modified DXD . Notes: On US keyboards, the key we are talking 
about is the key just to the left of the number 1 key.  

 Ctrl+I - Toggle SO2R Mode (Soundcard). Toggle through the SO2R modes supported by the 

program. Only operative in '$5SO2R' when N1MM logger controls the audio, not when using an 
external SO2R controller.  

 Ctrl+PgUp/Down - When changing band using Ctrl+PgUp/Down will skip the other radio's 

band.  
o THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!!  

 Ctrl+Shift+I - Toggle 'Advanced SO2R'. An advanced method of automated focus control. 

See SO2R?.  

 Ctrl+Shift+N - Set advanced SO2R delay time  

 Ctrl+Shift+K - FocusOther, Another method of automated focus control. Forces entry focus 

to non-transmitting radio, with entry focus returning to the transmitting radio as soon as it 
reverts to receive. See SO2R?. Disabled in SO1V mode.  

 Ctrl+Shift+L - Toggle CTRLFx Macro. This macro allows the user to send on the other radio 
(RTTY and CW only).  

15. RTTY Key Assignments 

 Alt+T - Toggle TX - RX  

 Alt+G - Grab callsign  

 Ctrl+K - Toggle TX/RX, and displays the CW/Digital Keyboard window to send manual 

information using the keyboard  

 Ctrl+Arrows - Swaps from one active DI to the other DI. DI1 will follow entry window 1. DI2 

will follow entry window 2  

 Esc - Stop sending  

 

16. Gridsquare Key Assignments (VHF and up) 

 Alt+equal (=) - Search entered info from both the Callsign field and the Gridsquare field in 
the call history table.  

http://n1mm.hamdocs.com/tiki-editpage.php?page=SO2R
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o The results will be shown in the Check window.  

 Alt+minus (-) - Toggle through call history and entered grid squares (max 3) in the grid 

square entry field.  
o When no grids are found in the call history there is nothing to toggle..  

17. Rotator Key Assignments 

 Alt+J - Turn rotor to bearing for the callsign in the Entry window or to the callsign in the 
callframe (when callsign field is empty).  

 Alt+L - Turn rotator to long path bearing for the callsign in the Entry window.  

 Ctrl+Alt+J - Stop turning the rotator when turning and no bearing in callsign field in Entry 
window.  

18. Window Key Assignments 

 Ctrl+Tab - Toggles between the Entry window and Packet window.  

 Ctrl+K - Display the CW/Digital Keyboard window to send manual information using the 
keyboard.  

 Ctrl+L - Display the Log window (toggles between open and minimized).  

 Ctrl+J - Display the Multiplier window, Toggle through the Countries, Zones, Sections & Other 
windows when open.  

19. Lookup Table Edit 

 Ctrl+D - to delete a row in the table or use the right click menu  

 Scroll Lock - the Scroll Lock key selects the current row for editing  

20. QTC Keys (for WAE contests) 

 Ctrl+Z - to enter or leave QTC mode  

o In RTTY, Ctrl+Z cycles the Digital Interface window through send QTC, receive QTC 
and normal QSO modes  

 Enter (CW/SSB only) - log the next QTC (EU side), or send the next QTC in the batch (DX 

side)  

 F3 (End of QSO Key) - sends the TU message and exits QTC mode  

 

2.4 Function Keys, Messages and Macros 

 1 Using Stored Messages in Contests - and the Function Key Message Editor 

 2 Macros 

 3 ESM (Enter Sends Messages) 

 4 Function Key Examples 

 

 

2.4.1 Using Stored Messages in Contests and the Function Key 

Editor 
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1. Fundamentals 

One of the things that most clearly differentiates contest logging programs from general-purpose 
loggers is the ability to send stored messages, to save energy during long contests. N1MM Logger can 
send stored messages in CW, SSB and digital contests. These messages can incorporate macros, 
short-form statements which perform program tasks automatically. For example, {ClearRIT} in a 

stored message will clear an attached radio's RIT whenever that message is sent - a great way to 
clear your RIT while running, at the end of each QSO.  

It will help you to follow the discussion below if you first understand, in general terms, how N1MM 
Logger's message-sending capabilities are organized.  

The program sends Function Key messages by accessing tables in the current database. There is one 

table for CW, another for SSB, and a third for digital modes. These tables are loaded with messages 
from what are called Function Key message file or .mc files. For CW and digital modes, these files 
contain the actual text to be sent, as well as Macros (see below). For SSB, these files contain a 
mixture of Macros and WAV filenames, which in turn contain the actual messages to be sent.  

 

A Macro is Not a Message 

Early in the use of computers for amateur radio contesting, the term "macro" was used to denote any 

stored message. We follow a different convention - for us, the term Macro means a message 
component that either triggers a program action or expands to a string of text to be transmitted in CW 

or digital modes. The use of the .mc filename extension for our Function Key message files is a left-
over from those days. Don't be misled.  

1.1. The Function Key Message Editor - Editing and Managing Function Key Message Files 

The Function Key Message Editor is the key tool for managing your Function Key messages. It 

provides the way for loading function key message files into your database, which must happen 
before you'll be able to send those messages from the keyboard. It also provides a Notepad-like 



editing window for modifying Function Key message files. You can import and export function key 

message files, edit them, and save them to the current database. The editor has all of the functions 
provided by the previous editor, and more, but in easier-to-use form.  

A key difference is that the Function Key Message Editor no longer operates directly on the current 
database, but instead on the message files themselves. You must Save an edited file to the database 
once you are satisfied with it.  

You reach the Function Key Message Editor in one of three ways. Right-clicking on the message 
buttons in the Entry Window or pressing Alt+K will show the message file associated with the current 

mode (CW, SSB or digital). You can also Go to the Config menu in the entry Window and drill down 
through "Change CW/SSB/Digital Function Key Definitions" to open one of the three messages files in 
current use, one per mode.  

 

Unknown Operating Mode? 

If right-clicking on a message button or pressing Alt+K results in an error message to the effect that 
the function key editor cannot be opened because the operating mode is not set, or if the function key 
editor opens up but the messages you see are for the wrong mode, you must first set the operating 
mode (CW, SSB or digital) before opening the function key editor. You do this by typing the mode 
(CW, SSB, RTTY or PSK) into the call sign box and pressing Enter. Once you have done this, right-

clicking on a message button or pressing Alt+K will open the function key editor with the messages for 
the mode you entered. 

 
However you get there, here's what it looks like:  



 
Let's quickly run through the controls. These have been designed for fast use during a contest, and as 
a result there are some cautions to be observed.  

 Save saves the current file to the current database AND to the file that is named in the 

title bar of the Function Key editor This is how you load the contents of a function key file 
from the editor into the database, ready for use. If you want to save those changes to a 
different file, use Export. Note: It is easy to change a default function key file without 



meaning to, if you forget that it is the file in the title bar and Save a modified 

version. If you do this, use the Sample Function Keys function below to retrieve the 
defaults, and then save them to the original file name.  

 Import opens a file selection dialog so that you can bring the function key message file of 

your choice into the Editor. It does not import the message file into the database. It does, 
however, ask you if you wish to put this filename on the Associated Files tab in the Contest 
Setup dialog, so that the next time you open this contest, it is this file that will be loaded into 
the database. You must respond Yes, or the import will not appear. If you do so, and then go 

to exit the editor, you will be asked whether you want to "activate" these messages. Click 
"Yes" and the contents of the editor will be loaded into the database. Note that if you press 
"Save" during the editing session, the current file will be overwritten with whatever is in the 
editor at the time  

 Export opens a dialog where you can provide a filename for the current contents of the 

Function Key Message Editor, and save them as an .mc file, without making changes to the 
database.  

 Sample Function Keys takes you to the web site where you can download sample function 

keys, or the default for your mode (Internet connection required). You must Import the 

downloaded file in order to edit it or to Save it into the database.  

 Help opens to this section of the manual (Internet connection required).  

 Cancel closes the editing window. If you have made any changes, or imported a file, the 

program will ask you whether you want to save the changes. Answer Yes and the editor 
performs a Save to the database and to the file named in the title bar. Answer No and the 
Editor just closes, with the contents of your function keys remaining unchanged.  

1.1.1. Transitioning to the New Editor  

The first time you start Version 12.06.01 or later, it will look in the currently open database and 

write each of the three Function Key message tables found there to a separate file, in your N1MM 
Logger main program directory. These files are named CW Default Messages.mc, SSB Default 
Messages.mc and Digi Default Messages.mc. To repeat, this happens only the first time, with the 
first database. For each subsequent database, the function key tables will be written to files named 

<db name> <CW/SSB/Digi> Default Messages.mc. Those files will not be used by the program. They 

only serve as backup for those who have function key sets stored in those other databases that they 
want to save. This could come up, for example, with users who create a new database for each 
contest - we want to be sure you don't lose any of those message tables that you have carefully 
crafted!  

1.1.2. Using the Editor  

From then on, when you click New Log in Database on the Files menu and create the first log for a 

given contest in the current database (what we also refer to as the first instance of a contest), the 
three default Function Key message files (CW Default Messages.mc, SSB Default Messages.mc and 
Digi Default Messages.mc.) will be loaded into the database. For example, if you have never set up a 
CQWW CW contest in this database, then those default files will be loaded. Their file-names will 

appear automatically on the Associated Files tab of the Contest Setup dialog. Do not move the 
default .mc files from the N1MM Logger program directory.  

On the other hand, if you have previously run a given contest, and you have put a message filename 
on the Associated Files tab, the program will load that file instead.  

If you want to load a different Function Key message file, there are two main ways to do so. First, you 

can use the "Change" button on the Associated Files tab. This is probably the best solution if you like 
to develop and store specific message files for particular contests. You can organize your .mc files into 
separate folders (for example, for CW, SSB and digital modes), so long as you leave the default files in 
the main directory. Click "Change". select a file, hit Enter and then OK out of the Contest Setup dialog  



You can also use the Import button on the bottom border of the Function Key message editor, 

mimicking the way you used to use File > Import Function Keys. When you do that, and select an .mc 
file for import, the program will ask you whether you want the Associated files tab to be changed to 
reflect this file as the new default for that contest. If you say yes, then the next time you load that 

contest, the file you imported will be the one loaded by the program. However, you'll note that it 
has not yet been loaded into your message buttons, which means it has not yet been loaded 
into the database. If you want to use it right away, you must click "Save" before you leave 
the Editor. In fact, you must click Save to retain any changes that you make in the Editor.  

If you don't want to save it, click "X" to exit. The program will ask you if you want to save your 
changes. This is the equivalent of the "Save" button, so just answer no, and nothing will be changed in 
the database.  

1.1.3. Right-click menu  

If you right-click in the Function Key Message Editor Window, you'll see a short menu. Three of the 

choices - cut, copy and paste - are the familiar Notepad editing commands. The other two merit some 
explaining.  

"Insert wav filename" does what its name implies. Click on it and you will be asked to select a wav 
filename from N1MM directory. Select a file, and the filename will be inserted at the location of your 
cursor. The intended use of this function is to make it easy to construct complex SSB message files, 
combining macros and filenames.  

The other choice is Restore Default Function Key Messages. A good time to use this would be when 
you have totally messed up, and want to get back to the "factory" defaults and start over. Note, 
though, that this does not restore the default message files you may have generated from your own 
database. If you want to put your own default messages into the editor, use the Import option.  

Editing, once the message file is on-screen, is very much like Notepad, but adapted for message file 

use. Comments (lines starting with a "#") are in green. The Run Function Key lines are black, and the 

S&P lines are blue. The part of each line that follows the comma separating the button label and the 
text of the message is bold, to help you spot lines where the comma may have been left out or 
misplaced.  

The new editor has one feature in common with the old - if you want to send different Function Key 
messages for S&P than for Run mode, then you must have something in all 12 lines of the Run 
section of the file, even if it is only a Function key label, a comma, and some sort of place-holder in 
the part of the line after the comma. The best placeholder, in CW and digital messages, is two spaces. 
You can use a single space, or even a "-", but those choices will both transmit a BT prosign on CW. For 
SSB, the Empty.wav. filename works well  

The "Export" button in the new editor is used to save the contents of an edited file to a different 

filename, which you can select, but it does not save the contents of that file to the current 
database.. Clicking "Save" will simply over-write the current file, shown in the title bar of the editor 
window, and also store the changed file in the database. If you make changes and then click either 

"X" or "Cancel", the program will ask you whether you want to save your changes; if you answer Yes, 
the program will execute a "Save", as above.  

1.2. Function Key message file structure 

 
N1MM Logger accommodates up to 24 messages for each mode (CW, SSB and Digital), each divided 
into two sets of 12, one for Run mode, the other for Search and Pounce (S&P). (For more information 
on Run vs. S&P and other features of function key usage, see the Entry Window chapter section on 

http://n1mm.hamdocs.com/tiki-index.php?page=Entry+Window


Function Keys). This means that your Function Key message files can have as many as 24 active lines, 
plus comments (see below). Here's an example::  

 

In this example, all 24 lines are filled. The part of each line before the comma is the label that will 
appear on the message button in the Entry Window, while the part after the comma is the actual 
message that will be sent or executed (in the case of Macros). The label's length is limited to 29 
characters, though you would never want to use so many. The message can be up to 255 characters 
in length. Note that the only time you use commas within the actual message would be to separate 
multiple wav file names and # or ! macros in SSB message sets (see below).  

There are a couple of labor-saving features. If you choose to do so, you can supply only a bare 
minimum set of messages in the first few lines of the file. The program will automatically use those for 

both Run and S&P modes. However, if you wish to use different messages in S&P, then you must fill 

in each of the first 12 lines of the file, if only with "F9 Empty,-". The 13th line will then be used by the 
program for F1 in S&P mode, the 14th for S&P F2, and so on. You do not need to fill out the entire 24 
lines, and the program will fill in the remaining S&P buttons with the corresponding Run messages.  

1.2.1. Comments in Function Key Files  

Beginning with program version 12.2.0, you can put comments in your function key files. Any line that 

begins with a # is considered to be a comment, and is not loaded as a Function Key Definition. This 



capability has been added in order to facilitate the development and use of a set of sample Function 
Key files for each mode, to assist new users in setting their Function Keys up easily.  

As you can see, this CW file in the following section has all the features, including extensive 
commenting. The first two lines start with "#", marking them as comments. You must still make sure 
that you have 12 un-commented ("active") lines in your Run set, and up to 12 in your S&P set of 
messages.  

1.2.2. Sample Function Key Files  

A large set of sample Function Key files is here .  

Let's use one of them to explain further.  

http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=23


 

This is the "factory" CW message file. Each line consists of the Label (which will appear on-screen on 
the buttons in the entry window), a comma as a separator, and the message that will be sent, 
including any Macros. For example, in the first line, the Label will be F1 CQ, and pressing F1 or clicking 

on the button first causes the Macro {MYCALL} to be expanded into the station call-sign from the 
Station Data dialog. If N4ZR is the station callsign, the program then sends the following CW: "CQ 
TEST N4ZR N4ZR TEST".  



Working down through the file, we see that F2 and F7 both use the macro {SENTRSTCUT}. This macro 

"grabs" the sent RST from the entry window, converts the RST by substituting whatever set of cut 
numbers you have selected here (such as 5NN), and then sends it in sequence.  

The next interesting twist is in F5. *, !, and # are used as short macros (not requiring curly brackets) 
for which the program respectively substitutes your call, the other station's call (once one has been 
entered in the entry window), and a serial number. Hence F5 will send just the other station's call-
sign. It is typically used with F2 to send the other station's call-sign and the contest exchange.  

1.3. Mixing Macros, Filenames and Text in a Single Function Key 

This is a very powerful tool for the experienced user, as you can imagine. For example, an SO2R 
operator could set up the S&P F2 key to send the exchange and then send a CQ on the opposite radio, 
simply by including the {CTRLF1} macro in the key definition. RTTY messages, as illustrated in the 
default listing, need the {TX} and {RX} macros at the beginning and end of each stored message.  

With CW and RTTY, what you define is what you'll get - if you put a space in a message, then a space 
will be sent. In the case of SSB messages, however, it is a bit trickier - if you run a macro such as "#" 

and a filename together - for example "#CQ.WAV" - Windows won't know where the macro ends and 
the filename begins. The simple solution is to insert a comma between elements in an SSB message, 
so that example becomes "#,CQ.WAV". Do the same thing if you have multiple .wav files in a single 
message.  

2. CW Function Keys 

The CW table above illustrates all the features of the CW function keys. The * and ! macros will insert 
your call and that of the other station (whatever is entered in the callsign field of the Entry window). 
The # macro inserts the serial number, in contests that require that. You can mix in any of the other 
macros found here.  

A cautionary note - it is usually considered best not to get too fancy with the speed change macros (> 

and <) in your CW messages. The time saved may not be worth the time wasted providing a "fill" if 
the receiving station's ability to copy in tough conditions is impaired by his losing the rhythm of your 
exchange.  

3. Digital Function Keys 

The Digital table works much the same as the CW table, in the sense that the program will literally 
send any text that you provide. The # and ! macros work here, and so do all the others. Note that the 
{TX} and {RX} macros are required in each message to tell the Digital Interface when to switch.  

4. SSB Function Keys 

The SSB function key definitions are different. Let's take another look at a "factory" default table, this 
one for SSB.  

http://n1mm.hamdocs.com/tiki-index.php?page=Configurer#Configurer_gt_Function_Keys_Tab
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This shows the default SSB function keys, as supplied with the program initially. You'll note that it's 

assumed that each of the function key definitions will consist only of one filename. The single 
exception is F5-His Call, which can either be empty (2 spaces or empty.wav after the comma), or if 
you are using voicing of call signs, filled with "!". This is the macro that is used to tell the program to 

voice a callsign by putting together letter and number files, so it would not normally be used. The 
whole subject of voicing, which is both a little complicated and quite controversial, is discussed below. 
Unless you are planning to voice call-signs or serial numbers (see below), you should never 
have the "!" macro in your SSB definitions. You can replace it with "empty.wav". The same 
goes for the "#" macro. "*" should never be used - use mycall.wav or the equivalent 
instead.  

The wav files can be placed wherever you like. The "empty.wav" file is installed in the program 
directory during program installation. The default for other wav files is as shown in the example above 
- note that if the full path is not spelled out, the program assumes that the path includes 

the program directory - for example, if the program directory is C:\N1MM Logger\, then in 
the example above, the recording for Run F1 will be found in C:\N1MM 
Logger\wav\{Operator}\. In any case, just make sure that the files are where you have told the 

program to look for them, or you'll get an error message in the status line (the bottom line of the 
Entry window).  

4.1. The {Operator} Macro 

As you probably noticed above, there is an {Operator} macro in the path for each of the .wav 
message files. The purpose of this is to enable you to change the stored message files to match the 
operator currently on duty (in a multi-op or guest op situation). For example, if a set of messages 
(such as CQ.wav) are stored in C:\N1MM Logger\WAV\N1MM\, then if N1MM is the operator, the 
program will send his CQ.wav when that key is pressed. The same is true for stored letters and 
numbers, used in voicing callsigns and serial numbers, except that those are stored in C:\N1MM 
Logger\letters\{Operator}\, or another path which is identified in the File tab of the Configurer.  

The current operator is displayed in the title bar of the Info window, and also in large blue letters 

inside that window, to the right. It is pre-filled with the callsign in the Station Data. To change the 

operator, or to enter one immediately after updating from a version prior to 11.12.3, just press Ctrl+O 
and enter the desired call-sign.  

Even if you operate alone, and never need to change operators, we recommend you leave the 
{Operator}macros in place and put the wav files in folders with your callsign as the title. That will 
make it easy to add a guest op.  

4.2. Recording on the Fly 

If you need to record or re-record a function key file in a hurry, you can do so from inside the 

program, so long as the Function Key message calls only a single .wav file, and that .wav file is 
already assigned to that function key file in the database.  

The key sequence is Ctrl+Shift+Fkey, in either Run or S&P mode Despite the limitations, this is still 

very useful, particularly for split operation in SSB contests where you want to specify a listening 
frequency.  

4.3. Voicing Call-signs, Serial Numbers and Frequencies 

This option appears to be growing in popularity among SSB contesters. One operator, to protect the 
sleep of his wife and young children, even created such a complete set of voicing files that he could 

operate an entire Sweepstakes without a microphone. Earlier releases of N1MM Logger contained a 
simplified form of voicing. In version 11.12.3 and thereafter, a more sophisticated way of voicing 
numbers was added. What follows explains the difference and how to implement either one.  

http://n1mm.hamdocs.com/tiki-index.php?page=Configurer


When voicing is used, the !, # and @ macros can be used in SSB messages, and the program will 

send the individual letter and number files that make up the call name or number that is to be sent. 
The individual letters, numbers and special characters used for voicing are stored in the location 
defined in the letters file path on the Files tab of the Configurer . Again, if you wish to have more than 

one operator, you will want to insert the {Operator} macro in the letters file path in the Configurer, 
and then record in a subdirectory named with the operator's call-sign, so that Ctrl+O can be used to 
tell the program which operator's letter files to use.  

Function key messages that use voicing may have more than one wav file or macro in them. Use 
commas to separate the individual wav file names and macros within a message.  

Note: If you do not want to use voicing, be sure that your Run F5 key is programmed to 
"empty.wav", not "!".  

4.3.1. Simple Voicing  

This technique is used for voicing call-signs, as the simplest way of voicing serial numbers, and for 

giving your listening frequency when operating split. The operator records files for the letters A-Z, the 
numerals 0-9, and a few special characters - query.wav for the "?" character, stroke.wav for the 
portable indicator (which you denote in your log using the "/" or slash character), and point.wav to 
voice the decimal point (in a frequency, for example). When the ! macro is included in a function key 
definition, and the key is pressed, the program substitutes a sequence of .wav files for the number or 
callsign. N1MM is parsed into N.wav+1.wav+M.wav+M.wav. The # and @ macros work the same 
way for serial numbers and frequency, respectively.  

4.3.2. Advanced Voicing  

This technique is used to voice serial numbers in a way that is more intelligible than a simple string of 

numbers. "One hundred twenty three" will likely be more easily understood than "one two three", 
because of the redundancy added by the "place markers."  

In order to implement advanced voicing, you will need to record the following wav files. These files 
must be stored in the user programmable Letters File path (Config, Files tab). The letters file path 

may contain the {Operator} macro, which is essential if you have more than one operator. Example: 
C:\N1MM Logger\Wav\Letters\{Operator}\  

0.wav through 19.wav (20 files)  
20.wav through 90.wav (only the even tens intervals) (8 files)  
hundred.wav and thousand.wav  

When you try to voice a number for the first time after program start, the program checks to see 
whether all the needed files for advanced voicing are present. If one or more are missing, serial 
numbers will be voiced using the simple voicing method. The same check is also made with changing 
operators (with Ctrl+O). A comment appears in the bottom pane of the Info window to report the 
outcome of the wav file check.  

A complete table showing the files voiced for each number can be found in the files section here . 
There is one further variation - if you have Logger set to use leading zeros,, then one or two leading 
0.wav files are voiced before the number, as appropriate. We do not recommend using leading zeros 

with Advanced Voicing. As you can imagine, "zero eleven" is probably not an improvement in 
intelligibility over "eleven" or "zero one one."  

A good way to get natural-sounding numbers is to record full compound numbers, like "one hundred 
ten" or "two thousand four hundred and thirteen" with a program like Audacity (see below), and then 
use it to cut up the recording into the various components you need. This will help you get a natural 
intonation pattern, making your voiced numbers easier to understand.  
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4.3.3. Recording Letters and Numbers  

This is the hardest part of voicing. A more natural-sounding output will be much easier for other 

stations to understand, a particularly important point with serial numbers. The question of how to 
reduce the robotic sound is a complicated one, as users of the phone companies' 411 service will 
appreciate.  

The program-induced lag between numbers is very brief, so the real tricks are:  

 trimming the individual voice files so that they have as little "dead air" as possible before and 
after the letter or number.  

 adjusting the speed, intonation and audio level of the individual number files so that they go 
together as naturally as possible.  

The best single tool we have found so far for this purpose is the freeware Audacity  audio editor. It 

incorporates a variety of excellent tools for trimming, equalizing levels, and so on. A lot will always 
depend on how much time the individual op is willing to devote.  

When recording with Audacity, be sure to "Export as .WAV" using the default file creation settings; 
these work fine with N1MM Logger, while some of its other .wav file options will not.  

Here's a tip some people have found to be helpful. This or may not work for you.  

 Do not record individual letters and numbers. Instead, record callsign-like strings, such as 
A1BCD, E2FGH and so on. Try to speak at the same speed you would during a contest. Then 

use Audacity (or whatever editor you favor) to cut the recording apart, trim off any dead time, 
and equalize the levels. You can even use the Change Tempo tool (under Effects) to speed up 
your recorded letters and numbers to sound more natural while retaining your voice's pitch 
and other characteristics - amazing!  

4.3.4. Should I Use Voicing?  

This remains controversial. Is the saving in energy during a contest worth the potential loss in 

intelligibility? You can potentially operate an entire contest using "search and pounce", without ever 
having to say a word yourself. On one hand, when you are running, voicing the other station's call-
sign is pretty safe, since he knows who he is, and needs only to be confident that you're calling him. 
On the other hand, some operators feel that the loss of the "human touch" may deter casual 
contesters from calling in.  

From an intelligibility standpoint, voicing serial numbers is less attractive. In poor conditions, the 
"robotic" quality may make copy harder, particularly for non-English-speakers. The jury is still out on 
this one as well.  

5. ESM (Enter Sends Messages) 

This section provides a step-by-step introduction to ESM. Try it, and we can almost guarantee you'll 
like it.  

The first step is to turn it on. Open the Config menu in the Entry Window, and select ESM  

http://audacity.sourceforge.net/


 
 
 

 
Now close the menu and enter any call in the entry window. We're assuming that you are doing S&P.  

 
 

 



 

What's different? Take a look at the F4 button. The highlight means that if you press Enter at this 
point, the F4 message will be sent (which is what you want - your call). Press <Enter>, your call is 
sent, but the cursor remains in the callsign field, and F4 is still highlighted. If he doesn't answer the 
first time, just press <Enter> again. If he answers you, hit <Space>, and look!  

 
 

 

 

The cursor has moved to the Exchange box, and now F2 is highlighted. That means that the next time 
you hit <Enter>, the program sends F2 and logs the QSO.  

So instead of an 8 step process to work an S&P QSO, you have either 3 or 4:  

1. Enter the callsign  
2. Press <Enter>  

3. (optional) If he doesn't answer, press <Enter> when it's time to call him again; if he does, 
press <Space> and copy his exchange  

4. Press <Enter> again to send your exchange to him and log the QSO.  

 
But suppose you're Running (Calling CQ)? The first thing to do is tell the program. You do that by 
checking the box next to the word "Running", either with your mouse or by hitting <Alt>+U. Now your 
Entry Window looks a bit different:  
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Note the highlight is now on F1, because the first thing in most Run QSOs is a CQ. Press <Enter> and 
the program will send F1.  

Now someone answers. Type in his callsign and the window changes.  

 
 

 

 

You're starting to get the hang of this - the highlights mean that when you hit <Enter> the program 

will send F5 followed by F2 (on CW - on phone you would speak the callsign and then press <Enter> 
to send your exchange).  

Once you have done that, the window changes again.  



 
 
 

 

Now the highlights tell you that you have copied a legitimate exchange (in this case the program has 
supplied it from the callsign, and that the next <Enter> will send your F3 message and log the QSO.  

So, type a callsign, hit <Enter> 3 times, and you've logged a QSO. Pretty slick!  

Now suppose you're like me and you fat-finger copying the exchange, so that you have nonsense in 
the Exchange box, like this. In that case, the program reminds you:  

 
 

 

 
If you hit <Enter> with an incorrect exchange, the program will send the F8 message and request a 

repeat. Alternatively, if you see your mistake and correct it, the screen changes again to show the "F3 
and Log It" highlights. Just press <Enter>, the program sends the F3 message, logs the QSO, and 
you're done.  

Once you've used ESM, I predict you'll never go back to the old way again.  



 

F1 Call CQ - A special Function Key that switches to Run Mode automatically 

The developers have reserved F1 as the "Call CQ" key. Pressing it while in Search and Pounce mode 
will switch you to Run mode. Although we do not recommend changing it, there are at least two ways 

to redefine F1: modify the ESM function key assignment table (see below) or use the {S&P} macro at 
the end of your F1 definition to force the program back to S&P mode. 

 
 
 

 

Two further refinements, and then this chapter is done. Open the Config menu again, and then open 
the "Configure Ports, Telnet Address, Other" sub-menu. Click on the Function Keys tab:  

In the left-hand column, note that I have checked "Send Corrected Call." This neat feature, in Run 
mode, keeps track of whether you have changed the callsign in the callsign box. For example, say you 
only copied "DL6A" at first, and filled in the rest later. Eventually, you copy DL6ABC, and when you 
press <Enter> to send the F3 (TU message), on CW the program sends "DL6ABC TU ..." On phone, 
you'll need to supply the correction.  

In the right-hand column, the third checkbox is cumbersomely titled "ESM only sends your call once in 
S&P, then ready to copy received exchange." In shorthand, we call this the "Big Gun switch." If you 
nearly always get stations you call the first time, you can save a keystroke by having the cursor 

advance automatically to the exchange box after the first time you call. If you often need to call again, 
don't check it. If you have checked it, and need to call a station more than once, you just press F4, 
regardless of where the cursor is.  
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Caution 

Don't change the "key mappings" (below the red type) unless you absolutely know what you're doing - 
it can make a horrible hash out of ESM. 

5.1. ESM on Phone - One Special Feature 

There's every reason, when running CW or RTTY, to use stored messages for almost every 
transmission. Phone is different - you may not want to have the computer talk for you all the time.  

 Most operators choose to say callsigns and serial numbers themselves, rather than having the 

computer assemble them from individual letters and numbers. See section 4.3 above for more 
discussion of these issues, and for information on how to set up your Function Key definitions, 
whether you choose to let the computer do it all or not.  

 

To deal with this, N1MM Logger incorporates some additional flexibility. Here's how it works, courtesy 
of the inventor, N2IC:  

You are in Run mode. A station answers. You type in the callsign, and you use your live voice to send 
the callsign and exchange, which is particularly likely to happen in a contest like CQWW where the 
exchange is very short (just your CQ zone). Now, the station you are working is about to send his/her 
exchange. If, at this point, you hit the Enter key, your exchange wav file would be sent, which will be 
redundant, because you already used your live voice to send the exchange. Instead of hitting the 

Enter key, hit the Space bar. Now, type in the other station's exchange. Hit the Enter key, and the 
"Thanks" message will be sent, and the QSO will be logged.  

In summary, the decision of whether to use the Enter key or the Space bar at that step in the logging 
process depends on whether you use your live voice to send your exchange, or a wav file.  

Here's an illustrated version of how it works:  

You're running, and W8QZR calls you. You type his call into the callsign field.  

 
Then, for whatever reason, you say his call and the exchange instead of having the computer do it. If 
you then hit Enter, the program will, as it says, transmit his call and the stored exchange message. 
Not what you want.  

Instead, you hit the Space bar.  



 

Perfect! Now the cursor is in the Exchange field, and you type in his exchange.  

 

The highlight moves to the TU and "Log It" buttons, just where they should be. Hit Enter, and the 
computer will log the QSO, send your "TU QRZ" message and be all ready for the next QSO.  

 

2.4.2 Macros 

 2.4.2 Macros  

 1. General Macros  

 1.1. {END} Macro Examples  
 2. CATHEX and CATASC Radio Hex Macro Commands  
 3. CATAHEX, CATIHEX, CATAASC, and CATIASC Macro Commands  
 4. Antenna and Rotor Control Macro Commands  
 5. CW Macros  

 5.1. CW Macro Examples  
 6. SSB Macros  

 6.1. SSB Macro Examples  
 7. SO2V/SO2R Macros  
 8. Multi-User Macros  



 8.1. {MESSAGE} Macro Examples  

 9. Digital (RTTY and PSK) Macros  
 9.1. RTTY and PSK Macro Examples  

 10. Packet/Telnet Macros  
 10.1. Packet Macro Examples  

One of the great strengths of N1MM Logger is its ability to send stored messages during contest QSOs, 

and to embed macros in those messages. Macros are so called because they either expand to a given 
text string, for CW and digital modes, or execute some program function. An example of the first is 
the {EXCH} macro, which expands to the exchange which you entered in the Contest Setup Dialog's 
Sent Exchange field - for example, if you enter John CT, that is what will be sent whenever the 
{EXCH} macro is encountered.  
The second type of macro is much more complex, and more powerful. These macros can switch the 
program from RUN mode to S&P mode, an essential attribute during NA Sprint, set or clear your 

transceiver's RIT function, or a myriad of other possibilities. In the sections that follow, you will find a 
comprehensive list of all the macros available in N1MM Logger, as well as useful examples of how 
stored messages can be structured for efficient operating.  

1. General Macros 

 
General macros can be used in all the places mentioned above.  
Note that the table below is sortable alphabetically by the name of the macro, by clicking on the 
up/down arrow icon just to the left of the "Result" heading.  

Macro keyword  Result 

*  Call from the Station info dialog, same as {MYCALL} 

!  

Sends the callsign entered in the Callsign field of the Entry window, or if that 

field is empty the last call logged. Use this macro rather than {CALL} if you 
wish to have the Send Corrected Call function work correctly. 

@  

To voice the current receive frequency, if you have recorded files for individual 
letters and numbers. The frequency will be voiced to the nearest 100 Hz, 
dropping .0 if receiving on an even KHz frequency. This capability can be used 
to avoid having to rerecord CQ messages on 40m split. Here is an example: 

C:\Program Files\N1MM logger\wav\{operator}\CQ 
Listening.wav,@,C:\Program Files\N1MM 
logger\wav\{operator}\AndThisFreq.wav 

{CALL}  

Sends the call in the Callsign field of the Entry window as it was at the time the 
message started, or (if that field is empty) the last call logged. Note: This will 
send the call as it was when the message STARTED. Use the ! macro instead to 
use the Send Corrected Call function. Do not use the {CALL} macro in F5 

(HisCall key) if you use ESM. 

{CHNAME}  
If a Call history file is loaded into the current database, and a callsign is entered 
for which a name is present in the file, then this macro will send that name. 
Call History lookup does not have to be enabled for this macro to function. 

{CLUSTER}  Cluster callsign from Station info dialog. See examples 

{COMMENT}  
Macro to add string following {COMMENT} to comment field of current or last 
QSO 

{END}  

This macro stores all macro text after the {END} macro string and executes it 
after CW, SSB or DIGI messages are sent. One use of the {END} macro is to 
send CAT commands to the radio(s) after a transmission ends. All QSO 
message text placed after the {END} macro command is not sent. 

#  
Send serial number for this QSO, or if there is no call sign in the Entry window, 
the serial number for the previous QSO 

http://n1mm.hamdocs.com/tiki-index.php?page=Configurer#Function%20Keys%20Field%20Descriptions


Macro keyword  Result 

{EXCH}  

Sent Exchange, based on the contents of the Sent Exchange box in the Contest 

Setup dialog. When the sent exchange includes a serial number (001 or # in 
the Sent Exchange box), the number sent will be for the current QSO if there is 
a call sign in the entry window, or for the previous QSO if there is no call sign in 
the entry window. 

{FORCELOG}  Same effect as Ctrl+Alt+Enter, but does not ask for a note to be entered 

{FORCELOGNOTE}  As above but asks whether you want to enter a note. 

{FREQ}  Frequency from the contact in the Entry window 

{GRID}  Gridsquare from Station info dialog 

{GRIDSQUARE}  Gridsquare from grid textbox (contact in Entry window) 

{GRIDBEARING}  Bearing between own gridsquare and grid textbox (contact in Entry window) 

{REVGRIDBEARING}  
Reverse bearing between own gridsquare and grid textbox (contact in Entry 
window) 

{KMGRIGDISTANCE}  
Distance in kilometer between own gridsquare and grid textbox (contact in 
Entry window) 

{LOG}  
CW:Logs the current contact. Same as ENTER in the Entry Window. Digital: Put 
the {LOG} macro after the {RX} macro... The receive frequency is being reset 
to the transmit frequency. Note: does not work in phone (SSB, FM etc) 

{LASTCALL}  Call of last station logged 

{LASTEXCH}  
Exchange of last station logged. For ROPOCO and LZOPEN only. It does NOT 
work for other contests! 

{MYCALL}  My Call from Station info dialog, same as * 

{NAME}  
Sends the name as entered in the Entry window name field (Example: TARA) or 
when no Entry window name field, searches the name in the call history table 

{NAMEANDSPACE}  
Sends the name as entered in the Entry window name field (Example: TARA) or 
when no Entry window name field, searches the name in the call history table 
and adds a space behind it 

{OTHERFREQ}  
Is replaced by the frequency of the non-active radio. Used for passing stations 

to other bands. Substitutes "R" for decimal on CW 

{OTRSP XXXX}  
Used to send a command to an OTRSP (Open Two-Radio Switching Protocol) 
device. XXXX can be any command known to the OTRSP device 

{PGDN}  
Change frequency up equal to amount set under 'PgUp/PgDn Incr (kHz)' 'in the 
Configurer under the 'Other tab'. Can be used after the {END} macro, as in NA 
Sprint function-key messages 

{PGUP}  

Change frequency down equal to amount set under 'PgUp/PgDn Incr (kHz)' 'in 

the Configurer under the 'Other tab'. Can be used after the {END} macro, as in 
NA Sprint function-key messages 

{PREVNR}  Sends the QSO # of the last logged QSO 

{LRMHZ}  Frequency Left Radio/VFO-A in MHz. Example: 28 when on 28.1234 MHz 

{RRMHZ}  Frequency Right Radio/VFO-B in MHz. Example: 14 when on 14.1235 MHz 

{RUN}  Sends the last logged callsign and then goes into Running mode 

{S&P}  Sends the last logged callsign and then goes into S&P mode 

{STEREOOFF}  The stereo bit on the LPT port will be set to OFF 

{STEREOON}  The stereo bit on the LPT port will be set to ON 

{TIMESTAMP}  Date and Time from the contact in the Entry window 

{TX}  

CW/SSB: when sent in a function key will key ptt. Use Esc to turn off. This is a 
manual PTT from the keyboard. RTTY: Check out the Digital macros below. 
Note: This does not appear to work with some radio/interface 

combinations. 



Macro keyword  Result 

{CLEARRIT}  

Reset the RIT to zero. Could be used in the macro that confirms the contact, 

usually F3. Use the RIT when the station is calling and when logged the RIT 
clears (using F3). Note: Will only work for radios that support that function. 
Most ICOM radios do not. Your manual will tell you for sure 

{CTRL-A}...{CTRL-Z}  
Sends Ctrl+A character to TNC. All characters from the alphabet can be used (A 
to Z). Not valid in MMTTY and PSK. See examples 

{ENTER}  Sends ENTER to TNC 

{ENTERLF}  Sends Return/Line Feed to the TNC. Try this if ENTER doesn't seem to work 

{ESC}  Sends Escape character to TNC. Not valid in MMTTY and PSK. See examples 

{DATE}  Short date in Windows format as set in Regional settings 

{DATE1}  Date in Nordlink-TF/WA8DED format (dd.mm.yy)- format: 26.02.99 

{SENTRST}  Sends the RST sent as entered in Entry window Snt field 

{SENTRSTCUT}  
Sends the RST sent with the number 9 sent as the character N. Will send 57N 

or 5NN etc 

{TIME}  Time in Windows format as set in Regional settings 

{TIME1}  Time in Nordlink-TF/WA8DED format (hh:mm:ss)- format: 20:36:55 

{TIME2}  
Short GMT time (hhmm)- format: 2036 Information how this macro works in 
digital contests can be found at: Time2 - How it works 

{DAYTIME}  Date in TAPR DayTime format - format: 0107162036 

{DATEGMT}  Date and GMT time - format: 16-jul-01 18:36:55 

{TIMEGMT}  GMT time - format: 18:36:55 

{F1} - {F12}  Sends text assigned to function keys F1 through F12 

{SOCALLSTACK}  

This macro enables single operator callsign stacking. When in RUN mode, this 
macro gives the operator the ability to stack and retrieve a single callsign when 
multiple stations are calling. The stacked callsign does not need to be a full call 
and it can contain a "?". Single operator call stacking can be used in SO1V/2V 
or SO2R mode, in both entry windows, and with/without ESM. When in RUN 

mode, {SOCALLSTACK} will move a call or partial call and place it in the 

callsign frame and bandmap. If a stacked call exists on the call frame, the 
callsigns will be exchanged. If the callsign contains a question mark ("?"), the 
cursor will highlight the question mark when the text is popped off the stack. If 
the callsign does not contain a question mark, the cursor is placed at the 
beginning of the callsign upon return to the entry window. Using the existing 
command ALT+D, it is possible to delete a stacked call from the bandmap and 
call frame without popping it off the stack with when the callsign entry window 

is blank. {SOCALLSTACK} will also pop the call off the stack if ESM replaced the 
stacked call with the string CQ-Frequency. When this occurs, the stacked call 
will be visible in the bandmap. {SOCALLSTACK} is not intended to be used with 
the MM call stacking function. See also the macro {STACKANOTHER}. Callsigns 
stacked by {SOCALLSTACK} can be popped off the stack by pressing the space 
bar when the CQ-Literal is on the call frame. More info and examples in the 

chapter: Single Operator Call Stacking 

{STACKANOTHER}  
Macro to stack additional callsigns in all modes. Also check the keycombination 
CTRL+ALT+G More info and examples in the chapter: Single Operator Call 
Stacking 

(CLRSTACK} Clears the call stack 

{LOGTHENPOP}  

RUN mode only. Intended for with the single operator call stacking feature. It 
logs the current station sending corrections if enabled, pops the next call off the 

stack, and updates ESM if enabled, to the correct step. The macro can be used 
with or without ESM. The suggested macro key is: {LOGTHENPOP} TU NW 
{F5}{F2} (Note: In contests with serial numbers, do NOT use # in the 
LOGTHENPOP macro). In CW, if {LOGTHENPOP} can not pop a call off the stack 

http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Digital%20contests%20-%20RTTY/PSK31
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Macro keyword  Result 

and the logged callsign was changed, send corrected call if enabled and the TU 

message. More info and examples in the chapter: Single Operator Call Stacking. 
Example function key setup can be found in the Chapter Function Key Examples 
(CW: example 3) 

{ROVERQTH}  
Sends the Rover QTH. Check out the chapter Setup QSO Parties for more 
information on Rover support 

{VARYMSG1} 
{VARYMSG2}  

These macros allow the user to control how often an alternate form of a 
function key message is sent instead of the primary form. Each can be used 

once in a given Function Key set. The form of the macro is 
{VARYMSGn&Primary Message&Alternate Message&How Often to Send 
Alternate&}. Substitute the form of the message you want to send most often 
for Primary Message. Substitute the message you want to send at intervals for 
Alternate Message. Finally, specify how often you want to send the Alternate 
message in "How Often to Send Alternate". A "0" in the "How Often to Send 
Alternate" field sends the Primary Message every time. A "1" in the "How Often 

to Send Alternate" field sends the Alternate Message every time. Placing a 
number, N, greater than 1, in the "How Often to Send Alternate" field sends the 
Alternate Message every Nth time. Examples: in the CQ Key definition (RUN 
F1), {VARYMSG1 &CQ * *&CQ CQ * *&3&} will send a slightly longer CQ every 
3rd time. In the TU Key definition (RUN F3), {VARYMSG2 &TU&TU *&4&} will 
send TU alone after a completed QSO, and send TU followed by your call only 

every 4th time. Any function key text before or after the {VARYMSGn} macro 
string is preserved. So, RTTY users may place the {TX} {RX} macros before 
and after the {VARYMSGn} macro string. The primary and alternate 
{VARYMSGn} fields may contain other macros but the two {VARYMSGn} 
macros may not be nested. 

 
The TNC Interface accepts all of the macros above.  

1.1. {END} Macro Examples 

 
The {END} macro signals the program that the remaining {} commands are to be executed when the 
program returns from sending the CW, SSB or DIGI messages. Here is an example:  

 Macro: F1 {STEREOOFF}CQ TEST *{END}{STEREOON}  

 
Whenever the F1 key is pressed, the stereo bit on the LPT port will be set to OFF. CQ will be sent via 
the current mode, and after the message is complete, the stereo bit on the LPT port will be turned 

back on. Thus, one can listen to just the second radio while the CQ is being sent, then listen to both 
radios after it is finished.  

 

More to send after the {END} Macro? 

Only Macros that do not involve sending messages are executed when they are placed after the 
{END} macro. For example, if you put {MYCALL} or "5NN" after the {END} macro, they will be 
ignored. Why? Well the message is over, there is nothing more to send. Conversely, all macros that 
only trigger program functions (don't send messages) are executed before any messages are sent, 
unless they appear after an {END} macro. 

2. CATHEX and CATASC Radio Hex Macro Commands 

http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking
http://n1mm.hamdocs.com/tiki-index.php?page=Function+Key+Examples
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB


Macro keyword  Substituted by 

{CAT1HEX 
radio_hex_command(s)} 
 
{CAT2HEX 
radio_hex_command(s)}  

These commands can be used to send commands to radio # 1 or 

radio # 2 requiring hex data input. The macro name must be 
followed by the radio hex data and closing terminator }. An example 
is shown below. There must be two hex characters per byte including 
zero ( zero entered as 00). Spaces are allowed anywhere in the hex 
command string to make entry and verification easier. You can not 
place more than one CAT1HEX or CAT2HEX command in a macro but 
the macro can contain one of each command. The exception to this 

rule is when the {END} macro is used. More than one radio 
command can be sent to the radio by placing a / character between 
the radio commands. Spaces are allowed around the / character. 
Multiple radio commands are broken into separate radio commands 
and sent to the radio using internal command pacing. Depending on 
the computer speed and the number of commands in the string, the 
use of these macros may delay the operation of the program when 

sending of CW or other program operation. There are no precautions 
which prevent the use of these macros while the radio is 
transmitting. If the user wants to switch an antenna port safely, use 
the {ANTRX#TOGGLE} macros which contain a TX inhibit. 
An example of an Icom command is: {CAT1HEX FEFE66E01C0102FD 
/ FEFE66E01C0102FD } 

{CAT1ASC 

radio_ASCII_command(s)} 
 
{CAT2ASC 
radio_ASCII_command(s)}  

These commands can be used to send commands to radio # 1 or 
radio # 2 requiring ASCII data input. The macro name must be 
followed by the radio ASCII data and closing terminator }. An 
example is shown below. All leading spaces before the radio 
command portion begins are removed and not sent to the radio. All 
other spaces in the command are sent to the radio. You can not place 
more than one CAT1ASC or CAT2ASC command in a macro but the 

macro can contain one of each command. The exception to this rule 
is when the {END} macro is used. More than one radio command can 
be sent to the radio by either placing a / character between the radio 

commands or by concatenating them together. Spaces before or 
after the / character are sent to the radio. Multiple radio commands 
using the / separator are broken into individual radio commands and 
sent to the radio using internal command pacing. Non-ASCII 

characters may be included in the radio command string by 
delimiting the two character hex value with < >. The leading < and 
trailing > characters are not sent to the radio. Spaces are not 
allowed inside the < > characters. Depending on the computer speed 
and the number of commands in the string, the use of these macros 
may delay the operation of the program when sending of CW or other 

program operation. There are no precautions which prevent the use 
of these macros while the radio is transmitting. If the user wants to 
switch an antenna port safely, use the {ANTRX#TOGGLE} macros 
which contain a TX inhibit. Examples of several forms of this 
command are: {CAT1ASC PB1;/PB2;} {CAT1ASC PB1;PB2;} 
{CAT1ASC P<42>1;PB2;} FT2000 - Play message #1 would be: 

{CAT1ASC PB01;} You may place a space between the macro name 

and the radio CAT command to improve readability. All leading 
spaces after the CAT1ASC macro command name are removed. If the 
ASCII radio command contains characters that are macros (*, !, #), 
these characters must be sent using the hex notation explained 
above. 
As an example, this macro contains a macro character {CAT1ASC 
*UM0} and will not work correctly. The correct form using hex 

notation would be {CAT1ASC <2A>UM0}  
If the radio command needed to be terminated with a CR (Orion), the 



Macro keyword  Substituted by 

command would be {CAT1ASC <2A>UM0<0D>} 

3. CATAHEX, CATIHEX, CATAASC, and CATIASC Macro Commands 

Macro keyword  Substituted by 

Active radio 
{CATA1HEX 
radio_hex_command(s)} 
 
{CATA2HEX 

radio_hex_command(s)} 
 
{CATA1ASC 
radio_ASCII_command(s)} 

 
{CATA2ASC 
radio_ASCII_command(s)} 

 
Inactive radio 
{CATI1HEX 
radio_hex_command(s)} 
 
{CATI2HEX 

radio_hex_command(s)} 
 
{CATI1ASC 
radio_ASCII_command(s)} 
 
{CATI2ASC 

radio_ASCII_command(s)}  

These eight macros's provide flexibility to send ASCII or HEX 

commands to either radio in SO2R mode (or VFO in SO2V) mode 
based on Active or Inactive radio/VFO. 
 
Radio specific commands were added for those SO2R users that do 

not have identical radios. The new macros follow the same syntax as 
the CAT1HEX and CAT1ASC macros. 
 

The F-key macro text passes through a routine that removes CAT 
macros for radio(s) that do not qualify based on Active/Inactive 
radio(s). This allows one F-key string to be used for multiple 
purposes. 
 
An example of a Pro3 macro string that switches DualWatch and the 

Rx antenna based on the radio activity is shown below. {catA1hex 
fefe6ee0 12 00 00fd}{catI1hex fefe6ee0 12 00 01fd}{catA2hex 
fefe6ee0 07 c0 fd}{catI2hex fefe6ee0 07 c1 fd} 

{CATDELAY}  

This macro suspends the entire program operation to allow CAT 
commands to be received and executed by the radio possibly before 
a transmission begins. The need for this macro is dependent on the 
computer speed, radio interface rate, and radio type. The form of the 
CATDELAY macro is {CATDELAY N} where "N" is a user 
programmable delay in 50ms increments. The value of N is internally 
limited to 20 which would be a delay of 1 second 

4. Antenna and Rotor Control Macro Commands 

Macro keyword  Substituted by 

{ANTRX1TOGGLE} 
 
{ANTRX2TOGGLE} 
 
{ANTRX3TOGGLE} 
 

{ANTRX4TOGGLE} 

These macros can be used to switch between antenna ports and toggle the 
receive antenna input on some radios when the program is not transmitting. 

Some radio models have multiple inputs but lack the CI-V command to control 
the port so the functionality of these macros is radio dependent. When the 
{ANTRX#TOGGLE} macro is executed, the numbered antenna port is selected. If 

the same antenna port macro executed again and the radio is equipped, the 
receive antenna will be toggled on and off with each macro execution. If the 
antenna port is switched to another port, the current setting of the RX antenna is 
stored and used when this antenna is selected again. If only one radio antenna 
port is used it is only necessary to assign that {ANTRX#TOGGLE} macro to a F-
key to toggle the RX antenna on/off quickly. 

 



Macro keyword  Substituted by 

Supported radios: Yaesu FT950, FTDX9000, FT2000 Icom: IC746, IC746Pro, 

IC756, IC756Pro, IC756Pro2, IC756Pro3, IC775, IC7700, IC7800 and Elecraft 
K3, TenTec Orion, Kenwood TS2000, Kenwood TS-590S 

{TURNROTOR}  Turn the rotor to the direction based on the calculated direction 

{LONGPATH}  Turn the rotor to the calculated longpath direction 

{STOPROTOR}  
Stop turning the rotor. Note that per the manual some functions are not 
supported for all rotor brands 

5. CW Macros 

 
CW macros are only substituted when used in substitutions for CW buttons.  

CW Program Control and Prosign Macros 

Macro 
keyword  

Substituted by 

<  Increment CW speed with 2 wpm. See examples 

>  Decrement CW speed with 2 wpm. See examples 

~ Send half space character. See examples 

[ SK prosign      . . . _ . _  

]  AS prosign      . _ . . .  

+  AR prosign      . _ . _ .  

=  BT prosign      _ . . . _  

* the ! Macro: To send the CW code for an exclamation point, substitute a caret ^ in the macro  

Special Character Macros 

Macro 
keyword  

Substituted by  
Macro 

keyword  
Substituted by 

^  . . _ _ .  É . . _ . .  

"  . _ . . _ .  Ü . . _ _  

'  . _ _ _ _ .  Ä . _ . _  

?  . . _ _ . .  Á . _ _ . _  

/  _ . . _ .  Ñ _ _ . _ _  

:  _ _ _ . . .  Ö _ _ _ .  

;  _ . _ . _ .  _ . _ _ . _  

(  _ . _ _ .  $ . . . _ . . _  

)  _ . _ _ . _  @ . _ _ . _ .  

,  _ _ . . _ _  . . _ . _ . _  

-  _ . . . . _  ! 
 

 

Improving CW Readability 



Some calls have letter combinations where it's hard for to copy correctly. E.g. 6Y2A is often copied as 

BY2A. To help make your call easier to copy, Go to Config > Change Packet/CW/SSB/Digital Message 

Buttons> Change CW Buttons, and try changing the default F1 and/or F4 message where * is used for 
your call. In this example, 6Y2A changes F4 from * to>6<~Y2A. 
Result: the 6 is sent 2 WPM slower compared to the rest of the call, and an additional half space is 
added between the 6 and Y. Try other combinations of <, >, or ~ to make your call easier to copy. 

5.1. CW Macro Examples 

 Sent the call entered in the callsign field  
o Macro: !  

 Send his call. The callsign entered in the callsign entry field will be sent by the 
program via the serial or parallel port  

 Sent CQ with your call sent as a macro substitution  

o Macro: cq~test~de~*  

 The time between the words is a half space (~).  
 The * will be replaced with the callsign from the Station dialog {MYCALL}  

 Send part of exchange faster (report sent 6 wpm faster)  

o Macro: <<<5nn>>>{EXCH}  
 The report 5nn is sent 6 wpm faster than the exchange (<<< >>>).  

6. SSB Macros 

 

SSB macros are only substituted when used in substitutions for SSB buttons. SSB macros can be 
concatenated using a comma.  

SSB Macros 

Macro 
keyword 

Substituted by 

{OPERATOR}  
Specify wav files like: C:\Program Files\N1MM logger\wav\{OPERATOR}\cq.wav 
Default to station callsign if not specified. 
See examples 

6.1. SSB Macro Examples 

 Send the call entered in the callsign field  

o Macro: !  
 Send his call. The callsign entered in the callsign entry field will be sent by the 

soundcard. The location of the letter and number files used to make up his call 

sign is set up in the Configurer under the Files tab. All of the WAV files for the 
letters/numbers etc. must be present in that folder. See here  

 Let each operator have his own WAV files  

o Wave file name, e.g.: wav\{OPERATOR}\cq.wav  
 You can specify WAV files like: wav\{OPERATOR}\cq.wav . As you change 

operators in a multi-operator contest station, the WAV files will change as well. 
You will have to create a full set of wav files for each operator. Note that the 
WAV directory syntax indicates a subdirectory under the N1MM Logger 

program directory. You can also fully qualify the file name, like: "C:\Program 
Files\N1MM Logger\wavfiles\{OPERATOR}\cq.wav"  

http://n1mm.hamdocs.com/tiki-index.php?page=Before+the+Contest#How%20to%20Record%20WAV%20Files%20for%20the%20Function%20Keys%20Used%20in%20SSB%20Contests


 If you really wanted to, you could use: wav\{OPERATOR}CQ.wav and keep 

separately-named files in the same directory:  
 N1MMCQ.wav  
 PA1MCQ.wav  

 Play exchange with operators voice: C:\Program Files\N1MM 
logger\wav\{OPERATOR}\5905.wav  

 {OPERATOR} is a string substitution that is only implemented for SSB 
messages  

 

7. SO2V/SO2R Macros 

 
SO2V/SO2R macros are only substituted when SO2V or SO2R is selected. The {CTRLFx} macros work 
only in SO2R mode, because their functionality is not useful in SO2V.  

Single Op 2 VFO and Single Op 2 Radio Macros 

Macro keyword Substituted by 

{ACTIVEAUDIOTOGGLE}  
Toggles the muting and unmuting of the AF gain on the active radio. 
This works only on radios that support this capability via the radio 
control port 

{INACTIVEAUDIOTOGGLE}  
Toggles the muting and unmuting of the AF gain on the inactive radio. 
This works only on radios that support this capability via the radio 
control port. 

{ACTIVEAUDIOON}  Unmutes audio on the active radio; same limitation as above 

{ACTIVEAUDIOOFF} Mutes audio on the active radio 

{INACTIVEAUDIOON}  Unmutes audio on the inactive radio 

{INACTIVEAUDIOOFF} Mutes audio on the inactive radio 

{OTHERBAND}  Sends the band of the other (inactive) VFO/radio (e.g. 80) 

{OTHERMHZ}  
Sends the frequency of the other (inactive) VFO/radio in MHz (e.g. 3.5 
and 3R5 in CW) 

{OTHERFREQCUT}  
CW only. Sends last digits of the frequency of the other (inactive) 
VFO/radio as cut numbers. Uses the cut number style selected in 
Configurer 

{JUMPRX}  
Change the RX focus to the other input window. If only one input 
window is shown the second window will be opened 

{WIPE}  
Wipe the focus window. If the entry boxes are all empty, restores the 

last wiped contact ("unwipe") 

{ADVSO2RON}  Turn 'Advanced SO2R' on. See Chapter 'SO2R' 

{ADVSO2ROFF}  Turn 'Advanced SO2R' off. See Chapter 'SO2R' 

{CTRLFX}  

SO2R only. Works with RTTY and CW. Sends on the other radio. Thus a 
CW Button might look like: "tu EXCH{CTRLF9}" where F9 on the other 
radio is set to send a CQ. It is important to note that via hotkey 
Ctrl+Shift+L will turn this feature on or off. When off the CTRLFn macro 

is ignored. Entry focus moves to the other radio only when the callsign 
field on the current radio is empty. 

{CONDJUMP}  

When RX and TX focus are split between two radios, and the user hits 
the Enter key, TX focus is first moved to the radio with RX focus. The 
CW message is sent. After the CW message has been completed, TX 
and RX focus are both moved to the other radio. When RX and TX focus 



Macro keyword Substituted by 

are not split between radios, and the user hits the Enter key, the CW 

message is sent. When the CW message has been completed, TX and 
RX focus remain unchanged. 
Typical usage in Sprint is: Run F3: TU {END} {CONDJUMP} 

{QSYCQ}  Allows QSYing to the last CQ frequency on the focus radio 

{STOPTX)  
In specialized SO2R scenarios, forces PTT to be released. Rarely 
needed, and not for SO1R use. 

8. Multi-User Macros 

 
Multi-User macros are only substituted when in Multi-User mode.  

Macro 
keyword 

Substituted by 

{MESSAGE} 
Send a message (via function key) to other connected stations over the network. See 
examples 

{PASS 0} 

... 
{PASS 15} 

Pass frequency from station 0 (Master station) through station 15. The Pass frequency 
is rounded to the nearest kHz 

{PASS 1800} 
... 

{PASS 
28000} 

Insert pass frequency for first connected station found on that band. Valid values are 
PASS 1800, 3500, 7000, 14000, 21000 and 28000 

{PASSMSG 
0} 
... 

{PASSMSG 
15} 

Pass last QSO information from station 0 (Master station) through station 15 

8.1. {MESSAGE} Macro Examples 

 
The {MESSAGE} macro sends a message (via a function key) to other connected stations over the 

network. The info will be shown in big red letters in the Info window from the receiving station(s). 
Place a number directly after the {MESSAGE} macro if you want to send the message to one specific 
station. If you don't want to send to a specific station, but want to start your message with a number 
put "- " in front of the message. Because "*" is used by macro substitution to indicate a callsign, you 
cannot put a * a the beginning of a message to indicate that the message should be sent to all 
stations. Since sending to all stations is the default behavior, this is not a problem. Just don't start the 
message with a number if you want to send the message to all stations.  

{MESSAGE} Macro Examples 

Button 
text 

Macro 

F8 Pass 
station 

{MESSAGE}2 {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} {GRIDBEARING}deg. 
{KMGRIDDISTANCE} km. 

Message sent to station 2 with info about the station in the callsign field. This is a macro 



Button 

text 
Macro 

which could be used in VHFREG1 where a station is sent from one band to another 

F8 Pass 
station 

{MESSAGE} {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} {GRIDBEARING}deg. 
{KMGRIDDISTANCE} km. 
Message sent to all connected stations with info about the station in the callsign field 

F8 OK {MESSAGE}2 OK. Send OK to station 2 

9. Digital (RTTY and PSK) Macros 

 
The following substitutions will be made when sending function key.  
In the Digital interface the macros below can be used but also all other macros shown under general 
macros.  

Macro keyword Substituted by 

{TX} 
Start transmission in the digital interfaces (needed to transmit!) Needed at 
thebeginning of every Digital macro! 

{RX} 
Switch to receive in the digital interfaces (needed to get back to receive). Needed 

at the end of every Digital macro! 

{CLRRX} 
Clear the RX window. This macro can be used either alone or after an {END} 
macro. 

{SCQ} Placed at end of TU macro, resume CQ 

{GRAB} Grab first callsign from grab callsign window 

{DELALL} Delete all entries from grab callsign window 

{DELTOP} Delete Top Entry from grab callsign window 

{DELSEL} Delete highlighted entry from grab callsign window 

_ (Underscore) MMTTY only. Send an idle tone 

^ 
Send the ! character (! sends the other station's call; use ^ to put a ! character in 
a message) 

{FILE:xxxx} 

Send textfile located in N1MM Logger program directory. xxxxx is replaced by the 
name of the text file and the text file needs to be in the logger directory. The 

macro works any place in a macro string. If the text file only contains one line it 
does not add CR to end of line. When the text file is multi lined the CR from the 
last line will be removed so the following text will be on the same line. Multiple 
{FILE:xxxx} macros are allowed in one macro string 

{LDIGFQ} Left Digital Interface Frequency 

{RDIGFQ} Right Digital Interface Frequency 

{PREVTIME} Send previously sent time (for ANARTS and BARTG alike contests) 

{ALIGN} 
Move signal into bandpass range. Does the same as Align Buttons on Digital 

Interfaces and the PSK Engine 

{PROFILE0} MMTTY only. Reset to HAM default definitions for RTTY mark, space, width 

{PROFILE1} 
... 

{PROFILE8} 

MMTTY only. {PROFILE1} through {PROFILE8} in the function keys at the start of 
a CQ or S&P macro will change MMTTY's profile. This way it is possible to have 
one profile for CQing and another one for S&P or however you want to set them 

up 

{HXXXX} 

HAL DXP38 only. The DXP-38 commands are in the form of Hex that look like $80 
$EA. This macro substitution takes the text string in the form of {HXXXX} or 
{H80EA} and converts this to the appropriate command that should be sent to 
the TU. See the RTTY chapter for more HAL DXP38 info 



Macro keyword Substituted by 

{DI1}...{DI24} Send text assigned to the digital macro keys DI-1 to DI-24 on the Digital Interface 

{LOGTHENGRAB} 

Run Mode only. Log the current contact and grab the top callsign from the Grab 

window of the DI. If the grab window is empty, logs the current contact and then 
switches to the TU key message instead of continuing with the rest of the 
message containing {LOGTHENGRAB} 

{DIGQTCR} WAE contest only. Open Digital QTC Receive window 

{DIGQTCS} WAE contest only. Open Digital QTC Send window 

{ALT-T} Same as keyboard ALT+T - Toggle TX/RX state 

{ALT-Q} Same as keyboard ALT+Q - Return to CQ frequency 

{ENABLEAFC} Turn AFC on 

{DISABLEAFC} Turn AFC off 

{ENABLENET} Turn NET on (not applicable in FSK) 

{DISABLENET} Turn NET off 

 

Always use {TX} and {RX} together 

Use {TX} and {RX} together in your macros. Otherwise, {TX} alone in a macro will cause the radio to 
remain in transmit until you press an RX button or the ESC key 

 

TNC - Clear Buffer After Abort 

It is best to add the command that your TNC uses to clear the transmit buffer to the end of your Abort 
Macro. If not, the transmit buffer still holds the remaining characters that were left in the sent string 
and will get sent the next time the TNC sends. 

9.1. RTTY and PSK Macro Examples 

Example Function Key Macros 

Function Macro 

Log the contact, grab a call from the Grab box and give an exchange 
to the next station. 
If the Grab box is empty, this macro will log the contact and just 
send the TU message instead.  

{TX}{ENTER} ! 

{LOGTHENGRAB} TU NW 
{F5}{F2}{RX} 

Log the contact, pull the next callsign from the call stack and send 

the exchange to him (see Single Operator Call Stacking). 
If you want to stack another station that has called you, just Alt-Click 
on the call in the RX window and it will be placed on the call stack 
where you can get it with this macro.  

{TX}{ENTER} ! 
{LOGTHENPOP} TU NW 
{F5}{F2}{RX} 

Example Macros for the PK-232 (Digital Interface window)  

Button text Macro 

Abort {CTRL-C}R{ENTER}TC{ENTER} 

TX X{ENTER} 

RX {CTRL-D} 

Band Up RB U{ENTER} 

http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking


Button text Macro 

RxReverse RXREV T{ENTER} 

Example Function Key Macros for the PK-232 (Entry window) 

Mode Button text Macro 

Running  F1 CQ X{ENTER}CQ CQ CQ TEST DE {MYCALL} {MYCALL} K CQ{CTRL-D} 

Running  F2 Exch X{ENTER} ! UR 599 {EXCH} 599 {EXCH} BK{CTRL-D} 

Running  F3 Tnx/Qrz X{ENTER} ! TU GL DE {MYCALL} QRZ{CTRL-D} 

S&P  F1 {MYCALL} X{ENTER}! DE {MYCALL} {MYCALL}{CTRL-D} 

S&P  F2 Exch X{ENTER}! UR 599 {EXCH} 599 {EXCH} GL DE {MYCALL}{CTRL-D} 

Example Macros for the KAM  

Button text Macro 

Abort {CTRL-C}R RTTY {ENTER} 

TX {CTRL-C}T 

RX {CTRL-C}E 

Example Macros for the SCS PTC (Digital Interface window)  

Button text Macro 

Abort {ESC}CLR{ENTER}{CTRL-D}{ENTER} 

TX/RX {CTRL-Y} 

RX-Reverse {ESC}TR 1{ENTER} 

RX-Norm {ESC}TR 0{ENTER} 

45 Baud {ESC}BAU 45{ENTER} 

75 Baud {ESC}BAU 75{ENTER} 

Command mode {ESC}Q{ENTER} 

- - - - - - 

RTTY {ESC}Q{ENTER}BAU{ENTER} 

PSK31 {ESC}Q{ENTER}PSKT{ENTER} 

CW {ESC}Q{ENTER}CWT{ENTER} 

AMTOR {ESC}Q{ENTER}AMTOR{ENTER} 

PACTOR {ESC}Q{ENTER}PT{ENTER} 

PACKET {ESC}Q{ENTER}PACKET{ENTER} 

Example Function Key Macros for the SCS PTC (Entry window)  

Mode Button text Macro 

Running  F1 CQ {CTRL-Y}CQ TEST DE * * * k{ENTER}{CTRL-Y} 

Running  F2 Exch {CTRL-Y}! HI 599 {EXCH} {EXCH} K{CTRL-Y} 

Running  F3 CFM {CTRL-Y}! QSL TU DE * QRZ? K{CTRL-Y} 

S&P  F1 {MYCALL} {CTRL-Y}! DE * * K{CTRL-Y} 



Mode Button text Macro 

S&P  F2 Exch {CTRL-Y}DE * TU 599 {EXCH} {EXCH} GL DE *{CTRL-Y} 

Example Function Key Macros for MMTTY (Entry window) 

Mode Button text Macro 

Running  F1 CQ {TX} CQ CQ CQ TEST DE {MYCALL} {MYCALL} K CQ {RX} 

Running  F2 Exch {TX} ! UR 599 {EXCH} 599 {EXCH} BK{RX} 

Running  F3 Tnx/Qrz {TX} ! TU GL DE {MYCALL} QRZ {RX} 

S&P  F1 {MYCALL} {TX} ! DE {MYCALL} {MYCALL}{RX} 

S&P  F2 Exch {TX} ! UR 599 {EXCH} 599 {EXCH} GL DE {MYCALL}{RX} 

Send CQ 
on new line  

F1 CQ {TX}{ENTERLF} CQ DE {MYCALL}{RX} 

10. Packet/Telnet Macros 

 
Packet/Telnet macros are only substituted when used in the packet/telnet buttons.  

Macros for use in packet/telnet buttons 

Macro keyword Substituted by 

{WAIT} Wait 5 seconds (fixed value) 

 
Macros for use in 'Comment For All Spots' (in Telnet/Packet window).  

Macros for use in 'Comment For All Spots' (in Telnet/Packet window) 

Macro keyword Substituted by 

{GRIDSQUARE} Gridsquare from grid textbox in Entry window 

{MODE} Mode used during contact in Entry window 

{QTH} QTH from section/qth textbox in Entry window 

{ZONE} Zone for state/province/section/oblast/other textbix in Entry window 

10.1. Packet Macro Examples 

 Connect the local DXcluster using TAPR firmware  

o Macro: {CTRL-C}C {CLUSTER}{ENTER}  
o The above sentence is specified for a function key in the Packet Window  

 {CTRL-C} sends a Control-C character to the TNC which is placed in 
command mode  

 {CLUSTER} will be substituted with the Packet Node Call from the Station 

Information dialog. As example: PI8XXX  
 {ENTER} will be substituted with the Enter key  



o The result is that the TNC is placed in Command mode (with Ctrl+C) and C PI8XXX is 
sent to the TNC because an Enter is sent after the command  

 Connect the Local DXcluster using TF/Nordlink firmware:  
o Macro: {ESC}C {CLUSTER}{ENTER}  

o The above sentence is specified for a function key in the Packet Window  
 {ESC} places an Escape character in the command line buffer. This is the 

same as Shift+Escape when the cursor is on the command line from the 
Packet Window  

 {CLUSTER} will be substituted with the Packet Node Call from the Station 
Information dialog. As example: PI8XXX  

 {ENTER} will be substituted with the Enter key  
o The result is that the TNC is placed in Command mode (with ESC) and C PI8XXX is 

sent to the TNC because an Enter is sent after the command  

 This is an example where more commands are placed under one function key:  

o Macro: {ESC}I {MYCALL}{ENTER}{ESC}P 
100{ENTER}{ESC}S1{ENTER}{ESC}C {CLUSTER}{ENTER}  

o The above sentence is specified for a function key in the Packet Window  

 {ESC}I {MYCALL}{ENTER} Send my call to the TNC  
 {ESC}P 100{ENTER} Change the Persistence to 100  
 {ESC}C {CLUSTER}{ENTER} Connect my local DXcluster 

 So one function key does it all!  

 This is an example using the {WAIT} macro:  

o Macro: {CTRL-M}{WAIT}C PE1M-7{WAIT}PA1M  
o In the substitutions you can include things like {CTRL-M}. The {WAIT} macro that 

waits 5 seconds.  
o Enter is sent automatically after each command. This may cause a problem with some 

systems.  

 This example sends Ctrl+Z to the DX-cluster to send packet mail (end message)  

o When you have no way to send CTRL+Z to the packet TNC. Then set one of the packet 
macros to {CTRL-Z} and that works just fine.  

o Example F12: {CTRL-Z}  

 

2.4.3 ESM (Enter Sends Messages) 

 2.4.3 ESM (Enter Sends Messages)  
o 1. ESM Overview  

o 2. ESM on Phone - One Special Feature  
o 3. Big Gun versus Little Pistol Switch  

 3.1. So You are a Big Station  
 3.2. So You are a Little Pistol  

1. ESM Overview 

This section provides a step-by-step introduction to ESM. Try it, and we can almost guarantee you'll 
like it.  

The first step is to turn it on. Open the Config menu in the Entry Window, and select ESM  



 
 
 

 
Now close the menu and enter any call in the entry window. We're assuming that you are doing S&P.  

 
 

 



 

What's different? Take a look at the F4 button. The highlight means that if you press Enter at this 
point, the F4 message will be sent (which is what you want - your call). Press <Enter>, your call is 
sent, but the cursor remains in the callsign field, and F4 is still highlighted. If he doesn't answer the 
first time, just press <Enter> again. If he answers you, hit <Space>, and look!  

 
 

 

 

The cursor has moved to the Exchange box, and now F2 is highlighted. That means that the next time 
you hit <Enter>, the program sends F2 and logs the QSO.  

So instead of an 8 step process to work an S&P QSO, you have either 3 or 4:  

1. Enter the callsign  
2. Press <Enter>  

3. (optional) If he doesn't answer, press <Enter> when it's time to call him again; if he does, 
press <Space> and copy his exchange  

4. Press <Enter> again to send your exchange to him and log the QSO.  

 
But suppose you're Running (Calling CQ)? The first thing to do is tell the program. You do that by 
checking the box next to the word "Running", either with your mouse or by hitting <Alt>+U. Now your 
Entry Window looks a bit different:  

http://n1mm.hamdocs.com/Enter


 
 
 

 

Note the highlight is now on F1, because the first thing in most Run QSOs is a CQ. Press <Enter> and 
the program will send F1.  

Now someone answers. Type in his callsign and the window changes.  

 
 

 

 

You're starting to get the hang of this - the highlights mean that when you hit <Enter> the program 

will send F5 followed by F2 (on CW - on phone you would speak the callsign and then press <Enter> 
to send your exchange).  

Once you have done that, the window changes again.  



 
 
 

 

Now the highlights tell you that you have copied a legitimate exchange (in this case the program has 
supplied it from the callsign, and that the next <Enter> will send your F3 message and log the QSO.  

So, type a callsign, hit <Enter> 3 times, and you've logged a QSO. Pretty slick!  

Now suppose you're like me and you fat-finger copying the exchange, so that you have nonsense in 
the Exchange box, like this. In that case, the program reminds you:  

 
 

 

 
If you hit <Enter> with an incorrect exchange, the program will send the F8 message and request a 

repeat. Alternatively, if you see your mistake and correct it, the screen changes again to show the "F3 
and Log It" highlights. Just press <Enter>, the program sends the F3 message, logs the QSO, and 
you're done.  

Once you've used ESM, I predict you'll never go back to the old way again.  



 

F1 Call CQ - A special Function Key that switches to Run Mode automatically 

The developers have reserved F1 as the "Call CQ" key. Pressing it while in Search and Pounce mode 
will switch you to Run mode. Although we do not recommend changing it, there are at least two ways 

to redefine F1: modify the ESM function key assignment table (see below) or use the {S&P} macro at 
the end of your F1 definition to force the program back to S&P mode. 

 
 
 

Two further refinements, and then this chapter is done. Open the Config menu again, and then open 
the "Configure Ports, Telnet Address, Other" sub-menu. Click on the Function Keys tab:  

In the left-hand column, note that I have checked "Send Corrected Call." This neat feature, in Run 
mode, keeps track of whether you have changed the callsign in the callsign box. For example, say you 
only copied "DL6A" at first, and filled in the rest later. Eventually, you copy DL6ABC, and when you 
press <Enter> to send the F3 (TU message), on CW the program sends "DL6ABC TU ..." On phone, 
you'll need to supply the correction.  

In the right-hand column, the third checkbox is cumbersomely titled "ESM only sends your call once in 
S&P, then ready to copy received exchange." In shorthand, we call this the "Big Gun switch." If you 
nearly always get stations you call the first time, you can save a keystroke by having the cursor 
advance automatically to the exchange box after the first time you call. If you often need to call again, 

don't check it. If you have checked it, and need to call a station more than once, you just press F4, 
regardless of where the cursor is.  

 

ESM cursor behavior and the Digital Interface window 

http://n1mm.hamdocs.com/F4


Because of the ability to transfer data from the DI window to the Entry window with a mouse-click, the 

behavior of the cursor moving between the boxes in the Entry window is different when the DI window 

is open than when it is closed. If you are using ESM in CW or SSB with the DI window open and the 
cursor does not move between the call sign and exchange boxes when you expect it to, try closing the 
DI window. 

 

Caution 

Don't change the "key mappings" (below the red type) unless you absolutely know what you're doing - 

it can make a horrible hash out of ESM. 

 

The chart below outlines the possible combinations of information in the Entry window, and what will 
be sent in each situation.  
Note: ESM is affected by two options in the Configurer under the Function Keys tab:  

 the "ESM sends your call once in S&P, then ready to copy received exchange" check box 

(sometimes called the "Big Gun" option)  

 the "Work dupes when running" check box (recommended)  

ESM Mode Enter Key Actions 

Callsign field 
Exchange 

field 
In Run Enter sends In S&P Enter sends 

Empty Empty CQ (F1) My Call (F4) 

New Call (1st time) 
Empty or 
invalid 

His Call + Exch(F5 + 
F2) 

My Call (F4) 

New Call (repeat) 
Empty or 

invalid 
Again? (F8) My Call (F4) 

New Call (repeat) - ESM sends call 
once... checked 

Empty or 
invalid 

Again? (F8) Again? (F8) 

New Call (before sending exchange) Valid 
His Call + Exch(F5 + 
F2) 

Exchange + Log(F2 + 
Log It) 

New Call (after sending exchange) Valid 
End QSO + Log(F3 + 
Log It) 

Log(Log It) 

Duplicate Call 
Empty or 
invalid 

QSO B4 (F6) do nothing 

Duplicate Call (before sending 
exchange) 

Valid 
His Call + Exch(F5 + 
F2) 

Exchange + Log(F2 + 
Log It) 

Duplicate Call (after sending exchange) Valid 
End QSO + Log(F3 + 
Log It) 

Log(Log It) 

Dupe (1st time) - Work Dupes checked 
Empty or 

invalid 

His Call + Exch(F5 + 

F2) 
do nothing 

Dupe (repeat) - Work Dupes checked 
Empty or 
invalid 

Again? (F8) do nothing 

Dupe (before sending exchange) - Work 
Dupes checked 

Valid 
His Call + Exch (F5 + 
F2) 

Exchange + Log(F2 + 
Log It) 

Dupe (after sending exchange) - Work 

Dupes checked 
Valid 

End QSO + Log (F3 + 

Log It) 
Log(Log It) 

2. ESM on Phone - One Special Feature 



There's every reason, when running CW or RTTY, to use stored messages for almost every 
transmission. Phone is different - you may not want to have the computer talk for you all the time.  

 Most operators choose to say callsigns and serial numbers themselves, rather than having the 
computer assemble them from individual letters and numbers. See the next section for more 

discussion of these issues, and for information on how to set up your Function Key definitions, 
whether you choose to let the computer do it all or not.  

 In some contests like CQWW, the exchange is so short that it may be more hassle than it is 
worth to have the computer voice your CQ zone.  

 
Or... you may forget, particularly when you are running tired, and say the other station's call and your 
exchange before you realize you've done so.  

To deal with this, N1MM Logger incorporates some additional flexibility. Here's how it works, courtesy 
of the inventor, N2IC:  

You are in Run mode. A station answers. You type in the callsign, and you use your live voice to send 

the callsign and exchange. Now, the station you are  
working is about to send his/her exchange. If, at this point, you hit the Enter key, your exchange wav 
file would be sent. That is bad - you already used your live voice to send the exchange. Instead of 
hitting the Enter key, hit the Space bar. Now, type in the other station's exchange. Hit the Enter key, 
and the "Thanks" message will be sent, and the QSO will be logged.  

In summary, the decision of whether to use the Enter key or the Space bar at that step in the logging 
process depends on whether you use your live voice to send your exchange, or a wav file.  

Here's an illustrated version of how it works:  

You're running, and W8QZR calls you. You type his call into the callsign field.  

 
Then, for whatever reason, you say his call and the exchange instead of having the computer do it. If 
you then hit Enter, the program will, as it says, transmit his call and the stored exchange message. 
Not what you want.  

Instead, you hit the Space bar.  



 

Perfect! Now the cursor is in the Exchange field, and you type in his exchange.  

 

The highlight moves to the TU and "Log It" buttons, just where they should be. Hit Enter, and the 
computer will log the QSO, send your "TU QRZ" message and be all ready for the next QSO.  

3. Big Gun versus Little Pistol Switch 

One of the settings in Configurer >Function Keys tab is 'ESM only sends your call once in S&P, 
then ready to copy received exchange'. When selected and in Enter Sends Message mode, the 
cursor moves to the Exchange field when there is something in the Callsign field and Enter is pressed 

and does not keep the cursor in the callsign field. If you don't usually get a station on the first call 
then deselect this option.  

3.1. So You are a Big Station 

 Stations normally come back to you on the first call  

 In >Configurer >Function Keys tab, check 'ESM only sends your call once in S&P, then ready 
to copy received exchange'.  

3.2. So You are a Little Pistol 



 You have to call mostly several times to get through to being answered  

 In >Configurer >Function Keys tab, uncheck 'ESM only sends your call once in S&P, then 
ready to copy received exchange'.  

 

Big Gun Tip 

One little trick to use with the Big Gun switch on is to program my call in F8 instead of "again". This 
way, when you don't get the guy on the first call, hit Enter again to repeatedly send my call until he 
answers (and the cursor is always in the right place when he does answer). 73 de Ted W4NZ 

 

2.4.4 Function Key Examples 

 2.4.4 Function Key Examples  
 1. SSB  

 1.1. WPX SSB example  
 2. CW  

 2.1. CW program default  
 2.2. Sprint CW examples  

 2.2.1. Example 1  
 2.2.2. Example 2  
 2.2.3. Example 3  

 2.2.4. Example 4  
 3. RTTY  

 3.1. General RTTY example  
 3.2. Example RTTY where the time is part of the exchange (like 

ANARTS).  

 

Note 1 

There may not be any 'holes' in the function keys lines with skipped function keys. ALL preceding 
Function keys must at least have a line in the table. Example: You'd like to have a different S&P F3 

key than the Run F3 key. First you have to add the 12 Run lines in the table, after that the S&P lines 
for F1 + F2 +F3 which you liked to change for S&P. So at least 15 lines in total have to be in the 
function key table (12 run + 3 S&P). 

 

Note 2 

The text F1 (etc.) in the left column is only text and has no intelligence/meaning for the program. You 

could remove it and change it to any text you like, which will show on the Function key in the Entry 
window. The order of lines determines what the key will do. Examples: line 5 is Run F5 , line 11 is Run 
F11, line 17 is S&P F5 (17-12=5) etc. 

 

Note 3 

When you load a function key definition file into the current database, that table of definitions, 

including any changes that you make during the current session, is saved in the database. That means 
that if you restart the program and, for instance, start a new contest log, you will discover that the 
program still uses the function key definitions set for the previous contest. Each N1MM Logger 
database has single, separate tables for CW, SSB and RTTY function key definitions. Once these have 
been created or loaded from a file (File > Import > Import function keys from file), they remain until 

replaced. The correct way to manage this is to specify a file for each relevant mode (on the Associated 
Files tab of the Contest Setup dialog) when you set up a new contest, so that the right function key 
definitions will be loaded. If you don't specify a file, or clear the Associated Files notation, the most 
recent set of definitions stored in the database will come up each time you open or reopen the log.  



1. SSB 

 
This is the default SSB Function Key Definition Table, as it appears in the database when the program 
is first installed.  

 

 
 

If an external DVK is configured, place the dummy filename empty.wav in each of the first n slots in 
the function key definition table, where n is the number of message memories supported by the DVK. 
This will cause the MK2R or LPT controlled DVK to be triggered when F1-Fn are pressed. Note that the 
program PTT will not be toggled when the external DVK message starts.  

1.1. WPX SSB example 

 

Here is an excerpt from my macro list that I used in WPX SSB with ESM. Note again that the first 12 
lines are for Run mode, and the last 12 for S&P. I was voicing both serial numbers and the other 
station's callsign. Note also that I used a brief pause.wav file (finite length but no sound) to get a 
pause between his call and the serial number.  

This is tricky because it requires mixing macros and WAV filenames. Pay close attention to the details 
- there are no doubt other syntaxes that work, but I know this does, with no spaces, commas or other 
punctuation in the right column.  

Button Caption WAV File  

F1 CQ wav\{OPERATOR}\cq.wav  

F2 Exch wav\{OPERATOR}\exchange.wav  



F3 TU wav\{OPERATOR}\tnx.wav  

F4 {MYCALL} wav\{OPERATOR}\mycall.wav  

F5 His Call wav\{OPERATOR}\pause.wav  

F6 Rpt Exch wav\{OPERATOR}\number.wav  

F7 
 

F8 
 

F9 
 

F10 
 

F11 
 

F12 
 

F1 
 

F2 Exch wav\{OPERATOR}\exchangeSP.wav  

F3 TU 
 

F4{MYCALL} 
 

F5 His Call 
 

F6 Rpt Exch 
 

F7 
 

F8 
 

F9 
 

F10 
 

F11 
 

F12 
 

2. CW 

2.1. CW program default 

 
Below are the default function keys as set up in the program. The F3 to F12 keys under S&P are not 
filled in. If you press these keys in S&P mode, the Run mode S&P messages will be sent.  

Button caption CW message  

F1 CQ cq~test~de~*  

F2 {Exch} <<<5nn >>>{EXCH}  

F3 TU TU de *  

F4 {MYCALL} *  

F5 His Call !  

F6 QSO B4 QSO B4 de *  

F7 ? ?  

F8 Agn Agn  

F9 
 

F10 
 

F11 
 

F12 
 

F1 {MYCALL} *  

F2 5NN {EXCH} <<<<5nn>>>>{EXCH}  

F3 
 



F4 
 

F5 
 

F6 
 

F7 
 

F8 
 

F9 
 

F10 
 

F11 
 

F12 
 

 
 

 
 

 
 

2.2. Sprint CW examples 

Whether you operate the NA Sprint or not, these examples will illustrate the use of various macros in 
combination with text in function key definitions.  

2.2.1. Example 1  

This Function key set is based on a set posted by Kenny, K2KW  

Button caption CW message  

F1 CQ * * <<<NA>>>  

F2 Exch * {EXCH}  

F3 TU EE{S&P}  

F4 {MYCALL} *  

F5 His Call !  

F6 QSO B4 B4 E E  

F7 ? ?  

F8 Agn AGN  

F9 
 

F10 
 

F11 
 

F12 
 

F1 CQ **<<<NA>>>  

F2 Exch ! {EXCH} *  

F3 TU EE{RUN}  

F4{MYCALL} *  

F5 His Call !  

F6 QSO B4 B4 E E  

F7 ? ?  

F8 Agn AGN  

F9 
 



F10 
 

F11 
 

F12 
 

 
Running Message Notes  

 For F2, there is a space before the *; E.G. "<space> * {EXCH}"  

 For F3, "EE" is there to confirm the QSO. You could easily use "TU".  

 After the "EE" is sent on the F3 message, the {S&P} macro puts you into the S&P mode. Then 

just hit your UP/DOWN arrow to QSY.  

 Personally I have F6 programmed as {EXCH} to send a repeat on the exchange  

 
S&P Message Notes  

 Note the difference in the sequence for the F2 message compared to the Running F2 message  

 For the F3 message, the {RUN} macro puts you in the running mode, ready to work a tail 
ender and send him the correct QSO sequence  

 Personally I have F6 programmed as {EXCH} to send a repeat on the exchange  

2.2.2. Example 2  

 
This function key set is based on one posted by Pete, N4ZR and modified by Rich, VE3KI.  

Button caption CW message  

F1CQ * * NA{CLEARRIT}  

F2 Exch * {EXCH} 
 

F3 TU E~E {CLEARRIT}  

F4 {MYCALL} *  

F5 His Call !  

F6 QSO B4 B4 *  

F7 Rpt Exch {EXCH}  

F8 ? ?  

F9 
 

F10 
 

F11 
 

F12 
 

F1 CQ * * NA{CLEARRIT}  

F2 Exch ! {EXCH} * {RUN}  

F3 NR #  

F4 {MYCALL} *  

F5 His Call !  

F6 Name PETE  

F7 State WV  

F8 ? ?  

F9 
 

F10 
 



F11 
 

F12 
 

 
Note two things about this set:  

1. The {RUN} macro is in S&P F2, not F3. This worked great for me - when I pressed Enter to send 
the S&P exchange, the exchange was sent, the QSO was logged, and the mode changed to {RUN} 
with the cursor in the call sign box. Therefore I did not have to press F3 to get from S&P to Run. The 

main problem with this is that if anyone asks for a repeat of the serial number, the Run keys are 
already active, so you have to either remember how to get the serial number from the S&P set 
(Shift+F3), or else just use the paddle, which is what I did.  

2. There is no {S&P} macro in this set. At the end of a Run QSO, you switch to S&P mode by just 
QSYing. This also worked OK for me; since you are going to have to QSY anyway, there seems to be 

no real need to force a change to S&P mode. I also had the "QSYing wipes the call & spots QSO in 
bandmap" option selected, which may have helped ensure that the cursor was in the right place after 
QSYing by wiping the entry window. Of course I did not actually have the band map open, and I just 
ignored any call signs that showed up in the frame in the entry window.  

It would be a nice touch if the final Enter in Run mode would not only log the QSO, send the 
acknowledgment (E E or R) and switch to S&P, but also QSY the radio by 1.5 kHz; but as far as I am 

aware there is no {QSY:+1.5} macro to do this. I think you have to either turn the radio dial or press 
the up/down arrow or PgUp/PgDn key (depending on what increments you have these keys set for). I 
just turned the dial. Next time, if I remember, I will set PgUp and PgDn to 1.5 kHz and try to use them 
more.  

73, Rich VE3KI  

2.2.3. Example 3  

 

This function key set is an example how to use the Single Operator Call Stacking macros in CW. 
Posted by John, K3CT.  

Button Caption CW Message (sic)  

F9 Stack {SOCALLSTACK}  

F10 Log Pop {LOGTHENPOP} TU NW {F5}{F2}  

F11 
 

F12 Wipe {WIPE} 

 

DX4Win uses F12 for Wipe so I use the same key for casual operating and contesting.  
Colored stickers with a message on the key tops helps me find the important keys.  

2.2.4. Example 4  

 
Customizing N1MM Logger for the North American CW Sprint by Steve, N2IC  

I'm not going to try to explain how to operate the Sprint - for this, there is an excellent writeup at: 

http://www.kkn.net/~n2ic/sprint.html  
What I will do is describe how to get the most out of N1MM Logger in the Sprint. My operation is 



SO2R, and my configuration is optimized for that mode. However,I'm sure you SO1R guys will pick up 

a few tricks from what I have done for SO2R.The most important thing is to get your options, windows 
and function keys setup correctly before the Sprint starts.  

The Options...  

Start up N1MM Logger using version 12.1.0 or later, and create a new SPRINTCW contest.  

In the Config menu, select the following options:  

 Enter sends message (ESM)  

 QSYing wipes the call & spots QSO in bandmap  

 Do not automatically switch to run on CQ frequency  

 Show non-workable spots  

 SO2R->Toggle CTRLFx Macro  

 
Note: SO2R->Focus on Other Radio is NOT turned on  

The Windows...these are the only windows I have on my screen and all fit nicely on my small monitor  

 Entry Window (one for each radio)  

 Visible Dupesheet (one for each radio)  

 Info  

 Log  

 Score Summary  

 
 



 
 

 

The Visible Dupesheet is really nice once you get used to it. To see if a station is a dupe, you just scan 
the dupesheet with your eyes, rather than frantically type a call into the Entry Window. You can 
change the font size in the Visible Dupesheet by dragging it wider, so that there is white space past 
right-most column. Then right-click in the white space for a choice of a small font or a large font.  

Notice that I do NOT have the "Available Mults & Q's" nor the Bandmap windows open.  

Now, I'm about to temporarily contradict myself. Open a Bandmap window. Right click and select 

"Packet Spot Timeout". Change the packet spot timeout to 1 minute. That's right....1 minute. Hit OK. 
Now close the Bandmap window. Don't reopen it. It is of no value in Sprint, but it is important to 
change the packet spot timeout value to 1 minute. (Side note: This option should really be called 
"Bandmap Timeout" not "Packet Spot Timeout". It controls how long calls stay on the bandmap and 
the appearance of calls in the "on deck" frame of the Entry Window. We're obviously not using packet 
in the Sprint.)  

Function Keys ....  



Here are my function key definitions. I'll explain a few that aren't obvious.  

Button caption CW Message  

F1 CQ {JUMPRX}cq na cq na * na  

F2 Exch * # steve nm  

F3 TU {CLEARRIT}T{END}{CONDJUMP}{STOPTX}  

F4 (MYCALL} *  

F5 His Call !  

F6 QSO B4 ! QSO B4 * NA  

F7 Other Short {CTRLF10}  

F8 Other Long {CTRLF11}  

F9 Go S&&P {S&P}  

F10 CQ CQ NA * * NA {RUN}  

F11 Long CQ CQ NA CQ NA * * NA {RUN}  

F12  -  

F1 S&&P CQ {JUMPRX}CQ NA CQ NA * NA  

F2 S&&P Exch ! # STEVE NM *{RUN}  

F3 S&&P TU TU  

F4 S&&P{MYCALL} *  

F5 S&&P His Call !  

F6 S&&P Name -  

F7 S&&P Other Short {CTRLF10}  

F8 S&&P Other Long {CTRLF11}  

F9 Go Run {RUN}  

F10 CQ CQ NA * * NA {RUN}  

F11 Long CQ CQ NA CQ NA * * NA {RUN}  

F12 - 

 

 
With the CQ F3 key, my "thank you" message is sent. When you QSY, you will automatically be 
changed to the S&P mode. Do not include the {S&P} macro here -it will cause the last station worked 
to get "stuck" in the on-call fame of the Entry Window.  

With the S&P F2 key, as soon as I send my exchange, it immediate switches to Run mode.  
I can also force myself into Run and S&P modes with the F9 key.  

The F7 and F8 keys send CQ's on the "other" radio. This is very useful when the other station is 
sending his exchange, and you are going to lose the frequency (i.e. it will become "his" frequency). 
You can send a CQ on the other radio, while he is sending his exchange. Then, when he finishes 

sending his exchange and you need to send your "thank you" message to finish the QSO, all you have 
to do is hit Enter, which will stop the CQ on the other radio, and send your CQ F3 message on the 
active radio. However, you had better be ready to copy a new caller on the "other" radio. You also 
need to be sharp with the Pause key to jump between the two radios when this happens. The 
{CONDJUMP} macro in the Run F3 message will move your entry focus to the "other" radio, so that 
you will be ready to copy a new caller.  

When I'm CQing on the active radio, but simultaneously doing S&P on the other radio, and hear a new 
station, I can just hit the Enter key. This will stop the CQ, and send my call on the other radio.  



One thing you need to do is keep an eye on where your transmit and receive focus is (the red and 

green dots on the Entry Window). When you're doing SO2R in the Sprint, there will be times where 
your focus is not where you might expect it, or want it. Always be ready with the \ and Pause keys to 
jump between radios. Yes, this takes lots of practice, and you will make mistakes. The Thursday night 
NCCC Sprints are good practice for this.  

73 and see you in the Sprint !  
Steve, N2IC  

3. RTTY 

3.1. General RTTY example 

 
The way the keys below are designed, they will work in many RTTY contests without any changes. 
Whether these particular ones suit your situation will depend on your antennas, your power, QTH, 
etc.; but maybe these will give you some ideas to work with.  

Button Caption Message sent  

F1 CQ {TX} CQ TEST DE * * CQ {RX}  

F2 EXCH 599{EXCH} ! BK {RX}  

F3 TU {TX}{ENTERLF} ! TU DE * QRZ? {RX}  

F4 {MYCALL} {TX} DE * K {RX}  

F5 His Call{TX}{ENTERLF}  

F6 QSO B4 {TX} B4 DE * CQ {RX}  

F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} K {RX}  

F8 {TX} AGN AGN DE * K {RX}  

F9 
 

F10 
 

F11 
 

F12 
 

F1 CQ {TX} CQ TEST DE * * CQ {RX}  

F2 EXCH {TX}{ENTERLF} DE * TU 599 {EXCH} {EXCH} BK {RX}  

F3 TU {TX} ! TU {RX}  

F4 Call Him {TX} DE * * * K {RX}  

F5 1x1 {TX} ! DE * K {RX}  

F6 0x1 {TX} DE * K {RX}  

F4 Call Him {TX} DE * * * K {RX}  

F5 1x1 {TX} ! DE * K {RX}  

F6 0x1 {TX} DE * K {RX}  

F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} {EXCH} BK {RX}  

F8 Agn {TX} AGN AGN de * K {RX}  

F9 
 

F10 
 

F11 
 

F12 

 

 



When using the above keys it is assumed that ESM is on. The Run mode keys F5, F6 and F7 are not 

very useful when you are S&Ping, this is why I put those keys to better use by programming them 
differently from the Run mode keys.  
Note also that you can use up to 24 additional buttons (mouse only, no keyboard access) on the 

digital interface window. For example, you can set up 0x1, 0x2, 0x3 and 0x4 calls, single, double and 
triple exchanges, separate requests for his zone and state and repeats for your zone only and for your 
state only, and so on.  

73, Rich VE3KI  

3.2. Example RTTY where the time is part of the exchange (like ANARTS). 

 
In the following table only the keys that are different from the general example above are shown  

Button Caption Text sent  

RUN and S&P 
 

F2 Exch {TX}599 {TIME2} {TIME2} {EXCH} ! KN {RX}  

F7 Rpt Exch {TX} 599 {TIME2} {TIME2} {TIME2} {EXCH} {EXCH} K{RX} 

 
73, Rich VE3KI  
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2.5.1 Serial, Parallel and Sound Card Interfacing 

 2.5 Interfacing  

 2.5.1 Serial, Parallel and Sound Card Interfacing  

o 1. Avoiding RFI and Other Common Interfacing Maladies (work in progress)  
o 2. Ports Used for Interfacing  

o 3. Radio interfacing  
o 4. Interfacing for PTT and CW Keying  

 4.1. Choosing Your PTT Method  
 4.2. Parallel (LPT) Port  
 4.3. Serial (COM) Port  
 4.4. Using a transistor  
 4.5. Using an opto-Isolator (opto-coupler)  

o 5. Via USB port  
o 6. Additional Parallel Port Interfacing  

 6.1. Diagnosing Parallel Port Problems  
 6.2. External DVK Interfacing  

http://n1mm.hamdocs.com/tiki-index.php?page=Serial%2C+Parallel+and+Sound+Card+Interfacing&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=USB+Interface+Devices&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Hardware&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Rotator+Control&structure=N1MM+Logger+Digging+Deeper


o 7. Band decoder output  

 7.1. Sample configs  
 7.2. Sample Config > Antenna for two stacked antennas  

o 8. Bearing data  

o 9. Sound card interfacing  
 9.1. Preferred method  
 9.2. Another possible soundcard interface.  

o 10. Serial and Parallel port interfacing under Windows 2000/XP/Vista/Windows 7  
 10.1. Everything on one COM port  
 10.2. I need more serial ports  
 10.3. Renumber your serial ports  

 10.4. Exposing and Deleting Phantom Serial Ports  
o 11. Hooking up a Footswitch  

 11.1. Parallel port  
 11.2. Serial port footswitch information (using the 9 pin connector numbers)  

1. Avoiding RFI and Other Common Interfacing Maladies (work in 
progress) 

More often than not, reports of quirky, intermittent issues with radio control, CW and PTT interfacing, 

as well as hum and distortion in sound card audio, wind up being traced back to RFI - your own signal 
turning up where it doesn't belong. The following discussion is closely based on work done by Chuck 
Counselman, W1HIS. While it doesn't refer only or even specifically to N1MM Logger, it is good advice.  

2. Ports Used for Interfacing 

The program can interface with your radio using several ports from the computer. These ports are:  

 Serial port - A serial port can send CW, control PTT or communicate with your radio; with 
some radios you may be able to do all three on one port. Hardware serial ports are rapidly 

disappearing from most computers, but if the computer has open PCI bus slots. inexpensive 
serial and serial/parallel port cards are available. Alternatively, USB-to-serial adapters may be 

used.  

 Parallel port - Parallel (LPT) port interfacing is quite flexible. In addition to controlling CW and 
PTT, N1MM Logger uses the LPT port to control popular SO2R control boxes, and to send band 
information to a band decoder for automatic antenna or bandpass filter switching. Note that 

you will still need a virtual or hardware serial port for radio control.  

 USB port - Most computers now have multiple USB ports. USB-to-serial adapters can be used 
to provide full serial port capabilities, but be aware that not all such adapters (or their drivers) 
work well with N1MM Logger or other programs writen in Visual BASIC. See USB Interface 
Devices for specifics. There are also many different interface devices available that use USB 

port control for a full gamut of capabilities. See the chapter Supported Hardware for more 
information.  

 Sound card - N1MM Logger can use your computer's sound card to record your contest QSOs, 
and also to send stored audio messages to your transmitter in response to function key 

presses. For these purposes, it is best to find a computer or sound card that has separate 

microphone and line input jacks, as well as a line out jack. Some sound cards (particularly in 
laptops) now come with only two jacks, and the input jack is switchable between microphone 
and line levels. If this is the case, the obviously you will not be able to run your microphone 
through your sound card and record QSOs at the same time.  

 
For CW the parallel and serial ports are assumed to have the default addresses shown in the list 
below. These addresses can be changed in the configurer to match your Windows setup.  

http://n1mm.hamdocs.com/tiki-index.php?page=USB+Interface+Devices
http://n1mm.hamdocs.com/tiki-index.php?page=USB+Interface+Devices
http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Hardware


Serial and Parallel Ports 

Port  Hardware Address 

COM1  &H3F8 

COM2  &H2F8 

COM3  &H3E8 

COM4  &H2E8 

COM5  &H2F0 

COM6  &H3F0 

COM7  &H2E0 

COM8  &H260 

LPT1  &H378 

LPT2  &H278 

LPT3  &H3BC 

 

These addresses used in Windows can be checked in 'Control Panel > System > Device Manager > 
Ports (COM & LPT) > (Choose a port) > Resources > Input Output Range'.  

Nonstandard port addresses will not work for CW.  

 

Tip 

If you have one standard and one non-standard COM port, assign the non-standard to the radio, and 
the standard port to CW. 

3. Radio interfacing 

 

 



 
 
 

4. Interfacing for PTT and CW Keying 

4.1. Choosing Your PTT Method 

N1MM Logger offers multiple methods for controlling PTT on your radio. Unless you use VOX, or QSK 

on CW, you will need to select one of these methods, and your choice may vary depending on the 
mode you want to operate, your radio's capabilities and how you choose to use them, any existing 
interfaces or other PTT wiring done for use with other programs, and so on.  

The available methods are:  

 Hardware PTT - uses serial (COM) or parallel (LPT) ports. Software controls the state of 

individual lines on the port for PTT and CW (and in the case of the LPT port, additional SO2R-
related functions.). This requires a driver (INPOUT32) - see Installing the Software for 
specifics. Works with USB-to-serial adapters, but will not work with USB-to-LPT adapters 

except for the Piexx SO2RXLAT .  

 Software PTT - uses PTT (TX/RX) commands sent to the radio through the radio control port. 

For certain radios that incorporate a radio CODEC (effectively, a sound card inside the radio), 
if you wish to use it either for AFSK (digital modes) or as a voice keyer for SSB, you will need 
to use Software PTT. Check the Supported Radios section for your radio setup instructions. 

Software PTT is great with some radios, such as the TS-590, but with others, which require a 
longer delay between CAT commands, it will be slower than hardware or Winkey PTT. In the 

case of Icom radios, when a data collision is detected, the PTT may fail to actuate or hang in 
transmit, requiring an ESC to return to receiving. Also, please note that N1MM Logger cannot 
control a built-in DVK, as compared to a CODEC, because if the recorded message is not sent 
from the computer, the program cannot know when the recorded message has finished. Such 
DVKs must use VOX, for this reason.  

 Winkeyer PTT - uses PTT provided by the Winkeyer USB series of CW keyers, but also works 

for SSB. If a port is set up to control a Winkeyer, and PTT is set as the Pin 5 function on the 
Winkeyer tab in the Configurer, PTT is automatically active on the real-panel jacks of the 

http://n1mm.hamdocs.com/tiki-index.php?page=Installing+the+Software
http://www.piexx.com/
http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Radios


Winkeyer, and it needs only to be cabled to the appropriate jack on your radio. Winkeyer PTT 

is the most flexible of the PTT options, particularly on CW, because you can set the inter-
character "Hang Time" separately from the end-of-message Tail Time. The settings are on on 
the Winkeyer tab in the Configurer. If you chose to use one of the other methods for PTT 

control, simply omit this cable.  

 Digital Modes PTT - If using FSK, configure MMTTY to a COM port or EXTFSK for FSK keying, 
and also configure it for PTT on the same port. To use a radio CODEC for AFSK in digital 
modes, PTT must be handled by N1MM Logger using Software PTT (see above). For AFSK not 

using a built-in radio CODEC, use N1MM PTT options for other modes, or configure PTT in 
MMTTY. If you want to use the same COM port for PTT in digital and non-digital modes, then 
you must check "Digital" on that port in the Hardware tab of the Configurer, and configure 
MMTTY for PTT. This tells N1MM to close the port and hand it over to MMTTY when you switch 
to a digital mode.  

 
For CW, if you have a Winkeyer, Winkeyer PTT is recommended, because it gives you the most 

flexibility in setting hang and tail time. If you do not have one, but have a serial or USB port, 
Hardware PTT is probably the simplest. You can do this with a simple transistor switch off the 

appropriate line of a serial port or a USB-to-serial adapter. CW and PTT can be handled on a single 
port, and with some radios it may even be possible to do radio control on that port as well if the radio 
does not need the RTS and DTR lines to be set in a particular way (since these lines are used for CW 
and PTT. Software PTT may work fine, depending on your radio, and has the advantage of not needing 
any additional cabling.  

For SSB or digital modes, use any of the options above. Remember, if you are using your radio's 
audio CODEC, you will need to use Software PTT and omit COM or LPT hardware PTT control.  

 

N1MM Logger Does Not Support CW Keying by Audio Tone 

Almost daily, we get queries about why N1MM Logger's CW won't work with software or interface units 
that feed audio tones to a transceiver. Typically, this involves the Signalink USB interface or the 

software program FLDIGI.  

N1MM Logger does not and will not support this way of generating CW. There are a couple of reasons. 
First, on many transceivers, when they are in USB or LSB mode, you are precluded from using CW 

filters and other CW receiving aids. Second, sound-card CW is fraught with problems, including audio 
noise in your CW, RF interference to the CW tones, and the possibility of generating two or three 
separate CW signals due to audio harmonics. It's just a terrible idea!  

The simple interfaces described below are easily constructed at minimal cost with readily available 
components. 

.  

4.2. Parallel (LPT) Port 

 
This is a typical simple interface  

 
 

http://n1mm.hamdocs.com/tiki-index.php?page=Configurer#Configurer_gt_Winkeyer_Tab


 
 
 

LPT 
pin  

Function 

1 Strobe 

16 PTT output 

17 CW output 

18 Ground 

 

Note 

For hints on diagnosing problems with a parallel port, see the note under Addtional Parallel Port 
Interfacing just a bit further on. 

4.3. Serial (COM) Port 

DB9 

pin  

DB25 

pin  
Function 

7 4 PTT output (RTS) 

4 20 CW output (DTR) 

5 7 Ground 

 

Note 

The CW and PTT lines for a radio must be on the same serial/parallel port. Example: When COM4 is 

the CW Port and Radio 1 or Both is selected, PTT control for Radio 1 must also be on COM4. USB-to-
serial converters are supported, but USB-to-LPT (parallel) converters are not. 

4.4. Using a transistor 

 
 

 
 
 



 Equivalents for the 2N2222 are 2N3904, BC547 or BC548.  

 NB. It isn't a bad idea to add a 1 kOhm resistor from base to ground, also adding a shunt 
capacitor of 10 nF is highly recommended at the collector output to ground in order to prevent 
RF feedback to base and subsequent blocking.  

4.5. Using an opto-Isolator (opto-coupler) 

 
Some users prefer to use an opto-isolator rather than a transistor, in order to provide more protection 
for the serial port in the event of something going wrong downstream. In that case, however, two 
special considerations may apply:  

 You may need to place a diode in series with the input of the opto-isolator, to protect it from 

negative voltage swings on a standard serial port. Check the specifications of the opto-isolator 
you use to determine whether this is necessary.  

 Some opto-isolators may not pull their output "low" enough (close enough to zero volts) to 
switch PTT or CW on a given transceiver. In that case, appropriate "pull-down" measures must 
be applied.  

5. Via USB port 

 
Not all computers have serial ports anymore or not enough to control transceivers, packet, serial CW 

keying etc. In this case consider a USB to serial port adapter. Most of them do nicely control the radio. 
The problem with these interfaces is doing CW and/or PTT (and 5 bit codes). Test before or ask 
around if they work for radio control, CW or PTT control with your computer and radio! Also look first if 
drivers for your operating system are available.  

With N1MM CW will work with native serial ports and with USB-to-serial adapters. For perfect CW not 

dependent on Windows processes the answer is Winkeyer by K1EL. CW transmitted as normal ASCII 
characters via the serial port. A USB/serial adapter will work fine with K1EL, because it is standard 
serial communications. Check the Winkeyer manual for more information.  

In some cases PTT and CW keying may unexpectedly stop working when using a USB-to-serial 
converter. Check this Windows setting:  

 Control Panel; System Icon,  

 Hardware Device Manager Tab or button.  

 Expand USB Serial Bus Controllers  

 Highlight each USB Root Hub  

 Double click for Properties settings, Power Management tab,  

 Remove the check mark from 'Allow the computer to turn off this device to save power'.  
o The box is checked by default in most cases.  

 Reboot the computer  

 
A table giving evaluations by N1MM users of various USB-to-serial converters is in the References 
Section. Another overview of serial- to-USB converters can be found at the RTTY contesting page by 
AA5AU at: http://www.rttycontesting.com  

6. Additional Parallel Port Interfacing 

http://n1mm.hamdocs.com/tiki-index.php?page=USB+Interface+Devices
http://n1mm.hamdocs.com/tiki-index.php?page=USB+Interface+Devices


 

If the type of CW port chosen is LPT1, LPT2 or LPT3, and a hardware LPT port is used, additional 
information will be present on the chosen parallel port. In configurer select for which Radio the output 
has to be given on the selected port (Radio 1 or Radio 2). The BCD data on the LPT is that of the 

current active radio/VFO. The band data is available on multiple LPT ports — Radio 1 on LPT1, Radio 2 
on LPT2 and so on. USB-to-LPT converters are not supported.  

Parallel port pin layout  

LPT 
pin  

Description 

1  Return for PTT and CW output. This pin has limited sink capability, so you may need to buffer it 

2  
Band output (Least Significant Bit) set by Antenna tab in Configurer. This pin is also used to stop 
the message sent on the hardware DVK. 

3  
NA-compatible TX focus. - Radio 1/2 Pin 3 will go to a logic LOW level (0V) when Radio 1 has TX 
focus and to a logic HIGH level (5V) when Radio 2 has TX focus. (NB. LPT pin 3 is the 
complement of Pin 14). Set ONLY if no hardware DVK output is selected (msg# 1). 

4  
NA-compatible RX focus. LPT Pin 4 will go to a logic LOW level when Radio 1 has RX focus and to 
a logic HIGH level when Radio 2 has RX focus. Set ONLY if no hardware DVK output is selected 
(msg# 2). 

5  
(Shift+singlequote) to toggle for Stereo mono. LPT Pin 5 will go to a logic LOW level for mono 
audio and to a logic HIGH level for stereo audio. Set ONLY if no hardware DVK output is selected 
(msg# 3). 

6  Set ONLY if no hardware DVK output is selected (msg# 4). 

7  Band output set by Antenna tab in Configurer 

8  Band output set by Antenna tab in Configurer 

9  Band output (Most Significant Bit) set by Antenna tab in Configurer 

14  

Radio select A/B (transmit focus) for DX Doubler compatibility. LPT Pin 14 will go to a HIGH level 

when Radio 1 has TX focus and to a LOW level when Radio 2 has TX focus. (NB. LPT pin 14 is the 
complement of Pin 3) 

15  Footswitch input port 

16  PTT output, high = transmit mode 

17  CW output 

18-
25  

Return for Band output 

6.1. Diagnosing Parallel Port Problems 

 

Will all PCI-e Parallel Port Cards Work? 

As fast as technology moves, it is difficult to be categorical about this, and there has been some traffic 
on the reflector suggesting that some families of LPT port chips are not compatible with the software 
components used by N1MM Logger to control individual lines on an LPT port. Experimental results 
show, however, that two families of chips do work, as of February 2013: These chips are used both in 
single-port cards and in combination cards (2 serial and one parallel, for example), but have only been 

systematically tested in the one LPT port variant.  

 MOSChip Semiconductors series MCS9900. This company is now owned by Asix Electronics 

Corporation,. and the very latest driver can be downloaded here . Specify PCIe Bridge for 

http://www.asix.com.tw/download.php?sub=downloadsearch&PSNoID=110


the product family. These chips are used in the SYBA SD-PEX10005 1 Port Parallel Card, 

available from the usual online sources.  

 Oxford Semiconductor OX16PC952-954. This company's chips are used in several 1-port LPT 

cards, including the StarTech.com PEX1P, which also is widely available. Originally, they were 
thought to be incompatible with parallel port switching, but this does not appear to be the 
case (contact N4ZR for details). 

 

Diagnosing LPT Port Issues 

Recently, a number of users have encountered difficulty using PCI-e LPT ports to control band 

decoders, SO2R controllers, and other devices. After a great deal of experimentation, here are a few 
things to try if you have trouble.  

 

1. Make sure you have the correct address specified in N1MM's Configurer. Typically, PCI-e add-in 
cards seem to have I/O addresses that are not the standard ones for a given port number. For 

example, built-in LPT1 ports typically have an address of 0378 for our purposes, which is the lower of 
the two I/O addresses given for the port in Device Manager. On the other hand, 3 different PCI-e 
cards tested all have fixed I/O addresses at D000 and D010, regardless of the LPT port number, and 
the correct address is the higher one - D010. When in doubt, try them both.  

2. The first time you run N1MM Logger after a new installation, don't run it from a shortcut. Instead, 
go into the N1MM Logger directory, right-click on the executable (.exe) file, and select "Run as 

Administrator". It has been suggested that this step may be necessary in some cases, in order for the 
component that drives the parallel port to be registered properly, and it can't hurt.  

K8UT discovered a nifty parallel port test utility at here . The crucial thing it does is totell you-- if it 
cannot find a port at a given address. It's freeware, and can be used with a voltmeter or something 
controlled by the LPT port (like a band decoder), with N1MM Logger settings put aside for the moment 
it will quickly establish whether the port is working properly.  

6.2. External DVK Interfacing 

When you select DVK on a parallel port, antenna selection via that port is disabled, because the DVK 
pins and the antenna pins on the LPT port overlap. Following is the table of pin-outs for external DVK 
control:  

F1 pin 3  
F2 pin 4  
F3 pin 5  
F4 pin 6  
F5 pins 4 and 6  
F6 pins 4 and 5  
F7 pins 4, 5, and 6.  

When F1-F7 are pressed, a 100 ms. pulse is sent to the relevant pins for external DVK control.  

In order to record messages on an external DVK, you will need to connect your microphone to it 
directly, and follow the procedure outlined in the DVK manual; N1MM Logger support is limited to 
triggering the first 7 memories when the corresponding Function Key (F1-7) is pressed, and stopping 

stored message playback when the ESC key is pressed. Some external DVKs have as few as 4 
memories, in which case only F1-F4 will trigger playback.  

7. Band decoder output 

http://www.xlentelectronics.nl/


 

Pins 9, 8, 7 and 2 can be set using the Antenna tab in Configurer. The output on the pins will follow 
the selected code which is being set up by the selected antenna.  

 
 

 
 

 

7.1. Sample configs 

 
 

 
 
 

 

To replicate the default Top-Ten Devices behavior, you would need to set up the Antenna tab in 
Configurer as shown above to the left|  

It is possible to use more than one antenna per band with N1MM logger. With Alt+F9 it is possible to 
toggle between these antennas.  



NB. Don't forget to add a space after the comma when more than one band is specified (e.g., 7, 3.8, 
not 7,3.8)  

7.2. Sample Config > Antenna for two stacked antennas 

 
 

 
 
 

 
You will need to make appropriate provision with a diode matrix on the output of your band decoder to 
select the appropriate antenna or antennas when a given code is sent from the program to the 

decoder. For example, if your band decoder outputs positive voltage and you use a tri-band beam with 
a single coax feedline, you will need diodes to sum the three signals from your band decoder into the 
one feedline.  

8. Bearing data 

Bearing data for rotator control is currently not available on the LPT port.  

9. Sound card interfacing 



9.1. Preferred method 

 
It is better to run the mic through the sound card all the time. That way your audio sounds 
the same either recorded or live. It also lets you re-record cq's on the fly, something that is 
really needed for 40m and 80m split cqing. Check out "#1 - Zero or Single Card, One radio, 
No Sound Card SO2R " which can also be found with more examples in the SO2R section.  

 

 

 
 
 

 

Select '1 - Single Card - One radio, No Sound Card SO2R' on the 'Audio' tab in the Configurer and 
setup the top part of this dialog.  
The sound is centered rather than set to a radio channel.  

9.2. Another possible soundcard interface. 

 
This is NOT the preferred method any more!  

 
 



 
 
 

 A 8:1000 ohms transformer should be used when the sound card speaker output is used to 
the radio microphone input.  

 A 600:600 ohms (1:1) transformer should be used when the line output from the sound card 
is used to the radio microphone input.  

10. Serial and Parallel port interfacing under Windows 

2000/XP/Vista/Windows 7 

 
Windows 2000, XP, Vista and Windows 7 require a special dll, INPOUT32, which will be installed 
automatically by N1MM Logger to use the parallel ports.  

10.1. Everything on one COM port 

 
By Uffe PA5DD.  

Shared ports allow for example Radio control/PTT/PTT-interrupt/CW on just one COM port, which 
might be all you have on your laptop. It requires that you make a serial splitter or a common 
interface. There are some pitfalls though:  

 Radio control communication is without hardware handshake (as you are using the hardware 

control pins for other purposes). This is not a problem as such, since hardware handshake is 
not used by your radio. True at least for ICOM & YAESU.  

 Some interfaces wire RTS/CTS together to allow a PC set for hardware handshake to work 
properly. This link must be removed for port sharing, as it will generate a permanent PTT 

interrupt on the CTS pin. This will abort your messages as soon as you start them. Also DSR 
should not be connected to anything.  

 In some radio control serial level converters the handshake signals are used as power supply. 
This is not possible if both RTS & DTR are used for CW/Other. You will have to provide power 

supply from somewhere else (I use the PS/2 mouse port). Note that in this case you only have 
to split out GND TXD RXD for the radio control.  



10.2. I need more serial ports 

 
By Didier KO4BB  

Interrupts are the limiting factor to more than a handful of serial (com) ports. There are 2 ways to 
address that:  

1) You want to use "standard" hardware using Windows "standard" com port model, and as long as 
the software will let you select IO port and IRQ, and as long as you don't need parallel printer or 
floppy (and as long as your video card does not use IRQs also), and if the program lets you share 
IRQs (for instance, you don't need an IRQ for a serial port used to drive the PTT line), (that's a lot of 
if's!!!) you can probably cram 4 to 6 com ports into a single PC. Note that you may still have problems 

if you try to run high bit rate on all the ports at once (that should not be a problem with radio control 
though). Please note that the "standard" PC setup (and Windows) supports 4 com ports with only 2 
IRQs. Those who have tried know that you don't want to run high bit rate on COM 1 and COM 3 at the 
same time because they share the same IRQ.  

2a) You do away with standard hardware, and then you can use specialty boards that have 4, 8 or 
even 16 ports. However, these boards use communication processors so they only need one IRQ from 
the PC but your software needs to be aware of and be able to communicate with that processor, either 
through custom software, or through a driver for your OS (Operating System i.e. Windows), or both. 
That's what ISPs use to gang a bunch of modems to support more than a couple phone lines/modems 

with each PC. While these may have high communication rate capabilities (because the 
communications processor uses FIFOs, small memory buffers that store incoming data until the PC is 
ready to take it), they also offer higher latency (response time) than a native port, not ideal for CW, 
although with a fast PC, most users have been satisfied with this setup.  

2b) USB adapters fall in the category of non-standard hardware, but because USB is now built into the 
motherboard, the communication processor hardware is directly supported by the BIOS, and the OS 
has the proper drivers, so that has quickly become a standard. However, the USB standard was not 

designed to minimize latency, so a USB-serial adapter, while OK to talk to a radio via it's serial port, is 

not ideal to do things such as CW using bit twiddling. That should be reserved to native serial or 
parallel ports (motherboard or add-on card). USB adapters are probably a little worse (with regard to 
latency and CW capability) than custom communication processors described at 2a) because the USB 
adapters communicate with the PC through a serial link instead of being directly connected to the 
processor bus, so the bit twiddling has to be done though a serial link, which adds latency. In addition, 
since the USB port may be shared with other devices, accessing these other devices while sending CW 
would be a bad thing.  

Bottom Line: There are excellent USB combination interfaces now available that can control one or 
more radios, key them with Winkeyer, and even provide soundcard facilities.  

10.3. Renumber your serial ports 

 

As you install new serial ports (serial or USB devices) Windows may arbitrarily assign COM port 
numbers to them that are outside the COM 1-8 range of the N1MM Logger configuration menu. 
Reassign the serial/USB port to a different number. Here's how:  

1. Right click "My Computer"  

2. Left click on "Manage"  
3. Left click on "Device Manager"  
4. Look in the right window and find + Ports (COM & LPT)  
5. Left click on the Plus sign  
6. Right click on the COM17 line  



7. Left click on the "Properties" selection  

8. Left click on the "Port Settings" tab  
9. Left click on the "Advanced" button  
10. Select the COM Port Number you want in the drop down menu  

11. Click on "OK" a bunch of times to back all the way out  
12. Your serial/USB port number will now appear as the number you chose  

 
If you have more than one COM port, you can change them all by selecting each one in turn and going 
through this process.  

73 de Bob - K0RC in MN  

10.4. Exposing and Deleting Phantom Serial Ports 

There may also be some invisible serial port number assignments on your PC. Here is how to have 

Device Manager expose and remove them:  

1. Click on the Start button and select All Programs > Accessories.  

2. In Windows XP, Click on Command Prompt; in Windows Vista, 7 or 8, Right-click on 
Command Prompt and select the Run as administrator menu item.  

3. Type set devmgr_show_nonpresent_devices=1 and hit the Enter key.  
4. Start Device Manager. There are many different ways to do this; one is to right-click on 

Computer (or My Computer), select Properties, and then click on Device Manager. Another 
is to find Device Manager in the Control Panel.  

5. In the Device Manager window, select the View > Show Hidden Devices menu item.  

6. Click on the + sign next to Ports to see the full list of COM ports that have been assigned in 
your computer.  

7. Highlight an unused port number you wish to remove from the list and then press the Delete 
key. Accept when asked to confirm and continue with any more port numbers that you wish to 
delete.  

 
Thanks to KK1L and N7WY for this tip.  

11. Hooking up a Footswitch 

 
A footswitch can be hooked up to a serial and a parallel port. The footswitch program action is for both 
LPT and COM ports on switch closure.  

11.1. Parallel port 

 
If pin 14 is not used to switch radios using an external SO2R box (for example, by using the Pause 

key), then hooking up a footswitch to LPT1 can be done by connecting a 10k resistor from pin 14 to 

pin 15. Pin 14 is normally +5V and provides pull-up voltage for pin 15.. Then connect a normally open 
footswitch between pin 15 and pin 18 of LPT1. Closing the footswitch pulls pin 15 low and performs 
the function selected in the configurer.  

If pin 14 is being used for Radio A/Radio B control of an external SO2R box, a 5V supply with a 10k 
series resistor can be used to provide the pull-up voltage for pin 15.  

11.2. Serial port footswitch information (using the 9 pin connector numbers) 



Connect a 10k resistor between pin 6 and pin 7. Set DTR, pin 4 to "Always On" and RTS, pin 7 to 

"Always Off". Connect the footswitch between pins 4 and pin 6.  
The program action will be on footswitch closure. The footswitch wires can not be referenced or 
connected to ground.  

 

2.5.2 USB Interface Devices 

 2.5.2 USB Interface Devices  

 1. General Comments on USB to Serial I/O Interface Devices  
 2. User Evaluation of USB to Serial I/O Interface Devices for use with N1MM 

Logger  
 3. Sound Interfacing and USB External Sound Cards  

With the disappearance of serial and parallel ports on most new PCs, most N1MM Logger users are 
now forced to use USB interface devices to accomplish functions formerly performed using serial and 
parallel ports. These include consumer-grade USB-to-serial adapters as well as devices designed and 

manufactured specifically for amateur radio use. For the most part, with the help of software drivers 
installed when the device is first connected to the PC, these devices are configured in N1MM Logger as 
if they were true serial ports, with some important caveats and exceptions noted in the following 
sections.  

A separate category of USB devices is the "USB Sound Card", which are similar in function to on-board 
and bus-based sound cards except that its interface with the PC is through a USB port. Some devices 
aimed at the amateur community combine USB sound cards and USB-to-serial adapters in a single 
box. Some transceivers are now delivered with such USB devices incorporated internally. Generally 
speaking, once the appropriate drivers have been installed, these devices are configured in similar 
ways, regardless of whether they are in a transceiver or in a separate box or boxes.  

 

USB-to-parallel adapters generally will not work 

USB-to-parallel adapters will not work for keying CW or controlling PTT through the standard parallel 

port interface, because these adapters do not permit controlling individual lines. The only exception 

we are aware of is the SO2RXLAT by Piexx , which is designed specifically for this purpose. 

1. General Comments on USB to Serial I/O Interface Devices 

 
There are two different problems that are often encountered by N1MM Logger users trying to use USB-
to-Serial adapters.  

The first of these problems relates to the specific chipsets and drivers used in these adapters. The 
market for these adapters is dominated by two chipsets, called Prolific and FTDI. There is a potential 
problem with adapters using the Prolific chipset for serial communications (in particular, for rig 

control) from N1MM Logger. This problem only applies to actual serial communications; simple on-off 
keying of DTR and RTS for CW and PTT keying is not affected. There are several versions of the Prolific 
chipset (including counterfeit knock-offs), and also several versions of the drivers, and at least some 
of these drivers are incompatible with the Microsoft library routines used by N1MM Logger, DXLab 
Suite, Logger32 and some other amateur radio programs. The symptom is an error message with the 
error number 8020. The result is that with some combinations of Prolific chipset and/or driver 

software, adapters using the Prolific chipset may not work properly for rig control and similar purposes 
with N1MM Logger. Rather than attempting to list all of the possible combinations of chipset version, 
driver version and operating system in order to determine which ones work and which ones do not, 

http://www.piexx.com/


our simplest advice is to avoid using USB-to-serial adapters using the Prolific chipset for rig control, 
rotor control or similar serial communications purposes.  

The second problem relates to FSK RTTY keying from MMTTY. MMTTY can use a true serial port for 
FSK keying, by programming the port to send 5-bit characters at 45.45 baud. Unfortunately, most 
single-port USB-to-serial adapters, or at least those that are new enough to work with Windows 7, 
cannot go slowly enough to do 45.45 baud Baudot. Some multi-port adapters (two or four serial ports 

from a single USB port, e.g. Edgeport) are capable of going slowly enough, but if there are currently-
sold single-port adapters that can do direct FSK keying, they are few and far between.  

The standard solution to this is to use EXTFSK. EXTFSK does all the timing internally instead of using 
the serial port hardware. EXTFSK is capable of keying FSK on any of the TxD, RTS or DTR lines on any 
serial port or any USB-to-serial adapter, and even on a true parallel port (but *not* on USB-to-parallel 
printer adapters, which are incapable of bit-twiddling). There is a downside to using EXTFSK - the 
timing is less accurate than the hardware timing from a true serial port. This may result in a slightly 
less readable signal under difficult conditions.  

We are not aware of any USB-to-serial adapters that will not do FSK with the help of EXTFSK, nor are 
we aware of any USB-to-serial adapters that will not key CW or PTT on their DTR/RTS lines other than 
adapters that don't have any physical connections for these control lines (such as the Elecraft KXUSB 
which does not implement the DTR and RTS control lines and therefore cannot use DTR or RTS).  

2. User Evaluation of USB to Serial I/O Interface Devices for use with N1MM 

Logger 

 
First, a cautionary note, courtesy of Bob, W5OV:  

This is a good reference, but potential users should not get a false sense of security because someone 
else may have had success with a particular device. In other words, it's more than just the hardware; 
the success rate is also closely tied to what operating system you have, what revision of the driver 

you are installing for the device you are trying to use, and what other drivers you have installed 
previously (which could have been for something you no longer use or no longer have connected to 
the computer), and your computer's particular configuration in general.  

Drivers: One key thing to never do is to allow Windows to tell you that it already has the driver for a 
particular device - you should always install the driver that comes with your interface. Windows can 
misidentify these devices when you plug them in and Windows will let you fail by using the driver it 
thinks is correct - and most often Windows is dead wrong.  

Generally speaking, with XP you can use most any USB to serial device (Prolific or FTDI chipsets) as 

long as you do not have a conflict. When it comes to Vista or Windows 7, FTDI seems to be the only 
game in town for close to sure results (Editor's note - not all users agree with this characterization. 
See the table below.)  

Even with all of this, depending on what you have done with your computer previously, you may have 

problems. And again, the point of all of this is that the problems may have nothing to do with what 
hardware you are trying to use. It could be something left over by some earlier activity on your 
computer. That said, most installations of these devices goes well right from the start. When they do 
not, it can be very frustrating.  

A further technical note, posted on the N1MM Logger reflector by Joe, W4TV, concerns an easy way to 
tell whether a given adapter can handle 45.5 baud RTTY:  



Windows serial drivers set the data rate (baud rate divisor) with 14 bits of a "double word." That limits 

the max/min range of the driver/UART to 214:1 ... and any maximum rate higher than 512K will 
preclude operation at 45.45 bps.  

The lower rates are not a 100% guarantee of compatibility but the higher rate is a certain 
sign that EXTFSK or AFSK will be required for RTTY.  

Be sure to look at the numbered notes for each device - that's where you will find specific issues 
discussed. Also, please remember that this table is based on N1MM user comments, and we have no 
additional information. Please contact the evaluator for any further details.  

Device  Vendor  Type  Submitted by  CAT  CW/PTT  RTTY  Win Win Win 

(Name or 
model of 
Device)  

(Company 
Name)   

(E-mail Address)  
(RS-
232 rig 
control)  

(DTR/RTS 
works)  

(5 Bit 
45 
baud)  

XP  Vista  7 

USB to 
RS232 
with FTDI 
Chipset 

(note 1)  

? From UK  
USB 
to 
SIO  

q.g.collier@btinternet.com  Y  Y  ?  Y  Y  ? 

UC232A 

(note 2)  
ATEN  

USB 
to 
SIO  

paul@w8aef.com  Y  ?  ?  Y  Y  ? 

USB to 
Serial 

Cable 
(note 3)  

Belkin  
USB 
to 
SIO  

pgerhardt@hotmail.com  ?  ?  ?  ?  ?  ? 

USB2-
4COM-M 
(note 4)  

ByteRunner  
USB 
to 
SIO  

dave.n3rd@verizon.net  Y  Y  N  Y  Y  Y 

USB-COM-
CBL (note 

5)  

ByteRunner  
USB 
to 

SIO  

wc0v10@embarqmail.com  Y  Y  ?  Y  Y  Y 

Edgeport/4 
- 4 RS-232 
serial DB-9 
(note 6)  

Digi 
International  

USB 
to 

SIO  

yungthor@ca.rr.com  Y  Y  Y?  Y  Y?  ? 

USB-COM-
PL (note 7)  

EasySync Ltd.  
USB 
to 

SIO  

garyhess999@hotmail.com  Y  ?  ?  Y  ?  ? 

2U 4S Hub 

(note 8)  
Entrega  

USB 
to 
SIO  

n3tl@bellsouth.net  ?  ?  ?  ?  ?  ? 

USB-
RS232 

Adapter 
(note 9)  

HoseNose  

USB 

to 
SIO  

cx6vm.jorge@adinet.com.uy  Y  ?  ?  Y  Y  Y 

USB to 2 
port serial 
converter 
(note 10)  

IOgear 2  

USB 

to 
SIO  

lew@paceley.com  Y  ?  ?  Y  N  ? 

FT232BM 
(note 11)  

PI 
Manufacturing  

USB 

to 
SIO  

W1TR@ARRL.net  Y  ?  ?  Y  ?  ? 



Device  Vendor  Type  Submitted by  CAT  CW/PTT  RTTY  Win Win Win 

(Name or 

model of 
Device)  

(Company 
Name)   

(E-mail Address)  

(RS-

232 rig 
control)  

(DTR/RTS 
works)  

(5 Bit 

45 
baud)  

XP  Vista  7 

Gigaware 
6-ft. USB-
A to Serial 
Cable 
(note 12)  

Radio Shack  
USB 
to 
SIO  

pgerhardt@hotmail.com  Y  ?  ?  Y  ?  ? 

TU-S9 
(note 13)  

Trendnet  
USB 
to 
SIO  

lew@paceley.com  N  ?  ?  
   

Keyspan 
USA-19HS 
(note 14)  

Tripp Lite  
USB 
to 
SIO  

rojomn@charter.net  Y  ?  ?  Y  Y  Y 

USB 

Interface 
Cable 
(note 15)  

West 
Mountain 
Radio  

USB 
to 
SIO  

jeffnjr484@yahoo.com  Y  Y  Y?  ?  ?  ? 

Edgeport 
/8 - 8 RS-
232 serial 

DB-9 (note 
16)  

Digi 
International  

USB 
to 

SIO  

david_yahoo@levinecentral.com  Y  Y  Y  Y  Y  Y 

Valley 
Enterprises 
CT-62 
(note 17)  

Valley 
Enterprises  

USB 

to 
SIO  

N4JIK kd4lcr@gmail.com  Y  ?  ?  ?  Y  ? 

Sitecom 
CN-104  

Farnell.com  

USB 

to 

SIO  

pim@pa5pr.nl  Y  Y  ?  Y  ?  N 

US232-
R10 
1615838  

Farnell.com  
USB 
to 
SIO  

pim@pa5pr.nl  Y  Y  ?  Y  ?  Y 

16" USB 
PDA/Serial 

adapter 
(note 18) 

Dynex 
USB 
to 
SIO 

mike@n1ta.com Y Y Y Y Y 
 

 

Note 1: I have used these with both Vista and XP machines, both of which were able to find the 
appropriate drivers. The applications in question were the N1MM and SD logging programs, and I have 
also used the adapters with the original (pre USB) Winkeyer device, again with good results. 

http://www.usbnow.co.uk/p48/USB_to_RS232_with_FTDI_Chipset_(1.8M_Cable)/product_info.html

. Note: W4TV says that no current FTDI device will do 45.5 baud RTTY without EXTFSK 
because no current FTDI chipset will handle data below 300 baud.  

Note 2: I have a pair of Aten and one Prolific PL-2303 USB to serial port adapters. Currently I am 
using one of the Aten adapters with PL-2303 a driver.All adapters work fine on Vista64 
http://www.aten.com/products/productItem.php?pcid=2005010513171002&amp;psid=20070130144

911002&amp;pid=2005022316346005&amp;layerid=subClass7   

Note 3: No Joy. Driver by MFG CD-Rom was VERY difficult to install and also tried to find and use a 
newer one from the mfg website w/o success. Got the lights to flash on the device like it was trying 

http://www.usbnow.co.uk/p48/USB_to_RS232_with_FTDI_Chipset_%281.8M_Cable%29/product_info.html
http://www.aten.com/products/productItem.php?pcid=2005010513171002&amp;psid=20070130144911002&amp;pid=2005022316346005&amp;layerid=subClass7
http://www.aten.com/products/productItem.php?pcid=2005010513171002&amp;psid=20070130144911002&amp;pid=2005022316346005&amp;layerid=subClass7


but was not making the handshake and would time out the attempt to connect. 

http://www.belkin.com/IWCatProductPage.process?Product_Id=281230   

Note 4: Tested with Green Heron Everywhere software for control of their RT-20/21 rotator control 
boxes. Uses the FTDI chip set. Dave N3RD  

Note 5: Works fine with Vista and Win 7 64 bit. Be sure to avoid the Prolific chipset adapters. those 
either don't work or crash the OS. http://www.byterunner.com/byterunner/product_name=USB-COM-

CBL/user-id=/password=/exchange=/exact_match=exact . I downloaded the Win 7 drivers. It 
seems to be functioning OK. Tom - W4BQF  

Note 6: I can get mine to work fine on XP Pro but wile it installs in Vista and is recognized it will not 

set up serial ports without crashing the system. I use the Edgeport 4 port USB to serial and it works 
fine for FSK and rig control of a 765. Geo N4UA 
http://www.digi.com/products/model.jsp?lid=EN&amp;pgid=38&amp;pfid=25&amp;mtid=215&amp;a

mtid=215&amp;pm=Y   

Note 7: I had trouble with my first adapter (Prolific). Then I ordered an FTDI device from EasySync in 

the UK and it worked immediately. http://www.easysync.co.uk/   

Note 8: It requires a power source which is unmarked I have no specs and need all the help I can get 
(N3TL) www.entrega.com?  
Note 9: This adapter can also be plugged directly into any rig that has a 9-pin female serial port for 
interfacing, such as the Elecraft K3 or Yaesu FT-920. Compatible with 32 and 64-bit versions of: 

Windows 7, Windows Vista, Windows 2003, and Windows XP. 

http://hosenose.com/interfaces.asp#USB-RS232   

Note 10: Wasn't recognized by Vista. Purchased on Frys.com. Did work for Rig Control of FT1000MP 

under N1MM/Vista32 with K1EL USB Winkeyer. http://www.iogear.com/product/GUC2322/   

Note 11: Vintage 2003, 
http://www.pimfg.com/product_detail.asp?part=UN8BE&amp;child=N&amp;kwid2=2418 USB 

Devices&amp;keywordx=5744 USB Converter   

Note 12: Worked fine with N1MM, 

http://www.radioshack.com/product/index.jsp?productId=3120513#   

Note 13: Did NOT Work for Rig Control of FT1000MP under N1MM/Vista32 or with K1ELUSB Winkeyer. 
Prolific 2302 chipset. Purchased on Amazon.com. 

http://trendnet.com/products/proddetail.asp?prod=150_TU-S9&amp;cat=49   

Note 14: Get the Keyspan USB-19 or other Keyspan with same chip and your problems will all be 
solved. It was not worth trying to avoid spending $28 with shipping to get two reliable devices. 
Available at a very good price at Amazon and quick ship. 

http://www.tripplite.com/en/products/model.cfm?txtSeriesID=518&amp;EID=13384&amp;txtModelID

=3914   

Note 15: I've used the adapter from West Mountain Radio with great success on PTT and RTTY and it 
works for me. Web page states that FSK RTTY support requires MMTTY and EXTFSK software. 

(W1TR)http://www.westmountainradio.com/Image/StoreConfigs/usb2serial.htm.  W4TV says that 
based on study of the driver .inf file, he believes that this device may not function properly for radio 
control.  

http://www.belkin.com/IWCatProductPage.process?Product_Id=281230
http://www.byterunner.com/byterunner/product_name=USB-COM-CBL/user-id=/password=/exchange=/exact_match=exact
http://www.byterunner.com/byterunner/product_name=USB-COM-CBL/user-id=/password=/exchange=/exact_match=exact
http://www.digi.com/products/model.jsp?lid=EN&amp;pgid=38&amp;pfid=25&amp;mtid=215&amp;amtid=215&amp;pm=Y
http://www.digi.com/products/model.jsp?lid=EN&amp;pgid=38&amp;pfid=25&amp;mtid=215&amp;amtid=215&amp;pm=Y
http://www.easysync.co.uk/
http://n1mm.hamdocs.com/tiki-editpage.php?page=www.entrega.com
http://hosenose.com/interfaces.asp#USB-RS232
http://www.iogear.com/product/GUC2322/
http://www.pimfg.com/product_detail.asp?part=UN8BE&amp;child=N&amp;kwid2=2418%20USB%20Devices&amp;keywordx=5744%20USB%20Converter
http://www.pimfg.com/product_detail.asp?part=UN8BE&amp;child=N&amp;kwid2=2418%20USB%20Devices&amp;keywordx=5744%20USB%20Converter
http://www.radioshack.com/product/index.jsp?productId=3120513
http://trendnet.com/products/proddetail.asp?prod=150_TU-S9&amp;cat=49
http://www.tripplite.com/en/products/model.cfm?txtSeriesID=518&amp;EID=13384&amp;txtModelID=3914
http://www.tripplite.com/en/products/model.cfm?txtSeriesID=518&amp;EID=13384&amp;txtModelID=3914
http://www.westmountainradio.com/Image/StoreConfigs/usb2serial.htm.


Note 16: After installing MMTTY and N1MM on the new Win7 notebook, I plugged in the EdgePort/8 

and crossed my fingers. Windows recognized the device was connected and then went to Windows 
Update online and found the driver. It installed without issue and worked immediately with N1MM and 
MMTTY. It has a small but nice program that easily allows you to adjust which COMx maps to which of 

the physical ports on the device. I have the actual Com port selected in MMTTY's TX tab and not 
EXTFSK.  

Though I grabbed the /8 I would hope the /4 installs and works just as well, providing 4 serial 
connections. I participated in the Mexico RTTY contest this past weekend and the rig control via 1 
serial port to my Kenwood TS-2000 worked perfectly. The 2nd serial port is used for a RTTY FSK/CW 
connection to the ACC2 port on the Kenwood TS-2000 and that worked perfectly as well. - K2DSL  

Note 17: Per N4JIK, the CT-62 cable from Valley Enterprises Intl. http://www.valley-ent.com  would 
not work with the latest Prolific drivers from the company's website, but worked fine with a Yaesu 8x7 

series radio and a driver downloaded from Valley's web site . See note 2 for another success story 
using an adapter with the Prolific PL-2303 chipset. N4ZR spoke with Valley Enterprises, who advised 

that they obtained the driver from G4HFQ , a CAT software writer and hardware vendor in the UK.  

Note 18: Just to confuse things, this adapter has a Prolific chipset, according to Mike, N1TA.  

3. Sound Interfacing and USB External Sound Cards 

 
If you want to record your contest QSOs, or use stored messages in phone contests, you will need to 
interface your computer to the audio system of your transceiver.  

This requires a little thinking ahead. If you wish both to record QSOs and to use stored messages, 

then you will need a sound device (be it internal or external) that has both Line and Microphone 
inputs, and that is capable of duplex operation - that is, it can both record and play back at the same 
time. This is not a rare capability, or something found only on expensive sound cards, but something 
to check in choosing which card to buy.  

A more common problem, these days, seems to be sound cards - particularly those integrated into 
laptop computers - that have only a single input that can be used for either Line or Microphone, but 
not both at the same time. In those cases your best bet may be to get an external USB sound card. 
Again, it is not necessary to go high-end for this application, so long as both criteria above are met.  

Two external USB cards that have been tested with N1MM Logger are the Encore, sold by NewEgg 

here  .for under US$20, and the GWC, also sold by NewEgg at this URL  for about the same price.. 
The ByteRunner UA-580 also works fine. (Thanks, Joe W4TV for this info)  

 

2.5.3 Supported Hardware 

 2.5.3 Supported Hardware  

 1. Windows and External USB Peripherals  
 2. Green Heron Engineering Inc. - GH Everyware (rotator control)  
 3. Ham Radio Solutions - EZmaster  
 4. K1EL - Winkeyer  

 5. microHAM - microKEYER  
 5.1. Tentec ORION + "Mute mic on supported radios"  
 5.2. ICOM CI-v Intterfaces + Transceive on/off Features  
 5.3. N1MM can't read the RX frequency (shows as 0) - frequency 

shown fine in microHam router without N1MM logger  

http://www.valley-ent.com/
http://www.valley-ent.com/soft/radio/PL2303Vista3200.exe
http://g4hfq.co.uk/
http://www.newegg.com/Product/Product.aspx?Item=N82E16829180006
http://www.newegg.com/Product/Product.aspx?Item=N82E16829180006
http://www.newegg.com/Product/Product.aspx?Item=N82E16829126101%20%28GWC%29


 5.4. Truncation of Messages (When Using Winkeyer Keyer)  

 6. microHAM - MK2R/MK2R+  
 6.1. USB-only SO2R Support  
 6.2. Suggested Port Setup by Joe, W4TV  

 6.3. On-the-Fly Recording from within N1MM Logger  
 7. RigExpert  
 8. Top Ten Devices - Automatic Band Decoder and DX Doubler  

 8.1. Hardware Update: 'Both Ears on the Inactive Radio' versus 'Both 
Ears on the Active (or Run) Radio' from the Keyboard  

 9. West Mountain Radio - RIGblaster  
 9.1. CW and Digital Setup RIGblaster Plus  

 9.2. SSB Setup RIGblaster Plus  
 9.3. RIGblaster Advantage  

 9.3.1. Setting Up N1MM Logger with the RIGblaster Advantage  
 10. Transverters  
 11. Unsupported Hardware  

 11.1. CW Decoders  

 11.2. W5XD MultiKeyer  
 12. Other Hardware Information  

 12.1. USB Soundcards  
 12.2. Other Soundcards  
 12.3. External versus Internal Soundcards  
 12.4. Going Back from Serial Port Numbers Greater Than Number 8  

1. Windows and External USB Peripherals 

One word of caution about external (USB) sound cards ... and other USB peripherals.  

Windows can only address the "USB root hub" ... they are directly connected to the internal PCI bus. 
Windows will process data from all "Root Hubs" in a machine in parallel. However, all of the "child" 
devices are like leaves on a tree, each leaf which "grows" from the same "root" receives a time slot 
(generally 16 msec) in turn. If you have too many "leaves" on one root, the delay can become 
excessive and result in communications failures (time outs) with the controlling software (logger).  

This can be particularly problematical with some software that polls every 50 to 100 msec and will 
timeout if a response has not been received before the next poll interval. USB can easily handle the 

aggregate throughput (it will do something like 240 mb/sec) but the delays can be a problem if the 
software writer does not account for them.  

Be particularly aware of this issue if you use external hubs and add many devices - particularly 
devices like memory sticks and "thumb drives."  

73' Joe Subich, W4TV  

For much more information about specific USB to serial adapters and similar hardware, see 
USB Interface Devices.  

2. Green Heron Engineering Inc. - GH Everyware (rotator control) 

N1MM logger can send bearing information direct to the Green Heron GH Everyware software. N1MM 
logger must be configured to send rotor information over the network (using UDP packets). This can 

be done by editing the N1MM Logger.ini file. Information regarding this is given in the supplied 
documentation with the Green Heron software, which is bundled with Everyware Remote and Base 
hardware and not sold separately.  

Please refer to the Everyware documentation for further details.  

http://n1mm.hamdocs.com/tiki-index.php?page=USB+Interface+Devices


3. Ham Radio Solutions - EZmaster 

EZ Master is an LPT port and USB Device that interfaces your PC with several devices in your shack 
like radios, antennas, filters switching, microphone, headphones etc. Including PHONE, CW, RTTY, 
DIGITAL Mode interface and internal DVK, CW Keyer and SO2R switching.  

More information can be found on the Ham Radio Solutions website .  

4. K1EL - Winkeyer 

Winkeyer is an external keyer chip designed by K1EL and G3WGV, which combines full electronic 
keyer features with a serial interface to a computer. Winkeyer is intended to interface with compatible 
Windows software and produce CW from ASCII characters sent to it, avoiding CW timing problems 
caused by multitasking.  

N1MM Logger was one of the first Windows logging program to support Winkeyer, and it has become a 
favorite CW solution for N1MM Logger users. Serial or parallel port keying may work fine, particularly 
with faster computers, but using Winkeyer can enable you to get by with a slower machine or run 

other programs in conjunction with N1Mm Logger, while keeping your CW perfect. Stand-alone keyers 
are available, and the Winkeyer keyer chip is also used in multi-function interfaces such as Ham Radio 
Solutions EZMaster, RigExpert, and several microHAM interfaces.  

More information can be found on K1EL's website .  

A full explanation of setting up N1MM Logger to work with Winkeyer is found in the Configurer section 
of the N1MM Logger Manual.  

5. microHAM - microKEYER 

 

The authoritative source for information on configuring N1MM Logger to work with various microHAM 

products is the microHAM web site  which offers a variety of "Example Configurations". These 
configurations are also accessible through the Help menu of the microHAM Router software, under 
"Document Download."  

5.1. Tentec ORION + "Mute mic on supported radios" 

In the Configuration dialogs (Other tab) make sure that "Mute mic on supported radios" is *NOT* 
checked. If that is checked, N1MM mutes the microphone and turns on the AUX input during DVK 
operation. By design the microKEYER routes DVK audio to the microphone input.  

5.2. ICOM CI-v Intterfaces + Transceive on/off Features 

How to connect microHAM devices to N1MM logger and for example a SteppIR antenna which needs 

Transceive ON to know the radio frequency while N1MM logger likes to see Transceive OFF.  

 connect all of the CI-V devices in parallel (tip to tip, ground to ground)  

 turn off Transceive in the Icom rig  

 turn ON "polling" in microHAM Router  

 turn OFF "polling" in microHAM Band Decoder  

 
The microKEYER (Router) will poll only when the logging software is not (for example, Router will poll 

http://www.hamradiosolutions.com/
http://www.k1el.com/
http://n1mm.hamdocs.com/tiki-index.php?page=Configurer&structure=N1MM+Logger+Manual#Configurer_REAL_GT_Winkeyer_Tab
http://n1mm.hamdocs.com/tiki-index.php?page=Configurer&structure=N1MM+Logger+Manual#Configurer_REAL_GT_Winkeyer_Tab
http://www.microham-usa.com/support.html


even though N1MM logger does not). The Router polls will keep data flowing on the CI-V bus to allow 
the SteppIR and other similar hardware to stay "in sync."  

The microHAM Band Decoder will provide antenna switching (including support for multiple antennas 
per band with the appropriate external switch) according to your normal programming , provide drive 
for bandpass filters (several brands) and can do "format conversion" which will allow a Yaesu (Quadra, 
FL-7000) or Icom (IC-2KL, IC-4KL, IC-PW1) solid state amplifier to work with any other (supported 
Yaesu, Kenwood, Icom, or TenTec) radio.  

The same capability exists with non-Icom radios.  

5.3. N1MM can't read the RX frequency (shows as 0) - frequency shown fine in microHam router without 
N1MM logger 

N1MM polls for slightly different data than Router (VFO A and VFO B vs. "Current operating 
frequency") so Router "times out."  

Open Router | Control | Set and uncheck "Disable router queries" .  

5.4. Truncation of Messages (When Using Winkeyer Keyer) 

Symptom: Sends all the macro CW messages except the last letter and then goes back to receive. The 
solution is to add a space or the | character (the shifted \ character) at the end of the macro message. 
The | character is about 1/3 of a space.  

6. microHAM - MK2R/MK2R+ 

 To set up MK2R+ with N1MM using LPT control see: 

http://www.microham.com/Downloads/MK2R_N1MM_Setup.pdf  

 For a set-up using only USB see "USB-only SO2R.pdf" by N4ZR in the N1MM Logger area on 
Yahoo (http://groups.yahoo.com/group/N1MMLogger).  

 
Q. When I load N1MM logger the message shows: "Winkeyer v2 detected, Only Winkeyer v4 and 

higher are supported in N1MM."  
A. That's a Winkeyer initialization error of some kind which shows when the MK2R+ is not switched on 
when N1MM logger is started.  

Q. How many serial ports are needed by MK2R to fully work  
A. In any case, one only needs five ports for a fully functioning system with N1MM (Radio 1, Radio 2, 
PTT 1, PTT2, and Winkeyer). Any other functions (Packet, rotor control, etc.) do not need  
to be in the "first eight." MMTTY/Digital Interface will share a port with PTT (and CW if you are not 
using Winkeyer) ... and MMVARI or MMTTY in AFSK mode does not require a port at all. Even if/when 
the SO2R control signals get mapped to serial handshake lines or the software adds support for the 

microHAM control protocol (on a virtual port) one additional port will not push most systems "over the 
line" - although the ability to start the block of eight other than at COM1 would provide a bit of 

insurance. 
 
73, Joe, W4TV  

An example setup  

microHAM Router  

 VOICE Audio Switching for both radios: CmCmCm  



FT1000MP, Proset Plus plugged to front mic jack.  

N1MM Logger (6.10.9 or higher)  

 Configurer >Audio tab  
o 2 - Single Card - Two Radio, No sound card SO2R  
o Select Device = USB Voice CODEC  
o Select Input Line = Microphone  

o Select Line to Mute = Microhone  
o Recording bits = 16  
o Sampling rate = 22050  

 
Ctrl+Shift+Fx to record, Fx to playback.  

6.1. USB-only SO2R Support 

With USB-only SO2R support using the the MicroHam SO2R protocol, an LPT port to command various 
SO2R functions with the MK2R/MK2R+ is no longer needed.  

Designate a virtual COM port as your MK2R control port in N1MM logger. To do this, check the 
CW/Other box for the port, click on 'Set', and check the MK2R box on the port details dialog. Then go 

to the SO2R tab on the MicroHam Router, select Microham SO2R protocol with the "radio button", and 
identify the COM port in the drop-down list just below. Finally, if you want to use program-derived 
band data, on the ACC tab change the Radio 1 and Radio 2 options to "SO2R protocol controlled". If 
you want to control band decoders for two radios, you may need to wire up a new cable to get Radio 1 
data from pins 6-9 on the ACC connector, and Radio 2 data from pins 10-13.  

Record-on-the fly within the program is supported using USB-only.  

6.2. Suggested Port Setup by Joe, W4TV 

"The MK2R/MK2R+ operates very well with six total ports (I will use A - F to avoid particular 
numbers):  

MK2R/MK2R+ with 6 Total Ports  

Port  Connected Device 

COM 
A  

Winkeyer (it is best to assign Winkeyer to the "lowest" port to avoid loss of CW if another port 
is activated for CW) 

COM 
B  

Radio #1 (PTT and Footswitch is optional on this port) 

COM 
C  

Radio #2 (PTT and Footswitch is optional on this port) 

COM 
D  

Digital #1 FSK and PTT for Radio #1 (assign Radio 1) 

COM 
E  

Digital #2 FSK and PTT for Radio #2 (assign Radio 2) 

COM 
F  

MK2R (protocol port) 



 

A user who does not choose to do FSK (uses AFSK only) can survive with FOUR virtual ports as PTT 
can be enabled on each of the radio ports - even with radios that normally expect "handshake" - as 
the MK2R does the handshaking and frees both RTS/DTR lines for control functions."  

The COM D and COM E PTT settings (or the optional radio port PTTs) are necessary if you wish to use 
the built-in N1MM Logger "DVK" with PTT (rather than VOX). This does not mean that you have to 

designate COM 5 and 6 on the Ports tab as PTT - instead you can just make sure the PTT box is 
checked on your two FSK ports in Router. If you wish to use the MK2R's built-in DVK instead, you will 
need to check the "DVK" box on the port you are using for the MK2R.  

6.3. On-the-Fly Recording from within N1MM Logger 

In order to make on-the-fly recording with Ctrl+Shift+Fx work with N1MM and the MK2R+, there are a 
couple of unusual requirements:  

 if using the MK2R SO2R protocol (USB-only), you need to use MM 7.10.9 or later  

 If your computer uses the Realtek or Soundmax chips for its on-board sound, then you will 
need temporarily to set the USB Voice CODEC to be the default sound device in Windows and 
be sure to turn off all Windows sounds for the duration, also in the Control Panel. There's a 

glitch in the Realtek/Soundmax drivers that doesn't let mic audio get through to the MK2R+'s 
USB Voice CODEC (which it uses to record and play Function Key messages) unless you do 
this.  

7. RigExpert 

When installing drivers for RigExpert Std or Plus, it creates 4 virtual COM Ports on your computer 
along with USB Audio Codec (for its internal sound card). Some users of the RigExpert TI-5 interface 
have reported that the 4th virtual port, for FSK keying, does not work with MMTTY. It is still possible 
to key FSK RTTY, using the 2nd virtual port (PTT/CW/SoftFSK) using the version of EXTFSK supplied 
with the RigExpert, and configuring MMTTY to use EXTFSK.  

Click on "Show Serial Ports" (ListRE program which comes with RigExpert software) and write down 

COM port numbers for CAT and PTT/CW for future reference.  
Then run your N1MM. (Make sure you are not running other logging programs at the same time to 
avoid port conflict).  
Go to Configure and click on Configure Ports, Telnet Address, Other. Click on Hardware. You will see a 
selection of COM port from COM 1 to COM 8. Select the proper COM port number for CAT (the one you 
memorized before), select your radio model and in Details select the proper parameters for your radio 
(baud rate, etc.). Then select proper COM port number for CW/PTT (check CW/PTT) and in the details 

set DTR to CW and RTS to PTT. If you are using RigExpert Plus, then you may also set a separate COM 
port for Winkeyer.  
If you want to use RigExpert as your Sound card (for SSB messages or RTTY) you may go to Audio 
(under the same Configurer menu) and select USB Audio Codec as you Sound Device.  
Please keep in mind that N1MM only accepts COM port number from 1 to 8. So if upon RigExpert 
installation you were given higher COM port number, then you should go to Windows Device Manager 

and change it.  
Also, don't forget that you can not run two programs that using USB Interface, at the same time.  

If you have older RigExpert - SD or 2.2, you still may use it with N1MM, just need to install additional 
driver (REAUDIO).  

When RigExpert SD is used with N1MM for Voice Keying, in the Configurer's Audio select "RigExpert" 
as a Device. Then configure the Recorded wav file path in the "Files".  
The older RigExpert models,need to have REAUDIO installed. For newer RigExpert models REAUDIO is 
not needed "USB Audio Codec" in the "Select Device" menu should be seleceted.  

8. Top Ten Devices - Automatic Band Decoder and DX Doubler 



 

To replicate the default Top Ten Devices behavior, you would need to set up Configurer >Antenna tab 
as shown in the Interfacing section.  

8.1. Hardware Update: 'Both Ears on the Inactive Radio' versus 'Both Ears on the Active (or Run) Radio' from 
the Keyboard 

 
I wanted to go one better and mimic the "PTT" operation of the DXD, which puts both ears on the 
INactive radio for aggressive S&P, but still be able to put both ears on the Active (or Run) radio from 
the keyboard, to help pick up weak answers to my CQs while HC8N is blasting on the S&P radio at S9 
+40. You can do this manually by switching the DXD audio mode switch from PTT to Auto, but I'd 
rather keep my hands on the keyboard.  

After corresponding with George, W2VJN and Dave, N3RD, of Top Ten, and entirely thanks to them, I 
have it working. I also owe a vote of thanks to Terry, N4TZ/9, whose article in September/October 

NCJ describes modifying the DXD to do the same trick, but with a footswitch, and got us all thinking.  

First, put the DXD jumpers (2) in their CT/Writelog/TR/MM position. This has the effect of isolating pin 

5 of the LPT port. Then put a 2N2222 open collector switch between pin 5 and the Auto terminal of S3 
on the DXD (that's the audio mode switch). Specifically, pin 5 drives the base of the transistor through 
a 1K resistor connected to the high side of R22, just like the basic CW keying interface. The emitter is 
grounded to the ground side of R22, and the collector is wired to the switch side of R29. I mounted 
the transistor next to R22 with double-sided tape. Ugly but effective. That's all there is to it.  

 

DX Doubler on port other than LPT1 

When using the DX Doubler on a port other than LPT1 check out the proper addresses. 

 
73, Pete N4ZR  

9. West Mountain Radio - RIGblaster 

9.1. CW and Digital Setup RIGblaster Plus 

Inside the RIGblaster Plus set the following jumpers on the P5 jumper block: D9 and D12, 
corresponding to RTS on PTT and DTR on KEY. Switch the port on which the RIGblaster is set from 
DIGITAL to OTHER. In N1MM's configuration use DTR (pin 4) set to CW and RTS (Pin 7) set to PTT. 
Using this configuration, everything works properly generating CW from N1MM and furthermore, this 
combination will allow the other soundcard related things to work (MMTTY, SSTV, PSK, Voice Key 
Express, etc). (by David, K1TTT)  

 

CW key down problem and RIGblaster Pro 

When your radio in CW stays in key down position try setting DTR to CW 

9.2. SSB Setup RIGblaster Plus 

 Serial port setup (configurer)  

o Com2 (any com port will do)  
o DTR: Always OFF  
o RTS: PTT  

 On the RIGblaster itself  

o Set the Tx/Auto switch to Auto.  



 Sound Volume Level  

o Use your soundcards volume control 

With it set up this way, it correctly mutes the microphone while transmitting a wav file and the VOX 
works when not transmitting a wav file.  

9.3. RIGblaster Advantage 

A number of our users have experienced difficulty setting up the RIGblaster Advantage to do various 
modes. The following is based on information from West Mountain RadioÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢s 
support department, but any errors are ours alone.  

When you load the RIGblaster driver onto your computer (we wonÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢t document 
that process here, because it is well covered in the Advantage manual), you will see a new virtual 
COM port and a new USB Audio Device reflected in your computerÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢s Device 

Manager. Make note of the COM portÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢s number. If it is not in the range 1-8, 

youÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢ll need to move it there for use with N1MM Logger. That procedure, too, is 
in the Advantage manual  

The virtual COM port can be used for PTT using RTS), CW or FSK (using DTR) keying, and control of 
your radio. The USB Audio device (called ÃƒÂ¢Ã¢â€šÂ¬Ã…â€œRIGblaster Advantage 
AudioÃƒÂ¢Ã¢â€šÂ¬Ã‚Â• in Device Manager) has both playback and record channels, and can be 
specified anywhere you are asked to specify a sound card.  

Control of your radio is available from the Advantage in one of two forms ÃƒÂ¢Ã¢â€šÂ¬Ã¢â‚¬Å“ an 
RS-232C level DB-9 connector, and a TTL level 3.5mm stereo jack. The TTL jack (labeled CTL IN/OUT) 
is suitable for controlling radios that use TTL-level control - such as Icom's CI-V remote jack and the 
8-pin mini-din CAT jack found on some Yaesu models. It is not suitable for driving older Kenwood 
radios which employed a "negative TTL" scheme (such as the TS-440S and TS-850). Your best bet in 
this case is to buy or build an adapter to convert the Kenwood control setup to basic RS-232.  

The AdvantageÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢s RS-232 port can drive many RS-232C equipped radios with 

one proviso - the transceiver must not require hardware flow control. Otherwise what happens is that 
the radio holds RTS high and the Advantage will be stuck in transmit.  

Many Yaesu radios have a menu option "CAT RTS" which can be disabled - this will get CAT working 
on those radios with just a straight serial cable between the Advantage and transceiver.  

The FT-847 actually requires a null-modem cable but this is the only radio WMR knows of which does. 
Because the FT-847 does not require flow control this works fine with the Advantage.  

Kenwood radios without the ability to disable flow control require a modified serial cable which shorts 
RTS/CTS at the radio end, to fool the radio into believing flow control is active. This works in practice 
on most radios we have tried it with, but has not been tested with N1MM Logger. A more elegant 
solution is just to use a separate USB to RS-232C adapter cable, giving you a second virtual COM port 
in Windows which is dedicated just to radio control. In this configuration, the Advantage COM port is 
used only for PTT and CW keying.  

The Advantage has a 3-position toggle switch on the front panel to determine how PTT is handled. In 
the "COM" position, PTT is under the control of the RTS line of the AdvantageÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢s 
virtual COM port. The center position, ÃƒÂ¢Ã¢â€šÂ¬Ã…â€œOFFÃƒÂ¢Ã¢â€šÂ¬Ã‚Â•, disables PTT and 

CW through the Advantage. The third option is ÃƒÂ¢Ã¢â€šÂ¬Ã…â€œVOXÃƒÂ¢Ã¢â€šÂ¬Ã‚Â•, which is 
derived from the audio signal itself in phone and data modes using AFSK.  



Remember that if N1MM is configured for PTT by radio command, the Advantage has no way of 

knowing this and will not go into transmit even though the radio does. Always make sure that PTT is 
done by RTS if under serial port control, or use the VOX position if using PTT via radio control.  

In summary, most radios can be set up for PTT (using RTS) and CW/FSK keying (using DTR). As long 
as the radio has either an 8 pin round mic jack or an RJ-45 mic jack it will work, because this is how 
audio and PTT get to the radio. For many radios, CAT can be achieved with a simple cable. For radios 

equipped with RS-232C jacks and which insist on flow control it is probably just simpler to use a 
separate USB to RS-232C cable.  

9.3.1. Setting Up N1MM Logger with the RIGblaster Advantage  

Now we get to the easy part. Go to Config > Configure Ports, Mode Control, Audio, Other. Open the 
hardware tab.  

 

Select the virtual COM port number you will be using for radio control. Select your radio from the 

drop-down list. Click ÃƒÂ¢Ã¢â€šÂ¬Ã…â€œSetÃƒÂ¢Ã¢â€šÂ¬Ã‚Â•. Do not select PTT via Radio 
Command. Make sure the communication parameters match between the program and your radio 
(found in its manual). If you are using just a single COM port for all functions, set DTR to CW and RTS 
to PTT, check the CW/Other box and youÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢re done.  



 

 
If your radio wants hand-shaking, then by all means, use a second USB-to-serial adapter dedicated to 
radio control. Be sure to configure RTS and DTR on this COM port to the handshake settings your radio 

wants. Then go to the AdvantageÃƒÂ¢Ã¢â€šÂ¬Ã¢â€žÂ¢s COM port, check its CW/Other box, and click 
ÃƒÂ¢Ã¢â€šÂ¬Ã…â€œSetÃƒÂ¢Ã¢â€šÂ¬Ã‚Â•. Set DTR on that port to CW, and RTS to PTT, check the 
"CW/Other" box, and you should be ready to go.  

 

10. Transverters 



N1MM logger has transverter support in the form that per bandmap an offset frequency can be set. 

Right click menu bandmap and select Set transceiver offset frequency. Enter the transceiver offset 
frequency in kHz (minus is allowed). Example: 116000 when using a transverter from 28 MHz to 144 
MHz (144000 - 28000 = 116000). The same for other bands (up or down). This can be set per 

bandmap so when using two transceivers with transverters they can each be on a different band. The 
offset is saved by the program so after a restart the offset is still there.  

11. Unsupported Hardware 

11.1. CW Decoders 

No CW decoder is built in nor any external CW decoder is supported.  

11.2. W5XD MultiKeyer 

The W5XD MultiKeyer is not supported and there are no plans to do so. SO2R support is provided by 

sound cards and Winkeyer or by other external hardware using serial and parallel ports.  
Winkeyer kits can be purchased very cheap and the logging program can do SO2R switching for CW 
with a single sound card. See the SO2R chapter. Scroll way down, and look for the picture of the #3 
SO2R CW configuration. Two sound cards are needed for full SSB SO2R (#4 SO2R).  

12. Other Hardware Information 

All by Joe Subich, W4TV  

12.1. USB Soundcards 

The manuals for the soundcards below (in alphabetic order) indicate they have independent 
microphone and stereo line inputs.  

 Audigy 2NX External  

 Creative SoundBlaster MP3+  

 Turtle Beach "Audio Advantage Roadie"  

 
The "low price option" below does not have an on-line manual but the specs on the web site show 
separate mic and line jacks.  

 Byterunner UA-580  
o appears to be the recommendation for those who need an external sound card (laptop, 

etc.).  

12.2. Other Soundcards 

 SoundBlaster Live 24 External  

o The one issue with the Live 24 External is that you cannot use the mic and line inputs 

at the same time (connecting the mic will disconnect the line). It will work fine for 
internal DVK in N1MM but you cannot "record QSOs" and use DVK at the same time if 
you loop the microphone through the Live! 24 External.  

12.3. External versus Internal Soundcards 

There are claims that External USB soundcards work substantially better (and should be used) than 
internal soundcards (on digital signals).  



Joe, W4TV: The claimed "advantage" comes from flawed tests which fail to properly set the input level 

to each sound device to take maximum advantage of its dynamic range. 
 
Except for the very worst sound cards or exceptionally noisy systems, internal sound cards have at 

least 60 dB of usable dynamic range (the better 16 bit cards have 80 dB of dynamic range and 24 bit 
cards with high level inputs can have dynamic ranges that approach 100 dB). If the audio from the 
transceiver is such that the receiver noise floor (no antenna) is six to ten dB above the noise floor of 
the sound card, the software DSP (MMTTY, etc.) will be able to operate at its full capacity. Receiver 
AGC, etc. will limit the receiver output to a level well below the input capacity of the soundcard. Most 
receivers will not vary more than 30 to 40 dB from quiet band to S9 +40 dB receive signals. 
Soundcard performance is not a matter of internal vs. external. It is a matter of careful attention to 
setting the proper level to allow the soundcard to function properly.  

12.4. Going Back from Serial Port Numbers Greater Than Number 8 

When using USB-serial converters some of them start up with serial ports numbering beyond 8. When 

this happens it is possible to change the serial port number to something less than Com 8. Go to 
Communications Port Properties, Port Settings Tab, then click on Advanced. There is a pull-down in 

the Advanced window that allows the setting of the port number. If all ports COM1 - COM8 are used 
then find out what devices  
are using them and reconfigure or uninstall those devices to free up the ports. Windows will "reserve" 
COM ports for devices that are disconnected so it will take some detective work.  

 

2.5.4 N1MM Rotator Control 

 2.5.4 N1MM Rotator Control  
 1. Rotator Control Basics  

 1.1. File Menu Selections  
 1.2. Button and Mouse Assignments  

 1.3. Sending Rotor Position Information to N1MM Logger  
 1.4. Using N1MM Rotor Stand-Alone  
 1.5. Using N1MM Rotor with the Main N1MM Logger Program  
 1.6. One Rotator Per Radio - how to do it  
 1.7. N1MM Rotor running on another computer  

 1.8. Turning a Stack  
 1.9. Run time error: 126  

 2. Using external software  

Rotator control by N1MM Logger is supported using  

 External software  
o N1MM Rotor (comes with N1MM logger)  
o LP Rotor (freeware by Larry Phipps - N8LP)  

 External hardware  

o ARSWIN by EA4TX  

 
 
Rotators can be controlled in several different ways:  

 Entry window:  
o by entering a beam heading in the callsign field and press Alt+J. The rotor will turn to 

the entered beam heading  
 Example:234 Alt+J will turn the rotor to 234 degrees  



 The number must be numeric, >= 0 and <= 360  

o using the menu items in the Tools menu  
 Turn Rotor Alt+J - Turn rotor to bearing for the callsign in the Entry window  
 Stop Rotor Ctrl+Alt+J - Stop turning the rotor when turning and no bearing 

in callsign field in Entry window  
o using the short cut keys below:  

 Alt+J - Turn rotor to bearing for the callsign in the Entry window or to the 
callsign in the callframe (when callsign field is empty)  

 Alt+L - Turn rotor to long path bearing for the callsign in the Entry window  
 Ctrl+Alt+J - Stop turning the rotor when turning and no bearing in callsign 

field in Entry window  

 Bandmap window: by right clicking on a spot and select: 'Turn Rotor'  

 Available Mult's and Q's window: by right clicking on a spot and select: 'Turn Rotor'  

 N1MM Rotor stand-alone program  

 
Some remarks  

 If there is a call of less than three characters in the callsign field in the Entry window nothing 
will happen.  

 The status bar will show the bearing it will turn to. Example: Turning Rotor to 123 degrees  

 Normally the rotor will turn to the country bearing after a callsign is entered. This info comes 
from the country file and mostly is the center of the country. In grid square contests however 
that is mostly not practical so when a grid is entered the rotor will turn to the calculated 
bearing between the own grid and entered grid square.  

1. Rotator Control Basics 

N1MM Rotor has the ability to control up to 16 rotors per station, and to control rotors connected to 
other computers on your LAN. N1MM Rotor leverages the Antenna tab to define what rotators are 

controlled when you are on a band. N1MM Rotor can even rotate a stack with one command. N1MM 
Rotor is an external program which can be used from within N1MM Logger or as a stand-alone 
program.  

 
 
 

Supported Rotator Types 

 DCU1 - No Stop button supported. 

 M2 Orion - Speed shown to bottom right of 

status bar. 

 Prosistel 

 AlfaSpid 

 Yaesu 

 RC2800P-A 

 Rotor-EZ 

 AlfaSpid ROT2 

 Prosistel C 

 Green Heron RT-21 (use DCU-1 option or 
Rotor-EZ setting) 

 
All rotators except the DCU1 support position 
reporting. It would be worth trying the Rotor-EZ 
setting with other rotators that use the DCU-1 
protocol or a superset of it, because the antenna 



position may be reported in the Rotor window. 

Upper pane: The upper pane shows the selected rotator (as entered in the Setup under Tools) and 

behind the @ the current rotator position. 
 
Menu bar: Shows the File, Tools and Help menus.  

The big digits indicate the current rotator position. When an antenna offset has been entered this will 
be shown in small digits to the right of the current rotator position.  
More to the right a visual indication where the rotator is pointing. The line in the circle can be dragged 

to turn the rotator, for rotators that support position reporting.  
The textbox is an entry field where you enter the bearing the rotator is to be turned to.  
Clicking the Turn button will turn the rotator to that position, and the Stop button will stop turning the 
rotator at the current position.  
A reverse offset will be shown as (R) .  

Status bar: Shows the speed when reported by the rotator.  

The program will be brought to top when turning (unless minimized)  

1.1. File Menu Selections 

 File  

o Always on Top - Select to have the program always on top  
o Exit - Exit the program  

 Tools  
o Setup Rotors - a dialog named 'Rotor Setup' will be displayed as shown below  



 

 

o Set Current Antenna Offset  
 The offset is entered on the antennas tab of the Configurer, or can be entered 

for the selected rotor. This offset is added to the rotor position to determine 
the antenna position. This is useful for antennas that are mounted at 90 
degrees for pattern interference reasons, or for antennas that have simply 

turned some in the wind over the winter  
o Set Current Antenna Bidirectionality  

 Bidirectional is for dipoles, or SteppIr's where the user wants to reverse the 
antenna rather than turn it more than 180 degrees  

o Calibrate Rotor - Calbrate the rotator. Only when supported by the rotator like the 
M2 Orion  

o Prosistel C Config  

 A dialog will open where you can set the rotator stop to North or South and 
the delay of the characters  

o Set rotation limits  
 This feature is for owners of rotators with brakes that jam. You may enter a 

number which will restrict how close the rotator will be turned to 0 or 360 
degrees. If you enter 10, the limits will be 10 to 350 degrees. Note that this 

can only be set for all rotators handled by an instance of the program. It didn't 
seem worth adding it to the antenna tab  

o A new line will be shown for every rotator that has been set up  



 Each line represents a rotator as entered in the setup under Tools  

 Help  

o Help - Shows the help file for this window  
o About - Gives the version of the N1MM Rotor program  

1.2. Button and Mouse Assignments 

 Manual entry field - Type a heading and press Enter or the Turn button to turn the rotator. 

The entered number is in degrees.  
o Maximum: 450 and minimum 0. An error message will appear when entered otherwise 

when pressing the Turn button.  

 Turn - Click to turn rotator to heading in textbox. Pressing Enter will also turn the rotator.  

 Stop Alt+S - Press to stop rotator turning. Pressing Alt+S or Escape will also stop turning the 
rotator.  

o This button is only shown when the rotator supports this feature.  

 F1 - F10 - Pressing the F-keys mapped to the bearing buttons will turn the rotator to the 
position as shown on the button. Right click to set the heading value.  

 Bearing buttons (F1 - F10)  
o Left mouse button click  

 Pressing one of the bearing buttons will turn the rotator to the position as 
shown on the button.  

 The F-keys F1 through F10 are mapped to the 10 bearing buttons.  
o Right mouse button click  

 Set Button to Current Position  
 The heading as entered in the manual entry field will be used to set 

the position.  
 Set Button to a Specific Heading  

 A dialog will appear and a frequency can be entered which will used to 
set the position.  

 
Only rotators that report position will be able to show the current position (also when rotating).  

1.3. Sending Rotor Position Information to N1MM Logger 

By default, N1MM Rotor sends position information only to the N1MM Logger main program that is 

running on the same computer as N1MM Rotor. If you are using only one computer, with both N1MM 
Rotor and N1MM Logger running on that computer, you can skip the rest of this section, but if N1MM 
Rotor is running on a different computer from N1MM Logger, you need to read on.  

If you want to send position information to copies of N1MM Logger running on other computers, you 
must use a text editor to manually edit the N1MMRotor.ini file in order to tell N1MM Rotor which 
computers to send the information to. Look for the line "RotorReportingIP" in the [Rotors] section; if it 
doesn't exist, you will have to add it.  

If all of the computers in the network are in the same subnet, i.e. they all have IP addresses that start 
with the same three numbers, such as 192.168.1.xxx, then you can send position information from 
N1MM Rotor to all of the computers in the network simply by setting RotorReportingIP to the 
broadcast IP address (last number = 255), as in:  

[Rotors]  
RotorReportingIP=192.168.1.255  

If you only want to send position information to certain selected computers on the network, you can 
specify one or more individual IP addresses, separated by spaces. For example:  



[Rotors]  
RotorReportingIP=127.0.0.1 192.168.1.10 192.168.1.12  

This will send rotor position information from N1MM Rotor to N1MM Logger running on three 
computers: the same computer that N1MM Rotor is running on, which is always denoted by 127.0.0.1 
regardless of which subnet it is in, and two additional computers whose IP addresses in this example 
are 192.168.1.10 and 192.168.1.12. Other computers in the network whose addresses are not 

specified in the N1MMRotor.ini file will not receive the rotor position information. The IP addresses do 
not all have to be in the same subnet, but of course they must all be reachable from the computer 
that N1MM Rotor is running in.  

 

1.4. Using N1MM Rotor Stand-Alone 

Go into the N1MM program directory with Windows Explorer and find 'N1MMRotor.exe'. This is the 

N1MM Rotor program. A shortcut on the desktop would be an easy way to start the program. All 
features mentioned above can be used.  

1.5. Using N1MM Rotor with the Main N1MM Logger Program 

Configure your rotors using the N1MM Rotor standalone program, as shown in the previous section. 
Verify that the rotors work correctly.  

The N1MM Logger main program has the capability to turn rotors from the Entry Window, as described 
earlier. To configure this capability in the N1MM Logger main program:  

 Setup the antenna selections in the Configurer; Tab: Antennas  

 
N1MM logger setup dialog in >Config >Configure Ports, Antennas tab  



 
 
 

 

The alphanumeric name in entered in the Rotor Description in the Configurer Antennas tab, must be 
exactly the same alphanumeric name entered in the N1MM Rotor Setup form.  

The N1MM Logger main program also has the capability to display the current direction of any rotor 
used by the controlling station, or any rotor in the network. To configure this capability, use the 
checkboxes "Display Rotors Used By This Station" and "Display Rotors Responding From Network" in 
the Configurer Antennas tab. A new display form will appear for each responding rotor:  

 



When "Display Rotors Used By This Station" is enabled, only the rotors used by the currently active 

bands in the Entry Window(s) will be displayed. When you change bands, the displayed rotors will be 
automatically updated.  

When "Display Rotors Responding From Network" is enabled, all rotors that report their position to the 
computer, from any N1MM Rotor running on the network, will be displayed.  

To start N1MM Rotor automatically from within the N1MM Logger main program, use the checkbox 
'Start N1MM Rotor Program' in the Configurer Antennas tab.  

1.6. One Rotator Per Radio - how to do it 

Occasionally, we get questions about how to relate a rotator to a specific radio or VFO, in SO2R - so 
that when you enter a callsign in that radio's Entry Window, the rotator for that radio's antennas 
receives the command.  

The answer is simple - On the Antennas tab of the Configurer, define the antennas for the second 
radio as if they were alternative antennas for a given band, and specify the desired rotator's COM port 
. Then, while the second radio's Entry Window is active, hit Alt+F9. You only need to do this once, 
each time you change bands on the second radio. See this page for more on configuring more than 
one antenna for a given band.  

1.7. N1MM Rotor running on another computer 

Let's assume that N1MM Rotor is on a separate computer which has IP address 192.168.1.14, and 
your computer, running N1MM logger, is 192.168.1.10.  

 Make sure N1MM Rotor is running on the computer that has the rotor connected to it.  

 Network the computers together.  

 Put this in your N1MM Logger.ini file:  

o [ExternalBroadcast]  

o BroadcastRotorAddr=127.0.0.1:12040 192.168.1.14:12040  

 ExternalBroadcast should already be there. If not, add it.  

 Enable "Display Rotors Responding From Network"  

 Put this in your N1MMRotor.ini file on the computer running N1MM Rotor:  
o [Rotors]  
o RotorReportingIP=127.0.0.1 192.168.1.10  

 Control the rotator by menus in the Tools menu. You put the direction or a callsign in the call 
textbox and press Alt+J  

 The requesting station will see a Rotor Form window open, showing the current direction of 
the rotator. Note that some rotators cannot report progress.  

1.8. Turning a Stack 

In the example picture above at the right the stack is on Com3 and Com4 and are turned at the same 

time when turning antenna 4 (stack).  

Enter 3,4 and the heading selected will be sent to the rotor program and it will tell the rotators (of 
whatever type) on com3 and com4 to turn to that azimuth. If you want to control a single antenna, 
you will have to switch to that single antenna using the antenna toggle in the main program, press 
ALT+j and then toggle to the set of antennas that you want.  

1.9. Run time error: 126 

Run time error 126 could be caused by a firewall that doesn't like a UDP message sent to 127.0.0.1 to 

notify the rotor program of what window is active. If you want to use the rotor program without 
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getting this error, you will need to figure out what program is causing this interference. First check 

your firewall. If that is not it, one user found that a program called "Port Explorer" was the cause. 
When "Port Explorer" was closed, the problem went away.  

2. Using external software 

Rotator control is supported directly by software from:  

 ARSWIN by EA4TX  

 LP rotor (freeware by Larry Phipps - N8LP)  

See the links section for urls.  

Start your ARSWIN or LP Rotor software before pressing Alt+J, Alt+L or Ctrl+Alt+L.  

 

2.6 Windows 

 1 Entry Window 

 2 Log Window 

 3 Bandmap Window 

 4 Packet and Telnet Window 

 5 Check Window 

 6 Available Mults and Qs Window 

 7 Edit Contact Window 

 8 Info Window 

 9 Score Window 

 10 Multipliers by Band Window 

 11 Statistics Window 

 12 Grayline Program 

 13 Visual Dupesheet Window 

 

2.6.1 The Entry Window 

 2.6 Windows  

 2.6.1 The Entry Window  
o 1. Button Assignments  
o 2. Callsign/Exchange Editing Features  

o 3. Entry Window Text Commands  
o 4. Other Info  

o 5. Status Bar Information  
o 6. Callsign Colors  
o 7. The Red and Green dots (LEDs)  
o 8. The Entry Windows  
o 9. Other Features  

o 10. Function Keys  
 10.1. General  
 10.2. Running mode and S&amp;P mode  

o 11. Other Keys  
o 12. File Menu Selections  
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http://n1mm.hamdocs.com/tiki-index.php?page=Log+Window&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Bandmap+Window&structure=N1MM+Logger+Digging+Deeper
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 12.1. Import  

 12.2. Export  
 12.3. Contest List  

o 13. Edit Menu Selections  

o 14. View Menu Selections  
o 15. Tools Menu Selections  
o 16. Config Menu Selections  

 16.1. Configure Ports, Telnet Address, Other - Also called Configurer.  
 16.2. Change Your Station Data  
 16.3. Change Band Plan  
 16.4. Clear INI file settings  

 16.5. Find all windows (move to within 800 *600)  
 16.6. Enter Sends Messages (ESM mode)  
 16.7. Set CW AutoSend Threshold - Ctrl+Shift+M  
 16.8. Spot all S&amp;P QSOs  
 16.9. QSYing wipes the call & spots QSO in bandmap  
 16.10. Do not automatically switch to run on CQ-frequency  

 16.11. Show non-workable spots in bandmap  
 16.12. Reset Rx freq to TX when QSO is logged (RUN and split)  
 16.13. Dual Rx always on  
 16.14. CQ Repeat - Alt+R  
 16.15. Set CQ repeat time - Ctrl+R  
 16.16. Call History Lookup  
 16.17. Filter Blacklisted Packet Spot Calls  

 16.18. Change Packet/CW/SSB/Digital Message Buttons - Alt+K  
 16.19. Multi-User Mode  
 16.20. Change Exchange Abbreviations  
 16.21. SO2R  
 16.22. WAE - Special commands for the WAE DX contest only  

o 17. Window Menu Selections  
o 18. Help Menu Selections  

 
Your entry window will be similar to this one.  

 

 
There are two ways to move from field to field.  

 Tab or Shift+Tab will move through the fields one by one in the standard sequence.  

 The Spacebar will jump from field to field in the Entry Window, filling in defaults where 
appropriate and skipping those fields that are unlikely to change.  

 

Tip 



Because it generally reduces the number of keystrokes required to log a contact, the Spacebar is the 

preferred way of navigating the fields of the Entry Window. 

1. Button Assignments 

(hotkeys in parentheses)  

 Wipe (Alt+W)- Wipe Out Entry Fields. Clear information about the current contact 

(alternatively, Ctrl+W).  

 Log It (Enter) - Write this contact to the database. Disabled when in Quick Edit mode.  

 Edit - Pops up the full Edit window to edit the last contact. Use Ctrl+Q (Quick Edit) as a 
convenient alternative.  

 Mark (Alt+M) - Mark the current frequency in the Bandmap as being in use. Used when you 

don't want to take time to enter the call of the station using the frequency.  

 Store (Alt+O) - Spots the callsign you have entered in the callsign field on the Bandmap, 

where it will be shown in bold because it is self spotted. The Config menu option "QSYing 

wipes the call and spots QSO in Bandmap" is an easier way to do this, whether you have 
worked a station or not.  

 Spot it (Alt+P) - Spot the contact on the current Packet/Telnet connection.  

 Buck - Display information on the current call using the Buckmaster callsign database. Note: 

hamcal32.dll must be in the start-up and the callsign database must also be set up properly in 
the Files Tab from the Configurer. If hamcall32.dll is not found it will use www.qrz.com to find 
the call.  

 F1 through F12 - Send the associated CW/Digital text or .wav file. Right click on the buttons 

to change labels and actions (or go into the menu). Running mode has 12 function keys and 
also S&P mode has 12 function keys. When Running the S&P keys can be found under 
Shift+Function key. See below for more info about the files send and the status of the Running 
indicator.  

 Shift+F1 through Shift+F12 - Send the associated CW/Digital text or .wav file from the 
opposite mode. So when the program is in Run mode pressing Shift will show the labels (and 
send the associated info) from S&P mode and vice versa. Each mode has 12 function keys. 

When Running the S&P keys can be found under Shift+Functionkey.  

 Esc - Stop sending. Also stops playback of recorded contacts.  

 Running Alt+U - Toggles "Running' box". When running is checked, the behavior of Enter 

Sends Messages mode changes appropriately. Additionally contacts are logged as being part of 
a run.  

 CW speed - The CW speed in wpm can be set using the textbox with speed & up/down 
buttons (only visible when CW mode is selected). Also Page Up and Page Down can be used to 
change the CW speed.  

 

Winkeyer and Starting CW Speed 

When using a Winkeyer, if you do not check "Ignore Winkey Speed Pot" on the Winkey tab in the 

Configurer, the program's starting CW speed will be set by the Winkeyer speed knob. If you check it, 
the program will start at the last CW speed used. 

2. Callsign/Exchange Editing Features 

 Space Bar - moves cursor to the position the last position the cursor was in prior to leaving 

the Callsign or Exchange fields.  

 Tab - Move to the next field.  

 Shift+Tab - move to the previous field.  

 Home - moves cursor to beginning of the field it's in.  

 End - moves cursor to end of the field it's in.  



 Question mark (?) - Sends a ?, and will cause the ? to be highlighted when you reenter the 

field. E.g. N?MM will send what is typed, but automatically highlight the ? so you can replace 
it. A double ?, as in DL?K?A will highlight all text in between and including the ? marks. The 
first keystroke entered will replace all three characters.  

 Left/Right Arrow - moves cursor to left or right one position within the field it's in.  

 Backspace - delete character to the left.  

 Delete - delete character to the right.  

 Shift+Home - will highlight from the cursor insertion point to the home (beginning) of the 
textbox.  

 Shift+End - will highlight from the cursor insertion point to the end of the textbox.  

 Shift+arrow key - will highlight as you press the keys. When you type the first character, it 
will delete the highlighted character.  

 

Note 

Check out the Key Assignments chapter for all available key assignments by the program. 

3. Entry Window Text Commands 

While N1MM Logger does not make extensive use of text commands (as CT did and Win-Test still 
does), there are a few that may prove useful.  

In each case, the command is typed into the Callsign Field of the Entry Window, and 
executed when Enter or Ctrl+Enter is pressed  

 Mode Changes - Enter CW, SSB, RTTY or PSK, and the program (together with your radio, if 

one is connected) will switch to the requested mode. For SSB, the switch will be to the 
conventional sideband (e.g., USB or LSB). This is particularly useful when you have not 
connected a radio, but wish to change the mode recorded in your log.  

 Frequency Changes- Enter a full frequency in kHz (e.g., 14025.1 , or 14025,1 if your 

computer uses comma as the decimal separator) in the Callsign field and the program will 
move to that frequency. Type a partial frequency relative to the current lower band edge 
(e.g., 025.1) and the program will go to that frequency relative to the band edge. Type a 
frequency with a + or - sign (e.g. +2, -3) to QSY by the selected amount (i.e. up 2 kHz or 
down 3 kHz). If your radio is interfaced for radio control, its frequency will follow the program. 
Type a frequency, but execute with Ctrl+Enter, and the program (and radio, if connected) will 

go into split mode and use the frequency you entered as the transmit frequency. For full 
information on split operation, see this chapter.  

 Wipe the Log- The WIPELOG command, when entered into the callsign entry field, will delete 

all QSOs from a log. This command is intended to clear test QSOs that you may have entered 
while practicing for a contest.  

 
Multi-op Commands -  

 WIPELOG -This command, introduced in Version 12.05.02, is used to delete any "practice" 
QSOs from a log before you begin actual operation. In single-computer stations it may be as 

easy simply to create another instance of the contest from the Contest Setup dialog. In 
networked computer stations such as multi-ops, this is helpful for ensuring that the logs 
maintained on each computer will be consistent with one another. In the latter situation, it is 
important that every computer on the network performs the WIPELOG command before any 
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contacts are made. Any spare computers should be set up for the contest, and the WIPELOG 

command executed before they are connected to the network.  

 OPON - This command is the equivalent of Ctrl+O, and opens a sub-window for a new 

operator to "sign on." This is particularly useful because after you have entered the operator 
call, you can go to Save Window Positions on the entry window's Tools menu and save your 
window setup. Thereafter, when you sign on again, the window setup will be adjusted to your 
preference.  

 
Mobile/Rover/VHFCommands -  

 ROVERQTH - for use in QSO parties, opens a pop-up window into which you enter your current 

or planned county abbreviation, in the form specified by the contest organizer. See the section 
on Mobile/Rover Support.  

 COUNTYLINE - for use when operating from a county line in QSO parties. Opens a pop-up 
window into which you enter the county abbreviations, separated by a comma. After you exit 

this window, check the title bar of the Entry window to ensure the correct counties are listed. 
See the section on Mobile/Rover Support.  

Additional VHF Commands -  

 BEACONS - This command will load a user-prepared file called Beacons.txt from the N1MM 
Logger program directory unto the database. The file format is:  

# Hours to stay in bandmap (mostly > 24 or > 48) 

60 

# call beacon;frequency;locator;comment 

OZ7IGY/B;144471,1;JO55WM; 

PI7CIS/B;144416,2;JO22DC;Should always be heard 

DL0PR/B;144486,3;JO44JH;Switches power! 

GB3VHF/B;144430.4;JO01DH;QRG with a . 

ON0VHF/B;144418,5;JO20;4 digit grid 

 

The purpose of this function is to permit users to display beacons on their bandmaps for much longer 
than the normal packet timeout, as a reminder to listen for those stations periodically. In the sample 
above, the beacons will continue to be displayed for 60 hours after the command is invoked. Note that 
unlike the other Entry Window text commands, this one pops up a file selection dialog as soon as the 
last letter is typed; no Enter is required, other than to exit the dialog and load the file once it has been 
selected.  

4. Other Info 

Alt+U - Toggles between Run and S&P modes  

If you are in S&P mode, Run mode is selected and the Run mode Function Key Messages are 
activated:  

 When you click on CQ-frequency in the Bandmap window  

 When you are in tuning range of your CQ-frequency (on that band)  

 When clicking on the green dot when it shows SP (Search & Pounce)  

If you place your mouse cursor anywhere on the frame of the Exchange section of the Entry window 
(the line around the part where you see the sent and received exchange), a floating "tooltip" is 
displayed which displays the time since your last previous QSO and the time since your last band-
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change. Useful primarily in multi-op stations in contests with requirements for how long you must stay 
on a band, and for getting a quick indication of QSO rate without opening the Info window.  

5. Status Bar Information 

 Left pane - Information  

o After entering a callsign - Country, Zone, Continent  
o Otherwise - Messages (like error messages, results from commands etc.)  

 Middle pane - QSOs /multipliers (/zone) depending on the selected contest  

 Right pane - Current score  

6. Callsign Colors 

There are two places where a callsign can be shown in the Entry Window , in the Callsign field and in 
the Call-frame.  

Red Single Multiplier Example: CQWW - qso is either zone or country multiplier (one multipliers)  

Green 
Double or better Multiplier Example: CQWW - qso is a zone and a country multiplier (two 
multipliers)  

Blue New contact  

Gray 
Dupe contact or an unworkable station in a non-workable country. This means that you 
don't need this station because he is a dupe or you are not even 'allowed' to work him in this 
contest according the contest rules. 

7. The Red and Green dots (LEDs) 

 
On the Entry Window below the left end of the Callsign textbox you will see either a green or a red dot 

(LED), or both. The LEDs are visual aids that help you keep track of what is happening on each 
VFO/radio when operating SO2V or SO2R. This is part of N1MM's continuing philosophy of letting the 
operator easily know what's happening at any given time.  

Green dot/LED - This VFO/radio has Entry focus in SO2V or SO2R modes - also known elsewhere in 
this manual as RX (Receive) focus or Keyboard focus. This means that any information entered by 

keyboard goes in that window, including function keys. Depending on your SO2R switching setup, it 
may also denote which radio you are hearing in your headphones.  

 Inside the green dot (or in that location if the green dot is in the other Entry Window) you will 
see either Ru or SP (Run/S&P). Ru means the Entry Window (and the VFO or radio that it 
controls) is in Running mode, and SP means it is in Search&Pounce mode.  

o Clicking on the green LED toggles between running mode (Ru) and S&P mode (SP)  

 Entry focus can also be toggled between the VFOs/radios by  
o using a mouse to click on a free space in one of the two Entry Windows  
o pressing the \ key (backslash)  

 To move both Transmit and Entry focus  

o press Ctrl+Left-Arrow / Ctrl+Right-Arrow to move both foci to the left or right 
VFO/radio  

o press the Pause key - if the green and red LEDs are in different Entry Windows, the 
first press will bring them together in the window that has the Entry focus. Subsequent 
presses will toggle both LEDs between the two Entry Windows.  

 
Red dot/LED - This VFO/radio has Transmit (TX) focus  



 Transmit (TX) focus can be changed between the VFOs/radios by pressing the Alt+F10 key or 

by pressing the Pause key (see above)  

 To move both Transmit and Entry focus, pressing Ctrl+Left-Arrow / Ctrl+Right-Arrow will 
move both foci to the left or right VFO/radio, or use the Pause key, as explained above.  

 When transmitting the TX focus can not be changed  

 When the VFO/radio has TX focus, the LED is dark red. When that VFO/radio is transmitting, 
the LED changes to bright red  

 Inside the red dot the R (Repeat) designator is shown when Repeat mode (for CQ-ing) is 
active  

 Inside the red dot the D (Dueling CQ) designator is shown when Dueling CQ is active  

Important note 

When using function keys to transmit either CW or stored voice messages, the message will be sent 

on the radio or VFO that has the Entry focus, not the one that has the Transmit focus. When you 
press the function key, the red LED denoting Transmit focus first switches to the Entry window that 
has the Entry (Keyboard) focus, and then the message is transmitted. On the other hand, when using 

either manual CW or phone, messages will be sent on the radio or VFO that has the red LED, so if you 
grab the microphone or paddle, that's what you'll get. After a while, it becomes second nature - we 

promise! 

8. The Entry Windows 

 
The program has two Entry windows. When using both bandmaps/both VFOs, both Entry 
windows are needed to make QSOs on both VFOs!  

The standard Entry window, which is always open, is being used to transmit on VFO-A (SO2V) or 
the left radio (SO2R).  
The second Entry window is being used to transmit on VFO-B (SO2V) or the right radio (SO2R). 
The second Entry window can be opened by entering a backslash \ in the first Entry window.  

If two Entry windows take up too much space, position the second Entry window over the first Entry 
window. "\" will toggle you from one to the other (typing focus) or use Ctrl+right/left to move 
transmit and typing focus. The Entry window can be resized if the two needed Entry windows take to 
much screen space.  

Most SO2R operators get the most efficiency while CQ-ing on 1 radio, and S&Ping on the other. The 

Entry Window examples below reflect a typical setup: The left VFO-A is now assigned to running, and 
the right VFO (B) is assigned to S&P.  



 

 

 

All of the features that are available to the single radio operator also work in SO2R/SO2V. For 
example, when tuning the band with the S&P VFO, spots that are in the bandmap are automatically 
inserted into each call frame (above callsign entry window) when you tune across the frequency of the 
spot. Hitting the space bar will pull the callsign from the call frame into the QSO field. Then if a station 
calls you on the run radio, toggling back and forth between Entry Windows with the \ key or Ctrl 
Left/Right arrows will keep the information in each Entry Window until the respective stations are 

logged, wiped clean via Alt+W or Ctrl+W, or you QSY and the callsign is entered into the bandmap (if 
"QSYing wipes the call && spots QSO in bandmap" is selected). Most people who are comfortable with 
Logger tend to use the reduced size Entry Windows in the examples above. All of the vital information 
an operator needs is displayed in the smaller window.  

The second Entry window will be opened when a call is clicked in the second bandmap and it is not 
open.  

More SO2R info can be found in the SO2R chapter.  

 

Tip 

In SO2V (one radio - two VFOs = 'normal' operation) QSOs made on VFO-A have to be entered in the 
standard (first) Entry window. Making a QSO on VFO-B (so transmitting on VFO-B) has to be done by 
using the second (VFO) Entry window. So when using both bandmaps, both Entry windows are needed 
to make QSOs on both VFOs. When a call from VFO-B is entered in the first Entry window you will 
transmit on the wrong VFO. Select the correct Entry window! 

9. Other Features 

 When a callsign is entered info about the country (bearing, distance etc.) is shown just above 
the status bar. Additional information from the call history lookup file may also be displayed 
(e.g. name, state, section, gird square, etc.). When calculating the bearing, if call history 
lookup is off the coordinates of the state that is the closest to the middle of the call-area is 

used. If call history lookup is on, the section or state from the call history is used. For VHF 
contests (having VHF in the contest name) the Grid Square field in the Station dialog is used 
as your bearing and not the entered Latitude and Longitude. If a beacons file is used, the grid 
square from the beacons file will be shown just above the status bar when the beacon call sign 
is entered.  

 When a callsign is entered and the station is a dupe moving to another frequency will 

automatically clear the callsign field (and place the station on the bandmap)  
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 If in the callsign typed there is a question mark (you didn't get the complete call the first 

time), the cursor highlights the ?, so that when you type, it will replace it. When in Enter 
Sends Message (ESM) mode a ? in the callsign field Enter doesn't move focus to the Exchange 
field but highlights the question mark. A callsign with a question mark in it can not be 
logged!  

 Clicking on the Exchange pane will have the same effect as pressing Space when the cursor is 

in the callsign field.  

 When both bandmaps are closed the frequency and mode are shown on the Entry window title 
bar before the contest name.  

 When tuning the band and a station on the bandmap is within tuning range, this call will be 

placed on the Entry window callsign frame. When the callsign field is empty, pressing the 
space bar will copy the callsign from the Entry window callsign frame to the callsign field. Also 
clicking on the callsign in the callsign frame will place the this callsign into the callsign field, 
replacing anything that was previously there. The tuning range can be set in the configurer 

(Other tab).  

 Set Frequency in callsign field - The frequency from the first VFO (A) can be set by 

entering a frequency or offset into the callsign field. Decimal points and comma's are allowed 
in (split) frequencies in the callsign pane. Placing a / in front of the frequency or offset will set 

the second VFO (B). Also Split frequencies can be set here; see the section on Entry Window 
Text Commands earlier in this chapter for frequency change and split frequency examples.  

 Set Mode in callsign field - The mode can be set by typing CW, USB, LSB, SSB, RTTY, AM, 
FM, PSK or SSTV into the callsign field. If the contest mode is mixed or a digital mode, typing 

RTTY or PSK in the entry field will open the Digital Interface window and open the serial ports 
for which the Digital check box has been checked in the Configurer. If the contest mode is not 
mixed or digital, typing RTTY or PSK will result in an error message; if you really want to open 
the DI window in this situation, for example to use Fldigi as a CW decoder, use the Windows > 
Digital Interface menu item. When the DI window is open and a non-digital mode is entered in 
the callsign field, the Digital port(s) is/are closed so it/they can be used for CW, PTT, etc.  

 Ctrl+P - Spot the station entered in the callsign field as a spot to the active cluster 

connection, either packet or telnet. You will be prompted for a comment. If no station is 
entered in the callsign field, the last logged station this session will be spotted. Macros are 
accepted in the comment sent.  

 Ctrl+O - Change the callsign of the operator. If you are multi-user, you will be prompted for 

the operator at the first call logged. The default is the callsign in the station information 
dialog. Entering "OPON" in the callsign field will also prompt for an operator callsign.  

 Auto-call completion - As you are typing a callsign in the callsign field, if a unique match to 

your log or to the check window call occurs, the remaining characters in the call are added to 
what you have already typed. They will be highlighted, so that if you continue to type, you will 
replace the characters automatically added.  

 Auto-CQ - Alt+R toggles the CQ button to send CQ once or repeat. The on/off on the status 

bar signals whether the next CQ will go into repeat mode. The only way to stop the repeat 
(mid stream), and to get completely out of it, is to hit Escape.  

o Ctrl+R sets the period of repeat in seconds or milliseconds.  
o Alt+R turns repeat mode on or off.  

 If repeat mode is on, CQ will always repeat  

 CQ needs to be the first two letters of the text sent by the function key 
for CW or anywhere in the name of the wav file name for SSB or text 
for all Digital modes.  

 CQ needs to be the first two letters of the caption of the function key 
for CW and SSB or anywhere in the caption of the function key for 
Digital modes.  

 If repeat mode is off, CQ will not repeat.  

 A 'R' will be shown in the red status 'led' when repeat mode is on.  
o The repeat timer for CW and SSB is for the interval from when you stop sending CQ 

until CQ resumes.  
 When using an External DVK there is no stop sending indication and CQ will 

not repeat.  



o When using a radio with internal voice message memories, the repeat timer can be 

used together with a CAT macro in the relevantÃƒâ€šÃ‚Â• function key. Note: The 
repeat timer in this case starts when the radio command is sent to the radio. Users 
that use this function to trigger radio voice keyers must assign the radio command to 

abort the message to a separate function key.  

 Ctrl+Shift+Fx - Record SSB message for the assigned function key. Pressing Ctrl+Shift+Fx 
again stops the recording. Fx can be F1 to F12.  

 Ctrl+Alt+Fx - Record external DVK memory 1 to 4. Fx can be F1 to F4. An external DVK has 

to be connected and configured on a LPT port.  
o When using an external DVK, all of the Run and S&P SSB function keys should be set 

to empty.wav and not left blank.  

 Enter sends messages - the so called 'Enter mode' or 'ESM' mode. An entire normal contact 

(CQ & S&P) can be handled with the Enter key. More information is given in the Using Stored 
Messages chapter under ESM (Enter Sends Messages)  

 Automatically Spot all S&P QSOs - Spot the contact automatically when you log it (only 

when in S&P mode).  

 "Quick Edit" (Ctrl+Q/Ctrl+A). - Quickly edit the QSOs worked before in the log.  
o Ctrl+Q - moves back one QSO  

o Ctrl+A - moves forward one QSO.  
o Enter - logs the changes made and brings you back in normal logging mode.  
o Escape - discards the changes made and brings you back in normal logging mode.  
o If the text boxes in the Entry window are colored blue, you are in Quick Edit mode, 

also "QuickEdit" will be shown in as the callframe caption when re-editing QSOs. Quick 
Edit starts editing with the highlighted contact and you can move forward or back from 
there.  

o There is no check if the entered contents is valid as is done when the QSO is entered 
normally. So check thoroughly what you type.  

 The program will display a warning if it suspects that the computer time is wrong (by checking 
local time & time zone).  

 Using both VFOs when 'Running' - When using the main VFO to transmit and the other to 
receive (split mode) after each logged QSO the RX frequency will be made equal to the TX 
(main VFO) frequency. It's there to let you use the main frequency control as an RIT. It resets 

after every RUNNING QSO.  

 Automatic antenna selection can be used. Antennas have to be set on the Antenna tab 
from the Configurer dialog and can be controlled using an external box on the parallel port. 
When you press Alt+F9, you will toggle through all the antennas FOR THAT BAND. If there is 
only one, then no toggling will occur. When you change bands, the antenna switch will be 

changed to the antenna with the lowest code for that band. The selected antenna will show in 
the status pane.  

 Alt+' (Alt+single quote) toggle between the wide and narrow filter for the selected mode 
(SSB, CW and Digital modes). This hot key will work whether you have changed your filter 

codes or not. Filter codes can be set in the the bandmap right click menu.  

 Pause - swap radios and match keyboard to radio.  

 Update timestamp qso - Updating the timestamp from a qso can be done from within the 

Entry window using the callsign field. Entries starting with "T" and four numeric digits will 
update the current row time in the log.  

 A warning message will be shown if user tunes away before logging a qso in the Entry window 

with a correct entered exchange.  

 Exchange field validation:  

CQ Zone only allow numbers, tab, space, backspace  

Section only allow letters/numbers  

Exchange only allow letters/numbers  

Grid only allow letters/numbers  

Power only allow letters/numbers 

http://n1mm.hamdocs.com/tiki-index.php?page=ESM+%28Enter+Sends+Messages%29#ESM_Enter_Sends_Messages_


 K1TTT's call checking function has been implemented. When a callsign is entered it is 

checked against a pattern file to see if the callsign entered is a possible callsign. A warning will 
be given in the Check window when this is not true. The checking in done using a set of rules 
in the file CALLSIGN.PAT. Note that the call checking function only works for HF (no WARC) 
and only for CW and SSB. More information in the chapter Call Checking.  

 When a SH/DX command is entered in the callsign field it is passed to the packet window for 

processing.  

 Show windows when radio frequency changed - This function will bring the program on 
top when the radio frequency is changed.  

o This only happens when there is another program on top of N1MM logger like your 

Internet browser, e-mail client etc.  
o A radio is attached (to get the frequency change from).  
o When N1MM logger is minimized nothing will happen.  
o This function is standard behavior and is always enabled.  

 TOUR command. A very few contests allow for multiple sessions in which you can work the 

same station in every session for QSO credit. You can enter TOUR into the Entry window in 

place of a call sign to reset dupe checking at any time before or during the contest. This 
command has 2 parameters that are entered into the Sent RST field, separated by a forward 
slash "/". The first parameter is the time when the current session begins (GMT) and the 
second parameter is the duration of the session. The format for both parameters is hhmm. For 
example, 1200/30 means the session starts at 1200Z and has a duration of 30 minutes. The 
minimum value for the duration parameter is 10 (10 minutes). If the TOUR command is 
entered without any parameters, the current values of the start time and duration will be 

displayed. The default values are 0000/00.  
o At the beginning of each session the start time and duration will be displayed in the 

status field at the bottom of the Entry Window. After the first QSO has been logged 
during the new session you should see the Multiplier window reset and dupes will be 
reset for this new session as well.  

o Most of the contests supported by the Logger do not need this command but some 

(mostly Russian and Ukrainian) have it built into the contest module and do not 
require it entered manually.  

o If you are planning on using TOUR command with other contests, keep in mind that 
settings for it will be lost when the logger is restarted. If the Snt (sent RST) field is not 
displayed in the Entry window, you will not be able to use this command.  

10. Function Keys 

10.1. General 

 
The program has 24 possible programmed messages assigned to the function keys. There are two sets 
of messages, Run messages and Search and Pounce messages. The first twelve messages you enter 
are presumed to be Run messages F1 to F12, the second twelve, Search and Pounce messages F1 to 
F12.  

The function keys can be redefined by right-clicking on the function key/message button array in the 
Entry window  

The function keys can be stacked. This means you can press several function keys behind each other 
which will all be sent in full in the selected order. For example, you could press F4 to re-send your call 

(if you think the other station did not get it right) and immediately press F2 to send the exchange. The 
program will send the two messages seamlessly.  

When hovering with the mouse over a function key button the text to sent is shown.  

http://n1mm.hamdocs.com/tiki-index.php?page=Call+Checking#Call_Checking


10.2. Running mode and S&P mode 

 
If "Running" is checked, you will see the Run messages, if not, you'll see the Search and Pounce 
messages on the function keys. SHIFT REVERSES THE MEANING OF THE ABOVE RULE.  
When you press Shift, the labels will change (if you made them different) and the text from the 
"Running" keys become the text from the "Search & Pounce" keys and vice versa.  

Running mode is determined by whether you are on a CQ-Frequency or when the 'Running' indicator is 

marked. There is one CQ-Frequency per band. Swapping VFOs may possible swap between Running 
mode and Search & Pounce mode. Running mode is based on the TX frequency.  

Moving away from the frequency on which you were in Running mode will place you automatically in 

Search and Pounce mode. Going back to the Running frequency will put you back in Running mode 
(the 'Running' indicator is marked again), clicking on the 'CQ-frequency' in the bandmap also will 
place the program in Running mode again. An exception is when you are working split i.e. transmit on 

one VFO and receive on the other. Moving around will not change Running mode into Search and 
Pounce mode.  

Default Function keys  

F1 CQ Key F5 His Call Key F9 ---  

F2 Exchange key F6 QSO B4 Key F10 ---  

F3 End of QSO Key F7 -  F11 -  

F4 My Call Key F8 Again Key F12 --- 

 
The above mentioned function key assignments are the defaults. The function keys can be remapped 
in the 'Configurer' dialog.  

Just put 24 messages (for CW/Digital) or 24 wave files for SSB in order. They will map to F1-F12 (first 

12 are for Run mode) and Shift+F1-F12 (second 12 are for S&P mode). Keys not programmed in S&P 
mode take the value of that key from Running mode (if programmed). This means that when the F5 
key in S&P mode isn't programmed, the F5 key from Running mode will be shown (and used) by that 
function key in S&P mode. If you want you can come close to CT compatibility.  

Therefore the text sent by and shown on the function keys depend on the Running mode 
indicator!  

Note that when in Search and Pounce mode, to call CQ, the CQ-key as configured is used i.e mostly 
F1. No need to press Shift+F1. That will place the program in Run mode and will press F1; from that 
point on F1 will call CQ (in Running mode). If you sent CQ, don't you want to be in Run mode? If not 
use the {S&P} macro to stay in S&P mode.  

 
There may not be any 'holes' in the function key lines with skipped function keys. ALL preceding 
function keys must at least have a line in the table Example: You'd like to have a different S&P F3 key 

than the Run F3 key. First you have to add the 12 Run lines in the table, after that the S&P lines for 
F1 + F2 +F3 which you liked to change for S&P. So at least 15 lines in total have to be in the function 
key table (12 run + 3 S&P). 

 
The text F1 (etc.) in the left column is only text and has no intelligence/meaning for the program. You 

could remove it and change it to any text you like, which will show on the Function key in the Entry 



window. The order of lines determines what the key will do. Examples: line 5 is Run F5 , line 11 is Run 

F11, line 17 is S&P F5 (17-12=5) etc. 

 
Alt + F11 - Run box behavior: The behavior of the running indicator (run box) can be manipulated 
using the Alt+F11 toggle. Normally when you are on your CQ-frequency you will be in Run mode. 
Changing frequency will toggle the run box into S&P mode. With Alt+F11 this behavior can be changed 
and the program will stay in the Run mode or S&P mode regardless to which frequency the VFO is 
tuned. A message is given in the Entry window status bar what the new value is. When on a 

DXpedition this behavior can be very useful. 

11. Other Keys 

Key  

Send 

function 
key(s)  

Action(s)  

Insert 
His Call and 
Exchange 
Keys 

Send His Call followed by the Exchange  

; 
His Call and 
Exchange 

Keys 

Send His Call Followed by the Exchange  

Alt+Enter N/A Sends the End of QSO message and logs the contact  

. 
End of QSO 
Key 

Sends the End of QSO message and logs the contact  

Ctrl+Alt+Enter N/A 

Logs a normally invalid QSO (invalid exchange, etc.). Prompts for a 
comment. When no comment is entered Forced QSO is added to the 

comment field. The receive frequency is reset to the transmit 
frequency. Use View>Notes to correct later 

 
 

Background: The ; and ' keys were added to make touch typing much easier for those who use the 
Insert and + keys for working and logging QSOs. It is impossible to touch type and easily hit these 
very often used keys. If you have ever operated at a multi-multi event with many different keyboard 
layouts (QWERTZ, QWERTY, German, Dutch etc.) you will have noticed that each keyboard layout has 
these keys in different places. Using keys like ; and ' helps standardize often used keystrokes. the 
keys to use can be set in the Configurer under the Function keys tab.  

12. File Menu Selections 



 

 

Note 

The databases used by N1MM Logger are in Microsoft Access 2000 format, with the file 
extension.mdb. The N1MM Logger databases contain much more than simply contest logs; for 
example, function key definitions (messages) for each mode, packet cluster addresses, and many 
other items of necessary data are stored there.  

Users can also apply a variety of approaches to their database(s). Some use a single database for all 
contests over a period of years, while others prefer to set up a new database for every contest. For an 

excellent short video on this subject by Larry, K8UT, go here .  

Always use a separate database for testing new versions of the program and make regular backups of 

the N1MM logger directory, or at least the database files ( *.mdb) that contain 'real' contest QSOs.  

 New log in database - Create a new contest log within the current database. More info here.  

 Open log in database - Open an existing log within the current database. More info here.  

 New Database - Create a new log database. Change the proposed name (new.mdb) into a 
meaningful name for the use or contents of this new database. From now on this database will 
be opened by default at startup of the program.  

 Open Database - Open an existing log database. A selection can be made from databases 

already created. Many contests can be stored within one database.  

 Copy (and Compact) Database - Copy the database to a new database file, and compress 

the data at the same time. Change the proposed name (new.mdb) into a meaningful name. 
This function can be used to reduce the size of the database after importing a new CTY.DAT 
file or after deleting contests. The original database is not changed, nor does the program 

http://n1mm.hamdocs.com/tiki-index.php?page=Video+-+Databases+%26+Logs#Video_Databases_Logs
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start using the new database unless Open Database is subsequently used to open the new 
database.  

Note: Copying a database also compresses it. If you have deleted contests from your database, you 
may want to copy it to reduce the space it takes up. Deleted contests and contacts are definitely gone 
after this action!  

 Copy This Contest to Another Database - Copy the current contest log to another 

database. If the target database does not exist, you should create it first, using the New 
Database command. The original database is not changed, nor does the program start using 
the new database unless Open Database is subsequently used to open the new database.  

 

Why Copy A Contest to Another Database? 

There are many reasons why you might want to copy contests from one database to another. Many 

users have created databases organized by year, by contest type, and so on. This option makes that 
easy.  
Some users, particularly those whose CPU or PC memory capacity is limited, have found that they get 

improved program performance by using a database that has only one contest (or relatively few 
QSOs) in it. If you start off using a database with many contests already in it, you can always create a 
new database and then copy the QSOs you have already made to it.  

 Repairing a corrupted database (Internet) - This is a link to the Microsoft Web site on 
how to fix a corrupted Access databases. A program to fix can be downloaded there 

(Jetcomp.exe). This file can also be download from the N1MM website under the menu item 
'Other files'.  

 Generate Cabrillo File - New with Version 10.12.3, replacing Export - Cabrillo File. One 
fewer step to producing the Cabrillo format text file that most contests now require of entrants 
submitting electronic logs.  

 

Once created, the Cabrillo file can be edited using Notepad or any text editor. Make sure that the 
Station information 'Config > Change Your Station Data') and overall contest information (File > Open 
Log in Database ) is correct before creating this file. Be sure to enter the correct Sent Exchange, or 
else your Cabrillo file will be wrong. For Multi-op stations select the correct Operator Category in the 
contest setup window. This generates the correct numbers for each station; in Multi-single, the station 
number field (the last digit in each line) identifies the Mult and Run station.  

It is a good idea to rescore the contest before submitting and check to be sure that the header of the 
Cabrillo file is correct before submitting the log. Some contest organizers use non-standard operator 
categories (i.e. not in the official Cabrillo specification); in these contests you will have to edit the 
category by hand to make it agree with the organizer's requirements.  

 

Digital Mode Designators 

Note: The Cabrillo standard only supports one mode designator for digital modes: RY. In some digital 

or mixed-mode contests, PSK and RTTY may be considered separate modes, and the contest 
organizers may specify additional non-standard designators such as PK. The Logger's Cabrillo mode 
export string for PSK is "PK" unless the contest considers RTTY and PSK to be a single digital mode. 
When this occurs the mode export string is "RY". Because the use of these mode designators is non-
standard, you should always check with the organizer's file specification and if necessary, edit the 

Cabrillo file to meet the organizer's requirements. 

 Exit Alt+F4 - Quit the program. If unlogged contacts are in the Entry window you will be 
prompted with the dialog below.  



 

 

12.1. Import 

o Import ADIF from file... - Load the data from an ADIF file into the current database. 

It is not possible to import a contest into the current database if the Contest Name 
doesn't match the current contest. Also, the N1MM Logger database can not contain 

QSO's with identical time stamps (time & date). If the contacts already exist in the 
current database, it will be necessary to open a new database and contest before 
importing the ADIF file. If the ADIF file contains tags that are not used by the N1MM 
Logger program, they are ignored. This is often the case when the ADIF file is 
generated by a different program. To view the N1MM Logger ADIF tags open a contest 

of the same type, log one or more dummy QSO(s), then export the ADIF file. Compare 
the Contest Name and QSO tags for the important QSO elements. See the FAQ section 
- Other section for additional information.  

o Import Call History... - Some contests use exchanges which are very often the same 
the next contest you work a station. This table in the log database can be used by 
some of the contests to show information in one of the exchange fields or fill a macro 

when a callsign is entered. This information can be Name (RTTY friends file), Grid 
square, age, etc. For more information see the Before the Contest chapter and for vhf 
the VHF and Up Contesting chapter (VHFREG1 is a VHF contest which uses this table 
to fill the grid square). When importing a new file with information the contents of the 

CallHist table will be deleted first. So export first if you want to keep the content!  
o Import Packet/Telnet Buttons from file... - Import the contents of the 

Packet/Telnet buttons file (*.mc). This way a separate set of Packet/Telnet Buttons 

can be created for different Packet/Telnet nodes which may have different commands.  
o Import Telnet Clusters... - Import the contents of a telnet cluster list file (*.txt) into 

the program. This way you can import a file with telnet clusters suited for your 
location/situation. The 2 items in the file (name and Telnet cluster address) are 
separated by a comma. A port number may be added using a" :" after the telnet 
cluster address where needed (the default is 7300). Example: 
GB7UJS,gb7ujs.shacknet.nu:7373 or K1TTT.NET,K1TTT.NET  

o Import Blacklisted Calls from file... - Used to import a list of Blacklisted calls (calls 
known to be false, particularly those spotted erroneously due to RFI or other 
interference). By default, the file is named Blacklist.txt, but you can assign another, 
specific name if you wish.  

o Import State and Province Abbreviations... - Import the state and province 
abbreviations used in many contest modules. This is done automatically when 

changing databases, but may be a good bet if you have trouble in a contest 
(particularly a QSO Party) with the program not recognizing certain county, state or 
province abbreviations. Do a rescore after executing this menu item when QSOs have 
already been logged.  

o Import Function Keys - Import the contents of a saved function keys file (*.mc). 
This file can be edited with a text editor like Notepad before importing. Note that for 
each mode, only one set of function key definitions can be loaded in a database at one 

time. However, the Associated Files tab of the Contest Setup dialog provides the 
ability to associate a definition file with each contest, so that it will be loaded 
automatically when that contest is started.  

 SSB Function Keys...- import SSB function keys.  

http://n1mm.hamdocs.com/tiki-index.php?page=Before+the+Contest#Before_the_Contest
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 CW Function Keys... - import CW function keys.  

 Digital Function Keys... - import the Digital Interface function keys (not the 
extra keys from the Digital Interface).  

o Recover QSOs from a Transaction Log (also known as a transaction file)... - 

Import the created transaction log file. This file is created when on the 'Other' tab in 
the Configurer the option 'Keep log of all QSOs to facilitate recovery of log' has been 
selected. More info in the Other Tab section of the Configurer chapter.  

12.2. Export 

 

Filename Tip 

When the "Save File" window prompts for a filename the default is callsign.txt (the callsign comes 
from the Station Information dialog). If your contest call sign was N1MM/P, put something like 
"N1MM_P.txt" The / and many other characters are a no go in the Windows OS. 

o Export ADIF to file  
 Export ADIF to file... - Create an ADIF file. This file can be used to export 

the current contest for import into a logging program or contest program (like 
this one). Deleted QSOs are not exported; select the 'DELETEDQS' contest to 
export these.  

 Export ADIF to file by date... - Create an ADIF file from the selected contest 
starting from the date set. The first time the default date starting from which 
QSOs will be exported is 1900-01-01 (yyyy-mm-dd). The second time the 
default date and time will be shown by the program and will be the moment 

you last exported with this option. The date/time can be changed if necessary, 
i.e. when opening another (older) database. This function is especially useful 
when you want to export the generated ADIF file into a (general) logging 
program to do award tracking etc. Deleted QSOs are not exported; select the 
'DELETEDQS' contest to export these.  

 

 Export ADIF to file by date from ALL contests... - Create an ADIF file from 
all QSOs in all contests starting from the date set. The first time the default 

date starting from which QSOs will be exported is 1900-01-01 (yyyy-mm-dd). 
The second time the default date and time will be shown by the program and 

will be the moment you last exported with this option. The date/time can be 
changed if necessary, i.e. when opening another (older) database. This 
function is especially useful when you want to export the generated ADIF file 
into a (general) logging program to do award tracking etc. Deleted QSOs are 
not exported; select the 'DELETEDQS' contest to export these.  

http://n1mm.hamdocs.com/tiki-index.php?page=Configurer#Configurer_REAL_GT_Other_Tab


 

 Export ADIF to file by Multi-User Station Number - Create an ADIF file 
from all QSOs from one station in a Multi User environment when you are 
currently logging DX. Otherwise, it exports only from the contest you are 

logging in. A station number has to be given after which a filename can be 
given for the ADIF file to generate.  

 
Note: When using ADIF export and the contest name contains "RTTY" or "JARTS" the export mode is 
set to "RTTY" even when the log file shows otherwise (i.e. LSB).  

o Export to File (Generic)  
 Export to File (Generic), order by QSO Time (normal)... - Creates a 

generic file named callsign.txt from the contest log ordered by time (and not 
by band). In some cases this is the file needed by the contest manager. This 
file can also be used to import into a spreadsheet or database program or your 
logging program if it can't import ADIF format. The exported file can be edited 

with a text editor like Notepad.  
 Export to File (Generic), order by Band... - Creates a generic file named 

callsign.txt from the contest log ordered by band, per band ordered by time. 
In some cases this is the file needed by the contest manager (like in VHF and 
up contests).  

o Export EDI to file by band... - Create an EDI (REG1TEST) file which is a regular file 
format used for VHF contests in Europe. A separate file will be created for each band 

with QSOs made on it.  
o Print Score Summary to File... - Print a summary sheet to a file with the default 

name callsign.SUM Example: N1MM.SUM The number of contacts printed on the 
Summary sheet is without dupe contacts. The exported file can be edited with a text 
editor like Notepad.  

o Export Call History... - Exports the information in the Call History database table. 

This table can only be filled or revised by using Import Call History. Do your editing on 
the Call History text file before import.  

o Export Packet/Telnet Buttons to file... - Export the contents of the Packet/Telnet 
buttons to file (*.mc). Exported Packet/Telnet buttons can be imported using the 
menu item 'File | Import Packet/Telnet Buttons from file...'. The exported file can be 
edited with a text editor like Notepad.  

o Export Telnet Clusters... - Export the telnet clusters (*.txt) in the program. This 

way you can export the current entries and update the list for your own 

location/situation. Exported Telnet clusters can be imported using the menu item 'File 
| Import Telnet Clusters...'. The default name for the exported file will be 
'Clusters.txt'.  

o Export Blacklisted Calls... - Used to export a list of Blacklisted calls (calls known to 
be false, particularly those spotted erroneously due to RFI or other interference). The 
export is from a table in the current database, which is built by blacklisting from the 

right-click menu in the Bandmap window. By default, the file is named Blacklist.txt, 
but you can assign another, specific name if you wish.  

o Export Function Keys to file - Export the contents of the function keys to file 
(*.mc). Exported function key settings can be imported using the menu item 'File | 



Import Function Keys to file...'. This way for every contest a separate set of function 

keys could be created. The exported file can be edited with a text editor like Notepad.  
 SSB Function Keys... - Export the SSB function keys.  
 CW Function Keys... - Export the CW function keys.  

 Digital Function Keys... - Export the Digital function keys (the Entry window 
keys, not the extra keys from the Digital Interface).  

12.3. Contest List 

At the bottom of the File Menu is a list of the last 9 contests you have had open, along with the 
databases they are contained in. This provides a very convenient way to switch between contests 
when you want to participate in more than one simultaneously. You can open the File menu and use 
your mouse to select the contest you want to work next, or you can hit Alt+F, which opens the File 
menu, and then hit the number (1-9) corresponding with the contest you want.  

The contest you currently have open will always be numbered "1", and the previously-open contest 

will be numbered "2", so if you want to toggle between just two contests, all you need to do is set 
them up and then Hit Alt+F, then 2, to jump back and forth.  

13. Edit Menu Selections 

 Wipe Out Entry Fields Ctrl+W - Clear information from the current contact (equal to 
Alt+W).  

 Edit Last Contact Ctrl+Y - Open a dialog to allow all fields for the last contact to be 

modified.  

 Add a Note to Last/Current Contact Ctrl+N - Add a note to your the current contact in the 

Entry window or the last QSO logged when no callsign is shown in the Entry window.  

 Edit Current Contact - Open a dialog to allow all fields for the current contact to be modified. 
Double clicking in the Log window on a contact will open the same dialog.  

 Quick Edit Previous Contacts (Back) Ctrl+Q - Quickly edit the QSOs worked before in the 

log. Ctrl+Q moves back one QSO, Ctrl+A moves forward one QSO. If the text boxes in the 
Entry window are colored blue, you are in Quick Edit mode. To exit, press enter to save 
changes or Escape to abandon changes.  

 Quick Edit Previous Contacts (Forward) Ctrl+A- Quickly edit the QSOs worked before in 

the log. Ctrl+Q moves back one QSO, Ctrl+A moves forward one QSO. If the text boxes in the 
Entry window are colored blue, you are in Quick Edit mode. To exit, press enter to save 
changes or Escape to abandon changes.  

 Increase Received NR by 1 Ctrl+U - Increase the number in the exchange field by 1. You 

will find this useful during serial number contests when you are in a pileup and you need to 
keep incrementing the DX station's serial number because you can't get him in the log...  

 Find/Find Again Ctrl+F - Find the callsign entered in the callsign field in the log. Pressing 
Ctrl+F again will find the next instance.  

14. View Menu Selections 

 Max Rates - View 1 minute, 10 minutes and 60 minutes highest rates for the contest. The 

content shown can be saved as a text file by clicking on the Save button or by right clicking to 
the clipboard using the menu item: Copy text to Clipboard.  

 Off Times - Show off times. Shown is the start and end of the period and the minutes off 
time, if the operator is known it will be shown. Also the total off time is given in minutes and 

days/hours/minutes. If a contest does not have an off period it is set at 30 minutes. The 



content shown can be saved as a text file by clicking the Save button or by right clicking to 

the clipboard using the menu item: Copy text to Clipboard. Off times uses time of first (last) 
logged QSO as the start (end) of on time. Any time between start (end) of contest and first 
(last) logged QSO is counted as off time. A warning will be displayed for pre-contest QSOs that 
cause the report to be incorrect.  

 

 Runs - Shows all runs. These are the periods between band changes and includes off times. 

The content shown can be saved as a text file by clicking the Save button or by right clicking 
to the clipboard using the menu item: Copy text to Clipboard.  

 Suspect Calls - Show suspect calls using the K1TTT's call checking function. A window will 
open with the results. The content shown can be saved as a text file by clicking the Save 
button or by right clicking to the clipboard using the menu item: Copy text to Clipboard.  

 

 Suspect Zones - Show suspect zones. Zones in the USA and Canada are omitted. The first 
zone is the zone from this contest, the second zone is the zone from the cty.dat file loaded. A 
window will open with the results. The content shown can be saved as a text file by clicking 
the Save button or by right clicking to the clipboard using the menu item: Copy text to 
Clipboard.  



 

 Varying Zones - Show varying zones. The first zone is the zone from this contest, the second 
zone is the zone from any other contest in this database or this contest. A window will open 
with the results. The content shown can be saved as a text file by clicking the Save button.  

 

 Passed QSOs -The number of passed qsos per operator. Showing band, number of passed 
qsos and multipliers.  

 Cross Check Exchanges - Will create a report of inconsistent exchanges, Grid Squares not in 
the call history and distances >= 700 km in VHF contests. Great to find typos after the 
contest.  

 Unique calls not in Master.dta - Will create a report of unique calls which are not found in 
the master.dta file in the N1MM logger program directory.  

 

 Notes - Open a window and display all contacts with notes. Great feature to check operator 
notes when checking the log after the contest. The content shown can be saved as a text file 



by clicking the Save button or by right clicking to the clipboard using the menu item: Copy 

text to Clipboard.  

 Statistics - Show statistics for the selected contest. Many choices available. See chapter 

'Statistics' for more detail. When, possibly during a contest, you check the statistics and a 
station comes back, just start typing. The statisctics window will go to the background and 
every typed characters will go to the Entry Window. A Print to File output can be import in the 
Import Goals in the Info Window.  

 

Note 

All 'Show' items below can only be used when valid callsign information is entered in the callsign field 
or the callsign frame. 

 Show Last 10 Spots - Show the last 10 spots for the call in the callsign field. If the callsign 
field is empty the callsign on the callsign field frame will be used, if any. A Packet or Telnet 

session with a DX cluster should be present because a query will be send to that cluster.  

 Show Buck/Packet - Show the Buckmaster information for the call in the callsign field. If the 

callsign field is empty the callsign on the callsign field frame will be used, if any. A Packet or 
Telnet session with a DX cluster should be present because a query will be send to that 
cluster.  

 Show Station - Show the station information for the call in the callsign field. If the callsign 

field is empty the callsign on the callsign field frame will be used, if any. A Packet or Telnet 
session with a DX cluster should be present because a query will be send to that cluster.  

 Show QSL/Packet - Show the QSL information for the call in the callsign field. If the callsign 

field is empty the callsign on the callsign field frame will be used, if any. A Packet or Telnet 
session with a DX cluster should be present because a query will be send to that cluster.  

 Show Sunrise/Sunset - Show the Sunrise/Sunset information for the call in the callsign 

field. If the callsign field is empty the callsign on the callsign field frame will be used, if any. 
The information shown is also available in the Info Window. A Packet or Telnet session with a 
DX cluster should be present because a query will be send to that cluster.  

 SH/DX Current Call or Spot - Shows DX information from the current call in the callsign 

field or spot. If the callsign field is empty the callsign on the callsign field frame will be used, if 
any. A Packet or Telnet session with a DX cluster should be present because a query will be 
send to that cluster.  

 Show QRZ (Internet) - Show the information that QRZ.com has for this call using your 
browser. An Internet connection should be present.  

 Show Google (Internet) - Show the information that Google.com has for this call using your 

browser. An Internet connection should be present.  

 Show Buck (Local) - Show the Buckmaster database information for this call. This requires 
installation of Buckmaster database software and Buckmaster database on the local computer.  

 Set Font - Change the font of the Entry window text boxes and callframe text. The callframe 

text is the same type but not size as the textboxes. If Arial is the choosen font,the callframe 
remains however MS Sans Serif. A nice slashed font is Monaco.  

15. Tools Menu Selections 



 

 

 Rescore Current Contest - Rescore the current contest. This is required before submitting a 

log if CTY.DAT has been changed (if applicable) or if contacts have been modified or deleted 
during the contest. It may be run at any time but is rather slow.  

 Rescore last N Hours - Rescore the last N hours for the current contest. It may be run at 

any time but is rather slow.  

 Download Latest Check Partial file (Master.DTA)(Internet) - This item will open your 
web browser to the web page where to download the latest version of the check partial file. 

Select the file to download and copy the file in the program directory(NB. N1MM logger 
supports the CT format master.dta file). Select the file to use in the tab 'Associated Files' 
under 'File | Open Log in Database' dialog. The calls in these database master files appear in 
the Check window after entering at least two letters of the callsign field.  

 Tune (CW mode) Ctrl+T - Switches the radio into CW mode and using the CW keying 

interface, key the transmitter. The PTT line will also activate and the radio has to be in semi- 
or full-break-in mode (vox) to transmit. To stop the tuning signal, press the Esc key or Ctrl+T 
again. After the tuning signal ends and PTT is released, the radio will return to the original 
mode.  

 Download latest N1MM Logger .pdf manual (Internet) - Links to the web site to 

download the latest manual from the website. Be sure to place it in the N1MM program 
directory so that you can open it from the Help menu.  

 Download latest country file (wl_cty.dat)(Internet) - This item will open your web 

browser to the web page where to download the latest wl_cty.dat file. After downloading the 
new country file it has to be imported in the program by selecting 'Tools>Import country list 
from downloaded file' which is the next menu item.  

 

Note 

As of June 2013, the layout of the country files web site has changed. To find the wl_cty.dat file, 
select the Contest > N1MM menu item on the web page. On the new page, under N1MM 8.6.2 and 
later, there is a sentence of instructions in which the word WL_CTY.DAT is a link. To download the file, 



right-click on the link and select "Save link as" or "Save target as", navigate to your N1MM Logger 

program folder and click on the Save button. Remember to import the file into your database using 
the next menu item. 

 Import country list from downloaded file- Load a new copy of the country file into the log 
database. Mostly this file is called wl_cty.dat but may have any name. Just select the right file 
when importing and select Open". To check which file you are using go into 'Help - About 
N1MM logger Vx.x.xx and look at the bottom line which tells you the current country file 
(mostly cty.dat or wl_cty.dat), check the date and time if it matches the file. Duplicate entries 
are ignored during the import so the first instance will be added.  

 

Note 

Always load the most current WL_CTY.DAT file from the Internet before entering a contest. 

 Add call to country - Specify a country for the callsign in the callsign field in the Entry 
Window. If no callsign entered this menu item will be grayed out. This is a quick way during 
the heat of a contest to add a country. Added callsigns to countries are valid until you do a 
new 'Import country list from downloaded file'. Making changes permanent means changing 

the imported country file (wl_cty.dat) and importing the changed country file. This feature is 
for getting stations accepted by the program from countries when otherwise rejected by the 
program due to a faulty country file. When using the right country the program will accept the 
station and calculate the right (well at least a more accurate) score (points and multipliers).  

 Tune to beacon for this band - This will change mode to CW/CW-R and tune to the NCDXF 

beacons on bands 10, 15 and 20 meters and displays the station transmitting and the power 
steps in the status bar of the focus window. Also the Short Path and Long Path bearings are 
shown. See: http://www.ncdxf.org/Beacon/BeaconSchedule.html  

 Update Call History with Current Log - Update the call history file selected with the qsos 

from the current log file. Contacts will be added when new or updated when already in the call 
history file. For the 2 grid fields the behavior is a bit different. When both grid fields are filled 
and a new third grid has been logged, the second grid (oldest) will be removed, and replaced 

by the contents of the first field. The new grid will be added to the first position. The same 
change in position will happen when only the first grid is filled and a new grid has to be added 
from the log. A 4 digit grid will be overwritten by a 6 digit grid when the first 4 characters are 

the same  

 Clear Call History then Update with Current Log - As above, except clears the call history 
table before adding contacts from the current log. Can be used to start a new call history file  

 Turn Rotor Alt+J - Turn rotor to bearing for the callsign in the Entry window or to the 

callsign in the callframe (when callsign field is empty).  
o The statusbar will show the bearing it will turn to. Example: Turning Rotor to 123°  
o Alt+L will turn the beam to the proper bearing for long path  

 Stop Rotor Ctrl+Alt+J - Stop turning the rotator.  

 Packet Window Tools - Opens the menu for the Packet Window, from the Entry window, so 
you don't need to look at the Packet Window  

 Program Execution Logging (debugging only)  
o Trace facility. Exports to a selectable file (*.trc). Tracing has been added to all 

program areas. If you experience problems (like a serious delay) please turn on 
tracing for the window/dialog giving (performance) problems. Send the recorded trace 

file to the programmers so they can figure out the problem/delay is in the program.  
 Disable  
 All  
 .... one entry per program window/dialog (Available window, Bandmap 

window etc.)  

 Save Window Positions - Save the current window positions to the .ini file.  

 Window positions are automatically saved when the program is closed.  



o Window positions are saved per operator. Use Ctrl+O to enter the call of the operator, 

and click ''Save Window Positions'. The next time that operator signs on (using 
Ctrl+O), the window setup will be adjusted to the saved layout.  

 Restore Window Positions - Restore from the .ini file the most recent saved window 

positions. The screen will update immediately  
o Window positions are restored per operator (when saved first by the operator). Use 

Ctrl+O to select Operator and press 'Restore Window Positions'. The windows will 
change to their new positions immediately. This enables easy reconfiguration of the 
screen when changing operators at a multi-op.  

 

Note 

More info about rotator control can be found in the Supported Hardware chapter under Rotator control 

16. Config Menu Selections 

 

16.1. Configure Ports, Telnet Address, Other - Also called Configurer. 

This a very important dialog which can change the program's behavior. This menu opens the 
configuration dialog to modify setup options. Go here for detailed documentation of this dialog.  

16.2. Change Your Station Data 

http://n1mm.hamdocs.com/tiki-index.php?page=Rotator+Control&structure=N1MM+Logger+Documentation
http://n1mm.hamdocs.com/tiki-index.php?page=Configurer
http://n1mm.hamdocs.com/tiki-index.php?page=Configurer


Modify overall Station information - name, call, address, state, latitude, longitude, etc. The callsign 

entered here is very important for most contests, It determines what country you are in, which may in 
turn affect the required exchange, scoring, which stations may be worked for contest credit, etc.  

16.3. Change Band Plan 

When you click on this choice, you will be shown a sub-menu of the CW, SSB and Digital band plans. 
Pick one of these and you will see a table of frequency ranges like this:  

 

The first thing to do is use the scroll bar to get back to the HF and low-VHF bands.  

Note that a default set of sub-band edges is loaded, which may or may not accord with the ones you 
use in your area. Also note that the SSB sub-bands are narrower than the CW sub-bands, and that the 
digital sub-bands are the narrowest of all. This is essential to proper operation of the program, so be 
sure to observe these requirements if you change the sub-bands. The program also assumes that the 

sub-bands do not overlap - if they do, bandmap coloring will reflect digital subbands first, then CW, 
and SSB last - this can lead to some confusion.  

When "Use Radio Mode" is checked on the Configurer dialog's Mode Control tab (this is the default 

setting), the only effect of these sub-band settings is to color the frequency scales in the Bandmap - 
blue for CW, black for SSB, magenta for digital modes, and red for outside the band. In this case, your 
radio mode and the set of function keys selected is controlled only by the radio's mode setting.  

When you invoke Follow Band Plan on the Mode Control tab, the program's behavior changes. If you 
click on the Bandmap within a sub-band designated for a given mode, or click on a call in the Available 
Mults and Qs window which is on a frequency in a sub-band whose mode is different from that the 
radio is on now, then the radio and function key definitions will change to match the new frequency.  

http://n1mm.hamdocs.com/tiki-index.php?page=Configurer#Mode%20Control%20Tab


You can edit each sub-band table to add or change these sub-bands. Use the same editing technique 

used in editing the Function Key definition tables and other tables throughout the program. The 
editing techniques are a little quirky, but they are required by the database engine, and you will 
quickly get the hang of them. Again, make sure your SSB sub-band (on any given band) is narrower 
than the CW sub-band, and that your digital sub-band on that band is narrower yet.  

A final caution - if you tune your radio manually across a sub-band boundary, or use an Up/Down 

button on the radio to jump across one, you will see that the Function key buttons change to the 
appropriate mode, but the radio's own mode does not change - you will have to do that manually. If 
you are operating in a mixed-mode contest, you will probably want to get in the habit of doing both - 
frequency jump and mode change - manually at the radio, or else grab a spot in the new mode sub-
band to keep everything on the same page.  

16.4. Clear INI file settings 

Option to clear out the 'N1MM logger.ini' file. Could be used when having Configurer troubles. Radio, 
port etc. settings will be lost when using this item.  

16.5. Find all windows (move to within 800 *600) 

Option to force all windows onto primary 800 x 600 screen. Great when coming from a higher 
resolution screen or a two monitor setup and windows are 'missing on the screen'.  

16.6. Enter Sends Messages (ESM mode) 

Ctrl+M - A mode of operation frst introduced by N6TR in TRLog, and much improved in N1MM Logger. 
The program anticipates the needed sequence of messages to complete a QSO in either Run or Search 
& Pounce mode, and sends each one in turn by simply hitting Enter. See ESM for further details.  

16.7. Set CW AutoSend Threshold - Ctrl+Shift+M 

Start sending the callsign after a certain number of characters typed AFTER the last number in the 
callsign. The minimum threshold is 1. 0 will turn off the feature. Only when in RUN mode, not in S&P. 
More info in the chapter on Key Assignments (Keyboard Shortcuts) in the Logging Key Assignments 
section.  

16.8. Spot all S&P QSOs 

Spot the contact when you log it.  

If this option is checked, a contact is automatically spotted when:  

 You complete the QSO in S&P mode and  

 the spot is not already on your Bandmap at the same frequency (+/- the tuning tolerance)  

The Packet and Telnet window has a right click menu option that allows the user to specify a comment 
for spots, which may include logged QSO field(s).  

16.9. QSYing wipes the call & spots QSO in bandmap 

Very useful for S&P. If you enter a station's call in the entry window, and then tune off for any reason 
(he doesn't answer your call, or...) the call is shown bold in the bandmap. The setting of this feature 
remains as it was across program restarts.  

http://n1mm.hamdocs.com/tiki-index.php?page=ESM+%28Enter+Sends+Messages%29#ESM_Enter_Sends_Messages_
http://n1mm.hamdocs.com/tiki-index.php?page=Key+Assignments+%28Keyboard+Shortcuts%29&structure=N1MM+Logger+Documentation#Logging_Key_Assignments


If you set >Config >QSYing Wipes the Call & Spots QSO in Bandmap, it will spot stations in the 

bandmap which you haven't worked yet or don't want to work all. These stations are not spotted on 
packet/telnet but only locally. Any call greater or equal to 3 characters that you don't work but have 
entered in the callsign field will be automatically spotted in the bandmaps when you turn the VFO to 

another frequency. This way you can place stations on the bandmap which you can't work direct (big 
pileup?) so want to store them somewhere. Also useful when you want to add stations to the bandmap 
who you don't want to (or may not) work but like to have the callsign in the bandmap so when 
searching for stations you know who is on that frequency so you can tune past it without stopping to 
check who it is.  

All bandmap features work on these 'spotted' stations so they are easy accessible if needed. Self 
spotted stations are easily recognized because they are shown in bold. This feature is also very useful 
in a M/S or M/M environment. Often there is a MULT station that is tuning the bands, but may not 
want to post the spot until the QSO has been worked by their own RUNNING station. (I do not wish to 

get into an ethics discussion, but this is done quite often) This feature allows the MULT station to build 
a band map full of calls for the RUNNING station to work when it gets a chance.  

That means you can do the following:  

 Tune to 21200.  

 Enter VU2PTT.  

 Tune off.  

 VU2PTT is "spotted" at 21200, and the Entry Window is cleared.  

 Tune to 21208.  

 Enter G4UJS.  

 Tune off.  

 G4UJS is "spotted" at 21208, and the Entry Window is cleared.  

 Repeat as long as desired.  

 Go back and work all of them using Ctrl+Up and Ctrl+Dn to navigate.  

 

Spot All S&P QSOs 

There is also a >Config >Spot all S&P QSOs option. It has a number of rules, but will spot everything 

you WORK on packet, if it has not already been spotted on the same frequency. 

16.10. Do not automatically switch to run on CQ-frequency 

When selected and you QSY back to an old Run frequency, the mode stays in S&P. F1 and Alt+Q 
continue to switch to Run mode. This is most useful in Sprint-like contests, where you QSY frequently 
and want to avoid unexpected switches to Run mode  

16.11. Show non-workable spots in bandmap 

This allows non-workable spots and logged contacts to be hidden. . If you hide spots, you will likely 

never utilize the program to its full advantage, especially S&P. If you don't know why I am saying this, 
then don't hide spots.  

16.12. Reset Rx freq to TX when QSO is logged (RUN and split) 

When using the main VFO to transmit and the other to receive (split mode) after each logged QSO the 
RX frequency will be made equal to the TX (main VFO) frequency. It resets after every RUNNING QSO. 
Using a radio with VFOs A and B, this feature is ithere to let you use the main frequency control as an 
RIT. With Main/Sub radios like the Icom 756/7800 series you can not RX on SUB without receiving on 
both VFOs. In this case put RX on Main and TX on SUB for Alt+S to work.  



16.13. Dual Rx always on 

Yaesu FT-1000 series, Icom IC-756 series, IC-781 ,IC-775 and IC-7800, Elecraft K3 with subRX only: 
Selects the mode for Dual Receive toggle (Alt+F12).  

 When selected -  
o Yaesu FT-1000 series: The sub receiver will be left on (blinking green RX led)  

o Icom IC-756 series, IC-781 ,IC-775 and IC-7800 only: Dual watch is not turned off 
when you switch from SUB to Main with Ctrl+Left Arrow or PAUSE  

o Elecraft K3: The sub receiver will be left on  
o Not selected - The sub receiver will switched off (RX led off)  

16.14. CQ Repeat - Alt+R 

Toggle for repeat CQing.go into repeat mode. With Winkeyer, beginning to enter a call-sign in the 

Entry Window terminates the CQ, but the program remains in CQ repeat mode. The function is 
automatically turned off when no longer on the CQ-frequency and the mode changed to S&P mode.  

16.15. Set CQ repeat time - Ctrl+R 

Specify the repeat interval (CW or SSB with sound card) in seconds. The default value is 1.8 seconds.  

16.16. Call History Lookup 

When enabled, Call History Lookup can be used to pre-fill the exchange during a contest to save 
typing, or to display user comments or notes for specific call-signs. Reverse Call History Lookup uses 
the same Call History file to find stations whose exchanges fit what you have entered in the Exchange 
field. It is enabled by the same Config menu entry. Follow the links above for the full story.  

16.17. Filter Blacklisted Packet Spot Calls 

When checked, spots of blacklisted calls will not be displayed on the Bandmap or in the Available 
window. Adding calls to the Blacklist can be done from the right-click menu in either Bandmap, or by 
importing a file. See the entry Window's File menu.  

16.18. Change Packet/CW/SSB/Digital Message Buttons - Alt+K 

Change the contents of the Packet/CW/SSB/Digital message buttons (Elsewhere called Function Key 
definitions). The maximum length of text in each Packet, CW, SSB and RTTY button is 255 characters. 
Alt+K will access the relevant list of definitions, depending on the mode you are in, or you can right-
click in the button area to get there . The first 12 rows are for Run mode definitions (F1-F12), and the 
second 12 are for S&P mode. (also F1-F12). The row-to-key association is fixed — that is, the third 

row in the table is Run F3, and the 14th is S&P F2. Empty rows must have something in them - it can 
be a single space, for example.  

If you wish, you can supply a single set of definitions (12 rows), and the program will use it for both 
Run and S&P mode. Alternatively, you can supply S&P F1 and F2, for example, and leave the 
remainder empty - the program will substitute only the first two S&P definitions when in S&P mode  

Also note that if you use a "&" character in a button caption, such as "S&P Exchange", you need to 
double it (S&&P) to avoid problems with a reserved Windows function.  

 Change CW Buttons - Change the contents of the CW buttons.  

http://n1mm.hamdocs.com/tiki-index.php?page=Call+History+and+Reverse+Call+History+Lookup
http://n1mm.hamdocs.com/tiki-index.php?page=Call+History+and+Reverse+Call+History+Lookup


 Change SSB Buttons - Change the contents of the SSB buttons (.wav files). Please use the 

file chooser buttons to the right of each row.  

 Change Digital Buttons - Change the contents of the Digital buttons.  

16.19. Multi-User Mode 

Start the networked mode of N1MM logger (Multiple computers connected to each other).  

 Multi-User Tools - Menu with Multi User stations tools. For more detailed info see the chapter 
on Multi-User Support?.  

 Edit Station Computer Names - Associate the computer numbers (starting with 0 for the 

master station) with their IP-addresses for use in Multi-User mode..  

 Change Operator - Ctrl+O - Change the callsign of the operator. If you are multi-user, you 

will be prompted for the operator at startup. The default is the callsign in the station 
information dialog. Entering "OPON" in the callsign field will also prompt for an operator 
callsign.  

 

16.20. Change Exchange Abbreviations 

N1MM Logger recognizes a number of alternative forms for the standard abbreviations used in Cabrillo 

logs to denote multipliers. The tables accessed from these relate the alternative and standard forms. 
Here is an example:  

 

This table is edited the same way as the function key definitions tables, but since it is unlikely that you 
would ever need more than one table, any changes are saved in the database and cannot be 
exported. If you use multiple databases, you will need to make the same changes in each. 

http://n1mm.hamdocs.com/tiki-editpage.php?page=Networked-Computer+Support


Note that the right column is the official abbreviations. normally, you should not edit this column 

unless the contest sponsor changes its official abbreviations. The left column, on the other hand, can 
be changed at will, so long as each left column entry is associated with a right-column official 
abbreviation. You'll note that for the official abbreviation to be recognized, it must appear in one row 

as both the Abbreviation and the Section. In the example above, for example NT is equated to NT, 
and so is YT.  

 Change ARRL Section Abbreviations - Change table of ARRL Section abbreviations.  

 Change QSO Party Abbreviations - Change the table of county abbreviations for a given 

QSO Party. you must have previously selected a particular QSO Party in the contest Setup 
dialog. Again, be extremely cautious in changing the right-hand column unless you are sure 
that the QSO party sponsor has made a change.  

16.21. SO2R 

More info about Single Operator Two Radio operation of the program can be found in the SO2R 
chapter.  

 Dueling CQ's - Ctrl+B - SO2R feature that alternates sending CQ on each radio in turn, 
listening on one while transmitting on the other. Supported for both CW and SSB.  

o Changing either radio in frequency more than 200 Hz will terminate Dueling CQ.  

 Set Dueling CQ Repeat Time - Adjusts time after CQ ends on one radio before it starts on 

the other. In seconds.  

 Advanced SO2R - Ctrl+Shift+I - toggle 'Advanced SO2R' mode. See Advanced SO2R  

 Advanced SO2R Delay Time - Ctrl+Shift+N - Adjustable delay for Advanced SO2R.  

 Focus on Other Radio - Ctrl+Shift+K - FocusOther, See FocusOther  

 FocusOther Always Swap - Focus always switches to the other radio when one radio is 
transmitting, and always switches back to the original radio when transmission is completed.  

 Toggle CTRLFx Macro - Ctrl+Shift+L - When enabled and present in one of the function 

key definitions, the {CTRLFx} macro executes Fx (Function key definition x) on the opposite 
radio. An example is TU{CTRLF1} in Radio 2's F3 slot, which sends TU and then sends the 

other radio's F1, used to get quickly back to the Run radio and call CQ after finishing an S&P 
QSO on Radio 2.  

 TX Lockout (Digital) - Select a lockout option. Also MIXED mode category is supported i.e. 
blocks second TRX on the same band and mode. This doesn't prevent RX overload. For digital 
modes only.  

o Multi-TX - This is the default setting. Start CQ on radio A, next a CQ on radio B, both 

are active. (no lockout)  
o First one wins - Start CQ on radio A, pause, Start CQ on radio B. The radio B CQ is 

ignored since radio A is already active, so if you press a F-key for the second radio 
while radio1 is transmitting, the radio B F-key is ignored.  

o Last one wins - Start CQ on radio A (CQ starts), pause, Start CQ on radio B. The CQ 
on radio A will aborted and the CQ on radio B will start so if you press a F-key for the 
second radio while radio A is transmitting, the radio A transmission is interrupted and 

radio B transmits.  

 Toggle SO2R Mode (Soundcard) - Ctrl+I - Used only with soundcard-based SO2R, also 
called "$5 SO2R"  

16.22. WAE - Special commands for the WAE DX contest only 

 Toggle WAE QTC mode - Ctrl+Z - Toggle the WAE QTC mode between QSO and 

sending/receiving QTCs. See WAE contest setup instructions.  

 WAE Received QTC Confirmation - Enter the WAE confirmation string or .WAV file (CW/SSB 
only - RTTY messages are configured in the Digital Setup window)  

http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29&structure=N1MM+Logger+Documentation#Advanced_SO2R
http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29&structure=N1MM+Logger+Documentation#Focus_on_Other_Radio_FocusOther_
http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29&structure=N1MM+Logger+Documentation#Sound_Card_Options
http://n1mm.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Documentation#WAEDC_contest_CW_SSB


 Max QTC Number for callsign colors in Band Map - opens a dialog box to allow you to set 

the number of QTCs to be used for displaying the special colors in the bandmap for stations 
with QTCs remaining  

 Ctrl-Z sends QTC? automatically (EU stations, Run mode only) - When this option is 
checked, pressing Ctrl+Z while in Run mode automatically sends QTC? and puts the program 
into QTC mode (CW only, EU stations only)  

17. Window Menu Selections 

 Available Mult's and Q's - Display the Available Mult's and Q's window. More info in the 

Available Mults and Qs Window chapter  

 Bandmap - Display the Bandmap window. In SO2R/SO2V each Entry window has its own 

Bandmap window. More info in the Bandmap Window chapter  

 Check - Display the Check window. More info in the Check Partial Window chapter  

 CW Key Ctrl+K - Display the CW Key window. Pressing Ctrl+K again or Enter will close the 

window but will continue sending the message. Pressing Escape will stop sending the 
message. The windows is multiline (for pasting in text) and can be resized. The font type and 
size is the same as used in the Entry Window  

 

 

 Digital Interface - Displays the Digital (RTTY/MMTTY/PSK) Interface window. In SO2R/SO2V 

each Entry window has its own Digital Interface window (DI1 and DI2 respectively). More info 
in the Digital modes chapters  

 Entry Window - Display the Entry Window  

 Gray Line - Open the optional to install Gray line program (only for Windows NT, 2000, XP or 
newer). More info in the Grayline Program chapter  

 Info - Display the Info window. More info in the Info Window chapter  

 Log Ctrl+L - Display the Log window (toggles between open and minimized). More info in the 
Log Window chapter  

 Multipliers by Band - Display the multipliers by band window. More info in the Multipliers by 

Band Window chapter  

 Packet - Display the Packet/Telnet window. More info in the Packet Window chapter  

 Score Reporting - Start the realtime score reporting application. More info in the Contest 
Reporting Application section in the Third Party Software chapter  

 Score Summary - Display the score summary window. More info in the Score Summary 

Window chapter  

 Visible Dupesheet - Display the Visible Dupesheet window. More info in the Visual Dupesheet 
Window chapter  

 

Ctrl+Tab toggles between the Entry window and Packet windows. If other windows are added that 
have text boxes, then they will be accessed in a round-robin basis via Ctrl+Tab.  

18. Help Menu Selections 
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 EntryWindow Specific Help (Internet) - Shows the Entry Window sub-section of the 
Windows chapter of the Digging Deeper section of the on-line manual. All Help menu choices 
with (Internet) require an active Internet connection to work.  

 Manual Index (Internet) - Shows the full index of the on-line manual.  

 Supported Contests & Setup (Internet) - Shows the Supported Contests chapter of the 

on-line manual.  

 Key Assignments (Internet) - Shows the Key Assignments list from the Digging Deeper 

section of the on-line manual.  

 Revision History & Latest Update Download (Internet) - Shows the Latest Update 

section of the Files Menu on the web site.  

 N1MM Logger Manual - Read the manual off-line. There is a link on the Tools menu that will 

download this file - be sure you download it into the N1MM Logger program directory. 
Requires Adobe Reader or another .pdf reader.  

 Contest rules for this contest (Internet) - Go to the web site from the contest sponsor on 
the Internet where the rules can be found.  

 WA7BNM Contest Calendar(Internet) - Go to WA7BNM's contest calendar site on the 
Internet.  

 User Questions & Discussion Group(Internet) - Go to the Yahoo Discussion Group page 

on the Internet.  

 Bug Report Form (Internet)) - Go to the form on the N1MM Logger web site. Please note, 
this is not the place to report difficulties such as installation or setup problems - far 

better to use the Yahoo group for that  

 Feature Request Form (Internet) - Go to the form on the N1MM Logger web site  

 View Error Log - View the latest 'Errorlog.txt' file generated by the program. The program 

creates and updates the contents of this file when the program generates an error. This could 
be used to help pinpointing a problem in the program.  

 Report Score to 3830 (Internet) - Go to the 3830 score reporting site on the Internet.  

 About N1MM logger Vx.x.xxx - Show the About Dialog.  

 



2.6.2 The Log Window 

 2.6.2 The Log Window  

o 1. Keyboard Assignments  
o 2. Mouse Assignments  

Your Log window will be similar to this one.  

 

 The top grid is the log  

 The bottom grid shows the contacts in yellow that match the partial or full call entered in the 
Entry window. It is sorted by band, call, date & time.  

 The separator bar is set at a percentage of window size. When shrinking the window, both 

sections get smaller. After resizing the window, decide how much space to allocate to dupes 
by setting the separator bar.  

 The upper pane gives date and time (in UTC) and the selected contest.  

 When a Multi operator mode (Multi-One, Multi-Two, Multi-Multi) is selected:  
o The operator name is shown in the log window  
o The radio number is shown in the log window  

o Group edits are not allowed while in multi-user mode.  
o Editing a qso is only allowed from the station who did make the qso, not from other 

stations.  
o A column will be added to the log window with Run1Run2  

 
The relative sizes of the grids can be adjusted by clicking and dragging the gray bar between the 
grids. The adjusted window size and the column width are saved by the program.  

In a serial number contest the serial numbers in the log window will be displayed without any leading 
zeros even when zeros are entered before the number (like 001). When printing the leading zeros will 
be added again and printed.  

1. Keyboard Assignments 

 Enter - Edit the contact which is selected.  

 Delete (Ctrl+D) - Delete the contact which is selected.  



2. Mouse Assignments 

 Left mouse button click  

o Single click on column title - Change log sort order using the selected column. 
Second click on a column will sort descending.  

o Double click on a contact - Quick Edit the contact.  

 Right mouse button click  

o Right-click on a contact - Displays a menu:  
 Quick Edit Contact - Quickly edit the current contact using the Entry window 

fields. Ctrl+Q moves back one qso, Ctrl+A moves forward one qso. If the 
textboxes background in the Entry window are colored blue, you are in Quick 
Edit mode. To exit, press enter to save changes or Escape to abandon 
changes. Quick Edit starts editing with the highlighted contact and you can 
move forward or back from there. Enter logs the changes made and Escape 

discards the changes bringing you back in normal logging mode.  
 Edit Contact - Edit the contact. See this page for further information.  

 Delete Contact (Ctrl+D) - Remove the contact from the log.  
 Play Contact - Used to play back contacts recorded using the qsorder.exe 

program by K3IT (see References, Third Party Software). This selection will be 
gray, if there is norecording file for this contact. If it is not gray, the selection 

can be chosen and the contact audio will play on your default sound player. 
(Make sure you don't have the sound card hooked up at that moment to your 
microphone!)  

 Jump to this frequency - Jump to the frequency logged with this contact  
 Graph Q rates up to this entry - For a historical display of rates from an 

existing log with QSOs in it, the procedure is to decide the point at which you 
want to examine your rate in the preceding 30 or 60 minutes. Highlight that 

point in the log window, and then right-click. Look for the option "Graph Q 
rates up to this entry" and click OK. That will open a new window, on which 
you can right-click for the same options as in the real-time window.  

 

 Menu items:  

 The period  
 30 minutes / 60 minutes  

 The number of bars to show  
 6, 10, 15, 20  

http://n1mm.hamdocs.com/tiki-index.php?page=Edit+Contact+Window


 Raw QSO count  

 Hourly rate (Q's/hr)  
 10 min moving avg  
 20 min moving avg  
 30 min moving avg  

o www.qrz.com - Ask information about this station using www.qrz.com (name, 

address etc.). An Internet session should be available.  
o Change All Contact Timestamps by a Fixed Amount -this will fix a log where all 

QSOs are off by a common amount of time  
 Put mouse over log window and right click  
 Select 'Change All Contest Timestamps by a Fixed Amount'  
 Dialog box will open, and enter offset time (+ or -) in minutes  
 The date will automatically adjust if the offset rolls a QSO into a different day. 

The time is entered in minutes, and can be a negative time to go backwards. 
(You might need a calculator to determine the offset in minutes if your date 
was off by many days, months, or years)  

 NOTE: While you can easily adjust for a mistake by doing another offset, it is 
advisable that you backup your log before making any changes.  

o Change Operator - Change operator callsign for this contact (Multi-user). The default 

is the station callsign. When selecting several rows, the change will be applied to all 
rows. This operation is not reversible. See example picture.  

 

o Change Mode - Change the mode for this contact. When selecting several rows, the 

change will be applied to all rows. This operation is not reversible. See example 
picture above.  

o Change Rx Tx Frequency (and band) - Change the RX and TX frequency for this 
contact. When selecting several rows, the change will be applied to all rows. This 
operation is not reversible. See example picture above.  

o Change Station Number - Change the station number for this contact (Multi-user). 
The Master station always has number 0. When selecting several rows, the change will 
be applied to all rows. This operation is not reversible. See example picture above.  

o Find all contacts with a station - Search a call (station) in the logged contacts from 

this contest.  
o Set Start Interpolation Time Row - Set the start row and time from where the time 

interpolation has to begin. An example how to use can be found in the After the 
contest chapter.  

o Set Stop Interpolation Time Row - Set the stop row and time from where the time 
interpolation has to stop. This menu item is only highlighted when a start time has 

been entered. An example how to use can be found in the After the contest chapter.  
o Rescore from this point on - Rescore the contest starting with this logged contact 

till the end of the log.  
o Delete custom column widths - Delete the custom column widths and go back to 

the default column widths as set per contest (by the programmer).  
o Show Mode - Select or deselect showing the mode behind all other columns in the log 

window.  

o Show Date - Select or deselect showing the date in front of the time (first column log 
window).  

o Select All - Select all QSOs in the log (for copy and paste actions)  

http://n1mm.hamdocs.com/tiki-index.php?page=After+the+Contest
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o Copy  

 Copy Generic Print String - Copy generic print string to clipboard  
 Copy ADIF String - Copy ADIF string to clipboard  

o Set Font - Set the font for the Log window, a selection window will appear.  
o Help - Show the help file for this window.  

 

2.6.3 The Bandmap Window 

 2.6.3 The Bandmap Window  

o 1. One radio scenario  
o 2. Two radio scenario  
o 3. Other  
o 4. Colors of the incoming spots:  

o 5. Keyboard Assignments  
o 6. Button Assignments  
o 7. Mouse Assignments  
o 8. Example bandmap usage  

Your Bandmap window will be similar to these.  

 

 

 

The Bandmap Window represents a VFO or a radio. There are three scenarios: one radio with 1 VFO 
displayed (SO1V); one radio with 2 VFOs displayed (SO2V); or two radios with one VFO shown for 
each radio (SO2R). The bandmap is made zoomable to the complete band size.  



1. One radio scenario 

 
With one radio in SO1V mode, only one bandmap can be displayed. With one radio in SO2V mode, two 
bandmaps may be displayed,m one for each Entry window. Each bandmap holds one VFO. Typically, 

VFO-A will be on the left and VFO-B will be on the right. If you want to change VFOs, just use the 
mouse to click on one of the spots in the bandmap or use the Ctrl+left & Ctrl+right arrow keys to 
change VFOs. The radio information box at the top of the bandmap will change colors as you change 
VFOs. The selected Bandmap or Entry window will have a blue top.  

2. Two radio scenario 

 
With two radios the operation is exactly the same, except that each bandmap represents one of the 
radios. It is best if one orients the bandmaps in the same position as the radios, left-right or top-
bottom. This will make operation more intuitive.  

3. Other 

 It is well worth your time to quickly review the Mouse Assignments below in order to become 

familiar with the functions that the Bandmap provides.  

 Also important! The usefulness of the Bandmap is greatly enhanced by reading the Key 
Assignments  

 The text CQ-Frequency will be shown on the bandmap when running stations. It is 
automatically marked when you press the CQ-button (mostly the F1-key).  

When a spot is less than three minutes old NEW will be placed behind the call and bearing in the 
bandmap. When the station works split the receive frequency (QSX frequency) will be shown behind 
the bearing after the spot is three minutes old, there is not enough room to give both NEW and the 
QSX frequency. Splits are shown as 3 digits on HF. The bearing to a station is shown only for stations 

outside your own country with exceptions for USA and Canada. When calculating the bearing the 

section or state from the callhistory is being used otherwise the coordinates of the state that is the 
closest to the middle of the callarea is used.  

 On the title bar of the bandmap you can see what type of radio is connected. It will show 
Manual - A when no radio is connected or as an example Kenwood VFO A when a Kenwood 
radio is connected. It will show a B for the other bandmap/VFO.  

 Normally only one frequency is shown in the top portion of the bandmap. This is the receive 

and transmit frequency. When working split the transmit frequency is added and shown just 
below the receive frequency in a smaller font.  

 Busted spots (calls with "BUST" in the comment) are not shown on the bandmaps (when 

coming in via packet/telnet).  

 When both bandmaps are closed the frequency and mode is shown on the title bar of the 
Entry window before the contest name.  

 During busy contests the default zoom is too dense. Use the right-click menu to zoom or use 

the numeric pad +/- keys.  

 New calls will show up first in the bandmap, ahead of old calls on the same frequency.  

 A zone only multiplier will be shown in red (except "non-workables"). The exception means 
that in CQWW, your own country will show as gray, even if it is a multiplier.  

 Country of unknown callsign (like TX5A in 2006) will be made equal to the prefix to force it to 
be a new country.  

o Better a broken callsign then missing a multiplier.. If it is a broken callsign the user 
can delete the spot.  

 A sunrise/sunset indicator (Ãƒâ€šÃ‚Â¤) is shown for spots from stations where applicable.  



 CW Skimmer spots are marked with "#" in spotter's callsign as skimmer spot in the bandmaps 

(see picture at right above). If spotter's callsign contains your (Station dialog) callsign, then 
the spots are marked with a "!".  

4. Colors of the incoming spots: 

 Blue: QSO  

 Red: Single Multiplier Example: CQWW - QSO is either zone or country multiplier (one 

multiplier)  

 Green: Double or better Multiplier Example: CQWW - QSO is a zone and a country multiplier 
(two multipliers)  

 Gray: Dupe  

 Bold - This is a self spotted call ('Stored' or by using the feature 'QSYing wipes the call & 
spots QSO in bandmap') and is not coming from the cluster.  

Note- A different set of color codes is provided for the WAE contests, to assist with QTCs. Read about 
it here  

5. Keyboard Assignments 

 Mouse wheel - Zoom in or out the bandmap which has KEYBOARD focus.  

 Numeric keypad + key - Zoom In to show less spots from the bandmap which has 
KEYBOARD focus.  

 Numeric keypad - key - Zoom out to show more spots from the bandmap which has 
KEYBOARD focus.  

 Shift - Numeric keypad + key - Zoom In to show less spots from the bandmap which does 

NOT have KEYBOARD focus.  

 Shift - Numeric keypad - key - Zoom out to show more spots from the bandmap which does 
NOT have KEYBOARD focus.  

 
Jump to Spots on active radio/VFO  

 Ctrl+Down Arrow - Jump to next spot higher in frequency.  

 Ctrl+Up Arrow - Jump to next spot lower in frequency.  

 Ctrl+Alt+Down Arrow - Jump to next spot higher in frequency that is a multiplier.  

 Ctrl+Alt+Up Arrow - Jump to next spot lower in frequency that is a multiplier.  

 
Jump to Spots on non active radio/VFO  

 Ctrl+Shift+Down Arrow - Jump to next spot higher in frequency on the inactive radio/VFO. 

This will skip over CQ-Frequency when radios/VFOs are on the same band. Proper keystroke 
operation is radio dependent. Disabled for SO1V.  

 Ctrl+Shift+Up Arrow - Jump to next spot lower in frequency on the inactive radio/VFO. This 
will skip over CQ-Frequency when radios/VFOs are on the same band. Proper keystroke 
operation is radio dependent. Disabled for SO1V.  

 Shift+Ctrl+Alt+Down Arrow - Jump to next spot higher in frequency on the inactive 
radio/VFO that is a multiplier. If you are operating single mode, your mode won't change when 
jumping between spots. Disabled for SO1V.  

 Shift+Ctrl+Alt+Up Arrow - Jump to next spot lower in frequency on the inactive radio/VFO 

that is a multiplier. If you are operating single mode, your mode won't change when jumping 
between spots. Disabled for SO1V.  

 Shift+Alt+Q - Jumps to your last CQ frequency on the inactive VFO/radio. Disabled for SO1V.  

http://n1mm.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#WAEDC_contest_CW_SSB


6. Button Assignments 

 SH/DX - Send a request to the Packet/Telnet window to send a SH/DX command to the 

cluster  

 Narrow/Wide - Toggle the radio filters from Wide to Narrow, or vice versa. The label 
indicates the current state. The label is not shown for some radios (like FT-817) and manual 
radios.  

 RIT Offset (e.g. -0.08) - Click this label to clear the RIT offset.  

 RIT - Click this label to toggle the RIT on and off.  

 XIT - Click this label to toggle the XIT on and off.  

 CW/USB/LSB/RTTY/PSK/AFSK/AM/FM - Click this label to toggle from USB/LSB (band 
sensitive) via RTTY to CW/PSK/AFSK/AM/FM (radio dependent).  

7. Mouse Assignments 

Left-click menu  

 Click on frequency - Jump with the active VFO/radio to that frequency.  

 Shift+Click on frequency (SO2R only) in Inactive Bandmap - Program the non active radio 
without changing window focus. Allows you to be active and sending on one radio and change 

the frequency on the non active radio without changing Entry window focus.  

 Shift+Click on bandmap callsign (SO2R only) in Inactive Bandmap - Same as Shift+Click on 
Frequency with the addition that the callsign is placed on the non active radio's callsign frame.  

 Click on call - Jump to that frequency and place the call on the Entry window callsign frame. 

When the callsign field is empty, giving space will copy the callsign from the Entry window 
callsign frame to the callsign field. Also clicking on the callsign in the callsign frame will place 
the call into the callsign field, replacing anything that was previously there.  

 Double-Click call - Jump to that frequency, place call into Entry window callsign field, replacing 

anything that was previously there. Spots with 'Busy' in the call will be ignored (placed in the 
bandmap when using Alt+M).  

 Click dial ticks - Jump to that frequency.  

 Click frequency label - Jump to that frequency.  

 Right Click call - Display the right-click menu for the selected call (see Right-Click menu 

below).  
o The selected call will be shown italic and underlined when right-clicking on it  

 Right Click anywhere else - Display the right-click menu with some options grayed out which 
are call related.  

 
Right-click Menu Options  

If you right click in the Bandmap Window the right-click menu will appear. In the left-hand illustration, 

the menu is shown as it appears when you click on the window, not on a particular spot. The right-
hand illustration shows how the menu looks if you right-click on a specific spot.  





 

 Remove Selected Spot - equivalent to Alt+D with the spot callsign in the call-frame; 

removes the selected spot.  

 Blacklist callsign - if you click on this option and the Filter Blacklisted Spot Calls option in 
the Packet Filters sub-menu of the Packet/Telnet window's right-click menu is enabled, then 

subsequent spots of that station will not be displayed on the Bandmap or in the Available 
window. Used to get rid of busted spots that recur often, such as LW3LPL. To edit the list of 



blacklisted spots, or to remove a call from the list, use the Right-click menu in the 

Packet/Telnet window.  

 Blacklist Spotter - designed in particular for use when an RBN station is feeding spots that 

are badly off-frequency (due to I/Q image problems) or otherwise defective. Could also be 
used for the occasional harasser on traditional DX clusters. Again, this feature is 
enabled/disabled in the Packet Filters sub-menu of the Packet/Telnet window's right-click 
menu; the blacklist can also be edited from the Packet/Telnet window.  

 Zoom In (Numeric Pad + or Ctrl+Scroll wheel if using a mouse.) - Show a wider frequency 

range on the Bandmap that has entry/RX focus.  

 Zoom Out (Numeric Pad - or Ctrl+Scroll wheel) - Show a narrower frequency range on the 
Bandmap that has entry/RX focus.  

 Go to Bottom of Band - Go to the bottom of this SSB/CW subband.  

 Go to Top of Band - Go to the top of this SSB/CW subband.  

 Remove Spots, This Band Only, Leave Self Spots  

 Remove Spots, This Band Only  

 Remove Spots, ALL BANDS, Leave Self Spots  

 Remove Spots, ALL BANDS  

 Show Last 10 Spots - click this option (which is gray unless a callsign has been clicked on) 
and the cluster will be asked for the last 10 spots of that station. These are displayed in the 
Packet/Telnet window.  

 Show Buck/Packet - requiests address information from the DX cluster  

 Show Station - sends the SH/STA [callsign] command to the DX cluster  

 Show QSL/Packet - sends the SH/QSL [callsign] command to the DX cluster  

 Show Sunrise/Sunset - sends the SH/SUN [callsign] command to the DX cluster  

 Show Buck/Internet - opens QRZ.COM in your default browser for manual entry of the 
callsign.  

 Show Buck Local - opens a call-sign database installed on the same computer as N1MM 

Logger  

 Set transceiver offset frequency - This is for transverter supporting transverters. The 
transverter offset is saved when the program closes and read again when opened. Remember 

to enter the frequency of the transceiver and not that of the transverter when going into split 
mode (Alt+F7). Information how to fill in this table (which frequencies to enter and how to 
calculate the IF frequency) can be found in the VHF and Up Contesting chapter.  

 

 Set transceiver timeout time - Timeout value for each radio (default is 10 seconds). 
Entering a value of zero will disable the timeout. Entering a negative number will set the time 

out value to 10 seconds. Entering a number that is too large for the program variable will set 
the timeout to the program maximum. The positive minimum is 5 seconds.  

 Set transceiver filter codes - You will be prompted for the wide or narrow string to set the 
filters. For Kenwood, it's pretty easy. You just look up in your manual the string you want and 
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enter it. For other radios, like FT-1000MP, its harder. You must enter a series of space-

delimited codes in DECIMAL. Therefore, when an FT-1000MP filter code of 0 0 0 0 8C is 
required, you must enter 0 0 0 0 140 (8C hex).  

To reset to the default values in the program enter a space and press the OK button. It is possible to 
use {CR} in the filter codes which will be replaced with the return character. These selection are 
disabled when manual radio is selected (i.e. no radio selected).  

o CW Wide  
o CW Narrow  

o SSB Wide  
o SSB Narrow  
o Digi Wide  
o Digi Narrow  

 Find a Callsign (use Alt-F8 to return) - This option allows you to search for a particular 

callsign in the bandmap. Searches from current frequency up to find each instance. If you 
right-click on a call in the bandmap, it will search for that call on the next higher band. If you 

right click elsewhere it prompts for the callsign. Useful for finding a friend or a multi-multi you 
want to work on another band.  

 Bring to foreground when made active - This brings the active bandmap to the 
foreground. When not having enough real estate on the monitor screen it is possible to place 

both bandmaps on top of each other. The active bandmap will be shown hiding the non-active 
bandmap.  

 Reset Radios - Allow manual reset all attached radios. When contact with a radio is lost the 
dialog below will appear. Select 'Retry' to restore the connection with all attached radios or 
Right-Click on the bandmap and choose "Reset Radios" to restart the connection.  

 

 Packet Spot Timeout - Indicates how long (in minutes) spots are kept in the Bandmaps. The 

default is 60 minutes, any integer may be specified. For use with the Reverse Beacon Network 
(RBN), a very short timeout (10-15 minutes) is recommended to avoid overloading the 
program with the spot volume.  

 Packet Window Tools - Displays the Packet/Telnet window's right-click menu (convenience 

feature)  

 Why don't I see spots? (Show packet filters) - Click and a window will open showing the 
current spot settings in effect.  



 

 Help - Show the help file for this window.  

 

Packet Window Commands 

When a command is sent to the packet window, it is sent to whichever connection is active. 

 

When the connected cluster is a DXSpider cluster, select on Tab: Other in the Configurer 'Format for 
DX Spider cluster'.  

Hovering with the mouse over a spot  

Hovering with the mouse over a spot in the Bandmap gives the following info about the spotted 
station:  

 Exact frequency sent by spotter.  

 Callsign of spotter.  

 The time in minutes since the station was placed on the DX cluster network.  

 Comments sent with the spot.  

 The 'standard' country prefix from the spotted station  

 
Hovering with the mouse over RX arrow  
Hovering with the mouse over the RX arrow shows the frequency.  

8. Example bandmap usage 

by Tom, N1MM  

In Search & Pounce (S&P) the callframe will show you each spotted station as you come within "tuning 
tolerance" (user settable) of that station. I'm terrible at remembering whether I worked a station and 
on what frequency. With worked stations in the bandmap, the program will tell you that they are not 
workable again. You can tune by them more quickly. The same feature is useful in contests with 
unworkable stations.  

In a contest like CQ WPX, with (basically) no value multipliers, here is how I use the bandmap. 
Whenever I can't get a run going I start S&P on a band with a lot of unworked stations (use the 

available window). I use Ctrl+Up and Ctrl+Down arrow to go to the next station. If that station is at 



the beginning of a QSO, I move to the next one. If the QSO is near the end, I wait and work the 

station. Then I move on. If I reach the top of the band, I start coming back down the band, working 
the ones I missed on the way up. If there is no station at a frequency, that's my new running 
frequency!  

In contests with valuable multipliers, you should use Ctrl+Alt up/down to get the multipliers first, then 
go back and get the QSOs.  

If the rate drops fairly low, sweep the band using your VFO. That is where the old calls in the 
bandmap come in useful. If you copy a call, but it seems like it is going to take a long time to work 

him, tune to the next guy. If you have "QSYing wipes the call & spots QSO in bandmap" turned on, 
the call will be spotted in bold, so you can Ctrl+Up/Ctrl+Down to him later.  
Remember: if a call is in the callframe, space will load it into the call textbox.  

If all this seems very unfamiliar, you haven't read the Key Assignments help (and/or the Key 
Assignments Shortlist).  
Reading that single item is your single best time investment in using this program.  

Spots and the time shown  

When you hover with the mouse over a spot in the bandmap, it will show the relative age of a spot in 
minutes. The time shown here depends on the spot format. There are two formats for spots. One is for 
current spots, one is for SH/DX spots. Some clusters allow to show old spots in the current spot 
format. The program handles the two types of spots differently.  

 Current spots go into the bandmap with the computer's local (converted to UTC) time. This is 
to remove variations in cluster times and order the spots into the time they were received.  

 Old spots are logged with the originating cluster's time with the provision that it cannot be 
later than the current local (UTC) time.  

 
With AR-Cluster you can display old spots with SH/DX or SH/FDX. It is recommended to use SH/DX, 
as it will be recognized as an old spot. Other cluster software may have similar capabilities.  

Red lines indicating US license frequencies  

On the bandmap there are red lines to indicate extra, advanced and general portions of each band. 
Since US hams can operate only in their section and the sections of lower class licenses, it is in your 
interest to operate some in the higher portions of each band. Otherwise there are some US hams you 
will not ever be able to work.  

The lines can be found on:  

 SSB: 3775, 3850, 7225, 14175, 14225, 21225 and 21300.  

 CW: 3525, 7025, 14025 and 21025.  

 No lines on 160 and 10 meters.  

 

2.6.4 The Packet and Telnet Window 
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 19.1. AR Cluster V6's Spot Quality Filtering  

Your Packet/Telnet window will be similar to this one, with Packet and Telnet tabs. The former is used 
only when connecting to an RF packet cluster node. Unless specifically differentiated, references in this 
manual to packet also apply to Telnet. For example, "Packet Filters" and "Packet Spot Timeout" also 
apply to Telnet.  

 

 

The button values can be changed by right clicking on them or going into the menu: 'Config > Change 

Packet/CW/SSB/Digital Message Buttons > Change Packet/Telnet Buttons'.  
Connect and other messages are shown in the bottom pane from the Entry window. Status info for 
Telnet is given in the Telnet window title. Focus is set to the Entry window when one of the 12 buttons 
is clicked.  

All incoming DX spots are placed on the bandmaps. Also the spots requested with commands like 
SH/DX etc. Split information given in the spot comment will be recognized. When such a spot is 
selected the transceiver will go into split mode (if applicable). The program recognizes: UP, U, DOWN, 

DN, D and the word QSX. Examples: QSX 3.838, QSX 4, UP 5, DOWN 2, U 5, D4, U4, DN4, UP4, 
DOWN4, QSX7144 etc.  



Where possible mode, state/section, grid etc. are extracted from comments on incoming spots. Grid 

square from spot comment is used to calculate bearing reported in Bandmap, Available window, Info 
window and Entry window.  

When telnet is selected a Telnet DX-cluster can be chosen from the top of this window. By clicking the 
'Close Port' button the current connection will be closed. A telnet cluster can be updated in the 
configurer dialog (Tab: Hardware).  

Packet/Telnet has a nine minute stay-alive function which sends a CR every nine minutes (not 
configurable). The timer is restarted when you send a message to the cluster.  

1. Colors used 

 Blue - 'Normal' incoming spots  

 Red - (Talk) Messages  

 Magenta - WWV messages  

 Black - All other messages like cluster welcome messages, SH/DX responses, messages sent 
to the cluster, prompts etc.  

2. Initial Button Assignments 

Below are the default button assignments for the Packet/Telnet buttons. A maximum of 12 buttons are 
available for packet and Telnet. Adding more lines in the edit window will not lead to more buttons (12 
is a fixed value). The contents and texts shown on the buttons can be changed to anything you like.  

Button 
text 

Command Description Packet Telnet  

BYE BYE Log off cluster OK OK  

CONN C PE1M-7 

Connect to the (non telnet) packet cluster. Example: C PE1M-

7 You have to set your cluster's call under 'Tools >Change 
Packet Buttons'. 

Connect -  

DI/N DI/N Show new messages (CLX needs the full: directory/new) OK OK  

SH/DX SH/DX/30 Show last DX spots OK OK  

USERS SH/U Show cluster users OK OK  

WWV SH/WWV Show WWV spots OK OK  

10M 
SH/DX/30 
10 

Show last 10M spots OK OK  

15M 
SH/DX/30 
15 

Show last 15M spots OK OK  

20M 
SH/DX/30 
20 

Show last 20M spots OK OK  

40M 
SH/DX/30 
40 

Show last 40M spots OK OK  

80M 
SH/DX/30 
80 

Show last 80M spots OK OK  

PA1M {MYCALL} 

Connect to the Telnet DX cluster by sending your call to the 
Telnet cluster. Most Telnet clusters expect your callsign as the 
first text received. The callsign used with the macro {MYCALL} 

is taken from the station information dialog 

- Connect 

 Close Port - Close the current Telnet connection.  



3. Keyboard Assignments 

 Ctrl+C - Sends Ctrl+C to the TNC which is used by TAPR TNC's.  

 Ctrl+Z - Sends Ctrl+Z to the TNC which is used by TAPR TNC's.  

 Shift+Escape - Places an Escape character on the command line which is send to the TNC 
after pressing Enter. The Escape character is being used by WA8DED/ TF firmware TNC's.  

The Packet/Telnet window must be active and the cursor must be on the command line.  
N.B. The Escape key (without the Shift key) makes the Entry Window active.  

4. Mouse Assignments 

 Left mouse button  
o Single click - Tune the active radio to the frequency of the spot.  
o Shift+click - Tune the inactive radio to the frequency of the spot.  

o Double click - The spot under the cursor will be placed in the callsign field in the 
Entry window and gets focus.  

o Ctrl+Single click - Tune the non-active radio to the frequency of the spot and make 
it active.  

 

Split operation 

If you click on a spot that has a QSX (listening) frequency given, your radio is under program control, 
and your radio can accept split commands, then the required QSX will be set. 

 Right mouse button - Displays a menu - see below  

5. Right Click Menu 



 

o Why don't I see spots? (Show packet filters) - A window will open showing the 

current spot settings in effect.  
o Configure Ports, Telnet Address, Other - Displays the 'Configurer' dialog.  
o Edit Telnet Cluster List - Displays the 'Change Packet Cluster List' dialog. Here you 

can add, edit or delete telnet cluster sites.  

 

The Default Packet Cluster List 

When you create your first database in N1MM Logger, the list of DX cluster addresses is copied from 
the ham.mdb.init file that is distributed with the Full Install. Thereafter, each time you create a new 

database, the program copies the contents of the table that includes the cluster addresses from the 
last database you had open. The purpose of this is to preserve any additions or changes you have 
made. It is not practical for the developers to update the default list of DX cluster addresses between 
Full Install releases, but that list is so complete that you should have no difficulty in finding a cluster 
you can connect to, If for some reason your favorite cluster does not appear in the default list, it is 
simple to add it from the right-click menu of the Packet/Telnet window. 

o Change Packet/Telnet Buttons - Change the label and contents of the 

packet/telnet buttons. Note that the use of '&' in the Button Caption will cause the 
following lettered key to become a "Alt+Hotkey."  

o Close Port - Close the packet or Telnet connection (depends on the selected Tab)  
o Specify Comment for All Spots - This dialog allows you to specify either a fixed 

comment to be added to all outgoing spots, or to select components of the last logged 
exchange.  



 
To specify a fixed comment ("ARRL DX", "WAE RTTY" or the like, type it into the text box. To send a 
component of your exchange with the spotted station (for example, to alert people to a station's ARRL 
section or the mode of the QSO), check the relevant box.  

The dialog displays exactly what will be displayed in the Comment field of your spot. In the eample 
above, if you check Zone, the "8" will be displayed.  

Be sure to turn on "Spot All S&P QSOs" on the Entry Window's Config menu if you want every spot to 
have a comment added. This needs to be re-enabled every time you start the program, to make sure 
that spots aren't being automatically made without your knowledge.  

o Add small random offsets to incoming cw spots - This will add or subtract 30 or 

60 Hz randomly to incoming CW spots to help spread out pileups for the running 
stations that you call. THE DEFAULT IS ON. You can turn it off permanently by toggling 
the option.  

o Auto logon - Automatically connect to a cluster when the program starts. When 
running Telnet, auto logon will send the right-most button (which by default contains 

the {MYCALL} macro). When running packet, auto logon will press the second button: 
"C call". When running both, only the one that was in focus the last time before closing 
the program will be re-started.  

o Packet Spot Timeout - Indicates how long (in minutes) spots are kept in the 
Bandmaps. The default is 60 minutes, but any integer may be specified.  

o Remove Packet Spots, Leave Self Spots - Remove all spots coming in via packet or 
Telnet but leave all self spots in the Bandmap.  

o Remove all spots - Remove all spots from the Bandmaps. This means that also all 
information on the Available Mults and Q's window is cleared.  

o Packet Filters - see below  
o Suppress Duplicate Skimmer Spots - see below  

o Set Font - Change the font of the Packet/Telnet text boxes. Fixed fonts (like Fixedsys, 
Courier, Anadale Mono which has slashed zeros etc.) are recommended, so that 
columns will line up.  

o Copy - Mark a part of the Packet/Telnet window with the left button, then right-click 
and choose copy. The selection will disappear before you choose copy, but that doesn't 
matter. You can then paste the selected area into Word or Notepad or whatever you 
like.  



o AR Cluster Help - opens an Internet window with help information for AR clusters.  

o VE7CC Cluster Help - opens an Internet window with help information for VE7CC 
clusters.  

o Help - Show the help file for this window.  

 

5.1. Packet Filters 

 Allow HF - When selected all spots on the HF bands ( < 30 MHz) are passed to the 

Bandmaps. See note below.  

 Allow WARC - When selected all spots are passed to the Bandmaps from the WARC bands. 
See also note below.  

 Allow VHF - When selected all spots on the VHF bands (> 30 MHz) are passed to the 

Bandmaps. See note below.  

 Allow spots from my country only - When selected only spots originated from your own 

country will be shown in the Bandmaps and Available window. See note below.  

 Allow spots from my continent only - When selected only spots originated from your own 
continent will be shown in the Bandmaps and Available window. See note below.  

 Allow only spots from specified call areas - When selected only spots originated from 

specified call areas will be shown in the Bandmaps and Available window. See note below. The 
spots can be specified at the next menu item. A call area is the country prefix + the first 
number in the call. Example: Call: WB1KK Call area: K1 (K + 1)  

 Enter call areas (currently) - Call area filter for the menu item above. Enter list of call 

areas to pass separated by spaces. Example: K1 K2 K3 K4 and select the OK button. To clear 
the list enter only a space and press the OK button.  

 Allow spots for this contest's mode(s) only - Only allow spots where the mode is equal to 

the mode set in the contest setup.  
o When the mode is mixed the selection will be anything "not digi".  

 Filter Blacklisted Packet Spot Calls - Used to block spots of specific calls from being added 

to the bandmap. Could be used to filter out persistent busted spots.  

 Edit Packet Spot Blacklist - Just what it sounds like, for adding to or deleting from the list of 
blacklisted spot callsigns  

 Filter Spots from Blacklisted Spotters - For use any time you do not want to receive spots 

from a particular spotter. For example, if an RBN station's receiver were to be severely off 
calibration, you could opt to block spots from that station rather than chase phantoms all 
weekend.  

 Edit Spotter Blacklist - Again, just what it sounds like. Add or delete spotters whose spots 

you wish to be blocked.  

 Change Subbands for mode filter - These are the definable band edges. The frequencies 

added (in kHz) are used for the specific mode. Note that no band edges are defined for Digital. 
What you will want to do for digital is add say 7060 7090 for band edges. That range will show 
as magenta in the Bandmap. If you click in that area and you are following the band plan , 
then the mode will change appropriately. Make sure you have the desired mode control 
defined in the config dialog ('Config | Configure Ports, Telnet Address, Others | Tab: Mode 
Control | Follow band plan (default)'). The bandplan is computed as follows: Is it Digital? If 
not, is it CW? If not then is it SSB.  

Note: The default US bandplan is used by the program. Non-US stations have to make changes to that 
bandplan. An example is 40 meters for Europe where the CW part of the band is mostly much smaller.  

o Change CW Bands - The band 7000 to 7035 is set as CW (Europe), the frequencies 
above are automatically set to SSB if no digital sub bands are set.  

o Change SSB Bands - The sub bands for SSB , if nothing is set this is the default 
mode.  

o Change Digital Bands - The sub bands for the digital modes  



Note: Allow spots and Allow HF/VHF/WARC filter settings.  

These settings have nothing to do with what shows in the Packet/Telnet window. They are not 
commands to the DX cluster, instead telling the program whether to use the spots in the Bandmaps 
and the Available window.  

Clear spots will take all the spots that appear in those two windows and delete them. It does nothing 
to the Packet/Telnet window. The spots shown in the Packet/Telnet window itself will not be filtered; 
you would have to do that at the cluster node. Learn your cluster's filtering commands. This is the 
best way to accomplish what you want.  

5.2. Suppress Duplicate Spots 

This option is provided to facilitate using the Reverse Beacon Network (RBN). The RBN typically 
provides multiple duplicates of each spot, because the same station can be heard at the same time by 
many reporting stations. In its default setting, duplicate spots are suppressed before being displayed 
or otherwise processed. If you wish to see all the duplicates, click to uncheck this option. Note: the 
option will be reset to the default setting (checked) when you stop and restart the program.  

6. Special Keys 

 Ctrl+click - Holding the Ctrl key while clicking in the packet window will jump the non-active 
radio to that frequency and make it active  

7. Macro Keys 

Macro key substitution is supported by the buttons in the Packet window and also in the comments 
send with a spot (using Shift+F9).  
The macros which can be used and some examples can be found on the macros page.  

In the substitutions you can include things like {CTRL-M}. There is also a {WAIT} macro that waits 5 
seconds and macros for {GRIDSQUARE}, {MODE}, {ZONE} and {QTH}.  

So if you needed to press CTRL+M, then wait for a prompt, then C PE1M-7 then enter your callsign, 
you could change the button to send:  

{CTRL-M}{WAIT}C PE1M-7{WAIT}PA1M  

Enter is sent automatically after each command. This may cause a problem with some systems.  

8. How to Add/Edit/Delete a Telnet Cluster 

There are three places where you can get to the 'Change Telnet Cluster List' dialog. Select one of 
them.  

 Right click in the "Packet /Telnet window" and select 'Edit Telnet Cluster List' or  

 Select 'Config | Change Telnet Cluster List or  

 Select 'Config | Configure Ports, Telnet Address, Others | Hardware tab' and click on the 'Edit' 
button.  

 
The 'Change Telnet Cluster List' dialog will appear. You can go to the bottom of the list and add what 
you want. Look at the already entered Telnet clusters to see what to enter. To delete a row, click on 
the row "handle" - the gray arrowhead - and press the 'Delete' button on your keyboard. To edit an 
entry select the field to update and enter the new information.  



9. How to Setup and Connect a Telnet Cluster 

1. Add the Telnet address to 'Config | Change Telnet Cluster List'.  
NB. Use gb7ujs.shacknet.nu as a model for how to specify a port other than 23.  
2. Click on the Telnet tab in the Packet/Telnet window.  

3. Choose the address to use from the drop-down box left from the button "Close Port".  
4. To connect, click on the F12 button with your callsign in it.  
*This presumes that the cluster you are using is looking for your callsign as the first thing to be sent 
(which it usually is).  
5. Now you should be connected to the cluster.  

10. How to Setup and Connect to a Packet Cluster Using a TNC 

1. Click on the Packet tab in the Packet/Telnet window.  
2. Set up the connect string for your local packet cluster under the F2 (Conn) button.  
3. Click on the F2 button (Conn).  

4. Now you xhould be connected to the cluster.  

*In general, setting up the connect string and the possible use of intermediate relay nodes to reach 
the cluster causes most problems..  

11. Auto Connecting to a Cluster 

 Set up your packet or Telnet to the cluster, to connect as explained above  

 Right click in the Packet/Telnet window text area and select Auto Logon in the men:  

 From now on the program will connect to the selected cluster automatically when the program 
starts  

 Auto Logon works only at program startup.  

o Button 1 or button 12 is sent to the cluster, depending on whether you are using 
packet or Telnet.  

 There is a "stay-alive" timer that sends a CR every 9 minutes.  

 If the connection drops spontaneously, you will have to re-connect manually.  

12. Spotting Stations 

Spotting stations has to be done from the Entry window. The station entered in the callsign field will 
be spotted. If the callsign field is empty the last qso made will be spotted.  

 Alt+P spots stations.  

 Ctrl+P spots with a comment.  

 Spot all S&P QSOs under 'Config'.  

 
The frequency from the spotted station is rounded to one decimal place by the program.  

13. Multi-User Setup 

When running in Multi-user mode (more computers connected in a network) only the Master station 
has to be connected to the DX-cluster. The master station will send all information from the cluster to 

all connected computers and also send info received from the connected computers running N1MM 
logger to the DX-cluster.  

14. Computers on a LAN 



It is possible to connect to Telnet hosts when the Internet connection is on a LAN via proxy server or 

router. First try to access the Telnet cluster via the Telnet program in Windows, if this works it should 
also work from within N1MM logger. It does not matter if the proxy is in software or hardware. Port 23 
(=telnet) should be open.  

15. Packet via the Soundcard 

Many hams use AGWPE for packet using the soundcard. N1MM logger is not able to direct use this 
package but there are ways using additional software to get N1MM logger and AGWPE work together. 

Basically you telnet from inside N1MM to either of these applications. They are in turn linked to 
AGWPE. Links to these programs can be found in the links section.  

 TelMgr by LU7DID  

 Telnet interface by IZ4AFW  

16. Supported Packet Clusters 

 AR-Cluster by AB5K  

 Clusse by OH7LZB (not fully supported, only incoming spots)  
o To make Clusse more compatible give the command SET/PCMODE YES (typed in 

uppercase).  
o Only incoming spots will be decoded by N1MM logger (not the response to the List 

command)  
o The List command (SH/DX) has a different format and will not be decoded.  

 CLX by DJ0ZY and DL6RAI  

 DX-spider by G1TLH  
o DX-spider uses a different SH/DX format, check in 'Configurer / Other' the setting 

'Format for DX-spider support'. This will send the right SH/DX message from the 

button in the top of the bandmaps.  

 DXnet by F5MZN (Unknown if fully supported but it probably is)  

 PacketCluster by AK1A  

 Wincluster Lite by KH2D  

 More?  

17. CW Skimmer and the Reverse Beacon Network (RBN) 

 
CW Skimmer version 1.1 and up has a built in Telnet server which allows N1MM Logger to receive 
spots from it. Add an entry to your Telnet list with the address: 127.0.0.1:7300 if you are running 
Skimmer on the same machine as N1MM Logger. If running on a different PC on the same network, 
use that machine's internal IP address in the same format.  

The Reverse Beacon Network's Telnet servers (telnet.reversebeacon.net:7000 and 
arcluster.reversebeacon.net 7000) make all of the RBN's Telnet spots available to the program. 
Because of the huge volume of spots on a major contest weekend - at least ten times as many as the 

conventional cluster network - we highly recommend that you use the Telnet servers' filtering 

capabilities to manage the quantity actually sent to you. The servers use the DXSpider and AR Cluster 
V6 software, both of which have very flexible filtering capabilities. It will be helpful to use a short 
Packet Spot Timeout (set on the right-click menu of either Bandmap) - 15 minutes should be more 
than adequate, because CW Skimmer re-spots stations that remain on the same frequency every 10-
12 minutes. Skimmer/RBN spots are not saved in the current database, so they are not reloaded when 
re-starting the program, even if the Packet Spot Timeout is set to a high value. Otherwise, trying to 
reload literally thousands of spots could cause problems on program re-start.  



Skimmer spots can be merged with spots from conventional DX clusters using software such as 

WintelnetX or CC User, freeware by K1TTT and VE7CC respectively. Skimmer spots are distinguished 
from regular spots by the addition of unique markers. In the Bandmaps, Skimmer or RBN spots are 
identified with "#" after the callsign and bearing; spots from your own Skimmer, identified by the 
callsign set in your Station Data), are marked with "!"  

18. Spot Filtering 

 

There are three levels of spot filtering available. The first of these is at the DX cluster node, using 
whatever filtering capabilities are built into the node. Because N1MM Logger stops processing telnet 
messages when CW is being sent, users who are connected to a very high volume node, such as the 
Reverse Beacon Network's Telnet node, may find it advantageous to block some of the less useful 
spots (for US users, you might not want spots from VK, for example).  

The second level of spot filtering is accessible from the right-click menu of the Packet/Telnet window, 

and decides which spots received from the cluster node should be forwarded to the Bandmap and the 
Available window. If too many spots are forwarded, depending on how fast your computer is, you may 

encounter brief delays in execution of commands (such as sending of CW messages) while the 
program catches up. See the Packet Filters section for specifics.  

The third level of filtering is set in the right-click menu of the Available Mults and Qs window, and it 

only governs which spots are shown in that window's lower pane. For example, if you decide only to 
list CW spots, the bandmaps will continue to display all spots, and the top pane of the Available 
window will continue to display overall spot numbers for each band, but the lower pane's list of spots 
will contain only CW spots. You can quickly switch back and forth between showing all spots, just 
those on the current band, only CW or SSB or digital spots, or any other band/mode combination.  

19. The Reverse Beacon Network and Spot Quality Tags 

Traditional or "human" spots, as they are sometimes known, are produced by action of individual 

operators who judge the station "worthy" of being spotted. Beginning in 2008, however, VE3NEA's CW 
Skimmer software was the foundation for the creation of the Reverse Beacon Network, or RBN. CW 

Skimmer and its companion Skimmer Server spot everything within their covered bandwidths, 
generating an unprecedented volume of CW and digital mode spots. These spots are distributed 
through two RBN nodes, one using DXSpider software and the other ARCluster Version 6. The spot 
streams are voluntarily carried by a large number of DX cluster nodes worldwide; the most complete 
directory is found on this website, which specifies which of them carry RBN (or "CW Skimmer") spots.  

Much more information about the RBN and its operation may be found here  and here .  

19.1. AR Cluster V6's Spot Quality Filtering 

Because of the large volume of spots generated by the RBN, even at very high accuracy rates (over 99 
percent), a large number of busted spots have been noticed. Toward the end of major contests, these 

may be a significant problem for serious competitors. In addition, calibration and image errors are 
sometimes encountered due to hardware and software issues.  

CT1BOH has developed and AB5K has implemented DX cluster-based evaluation of spot quality, in an 
effort to reduce the number of bad spots seen on the RBN. This nice piece of work was implemented in 
Version 6 of AR Cluster. AB5K.net was the first node offering this feature, and many more now have it 

too. You can find an exhaustive list at this web site .  

The evaluation is subdivided into 3 categories  

:  

http://n1mm.hamdocs.com/tiki-index.php?page=Packet+and+Telnet+Window&structure=N1MM+Logger+Documentation#Packet_Filters
http://n1mm.hamdocs.com/tiki-index.php?page=Available+Mults+and+Qs+Window
http://reversebeacon.blogspot.com/
http://www.reversebeacon.net/main.php
http://www.dxcluster.info/telnet/index.php?software=AR-Cluster


Validation – When a callsign is first spotted on a given frequency, it is tagged with a “?” in the last 

column of the Comment field of the spot. When two or more other RBN nodes agree on the spot, the 
tag on each subsequent spot becomes “V”  
.  

Frequency – After a station has been spotted on a given frequency, if it is then spotted on another 
frequency the spot is tagged as above, but with a “Q”, for QSY? Again, once the move is confirmed, 
subsequent spots are tagged with V. The idea here is to catch I/Q image spots, spots sent by badly-
calibrated Skimmers or spots inadvertently sent on the wrong band.  

Busted Spots – This is the real high point of the Quality Tags. The algorithm uses some sophisticated 
measures of the “resemblance” between the busted spot and the real one, and will tell you both what 
spots are busted and what the real call is, based on other spots at or very near the same frequency.  

Here is a brief snapshot of one minute of RBN plus traditional spot flow.  

 

You can see that the node software picked up two busted spots, and also was skeptical about others 

until they were repeated. There are no QSY spots in this sampling, but if there had been, you would 
have seen the “Q” tag.  

Here’s another sample, with filters set only to pass busted spots. The algorithm appears to work pretty 
well.  



 

When you first connect to an AR Cluster, make sure it is sending RBN spots as well as traditional ones 
by commanding it to “set dx filter”. Once RBN spots are flowing, you can set any other filters you want 
to, such as limiting spots to stations in your geographic area. Then all you have to do is send “set DX 
extension skimmerquality”, and the Quality Tags will start to appear at the right end of the Comment 
field.  

Some operators will prefer to filter out certain of these spots. Most likely canduidate for this treatment 
are spots tagged with “B”., but you can filter out “?” or “Q” spots too, and the node will not send spots 
of those stations to you until they are confirmed (and tagged V). Here’s a partial list:  

Set DX filter Skimbusted – only send me those spots that are marked as busted, together with the 
node's identification of the correct spot)  

Set Dx Filter NOT Skimbusted – don’t send me any spots that are tagged as B  

Set DX filter NOT SKimQSY – don’t send me any Q spots until they are verified  

Set DX filter Skimvalid – only send me spots that have been tagged with a V  

These and other Skimmer-related filtering commands are found on AB5K’s website.   

One of the neat things about AR Cluster V6 is that you can create complex filters to show you exactly 
what you want. For example:  

SET DX FILTER {MYCALL} OR (spotterstate=MD OR spotterstate=PA OR spotterstate=VA 
OR spotterstate=WV)  

This filter will tell me whenever I am spotted anywhere in the world, and otherwise will show me all 
spots, both traditional and RBN, made by stations in the states around my QTH.  

You could add some Quality Tag-specific filters – for example:  

http://www.reversebeacon.net/main.php


SET DX FILTER call={MYCALL} OR NOT skimbusted and (spotterstate=md OR 
spotterstate=pa OR spotterstate=va OR spotterstate=WV)  

This filter will work the same as that above, but also will not show me any spots that the cluster 
evaluates as busted.  

Here’s another filter that lays on some more complexity, written by CT1BOH and recently published on 
CQ-Contest:  

Set DX Filter (skimValid OR not skimmer or ((SkimQsy OR SkimUnknown) AND (cty <> K 
AND cont <> EU )))  

This filter shows human spots, Skimmer spots appraised as V(alid), and Q and ? spots from outside 
Europe and the USA. It filters out Q(new frequency?) and ? (not yet valid) spots from the US and 
Europe, on the theory that it’s less important to jump on those first.  

Many operators will prefer to make their own judgments, rather than using filters. There are some 
advantages to this, probably. For example, a rare multiplier spotted initially by only one RBN node 
would carry a “?” tag until two more confirm the spot. Waiting for it to come through a Skimvalid filter 
could result in your being twentieth in the pileup instead of first or second. Late in a big contest, a 

large multi-op will have worked many of the stations on each band. A lot of busts will seem to be 
valid, but operators may want to make that judgment quickly for themselves rather than relying on 
the node. The next section shows how you can use N1MM features to make this approach easier.  

N1MM Logger has two main ways of initiating S&P QSOs, by using either the Available Mults and Qs 
window or the Bandmap(s). Of the two, the Bandmaps are the easiest way to work with Quality Tags, 
simply because the Available window scrolls so quickly when receiving spots from the RBN. Just 
mouse over the callsign you wonder about, and the full spot, including the Quality Tag, will appear in a 
tooltip. This makes it really quick and easy to skim over the bandmap and dismiss the busted ones 
with Alt+D Here’s an example  

 

In this example, if you had worked EA1FAI a couple of minutes before, when you saw EA1FAE pop up, 

you moused over him, and he was revealed as a busted spot. Alternatively, you can click on a call to 
select him for a possible QSO, and if the tooltip reveals he’s a bust, you just hit Alt+D and move on.  

So that’s the story – whether you choose to filter at the cluster node, or see everything coming in and 
make your own decisions, Quality Tags can be a very useful tool. Congratulations to CT1BOH and 
AB5K for their achievement.  

 

 

2.6.5 The Check Window 



 2.6.5 The Check Window  

o 1. Features  
o 2. Colors of the Callsigns  
o 3. Keyboard Assignments  
o 4. Mouse Assignments  
o 5. Wildcard Search  
o 6. Call Checking  

 6.1. Updating the Pattern File  

 6.2. The Pattern File  
 6.3. Components  
 6.4. Examples  
 6.5. What are We Trying to Match?  

1. Features 

 The Check window displays worked calls from the current log plus callsigns from the 

master.dta file that match the input in the callsign field of the Entry window.  

 The Check window is not cleared until a character is typed in the callsign field in the Entry 
window, so clearing the callsign field won't clear the Check window.  

 All callsigns are shown in upper case.  

 If more than 50 matching callsigns are found in the master.dta file, only the first 50 (in 
alphabetic order) are displayed.  

 In order for the Check window to be active, there must be a valid master.dta file in the 

program file directory. A variety of such files may be downloaded from this site . For 
example, master.dta files are available comprising only US and Canadian callsigns. The 
master.dta file used for a given contest is selected on the Associated Files tab of the Contest 
set-up window.  

 
The title bar shows Mul: or Q: followed by the band.  

 2X: - This station would be a Double Multiplier on this band (this country and zone)  

 Mul: - This station would be a Multiplier on this band (country, section, etc.)  

 Q: - This station would be a new QSO on this band  

 Example: Mul: 15 20 Q: 160 80 40 10 - This station would be a new Multiplier on 15 and 20 
meters, or just a new QSO on 160, 80, 40 and 10  

Note: For the title bar to operate correctly, the "Available Mults and Q's" window must be 
open.  

The Check window is divided into two areas:  

 Upper area: callsigns found in this contest log  

o QSOs made in this contest  

 Lower area: callsigns found in the selected master.dta file  

http://www.supercheckpartial.com/


 

When the program is 

started and no callsign is 
entered the Check 
window will show the 
date, time and length of 
the MASTER.DTA file. 

 
When the master.dta file 
for the selected contest is 
not found or missing a 
warning will be given, 
Use 'Download latest 

Check partial file 
(Master.DTA) (Internet)' 
under 'Tools' to download 
the file from the Internet 

 

 

 

When there are no 
matches found Unique 
will be shown in big red 

letters 
 
 
When the station entered 
is a dupe it will be shown 
in black and the text 
Dupe! will be added in 

red 

 

 

 

On this window's right-click menu, shown above, there is the option to select "Show N+1 calls." If this 

option is checked, callsigns will be shown that are one letter or number different from the callsign 
entered in the Entry Window, as in this example. This can be very helpful when listening under difficult 
conditions where you are not sure of the callsign.  



 When a callsign entered matches a call in the log, the callsign in the Check partial window will 

be set to bold and 12 point font (PA1M below).  

 Entering PA1M in the callsign field will give PA1M, PA1MR, PA1MV and all others with PA1M in 
the callsign (picture below left). When N+1 is selected also all callsigns with one character 
difference will be shown (picture below right).  

N+1 not selected 
PA1M entered in Entry 
window 

N+1 selected  

 

No QSOs match the 
entered call in the log so 

the window starts with a 
blank line. When a 
callsign matches the 
master.dta file or the log 
it will be set to bold and 
12 point font (Example: 

PA1M) 

 
When N+1 selected,PA1K 
is found in the log and 
many more callsigns 
differing by only one 
character are found in 
the master.dta file. The 

differing character is 
shown bold 

 

2. Colors of the Callsigns 

Blue New contact on this band  

Black  
Dupe contact or a station in a non-workable location. 
This means that you don't need this station because he is a dupe or you are not allowed to work 

him by the contest rules. 

3. Keyboard Assignments 

 Alt+Y - will "yank" the first call from the Check window into the callsign field of the Entry 

Window that has the entry focus. Repeated Alt+Y will substitute the next call in the Check 
window, from left to right.  

4. Mouse Assignments 

 Left mouse key clicking on a callsign in the listbox  
o Click on call - Enter the call into the callsign field on the Entry window replacing 

whatever was there.  

 When clicking on a call with spaces, only the first token will be loaded as 
callsign  

 Right mouse key clicking, a pop-up menu will appear  
o Set Reverse Look Up Threshold - This sets the threshold for the number of 

characters that must be entered into the Entry window exchange box before a reverse 
lookup in the log and the Call History file will be performed. A larger number will result 
in faster lookups and fewer matches displayed in the Check window. This option is 
greyed out if the main reverse look up option is not enabled. See the Show Reverse 
Look Up (Log and/or Call History) option below.  



o Reverse Look Up Search Without Leading Wildcard (*) - By default, the reverse 

lookup search looks for the text entered into the Entry window exchange box 
anywhere in the exchange data in the Call History file, e.g. BC in the Entry window will 
match ABC as well as BC, BCD, etc. in the log and Call History file. If this option is 

checked, the reverse lookup will only display callsigns where the first characters in the 
exchange field match the data in the exchange box, i.e. BC will match BC and BCD in 
the entry window, but not ABC. This results in faster lookups and results in a shorter 
list of matched callsigns. This option is greyed out if the main reverse look up option is 
not enabled. See the Show Reverse Look Up (Log and/or Call History) option 
below.  

o Show Reverse Look Up (Log and/or Call History) - In many contests, this option 

enables a reverse lookup option on the exchange using information from the log, and 
if the the Config > Call History Lookup option is enabled, from the Call History file (see 
the Call History page for more information on Call History Lookup). For example, if you 
hear an exchange that would be a needed multiplier but you don't hear the callsign, 
you can enter only the exchange into the Entry window and the program will find 
callsigns in the log and/or the Call History file with matching exchanges. This option 

will work on partial exchanges, depending on the previous two options. If a partial 
callsign was entered in the callsign box before entering the exchange, matches will be 
limited to those that match both callsign and exchange fields. A maximum of 100 
matching callsigns will be displayed, and they will be below callsigns found from the 
log and (if a partial call sign has been entered) the master.dta file. You can click on a 
callsign in the Check window to fully populate the callsign and exchange fields in the 
Entry window. If this option is not supported for the current contest, the reverse 

lookup options will be greyed out in the pop-up menu.  
o Show N+1 Calls - show all callsigns with one character difference from the complete 

callsign entered in the Entry window callsign field. The different character will be 
shown in bold.  

o Set Font - Set the font for the Check Partial window, a selection window will appear.  
o Help - Show the help file for this window.  

 

 

The above screen shot shows an example of the reverse lookup feature in action. All I was able to 

catch of the call sign was the first three characters (AA4). The top line in the Check window shows the 
three call signs from my log so far that match these three characters. They are all dupes on this band 
(all three are in black). The next block of 9 lines shows the AA4 call signs from the SCP file 
(MASTER.DTA). If I catch more of the callsign next time around, this might be helpful, but it hasn't 
narrowed things down much. However, I also heard the last part of the exchange (NC). After using the 

http://n1mm.hamdocs.com/tiki-index.php?page=Call+History+and+Reverse+Call+History+Lookup


space bar to move to the exchange box and entering NC, 5 call signs show up in the bottom two lines 

as a result of a reverse lookup in my Call History file. None of these call signs is the same as the ones 
in the first row, so none of them has been worked yet. I conclude that it's probably worth hanging 
around to try to make a QSO. If the exchange I had heard had been GA, as it happens the reverse 

lookup would have shown me the three call signs that are in the top line, and since they are all dupes, 
with difficult copy conditions I might not have bothered to stick around on the off-chance that it was 
an AA4 call in GA that isn't in my log or my Call History file; that would be possible, but this late in the 
contest it's not very likely.  

5. Wildcard Search 

If one or more characters are not known a ? may be used in the callsign field in the Entry Window. It 
needs two sequential characters like N?MM or N1? to find the call. So M?M will not work!  

Searching for leading wildcards is also implemented. I.e. ?1M matches KN1M as well as N1MM. N+1 
will do this automatically for one ? im place of each expected character in the call.The use of two 
question-marks is also allowed, for example ??1M  

Examples:  

PA?M will match PA1M, PA7MM etc.  
P?1M will match PA1M, PG1M, PF1MO etc.  
P?3 will match no callsigns because there are no two sequential characters  
?1M will match N1MM, KN1M, PA1M etc.  

6. Call Checking 

 

 

 
Dave Robbins, K1TTT's call checking code has been implemented in the program. When a callsign is 
entered it is checked against a pattern file to see if the callsign entered is a possible callsign. A 
warning will be given when this is not true. The messages appears in the check window.  

 

 

 



 

 
This feature can really help our UBN rates if we get good rules!  

 

 

Only for HF 

Note that the call checking function only works for HF (no WARC) and CW/SSB and only when nothing 
is found in the CHECK window. So not for RTTY etc. and not on VHF and up! 

 

 

Warning 

Do not assume that if the program gives a warning that the callsign is not possible and has to be 
removed from the log. Some of these rules could already be outdated due to countries changing 
callsign sequences or issuing special contest calls. 

 

6.1. Updating the Pattern File 

 
Unfortunately many countries have changed their callsign assignment process over the last years and 
many will change the coming years. Because of this the rules may not be valid. The rules are in the 
callsign.pat file in the program directory. The rules need constant updating, so if you have any rules or 
find broken rules for your country, please post them.  

 
 
Note the following:  

 Lines that start with ! are comments and are ignored by the program  

 Lines alternate, first there is a text message that would be displayed for the user and should 
basically state what the problem is  

 After the text message is a cryptic line that is the machine readable part of the rule  

 
 
 

When reviewing the rules please look mostly at the text messages, these should give you a basic 

explanation of what the rule is. When you send updates please give a short description of what the 
rule is, similar to the text messages already in. Write longer explanations if needed to explain all the 
nuances of a particular callsign rule. If you can't make up the code part for the particular callsign 
scheme just send it in and we will help. If a rule in the file now is no longer valid please include both 
lines from the file in your message and an explanation or example of why it is no longer a bad call 
pattern.  

 

 
At present the rule file is limited to 200 rules, but can easily be expanded.  



 

 

Share your knowledge 

Please do not to make up rules just for yourself. This is a golden opportunity to give back to the group 
with your knowledge of your home country's callsign standards. 

 

6.2. The Pattern File 

 
A rule 'pattern' describes a bad callsign character by character. As long as the call matches the pattern 
the procedure continues. If the pattern runs out before the end of the callsign then the rest is 
assumed to match. If the callsign runs out of characters first then it doesn't match and the call is 

passes as good.  

 

6.3. Components 

 
The components that make up a 'rule' are:  

 
 
Single characters:  

 

Single characters  Match single characters 

A match the letter 'A' 

1 match the number '1' 

etc.  
 

 

 
Repetition flags  

 
These must be followed by 
a character type specifier   

To make up phrases like 

: Match one  N match any character (A-Z, 0-9)  :D  match one of any digit 

+ Match one or more  A match any letter(A-Z)  +A  match one of any digit 

* Match zero or more  D match any digit (0-9)  *N  match zero or more letters or digits 

- Optional match  
  

-D optionally match one digit 

 

 
Groups of characters to match  

 
Which can make up phrases like 

[ ] match  [ABCDFXZ] match a,b,c,f,x, or z 



 
Groups of characters to match  

 
Which can make up phrases like 

! match any characters not in list  [!ABC] match anything other than a,b, or c 

- match a range of characters  [!A-R] match anything other than letters a to r 

 

 
 
More info is given below like checking bands and modes.  

 

6.4. Examples 

 
The following are some simple examples of patterns and what they match or don't match.  

 

Pattern  Pattern matches  Pattern doesn't match 

:A:D A1 Z0 Q8  AA 19 1A 

+A:D A1 AA1 ABC1  AA 19 1A 

*A:D 1 19 A1 AA1 ABC1  AA 1A 

F:D F1 F2 F9  A1 Z0 1A 

[ABC]B:D AB1 CB1 BB9  AC1 DB9 CZ0 

[!ABC]B:D ZB1 DB9 QB0  AC1 AB1 CB1 BB9 CZ0 

 

6.5. What are We Trying to Match? 

 
First, what do we do with a match?? Well, if a callsign matches one of the patterns a message appears 
in the check window. Therefore we make up rules that specify what a 'bad' call is, like:  

1. Calls that start with 3 letters  

1. Calls with first letter B with prefix other than BT, BV, BY, BZ  

1. French calls with a 1 or 6 that don't have 3 letter suffix  

1. East German calls that don't end in A to O (East Germany does not exist anymore but is still in 
as a nice matching example)  

 
 
 
Then we try to make a pattern that will match only calls fitting that rule.  



 

 
Unfortunately some countries have made the job a bit harder by restricting certain types of calls to 
certain bands and modes. I.E. the HJ prefix is only used on CW or 40m and 80m SSB. So we need 

some way to specify rules for those calls. So what I do is append the band and mode information to 
the end of the callsign before it goes through the pattern matcher. What it looks like then is this: 
"BY1AA=4S" where the '=' is added at the end of the call, followed by the band number (1=160m, 
2=80m, ... 6=10m) and the mode (S=SSB, C=CW, O=Other modes). Now we can make rules that 
apply to specific bands and not have another mechanism to remember. This also helps us by marking 
the end of the call with the '=' sign, so now we can sort out calls that have to have specific lengths.  

 
 
This means the following combinations can be made to specify bands and modes: 

=3C match a '3' (40meters) followed by "C" for CW, call would be bad on 40m CW 

=4 match just a '4' for 20m either mode, call would be bad on 20m any mode 

=:DS match any band, but only for SSB, call would be bad on SSB on any band  

 
 
Which for our rule that is valid only on CW or 40/80 SSB means that it is bad on any other band or on 
SSB so we could do: =[1456]S which means the call is bad on 160, 20, 15, or 10m SSB.  

 
 
Also, before a call is sent through the pattern matcher any portable part of the call is removed. This 
way a /QRP, /A, /MM, /CT3 etc. does not affect the checking of the basic callsign.  

 
 
Now, back to some of the cases mentioned earlier and how to make up rules for them.  

 

 
1. Calls that start with 3 letters 

This is fairly easy, all we need is a rule that will 'match' if the first 3 characters are letters. Since the 
:A phrase says to match any one letter we can use  

that to get the rule: :A:A:A. Notice, that since we are only worried about the first 3 characters of the 
call we don't have to go past that in the rule. This  

makes use of the property that says if the rule runs out before the callsign does the rest is assumed to 
match.  

 

 
2. Call with first letter B with prefix other than BT, BV, BY, BZ 

This is a bit harder, but at least we only have to deal with the first 2 characters of the call. First, we 
only want this to apply to calls that start with a 'B'. Then if the second character is not one of the 
group 'TVYZ' we want it to 'match'. So we get the rule: B[!TVYZ]. This is the same as above, if we 



match the 'B', and then the next character is not one of the set "TVYZ" we don't care what the rest of 
the call might be.  

 
 
3. French calls with a 1 or 6 that don't have 3 character suffix 

Now this is a real test of the capability of the rules and how well you understand them. First we need 
calls that start with 'F', followed by a '1' or '6'. Then we need to match one or two character suffixes to 
reject suffixes that are too short. For this we will use one of the 'optional' matches for the second 
letter of the suffix to get: F[16]:A-A= 

Note how we have the ":A-A" which will match one letter, then optionally another letter. We can not 
use "+A" in this case because that would also match 3 letters. Then the '=' will anchor the end of the 

rule so that if there was a third letter in suffix it would not match the '=' and the call would pass as 
good. Unfortunately the French also use other prefixes like FB, FD, FE, FF that follow the same rule. 

But this can not be combined be cause of other calls that also start with F and don't necessarily have 3 
letter suffixes. Calls like FR, FS, FJ, FC, FT may not fit the 3 letter rule. This means we need a second 
rule to finish this problem to specify the other French prefixes we want to check for 3 letter suffixes. 
To cover this we get the rule: F[BDEF]16:A-A=. Which will match French 2 letter prefixes followed 
by a '1' or '6' with only 1 or 2 letter suffixes.  

 

 
4. East German calls that don't end in A to O 

Now here is the killer. Fortunately all these calls have been replaced, but it is still a good example and 

will probably be very similar to some of the Russian rules for suffixes. First we want to match calls 
that start with 'Y', followed by a digit from 2 to 9, followed by another digit from 0 to 9, then there 
could be one, two, or in rare cases three letter suffix that must end with a letter in the range of 'A' to 
'O'. With all this in mind we get the rules: 

Y[2-9]:D[!A-O]= for single letter suffix 

Y[2-9]:D:A[!A-O]= for 2 letter suffix 

Y[2-9]:D:A:A[!A-O]= for rare 3 letter suffix  

 
 

Again we ended up with multiple rules, in this case because if we had used a '+A' or '*A' it would have 
also matched the last letter that we wanted to check specifically.  

 
 
Now if you look in the file CALLSIGN.PAT you will see all the rules that I have come up with. Each rule 

also has a line giving the explanation for it. This explanation is shown as a messages in the check 
window. You will note that some of them are not hard rules, only that the call is rarely used.  

 
 
Now you should all be experts at making rules for bad callsigns. When you come up with a new 
pattern you can test it by entering the callsign in the callsign field.  

http://n1mm.hamdocs.com/16


 

 
It is possible to come up with rules that you can't get to in the file. For instance a call like "HI500ABC" 
would always be rejected by the "CALL TOO LONG" rule near the top of the file, so if you tried to come 

up with a specific rule saying that HI500 calls only have 2 letter suffixes you would not get to it unless 
you put it before the rule for maximum callsign length.  

 
 
Some of the 'Generic' rules will reject calls that may be good. The special calls using extra long 
numbers, like the "HI500ABC" above may very well be a legal call. But since these should be relatively 
few, especially during a contest, I feel it is better to have them shown in the check window and let the 
operator determine if they are correct than to try to come up with rules that may only be used once.  

 

 

2.6.6 The Available Mults and Qs Window 

 2.6.6 The Available Mults and Qs Window  

o 1. The Header  
o 2. The Band Buttons  
o 3. Spot List Box  
o 4. Band Button Assignments  
o 5. Band Button Background colors  
o 6. Mouse Assignments  
o 7. Right-Click Menu  
o 8. Multi-Mode Contests  

The Available Mults and Qs window is most useful when spots are being received from a packet or 

telnet DX cluster (e.g. in a multi-operator setup, or in Assisted or Unlimited class in contests that do 
not allow the cluster to be used in the single-operator class). However, even if you are operating 
unassisted with no cluster connection, you may want to have this window open in order to be able to 
take advantage of the QSO/Multiplier feature in the title bar of the Check window. If you want to use 
this feature without making use of the other features of this window, you can open the Available Mults 
& Qs window and then hide it behind other windows on your screen.  

The Available Mults and Qs window for single-mode contests is similar to this example.  



 

This window consists of three parts - the header, the band buttons and at the bottom the spot list box.  

1. The Header 

 
The header shows the number of Available Multipliers and QSO's. (Example 4 Mults 12 Qs), and also 
reports on some of the right-click menu items that may affect what happens when you click on a spot. 
See below for specifics.  

You will note that this window does not appear to have the entry focus except when you have right-
clicked to access the context menu to change the window's settings. This is as designed, because 

keyboard/mouse click focus should normally be on the Entry Window. Nonetheless, mouse clicks on 
band buttons and individual spots will be acted upon, as outlined below.  

2. The Band Buttons 



 

 

 
The top part of this window indicates the number of multipliers (left column) and potential contacts 

(right column) available on each band. The two numbers in the right column reflect the number of 
workable (non-dupe) QSOs available, and the total number - the latter is useful to determine relative 
band opening quality in a contest, like Sweepstakes, where late in the contest you may have worked 
most of the active stations. For example, the right column might display "2/47", indicating a wide-
open band but with only two stations you have not already worked.  

Red numbers indicate the band with the largest number of contacts (QSOs) available. The WARC 
bands only appear when DX (the default general logging contest) is the active contest. A VHF version 
will appear when a VHF contest is selected.  

If you place your mouse cursor over one of the multiplier numbers, a tooltip will appear giving the last 
(up to 10) unworked multipliers spotted on that band.  

For a contest such as FD that allows HF and VHF, the lack of band buttons for VHF+ means (i) there 
will be no available spot totals displayed for the VHF+ bands; and (ii) there is no single click to QSY to 
VHF. You must either type in a frequency or QSY the radio manually to get to a VHF+ band. Even 

though the HF button set is shown, VHF spots that are workable in a particular contest will still appear 
in the lower pane of the available window (and on the band map); like other spots, those VHF+ spots 
are clickable to QSY (assuming radio support).  

Each of the band buttons changes color when a callsign is entered in the callsign field or, in the case 
of contests where the multiplier cannot be determined from the callsign, when the exchange is copied. 
The color (green, red, blue or none) denotes whether that station is needed on that band as a double 



multiplier (green), a single multiplier (red), a valid non-duplicate QSO (blue) or not needed (none). 

The intention is to let you know whether you need that current station's multiplier on other bands, so 
that you can move him if you wish.  

The active band's button text is shown in bold.  

3. Spot List Box 

 

 

 
The list box (the lower section of the window) shows spots received via Packet or Telnet. There are 7 

columns: Call, Frequency, Bearing (DIR), Mode, Time (TS) in the format "mm-dd hhmmss", SNR 
(Signal-to-noise ratio) for Skimmer spots, and Mult status (yes/no). Clicking on the selected column 
title will sort the column, clicking again will reverse the sort order. An indicator of split spots appears 
next to frequency. Spots coming from a local Skimmer are shown with a (!) to the right of the bearing, 
and those from a non-local Skimmer or the RBN (other than your spots, if you are a contributor) with 

(#). A sunrise/sunset indicator is shown to the right of the bearing where applicable, as an aid to 
determining which spots may either be "perishable" or particularly suited to a gray-line QSO.  

The color codes described are applied to each call listed; however, spots that would be duplicate QSOs 
(gray) are not displayed.  

4. Band Button Assignments 

 Left click on band button - Set the left radio or VFO-A to the first spot on the band specified.  



 Right click on band button - Set the right radio or VFO-B to the first spot on the band 

specified.  
o Note: When both Entry windows are open on the same band (in SO2V), then clicking 

on a call will bring this call to the window without transmit focus. Select the correct 
radio/VFO by right or left clicking the band button. You should not be able to select the 
same band on both radios in SO2R, unless you deliberately do it on the radios' front 
panels. For obvious reasons, this is not a good idea,  

5. Band Button Background colors 

 Blue: Available QSO  

 Red: Single Multiplier. Example: CQWW - QSO is either zone or country multiplier (one 
multiplier)  

 Green: Double or better Multiplier. Example: CQWW - QSO is a zone and a country multiplier 

(two multipliers)  

 Gray: Dupe  

6. Mouse Assignments 

 Left mouse key clicking on a callsign in the list box  

o SO1V  
 Single Left click - Always send the spot to VFO-A.  
 Shift + Single Left click - No action.  

o SO2V + set for "Basic VFO Selection" (set in the Right-Click menu explained below)  
 The selection Basic VFO Selection" or "Advanced VFO Selection" can be 

set/seen in the right click menu.  
 Single Left click - Send the spot to VFO-A.  
 Shift + Single Left click - Send the spot to VFO-B.  

o SO2V + set for "Advanced SO2V VFO Selection" (set in the Right-Click menu explained 
below). When set for "Advanced VFO Selection" the window title tells you the setting 
of this option.  

 Single Left click  

 If both VFO's are not on the spot band, send the spot to the Active 
VFO. The spot VFO Entry Window and Bandmap wil be made active.  

 If either VFO is on the spot band, use the VFO which is on the spot 
band checking the active VFO first. The spot VFO Entry Window and 
Bandmap wil be made active.  

 Shift + Single Left click - reverse the VFO selection determined above.  

o SO2R + set for "SO2R Focus Follows Spot" (set in the Right-Click menu explained 
below)  

 The radio that the spot is sent to will be made active if "SO2R Focus Follows 
Spot" is checked. If the option is un-checked, the window focus will not 
change.  

 Single Left click  
 If both radios are not on the spot band, send the spot to the inactive 

radio.  

 If either radio is on the spot band, send the spot to that radio.  
 Shift + Single Left click - Reverse the VFO selection determined above if the 

selection will not place both radios on the same band.  
o Double click - Go to the frequency with the active VFO. The callsign on which you have 

clicked is placed in the callsign field in the Entry window overwriting anything that was 
in there!  

 Left mouse button clicking on column title  
o Toggle the sort order of the spot list between ascending and descending based on the 

column selected (Call, Frequency, Bearing (Dir), Time (TS).  



7. Right-Click Menu 

The following screen-shot shows the right-click menu effective with version 12.08.00  

 

If you right click in the Available Window these menu items will appear. Not all menu items are always 
selectable.  

 Delete Spot - Delete selected spot from the list of spots. This option is only selectable when 
you right-click on a call-sign in the lower list box.  

 Blacklist callsign - if you click on this option and the Filter Blacklisted Spot Calls option in 

the Packet Filters sub-menu of the Packet/Telnet window's right-click menu is enabled, then 
subsequent spots of that station will not be displayed on the Bandmap or in the Available 
window. Used to get rid of busted spots that recur often, such as LW3LPL. To edit the list of 
blacklisted spots, or to remove a call from the list, use the Right-click menu in the 
Packet/Telnet window.  

 Blacklist all spots from spotter - designed in particular for use when an RBN station is 

feeding spots that are badly off-frequency (due to I/Q image problems) or otherwise defective. 

http://n1mm.hamdocs.com/tiki-index.php?page=Packet+and+Telnet+Window


Could also be used for the occasional harasser on traditional DX clusters. Again, this feature is 

enabled/disabled in the Packet Filters sub-menu of the Packet/Telnet window's right-click 
menu; the blacklist can also be edited from the Packet/Telnet window.  

 Advanced SO2V VFO Selection (radio dependent) - Determines the SO2V single left click 

behavior on a spot in the bandmap. See the details above. The option is grayed out when 
SO2V isn't selected and the window title tells you the setting of this option. Added because not 
all radios will work with the Advanced setting.  

 Enable right click QSY on spot - When checked a right click on a spot will cause the inactive 

radio or VFO to be programmed without changing the Entry window focus. If a split spot is 
selected in SO2V mode, the TX frequency will not be programmed because it will change a 
potential RUN frequency. When this occurs, a message is printed at the bottom of the Entry 
window. Right clicking on a spot in SO2R mode that would place both radios on the same band 

is ignored. This option needs to be unchecked to allow spots to be deleted or the rotor to be 
turned from the Available window. This option is grayed out, not available in SO1V mode.  

 SO2R Focus Follows Spot - Determines the SO2R single left click behavior on a spot in the 
bandmap. See the details above. The option is grayed out when SO2R isn't selected and the 

window title tells you the setting of this option.  

 Turn Rotor - Turn rotator to bearing for selected callsign  

 Show Tool Tips - When this option is enabled, hovering with the mouse over a spot in the list 
will show a tooltip with more info about the spot (frequency, spotter, time, comments)  

 
The remaining options operate at all times. Note that none of the following options affect the contents 
of the bandmap(s). Only the list of calls in the Available window will change.  

 Show Q's_Mults - toggle between showing all spots or just multipliers  

 1 - Show Focus Radio/VFO - Show only spots on the band of the VFO or Radio which has 

entry focus.  

 2 - Show Non-Focus Radio/VFO - Show only spots on the band of the the VFO or Radio 
which does not have entry focus.  

 3 - Show Both Radios/VFOs - Show spots on the bands of both VFOs or Radios.  

 4 - Show All Bands - Show spots on all bands.  

 160 - Show only 160 meter spots.  

 80 - Show only 80 meter spots.  

 40 - Show 40 meter spots.  

 20 - Show only 20 meter spots.  

 15 - Show only 15 meter spots.  

 10 - Show only 10 meter spots.  

 
This menu also permits setting of spot filters by mode. The options are:  

 All Modes  

 CW Mode  

 SSB Mode  

 RTTY Mode  

 PSK Mode  

 Radio Mode Follows the mode selected on the active radio  

 Contest Mode Category  

 
Only one of these options can be selected at a time. The first three are self-explanatory. The program 
distinguishes between RTTY and PSK spots based on the Comments field in the spot - BPSK, PSK31, or 
any other word containing "PSK". If "Contest Mode Category" is selected, the program will only display 



spots in the Available window that conform to the Contest Mode Category selected in the Select Log 
Type dialog (also called the Contest Setup dialog).  

 

Filtering notes 

There are three levels of spot filtering available. The first of these is at the DX cluster node, using 
whatever filtering capabilities are built into the node. Because N1MM Logger stops processing telnet 

messages when CW is being sent, users who are connected to a very high volume node, such as the 
Reverse Beacon Network's Telnet node, may find it advantageous to block some of the less useful 
spots (for US users, you might not want spots from VK, for example).  

 

The second level of spot filtering is accessible from the right-click menu of the Packet/Telnet window, 
and decides which spots received from the cluster node should be forwarded to the Bandmap and the 
Available window. If too many spots are forwarded, depending on how fast your computer is, you may 
encounter brief delays in execution of commands (such as sending of CW messages) while the 
program catches up, so it is probably a good idea to use some filtering at one or both of these levels.  

The third level of filtering is in the Available window. For example, if you decide only to list CW spots, 
the bandmaps will continue to display all spots but the lower pane's list of spots will contain only CW 
spots, and (beginning with version 13.3.2) the counts in the upper pane will only count CW spots. You 

can use the right-click menu to switch back and forth between showing all spots, just those on the 
current band, or only CW or SSB or digital spots. 

.  

 Packet Window Tools - Displays the Packet/Telnet window's right-click menu (convenience 
feature)  

 Count Unique Mults (turn off for better performance) - Beginning with Version 12.08.00, 

this option has been added to improve performance under heavy spot flow, as is encountered 

when using spots from the Reverse Beacon Network in a major contest.. When it is selected, 
behavior is identical with previous versions, and each un-worked multiplier on a band is only 
counted once. For example, if you have three P5s on a given band, the P5 multiplier is only 
counted once. If the option is not selected, then each spot representing an un-worked mult is 

counted, and the mult numbers will appear to be inflated. For this reason, we suggest you 
turn the option on unless you encounter problems symptomatic of an overloaded computer. 
These are most likely at the start of a major contest with many possible multipliers.  

 Help - Shows this section of the manual from the web site. Internet required  

 
 
 

8. Multi-Mode Contests 

 
Beginning with version 10.7.2, this window will display one column of band buttons for each mode in 
multi-mode contests. Operation is otherwise similar to that in single-mode contests. If the contest's 

rules specify that multipliers only count once per band, the colors of both modes' buttons for that 
band will change in unison; if multipliers count once per band and mode, then the band button colors 
will show the status, as described below, on each band/mode combination. The mode columns that 
appear are dependent on the contest and the user selectable Mode Category in the contest setup 
window.  



 

 

2.6.7 The Edit Contact Window 

 2.6.7 The Edit Contact Window  

o 1. Button Assignments  
o 2. How to Permanently Delete a Contact?  
o 3. How to Recover a Deleted QSO? (revisions thanks to W9WI and K0RC)  
o 4. Why Move and Not Delete?  

Your Edit Contact Dialog will be similar to this one.  



 

 

This screen gives the possibility to update contacts after they have been logged.  
The fields 'Country Prefix', 'Mult 1' and 'Mult 2' can't be updated because they are recalculated after 
each contact update.  

The following modes are allowed to be entered in the 'Mode' field:  

CW, CW-R, LSB, USB, RTTY, rtty-L, rtty-U, RTTY-R, AM, FM, PSK31, PKT, PAC2, GTOR, FSK31, PSK31, 
PSK63, PSK125,  
MT63, DIGI, BPSK, bpsk, SSTV, mfsk-L, mfsk-U, MFSK, MFSK8, MFSK16, HFSK, MTTY, THRB, ASCI, 
HELL, Q15, PCW.  

To what country the program assigns a contact doesn't really matter, except for the *claimed* score. 
The assigned country does not appear in Cabrillo. You are not penalized for an incorrect claimed score.  

The main reason for tracking down these things is for better information about what countries are 
needed during the contest.  

 

Tip 

When the program doesn't allow you to log a contact the way you want it, you can either force-log it 
(Ctrl+Alt+Enter) or log it as the program expects it, and then edit the contact in this screen.  
Example: A KG4 station calls and gives a state as exchange, this KG4 is in the USA. The program 

expects this KG4 to be in Guantanamo Bay and doesn't allow entering a state but wants a number. 
Enter a number which the program expects and edit the contact in this screen. Of course you have to 
update CTY.DAT to add the KG4 station so this won't happen again. See the Tips and Tricks section 
how to do this. Make a note using Ctrl+N so you can update the qso later. 



 

When a contact has been updated and you are moving on to the next/previous qso with the up or 
down arrow keys the following screen will be shown.  

 

 

 Yes - Save the changes made and move on to the next or previous qso in the log.  

 No - Don't save the changes made and move on to the next or previous qso in the log.  

 Cancel - Go back to the qso which has been changed but not saved.  

 
Updating the timestamp from a qso can be done from within the Entry window callsign field. Entries 
starting with "T" and four numeric digits will update the current row time in the log. Check out the 
chapter 'After the contest' for more information. 

1. Button Assignments 

 Update - Update the log entry and exit the dialog returning to the last qso in the log.  

 Delete - Removes a log entry from the current selected contest and exits the dialog returning 

to the last qso in the log.  
o When pressing the deleted button in a contest the following message will appear:  

 Yes, will move the qso to the DELETEDQS 'contest'  
 No, will cancel deleting the qso.  

 

 

o When using multi-user mode it is only possible to delete a qso made on the station 
which made the qso.  

 Message: "You may not delete contacts logged by another station while in 
Multi-User mode. Ask station #radionumber to delete it. Delete not 
performed!"  

 Help - Show the help file for this window.  

 Exit - Exit this dialog without updating the log entry.  

 Up Arrow - Go to the next entry towards the beginning of the log. If the current log entry 

was updated, you will be prompted to save it before moving to the next entry.  

 Down Arrow - Go to the next entry towards the end of the log. If the current log entry was 
updated, you will be prompted to save it before moving to the next entry.  

2. How to Permanently Delete a Contact? 

http://n1mm.hamdocs.com/radionumber


 Delete one QSO from the DELETEDQS 'contest'  

o Select a qso to delete in the log window  
 When pressing the deleted button the following message appears:  

 Yes, will delete the qso permanently from the DELETEDQS 'contest'  
 No, will cancel deleting the qso  

 It is not possible to select more than one qso and delete them. Deleting has to 
be done either per qso or by deleting the entire DELETEDQS 'contest'.  

 

 

 Delete all QSOs  
o Select the DELETEDQS 'contest'  

 File, Open Log in database, Select the DELETEDQS 'contest' in the 'Select 
Existing Log' dialog.  

o Delete the "DELETEDQS" contest by pressing the 'Delete' key. It will reappear with no 
QSOs.  

 A confirmation will be asked.  

3. How to Recover a Deleted QSO? (revisions thanks to W9WI and K0RC) 

It's not a trivial process, but it is possible to recover an inadvertently-deleted QSO. You'll need to copy 
the QSO from the DELETEDQS contest, change its Contest ID, then paste it into the contest it was 
deleted from. As always, back up the database file before you begin.  

 Open the DELETEDQS contest in the database.  

 Left click on the contact you want to restore, then right click, and select 'Copy > ADIF String'.  

 Open Notepad.  

 Right click in the Notepad window and select 'Paste', or just hit Ctrl+V  

 Hit ENTER a few times to put some blank lines after the ADIF string in Notepad.  

 Open the contest you want to paste the contact into.  

 Left click on a contact in that log (it doesn't matter which contact). Then right click, and select 

'Copy > Copy ADIF String'.  

 Right click in the Notepad window and select 'Paste', or just hit Ctrl+V  

 In each contact, you'll see a CONTEST_ID tag that looks like this:  

<CONTEST_ID:8>DELETEDQ or <CONTEST_ID:10>ARRL-SS-CW  

 Change the string in the first QSO ( the one you want to undelete) to match the string in the 

second QSO. Don't forget to copy any spaces that may lie between the end of the contest 
name and the < character of the next tag.  

 Change the <TIME_ON:6>hhmmss field in the first contact by one second. For example, if it 

reads <TIME_ON:6>195747, add one second so that it reads <TIME_ON:6>195748. If the 
time happens to end in 59, subtract one second instead, e.g. change <TIME_ON:6>200359 to 
<TIME_ON:6>200358.  

 Select the first (modified) QSO, everything from the beginning of the first line to the end of 

the first <EOR>.  

 Right click in the Notepad window and select 'Copy', or hit Ctrl+C.  

 Right click in the Log Window and select 'Paste contacts'.  



 Check to be sure the QSO has been restored, and Rescore Current Contest (on the Tools 

menu) to get credit for it.  

4. Why Move and Not Delete? 

A deleted contact in a contest is not permanently deleted but moved to the 'contest' DELETEDQS. This 

way a qso can be recovered when accidentally deleted. Permanently deleting the 'deleted' QSOs can 
be done in the 'DELETEDQS' contest. The technical reason to put the QSOs in another contest is that 
Access does not free space until you compact. It doesn't do any good to delete a qso, so why not just 
move it?  

 

2.6.8 The Info Window 

 2.6.8 The Info Window  
o 1. General  

o 2. Mouse Assignments  
o 3. Rate information section  
o 4. Buttons  
o 5. Real Time Graphical Rate Display  
o 6. Setting a Goal for the Contest  
o 7. Setting the QSO Numbers  
o 8. Multi-User Information  

 8.1. General  
 8.2. Mouse Assignments  

Your Info window will be similar to this one.  

 



 

The info window can be found in the Entry Window dialog under the menu 'Window | Info'.  

1. General 

The following information currently appears in this window:  

 Own callsign and Sent Exchange (statusbar)  
o The next QSO number will be shown on the title bar if it is a serial number contest. 

Example: Exch: 59 002  

 Callframe spot (line 1) - Info from spot from bandmap  

 CountryInfo (line 2 & 3) - CallCountry, Zone, Continent, Bearing (short path), Distance (miles 

& km), Bearing (long path)  
o From the station in the call window, or if nothing is there, the call in the call frame.  
o If there is nothing in either, it shows the last info that was displayed there.  

 Sunrise/Sunset(line 4) - Sunrise/sunset times, Local time  

o Local time is not shown for K, VE, UA and VK because of the multiple time zones in 
these countries.  

 Messages (line 5) - Packet spot information, packet talk messages (appear in red)  

 WWV Messages (line 6) - WWV statistics  

 Rates Section  

o Rates (left)- Rate information /goal information (colors) / band change information  
 The band change information and the band timer are hidden when Single 

operator or Multi-multi are selected.  
 Real Time graphical rate display  
 Import and setting Goals button  

o Graph (middle) - shows graphical information regarding qso count, hourly rates or 
moving averages per 30 or 60 minutes.  

o Record level indicator (middle) - for recording QSOs. For this indicator to show 'Record 
QSOs' under the 'Tools' menu must be on.  

o Info section (right)  

 Callsign of the operator in lower right corner (bold). Set with Ctrl+O.  
 Band change counter (contest and section dependant)  
 band timer (contest and section dependent)  

 Band Change & Band Timer Display  
o Only shown in certain contests and Operator Category dependant.  
o 10 minute band timer - counts down after band change.  
o The band change timer does not start until the first band change of the contest.  

o The band change counter has a "stop light" (red/yellow/green) colored background.  

 Mult-Run indicator - Shows MULT or RUN when Multi-One or 1 or 2 when Multi-Two selected  
o Shown only when Multi-User and Operator Category = Multi-One  
o Multiplier or Run station can be toggled with key combination Ctrl+Alt+M  

 Multi-User Section - Multi user information (more information below)  
o Only shown when Multi-User Mode is selected.  

 Messages Section  

o Computer name, IP-address and port info when in multi-user.  

o Winkeyer version info  
o Messages between stations have a big font so that multis would easily see messages 

to each other.  
o Pass frequencies > 100000 kHz will be shown without decimals.  
o When you are being spotted on a cluster this will be shown in the message area 

including spotter and comment. Nice to know ;-)  
o With the advent of the RBN, and also as conditions improve, the sheer number of 

spots received and listed in the Available Window and on the Bandmaps within the 
spot timeout period may exceed the computer's capacity to process them. The 
program monitors CPU utilization, and when it approaches a dangerous level, 
automatically trims a small number of the oldest spots. When this takes place, you will 



see an advisory message in this section of the window, so that you can decide if you 
wish to make any changes in your DX cluster filtering or other variables  

2. Mouse Assignments 

 Right-click in most parts of the window - Clicking on an item will select or deselect showing 

the selected information. Someparts have a menu of it's own.  
o Callframe spot - Show country and spot info from the station on the callsign field 

frame  
 NOT the callsign in the entry window but in the callframe above the callsign 

field!  
o CountryInfo - Show country info from the station in callsign field  
o Sunrise/Sunset - Show Sunrise/sunset times, Local time from the station in the 

callsign field.  
o Messages - Show packet talk messages  
o WWV Messages - Show the WWV messages  

o Rates Section - Show the rates section  
o Multi-User Section - Show the multi-user section  
o Help - Show the help file for this window  

o Clear Message Window - Clears the message part of the Info window  
o Show RBN spots of this station (internet) - If connected to the internet, this option will 

open the Reverse Beacon Network web page and display RBN spots of your own call 
sign  

 
When Multi-User Mode is selected, clicking on a red or green icon in the Multi-user part of the window 
will give an extra menu. See the Multi-User information below.  

3. Rate information section 

The rate information is shown on the middle part of the info window. Dupe QSOs are included in the 

count. A zero rate will be shown as a blank.  
Shown is the following information.  

 Left part  

o Top of rates frame - QSOs per multiplier info ( x mult = y.y Q's)  
o Last 10 Q's - Rate last 10 QSOs (QSOs per hour)  
o Last 100 Q's- Rate last 100 QSOs (QSOs per hour)  
o Since hh:mm - Rate one hour back in GMT (QSOs per hour)  
o Since hh:00 - Number of QSOs since the start of the current clock hour  

 Middle part  

o Real Time raphical rate display (middle) - see information below.  
o Record level indicator (middle) - for recording QSOs. For this indicator to show 'Record 

QSOs' under the 'Tools' menu must be on.  

 Right part  

o Band Chgs - Number of band changes since beginning of the contest for multi-single 

operators.  
 Resets to 0 at top of hour and is free.  
 Counts band changes for each computer only if in Multi-Two  
 Band changes are not counted if the worked station on the other band is a 

multiplier  
o xx min band timer - Count down timer from xx minutes to 0 which starts after the first 

logged qso after a band change.  
 NB There is one band change counter and it works for the Run station. The 

multiplier station will have to keep track of changes manually.  



 
Background colors rate information  

The background colors change depending on the goal you have set for this contest.  

 Red - < 50% of goal  

 Yellow - < 51-99% of goal  

 Green - 100+% of goal  

4. Buttons 

 Import Goals - Use this button to import hourly rates from the current contest to be used as 

goal. If the contest you want as a goal is not the current contest, open it, then set the goal. 
Import Goals will import a text file created by Print to File in View, Statistics.  

 Goal = - Manually edit the hourly rate goals to be used in this contest. Hours should be from 
0-23. If an hour is missing the next lower hour will be used.  

5. Real Time Graphical Rate Display 

The purpose of the graph is to provide tactical data to a contester or team lead, to allow quick 
decisions on band changes, antenna selection, etc.  

 As such, the intention is to visualize small changes in ==relative== Q rates over short 

periods. There is no scale information on the graph for getting a sense of raw numbers 
(assumption being that the numeric rates on the Info window are better at providing exact 
numbers). For current data, the graph does show the current hour's goal as a black line, again 
to provide an at-a-glance sense of how things are progressing.  

 Some values are selectable (via right-click) for graphing.  

o The period shown can be either 30 or 60 minutes.  
 The graph can have 6, 10, 15, or 20 bars.  

 Each bar can represent the raw Q count for that timeslice, the hourly rate, or a 
moving average over the last 10, 20, or 30 minutes.  

 The bars show rates for just this station. In the case of a single SO2R station, the bars show 
radios 1 and 2 in different colors, stacked, to show each radio's overall contribution. For multi 
operations, the rates of other stations are not displayed, nor are the contributions of other 
operators at this station displayed differently.  

 Since the graph is intended to be updated in (almost) real-time, the feature set is intentionally 
minimal. The code draws the graphs one line at a time - this yields very dull graphics, but 
does not require any additional DLL files or controls, and runs well for me on an older, slower 
PC.  

 The real-time graphical rate display has options accessible by right-clicking on the graph area. 
This display will not show anything until you start making QSOs in your current log.  

 The horizontal line is the goal value marking line.  

6. Setting a Goal for the Contest 

Most people want to make more QSOs each year than the year before. We approach each contest with 
a similar goal - beat last year's numbers!  

It's always nice to know how many QSOs you had last year so you can see where your weak spots 

are. If this information is not available or you think these numbers are wrong (to low?) set your own! 
You can set the number of QSOs you want to make on an hourly basis and the program will show 
them on the 'Goal = ' button.  



If you have last year's contest log you can import the number of QSOs and adjust afterwards if 
necessary.  

The only difference importing QSOs from a previous contest is what database you have loaded in 
N1MM logger during setup of the goal numbers. If you have the previous contest (from last year) 
loaded the program will calculate the QSOs per hour and display them. These numbers can be 
updated to set a new (higher) goal.  

 

Goals set per Database, Not per Contest 

The goal is set per database and not per contest in the database, so it is not possible to set different 

goals for more than one contest within one database. For some, this is another reason to use a 
separate database for each (major) contest. 

7. Setting the QSO Numbers 

You can set the number of QSOs per hour.  

 
 

 

 Select button 'Import Goals' on the Info window. Selects the bands to import using a previous 
contest log or a text file.  

o Import Bands  
 Select bands to import for the selected contest  

 Choices are: All, 160m, 80m, 40m, 20m, 15m and 10m  
o Log - Import from a previous contest Log  

 Load or have loaded the previous contest (mostly from last year) in the 

program.  
 Use 'Choose a File' and select in the database the contest you want.  
 Select a contest in the selected database using 'Select Contest'.  
 Another type of contest is allowed to get some figures and hours 

imported.  
 Have an empty contest loaded or make a new contest with 'File, Open 

Log in Database'.  
o Text File - import goal from a text file  

 Text file can be either a whitespace delimited file (.txt) or a comma separated 
file (.csv).  

 User selects which file type in the Choose a File dialog box.  
 Contents of the text file are: 1st field/column is the day/hour as dhh, 

2nd field/column is the all band houtly rate.  



 For importing goals by band, 1st field/column is the day/hour as dhh 

and the subsequent fields/columns are the hourly rate on 160, 80, 40, 
20, 15 & 10.  

 Select button 'Goal ' on the Info window. A screen will appear where you can enter the QSOs 

to make per hour. If you have not imported a contest the dialog will be empty otherwise it will 
be pre-filled.  

o Goals need to be in the form of dhh, where d is 1, 2 or 3, and hh is from 0-23.  
o The hh is the Z time for the first, second or third *calendar* day of the contest. d is 

the calendar day number starting with 1. ARRL Sweepstakes starts on Saturday at 
2100z, so the first hour goal would be for 121. The last hour starts at 0200z on 
Monday, so the goal would be set for 302. With the other change made, these rates 
can be extracted from other contests in other databases, avoiding the necessity of first 
loading the contest, extracting the goals and then reloading the current contest. Now 
you can just choose the database and contest to use for your goals.  

o The goals can also be set manually, using the scheme above. Note that goals hold for 

the hour they are set, and each subsequent hour until a new goal is set.  
o Example below: 112 means day 1 and 12 UTC. The last line is day 2 and 09 UTC.  

 

8. Multi-User Information 

8.1. General 

In the bottom part of the Info window all information needed during contesting is displayed. See the 
picture below.  

 

 Green or Red station icon  
o Green means connected  

o Red means not connected, and the other computer is being actively polled. Users may 
experience delays and stutters in this state.  

o Blue means not connected, and the other computer is not being actively polled. The 
connection will be automatically reestablished when the other computer becomes 
reachable. Users will not experience delays and stutters in this state.  

o Light Red means that the program has not been able to contact the other machine for 
a while.  

 This is a transient state, and the program will try to solve this problem, if it 
returns to green, then everything is ok.  



 At startup it is not an issue. If during a contest, with lots of RF, this might 

mean you have RF in your network cables.  
o Right clicking on these icons brings up a menu  

 Station  

o Name from the station as entered under 'Config / Edit Station Computer names'  

 Pass frequency  

o Frequency where the station likes to receive it's passed stations.  
o Pass frequencies > 100000 kHz will be shown without decimals.  

 Run  
o Selected means running  

o Not selected means he is Searching & Pouncing  

 Operator  
o Who is operating the station  
o This call will change to red while transmitting  

 Last 10  
o Rate information from the station over last 10 QSOs  

 Last 100  

o Rate information from the station over last 100 QSOs  

 Current Freq  
o Operating frequency  
o Mode indication like CW, SB, FM (only when in Mixed mode)  

8.2. Mouse Assignments 

 Right-click on the red or green station icon - opens a menu window.  

 Call for Help - On the selected station the following message will be shown: "Station x needs 
assistance". This way an operator can call for assistance without leaving the chair by sending a 

message to another (operating) position. The file "Assist.wav" from the program directory will 
be played on the target station.  

 Help - Show the help file for this window.  

 Send Message - Send a message to this station. The message will be shown in the Info 

window from the selected station and appears in red.  

 Target for Call stacking - The stacked callsign will be put on the 'stack' for this station. See the 

Entry Window for more information about call stacking.  

 Pass current/last QSO - Pass the current qso in the Entry window or the last qso when the 
Entry window is empty to this station.  

 Show Status - Show status of all connections. See image below (no connection set up here).  

 

 Close Connection - Close the network connection from this station.  

 Open Connection - Open the network connection from this station (only selectable when dot is 

red).  

 Prevent Automatic Reconnect Attempts - Prevent automatic reconnect attempts every 30 
seconds by the program.  

 



2.6.9 The Score Window 

 2.6.9 The Score Window  
o 1. Mouse Assignments  

Here are three examples of the Score window, which is formatted automatically when you select a 
contest.  

CQWWSSB PACC VHFREG1  

 

 

 

 

The Score Summary dialog displays the score for the current contest with the points that have been 
achieved by band (as a single band entry). Totals for points, multipliers and score are shown. The 
dialog can be found under the Window menu item. The scores are updated when contacts are 
added/deleted.  

The first and last example pictures above are single mode contests (SSB), the example in the middle 
is a mixed mode contest and where necessary the modes will be shown by band. The points are shown 
in the caption of the dialog.  

1. Mouse Assignments 

 Right mouse click, a menu will appear  

o Copy all - Copy all info to the Windows clipboard.  
o Print to file - Print the score summary to a file.  
o Help - Show the help file for this window.  

 
Note:The number of contacts shown on screen and printed on the summary sheet are after duping.  

 

2.6.10 The Multipliers by Band Window 

 2.6.10 The Multipliers by Band Window  

o 1. Keyboard Assignments  
o 2. Mouse Assignments  
o 3. Radio Button Assignments  
o 4. Colors  



Your Mults by Band Dialog window will be similar to these.  

 

 

 

This dialog gives a band by band breakdown of worked and wanted countries/zones/sections (contest 
dependent) per continent when Country is selected. Each continent has it's own Tab, the last Tab 
gives a total for all bands. In the title bar the number of worked and the total of possible 

countries/zones/sections is shown. The Multipliers by Band dialog can be found under the Multipliers 
item under Windows. A scroll bar at the bottom is added for convenience.  

The blocks shown can be bands or modes depending on the contest. The number of shown blocks 
depends on the selected contest and selected mode (CW, SSB, Mixed).  

In most contests all multipliers are shown (like countries, sections etc.). There are a few contest with 
many possible multipliers to much to fit in the multiplier window. In that case (like IOTA contest) ony 
the multipliers worked are shown (and when starting the contest the Sect or Other tab shows an 
empty dialog and every new multiplier will add a line in the dialog.  

If unknown sections are logged they will be shown under the callarea "UNK".  

 The number of blocks shown per band depends on the 'Mode category' which can be found on 
the tab 'Contest' under 'File>Open Log in Database dialog.  

o CW, SSB, RTTY - will give one block per band  
o MIXED - will give two blocks per band  

 white = CW, gray = SSB  

 The bands shown depend on:  



o The selected contest, each contest has its own default which mostly will be the 6 HF 

bands.  
o The setting of the band filter box in the Multiplier by Band dialog.  

 A combination of the Band filter box and the Mode filter box gives many possibilities.  

o Mode filter Auto means that it uses the 'Mode category' which can be found on the tab 
'Contest' under 'File | Open Log in Database dialo'.  

 Examples:  

o Bandfilter: Auto Mode filter: Auto  
 default per contest, mostly the 6 major HF bands (160 80 40 20 15 10)  

 Used in all major contests like CQWW, ARRL DX etc  
 Single mode contests (CW or SSB)  

 2 blocks - possible CW and SSB (mixed mode contests) with no band 

multipliers  
 Used in contests like ARRL 10 meter etc.  
 White = CW, Gray = SSB  
 Mixed is selected  

 12 blocks - mixed mode contests where there are also band multipliers  

 The order of the blocks is 160CW, 160SSB, 80CW, 80SSB, ..., 10CW, 
10SSB  

o Bandfilter: HF+WARC Mode filter: SSB  
 9 blocks - all 9 HF bands (160 80 40 30 20 17 15 12 10)  

 there is no multiplier indicator for 60 meters  
 used in contests like DX etc.  

o Bandfilter: HF+WARC Mode filter: Mixed  
 18 blocks - 2 blocks per band for all 9 HF bands (160CW, 160SSB, ..., 10CW, 

10SSB)  
 used in contests like DX etc. when the Mode category selected is Mixed  

 Grid square overview  
o Shown when a VHF or up contest is selected  

o Clicking on a grid will center the window on that grid  
o The own station gridsquare will be shown in white/dark green  

1. Keyboard Assignments 

 Ctrl+J - Toggle through the Countries, Zones, Sections & Other windows  
o When the Multiplier window is not open, it will be opened.  

 Ctrl+Shift+J - Opens or minimizes the Multiplier-by-band window  

 Ctrl+Alt+J - Toggles through continents.  

2. Mouse Assignments 

 Left-click on multiplier/abbreviation  

o Click on the abbreviations and it will populate the Entry Window exchange filed with 
the correct syntax. It will overwrite the current exchange so be careful!  

o It will only work for contests where Exchange1 is used for the county or section, which 
is many contests, but not all.  

 Right-click in the window - a menu will appear  

o Show Zones/Countries :  
 Countries selected: Shows the zone for a selected country  
 Zones selected: Shows the countries in the selected zone  

o Show Calls Worked - Shows all calls worked in this country or zone, or in this county 
(QSO parties only).  



o Set Grid center - Shows a dialog in which you can enter the desired grid square (4 

digits long) on which to center the grid square view (grid square contests only)  
o Show Bearing to Grid - Displays bearing and distance to that grid square (grid 

square contests only)  

o Turn Antenna to Grid - if rotor control is configured (grid square contests only)  
o Set Rover QTH - Used to change location for rover stations (Rover station category 

only)  
o Minimum Grid Square Box - Reduces the size of the box for each grid square to the 

minimum required to display a 4-character grid (grid square contests only). The boxes 
revert to normal size when the Multiplier window or the program are closed.  

3. Radio Button Assignments 

 Country - Show the countries worked for the band chosen.  

 ZN - Show the zones worked for the band chosen.  

 Sect - Show the sections or states worked for the band chosen.  

 Other - Show the other possible multipliers worked for the band chosen.  
o in VHF contests a Grid square overview will be shown.  

 Auto - Band filter  

o Auto - Shows the bands for the selected contest (mostly the major 6 HF bands)  
o HF - shows all 6 major HF bands  
o VHF - shows all VHF and up bands (50 MHz and up)  
o HF + WARC - shows all HF bands  

o All separate bands - 1.8, 3.5, 7 .... up to 241 GHz  

 Auto - Mode filter  
o Auto - Shows the mode as selected for the chosen contest (CW, SSB, Mixed, Digi)  

 one block per band when a single mode is selected  

 two blocks per band when Mixed is chosen as 'Mode category' which can be 
found on the tab 'Contest' under 'File | Open Log in Database' dialog'.  

o CW - shows only CW contacts (one block per band)  
o SSB - shows only SSB contacts (one block per band)  

o Dig - shows only Digital contacts (one block per band)  
o Rev -when not in a single mode contest this button selects the other mode (SSB 

versus CW) (one block per band)  

 Reset - Resets the two filters to Auto  

4. Colors 

 White - You need this one, work 'em  

 (light) Red - Worked country, zone, section or grid square  

 

2.6.11 The Statistics Window 

 2.6.11 The Statistics Window  
o 1. General  
o 2. Button Assignments  

o 3. File Menu  
 3.1. Example Statistics  

Statistics can be found under View > Statistics in the Entry Window.  

 



Tip 

During a contest, if you are checking Statistics and a station comes back, just start typing. The 
statistics window will go to the background and every typed characters will go to the Entry window. 

1. General 

The statistics window has the possibility to select almost all database fields from a contest in the row 
or column side of the statistics table. Many different statistics can be made this way. The database 
fields to select from are tabulated below.  

Fields Row Column Remarks  

Band Y Y 
 

Operator Y Y compare operators, only useful when running Multi-operator  

Hour Y N 
 

RadioNr Y Y only useful when using more than one radio  

Mode Y Y useful in mixed contests  

CountryPrefix Y N worked number of stations per country or mode  

Zone Y Y 
 

Section Y Y 
used in many domestic or local contests - may equate to province, oblast, 
ARRL section, etc., depending on the contest  

CK Y N 
2 digit number used in Sweepstakes, formally denoting the year first 
licensed  

Prec Y Y "Precedence" used in Sweepstakes to denote class of entry  

Points Y Y 
 

Mult1 Y Y multiplier, or first multiplier in contests with more than one  

Mult2 Y Y Second multiplier in contests with more than one  

Mult3 Y Y Third multiplier where applicable  

WPXPrefix Y N prefix as determined by WPX rules  

GridSquare Y Y 4-character of grid square  

Run1Run2 Y Y useful when doing SO2R  

MiscText Y N Contest specific information  

ContactType Y Y Blank = qso, "D" = dupe, "N" = non-workable station  

Day Y Y first or second day of the contest  

Mult & Band Y Y 
 

Exchange1 Y Y Use in some contests (like WAE to show QTCs) 

 

Note 

Old contests may not have valid values in fields that have been added since the contact was logged. 
The number of contacts shown on screen and printed on the summary sheet are without dupe 
contacts. 

2. Button Assignments 

 Row - Select a row field.  

 Column - Select a column field.  

 Refresh - Refresh the contents of the table. The statistics are not automatically updated when 
a contact is logged/changed/deleted.  

o The statistics window is refreshed when changing contests.  



3. File Menu 

 Print - Print the statistics table to a printer. Font can be set by user.  

 Print to File - Print the statistics table to a file.  

3.1. Example Statistics 

Here are some examples:  

Row Column Usage Description  

CountryPrefix Band Always QSOs per country per band  

Hour Operator Multi User QSOs per hour per operator  

Band Operator Multi User QSOs per band per operator  

GridSquare Band Grid contests QSOs per gridsquare per band  

Band Exchange1 WAE and some other Show RQTC & SQTC info 

 

 

 

2.6.13 Grayline Program 

 
A Grayline program comes with the N1MM logger software package. It is included in the N1MM full 
installation program. You may install the Grayline program at any time, during initial installation or 

later. N1MM logger does not need to be running to use it, or even installed, but you may start the 
program from the Window menu in the N1MM Logger Entry Window.  



 

1. Right Click Menu Selections 

 Grayline contrast  
o A dialog will open the Sunset and Darkness can be adjusted. A test button is available 

to check the settings.  

 Show my Location - Will show a red dot on your location.  

o The location as set in the N1MM Logger main program is used (Config | Change Your 
Station data| Latitude & Longitude).  

 Show Meridian Lines - Show the meridian lines on the Grayline map.  

 Sun  
o Show Sun - Select or de-select showing the current position of the sun on the Grayline 

map.  

o Small sun - Show a small sun.  

o Medium Sun - Show a medium sun.  
o Large Sun - Show a large sun.  

 Twilight terminator- the width of the gray line in degrees.  

o Civil terminator - 6Ãƒâ€šÃ‚Âº  
o Nautical terminator - 12Ãƒâ€šÃ‚Âº  
o Astronomical terminator - 18Ãƒâ€šÃ‚Âº  

 

Details About the Grayline Program 

The Grayline program was not written by the N1MM team, and they have no ability to implement 
enhancements or bug fixes.  

One frequent issue reported by users has to do with the Grayline window "disappearing" from the 

screen. This appears to happen because something corrupts the Grayline program's ".ini" file (actually 
named QTH.txt and located in the Grayline folder of the N1MM program directory).  

If you encounter this problem, there are two ways to fix it.  

1. Right-click on the icon in the task bar, and select "Move" (if "Move" is greyed out, first select 
"Restore", then "Move"). Tap one of the arrow keys on the keyboard (this is important but not 
obvious). Move your mouse around until the window appears on screen. Left-click to freeze the 
window where you want it.  

or  



2. Open QTH.txt in Notepad and delete the first two lines. The next time the Grayline program starts, 

the window will reappear at the default location, and you can then adjust its position and size to meet 

your needs. 

 

2.6.12 Visual Dupesheet Window 

 
Example Visual Dupesheet  

 
 

 

 

The Visual Dupesheet is a quick way to determine if a station is a dupe without having to enter the 
callsign in the program. The calls already worked will be indexed much like a paper dupesheet that is 
organized by callarea and suffix. The Visual Dupesheet is especially useful for short, high speed 
contests like the NA Sprint. It is closely patterned on the Visual Dupesheet used by TR Log.  

 Each VFO/Radio/Bandmap has its own Visual Dupesheet. The VFO/Radio A sheet displays all of 

the contacts for the band VFO/Radio A is on. VFO/Radio B does the same for whatever your 
VFO B/Radio is set to even if you don't (or cannot) use VFO B.  

 The columns signify call areas. If a call area exceeds the number of calls that will fit it will 

overlap into an adjacent column with some dash lines to differentiate.  

 Each call area is sorted by suffix.  

 To see the dupe sheet for any band, set your radio to that band.  

 To check for a dupe, first look for the call area column, then look up the suffix, then the prefix.  

 If you don't want both windows open, close one, position the other where you want it and then 

use Tool > Save Window Positions. The next time you start the program only one window will 
open.  

 Unless you can copy RTTY in your head, you do not need the Visual Dupesheet for RTTY 

contests. Obviously RTTY calls will tell you they are dupes or not as soon as they print.  

 The Visual Dupesheet can hold a maximum of 800 stations per band. Going above this limit 

will give a warning . Depending on computer speed and configuration, users may experience 
noticeable delays when using the Visible Dupe Sheet with logs containing more than 300 calls. 
Performance with 600 callsigns is acceptable with a 2.6 GHz computer running only Logger.  

 Right-clicking on the gray area at the right of the Visual Dupesheet allows selection of a small 
or large font size.  

 There are no menus in this dialog.  

What is the usefulness of the Visual Dupesheet?  

By Steve, N2IC  

First, let me say what this feature is not: It is NOT intended to be a step towards paper (or electronic) 
dupe sheet submission. A paper dupe sheet is an obsolete artifact of the pre-computer logging era.  



Now, I'll be perfectly honest about the utility of the Visual Dupesheet. I have been a user of TRLog for 

many years, as well as a fan of the NA Sprint contest. To do very well in an extremely fast-paced 
contest, like the NA Sprint, you have to minimize the amount of non-productive time. Any time you 
are not actually making a QSO is non-productive time. As you tune around a band, looking for new 

stations to work, you need a really fast way to determine if a station that you hear is a dupe. The 
fastest way to do this is to use only your brain. Some contesters have an amazing ability to keep their 
dupesheet completely "in their head". For the rest of us, we typically reach for the keyboard and type 
the call into the entry window. As soon as you do this, N1MM Logger instantly tells you whether it's a 
dupe. Excellent. However, some of the NA Sprint operators who use TRLog have found an even faster 
way to check for a dupe - using TRLog's Visual Dupesheet feature. As you tune the band, you keep 
your eyes focused on the Visual Dupesheet. It becomes second nature to scan the Visual Dupesheet. 

When you hear a non-dupe that you want to call, you don't even have to enter the call in the Entry 
Window, yet. Just hit the Enter key. If he/she comes back to you, you now have time to enter his/her 
call and exchange.  

Obviously, in a contest where you work many, many stations on each band, this feature won't work - 
it takes too long to scan the Visual Dupesheet when it is crowded with calls. However, this is not the 

case with the NA Sprint. The winners work no more than 150 stations per band, making the Visual 
Dupesheet an ideal way to dupe check.  

 

2.7 Digital Modes 

 1 General RTTY and PSK Information 

 2 Digital Overview and Features 

 3 Digital Setup 

 4 Digital - MMTTY for RTTY Support 

 5 Digital - MMVARI for PSK and Other Modes 

 6 Digital - Fldigi for Sound Card Modes 

 7 Digital - External TNC Support 

 

2.7.1 General RTTY and PSK Information 

 2.6.13 Grayline Program  
 1. Right Click Menu Selections  

 2.6.12 Visual Dupesheet Window  

 What is the usefulness of the Visual Dupesheet?  

 2.7 Digital Modes  

 2.7.1 General RTTY and PSK Information  
o 1. RTTY Information  

 1.1. Common RTTY Frequencies  

 1.2. General RTTY Information  
o 2. PSK Information  

 2.1. General PSK Information  
 2.2. Common PSK and Digital Frequencies  

Digital mode contesting is growing rapidly. N1MM Logger supports digital mode contesting, not only 
RTTY but also other digital modes, with a flexible interface.  

1. RTTY Information 

http://n1mm.hamdocs.com/tiki-index.php?page=General+RTTY+and+PSK+Information&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+Overview+and+Features&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+Setup&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+MMTTY+for+RTTY+Support&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+MMVARI+for+PSK+and+Other+Modes&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+Fldigi+for+Sound+Card+Modes&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+External+TNC+Support&structure=N1MM+Logger+Digging+Deeper


This section contains some general information about operating in RTTY that is not directly related to 

N1MM Logger. For RTTY newbies, it is recommended that you read AA5AU's tutorial on getting started 

on RTTY . If you are new to digital mode contesting in general and RTTY in particular, the following 
information may also be helpful. If you are an old-timer on RTTY, you can probably skip this section.  

Before the spread of personal computers, RTTY was the most prevalent digital mode (other than CW, 

that is!), and was done using surplus teletype equipment - mechanical teleprinters. This equipment 
posed severe constraints on the RTTY mode that are still evident today. Despite these constraints, 
RTTY has proven to be quite well-adapted to contesting, and it is still by far the most common digital 
contesting mode.  

More recently, these mechanical teleprinters have been replaced by other devices. At first these were 
mostly separate boxes containing embedded microprocessors (called "terminal units" or "TNCs"), but 
now the most common device for decoding and encoding RTTY is simply a sound card in a personal 
computer. N1MM Logger is capable of using either a hardware terminal unit or one of several software 
"engines", including MMTTY, MMVARI, Fldigi and 2Tone. Because there is no one method, whether it 

be a software program or a hardware modem, that performs better than the others under all 
conditions, N1MM Logger also supports the capability to run two or more such methods in parallel, 
thus gaining the advantages of both. For example, a user might choose to use a terminal unit such as 
the HAL DXP-38 in parallel with one or more copies of MMTTY using different decoding algorithms and 
parameters, in the hope that when conditions are marginal, one or another of the parallel decoders 
will succeed even when the others are failing to decode accurately.  

The most commonly used digital engine for RTTY is MMTTY. MMTTY performs very well, and offers a 
wide range of adjustments and options that are not available with the other available choices. 
However, MMTTY does not support other digital modes like PSK31. Amateurs who wish to use other 

digital modes will have to use either MMVARI or Fldigi as the digital engine for those modes, and users 
who are accustomed to using one of these engines for other modes may prefer to use the same 
engine for RTTY instead of switching to MMTTY. MMVARI comes pre-loaded with N1MM Logger, 
whereas MMTTY, Fldigi and 2Tone must be downloaded separately.  

An RTTY signal is a single carrier (like CW), but instead of being modulated on and off like CW, the 
transmitted power is kept constant, and modulation is imposed by changing the frequency by a preset 
amount; in amateur usage, the historical practice is to use a "shift" of 170 Hz. That is, RTTY is 
modulated using frequency-shift keying (FSK). The frequency shifting can be done either at RF, in 
radios which support this method, or at audio frequencies.  

The first method (usually called FSK) requires an on-off keying signal to be applied to a keying input 
to the radio. This keying is very similar to CW keying, except that instead of turning the carrier on and 

off as in CW, closing the key input shifts the transmitter's frequency. FSK therefore requires an on-off 
keying interface between the computer and the radio, and the radio must have the internal circuitry 
required to perform the frequency shifting. Radios that support this FSK mode usually have other 
features that assist RTTY operators, such as specialized filtering.  

The second method, using audio tones fed into an SSB transmitter which converts the tones to RF in 
exactly the same way that SSB converts audio voice frequencies to RF, is called Audio Frequency Shift 
Keying (AFSK). AFSK can be used with any SSB transmitter. Because the optimum filtering and other 

settings for RTTY operation are different from those for voice communication, some transceivers offer 
special AFSK or digital-mode modes, but fundamentally these are the same as SSB.  

There are never-ending arguments among amateurs as to which method is better, FSK or AFSK. If a 
station has been successfully set up for other sound-card digital modes, such as PSK31, that same 

setup can be used for AFSK RTTY, whereas the hardware configuration needed for FSK is unique to 
RTTY and cannot be used for other digital modes. However, some radios do not support the use of 
narrow receiving filters in SSB mode, which makes FSK better for RTTY contesting with those radios 
from an operational point of view. From a signal quality point of view, the very best AFSK setups can 
produce signals that are somewhat cleaner (occupy less spectrum) than most FSK transmitters are 

http://www.aa5au.com/rtty.html
http://www.aa5au.com/rtty.html


capable of, but on the other hand, a poorly set up AFSK station can transmit spurious signals, splatter 

or hum and noise. Badly configured AFSK setups are unfortunately more common than they should 
be, and give AFSK a bad name. When using AFSK, care must be taken to ensure that audio levels are 
set correctly; FSK does not require the same level of care.  

Digital modes are harder on transmitting equipment than CW and SSB because of the higher duty 
cycle (sustained periods of full-power transmitting). As a result, it is important not to overstress the 

transmitter. It is also important to take steps to avoid transmitting extraneous noises or spurious 
signals, and to ensure that neither audio harmonics nor intermodulation distortion (IMD) products are 
generated anywhere in the signal chain.  

Here are some tips for RTTY setup and operation:  

Hardware interfacing:  

 Unless your radio has a USB Codec built in (e.g. IC7200 and 7600), in order to receive RTTY 

you will need to connect the audio output from your radio to the input of the sound card being 
used with your computer, or if you are using a TNC or TU, to its audio input (see the manual 
for your TNC/TU for details)  

 To transmit:  

o For AFSK, you need to connect the audio output from your sound card or TNC/TU to an 
audio input on your radio (exception: radios with a built-in USB Codec), either directly 
or via a sound card interface  

o For FSK, you need a keying circuit from a serial port to your radio's FSK keying input. 
If you are using a USB-to-serial adapter, you will probably need to use the EXTFSK 

plug-in in MMTTY  
o For either AFSK or FSK, you need some way to control PTT (TX/RX switching). In 

AFSK, VOX operation is the simplest method with many radios, although some radios 
do not support the use of VOX with the line-level audio inputs used for AFSK, and VOX 
is not possible in FSK. If you use PTT control from N1MM Logger in other modes, the 
same method can be used in digital modes. Alternatively, you can control PTT from a 
serial port with a keying circuit. In FSK, the same port can be used for PTT and FSK  

 
On the radio make sure:  

 Audio processing is off  

o Speech processing is off  
o Hi boost is off (Kenwood radios)  

 If the radio does not have an RTTY-specific mode, it should be in LSB mode  

o RTTY-specific modes may also be called FSK, AFSK, LSB-D, PKT-LSB, ...  

 The most often used speed is 45.45 Baud (60 words/min)  
o Some contests use 75 Baud (100 wpm)  

 The standard shift is 170 Hz  

o Some TNCs use 200 Hz shift  

 When using a TNC set 'Mark' to 2125 Hz and 'Space' to 2295 Hz  

 Don't overrun your finals from the transceiver and/or amplifier  
o 50 percent duty cycle is mostly ok, but some transmitters may require reduced power 

in digital modes  
o See the Interfacing chapter for url's and tips on interfacing  

 The BAUDOT character-set does not have all ASCII characters so some special characters such 
as (~ * _ @ # =)? can not be printed/transmitted  

 During contests narrow filters are normally used (250 - 500 Hz)  

1.1. Common RTTY Frequencies 

http://n1mm.hamdocs.com/tiki-index.php?page=Interfacing&structure=N1MM+Logger+Documentation


Contests USA (kHz) USA (kHz) Europe/Africa (kHz) Japan (kHz)  

Common Common DX frequency Common Common  

1800 - 1810/1835 - 1845 1800 - 1810 1838 - 1843 1838 - 1843 
 

3570 - 3600 3580 - 3600 3590 3580 - 3620 3520 - 3530  

7025 - 7100 7025-7050/7080 - 7100 7040 7035 - 7045 7025 - 7040  

 
10120 - 10150 

 
10140 - 10150 

 
14060 - 14120 14080 - 14100 

 
14080 - 14100 

 

 
18100 - 18110 

 
18100 - 18110 

 
21060 - 21150 21080 - 21100 

 
21080 - 21120 

 

 
24910 - 24930 

 
24920 - 24930 

 
28060 - 28150 28080 - 28100 

 
28050 - 28150 

 
 

1.2. General RTTY Information 

There are two aspects of RTTY which are often confusing to newcomers to the mode.  

The first of these is the "polarity" of the signal. In FSK, there are two frequencies, conventionally 
called "mark" and "space". In amateur RTTY, the mark frequency is the higher of the two RF 
frequencies. Someone who is transmitting with the opposite polarity is said to be transmitting "upside 
down". His signal will be gibberish at the receiving station, unless the operator there inverts his 
receive polarity. When first setting up for RTTY, if you appear to be unable to decode any signals you 
receive, try inverting your receive polarity (in MMTTY, use the "Rev" button; in MMVARI, switch 
between RTTY-L and RTTY-U settings).  

In FSK, getting the polarity right involves arranging things so that the switching conventions (does 

closing the keying input result in mark or space?) match between the radio and the computer. 
Unfortunately, the switching conventions are not universal. Fortunately, almost all radios affected by 

this have a menu item in the radio to reverse the keying polarity. Once this option is set correctly, the 
radio's transmit RTTY polarity will be correct from then on. On receive, most if not all radios in FSK 
mode receive RTTY on the lower sideband. If software is used to demodulate the received signal, it 
must be set so that the lower of the two audio tones is converted to mark and the upper tone to 
space. This is the default configuration in software that supports FSK keying (like the MMTTY engine 

used in N1MM Logger). Note that in FSK, the transmit and receive polarities are determined 
independently, i.e. it is possible to receive correctly and yet to transmit upside down.  

In AFSK, getting the polarity right involves coordination between the choice of audio frequencies 
generated in the sound card and the choice of sideband on the radio. The most common combination 
is to use lower sideband on the radio, combined with an audio tone pair in which the mark tone is the 
lower of the two audio frequencies (e.g. the most common pair is mark = 2125 Hz, space = 2295 Hz). 
The use of the lower sideband inverts these tones at RF to match the standard amateur convention. 
Software that uses the opposite convention (mark tone higher than space) is used with the radio in 

upper sideband. Fortunately, once the receive polarity is correct in AFSK, the transmit polarity will also 
be automatically correct.  

The second sometimes puzzling aspect is related to the RTTY character set. The digital code used in 

RTTY predates the ASCII code used by modern computers. Instead of 8 bits, which allows for 256 
different characters, the Baudot or Murray code used in RTTY has only 5 bits. This 5-bit code only has 
enough different characters for 26 letters plus 6 control codes, so to get numbers and punctuation the 
text has to be preceded with a special "FIGS" character (one of the 6 control codes) to get a second 
set of 26 characters (10 numbers plus 16 punctuation marks). FIGS is "sticky", so there is another 
special "LTRS" character to switch back to the letters case.  



Just like any other character, these FIGS and LTRS characters can be damaged by noise, QRM, QSB, 

etc., and if they are, the received info is displayed wrongly until the next LTRS or FIGS character (or 
in some situations, the next space character) comes along and sets things right. Sometimes the 
opposite happens - a text character is converted by noise into a FIGS or LTRS code, with similar 
results.  

The most common problem that results is numbers being printed as letters, so with a bit of 

experience, many RTTY operators will get used to interpreting TOO as 599 and UE as 73. Serial 
numbers are slightly more difficult; PQW in the input data is most likely 012, and so on. You can see 
which letter corresponds to which number by comparing the top (QWERTY) row of letters on the 
keyboard with the numbers immediately above and to the left. Letters can also be printed as numbers 
and punctuation; for example, CQ TEST when converted to FIGS case becomes :1 53'5 .  

Various software has different ways of helping out with this. When you run MMTTY stand-alone, if you 
right click on a "word" (delimited by spaces), the entire word changes to the opposite case. So, for 
example, VE4AEO is changed to ;3R-39 and vice versa. N1MM's digital window has a box titled 

Letters/Figs for opposite-case display, that shows text that the mouse "hovers" over (no click 

necessary) in the opposite case. This requires you to move the mouse over the text that you want to 
convert; the unconverted text is displayed in the MouseOver box.  

Unshift on Space 

There is a common feature called Unshift on Space (UOS or USOS) whose purpose is to deal with the 
lost {FIGS}/{LTRS} problem. It was designed for normal text, where the majority of information is 
alphabetic.  

 

MMTTY has two UOS options. One of these is a button on the MMTTY main window that affects what 
you see in the receive window; the other is a setup option (under the Tx tab in the MMTTY setup) that 
affects what you transmit.  

The receive option in the main window simply changes the receive window's case back to {LTRS} at 

the beginning of every new "word", i.e. after a space, unless of course the new "word" starts with 
{FIGS}. This takes no extra time, but improves reliability of receipt of alphabetic text.  

The transmit option, on the other hand, actually transmits extra {FIGS} characters at the beginning of 
every numeric "word" to try to ensure greater reliability. It does not transmit an extra "LTRS" at the 

beginning of every alphabetic word, because using UOS on receive is a more efficient way to achieve 
the same end result.  

When you are ragchewing, you should always use UOS on both receive and transmit. UOS assumes 
that the majority of "words" are alphabetic, which is true of normal text.  

During contests, the receive UOS option is still helpful, especially when the exchange includes letters, 
and it does not cost anything. The N1MM Logger DI window's "Letters/Figs" line can be used to deal 
with those cases where receive UOS converts an intended numeric field to letters.  

The transmit UOS option achieves greater reliability of numeric exchanges at the cost of some extra 
{FIGS} characters. If you are concerned about the slight speed penalty it imposes, you can leave 
transmit UOS on and use dashes ("-") instead of spaces between all-numeric fields, e.g. 599-123-123 
. (Do not make the mistake of using dashes between alphabetic fields though; dashes between 
alphabetic fields are both slower and less reliable than spaces.) The downside of using dashes in this 
way between numeric fields is that if the initial {FIGS} character is lost, the entire exchange will be in 

the wrong case, e.g. TOOAQWEAQWE. Sending spaces with transmit UOS on costs two extra {FIGS} 
characters but is more reliable (our example with an initial lost {FIGS} character becomes TOO 123 
123). On the other hand, turning transmit UOS off results in 599 QWE QWE in any receiver using UOS, 
even with no errors at all. A compromise among all of these possibilities is to always turn transmit 



UOS on, but use a hybrid exchange: 599-123 123 (a dash instead of a space after the signal report, 

but spaces after that). A single {FIGS}/{LTRS} error will not prevent at least one copy of the 
exchange from being decoded correctly regardless of whether the receiving station is using UOS or 
not. 

2. PSK Information 

2.1. General PSK Information 

PSK31 (and its higher-speed versions, PSK63 and PSK125) is an example of a "sound-card digital 
mode", i.e. a digital mode that was made possible by the use of sound cards in PCs. The advent of 
sound cards in PCs made these sound-card modes available for anyone to use with a minimum of 
expense. All that is needed is an SSB transceiver, an audio interface (which can be as simple as patch 
cables, or can include isolation and attenuation controls) and a means of controlling PTT, unless VOX 
is used.  

N1MM Logger supports PSK31 and other sound-card digital modes using either of two digital engines: 
MMVARI and Fldigi. MMVARI comes pre-loaded with the program, whereas Fldigi has to be downloaded 
separately. Fldigi supports a wider variety of digital modes than MMVARI, although the majority of 
these modes are not used for contesting.  

Conventionally, sound-card digital modes are communicated using USB, regardless of the band. Many 

PSK31 users set their radio's dial to a standard frequency (14070.0 kHz is the most common) and 
then look for signals anywhere within their SSB filter bandwidth (e.g. from 250 Hz to 2750 Hz or so, 
which would correspond to transmitted frequencies from 14070.25 kHz to 14072.75 kHz). PSK31 
signals are narrow-band, so there can be many different PSK31 signals simultaneously copyable within 
the available frequency range without changing the radio's dial setting. Tuning is often done simply by 
clicking on the desired signal in the waterfall display.  

PSK31 is short for "Phase Shift Keying, 31.25 baud". There are also higher-speed versions, PSK63 
(62.5 baud - seen fairly often) and PSK125 (125 baud - rare). Actually, in addition to using phase shift 

keying for modulation, PSK31 also uses amplitude modulation ("waveform shaping") to minimize the 

bandwidth occupied by a signal. As a result, PSK31 places great requirements on the linearity of the 
equipment used, from the sound card generating the signal to the transmitter, and also the receiver. 
The peak power of a PSK31 signal can be approximately twice as high as the average power. If a 
transmitter is operated near its power handling capacity, it can clip these peaks, resulting in 
"splatter", which shows up on the waterfall as extra "tracks" in addition to the two main modulation 
tracks that are normally visible. To avoid having this happen, the audio levels in the sound card and in 
the transmitter's input audio stages must be controlled to avoid reaching power levels that would 

result in clipping. In most transmitters, this is equivalent to keeping the power below the level that 
would result in ALC action, and often this means powers below approximately half the transmitter's 
maximum power rating.  

Standard PSK31 (sometimes also called binary phase shift keying, or BPSK31) is sideband-
independent. There is a rarely-used variation called QPSK31 (or QPSK63 for the 62.5 baud speed) that 
uses four phases instead of two (quadrature phase shift keying). This allows for some error correction 

while still delivering the same text speed. QPSK31 is sideband-dependent, i.e. the transmitting and 
receiving station must both be using the same sideband in their radios (by convention, upper 
sideband).  

PSK31 works well even at low powers. In fact, once the transmitted power is sufficiently high to give 
an acceptable level of copy, there is no advantage to be gained by increasing power further. Unlike 

analog modes, where increasing power may make your signal louder relative to QRM and therefore 
easier to copy, increasing the power in PSK31 does not improve your signal's readability. It can even 
degrade copy by overloading the other station's receiver and creating splatter within the receiver. 
More importantly, a very strong signal will affect the AGC in every receiver that picks it up, causing 



the receiver gain to decrease and making copy of signals on other frequencies more difficult. For this 
reason, high-power operation is unpopular in PSK31.  

When you plan to run PSK:  

 Keep your macros short.  
o PSK is about 1/3 slower than RTTY; you can really impact your rates with wordy 

macros  

 Use lower case letters wherever possible  
o PSK is a varicode mode. That means that characters contain a variable number of bits, 

unlike ASCII characters that have a fixed number of bits. Most lower-case PSK 
characters have fewer bits in them than their upper-case equivalents, so lower-case 
(in general) transmits faster  

 
On the radio make sure:  

 Audio processing is off  

o Speech processing is off  
o Hi boost is off (Kenwood radios)  

 Radio should be in USB mode  

o Some radios have modes designed for digital sound card modes, e.g. PSK, DATA A  

 Transmitter linearity is extremely important in PSK  
o Keep power below 1/2 the transmitter rating to avoid clipping peaks  

o Avoid any visible ALC action (except in radios with ALC designed for PSK, e.g. Elecraft 
K3)  

o See the Interfacing section of this help for url's and tips on interfacing  

 Using lower case letters instead of all caps will increase speed and reduce TX time  

 Only 100 Hz is needed as channel separation  

 Example filter usage:  

o Available 2.4 kHz / 250 Hz /100 Hz filter bandwidths  

o 2.4 kHz is used for monitoring the PSK area of band when in search and pounce mode  
o 250 Hz and 100 Hz filter bandwidths are used when in run mode  

2.2. Common PSK and Digital Frequencies 

PSK31 activity generally starts from the bottom edge of the IARU RTTY bandplan, expanding upwards 
as activity increases.  

Band Digital Frequencies (kHz) PSK Frequency (kHz) Remarks  

160 meter 1800 - 1810 / 1838 - 1843 1807 / 1838  1807 in Region 2  

80 meter 3575 - 3585 3580  

40 meter 7030 - 7040 / 7060 - 7085 7035 / 7080 7080 in Region 2  

30 meter 10130 - 10145 10142 WARC, no contesting  

20 meter 14065 - 14090 14070  

17 meter 18100 - 18110 18100 WARC, no contesting  

15 meter 21060 - 21090 21080  

12 meter 24920 - 24930 24920 WARC, no contesting  

10 meter 28110 - 28125 28120  

 

2.7.2 Digital Overview and Features 
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The digital part of the N1MM logger program is designed, coded and maintained by Rick Ellison, 
N2AMG.  

1. Digital Overview 

N1MM Logger supports a variety of methods to decode and transmit digital modes, including an 

external TNC/TU; the MMTTY engine for RTTY (sound card on receive, either sound card AFSK or 
FSK keying on transmit); G3YYD's 2Tone drop-in replacement for MMTTY, for AFSK RTTY; the 
MMVARI engine for RTTY (AFSK, or starting with Logger version 10.9.5, FSK), PSK31, PSK63, 
PSK125 (both BPSK and QPSK), and MFSK16; or the Fldigi engine for a broad range of sound-card 
digital modes including AFSK RTTY, PSK and many more. Regardless of which of these engines is 
used, the digital data streams pass to and from the engine via the Digital Interface (DI) window. At 

least one DI window must be open to operate the Logger in digital modes. Depending on your 
hardware configuration and operating mode, you may have either one (SO1V, SO2V) or two (SO2V, 

SO2R) DI windows open. Both DI windows have full receive and transmit capabilities. It is also 
possible to supplement the two DI windows with up to four additional receive-only windows. The user 
can interact with the DI windows using either the keyboard or the mouse as the primary control 
interface. There is a wide variety of options available to customize the operation of the digital 
interface.  

For RTTY, by far the most popular interface engine is MMTTY. MMTTY performs very well, supports 
both FSK and AFSK, and has a wide variety of options and parameters that can be adjusted to tweak 

its performance. Many new users of N1MM Logger will already be familiar with MMTTY, either from 
using it stand-alone as an RTTY program, or from using it from within another contesting or general 
logging program. MMTTY does not come pre-installed with N1MM Logger; it must be downloaded and 
installed separately, and then the Logger can be configured to use it.  

An alternative to MMTTY, using different decoding and encoding algorithms that perform better than 
MMTTY under some (but not all) conditions, is 2Tone. 2Tone was written by G3YYD to be a 
replacement for MMTTY without requiring any changes to the interface programming. That is, 

anywhere the MMTTY program is called up in N1MM Logger, 2Tone can be used instead simply by 
changing the path to the program in the configuration. Probably the most common use for 2Tone is in 

parallel with MMTTY. One of the programs is used in the main Digital Interface window, and the other 
one is used in an additional RX-Only window. Someone using FSK will use MMTTY in the main window 
and 2Tone in the additional window; someone using AFSK can choose either one to be the main 
engine.  

MMTTY (and 2Tone) does not support other digital modes. Users of those other digital modes can 
choose either MMVARI or Fldigi as the digital engine for those modes. MMVARI comes pre-loaded with 
N1MM Logger, whereas Fldigi has to be downloaded and installed separately. Fldigi supports a wider 



variety of modes, although most of those modes are not used for contesting. For most users, it is 

probably the user interface that determines which of these two engines they prefer. Users who are 
accustomed to operating digital modes using one of these engines may be more comfortable using the 
same engine for RTTY as well, instead of switching to MMTTY.  

While MMTTY typically performs as well as or better than most of the hardware interfaces that were 
formerly common for RTTY (e.g. multi-mode TNCs), there are some terminal units that can rival or 

exceed it in performance under some conditions. Users who already have one of these devices may 
wish to consider using it with N1MM Logger, either on its own or in parallel with MMTTY. For most such 
terminal units, the user will have to program the software commands needed to control the unit into 
the digital interface. An exception is the HAL DXP-38, which is supported directly without requiring 
user programming.  

The remainder of this section describes the operation of the DI windows, including basic operation as 
well as advanced features that can help make operation easier and more efficient. The next section 
describes how to set up N1MM Logger and the DI Window for digital modes regardless of which type 

of digital engine is used. Engine-specific details are described in separate sections for each of the 
supported engines (MMTTY, MMVARI, Fldigi and external TNCs; 2Tone is included under MMTTY).  

Problems? 

Check out the Digital Modes part of the Frequently Asked Questions (FAQ) of this Wiki. 

2. Making QSOs 

This section explains:  

 How to make a Digital mode transmission  

 Keyboard, Insert key and Mouse Assignments  

 Function keys  

 Macros  

2.1. Make a Digital Mode Transmission 

 Select 'Window | Digital Interface' and the Digital Interface will open. The Digital Interface 

window can be positioned and resized on your monitor as desired  

 If an external TNC is used only the Digital Interface window is opened. When one of the sound 

card interfaces is chosen an extra window will appear: MMTTY, MMVARI or FLDIGI depending 
on which interface is selected in the DI window's Interface menu  

 Left clicking on a call will grab the callsign. Right clicking on the RX and TX windows will show 
a menu (depends on a menu setting)  

 Pressing Insert will Grab the highlighted call and sends Hiscall followed by the Exchange 
button  

 Double clicking on a callsign in the callsign box from the Digital Interface sends that call to the 

Entry window  

 A callsign is automatically highlighted if recognized by the program. Call signs are always 
recognized when they are both preceded and followed by a space. There is also an option to 

recognize call signs buried in garbage (without a leading or trailing space), provided that call 
sign is in the MASTER.DTA file  

2.2. Digital Need to Know 

 If the callsign in the callsign field in the Entry window is equal to the callsign in the received 
text, the call in the Entry window does not get placed into the call list.  

http://n1mm.hamdocs.com/tiki-index.php?page=Digital+Setup#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+MMTTY+for+RTTY+support#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+MMVARI+for+PSK+and+other+modes#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+Fldigi+for+Sound+Card+Modes#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+External+TNC+Support#N1MM_Logger_Manual


Staying Focus'ed 

Focus is automatically returned back to the Entry window when clicking a callsign in the Receive 
window 

 Pressing Ctrl while single clicking on a call will force the call into the Entry window  

 Click in the Entry window input field you want data to go to and then hold down the Ctrl key 

while clicking on that data. It will paste to the field you clicked into  

 "-" separators between exchange elements are removed automatically  

 CQ Repeat time starts  

o when using a sound card engine, from when the sending stops  
o when using an external TNC, from when the message begins, as there is no way to tell 

when the TNC finishes sending  

 During transmit, callsigns are not grabbed from the receive window  

 Linefeed characters (LF) in incoming text are replaced with Carriage Return (CR) characters  

Auto-CQ with a TNC 

To get auto-CQ to work correctly with a TNC set your repeat time to at least 9 or 10 seconds. It may 
need to be longer if you have a longer CQ macro. This will stop the TNC buffer from receiving the next 
string before it finishes sending the last one. 

Clear the TNC Transmit Buffer 

It is best to add the command that your TNC uses to clear the transmit buffer to the end of your Abort 
Macro. If not, the transmit buffer still holds the remaining characters that were left in the sent string 
and will get sent the next time the TNC sends. 

Stop Sending CQ 

When using a TNC turn off Config >Function Keys >Stop Sending CQ when Callsign changed. If not 
every time you stop an auto-CQ and you type a callsign in the box it will send the abort string to the 
TNC. 

3. Tips for Making QSOs 

Callsigns and exchanges are displayed in the Digital Interface (DI) window. This information can be 

transferred to the Entry window's Callsign field and exchange fields with the mouse, or it can be typed 
in manually the same as you would do in CW and SSB. Call signs recognized in the input stream are 
also placed in the Grab window, and can be transferred from there to the Entry window using the Grab 
button, the {GRAB} macro or Alt+G on the keyboard.  

3.1. Using Hover Mode 

 Hover Mode places the callsign in the callsign field in the Entry Window when you hold the 
mouse over a valid callsign. If you use this in combination with the 'Right click = Return NOT 

menu' option, you hover over the call then right click to plant the call and send your call; 
when the station comes back to you you click on the exchange to place it in the Entry Window. 
Right clicking again sends TU and logs the Q. Right click, left click,right click and you're done...  

o Note: Your own call is excluded from being picked up.  

o Hover mode is used in conjunction with the menu selection 'Rt Click = Return NOT 
menu' which will will send a Return when right clicking in the DI RX window instead of 
displaying a pop up menu  

3.2. The Rate Improver - Right Click = Return NOT Menu 

Select from the settings menu in the Digital window "Right Click = Return NOT menu". This setting 
could improve your rate greatly as your hand never leaves the mouse except for the occasional 
difficult exchange. Making a qso:  



 While in Run mode with ESM on  

o Right click in the DI's RX window to sends CQ  
o When a station replies left click on the call  
o Right click sends your exchange  
o As he sends his exchange left click on it  
o Right click again to send TU and log the call  
o Right click again starts CQ (and you're back at the first bullet)  

 In S&P it does the same thing as hitting Enter to advance thru the ESM mode  

 
Right click takes the place of hitting Enter for ESM. Most of the time while in the contest I have one 
hand on the mouse and the other hand I have one finger resting on the space between the Esc and F1 
keys. With that finger I can hit Esc if I have started a CQ and someone has started coming back to 
me. 73 Rick N2AMG  

4. Do You Have... (what to check when it does not work) 

Below are the most common mistakes made setting up or using N1MM logger in RTTY mode.  

 Add {TX} and {RX} to each of the F Keys  

 Set up Mode Control in the Configurer  

 Select the DI type in the Configurer under the Tab: Digital Modes  

 When MMTTY selected: Set up the path to MMTTY in the Configurer under the Tab: Digital 
Modes  

 Set up the Dig Wnd Nr in the Configurer under Hardware for Digital ports  

4.1. Insert Key Assignments 

Mode 
Enter Sends Message 
(ESM mode) 

Ins key or ; does the following:  

RUN and 

S&P 
OFF 

1. Grab Callsign from call list if callsign field empty otherwise 

use call in callsign field  

  
2. Prefills Exchange Boxes  

  
3. NO DUPE: Sends F5 (Hiscall) + F2 (Exchange) or DUPE: 
Sends Nothing  

  
4. Places cursor in next exchange field (Example: Sect)  

RUN ON 
1. Grab Callsign from call list if callsign field empty otherwise 
use call in callsign field  

  
2. Prefills Exchange Boxes  

  
3. NO DUPE: Sends F5 (Hiscall) + F2 (Exchange) or  

  
3. DUPE  

  
— WorkDupes checked: Sends F5 (Hiscall) + F2 (Exchange)  

  
— WorkDupes not checked:Sends F6(Dupe)  

  
4. Places cursor in next exchange field (Example: Sect)  

  
5. Highlights F8 button  

S&P ON 
1. Grab Callsign from call list if callsign field empty otherwise 
use call in callsign field.  

  
2. Prefills Exchange Boxes  

  
3. NO DUPE: Sends F4 (Mycall) or  

  
3. DUPE  

  
— WorkDupes checked: Sends F5 (Hiscall) + F2 (Exchange)  



  
— WorkDupes not checked:Sends F6(Dupe)  

  
4. Once exchange entered INSERT sends F5-F2  

  
** Pressing INSERT again will continue to send F5-F2  

  
5. Places cursor in next exchange field (Example: Sect) 

 

4.2. Configuring the Entry Window Function Keys 

 The Entry window function keys support 'Running' mode and 'Search & Pounce' mode.  

 The function keys use the same macros for PSK and RTTY.  

 The function keys can be changed under: 'Config | Change Packet/CW/SSB/Digital Message 

Buttons | Change Digital Buttons'.  

 Below example button definitions:  

 

 

Some tips for function key and button macro messages:  

 Text to be transmitted must be preceded and followed by {TX} and {RX} macros  

 Always begin and end the actual text of your messages with a space character to separate the 
content of your message from garbage characters generated by noise. If your call sign is the 

last thing in a message and there is no following space, the person at the other end will not be 

able to tell where your call sign ends and the garbage begins  

 With the sole exception of consecutive all-numeric elements, where a hyphen ("-") can 
optionally be used instead of a space, always separate call signs and exchange elements from 

each other with single spaces  

 To set your messages off from previous text, you can start with a single {ENTER} instead of a 
space. Do not waste time by sending more than one {ENTER}. Never end a message with 
{ENTER}; that causes your information to scroll upwards on the received screen just as the 

other operator is trying to click on it  

 Don't put in long sequences of spaces, periods or other punctuation; that just wastes time 
without making it any easier to copy  



 Do not place any kind of punctuation immediately before or after a call sign; always set call 

signs apart from the rest of the text with single spaces  

 Ending messages with K, KN or BK is unnecessary in RTTY; the receiving station knows that 
you are finished when your carrier drops  

 In contests where the US state is part of the exchange, do not use DE before your call sign; 

that can be confused with the exchange for Delaware. Also, do not use IN as a preposition to 
indicate that what follows is your QTH; that may be interpreted as Indiana  

 Do not repeat unnecessarily. If signals are strong, you only need to send your exchange once; 

if conditions are poor, sending your exchange twice or even three times can pay off by 
reducing the number of requests for repeats, but when conditions are very good, this is 
unnecessary. Adjust your exchanges to suit conditions (the extra buttons in the DI window are 
useful for this)  

 If a signal report is part of the required contest exchange, send it once and once only. 

Everyone knows what it is going to be, so there is no need to repeat it. Always send the report 
as 599 (all-numeric), never 5NN (5NN takes more time in RTTY than 599; 5NN is for CW only)  

 If you are CQing and more than one station is responding to you, it may help to put the other 

station's call sign at the end of the exchange as well as at the beginning, to take care of 
situations where other stations who are still calling cover up the call sign at the beginning  

 In general, though, don't send the other station's call sign more often than is necessary to 
ensure he knows you are talking to him and he has copied the call sign correctly  

 Don't send your own call sign more often than necessary to ensure that the other station 
knows your call sign. There is no need to send both call signs in every message; once the call 
signs have been exchanged correctly, subsequent repeats don't add anything  

 Don't send the other station's exchange back to him. If you are not sure you got it right the 

first time, ask for a repeat, but once you feel you have copied it correctly, move on. Sending 
his exchange back puts doubt in the other station's mind unnecessarily, and in poor conditions 
he can confuse it with your own sent exchange  

 When responding to a CQ call, never send your exchange until after the CQing station has sent 

you his exchange and you have copied it correctly. Do not include any part of your exchange 
in your F4 message  

4.3. Message Buttons 

 There are 8, 16 or 24 extra message buttons possible on the digital interface (DI window)  

 A right click on one of the message buttons brings up the Digital Setup dialog where the 

messages can be configured  

 These extra message buttons support regular macros but don't support 'Running' mode and 

'Search & Pounce' mode  

 If using a TNC, include in your messages the control commands needed to turn on the TNC 
and switch to RX...  

 Macro key substitution is supported by the buttons in the RTTY window as well as the function 
keys on the Entry window  

The macros which can be used and some examples can be found in the macros reference section  

There are several additional buttons for an External TNC. Please check the Digital - External TNC 

support chapter. Also please check the rules for messages and macros when using MMTTY and 
MMVARI.  

5. Name Lookup 

The program has the possibility to lookup the name from a station entered in the Callsign field. For 
this to happen the following has to be done.  

 Import a callsign versus name text file  

http://n1mm.hamdocs.com/tiki-index.php?page=Macros#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+External+TNC+support#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+External+TNC+support#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+MMTTY+for+RTTY+support#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+-+MMVARI+for+PSK+and+other+modes#N1MM_Logger_Manual


o The famous 'Friend.ini' file used in the WF1B program can be directly imported  

o Also a text file using the format for Call History import can be used  
 Callsign <comma> Name. For example: N1MM,Tom  

 Select >Config >Call History Lookup  

 Use the {NAME} macro to have the name sent  

o Note: The name is looked up in the Call History table with the cursor in the callsign 
field and pressing the Spacebar!  

 
Example how to import the Friend.ini file from the WF1B program.  

 Select >File >Import >Import Call History  

 Select your 'Friend.ini' file by changing 'Files of type:' to 'All Files (*.*)'. Otherwise only text 
files will be shown!  

 Select the 'Open' button. The callsigns with names from the text file will be imported  

 NB. Importing info in this table will delete all previous content. There is no merge option! So if 

there is information in it and you only want to add info, first export this info (Select >File > 
Export >Export Call History) and merge the data outside the program with a Text editor like 
Notepad. After this import the new merged file 'Friend.ini' file  

 The program will show in the bottom pane of the Entry Window status information during 
importing and afterwards the number of imported callsigns  

6. Output RX Data to a Text File 

Sending your RX data to a text file can be done in N1MM logger or in MMTTY. These files are a safety 
feature, as you can go back through them for any info you missed or lost during a crash.  

 N1MM Logger: Right click in the RX window and select >Output to Text File (this choice is not 
available if you have selected the 'Right Click = Return NOT menu' option; to turn the RX text 
file option on or off, you will have to temporarily disable the Right Click = Return option)  

 MMTTY: Doing this in MMTTY is a bit tricky. Go to the directory where MMTTY has been 

installed and load MMTTY in standalone mode. Click on File/Log RX and close the program. 
From now on every time you start MMTTY either via the logger or in standalone mode an 
output text file will be created and all your info will be stored in this text file. In the directory 
where MMTTY is located files will be created that have names like 031103.txt. MMTTY creates 
a new file for each day.  

7. Single Operator 2 Radios (SO2R) 

N1MM Logger also supports SO2R for RTTY. You can use any combination of either 2 MMTTY windows, 

2 TNC windows or a combination of MMTTY and a TNC for SO2R operation. Info about MMTTY 
soundcard setup and SO2R can be found in the N1MM logger Help file in the SO2R chapter.  

8. Additional Receive-Only Windows for RTTY 

N1MM Logger supports up to four additional receive-only windows for RTTY. The purpose of these 
windows is to allow simultaneous use of more than one decoding algorithm on the same audio input. 
While it is possible, by using wide bandwidth filters, to use the additional windows to decode different 
signals from the one in the main DI windows, the normal use of the additional windows is to decode 
the same signal as the one in the main window, using a different decoding method to improve the 
overall ability to decode signals in difficult situations.  

In SO2R or SO2V, these receive-only windows can be distributed in any way between the two DI 
windows. These receive-only windows may use additional copies of MMTTY or 2Tone, configured with 

http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29&structure=N1MM+Logger+Documentation


different "profiles" (e.g. multipath, fluttered, different detection algorithms), or they can be used with 

additional TNCs or TUs. You can use any of the possible digital interface engines in the main DI 
window (MMTTY, 2Tone, MMVARI, Fldigi or a TNC/TU), but regardless of which engine is used in the 
main window, the additional receive-only windows can only use MMTTY, 2Tone or a hardware decoder.  

The receive-only windows are invoked from the DI window's Setup > Open Add. Rx Window (4 Avail.) 
menu item - the number in the menu item indicates how many of these windows are unused and still 
available. The first time one of these windows is opened, its Setup window will be displayed.  

 

The setup information that must be entered includes the engine type (MMTTY, TNC or Dxp38 - the 
MMTTY setting is also used for 2Tone), the path to the copy of MMTTY or 2Tone for that window (if 
used), and/or the COM port information for a TNC (if used). If the engine type is MMTTY, a separate 
spectrum display window is opened for the software digital engine (MMTTY or 2Tone). If the digital 

engine used in the main DI window is also a sound card software engine, the spectrum display for the 
additional window may be redundant, in which case you can minimize it to the task bar - do not close 
it, just minimize it.  

After the setup information has been entered, the window should be closed and re-opened, and then it 
will be available for use.  

Starting in version 13.06.01, it is possible to embed or attach a small (one or two lines) copy of the 
additional RX windows directly into the top of the main Digital Interface DI window. There are menu 
items used to select the layout (one line or two; full width vs. 2 columns). Each such attached window 
is denoted with its number (1, 2, 3 or 4), which is normally on a green background. If the number is 
clicked on with the mouse, the background color changes to yellow and the text in that window is 



frozen temporarily, similarly to the green/yellow bar on the left of the main receive window and the 
regular additional RX windows.  

The regular additional RX window(s) is/are minimized to the task bar when the attached windows are 
enabled, but they may be restored from the task bar icon in order to be able to view more lines of 
text, to change setup parameters, or to close the additional RX window. The task bar icons for the 
additional RX windows are grouped together with the icon or icons for other N1MM Logger windows. 

Note that if any of the additional RX windows uses sound card software for decoding, there will also be 
separate icons on the task bar for the digital engine(s); do not confuse the icon for the additional RX 
text window with the icon for the digital engine (MMTTY or 2Tone) used by the additional RX window.  
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1. Setup Overview 

Setting up an interface involves configuring the Logger for the selected interface. Configuring has to 
be done within N1MM logger in a few places, including the Configurer as well as the Digital Interface 
window. If you are using MMTTY for FSK RTTY, you will also have to perform some configuration from 
within MMTTY. If you use Fldigi, there is some configuration that must be done from within Fldigi.  

You do not need to download or install any additional files or programs to use MMVARI or a TU/TNC. 
However, before you can use MMTTY, you will have to download and install it. The same applies to 
2Tone and Fldigi. This process is described in the next two sub-sections.  

A brief note about hardware connections. If you are using a TNC or TU, the hardware connections will 
be explained in the documentation for the TNC. If you are doing sound card digital modes (including 

RTTY) using MMTTY, 2Tone, MMVARI or Fldigi, your hardware connections will depend on the radio, 
the sound card and the interface (if any) in use. It is impossible to cover all of the permutations and 
combinations in detail, but the following general comments apply.  

First, you must have some means of connecting the radio's audio output to the sound card's input. 
The ideal connection would be from a fixed-level ("line out") output on the radio to a "line in" input on 
the sound card. If your radio has one receiver, this will probably use the left channel of the sound 



card; with dual receivers, the second receiver may use the right channel (of course, this requires a 

stereo sound card; some external sound cards, such as the SignaLink, are mono and will not support 
dual-channel receive). If your sound card does not have a line level input, you may need to use a 
microphone input, and in this case you may need an attenuator to reduce the line level output from 
the radio to the lower level needed for the microphone level input on the sound card.  

To transmit, there must be some means to convey modulation from the computer to the radio. For 

FSK RTTY, this is an on-off keying signal, which is normally generated by a serial port connected to 
the radio's FSK keying input through a simple keying circuit. This serial port cannot be the same port 
that is used for radio control or for a Winkeyer or other serial device. If it is a USB-to-serial adapter, 
you will probably need to use MMTTY's EXTFSK plugin. If you are using MMVARI for RTTY using FSK 
keying, select the appropriate plugin (FSK8250 for true serial ports, EXTFSK for USB-to-serial 
adapters) in the Configurer under the Digital Modes tab.  

For AFSK RTTY and for all other sound card digital modes (e.g. PSK31), there must be a connection 
from the sound card's output ("line out", or speaker or headphone output) to the radio's audio input. 

If the only audio input on the radio is a microphone input, you may need attenuation to reduce the 
level to avoid overdriving the transmitter.  

You also need some means to control TX/RX switching (PTT). The most common method is to use 

hardware PTT control from a serial or parallel port via a simple keying circuit. Hardware PTT can be 
controlled either from the digital "engine" (MMTTY, MMVARI or Fldigi, but not 2Tone), or from N1MM 
Logger itself. To use serial port PTT from the digital engine, you must use a different port from the 
one that is used by the Logger for radio control. If you have a serial port set up for FSK keying, you 
can use a control line (RTS or DTR) on this same port for PTT control from the digital engine. If PTT is 
controlled from a digital engine rather than from the Logger, you should check the Digital box for that 
serial port in the Configurer and make sure to indicate the appropriate Dig Wnd Nr (1 for DI1, 2 for 
DI2).  

If you do not have a separate serial or parallel port available for PTT in digital modes, you can control 

PTT directly from the Logger. For example, if your radio control interface supports PTT using RTS or 
DTR on the radio control serial port, you can configure the Logger to use this method. If no method of 

hardware PTT control is available and if your radio supports PTT via radio command, you can use 
software PTT control from the Logger. Warning: Using both software and hardware PTT control at the 
same time can cause problems; do not use both methods in parallel.  

As an alternative to hardware and software PTT control, you may be able to use VOX. This does not 
work with all radios, it cannot be used for FSK RTTY, and setting of audio levels and VOX triggering 
levels can be tricky, but some users have found this to be the simplest method of PTT control, since it 
does not require any additional hardware connections. Some external interfaces (e.g. SignaLink) 

perform a VOX function external to the radio, i.e. they generate a hardware PTT signal based on the 
presence of an audio signal without any connection to a serial port on the computer. If you are using 
such an interface, or VOX within the radio, you do not configure any PTT in the Logger or in the digital 
engine, as PTT control in these cases is external to the software.  

Setting Sound Card Levels 

If you are using a computer sound card, you will need to pay some attention to level settings.  

On receive, to make best use of the sound card's available dynamic range you would adjust the sound 
card's record level control (and/or any other level controls or attenuators there might be in the receive 
audio path) so as to just barely avoid overdriving or saturation on the loudest signals. In MMTTY, an 
input signal that is too strong will cause the word "Overflow" to be displayed in the MMTTY spectrum 
window. The record sound level should be adjusted to be just below the point where this word is 
displayed on the strongest signals.  



On transmit (AFSK RTTY and other digital modes), it is important to avoid setting levels high enough 

to cause either appreciable audio harmonics or intermodulation distortion (IMD). The goal is to come 

up with a combination of settings in the sound card playback mixer and the radio's mic gain or line in 
gain setting that results in audio signals just below the point where fast-acting ALC is triggered. On 
many radios, this is the point where the ALC meter just starts to move (special case: this is not true of 
the Elecraft K3 and KX3, where the proper audio settings are those that result in 4-5 bars displaying 
on the radio's ALC meter). With many sound cards, you should try to avoid setting the playback gain 
in the sound card all the way to the maximum; the sound card's output may not be very linear at the 
maximum setting. A setting somewhere in the middle part of the range is ideal, provided it produces 

enough signal for the radio. Gain distribution is also important. A very low level out of the sound card 
followed by large amounts of amplification in the radio's audio circuits will risk adding hum and noise 
to your transmitted signal.  

Sound card level adjustment should always be done using an audio frequency in the middle of the 
radio's filter bandpass. This is where both received and transmitted signals will be strongest. If level 
adjustment is performed using an audio frequency near the edge of the bandpass, the resulting level 

settings will be too high. During operation, if a desired signal is found near the edge of the bandpass, 
the Logger's Align button can be used to retune the radio so the desired signal is placed at the optimal 
point in the bandpass.  

If you are using the Windows default sound card for generating transmitted signals in digital modes, 
make sure to disable all Windows sounds. Most amateurs who spend significant time in digital modes 

prefer to use a separate sound card. It does not need to be a high-end audiophile sound card; digital 
modes like RTTY do not require anything extraordinary in the way of a sound card. The parameter of 
most interest is the noise floor; the noise level in a second sound card may be lower than that in the 
sound card on the computer's motherboard, and this may help improve reception of digital signals. 

1.1. Downloading and Installing MMTTY 

MMTTY is not installed as part of the installation of N1MM Logger. It must be downloaded and installed 
separately. It is possible to use N1MM Logger in RTTY without using MMTTY (e.g. by only using an 

external TNC, or AFSK RTTY from MMVARI). If you intend never to use MMTTY, you can skip the rest 
of this section. However, most RTTY users will probably want to have the ability to use MMTTY, at 

least as an option. In particular, if you would like to make use of the additional RX windows for 
"diversity decode", you will most likely need to install MMTTY (unless you have several TUs/TNCs you 
can use for the purpose).  

If you do not have a copy of MMTTY, then before continuing with the digital setup it is recommended 

that you download a copy of the MMTTY installer from the MM HamSoft website . You can find a 
copy of the full installer for the current version of MMTTY at that website. This file is a self-extracting 
executable, similar to the N1MM Logger installer. Download the file to a temporary folder and then 
execute it. It is recommended that you install MMTTY in its own program folder and not in the N1MM 
Logger program folder. By default, the installer will install MMTTY to C:\Program Files\MMTTY\ .  

Note for users of Windows Vista and Windows 7 and 8: User Account Control (UAC) in these versions 

of Windows prevents user programs from writing configuration information into the Program Files 

path. Even if programs are run with Administrator privileges, UAC may interfere with the ability to use 
separate configuration files for separate copies of the same program. Therefore, it is suggested that 
the folder for MMTTY, as well as any folders for extra copies used in the second DI window and the 
four additional RX windows, should not be in the Program Files path. It is suggested that you create a 
new folder outside the Program Files path, such as C:\Ham Radio\MMTTY, and then place any 
individual sub-folders for separate copies of MMTTY within that folder.  

If you already have a copy of MMTTY installed on your computer, you can use that copy from N1MM 
Logger. However, if you also use MMTTY stand-alone, it is possible that you may want (or need) to 

have a different setup for stand-alone use than with N1MM Logger (e.g. if you use the radio control 

http://hamsoft.ca/pages/mmtty.php


port from within MMTTY stand-alone; this is not possible when MMTTY is used with the Logger). If you 

need a different setup with the Logger than the one you use stand-alone, then you should create a 
separate folder for each copy (for example, you can create a sub-folder inside either the N1MM Logger 
program folder or the MMTTY program folder for the second copy of MMTTY). You need to copy only 

the MMTTY.exe and UserProfile.ini files from the main MMTTY folder into the additional folder (plus the 
extfsk.dll file if you are using EXTFSK for FSK keying). MMTTY will create a separate copy of MMTTY.ini 
when it is run.  

If you plan to use two copies of MMTTY in SO2V or SO2R mode, one for each received audio stream, 
you will need to create two copies in separate folders with different configurations. In SO2V, one of 
these copies can be configured to use the left channel and the other copy to use the right channel of a 
single stereo sound card. In SO2R, you can either use a stereo sound card as in SO2V, or you can use 
two separate sound cards, one for each radio.  

If you want to use MMTTY for diversity decoding in additional RX windows, you will need to create 
another separate sub-folder for each additional RX window. For example, you can create sub-folders 

called DI1, DI2, DI1RX1, DI1RX2, DI2RX1 and DI2RX2 so that you can run up to six copies of MMTTY 

simultaneously; one for each main DI window, plus up to 4 additional RX windows (e.g. two additional 
windows for each DI window). Into each of these windows, you need only copy the MMTTY.exe and 
UserPara.ini files from the main MMTTY program folder created when you first installed it. Each copy 
will then be configured to use the appropriate sound card and channel. The "Additional RX" copies use 
the same sound card and channel as the parent copy in the main DI window, but they can be 
configured to use different decoding algorithms or profiles to give you "diversity decoding", i.e. two or 
three different decoding methods used on the same receive audio.  

Once MMTTY has been downloaded and installed, you can proceed to use the Configurer to set up 
N1MM Logger to use it.  

1.2. Downloading and Installing 2Tone 

2Tone is not installed as part of the installation of N1MM Logger. It must be downloaded and installed 

separately. You cannot run 2Tone stand-alone. Most people who use 2Tone have already downloaded 

and configured MMTTY, and simply use 2Tone as a drop-in replacement for the MMTTY engine. If you 
are using 2Tone in the main DI1 or DI2 window, change the MMTTY path in the Configurer under the 
Digital Modes tab to point to 2Tone.exe . If you are using 2Tone in an additional RX window, configure 
that window for MMTTY but change the path in the setup to point to that window's copy of 2Tone.exe . 
Note that if you are using 2Tone in more than one DI or RX window, every window you use it in must 
point to a different copy of 2Tone.exe, i.e. in a different folder.  

You can find the latest version of 2Tone in the G3YYD folder in the Files area of the N1MMLogger-
Digital user group at Yahoo. Download the zip file containing the latest version and unzip its contents 
into the folder(s) or sub-folder(s) you wish to run it from (a separate folder for each window you wish 

to use it in). The first time you install 2Tone in a folder, copy the entire contents of the zip file into the 
folder; when installing updates, you do not need to extract the ini files from the zip file if you wish to 
keep using the configuration information from the previous version.  

AA5AU has posted a tutorial on setting up N1MM Logger with 2Tone here ; #4 in the list gives step-
by-step instructions for downloading, installing and setting up 2Tone.  

1.3. Downloading and Installing Fldigi 

FLdigi is not installed as part of the installation of N1MM Logger. It must be downloaded and installed 
separately. It is possible to use N1MM Logger in RTTY and PSK contests without using Fldigi. Fldigi 
supports a wide range of other digital modes, but most of these are rarely used for contesting. If you 
intend never to use Fldigi, you can skip the rest of this section.  

http://rttycontesting.com/n1mm/n1mm-quickstart-index.html


If you do not have a copy of Fldigi, then before continuing with the digital setup it is recommended 

that you download a copy of the Fldigi installer from the W1HKJ website at 

http://www.w1hkj.com/  . You can find a copy of the full installer for the current version of 

Fldigi at that website. This file is a self-extracting executable, similar to the N1MM Logger installer. 
Download the file to a temporary folder and then execute it. It is recommended that you install Fldigi 
in its own program folder and not in the N1MM Logger program folder. By default, the installer will 
install Fldigi to C:\Program Files\Fldigi-x.xx.xx\, where x.xx.xx is the Fldigi version number.  

Note that Fldigi cannot be configured to use a single channel of a stereo sound card; Fldigi always 
uses its sound card in mono mode on receive. If you want to use Fldigi in a two-receiver configuration, 
either SO2V or SO2R, you will have to use two separate sound cards. You will also need to install two 
separate copies of Fldigi in separate folders, one for each DI window, in order to be able to configure 
each one for a separate sound card. It is suggested that you do a full install for each copy, but do not 

create Start menu or Desktop shortcuts for the second copy. As with MMTTY, users of Windows Vista 
and Windows 7 may find it necessary to install one or both of these copies outside the Program Files 
path.  

You do not need to install separate copies of Fldigi for additional RX windows, because this feature is 
not implemented for Fldigi or MMVARI engines, only for MMTTY, 2Tone and hardware TUs/TNCs.  

1.4. Setting Up the Configurer 

There are three tabs in the Configurer that need to be set up when configuring N1MM Logger for 
digital modes. The first is the Hardware tab, where serial ports used for digital modes are set up. If 
you are using VOX or an interface that performs the VOX function externally (e.g. SignaLink), you do 
not need to configure a port for digital modes under this tab.  

http://www.w1hkj.com/


 

 The Digital box in the main Configurer window indicates to the Logger that this port is used 
for digital mode control.  

o Use this to indicate a port that is used for an external TNC  
o Use this to indicate a port that is used for FSK keying with MMTTY, but not if EXTFSK 

is being used  
 A port that is used for FSK must also be configured inside the MMTTY setup, 

regardless of whether the Digital box is checked or not; this includes ports 
used with EXTFSK  

 It is possible to use a port in the range COM9-COM16 for FSK with MMTTY. In 
this case, there is no Digital box to be checked; the port must be configured 

entirely within MMTTY  
 It is possible to use an otherwise unused port in the range COM1-COM8 with 

EXTFSK; such ports must be configured within MMTTY and EXTFSK, but not in 
the Configurer  

o Use the Digital box to indicate a port that is used by the digital engine for PTT in 

AFSK RTTY or other digital modes with MMTTY, MMVARI or Fldigi  
 Exception: If PTT is done by EXTFSK or if PTT is done by the main N1MM 

Logger program, e.g. from a radio control port or from a Winkeyer, do not 
check the Digital box for that port  

 If you are using 2Tone as your transmitting interface for RTTY, PTT must be 
done by the main N1MM Logger program, so do not check the Digital check 
box for that port  

o It is possible to share a port (sequentially, not simultaneously) for both serial port CW 
keying (e.g. on DTR) and for PTT and FSK using MMTTY for RTTY (e.g. on RTS and TxD 

of the same port). In this case, check both Digital and CW/Other for that port. When 



the DI window is closed, the settings in the DTR and RTS boxes will determine how the 

port is used; whenever the DI window is open, it will be the settings in the digital 
engine (e.g. MMTTY) that determine how the port is used. However, if you want to 
leave the DI window open with the program and radio in CW mode (e.g. to use the 

Fldigi CW decoder), you cannot share the CW port with the digital engine; do not 
check the Digital check box on a port that will be used for CW with the DI window 
open  

 

 

If you have checked the Digital check box, click on the Set button for the same port and select the 
radio number and DI window number to be associated with the port.  

 The Radio Nr box indicates which radio this digital interface is for in SO2R mode; in SO2V and 

SO1V, Radio Nr is always = 1  

 The Dig Wnd Nr indicates whether this port is used for DI1 or DI2. This applies to SO2V and 

SO2R; in SO1V, Dig Wnd Nr is always = 1  
o You must choose a Dig Wnd Nr for each port that has the Digital box checked; 

otherwise the program will not assign the port to a DI window!  

 
The next tab to be set up is the Digital Modes tab.  



 

 MMTTY (if used; use this selection for 2Tone as well)  
o Digital Interface 1/2 (left part of window)  

 TU Type: Soundcard  
o DI-1/2 MMTTY Setup (upper right part of window)  

 MMTTY Mode: Select AFSK or FSK  
 MMTTY Path: Select path to MMTTY.EXE (or 2Tone.exe), including the name 

of the executable file (i.e. not just the path to the folder)  
 The path does not need to be in the N1MM Logger program directory  
 The paths for the two DI windows do not need to be the same  

SO2V/SO2R in MMTTY 

You can use MMTTY with both receivers in a two-receiver setup with a single stereo sound card. You 
will need to install two copies of MMTTY in two separate program folders in order to allow one copy to 

be configured to use the left channel of the sound card and the other copy to be configured to use the 

right channel of the sound card. 

SO2V/SO2R Shut Down Issue 

When two copies of MMTTY are used in DI1 and DI2 with a different COM port for each copy, you 

should close the two DI windows separately before shutting down N1MM Logger. If both DI windows 
are open at the time N1MM Logger is shut down, the COM port assignments in the two copies can get 
confused due to a glitch in MMTTY, which means the port assignments may be wrong the next time 
the Logger is started up. 

 MMVARI (if used)  



o Digital Interface 1/2 (left part of window)  

 TU Type: Soundcard  
o DI-1/2 MMVARI Setup (bottom part of window)  

 MMVARI RTTY Mode: Select AFSK or FSK  

 FSKPort: (FSK only)  
 Choose FSK8250 if you are using a true serial port or a device that 

can simulate a serial port and handle 5-bit codes at low speeds (this 
does not include most USB-to-serial adapters, but it does include 
some commercial interfaces designed to support FSK RTTY as well as 
some multi-port USB-to-serial adapters)  

 When MMVARI is opened for FSK RTTY, a small window 

labelled MMVARIFSK1 1.04 will open, or appear on the 
Windows Task bar. In this window you select the COM port 
number and the signal line to be used for PTT (RTS or DTR). 
FSK keying will be done on the TxD line. If this is a USB device 
that simulates a serial port, check Limiting speed. You can 
use the _ box at the top right to minimize this window after 

completing the setup  
 FSK8250 supports all of the RTTY speeds supported by 

MMVARI and the selected COM port or device  
 Choose EXTFSK if you are using a regular USB-to-serial adapter  

 When MMVARI is opened for FSK RTTY, a small window 
labelled EXTFSK 1.06 will open, or appear on the Windows 
Task bar. In this window you select the COM port number and 

the signal lines to be used for FSK keying (normally TxD) and 
PTT (RTS or DTR). You can use the _ box at the top right to 
minimize this window after completing the setup  

 The only RTTY speed supported by EXTFSK is 45.45 baud  

SO2V/SO2R in MMVARI 

You can use MMVARI with both receivers in a two-receiver setup with a single stereo sound card. In 
the DI Window's Digital Setup dialog box under the MMVARI Setup tab, simply configure the DI1 

SoundCard to use the left channel and the DI2 SoundCard to use the right channel. 

 Fldigi (if used)  
o Digital Interface 1/2 (left part of window)  

 TU Type: Soundcard  
o DI-1/2 Fldigi Setup (lower right part of window)  

 Fldigi Path: Select path to fldigi.exe (complete path, including the name of 

the executable file)  
 The paths for the two DI windows do not need to be the same  

SO2V/SO2R Limitation in Fldigi 

There is a basic limitation in the Fldigi engine which can make it harder to use in dual-receiver 
situations (SO2R and SO2V). Fldigi always receives in mono mode. If you are using a stereo sound 
card to decode two receivers, with one receiver in the left channel and the other receiver in the right 
channel, Fldigi will combine the two receivers in its waterfall. It doesn't matter whether Fldigi is the 

interface engine in DI1 or DI2, it will see the audio from both receivers.  

Therefore, if you want to use Fldigi with both receivers in a two-receiver setup, you will need to use 
two separate sound cards for the two receivers. You will also need to install two copies of Fldigi in two 
separate program folders in order to allow a different sound card to be configured in each copy. 

 External TNC (if used)  
o Digital Interface 1/2 (left part of window)  

 TU Type: Other  



 Set other parameters appropriately for the TNC in use (Example settings: 
9600, 8, N, 1, Xon-Xoff)  

 
The third tab to be set up is the Mode Control tab, which determines what mode the radio will be set 
to use in RTTY and PSK.  

 

The available choices in the list boxes under Mode sent to radio will depend on the particular radio 
type (see Supported radios). For FSK RTTY, the correct choice will normally be RTTY. For AFSK RTTY, 
depending on the radio the appropriate choice might be AFSK or LSB/USB. For PSK and other sound 
card modes, the radio mode would be PSK (if available), AFSK-R (on some radios) or USB on most 
radios. For more information, see the Configurer page under the Config >Mode Control tab.  

2. The Digital Interface - Window 

The Digital Interface window is nearly the same regardless of which type of interface (MMTTY, 
MMVARI, FLDIGI or TNC) is being used. Its appearance (foreground and background font colors) can 
be customized using the Settings > Setup menu item.  

http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Radios#Digital_Mode_Mapping
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The Digital Interface is opened from the Entry window's Window > Digital Interface menu item. If you 
are using two entry windows (SO2V/SO2R), each entry window has a separate DI window associated 
with it - DI1 with the VFO A/Radio 1 Entry window, and DI2 with the VFO B/Radio 2 Entry window. 
Each DI window is opened from its corresponding Entry window's menu bar. If the digital "engine" 
chosen in a Digital Interface window is sound card software (MMTTY, MMVARI, Fldigi or 2Tone), a 
separate window including a tuning display and various other digital engine-specific information will 

also be opened when the Digital Interface window is opened - see the section of the manual relevant 
to the specific digital engine that has been selected.  

The Digital Interface caption displays either the offset frequency (radio's dial frequency +/- audio 
frequency) or the radio's dial frequency, depending on what you have chosen in the Digital Setup.  

 TX - Indicator to show which window has transmit focus (useful when using two sessions like 

SO2R)  

 Letters/Figs - Shows the text under the mouse in reverse case (letters/figures switched)  

 MouseOver - Shows the text under the mouse; this is the text that would be selected by a 
mouse click  

 Top RX window - This is the receive window. This is the window used for making QSOs. 

There are 2 ways of placing a callsign into the callsign window of the Logger. You can single 
click on a callsign and it will transfer over to the main logging window, or, whenever a callsign 
is detected in the RX window it will be sent to the callsign grab window for easy movement to 
the logging window by clicking the Grab button. By clicking on the colored bar on the left you 

can pause input to the receive window to scroll back through the (last 2000 lines of) text using 
the scroll bars. When the window is paused the color of the bar will turn Yellow. To turn input 
to the window back on click in the bar again and everything that was to be printed to the 

window will now enter the window. When the receive window is paused it is possible to select 
and copy text in the window.  

 Bottom TX window - This is the transmit window, a free form typing window. If you click on 

the TX button the cursor will be placed into this window and what ever is typed will be sent. 
The size is static and doesn't change size (2 lines). For TNC users: when not transmitting, 
anything typed in the TX Window will be sent to the TNC. Used to change settings etc.  

 Callsign Textbox and Grab - When a callsign is encountered in one of the receive windows it 

will be placed in this textbox and when you press the Grab button it will transfer the callsign 
over to the main Entry window. The grab callsign window holds the last 10 callsigns seen in 
the RX window. The most current one is at the top and is highlighted. Dupe callsigns will not 



be shown in the grab window. The Sort Order in the grab window can be selected by right-
clicking; you can choose either Last In First Out or First In First Out as the sort order  

Callsign not added to grab List 

If the callsign in the callsign field in the Entry window is the same as the callsign in the received text, 
the call in the Entry window does not get placed into the grab call list. Clicking on a callsign in the RX 

window to move it into the Entry window will remove that callsign from the Grab list. 

 Message buttons - These buttons on the Digital Interface are (max.) 24 extra message 
buttons for preprogrammed messages. Configuring these message buttons is done in the 
Digital Interface window under 'Setup | Settings' or by right clicking on them which brings up 
the Digital setup dialog. The width of these message buttons dynamically adjusts in relation to 

the width of the interface window  

 Clr RX - Clear the receive window (also possible using the right click menu)  

 Align (MMTTY and Fldigi only) - This is used to move the signal that you are copying into the 

pass band of your filters. Set the frequency in the setup area. For example, if your filters are 
centred on 2210 Hz, RTTY signals close to the 2125/2295 Hz pair will be copied well, but 
signals at higher or lower frequencies may not make it through the filters. If you click on such 
a signal to decode it, it may not decode very well. After clicking on the signal, if you click on 
the Align button your transceiver will be retuned to line the signal up on the configured 

frequency. This is essential in FSK where the transmit frequencies are fixed in the radio, and 
useful also in AFSK if you want to use narrow filters  

o Note that when you are using the MMVARI interface engine, the Align button appears 
on the MMVARI window instead of on the Digital Interface window  

 TX - Start the RTTY transmission, the transceiver is keyed. Will be colored Red when 

transmitting  

 RX - Stop the RTTY transmission - the transceiver changes back to receive. Will be colored 
Green when in receive  

 AFC (MMTTY only) - Can be used to turn MMTTY's AFC on or off (colored background means 

AFC is on)  

 HAM (MMTTY only) - Restore the MMTTY frequency and shift settings to the HAM default  

 Lock (Fldigi only) - Locks the transmit frequency at the current location. If you move the 
receive frequency, e.g. by clicking elsewhere in the waterfall, the transmit frequency does not 
change. Used for operating split  

 Rev (Fldigi only) - In sideband-sensitive modes like RTTY, reverses the tones (e.g. opposite 
sideband)  

 Grab - Transfer the selected callsign in the Callsign textbox to the callsign field on the main 

logger window. Once the callsign is filled, whatever you click on next will fill the next box to 
have info entered in. When the Digital Interface is in transmit, calls are not added to the Grab 
window  

 CLR - Clear the Grab list  

2.1. Receive Window Callsign Colors 

When a callsign is recognized in the receive input stream the callsign will be colored according to the 
same color scheme that is used in the Bandmap Window and brought to the Grab window. Valid 

callsigns that are separated by spaces are always recognized, and optionally the Search routine can be 
used to search for known call signs from the Master.dta file in garbage text strings. When the search 
in garbage text is enabled and two calls are found in the same string, only the last one gets 
highlighted. Also, if the call sign being copied contains a shorter call sign that is in the Master.dta file, 
using the search in garbage feature may result in the shorter call sign being recognized instead of the 
longer one. The highlighted calls in text strings are clickable.  

The determination of what is a valid callsign is affected by two things: the Callsign Validity and 
Highlight option chosen in the Digital Setup window, and whether or not there is a file named 
LP1H_Calls.mdb in the N1MM Logger program folder.  
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If the "Use Generic Routines" option is chosen in the Digital Setup, anything that looks like a callsign 

(i.e. passes the check routines - see next paragraph) will be highlighted with a color that indicates its 
multiplier status using the same colors as in the Bandmap and Entry window. If the "Use Master.dta 
File" option is chosen, only call signs in the Master.dta file will be colored according to the multiplier 

status; callsigns that are not in the Master.dta file will be given a different highlight color to indicate 
that they were not found in Master.dta. Regardless of which option is chosen, any callsign that passes 
the check routines will be placed in the Grab window.  

There are two separate check routines. The first is based on a database of all call signs that are known 
to have been issued by licensing authorities. This database, called LP1H_Calls.mdb, has been compiled 
by LU5DX. It contains approximately 1.7 million callsigns, and is updated five times a year. A zip file 
containing this database can be downloaded from the Files menu on the N1MM Logger web site and 
unzipped into the N1MM Logger program folder. If this database is found, any text string that is 
neither a number nor a gridsquare reference nor too long to be a callsign is checked against this 

database, and if it is found there, it is considered to be a valid callsign. If this database is not present, 
or if the text string is not found in the callsign database, then it is checked using the second check 
routine, which is a pattern-matching routine that looks for patterns that match amateur callsigns 

(national prefix, number, suffix). If the database is present and a callsign that matches the pattern-
matching routine but is not found in the database is entered into the Entry window, a warning 
message is displayed in the Check window to indicate that the callsign was not found in the database.  

2.2. Mouse Assignments 

 Left mouse key clicking  

o Single clicking on a callsign grabs it and places it in the Callsign field on the Entry 
Window dialog  

o Single clicking on Exchange info etc. grabs it and places it in the Exchange field on 
the Entry Window dialog  

 NB. The callsign field must be filled first!  
o Double clicking on a callsign grabs it and overrides the current information in the 

Callsign field on the Entry Window dialog  
o Ctrl+Single clicking - will force what ever you are clicking to be sent to Entry 

window. (Must click first in Entry window where you want to place the new data)  
o Shift+Single clicking - will cause the moused over text to be Letter/Figs converted 

on the fly while sending to Entry Window (only in RTTY Mode)  
o Alt+Single clicking - if Digital Call Stacking is enabled, will transfer the call sign 

being clicked on to the Bandmap call stack (see Single Operator Call Stacking? for 

more information)  

 Right mouse key clicking on RX window  
o Will give a menu only when the menu item 'RT Click = Return NOT menu' is 

NOT selected!  

 Clear RX - Clear the receive window. This receive buffer can contain a 
maximum of 10,000 characters  

 Output to Text File - Output the received text to a text file named RTTY1.txt  
 Help - Show the help file for this window  

 Right mouse key clicking on TX window  

o Will give a menu only when the menu item 'RT Click = Return NOT menu' is 

NOT selected!  
 Clear TX - Clear the transmit window  
 Paste - Place the TX text in the Paste buffer  

 Right mouse key clicking in GRAB window  

o Gives a menu:  
 Clear List - Clear the entire grab window  
 Clear Selected Call - Clear the selected call in the grab window  
 Sort Order - Choose the order in which call signs are pulled from the grab 

window:  

 Last In, First Out  
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 First In, First Out  

2.2.1. Keyboard Assignments 

 Alt+T - Toggle TX/RX, when in TX the cursor will be set to the TX window of the active 

interface  

 Ctrl+K - Toggle TX/RX, and displays the CW/Digital Keyboard window to send manual 

information using the keyboard  

 Alt+G - Grab most recent callsign from callsign textbox. Upon grabbing that callsign gets 
deleted from the grab list  

 Ctrl+Left/Right arrows - When two radios are configured in SO2R or a dual-receiver radio is 

used in SO2V, and two digital windows are open, pressing Ctrl+Left arrow or Ctrl+Right arrow 
will swap from one active Digital Interface to the other. Digital Interface 1 will follow VFO 
A/Radio 1, Digital Interface 2 will follow VFO B/Radio 2  

3. The Digital Interface - Menu Selections 

The digital interface has a menu at the top which varies depending on which type of interface is 
selected under the Digital Modes tab in the Configurer.  

3.1. Configurer Selection: Soundcard 

 Setup  

o Settings - Opens the Digital Setup window; see the section on 'The Digital Interface - 
Setup' below  

o Turn AutoTRXUPdate On/Off  
 If your radio's dial displays the actual transmitted frequency (i.e. the Mark 

frequency in FSK RTTY), you would turn this option off  
 If your radio's dial displays the suppressed carrier frequency (e.g. SSB mode), 

you would turn this option on. This causes the program to add (USB) or 

subtract (LSB) the audio frequency from the digital engine to/from the radio's 
dial frequency so that the frequency that appears in the Entry window, the 
Bandmap, the log and spotted to the DX cluster is the actual transmitted 
frequency, not the suppressed carrier frequency  

AutoTRXUpdate can affect other modes 

If the AutoTRXUpdate option is turned on, it takes effect whenever the DI window is open. If you leave 
the DI window open and switch to CW or SSB, the offset will continue to be applied, and the 
frequencies in the Entry window, Bandmap and your log will be incorrect. You should always close the 

DI window when switching from digital modes to other modes. Also, if you are likely to want to use a 
non-digital mode the next time you start the program, you should close the DI window before shutting 
down N1MM Logger in order to ensure that the DI window does not cause this option to be applied the 
next time you start the Logger. 

o Bring to Foreground when made Active - Bring the Digital Interface and Engine to 

the foreground when its Entry window has focus  
 This adds ability to stack Digital Interfaces and Engines and have the correct 

one on top when the associated Entry window has focus  
o SoundCard  

 Receive Mixer - Shows the Record control mixer dialog from the Windows 
operating system. Only for Windows versions XP and earlier  

 Transmit Mixer - Shows the Play control mixer dialog from the Windows 
operating system. Only for Windows versions XP and earlier  

 These menu items are not available when using the Fldigi engine  



o Setup MMTTY - The MMTTY setup is shown. This menu item is only visible when 

MMTTY is selected  
o AFC On/Off with CQ - If set then the AFC will turn on with CQ message or TU 

messages. Turning AFC on when soliciting new callers with a CQ or QRZ message can 

help tune in off-frequency callers  
o NET On/Off with Run Change - Option to turn Net function on in S&P and off in 

Running mode. In S&P mode, you normally want to transmit on the same frequency 
you are receiving on; in AFSK, turning NET on ensures this. In Run mode, you 
normally leave NET off in order to allow the receiver to track off-frequency callers 
without moving your TX frequency  

o Turn Hover Mode On/Off - With this option selected, when the mouse is hovered 

over a valid callsign the callsign is automatically transferred to the Entry window's 
callsign box without having to click on it. This option is most effective when used in 
combination with the RT Click = Return NOT menu option  

 Note: Your own call is excluded from being picked up  
o RT Click = Return NOT menu - When this option is selected, a right-click in the RX 

window will perform the same functions as pressing the Enter key. This is designed to 

work with ESM; in ESM, pressing the Enter key automatically sends the next message 
in the normal QSO sequence. For example, when CQing, once a callsign has been 
placed in the callsign box (either by left-clicking on it or using the Hover mode option), 
right-clicking will send the exchange and move the cursor to the exchange box, left-
clicking on the received exchange will transfer the exchange to the entry window and 
right-clicking will send the TU message and log the contact. A complete QSO can be 
performed with simply a couple of left-clicks and a couple of right-clicks  

o Send Text File - Send a text file. A file open dialog will appear from which the file to 
be sent can be selected  

o Output Main RX Window to Text File - When this is checked, text that is displayed 
in the main RX window will be saved to a text file in the N1MM Logger program folder. 
The file name will be date stamped (mmddyyyy), as in 
05312012DigitalInterface1Output.txt (for DI1)  

o Digital Call Stacking - Used together with the {LOGTHENPOP} macro. See Single 

Operator Call Stacking? for more information  
 Enable using First In First Out - Enables the Digital Call Stacking feature. 

Calls are popped off the stack in the order they were placed there  
 Enable using Last In First Out - Enables the Digital Call Stacking feature. 

Calls are popped off the stack in reverse order, i.e. most recent first  
 Enable using FIFO Mults First - Enables the Digital Call Stacking feature. 

Calls are popped off the stack in order of their multiplier value. In those 
contests where one QSO can yield 2 or 3 mults, the higher-mult calls will be 
taken first. Among calls with the same multiplier value, calls are popped in 
FIFO order, i.e. in the order they were placed there  

 Disabled - Disables the Digital Call Stacking feature  
o Use RX Window Callsign Pause Routines - When this option is selected, moving 

the mouse in the RX window over a valid callsign while the callsign box in the Entry 

window is empty will cause incoming text to stop appearing and the RX window to 
pause scrolling. At this point you can either click on the callsign to transfer it into the 
Entry window, display any incoming text that was held back during the pause and 
resume scrolling, or simply move the mouse off the callsign to display any held 

incoming text and resume normal scrolling. Also with this option selected, when the 
left mouse button is clicked in the RX window to select text the RX window will pause 
until the mouse button is released after the text has been selected, at which point the 

selected text will be copied to the clipboard, any held incoming text will be displayed 
and normal scrolling will resume. If there is a scrollbar present in the RX window, 
moving the scroll bar will cause incoming text to be paused until either text has been 
selected and the mouse has been released, the pause strip at the left side of the 
window is clicked, or the right mouse button is clicked in the RX window  

o Add. RX Windows  

 Enable Attached RX Windows - After one or more additional RX window(s) 
has/have been set up using the last submenu item below, this option can be 
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selected in order to attach or embed small RX text displays from the additional 

RX window(s) into the main DI window. When the additional RX windows are 
attached to the main RX window using this option, the attached windows 
appear above the main RX window as controlled by the next option. The non-

attached RX windows are minimized to the task bar when the attached 
windows are enabled, but they may be restored from the task bar in order to 
see more text than is visible in the attached window, to access the setup 
options, or to close the additional RX window without closing the main DI 
window. The task bar icon for the additional RX window is grouped with the 
main N1MM Logger icons. If the additional RX window is using a software 
decoder, there will also be a separate task bar icon for the digital engine; do 

not confuse the two task bar icons  
 Layout  

 Single Over Each Other - Each additional attached RX Window 
displays a single line of text. If there is more than one additional 
window, the attached windows are stacked vertically above the main 
RX window  

 Double Over Each Other - Similar, except each additional attached 
RX Window displays two lines of text. The DI window must be sized 
large enough vertically to make sufficient room for the main RX 
window as well as the additional attached RX window(s)  

 Side by Side - Additional attached RX Windows are arranged in two 
columns above the main RX window, with two lines of text in each  

 Open Add. RX Window (4 Avail.) - This allows you to open an auxiliary RX 

window for diversity decoding of the same RTTY signal, e.g. by using a TNC in 
the main DI window and MMTTY or 2Tone in the auxiliary window, or by using 
a different copy of MMTTY or 2Tone with a different decoding algorithm to 
decode the same audio input. There are up to 4 such windows available (the 
remaining number available appears in the menu). Each additional window is 
associated with either DI1 or DI2, depending on which DI window menu was 
used to open it. There is a separate Setup dialog for each additional RX 

window, which is accessible from the menu bar at the top of the additional 
window. The first time an additional RX window is opened, its setup dialog will 

automatically be displayed. The decoder type (MMTTY, TNC or DXP38 - use 
MMTTY for 2Tone), and the path to the program or the COM port information 
for a TNC must be filled in before the additional RX window can be used. Once 
all of the additional RX windows you intend to open from either DI window 

have been set up and tested, you can use the Enable Attached RX Windows 
option to attach the additional windows to the main DI window  

 Interface  
o MMTTY - Select MMTTY (or 2Tone) as the interface  

 Requires MMTTY (or 2Tone) to be installed and the DI-1/2 path(s) to MMTTY to 
be set up in the Configurer  

o MMVARI - Select MMVARI as the interface  
 No other installation required - the MMVARI engine is installed during the 

N1MM Logger install  
o Fldigi - Select Fldigi as the interface  

 Requires Fldigi to be installed and the DI-1/2 path(s) to Fldigi to be set up in 

the Configurer  

 Help - Shows help file  

3.2. Configurer Selection: OTHER 

 Setup  
o Settings - Opens the Digital Setup window; see the section on 'The Digital Interface - 

Setup' below  
o Turn AutoTRXUPdate On/Off  



 If your radio's dial displays the actual transmitted frequency (i.e. the Mark 

frequency in FSK RTTY), you would turn this option off  
 If your radio's dial displays the suppressed carrier frequency (e.g. SSB mode), 

you would turn this option on. This causes the program to add (USB) or 

subtract (LSB) the audio frequency from the digital engine to/from the radio's 
dial frequency so that the frequency that appears in the Entry window, the 
Bandmap, the log and spotted to the DX cluster is the actual transmitted 
frequency, not the suppressed carrier frequency  

AutoTRXUpdate can affect other modes 

If the AutoTRXUpdate option is turned on, it takes effect whenever the DI window is open. If you leave 
the DI window open and switch to CW or SSB, the offset will continue to be applied, and the 
frequencies in the Entry window, Bandmap and your log will be incorrect. You should always close the 

DI window when switching from digital modes to other modes. Also, if you are likely to want to use a 
non-digital mode the next time you start the program, you should close the DI window before shutting 
down N1MM Logger in order to ensure that the DI window does not cause this option to be applied the 

next time you start the Logger. 

o Bring to Foreground when made Active - Bring the Digital Interface and Engine to 

the foreground when its Entry window has focus  
 This adds ability to stack Digital Interfaces and Engines and have the correct 

one on top when the associated Entry window has focus  
o Turn Hover Mode On/Off - With this option selected, when the mouse is hovered 

over a valid callsign the callsign is automatically transferred to the Entry window's 
callsign box without having to click on it. This option is most effective when used in 
combination with the RT Click = Return NOT menu option  

 Note: Your own call is excluded from being picked up  
o RT Click = Return NOT menu - When this option is selected, a right-click in the RX 

window will perform the same functions as pressing the Enter key. This is designed to 
work with ESM; in ESM, pressing the Enter key automatically sends the next message 
in the normal QSO sequence. For example, when CQing, once a callsign has been 
placed in the callsign box (either by left-clicking on it or using the Hover mode option), 

right-clicking will send the exchange and move the cursor to the exchange box, left-
clicking on the received exchange will transfer the exchange to the entry window and 
right-clicking will send the TU message and log the contact. A complete QSO can be 

performed with simply a couple of left-clicks and a couple of right-clicks  
o Send Text File - Send a text file. A file open dialog will appear from which the file to 

be sent can be selected  
o Output Main RX Window to Text File - When this is checked, text that is displayed 

in the main RX window will be saved to a text file in the N1MM Logger program folder. 
The file name will be date stamped (mmddyyyy), as in 

05312012DigitalInterface1Output.txt (for DI1)  
o Digital Call Stacking - Used together with the {LOGTHENPOP} macro. See Single 

Operator Call Stacking? for more information  
 Enable using First In First Out - Enables the Digital Call Stacking feature. 

Calls are popped off the stack in the order they were placed there  
 Enable using Last In First Out - Enables the Digital Call Stacking feature. 

Calls are popped off the stack in reverse order, i.e. most recent first  

 Enable using FIFO Mults First - Enables the Digital Call Stacking feature. 
Calls are popped off the stack in order of their multiplier value. In those 
contests where one QSO can yield 2 or 3 mults, the higher-mult calls will be 
taken first. Among calls with the same multiplier value, calls are popped in 
FIFO order, i.e. in the order they were placed there  

 Disabled - Disables the Digital Call Stacking feature  
o Use RX Window Callsign Pause Routines - When this option is selected, moving 

the mouse in the RX window over a valid callsign while the callsign box in the Entry 
window is empty will cause incoming text to stop appearing and the RX window to 
pause scrolling. At this point you can either click on the callsign to transfer it into the 
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Entry window, display any incoming text that was held back during the pause and 

resume scrolling, or simply move the mouse off the callsign to display any held 
incoming text and resume normal scrolling. Also with this option selected, when the 
left mouse button is clicked in the RX window to select text the RX window will pause 

until the mouse button is released after the text has been selected, at which point the 
selected text will be copied to the clipboard, any held incoming text will be displayed 
and normal scrolling will resume. If there is a scrollbar present in the RX window, 
moving the scroll bar will cause incoming text to be paused until either text has been 
selected and the mouse has been released, the pause strip at the left side of the 
window is clicked, or the right mouse button is clicked in the RX window  

o Add. RX Windows  

 Enable Attached RX Windows - After one or more additional RX window(s) 
has/have been set up using the last submenu item below, this option can be 
selected in order to attach or embed small RX text displays from the additional 
RX window(s) into the main DI window. When the additional RX windows are 
attached to the main RX window using this option, the attached windows 
appear above the main RX window as controlled by the next option. The non-

attached RX windows are minimized to the task bar when the attached 
windows are enabled, but they may be restored from the task bar in order to 
see more text than is visible in the attached window, to access the setup 
options, or to close the additional RX window without closing the main DI 
window  

 Layout  
 Single Over Each Other - Each additional attached RX Window 

displays a single line of text. If there is more than one additional 
window, the attached windows are stacked vertically above the main 
RX window  

 Double Over Each Other - Similar, except each additional attached 
RX Window displays two lines of text. The DI window must be sized 
large enough vertically to make sufficient room for the main RX 
window as well as the additional attached RX window(s)  

 Side by Side - Additional attached RX Windows are arranged in two 
columns above the main RX window, with two lines of text in each  

 Open Add. RX Window (4 Avail.) - This allows you to open an auxiliary RX 
window for diversity decoding of the same RTTY signal, e.g. by using a TNC in 
the main DI window and MMTTY or 2Tone in the auxiliary window, or by using 
a different copy of MMTTY or 2Tone with a different decoding algorithm to 

decode the same audio input. There are up to 4 such windows available (the 
remaining number available appears in the menu). Each additional window is 
associated with either DI1 or DI2, depending on which DI window menu was 
used to open it. There is a separate Setup dialog for each additional RX 
window, which is accessible from the menu bar at the top of the additional 
window. The first time an additional RX window is opened, its setup dialog will 
automatically be displayed. The decoder type (MMTTY, TNC or DXP38 - use 

MMTTY for 2Tone), and the path to the program or the COM port information 
for a TNC must be filled in before the additional RX window can be used. Once 
all of the additional RX windows you intend to open from either DI window 
have been set up and tested, you can use the Enable Attached RX Windows 

option to attach the additional windows to the main DI window  

 Interface  

o MMVARI - Select MMVARI as the interface (e.g. for PSK or other sound card digital 
modes)  

 No other installation required - the MMVARI engine is installed during the 
N1MM Logger install  

o OTHER(Tnc) - Select the TNC or TU as the interface  

 Help - Shows help file  

3.3. Configurer Selection: DXP38 



 Setup  

o Settings - Opens the Digital Setup window; see the section on 'The Digital Interface - 
Setup' below  

o Turn AutoTRXUPdate On/Off  
 If your radio's dial displays the actual transmitted frequency (i.e. the Mark 

frequency in FSK RTTY), you would turn this option off  
 If your radio's dial displays the suppressed carrier frequency (e.g. SSB mode), 

you would turn this option on. This causes the program to add (USB) or 

subtract (LSB) the audio frequency from the digital engine to/from the radio's 
dial frequency so that the frequency that appears in the Entry window, the 
Bandmap, the log and spotted to the DX cluster is the actual transmitted 
frequency, not the suppressed carrier frequency  

AutoTRXUpdate can affect other modes 

If the AutoTRXUpdate option is turned on, it takes effect whenever the DI window is open. If you leave 
the DI window open and switch to CW or SSB, the offset will continue to be applied, and the 

frequencies in the Entry window, Bandmap and your log will be incorrect. You should always close the 

DI window when switching from digital modes to other modes. Also, if you are likely to want to use a 
non-digital mode the next time you start the program, you should close the DI window before shutting 
down N1MM Logger in order to ensure that the DI window does not cause this option to be applied the 
next time you start the Logger. 

o Bring to Foreground when made Active - Bring the Digital Interface and Engine to 

the foreground when its Entry window has focus  
 This adds ability to stack Digital Interfaces and Engines and have the correct 

one on top when the associated Entry window has focus  
o Turn Hover Mode On/Off - With this option selected, when the mouse is hovered 

over a valid callsign the callsign is automatically transferred to the Entry window's 
callsign box without having to click on it. This option is most effective when used in 
combination with the RT Click = Return NOT menu option  

 Note: Your own call is excluded from being picked up  
o RT Click = Return NOT menu - When this option is selected, a right-click in the RX 

window will perform the same functions as pressing the Enter key. This is designed to 
work with ESM; in ESM, pressing the Enter key automatically sends the next message 
in the normal QSO sequence. For example, when CQing, once a callsign has been 
placed in the callsign box (either by left-clicking on it or using the Hover mode option), 
right-clicking will send the exchange and move the cursor to the exchange box, left-
clicking on the received exchange will transfer the exchange to the entry window and 
right-clicking will send the TU message and log the contact. A complete QSO can be 

performed with simply a couple of left-clicks and a couple of right-clicks  
o Send Text File - Send a text file. A file open dialog will appear from which the file to 

be sent can be selected  
o Output Main RX Window to Text File - When this is checked, text that is displayed 

in the main RX window will be saved to a text file in the N1MM Logger program folder. 
The file name will be date stamped (mmddyyyy), as in 

05312012DigitalInterface1Output.txt (for DI1)  
o Digital Call Stacking - Used together with the {LOGTHENPOP} macro. See Single 

Operator Call Stacking? for more information  
 Enable using First In First Out - Enables the Digital Call Stacking feature. 

Calls are popped off the stack in the order they were placed there  
 Enable using Last In First Out - Enables the Digital Call Stacking feature. 

Calls are popped off the stack in reverse order, i.e. most recent first  

 Enable using FIFO Mults First - Enables the Digital Call Stacking feature. 
Calls are popped off the stack in order of their multiplier value. In those 
contests where one QSO can yield 2 or 3 mults, the higher-mult calls will be 
taken first. Among calls with the same multiplier value, calls are popped in 
FIFO order, i.e. in the order they were placed there  

 Disabled - Disables the Digital Call Stacking feature  

http://n1mm.hamdocs.com/tiki-editpage.php?page=Advanced+Functions


o Use RX Window Callsign Pause Routines - When this option is selected, moving 

the mouse in the RX window over a valid callsign while the callsign box in the Entry 
window is empty will cause incoming text to stop appearing and the RX window to 
pause scrolling. At this point you can either click on the callsign to transfer it into the 

Entry window, display any incoming text that was held back during the pause and 
resume scrolling, or simply move the mouse off the callsign to display any held 
incoming text and resume normal scrolling. Also with this option selected, when the 
left mouse button is clicked in the RX window to select text the RX window will pause 
until the mouse button is released after the text has been selected, at which point the 
selected text will be copied to the clipboard, any held incoming text will be displayed 
and normal scrolling will resume. If there is a scrollbar present in the RX window, 

moving the scroll bar will cause incoming text to be paused until either text has been 
selected and the mouse has been released, the pause strip at the left side of the 
window is clicked, or the right mouse button is clicked in the RX window  

o Add. RX Windows  
 Enable Attached RX Windows - After one or more additional RX window(s) 

has/have been set up using the last submenu item below, this option can be 

selected in order to attach or embed small RX text displays from the additional 
RX window(s) into the main DI window. When the additional RX windows are 
attached to the main RX window using this option, the attached windows 
appear above the main RX window as controlled by the next option. The non-
attached RX windows are minimized to the task bar when the attached 
windows are enabled, but they may be restored from the task bar in order to 
see more text than is visible in the attached window, to access the setup 

options, or to close the additional RX window without closing the main DI 
window  

 Layout  
 Single Over Each Other - Each additional attached RX Window 

displays a single line of text. If there is more than one additional 
window, the attached windows are stacked vertically above the main 
RX window  

 Double Over Each Other - Similar, except each additional attached 
RX Window displays two lines of text. The DI window must be sized 

large enough vertically to make sufficient room for the main RX 
window as well as the additional attached RX window(s)  

 Side by Side - Additional attached RX Windows are arranged in two 
columns above the main RX window, with two lines of text in each  

 Open Add. RX Window (4 Avail.) - This allows you to open an auxiliary RX 
window for diversity decoding of the same RTTY signal, e.g. by using a TNC in 
the main DI window and MMTTY or 2Tone in the auxiliary window, or by using 
a different copy of MMTTY or 2Tone with a different decoding algorithm to 
decode the same audio input. There are up to 4 such windows available (the 
remaining number available appears in the menu). Each additional window is 
associated with either DI1 or DI2, depending on which DI window menu was 

used to open it. There is a separate Setup dialog for each additional RX 
window, which is accessible from the menu bar at the top of the additional 
window. The first time an additional RX window is opened, its setup dialog will 
automatically be displayed. The decoder type (MMTTY, TNC or DXP38 - use 

MMTTY for 2Tone), and the path to the program or the COM port information 
for a TNC must be filled in before the additional RX window can be used. Once 
all of the additional RX windows you intend to open from either DI window 

have been set up and tested, you can use the Enable Attached RX Windows 
option to attach the additional windows to the main DI window  

 Interface  
o MMVARI - Select MMVARI as the interface (e.g. for PSK or other sound card digital 

modes)  
 No other installation required - the MMVARI engine is installed during the 

N1MM Logger install  
o Dxp38 - Select the DXP38 as the interface  



 TNC  

o TX - Switches the DXP38 into Transmit mode  
o RX - Switches the DXP38 back to Receive at the end of the current message  
o Abort - Switches the DXP38 back to Receive immediately  
o Tuning Indicator - DXP38 Tuning Indicator on/off  

 On - tuning indicator on  
 Off - tuning indicator off  

o Echo - DXP38 Echo on/off  

 On - echo on  
 Off - echo off  

o Tones - DXP38 Tones setup  
 Normal - normal mark/space tones  
 Reverse - reverse mark/space tones  

o RF Gain - DXP38 RF Gain setup  
 0 - no amplification  

 +6 db - 6 db amplification selected  
 +12 db - 12 db amplification selected  

o Filter - DXP38 Filter setup  
 Narrow 55 hz - Selects narrow (55 Hz) filter  
 Mid 75 hz - Selects mid (75 Hz) filter  
 Wide 100 hz - Selects wide (100 Hz) filter  

o Setup TNC - Opens the DXP38 tab in the Digital Setup window for making 
adjustments to other DXP38 parameters  

o Hard Reset TNC - As it says - does a hard reset on the DXP38  

 Help - Shows help file  

4. The Digital Interface - Setup 

This setup dialog is for all interface types, but some settings are only for MMTTY or MMVARI. When 
selecting 'Setup | Settings' in the Digital Interface window a dialog like the one below will shown. Any 

changes made in the setup form must be saved by clicking the Save Configuration Button located on 
the bottom of the form. Any changes made and saved will be changed as soon as the setup area 
closes.  

4.1. Tab: General/MMTTY Setup 

This interface has general setup information for ANY type of interface (Soundcard of external TNC) and 
some specific settings for MMTTY, MMVARI and Fldigi.  



 

 RX Windows add to Grab window - If this option is checked, callsigns detected in the 

Additional RX windows will be sent to the Grab window  

 Display Radio Freq and not Exact Freq in DI Caption  
o Check this option if you are using a radio mode that displays the actual transmitted 

frequency rather than the suppressed carrier frequency (e.g. FSK RTTY)  
o Note that this setup option only affects the frequency that is displayed in the DI 

window and that is returned by the {RDIGFQ} or {LDIGFQ} macro. To change the 

frequency that is sent to the Entry window and recorded in the log, see the DI 
window's Setup > Turn AutoTRXOffset On/Off menu item  

 Add Callsign to Bandmap on Alt+G - (MMTTY and PSK) Option to send callsign from station 

in callsign field (Alt+O) when doing a grab (Alt+G)  

 Remove Excess Linefeeds from RX Window - Ability to strip excess linefeeds from RX 
Window  

 Send Space on Callsign Mouse Click - Sends a space to advance the entry window cursor 
after clicking on a call sign  

 (MMTTY) Send HamDefault on Run to S&P change - (MMTTY only) Ability to have Ham 

Default(MMTTY) sent when going from Run to S&P to reset Mark Frequency. Select to enable  



 (MMTTY-MMVARI) Turn AFC Off when switching to S&P - (MMTTY and PSK) Ability to 

Turn AFC Off when going from Run to S&P. Select to enable. Many people when in Running 
mode will leave the Net Off and turn on AFC to find people coming back to them a little off 
frequency. So to turn the AFC back off when you go to S&P (without forgetting) this setting 
comes in handy  

 Do Not add Dupes to Grab Window - Setting for adding dupes to Grab window or Not  

 Send Space on Using Grab - when doing a grab from the grab window it will also send a 
space press command to Entry window to advance the cursor  

 If QSY Wipes call is checked Clear Grab Window on QSY - If QSY Wipes and Spot call is 

checked then Clear the Grab window on wipe of callsign.  

 QSY will clear Grab Window - Changing frequency will clear the Grab window  

 Clear Grab Window On CQ - sending CQ will clear the Grab window  

 Callsign Validity Routines  
o Use Generic Routines - the generic routines will highlight anything that passes the 

check routines (and probably will look like a callsign)  

o Use master.dta File - when selected only the callsigns in the master.dta file will be 
highlighted  

 Highlight Color for non-Master.dta calls will be shown in the shown color.  
o Use Search routine to find Master.dta in Garbage Text - ability to turn off 

checking for callsigns in garbage text in digital modes  
o Highlight Foreground Text - call sign text will be in the highlight color on the 

normal background  

o Highlight Background of Text - background color surrounding call sign will be 
changed to the highlight color  

 Digital Interface Window Colors  
o The RTTY receive and transmit window background colors, RX text color and own 

callsign color in RX window can be changed here. Click on one of the colored boxes to 
change its color. Note that the highlight colors for validated callsigns corresponding to 

their worked/multiplier status (red/green/blue/grey) are the same as in the bandmap 
and cannot be changed  

 Digital Interface RX Window Font Selection - Change the font and character size for the 
RX channels. Press the 'Set Font' button to get a selection window  

o You must close the Digital Window and reopen it so the changes can take effect  

 MMTTY Window Settings  

o Normal - The normal size MMTTY window is shown, including waterfall/spectrum, 
menu bar and control buttons  

o Small - The small size MMTTY window is shown, i.e. waterfall/spectrum display only  
o Control Menu's - Shows waterfall/spectrum plus menu bar  
o Control Button's - Shows waterfall/spectrum plus control buttons  
o Give MMTTY Help Starting - Turn MMTTY kick-starts off and on  

Having trouble getting MMTTY to start? 

If you are having trouble getting MMTTY to initialize when the DI window starts up, here are some 

things to try: First, upgrade to the latest version of MMTTY. Several cases of failure to start have been 
solved by updating to version 1.68A. Next, if that doesn't work, try checking the Give MMTTY Help 
Starting check box. If this box is already checked, try unchecking it. 

 Preferred RTTY Interface - Select the preferred RTTY interface. Choices are: MMTTY, 
MMVARI, TNC or Fldigi  

 Preferred PSK Interface - Select the preferred interface for PSK (and other sound card 
modes). Choices are MMVARI and Fldigi  



 On Top Settings  

o MMTTY always on Top - MMTTY is always in front of all other N1MM logger windows. 
A restart of N1MM logger is needed to activate this function. Minimizing the N1MM 
logger program will not minimize the MMTTY engine  

o MMVARI always on Top - MMVARI is always in front of all other N1MM logger 
windows. A restart of N1MM logger is needed to activate this function. Minimizing the 
N1MM logger program will not minimize the MMVARI engine  

o Fldigi always on Top - Fldigi is always in front of all other N1MM logger windows. A 

restart of N1MM logger is needed to activate this function. Minimizing the N1MM logger 
program will not minimize the Fldigi engine  

 Shift Frequency Compensation - for radios which use/need Shift Frequency Compensation  
o Enabled - Select to enable Shift Frequency Compensation  
o Offset Frequency - the frequency offset  

 Alignment Frequency - frequency used by the Align button = preferred audio frequency. If 

you are using FSK RTTY, be sure to set the RTTY alignment frequency corresponding to your 
radio's transmit frequency (i.e. set Align frequency to your radio's Mark frequency in MMTTY, 
Mark frequency + 85 in MMVARI and Fldigi)  

o MMTTY - RTTY alignment frequency. This is the Mark frequency  
o MMVARI - Alignment frequencies for MMVARI  

 RTTY - RTTY alignment frequency in MMVARI  
 NB Add 85 to place Mark Frequency on desired frequency. Example: 

For 2125 Mark, enter 2210  
 Other - alignment frequency for other modes than RTTY  

o FLdigi - Alignment frequencies for Fldigi  
 RTTY - RTTY alignment frequency in Fldigi  

 NB Add 85 to place Mark Frequency on desired frequency. Example: 
For 2125 Mark, enter 2210  

 Other - alignment frequency for other modes than RTTY  

 Save Configuration - Save the configuration changes you just made. If you want to back out 
without saving the changes, click on the X in the upper right corner to close the window  

4.2. Tab: MMVARI Setup 



 

 MMVARI Engine  
o Waterfall/Spectrum/Misc Color palette - The colors that make up the color palette 

can be changed to represent whatever colors you would like. The colors go from the 
weakest signal on the left to the strongest signal on the right. There is a color palette 

setting for the Waterfall, Spectrum and for Miscellaneous colors. The Default button 
changes the colors back to the default colors  

o Squelch Level - This level represents the noise level where you would like the 
interface to start copying signals. 0 indicates an open squelch and everything will be 
decoded  

o High Pass Filter - Select 'Use High Pass Filter' to use the internal high pass filter for 

RX. Although this is unnecessary with most soundcards, it sometimes is effective for 
eliminating hum in the input audio  

o Spectrum Lower Frq - the lower frequency to display when the Spectrum view or 
Waterfall is active  

o Spectrum Upper Frq - the upper frequency to display when the Spectrum view or 
Waterfall is active  

o CW ID  

 Enable - If this check box is checked (Enabled) the interface will send the 
string entered in the field (Enter CWID String) in CW after every transmission. 
A * will be substituted by SK, + by AR and = by BT  

o AFC Search Range - This is how far in Hz the interface will track a drifting signal i.e 
the frequency sweeping width (+/-Hz) for the AFC  



 Sense Level - specifies the S/N level (dB) for the wide AFC. When the search 

range is less than or equal to 50 Hz, the wide AFC does not function. The 
sense level is applied to all the RX channels  

o Use TNC Software for control - When selected N1MM logger will release the serial 

port for the TNC so the soundboard in the TNC can have control. When using an 
external TNC the internal soundboard can be used  

o Digital Output Level - specifies the digital output level in the range of 0 to 32767. 
The default value is 16384  

 DI1/DI2 MMVARI Soundcard  
o MMVARI Soundcard #  

 Input Soundcard# - Select the input soundcard to be used when there is 
more than one soundcard in your computer (maximum 4)  

 Input Channel - Select the input channel. Mono, Left channel or Right 
channel  

 Output Soundcard# - Select the output soundcard to be used when there is 

more than one soundcard in your computer (maximum 4)  
o FIFO  

 RX - specifies the depth of the RX FIFO. Valid values are 4 to 32  
 TX - specifies the depth of the TX FIFO. Valid values are 4 to 32  

o Clock - Soundcard Clock adjustment  
 RX - specifies the tuning parameters of the RX clock adjustment function  
 TX Offset - the offset of the TX frequency compared to the RX frequency  
 Graphical Adjustment - Graphical RX clock adjustment  

 The computer clock itself is not very accurate (+- 100 ppm); that is 

why to use WWV or another precision source to calibrate the 
soundcard  

 1. Tune to WWV or another Time Mark; adjust so tick is on 1000 Hz in 
Spectrum of MMVARI  

 2. Wait for line to appear in display and adjust Clock Freq so line 
appears straight and not at an angle  

 3. Click button to save new frequency when line is straight up and 
down  

 MFSK (MFSK only)  
o Handling Center Frequency - When selected the center frequency is used for the 

carrier frequency. When not selected the base tone frequency is used for the carrier 
frequency  

o Use Metric Level Squelch - Select to use the metric level for the squelch. When not 

selected the S/N level is used for the squelch  

 # of MMVARI channels - Number of MMVARI channels to use. Choices are 1, 2, 3 or 4  
o Note that if this is set to 1, you have the option to select the Multi-Channel Rx menu 

item in the MMVARI menu bar, but when it is set to 2, 3 or 4 this option is not 

available  

 Save Configuration - Save the configuration changes you just made. If you want to back out 
without saving the changes, click on the X in the upper right corner to close the window  

4.3. Tab: Message Setup 



 

 Digital Message Set Select Interface Type and Window Number to begin - Update the 
message definitions and button caption texts  

o Select an interface (TNC or soundcard DI) from the drop down menu. Choices are:  
 MMVARI - messages for the MMVARI interface  

 MMTTY,Fldigi - messages for the MMTTY and Fldigi interfaces  
 Other - messages for the TNC  
 Dxp38 - messages for a DXP38  

o Click on the message button which has to be updated  
o Type the message text in the field 'Message Text'  
o Type the button caption text in the field 'Message Caption'  

o Click on the 'Save Message' button when satisfied  
o The selected message caption text will be shown on the button  
o Available macros for use in messages are shown in the box 'Available Macros'. First 

select a message button to see them all  
o The Macro buttons below (for TNC use only) have to be configured as TX/RX buttons. 

Enter the control codes that are needed to turn on and off your TNC  
 Only visible when Other is selected  

 RX - Receive macro, i.e. the command(s) your TNC needs to put it into 
transmit. This will become the contents of the {RX} macro  

 TX - Transmit macro, i.e. the command(s) your TNC needs to put it back into 
receive at the end of a message. This will become the contents of the {TX} 
macro  

 ESC - Abort macro, i.e. the command(s) your TNC needs to abort an ongoing 
message immediately. This will be executed when you press the Escape key  



 Load Messages - Load saved messages from a saved file (*.mc) to the selected Digital 

Message Set  

 Save Messages - Save messages from the Digital Macro Set to a file (*.mc)  

 # of Messages - Select the number of message buttons. You can select 0, 8, 16 or 24  

 Message Setup  
o Message Text - Area where to create the message text for the selected message  
o Message Caption - Message caption from the button  

o Available Macros - Shows the available macros that can be used in messages. 
Clicking on a macro will transfer it to the message text area  

o Save Message - Save the created message  

 Save Configuration - Save the configuration changes you just made. If you want to back out 
without saving the changes, click on the X in the upper right corner to close the window  

4.4. Tab: WAE RTTY Configuration 

This tab will only show when the WAE RTTY contest has been selected and the information in this tab 
is only valid for the WAE RTTY contest.  

 

 RQTC - Under RQTC are the 4 messages to send when receiving a QTC  

 SQTC - Under SQTC are the 4 messages to send when sending a QTC  



 Default Number of QTC to Send - maximum of 10 QTC's  

 When sending request for single QTC do what?  
o Clear all data for that QTC  
o Clear only Bad Data  
o Do nothing just send request  

 Save Configuration - Save the configuration changes you just made. If you want to back out 
without saving the changes, click on the X in the upper right corner to close the window  

4.5. Tab: DXP-38 Setup 

This tab will only show when the DXP-38 TU has been selected under the Digital Modes tab in the 
Configurer.  

 

 
The various settings in this window are for setting up DXP-38 parameters.  



 Save Configuration - Save the configuration changes you just made. If you want to back out 

without saving the changes, click on the X in the upper right corner to close the window  

 

2.7.4 Digital - MMTTY for RTTY support 

 2.7.4 Digital - MMTTY for RTTY support  

o 1. MMTTY Windows  
o 2. Download, Configure and Test MMTTY  

 2.1. Download MMTTY  
 2.2. Configure MMTTY  

 2.2.1. FSK KEYING  
 2.2.1.1. Using the RIGblaster Interface for FSK with 

N1MM/MMTTY  

 2.2.2. AFSK KEYING  
o 3. Testing MMTTY  
o 4. Dual Receiver/Dual Radio Setup  
o 5. Using MMTTY  

 5.1. How to Tune RTTY  
 5.2. When Should I Use AFC?  
 5.3. When Should I Use the NET Option: NET On/Off with Run Change  
 5.4. Why to Use "Auto Update TRX Offset w/Mark Freq."  
 5.5. Using MMTTY for 75 baud RTTY  

The MMTTY soundcard interface, which uses the MMTTY engine by Makoto Mori, JE3HHT, is the most 
popular method for RTTY. Amateurs who use RTTY are indebted to Mori-san for the positive impact 
MMTTY has had on amateur radio RTTY. 

The 2Tone soundcard interface was written by David Wicks, G3YYD, as a replacement for the MMTTY 
interface in programs like N1MM Logger. It can be substituted for MMTTY as the digital engine used in 

any of the Logger's DI windows or Additional RX-only windows. The 2Tone windows are different in 

appearance from the MMTTY windows, but perform similar functions. These windows are described 
and documented in pdf files that you download with 2Tone.  

1. MMTTY Windows 

When using MMTTY two windows will open.  

 the Digital Interface window  

o is similar for MMTTY, MMVARI, Fldigi and external Interfaces (TNCs or TUs). See the 
Digital Interface section  

 the MMTTY engine window -  

o there are four versions which can be selected in the Digital Interface menu under 
Settings.  

 Small version MMTTY engine window  

http://n1mm.hamdocs.com/tiki-index.php?page=Digital+Setup&structure=N1MM+Logger+Documentation#The_Digital_Interface_-_Window


 

 Normal, or Large version MMTTY engine window  

 

 Control Menus - small window plus the menu bar (View, Option, Profiles)  

 Control Buttons - large window minus the menu bar  

2. Download, Configure and Test MMTTY 

2.1. Download MMTTY 

 Download the current release of MMTTY here   
o At least version 1.64 is needed; version 1.68A is recommended  

 Run the setup program and install this to your computer (preferable) in its own directory  

o Don't install in the N1MM logger directory when using a MMTTY version from before 
July 7 2002. When uninstalling MMTTY all files in the install directory will be deleted 
and with that also N1MM logger. MMTTY version 1.64 uses a new installer and does 
not have this problem anymore  

 The NewExe contains the file XMMT.ocx needed for MMTTY version 1.64 or higher and should 
be in the N1MM Logger directory after an update  

 The 2Tone engine, which can be used as a drop-in replacement for MMTTY, can be 
downloaded from the G3YYD folder in the Files area of the N1MMLogger-Digital Yahoo user 
group, in the form of a zip file containing the 2Tone engine together with documentation for 
installing and using it  

2.2. Configure MMTTY 

http://hamsoft.ca/pages/mmtty.php


2.2.1. FSK KEYING 

1. In the N1MM Logger Entry window, select >Config >Ports, Telnet Address, Other >Digital Modes 
tab  

o Select Soundcard as your Interface type  
o Select for the selected Digital Interface as MMTTY, Mode FSK  
o Select the path to your MMTTY directory (for DI-2 if you are configuring for the second 

DI window)  

 Select the 'Hardware' tab  

o Beside the port that you are using for FSK keying, if you are also using this same port 
for PTT or CW keying from the main N1MM Logger program place a check mark under 
the Digital column beside this port; note that this is not applicable if you are using 
EXTFSK  

o If you have checked the Digital check box, click on the Set button and set the Dig Wnd 
Nr to 1 (or 2 if you are configuring for DI-2)  

 
2. Save and exit the Configurer  

 If MMTTY is already loaded you will probably get an error message about not being able to 
open port xxxx  

 
3. Open the Digital Interface window (under the Window menu)  

 Select the Interface > MMTTY menu item in the DI window  

 Select: Option > Setup in the MMTTY window, or use the DI window's Setup > Setup MMTTY 

menu item  
o Select the TX tab and under PTT, set the serial port that you will be using for FSK 

keying and data; if you also use this port in other modes for CW or PTT keying, the 

Digital check box in the Configurer should also be checked for this port  
 If you are using a USB-to-serial adapter, or a control line other than TxD to do 

FSK keying, you will have to select EXTFSK as the serial port and configure the 

port and signal line information in the EXTFSK window  
 Note that MMTTY's Radio Command port must be set to NONE; if you use 

MMTTY's Radio Command port when running MMTTY stand-alone, you must 
reconfigure MMTTY not to use this port when it is run from N1MM Logger  

o Select the Misc tab and check COM-TxD(FSK) for the Tx Port  
 If you are using a USB device to do FSK keying, click on the USB Port button 

and set the option to C. Limiting Speed  

o Select the Sound Card tab (in MMTTY version 1.66G) and choose the correct sound 
card for Reception (the Transmission sound card is not used in FSK) (Note: Users of 
newer versions of Windows should consult the text box on sound card selection in 
Windows 7 in the section below on AFSK, as the same issues may apply to sound card 
selection for reception in FSK.)  

o If you are using two copies of MMTTY to decode signals using the two channels of a 

stereo sound card for different receivers (SO2V) or different radios (SO2R), select the 

Misc tab again and in the Source pane, select either "Left" or "Right", depending on 
which channel you want this copy of MMTTY to decode  

o Close the MMTTY Setup dialog  
o Close the 'Digital Interface' to have the Logger and MMTTY save the settings  

2.2.1.1. Using the RIGblaster Interface for FSK with N1MM/MMTTY  



 

The default for FSK via MMTTY is TXD. You'll need to change the jumpers when using a RIGblaster. 
Also, make sure you get MMTTY working as a standalone first. Then you should just be able to specify 
MMTTY (select Soundcard) in the Digital Interface config in N1MM and it should take off. If you are 

lucky enough to have a radio where PTT is asserted via radio control ( Kenwood is one) then leave the 
PTT unchecked in the port setup and checked in the PTT via rig control portion.  

2.2.2. AFSK KEYING 

 
1. Open the Configurer (Configure Ports, Telnet Address, Other in the Config menu).  

 Select the Digital Modes tab  

o Select Soundcard as your Interface type.  
o Select for the selected Digital Interface as MMTTY, Mode AFSK  
o Select the path to your MMTTY directory (for DI-2 if you are configuring for the second 

DI window)  

 Select the 'Hardware' tab  

o You can let N1MM Logger control PTT, or if you don't use PTT in other modes and want 
to have MMTTY control PTT, you can place a check mark under the Digital column 
beside the port that you are using for the digital port  

o If you are using VOX or an external VOX unit like the SignaLink interface to control 
PTT, you don't need to configure anything for it in the Logger  

o If you have checked the Digital box, click on the Set button and set the Dig Wnd Nr to 
1 (or 2 if you are configuring for DI-2)  

o If you are using 2Tone in place of MMTTY, do not check the Digital check box for your 
PTT port  

 
2. Save and exit the Configurer.  

3. Open the Digital Interface window (under the Window menu)  

 Select the Interface > MMTTY menu item in the DI window  

 Select: Option > Setup in the MMTTY window, or use the DI window's Setup > Setup MMTTY 

menu item  
o If you are using 2Tone rather than MMTTY, you will make the configuration settings 

below in the 2Tone Setup window, which is opened from the 2Tone window  
o If you have chosen to have MMTTY control PTT (not applicable with 2Tone), select the 

TX tab and under PTT, set the serial port that you will be using for PTT; this should be 
the same port that you checked the Digital box for in the Configurer  

 Note that MMTTY's Radio Command port must be set to NONE; if you use 
MMTTY's Radio Command port when running MMTTY stand-alone, you must 
reconfigure MMTTY not to use this port when it is run from N1MM Logger  

o Select the Misc tab and check Sound for the Tx Port  
o Select the SoundCard tab (in MMTTY version 1.66G) and choose the correct sound 

card for both Reception and Transmission (users of WIndows 7, Vista and newer 

versions should read the note below)  

o If you are using two copies of MMTTY to decode signals using the two channels of a 
stereo sound card for different receivers (SO2V) or different radios (SO2R), select the 
Misc tab again and in the Source pane, select either "Left" or "Right", depending on 
which channel you want this copy of MMTTY to decode  

o Close the Setup dialog  

o Close the 'Digital Interface' to have the Logger and MMTTY save the settings  



Sound Card Selection in Windows 7 

In earlier versions of Windows, selecting the sound card was relatively straightforward. Windows 
assigned a number (or two numbers, one for recording=receiving and one for playback=transmitting) 
to each sound card device when it was installed, and that number could usually be relied upon not to 
change. Once you had selected the desired sound card in MMTTY, you were finished with the sound 
card configuration. 

Starting with Vista and continuing in Windows 7, Windows has made life for sound card users more 
complicated. The list now enumerates each active input or output as a separate device. The list of 

active inputs or outputs can change dynamically. Plugging or unplugging a cable into one of the jacks 
on a sound card can create or delete a new entry on the list. Windows power management can turn a 
USB port off if it has not detected any activity on that USB port for some time, causing any inputs or 
outputs on a USB sound card on that port to be removed from the list. When the computer is restarted 
or reawakened after hibernating or sleeping, the list may be reconstructed and if there have been 
changes since the last restart, the order of devices on the list may change. If you are using a radio 

with a built-in USB codec, turning the radio on or off will add or remove that codec to/from the list. If 
any of these changes in the list results in a different number being assigned to a device you are using 
in MMTTY, that device will appear to stop working and you will have to readjust the sound card 
configuration in MMTTY. 

If this happens to you, the way to avoid it is as follows: Immediately before the contest, make sure 
that every sound card or codec that you plan to use during the period of the contest is turned on and 
stays on for the duration. Verify your sound card configuration immediately before the contest and 
then avoid doing anything during the contest that might result in a change to the list. Disable power 
management features that might result in a USB port you are using being shut off by Windows. If you 

are using the USB codec inside a radio, always turn on the radio before opening the DI window, and 
close the DI window before turning off the radio; preferably, don't turn the radio off during the 
contest. Fortunately not all of these precautions will be necessary in every case, but you should be 
aware of the possibility just in case. 

One other wrinkle introduced in newer versions of Windows is that with some sound cards, the default 
for the sound card input in the Windows Control Panel may have been set to single channel (mono) 
instead of two channels (stereo). If you are planning to use both channels of a stereo sound card to 
decode signals from two receivers (SO2V) or two radios (SO2R), you may need to verify that the 
default recording format for that sound card input is set to two channels. 

3. Testing MMTTY 

MMTTY is also a stand alone application. So testing can be done outside N1MM logger.  

4. Dual Receiver/Dual Radio Setup 

In a dual-receiver setup (SO2R or SO2V), you may wish to be able to copy two separate RTTY signals 

(e.g. on two separate bands or two separate frequencies) simultaneously. To do this, you would open 

two Entry windows (VFO A/Radio 1 and VFO B/Radio 2) and open the Digital Interface window from 
each Entry window. You can then run MMTTY (or other digital interface engine, such as 2Tone) from 
each of these DI windows.  

The two audio streams from the two receivers can either be decoded by two separate sound cards, or 
in a single stereo (two-channel) sound card using the left and right channels for the two receivers. In 
either of these situations, the two copies of MMTTY must have different configurations; in particular, 
each one must be configured to use a different channel of the sound card, or a different sound card. In 
the case of a dual radio setup, if you are using FSK on both radios and/or if MMTTY is used to control 

PTT on both radios, each copy of MMTTY would also have to have access to its own serial port for PTT 



& FSK. This is also true in SO2V setups in order to enable transmitting from either VFO; even though 

there is only one FSK keying input to the radio in SO2V, the two DI windows need two separate serial 
ports for FSK keying, both connected to the same keying input on the radio.  

These serial ports are configured in two places: in the Logger's Configurer and in MMTTY. In the 
Configurer, you indicate which serial ports are used with check marks in the Digital column (Note: in 
order to check two Digital mode ports in the Configurer, you must be in SO2V or SO2R mode). You 

must also click on the Set button for each port in the Configurer and set the Dig Wnd Nr to 1 or 2, to 
indicate which of the two DI windows that serial port will be associated with. You must also set up 
each copy of MMTTY to use its respective serial port by choosing the relevant serial port in the PTT & 
FSK Port box under the TX tab in the MMTTY Setup window.  

If the two copies of MMTTY are to use different channels of the same sound card, each copy must be 
configured to use its respective channel on the sound card under the Misc tab in the MMTTY Setup 
window; or, if they are using different sound cards, each copy must be configured to use its own 
sound card under the SoundCard tab.  

In order to support separate configurations for the two copies of MMTTY, each copy must be located in 
a separate folder. You can either use the main MMTTY program folder for one copy and a separate 
subfolder for the other copy, or you can create two subfolders for use by the Logger, leaving the copy 

in the main MMTTY program folder for stand-alone use. These subfolders must each contain, at a 
minimum, a copy of the MMTTY.exe file and the UserPara.ini file from the main MMTTY program folder. 
A copy of MMTTY.ini will be created the first time MMTTY is run from the folder if it was not previously 
present. If you are using the EXTFSK plugin, you will need a copy of the extfsk.dll file in the folder as 
well. Other files from the main MMTTY program folder may also be copied to the subfolders, but they 
are not used.  

The Logger's DI windows have an additional RX window feature as well. Up to four additional RX-only 
windows can be invoked from the Setup menus in the two DI windows. These additional windows can 
be distributed in any way between the two DI windows. They can use either hardware decoders, 

MMTTY or 2Tone, but the most common use is for separate copies of MMTTY or 2Tone using different 
decoding algorithms or profiles on the same data stream. Because they are receive-only, these 

windows do not need access to serial ports and are not configured in the Configurer. However, to be 
fully useful, although they most likely will share the same sound card and channel with their parent DI 
window, they do need to have separate setups from the main copy of MMTTY (e.g. to use a different 
decoding algorithm or profile). Therefore, if you wish to use these additional RX-only windows with 
MMTTY, you will need to create additional folders, one for each additional window, containing copies of 

the MMTTY.exe, MMTTY.ini and UserPara.ini files (or if your are using 2Tone in stead of MMTTY, the 
2Tone.exe, MMTTY.ini and 2Tone.ini files). These additional folders do not have to be created at the 
time you first install MMTTY; you don't need to do this until you are ready to use the additional RX 
windows.  

5. Using MMTTY 

 The macros for the Interface using MMTTY are different from the way they work with the TNC . 
What ever you put in the macro will get transmitted. There is a macro keyword needed to turn 

TX ON {TX} or TX OFF {RX}.  

 There is no special abort macro needed for use with MMTTY just using the ESC key will stop 
transmitting.  

 The TX and RX buttons are for the free form typing in the TX window.  

 When MMTTY loads it loads the last used settings when the Interface was closed.  

5.1. How to Tune RTTY 

 Use the VFO on your radio and dial in the peaks to match the 2 yellow lines on the spectrum  

 Click view and the X-Y scope to see a crossed-ellipses tuning display  



o If the X-Y display seems to rotate in the wrong direction, open the MMTTY Option > 

Setup window (or the DI's Setup > Setup MMTTY menu item), select the Font/Window 
tab and check (or uncheck) the Reverse rotation button  

 Make sure you click the "HAM" button for proper shift etc.  

o The default values for the HAM setting can be changed under the Demodulator tab in 
the MMTTY Option > Setup window  

 It's better to set AFC off when you are in a crowded section of the band and manually tune the 

signals; if you leave AFC on, nearby strong signals may pull the tuning away from the signal 
you want to copy  

 Also in crowded sections it can be helpful to use the built-in notch and bandpass filters  

 If you are using AFSK, normally you would use LSB on the radio  
o If you use USB, make sure you click the "Rev." button in MMTTY  

 If you are using FSK, you need to be aware that NET does not work, and that tuning in a 

received signal by clicking in the waterfall or by allowing AFC to tune in the signal will result in 
your receive frequency being different from the transmit frequency. The "HAM" button will 
restore the correct audio frequency in your receive decoder but without retuning the radio. 

The "Align" button in the DI window can be used to retune your radio so that the received 
signal is lined up with your radio's transmit frequency  

 
Periodically you may get a lost sound indication in the MMTTY window and the program may quit 
responding to RTTY.  

 This should never happen but if it does, try increasing the priority with which MMTTY runs 

from its default "high" to "highest". This is one step below the maximum "critical". This setting 
is in MMTTY under Options, Setup MMTTY and the MISC tab..... Another effect this has is to 
make the transition from RX-TX-RX smoother.  

5.2. When Should I Use AFC? 

 Use AFC (automatic frequency control) when MMTTY should automatically track the incoming 

RTTY signal.  

 With AFC and NET turned on, MMTTY will track the incoming signal and also keep your 
transmitter frequency locked to the received signal when using AFSK.  

 
When MMTTY is set to transmit FSK, AFC will work on receive only. When in "Running" mode, you 
want to keep your TX frequency stable, but with RX AFC set on you can pick up stations who reply a 
bit off your frequency and copy the exchange without losing your TX spot. Just don't let the AFC 
spread get too far from where you're transmitting.  

 A nice option to use is: AFC On/Off with CQ - If set then the AFC will turn on with CQ message 

or TU messages. This way when Running the AFC is on and during S&P the AFC is off. Check 
it.  

5.3. When Should I Use the NET Option: NET On/Off with Run Change 

 
NET only operates in AFSK. If you are using FSK, your transmit frequency is fixed by your transmitter, 
and the NET software feature does not work.  

 When in 'Search and Pounce' mode the program will check the NET option so that once you 
tune a signal in, you will transmit on the same frequency you are receving him on (Warning: 

this doesn't work in FSK)  



 When in 'Running' mode the program will uncheck the NET option, which allows your receive 

decoder to follow an off-frequency caller while still leaving your transmit frequency unchanged  

5.4. Why to Use "Auto Update TRX Offset w/Mark Freq." 

 
If you are using FSK RTTY, most radios display the actual mark frequency on the tuning dial. A few 

even do this in AFSK RTTY. If your radio is like this, you don't need to use this option. The DI window 
title bar will display an offset frequency (radio dial (+/-) audio), but if this option is turned off the 
offset frequency will not be logged and you can ignore it.  

If you are using AFSK RTTY, especially with the radio in LSB or USB mode, as well as when you are 
doing a sound card digital mode like PSK (using MMVARI or Fldigi), the radio probably displays the 
suppressed carrier frequency on its dial. This is different from the mark frequency. If you are using the 
default mark frequency of 2125 Hz, the radio's dial display will be 2125 Hz too high (LSB) or too low 
(USB) as compared with the actual mark frequency. By checking this option, N1MM Logger will 

perform the correction automatically and display the actual mark frequency in the Entry window and 
the Bandmap window, as well as in the DI window title bar.  

5.5. Using MMTTY for 75 baud RTTY 

 

There are some RTTY contests that specify 75 baud (100 wpm) RTTY instead of the usual 45.45 baud 
(60 wpm) speed. MMTTY can be used for 75 baud RTTY, but there are a few quirks:  

 If you use EXTFSK for FSK keying (e.g. via a standard USB-to-serial adapter), you will not be 

able to use this combination for 75 baud. EXTFSK does not support 75 baud. Instead, you 
must reconfigure for AFSK  

 In the MMTTY Setup window, select the Decode tab, and at the top of the window, for 

BaudRate select 75  

 If you are using MMTTY version 1.68 or newer, in the MMTTY Setup window under the 

Demodulator tab, in the section labelled HAM Default, UNcheck the "Fixes 45.45 baud" check 
box  

 If you are using an older version of MMTTY, you will need to be aware of the following:  
o The pre-version 1.68 MMTTY HAM Default button cannot be used in 75 baud RTTY; if 

you press HAM, the speed will be reset to 45.45 baud. Besides not pressing the HAM 

button in the MMTTY window, there are a couple of other setup items you need to take 
care of:  

 In the DI Setup window, under the General/MMTTY Setup tab, make sure the 
following item is NOT checked:  

 (MMTTY)Send HamDefault on Run to S&P Change (if you forget 
to uncheck this item, you will be switched back to 45.45 baud every 

time you switch from Run to S&P)  
 If you are using FSK with a true serial port or with an interface that supports 

FSK without using EXTFSK (e.g. a microHAM microKeyer), turn AFC off in the 
MMTTY window, and make sure the following item in the DI Setup window is 

NOT checked:  
 (MMTTY - MMVARI)Turn AFC On/Off on Run Change (if you 

forget to uncheck this item, AFC will pull your receive frequency off 

your transmit frequency and you will be unable to use the HAM button 
to correct the situation)  

 In the DI Window's Setup menu, UNcheck AFC On/Off with CQ 
(same reason)  

 If you are using AFSK and like to use AFC, you may continue to do so, 
provided you are careful to ensure that your transmit and receive frequencies 
stay together. The HAM button is not available to re-align your transmit and 



receive frequencies. Therefore if you are using AFC, you should have NET on 

as well, to keep your transmit and receive frequencies together. (Note: NET 
does not work in FSK)  

 After the 75 baud contest is over, be sure to restore the 45.45 baud speed and any of the 
other configuration options you changed for 75 baud, in order to restore normal functioning  

 

2.7.5 MMVARI for PSK and Other Modes 

 2.7.5 MMVARI for PSK and Other Modes  
o 1. The MMVARI Interface  

 1.1. The MMVARI Interface Window  
 1.2. The Waterfall or Spectrum Window  
 1.3. Macros  

o 2. Setting Up the Digital Interface  
o 3. MMVARI Example: Make a PSK Transmission  
o 4. MMVARI - Other  

1. The MMVARI Interface 

The MMVARI soundcard interface is based on the MMVARI engine by Makoto Mori, JE3HHT.  

All modes from the MMVARI engine are supported including bpsk (e.g. PSK31 and PSK63), qpsk-L 
(LSB), qpsk-U (USB - e.g. QPSK63), also RTTY-L (LSB), RTTY-U (USB), MFSK-L (LSB) and MFSK-U 
(USB) as well as non-standard modes GMSK (HF), FSK (V/UHF), FSK-W (V/UHF, satellite). The -L and 
-U variants of some of these modes are there to allow you to choose which sideband you use on the 

radio. In other words, you are not restricted to using LSB for RTTY and USB for other digital modes; 
you can choose to use either USB or LSB on the radio, and if you have chosen the correct mode 
variant in MMVARI, it will adjust the audio tones it uses to correspond to the sideband you have 
chosen.  

RTTY 

In Logger versions before 10.9.5, MMVARI supported RTTY using AFSK keying only. As of version 
10.9.5, MMVARI is now capable of using FSK keying for RTTY (selected from the Configurer under the 
Digital Modes tab). Note, however, that the "FSK" mode in the MMVARI mode box is an entirely 

different mode - it is not FSK RTTY. 

 

The MMVARI engine does not have to be installed separately, it is included in the N1MM logger 
program program/update files and is the default digital engine when loading the digital window for the 
first time.  

1.1. The MMVARI Interface Window 



 

The Digital Interface window when using the MMVARI engine is broken into several areas which will be 
covered from the top down.  

 TX - Indicator to show which DI window the transmit is going to take place from (useful when 
using two DI windows for SO2R/SO2V)  

 Letters/Figs - Shows the text under the mouse in the other case (FIGS/LTRS - RTTY only)  

 MouseOver - Shows the text which would be selected where the mouse is positioned over  

 Receive Windows - The MMVARI engine supports from 1 to 4 receive windows. The number 

of receive windows is selected from the DI window's Setup > Settings menu item in the Digital 
Settings window under the MMVARI Setup tab at the lower right corner (# of MMVARI 
Channels). All of these windows operate in the same manner and you are able to grab 
callsigns from any of them and place them into the Entry window. Note that when the # of 
MMVARI Channels is set to 1, a different method of multiple RX channels becomes available 
(see The Waterfall or Spectrum Window below)  

 
There is a colored pane on the left side of each receive window. By clicking on the colored pane you 
can pause input to the receive window to scroll back through the (last 2000 lines of) text using the 

scroll bars. When the window is paused the color of the pane will turn Yellow. To turn input to the 
window back on click in the pane again and everything that was to be printed to the window will now 
enter the window. When the receive window is paused it is possible to copy text in the window.  

If you click on a callsign using your mouse it will be put into the callsign field in the Entry window.  
Also, whenever a callsign is printed to any of the receive windows followed by a space it will be sent to 
the callsign grab window for easy movement to the logging window by clicking the Grab button.  



You can select any exchange info by single clicking on the sent info. This info will be transfered over to 
the logger Entry window item by item after the callsign is filled in.  

The top receive pane is the window used for making QSOs. Selecting another frequency for this 
window is done by left clicking in the Waterfall or Spectrum window. Changing the frequency of the 
other three receive windows is done by moving the numbered marker above the waterfall to the 
desired location. You can also use the Swap buttons in the lower part of the Waterfall window to 
exchange the selected window with the top receive window.  

 Transmit window - This is a free form typing window. If you click on the TX button the 

cursor will be placed into this window and whatever is typed will be sent. The size of this 
window is fixed at 2 lines  

 Callsign Textbox and Grab - When a callsign is encountered in one of the receive windows 

(followed by a space) it will be placed in this textbox and when you press the Grab button it 
will transfer the callsign over to the main logger window. The grab callsign window holds the 
last 10 callsigns seen in the RX window. The most current one is at the top and is highlighted. 

A right click in this box brings up a menu to clear list or selected callsign. Dupe callsigns will 
not be shown in the grab window  

 
Note: If the callsign in the callsign field in the Entry window is the same as the callsign in the received 
text, the call in the Entry window does not get placed into the call list.  

 Clr RX - Clear all receive windows  

 TX - Places the interface into transmit, the transceiver is keyed, and places the cursor into the 
TX window for input. See the Radio Interfacing section for Parallel and Serial port info on 
configuring for hardware PTT  

 RX - This will place the interface back into receive mode after all the characters in the 
transmit buffer have been sent. To abort transmit immediately without waiting for remaining 
characters to be sent, press the Esc key  

 Macro buttons - These buttons on the Digital Interface are up to 24 extra Macros for 

preprogrammed messages. Configuring these macros is done in the Digital Interface window 
under 'Setup, Settings' or by right clicking on them which brings up the Digital Setup window. 
The macro buttons widths dynamically adjusts in relation to the width of the DI window  

 Grab - Transfer the selected callsign in the callsign text box to the callsign field on the main 

logger window. The cursor advances to the exchange box ready to accept the exchange when 
you click on it  

 CLR - Clears the grab window  

1.2. The Waterfall or Spectrum Window 



 

The MMVARI digital engine window - This window uses the MMVARI control from Makoto Mori, 
JE3HHT. Across the top the title bar shows either the offset frequency (radio (+/-) audio) or the 
radio's dial frequency, depending on a setup option. As you tune your radio this will update and the 
numbers will change.  

The screen shot here shows the window with four receive channels selected in the Digital Setup. There 
are cursors corresponding to each of the receive windows. The inverted triangle cursor, filled in in light 
blue, is for the main receive window. If NET is on, this is also your transmit frequency. If NET is off, 
there will be another inverted triangle filled in in dark blue indicating your transmit frequency. If you 

have more than one receive window enabled, a cursor with a number in it (1, 2, ...) corresponds to 

each additional receive window. To change frequency for the main receive window you can place your 
mouse pointer over a signal trace and click with your left mouse button. To change frequency for one 
of the other receive windows, you can click on the numbered cursor and drag it to the desired location 
in the waterfall.  

TX Frequency and NET in FSK RTTY 

Note that if you are using FSK keying in RTTY, MMVARI has no control over your transmit frequency. 
Your transmit frequency in FSK RTTY is fixed by the radio. Therefore, moving the dark blue transmit 
indicator does not change your actual transmit frequency in FSK RTTY. Likewise, the NET function is 

inoperative in FSK RTTY. 

 Buttons above the waterfall  
o TX - Start the transmission, the transceiver is keyed and places the cursor into the TX 

window for input. See the Radio Interfacing section for Parallel and Serial port info for 

TX/RX switching (PTT)  

o RX - Stops the transmission, the transceiver changes back to receive after all the 
characters in the transmit buffer have been sent. To abort immediately, press the Esc 
key  

o AFC - Turns AFC on or off. Selected (white) means AFC on (Note: This button is 
greyed out and disabled when the Multi-Channel RX browser feature is enabled)  

o NET - Turns NET on or off. Selected (white) means NET on. When NET is on the TX 

frequency follows the RX frequency (this function is inoperative in FSK RTTY)  
o Align - This is used to move the signal under the receive indicator to the Alignment 

Frequency set up in the Digital Setup window. This can be used in most sound card 



modes to center the received signal in your filter bandpass, and in FSK RTTY it is used 
to align the received signal with your transmitter's signal  

 
Example: Suppose the center of the filter pass band is 2200 Hz. When clicking on a signal at about 
1400 Hz the signal may be difficult to copy unless you are using wide filters. To move the signal to the 
center of your filter bandpass, click Align and the rig shifts and the spectrum frequency shifts and 

places the station on the frequency that was initialized in the Digital Setup window in the Alignment 
Frequency area. This allows you to narrow your filter bandwidth around the selected signal. If you are 
using FSK keying for RTTY and if your receive frequency is not exactly on the center frequency of your 
radio's mark/space tone pair (e.g. 2210 Hz for the standard 2125/2295 "high" tone pair), then you 
can use the Align button to retune your radio so your receive and transmit frequencies will be aligned 
correctly.  

o Mode selection - Select the mode to use by clicking on this button. The Speed 
selections are mode dependent. Selections are:  

 GMSK - MBCS experiment (HF) - Possible speed selections: 31.25, 62.5, 

125, 250  
 not used for contests  

 FSK - MBCS experiment (V/UHF) - Possible speed selections: 31.25, 62.5, 
125, 250  

 not used for contests  
 Do not confuse this mode with FSK RTTY - MMVARI's "FSK" mode is 

not FSK RTTY. Starting with Logger version 10.9.5, MMVARI does 

support FSK RTTY, but this can only be selected from the Configurer, 
not from the MMVARI window  

 FSK-W - MBCS experiment (V/UHF, satellite) - Possible speed selections: 
31.25, 62.5, 125, 250  

 not used for contests  
 BPSK - MBCS experiment (HF) - Possible speed selections: 31.25, 62.5, 125, 

250  
 for contesting purposes, BPSK and bpsk are equivalent  

 bpsk - Standard BPSK (e.g. PSK31) - Possible speed selections: 31.25, 62.5, 
125, 250  

 rtty-L - BAUDOT RTTY (LSB) - Possible speed selections: 45.45, 50, 56, 75, 
100, 110, 150, 200  

 rtty-U - BAUDOT RTTY (USB) - Possible speed selections: 45.45, 50, 56, 75, 

100, 110, 150, 200  
 You may choose either AFSK or FSK keying method for RTTY in the 

Configurer under the Digital Modes tab  
 mfsk-L - MFSK (LSB) - Possible speed selections: 15.625, 31.25  
 mfsk-U - MFSK (USB) - Possible speed selections: 15.625, 31.25  
 qpsk-L - QPSK (LSB) - Possible speed selections: 31.25, 62.5, 125, 250  
 qpsk-U - QPSK (USB) (e.g. QPSK63)- Possible speed selections: 31.25, 62.5, 

125, 250  
o Speed selection - Select the speed to use in bps by clicking on this button. The 

speed to select is mode dependent as described above  
o Main Channel receive frequency - audio frequency  

 In RTTY, MMVARI displays the center frequency, not the mark frequency as 
displayed in MMTTY  

o Main Channel transmit frequency - audio frequency  
o Main Channel S/N reading  

 The Waterfall  

o At the top of the waterfall offset frequency (radio (+/-) audio) labels and tick marks 
are displayed  

o Receive channel markers  
 Top markers (tag cursors)  



 1,2,... - frequency receive channel 1,2,...  

 N - indicates a notch filter  
 The light blue colored marker (inverted triangle on the waterfall) indicates the 

main RX frequency  

 The dark blue colored marker (waterfall) indicates the TX frequency if it is 
different from the main RX frequency (only possible if NET is off)  

 Mouse key clicking  
o Left mouse key clicking - single clicking in the waterfall will change the main RX 

frequency  
o Right mouse key clicking - the audio frequency at the point clicked on will be 

shown. Also a menu will show:  
 Set notch on here - adds a new notch filter on the selected frequency 

indicated by a N in a yellow area. Multiple notches can be set; you can clear an 
individual notch by right-clicking on the N  

 Delete all notches - all set notches will be removed  

 Set TX Carrier on here - can be used to set the TX frequency (with NET off)  
 Turn Off Bandpass Filter - Turns the BPF off  

 RX 1 (2,3) Freq Here - can be used to set the RX 1, 2, or 3 frequency here 
(only if the # of MMVARI Channels is greater than 1)  

 
The left vertical indicator shows the signal level meter (green) and the squelch level (yellow line). Biy 
clicking on it the squelch level can be changed.  

 Receive channels below the waterfall  

o If you have chosen to use more than one MMVARI channel, below the waterfall the 
additional receive channels will be shown. The number of additional channels below 
the main waterfall is one less than the total number of MMVARI Channels set, i.e. 
there can be up to three additional channels (up to four MMVARI channels in total - to 
display more than four channels, see the Multi-Channel RX feature below)  

o Mode - Select the mode to use for this receive channel  
o Speed - Select the speed to use for this receive channel  

o Receive channel frequency  
o Receive channel S/N value  
o AFC - Turns AFC on or off for the selected channel. Selected (white) means AFC on  
o Squelch indicator - The squelch can be adjusted by dragging the line indicator to 

where you want it and turning off the squelch by dragging it all the way left  
o Miniature waterfall display - shows within 500 hz of the signal that that channel is 

on. You can click anyplace in this miniature waterfall or drag the indicator to where 

you want it  
o Swap - Exchanges this receive window with the main receive window. While working 

one station, you can dial the second station in via a second receive window and after 
you finish the first contact just hit swap button and then call the other station. See 
below for an alternative method of multi-channel receive  

 Menu at the Top  

o BPF - Used to enable/disable an internal audio Band Pass Filter. The BPF filter has 

steep skirts and 80db of rejection outside the bandpass. However, because it is in the 
sound card and not in the radio, it has no effect on unwanted signals inside the radio, 
i.e. a strong unwanted signal inside the radio's IF filter bandpass can still trigger the 
radio's AGC and cause gain blocking, even though the signal has been rejected in the 
sound card by the BPF. You can only prevent this by selecting narrow filters in your 
radio  

 Enable/Disable BPF - turns BPF on or off  
 Wide 1000 Hz, Middle 500 Hz, Narrow 250 Hz, Ultra Narrow 100 Hz, 

Custom - filter bandwidth settings (grayed out when the BPF is disabled)  
 To set Custom width after enabling the BPF, left click in the waterfall 

where you want the BPF bandpass to start. Drag your mouse with the 



left button held down and release it where you want the BPF bandpass 

to end. The waterfall display will immediately relect the chosen 
Bandpass. This makes it simple to eliminate an offending station on 
the fly  

 The minimum width of the BPF that can be set is 100 Hz  
 The BPF can be turned off by selecting Disable BPF on the BPF menu or by 

right-clicking in the waterfall and selecting Turn off bandpass filter  
 The BPF settings are retained when you close and reopen the digital engine 

window  
o ATC - Used to turn Automatic Timing Control (ATC) on or off. It is recommended to 

keep ATC on all the time for better signal decoding  

 when RTTY is selected ATC is always off  
 in MFSK mode ATC is always on  

o FFT - FFT is Fast Fourier Transform, which is a method of extracting the spectrum out 
of a waveform. That is the basic tool that gives the waterfall and spectrum scope 
displays  

 FFT Type - Select the FFT display method. Selections are: Spectrum, 

Waterfall, Sync or Wave Input  
 FFT Width - Select the display width (frequency range). Selections are: 250 

Hz, 500 Hz, 1000 Hz, 2000 Hz, 3000 Hz or User Defined. User Defined width is 
set in the Digital Setup window  

 FFT Scale - Select the vertical scale to use. Selections are: 100 dB, 60 dB, 
Square Amplitude  

 Waterfall AGC - Turn the waterfall AGC on or off  

 Align after Left Click - Automates the Align process. Any time a signal is 
clicked on in the waterfall, an automatic Align operation is performed to re-
center the audio frequency on the Alignment Frequency you have selected in 
the Digital Setup window  

o SHIFT - Shift selections. The choices are 170 Hz, 200 Hz, 23 Hz or User Defined  
 Only in RTTY-L, RTTY-U and GMSK  

o RTTY Demodulator - select either IIR or FFT decoder. Depending on conditions, one 

may decode better than the other  
 Only in RTTY-L and RTTY-U  

 

 

o Multi-Channel Rx - This feature is only available when the # of MMVARI 

Channels in the Digital Setup window under the MMVARI Setup tab is set to 1. 
It is an alternative method of receiving multiple signals simultaneously with 
MMVARI  

 Open (or Close) Multi Channel Browser - turns this feature on or off  
 When the Multi-Channel RX feature is turned on, there will be several 

numbered tag cursors at the top of the waterfall, and a separate 



browser window will open (see below). The number of channels is 

user-selectable (from 2 to 24)  
 Each line in the browser window shows text decoded under the 

corresponding numbered cursor  

 There is only one RX pane in the Digital Interface window, which 
displays text from the main RX signal under the light blue inverted 
triangle cursor  

 You can move the main RX cursor to the position of any of the 
numbered tag cursors simply by clicking in the corresponding small 
text window  

 You can use this feature to keep track of several separate signals 

being received. You can work each one in turn by clicking in the 
corresponding numbered text window to move the main RX/TX 
frequency (with NET on) to each numbered cursor position in turn (if 
NET is off, or you are using FSK RTTY, clicking in the text window only 
moves the RX frequency but not the TX frequency)  

 Set Number of RX Channels - you can select from 2 to 24 channels to 

display in the browser window  
 Set AFC Search Level - Used to set the signal level (S/N ratio) used to 

determine whether a signal is strong enough to activate the AFC and cause the 
RX frequency to move to it (can be set from 1 to 20 dB)  

 Set AFC Search Range - Each extra RX channel has AFC (automatic 
frequency control) which moves the cursor to keep it centered on a signal if 
the frequency changes slightly. This menu item is used to set the frequency 

range over which this feature operates (can be set from 100 to 500 Hz)  
 Set Spectrum Search Frequencies - Allows you to set the lower and upper 

limits for the browser channels. The lower limit can be 250 Hz or higher, and 
the upper limit can be 2700 Hz or lower  

 Turn Channel Markers On - If unchecked, channel markers will not be 
displayed  

 Show Audio Frequency Only - if checked, audio frequencies will be 
displayed instead of RF frequencies  

 

The Multi-Channel RX method allows you to keep track of more channels (max 24) than the older # of 
MMVARI Channels method (max 4) that you set up from the Digital Setup window. The memory for 
each channel is limited to 80 characters. You can click on callsigns in the callsign column of the 
browser window in order to transfer them to the Entry window, or in Dxpedition mode (see below), 
you can click on a callsign in the browser window in either the decoded stream or the callsign column 
to: move the RX cursor (and if NET is on, the TX cursor) to that channel, transfer the callsign to the 

Entry window, and transfer the last 80 characters decoded in that channel into the main RX window. 
All channels in the browser in this method will be in the same mode. In RTTY, clicking on the channel 
marker for a channel switches between normal and reverse decoding in that channel. (For another 
way to do multiple receive in PSK only, you can also try the PSK Browser in Fldigi). 
 
 
 



 
 
Browser window in multi-channel RX (older version)  

 Setup menu  
o Set On Top - check this if you want to ensure that the browser window is always on 

top of other windows  

o Set AFC Width - set the frequency range for AFC in each browser channel  
o Set AFC Level - set the signal level that activates AFC  
o Set Squelch Level - set the squelch level in the browser  
o Set Chennal Background Color - set the background color for the text in the 

browser window  

o Set Channel Text Color - set the color for text in the browser window  
o Set Channel Highlight Color - set the color for the highlighted channel  
o Dxpedition mode - turns Dxpedition mode on or off  



 With Dxpedition mode off, clicking on a channel in the browser moves the 

main RX cursor to the frequency of that channel. If NET is on, the TX cursor 
also moves to the same frequency  

 With Dxpedition mode on and NET off, clicking on a callsign in either the text 

stream or the callsign box in a browser channel:  
 Moves the main RX cursor to the frequency of that channel, leaving 

the TX cursor where it was  
 Transfers the last 80 characters from that channel into the main RX 

window  
 Transfers the callsign into the Entry window  
 Can be used in a Dxpedition situation where your TX frequency is fixed 

and you want to work stations anywhere in your receive range  
 With Dxpedition mode on and NET on (this is not possible in FSK RTTY), 

clicking on a callsign in either the text stream or the callsign box in a browser 
channel:  

 Moves the main RX and TX cursors to the frequency of that channel  
 Transfers the last 80 characters from that channel into the main RX 

window  
 Transfers the callsign into the Entry window  
 Can be used for normal S&P operating. After switching to the 

frequency of the selected channel, you can click on the Align button to 
center that channel in your receiver's filter bandpass  

 CLEAR menu - clears the browser window  

1.3. Macros 

 The macros for the Interface using MMVARI are different from the way they work with the TNC 

. What ever you put in the macro will get transmitted. There is a macro keyword needed to 
turn TX ON {TX} or TX OFF {RX}  

 There is no special abort macro needed for use with MMVARI just using the ESC key will stop 

transmitting  

 The TX and RX buttons are for the free form typing in the TX window  

 When MMVARI loads, it loads the last used settings when the Interface was closed  

2. Setting Up the Digital Interface 

The setup dialog is for both MMTTY and MMVARI, this means that some settings are only for MMVARI, 
MMTTY or both. When selecting 'Setup | Settings' in the Digital Interface window a dialog wil be shown 
which is both for MMTTY and MMVARI. Please check the setup information in the Digital 
Setupchapter.  

3. MMVARI Example: Make a PSK Transmission 

 We need to make room for the Digital Interface so for now minimize the Logger Telnet/Packet 

window  

 Now select 'Window | Digital Interface' and the Digital Interface and the Waterfall/Spectrum 

window will open. The Digital Interface dialog can be positioned and resized on your monitor 
as desired  

 Left clicking on a call will grab the callsign. Right clicking on the RX and TX window will pop a 
menu (S&P mode) or send the Exchange function key in Running mode  

 Pressing Insert will Grab the highlighted call and sends His call followed by the Exchange 

button  

 Double clicking on a callsign in the callsign box from the Digital Interface sends that call to the 
Entry window  

http://n1mm.hamdocs.com/tiki-index.php?page=Digital+Setup#N1MM_Logger_Manual
http://n1mm.hamdocs.com/tiki-index.php?page=Digital+Setup#N1MM_Logger_Manual


 A callsign is automatically highlighted if recognized by the program. For that to happen it 

needs to have a space before and a space after the callsign. If the first thing on a new line in 
the Digital Interface window is a valid callsign, it is not highlighted or added to the grab list  

4. MMVARI - Other 

 The Radio Frequency display on the Waterfall and Spectrum display follows the active Radio 
Frequency  

 The last PSK mode used is remembered, so the next time the last used mode is selected.  

 Getting (PSK) object errors during program start or starting PSK?  

 During transmit, callsigns are not grabbed from the receive window.  

 

2.7.6 Digital - Fldigi for Sound Card Modes 

 2.7.6 Digital - Fldigi for Sound Card Modes  
o 1. The Fldigi interface  
o 2. Download and Configure Fldigi  

 2.1. Download Fldigi  

 2.2. Fldigi Initial Configuration  
o 3. The Fldigi Interface Window  

1. The Fldigi interface 

The Fldigi sound card interface is based on the fldigi code by Dave Freese, W1HKJ.  

Fldigi supports a wide variety of digital modes, including not only AFSK RTTY and PSK, but also other 
less common modes such as MFSK, MT63, Olivia, Throb, etc.  

Fldigi is a stand alone application, so you can also use it separately from N1MM Logger. Note that the 

configurations for Fldigi stand-alone and within the Logger are separate, i.e. changes made to the 
stand-alone configuration will not be applied to the configuration within the Logger, and vice versa.  

Fldigi does not support keying outputs on serial or parallel ports, as used by N1MM Logger for CW and 

FSK keying. Fldigi can be used from the Logger for AFSK RTTY or for PSK31 or other digital modes, 
but not for transmitting RTTY using FSK. It can also be used as a CW receive-only decoder with the DI 
window open. For sending CW, use one of the CW interfacing methods detailed in the "Basic 
Interfacing - Radio, CW, PTT" chapter. You must not check the Digital check box on a port that will be 
used for CW keying while the DI window is open.  

2. Download and Configure Fldigi 

2.1. Download Fldigi 

 Download the current release of Fldigi from the W1HKJ website at http://www.w1hkj.com/

 . You can find a copy of the full installer for the current version of Fldigi at that website. 
This file is a self-extracting executable, similar to the N1MM Logger installer. Download the 
installer file to a temporary folder and then execute it. It is recommended that you install 
Fldigi in its own program folder and not in the N1MM Logger program folder. By default, the 
installer will install Fldigi to C:\Program Files\Fldigi-x.xx.xx\, where x.xx.xx is the Fldigi 
version number. If you are using Windows Vista, 7 or 8, do not accept the default; instead, 
install the program outside the Program Files (or Program Files(x86)) folder.  

http://www.w1hkj.com/
http://www.w1hkj.com/


2.2. Fldigi Initial Configuration 

After Fldigi has been downloaded and installed, open the Configurer and set up the path to Fldigi 
under the Digital Modes tab. After closing the Configurer, choose a contest in N1MM Logger that 
supports digital modes, select the Logger's Window > Digital Interface menu item, and then in the 
Digital Interface window, select the Interface > Fldigi menu item.  

When you first open the Fldigi interface from the Logger, and also any time you install a new version 
of Fldigi, you will be prompted to fill in some configuration information by the Fldigi configuration 
wizard, as follows:  

 Operator information - You do not need to fill in any of this information; N1MM Logger 

handles logging and all related information  

 Audio devices - Under the Devices tab, check the PortAudio box and select the sound card 

input and output you are using for Capture and Playback. Click Next  

 Transceiver control - Select the XML-RPC tab, check the Use XML-RPC Program box, and 

click the Initialize button. Do NOT select RigCAT, Hamlib, or MemMap for rig control; none of 
those will work with N1MM Logger  

 You can let N1MM Logger handle PTT, in which case you do not need to configure PTT in Fldigi. 
However, if you do not use PTT in other modes and you want to use hardware PTT controlled 
by the digital interface (e.g. Fldigi), you can select the Hardware PTT tab, check the Use 
separate serial port PTT checkbox, select the appropriate COM port in the Device: window, 
and check either Use RTS or Use DTR, depending on which one your hardware setup uses. If 

the label on the Initialize button is red, click on the button. Note that a COM port that is used 
by Fldigi cannot be used simultaneously by the Logger for other purposes. Check the Digital 
check box beside the COM port in the Configurer to ensure that the Logger will not try to use 
this port while the Digital Interface is open  

o If you intend to use Fldigi as a receive-only CW decoder, you cannot control PTT from 
Fldigi on the same port that N1MM Logger uses for CW keying; do not check the 

Digital check box beside this port, and do not configure it within Fldigi as a PTT port  

 Click Finish  

 
The Fldigi configuration wizard does not automatically save its settings. After you have exited the 
configuration wizard and the main Fldigi interface window has opened, you must save the 
configuration settings using the Fldigi Configure > Save Config menu item. If you don't do this, then 
every time you open the Fldigi window you will have to go through the configuration wizard steps 

again. Similarly, any time you make a subsequent change to the Fldigi configuration you must 
explicitly save the new configuration if you want the change to be remembered.  

3. The Fldigi Interface Window 

 



 Menu  

o File  
 Exit - closes the Fldigi window  

o Op Mode  
 CW - This configures Fldigi to decode CW (receive-only)  
 PSK - select BPSK-31 for normal PSK31, BPSK-63 for PSK63, etc.  
 RTTY - select RTTY-45 for normal 45 baud AFSK RTTY  
 Other selections can be used for other modes - see the fldigi help for details  

o Configure  
 Waterfall - under the Display tab, you can select whether to show audio or 

RF frequencies in the scale at the top of the waterfall, and whether to display 
transmitted as well as received signals  

 Rig control - XML-RPC should have been selected during the initial 
configuration. You can use the Hardware PTT tab to change the PTT settings 
for a separate hardware PTT port  

 Sound card - you can select the sound card to be used by Fldigi under the 
Devices tab  

 Modems - this is where you make configuration changes that apply to specific 
modes only (e.g. PSK-specific changes, or RTTY-specific changes)  

 Save Config - use this to save the new configuration any time you make 
changes  

o View  
 PSK Browser - opens a browser window that can display up to 30 signals 

within the waterfall simultaneously (PSK only). To configure this browser 
window, use Fldigi's Configure > Modems > PSK > Viewer configuration 
window to set the number of channels, the starting (lowest) audio frequency 
(channel separation is 100 Hz), and various other parameters  

 
Most Fldigi menu items not mentioned above are either not used by N1MM Logger, or perform 
advanced functions that are not needed for basic operation. See the fldigi help at the W1HKJ web site 

for more details (there is a link to the Fldigi-Help page from the download page at  

http://www.w1hkj.com/download.html ).  

Note also that when the Fldigi engine is selected, additional buttons appear in the Logger's Digital 
Interface window:  

 Align - for retuning the radio so that the desired signal is aligned on a pre-configured 
frequency  

 Lock - to lock the transmit frequency at the present position in the waterfall while allowing the 

receive frequency to vary (for operating split)  

 Rev - in sideband-sensitive modes like RTTY, reverses the tones  

 

SO2V/SO2R Limitation 

There is a basic limitation in the Fldigi engine which can make it harder to use in dual-receiver 
situations (SO2R and SO2V). Fldigi always receives in mono mode. If you are using a stereo sound 
card to decode two receivers, with one receiver in the left channel and the other receiver in the right 

channel, Fldigi will combine the two receivers in its waterfall. It doesn't matter whether Fldigi is the 
interface engine in DI1 or DI2, it will see the audio from both receivers.  
Therefore, if you want to use Fldigi with both receivers in a two-receiver setup, you will need to use 
two separate sound cards for the two receivers. You will also need to install two copies of Fldigi in two 
separate program folders in order to allow a different sound card to be configured in each copy. 

 

http://www.w1hkj.com/download.html


 

2.7.7 Digital - External TNC Support 

 2.7.7 Digital - External TNC Support  

o 1. The Digital Interface  
o 2. Setting Up the TNC in the Configurer  
o 3. Test Your External TNC  
o 4. Additional Macros for the External TNC Interface  
o 5. HAL DXP38 Setup  

 5.1. Hardware Setup  

 5.2. Software Setup in N1MM Logger  
 5.3. Configuring a DXP-38 in one of the additional RX windows  

o 6. HAL ST-8000 Setup (not supported)  
o 7. KAM Setup  
o 8. PK-232 Setup  

 8.1. Setting up the PK-232  
o 9. SCS PTC Setup  

The Digital Interface will not only work with MMTTY, MMVARI and external TNC's like the PK232, HAL 
DXP38 but with ANY TNC.  

This is because (with the special-case exception of the HL DXP-38) the commands for the TNC are not 

hard coded into the program. This has to be done by the user of the program  

Information about the following external TNCs can be found below but as already stated ANY TNC that 
uses serial communication can be used with N1MM Logger.  

1. The Digital Interface 

The Digital Interface can be used with any external TNC.  

 

Using a TNC will show an interface like the one above.  

2. Setting Up the TNC in the Configurer 

1. Start the N1MM Logger application  



2. On the Logger Main Window select >Config >Configure Ports, Telnet Address, Other >Digital 

Modes tab  
3. In Digital Setup  

1. Choose Other for Interface (for any TNC except for the HAL DXP-38; for the DXP-38, 

see separate instructions below)  
2. Set other parameters accordingly (Example settings: Com 4 ,9600 ,8 ,N ,1, RST-Xon)  
3. Save the configuration < OK >  

4. Load the Digital Interface from the Window menu  
5. Program the RX, TX and Abort macros by opening the Digital Setup window (Setup > Settings 

menu item in the DI window), selecting the Macro Setup tab, selecting the "Other" digital 
macro set, and then right-clicking on each of the TX, RX and Esc buttons at the right side of 

the window and programming them with the appropriate codes to put your TNC into transmit, 
to put it into receive at the end of a message, and to abort a message, respectively. Once you 
have done this, the {TX} and {RX} macros will work in function-key messages and the other 
DI button messages, and the Esc key can be used at any time to abort a transmission.  

 

Make sure your interface is set to copy RTTY at 45 baud and 170 Hz shift. If necessary, you can type 
the TNC command(s) for this in the transmit window so it will be sent to the TNC, or (better) you can 
program it into one of the DI message buttons.  

 

3. Test Your External TNC 

 Test stand-alone  

 See the separate sections for the PK-232, KAM, HAL etc. If your TNC is not mentioned please 
set it up like the other mentioned TNC's  

 
Make sure your radio and TNC work on your computer's serial port by testing them with an existing 

terminal program. Connect your TNC/Radio into your computers serial port. The Hyperterm terminal 
program is included with Windows and works well. Make sure you note all COM port parameters. You 

should be able to tune in a RTTY signal and print it using the Hyperterm program. The Windows 
Hyperterm is geared toward modem communications and is not especially intuitive for direct COM port 
use. As stated previously, you can use any number of terminal emulator programs. For example, the 
Tera Term Pro 3.1.3 by Ayera Technologies is a small, open source, free terminal emulator that is 
available for download.  

The interface has been tested with the three mentioned TNC's below and works fine with them. Any 
other TNC should also work as long as you place the right commands for that TNC in the macros.  

4. Additional Macros for the External TNC Interface 

The Digital Interface will accept all of the Macro keywords that can be used in the Packet window and 
other places in the Logger and will also accept the following:  

Ctrl+A Ctrl+B Ctrl+C Ctrl+D Ctrl+E Ctrl+F Ctrl+G  

Ctrl+H Ctrl+I Ctrl+J Ctrl+K Ctrl+L Ctrl+M Ctrl+N  

Ctrl+O Ctrl+P Ctrl+Q Ctrl+R Ctrl+S Ctrl+T Ctrl+U  

Ctrl+V Ctrl+W Ctrl+X Ctrl+Y Ctrl+Z Esc  Enter 



 

These macro keywords can be used in any of the DI message buttons or the Logger function keys in 
the Entry window.  

The TX window will accept all control key commands except for the Esc key, which must be sent as a 
Shift+Escape combination.  

Remember that when setting up a message key that is not a TNC command you will need to include 
the {TX} macro (or the equivalent TNC command) to key the TNC before it sends. If a message does 
not start with the {TX} macro, your TNC will think it is a command being sent to it instead of message 

text, and it will not know how to process it. Before using the {TX} and {RX} macros in messages, you 
need to initialize them with the correct commands for your TNC, by opening the Digital Setup window, 
selecting the Macro Setup tab, selecting the "Other" Digital Macro Set, and then programming the TX, 
RX and Esc buttons with the correct command sequences for your TNC.  

To use free form typing in the TX window you need to first key your TNC (e.g. using the TX button 

after it has been programmed correctly for your TNC). Click the TX button to start transmitting and 
then click in the TX window. Whatever you type in the TX window now will be sent out. After you have 
finished typing, click on the RX button to return to receive mode.  

5. HAL DXP38 Setup 

 
The HAL DXP-38 is supported as one of the possible interfaces. Setup for the DXP-38 is different from 
setup for other TNCs.  

There is a selection for the DXP-38 interface type in the Configurer under the Digital Modes tab, TU 
type.  

5.1. Hardware Setup 

It is a good idea to get the DXP38 running with WF1B, HAL or another known software package before 
trying to set it up for the first time in N1MM Logger. Doing this eliminates the need to troubleshoot 
both hardware and software simultaneously when configuring N1MM Logger. Hardware setup:  

1. Connect the PTT and FSK lines to the rig  
2. Connect the COM port (1 for HAL software) to the TNC  

3. Connect audio input to the DXP-38  
4. Connect the power  
5. Connect AFSK output to the rig (AFSK only)  
6. Consult the DXP-38 manuals for the details. The rig must be setto FSK RTTY (LSB) or LSB for 

AFSK  

5.2. Software Setup in N1MM Logger 

 
Port configuration - The COM port used for the DXP38 port should have a check mark in the Digital 
check box in the Configurer. Under the port settings (Set button), DTR/RTS should be set to Always 
On. Set the DigWNdNr to the digital window number that the DXP38 will be used with (1 or 2, for DI 
window #1 or #2).  





 

Digital configuration - In the Configurer under the Digital Modes tab, in the left side for the digital 
interface window that the DXP38 will be used with (Digital Interface 1 or 2), the port settings should 
be 9600 baud, N,8,1 and no handshaking:  



 

Command macros to control the DXP38  

Most of the useful DXP38 features can be controlled from the DI Setup window under the Dxp-38 
Setup tab. However, you may also use DXP38 macros in the DI window buttons (but NOT in the Entry 
window function keys). To program one or more of these buttons, you can right-click on one of the 
buttons to open the editing screen. The HAL command set is documented in the DSP4100 technical 

documentation at the HAL website. The HAL macros are in the form of two hexadecimal bytes, the first 
of which is a hex 80. To program a command whose second byte is xy (where x and y are 
hexadecimal digits), include a macro in the form {H80xy} in the message button. You miust follow 
this exact template: the macro is surrounded by curly braces and starts with an H, followed by four 
hexadecimal digits (8, 0 and the two digits corresponding to the desired HAL command). Once you 

have edited one of more of the message buttons, you can save the entire file in the Dxp38 macro 
button set using the Save Macros button in the edit window.  

RTTY messages  

Your contesting and other RTTY messages can be either in the Entry window function keys (F1-F12, 
e.g. for use from the keyboard or with ESM) or in some of the DI window buttons (for auxiliary 
messages that are only used occasionally, by clicking on them with the mouse). These messages work 

the same way with the DXP38 as for other digital interfaces. Start each message with {TX} and end it 
with {RX}. Note that message buttons that are programmed in the DI window set with Dxp38 selected 



as the interface type will be stored in the Dxp38 macro set, i.e. they will be saved separately from 
message buttons that you set up for MMTTY or for MMVARI.  

First time startup  

 Start up N1MM logger first  
o After the program loads, make sure focus is on the TNC received text screen. Then 

turn on the DXP38. If the data link is OK , an @ will be printed on the screen. It takes 

about 20-30 seconds for the DXP to initialize after the @ appears in the RX window.  

 Subsequent startups  
o Turn on the DXP38. Start N1MM logger. After the DXP38 initializes, you should see a 

text rendition of the initialization process on the screen. For example (the DXP-38 

tuning indicator has been enabled in this screen shot, but none of the 24 message 
buttons in the DI window has been programmed yet):  

 

 

5.3. Configuring a DXP-38 in one of the additional RX windows 

 
The DXP-38 can be configured to be used in one of the additional RX-only windows. To do so, use the 
Setup > Open Add. RX Window menu item in the Digital Interface window. If this is the first time this 



window has been opened, the Setup window will open, otherwise you may have to use the Setup 
menu item in the RX window:  

 

Select Dxp38 as the window type. The MMTTY Setup section is not used for the DXP-38. Under TNC 
Setup, select the COM port used for the DXP-38 and set the other parameters to 9600, N, 8, 1, no 
flow control, DTR and RTS both Always On. Once you click the Save button to save the configuration, 
close and reopen the RX window. It should look like this:  



 

6. HAL ST-8000 Setup (not supported) 

The HAL ST-8000 TNC is not supported and will not work with N1MM Logger as the baud rate used by 
the HAL is 45 baud and the serial port control in N1MM will only go as low as 110 baud...  

7. KAM Setup 

 Launch Hyperterm and set its parameters to 9600 bps, 8 databits, no-parity, 1 stopbit and no 

flow control  

 Connect the KAM to the port configured in Hyperterm  

 Turn on the KAM  

 When you see the message 'Press (*) to set Baud Rate, press the "*" button'  

 Then set your callsign as prompted  

 To place the unit into RTTY mode type "RTTY"  

 Also make sure the unit is set up for software handshaking XFLOW = ON  

 Once you are communicating with the KAM and have it in the RTTY mode, you can also tune in 

a RTTY signal and it will decode and print on the Hyperterm window  

 Now try to transmit by typing a Ctrl+C and a "T" on the keyboard followed by several 
characters that you wish to transmit. To get back to receive, type a Ctrl+C and a "R"  

 If you have problems, consult your KAM manual  

 Now exit the Hyperterm program and start Logger  

 
Below are sample RTTY settings for the KAM TNC  

AUTOCR 0 AUTOLF ON AUTOSTRT OFF  

BKONDEL ON CD SOFTWARE CRADD OFF  

DIDDLE ON ECHO ON FILTER OFF  

FSKINV OFF INVERT OFF LFSUP OFF  



LOWTONES OFF MARK 2125HZ RBAUD 45  

SHIFT 170 SPACE 2295HZ USOS ON  

XFLOW ON XMITECHO ON 
  

 
There are three parts in setting up N1MM logger to work with the KAM.  

1. Port configuration  

o The KAM should have a checkmark in digital  

2. Digital configuration  

o On the digital configuration dialog  
o Choose a free port and configure it for 9600 baud, N,8,1 and none  

3. Macro Creation required to control the KAM  

o Set the TX macro to: {Ctrl-C}T  
 will go into transmit  

o Set the RX macro to: {Ctrl-C}E  
 return to receive after the message is completed  

o Set the ESC macro to: {Ctrl-C}R  
 this will immediately return the system to receive before sending any text  

o You can now program your messages with the {TX} and {RX} macros, for example  
 CQ macro: {TX} CQ CQ CQ DE W3PP W3PP W3PP KKK {RX}  

8. PK-232 Setup 

 Make sure the PK-232 autobaud is set and the unit is set to RTTY mode  

 Launch Hyperterm and set its parameters to 1200 baud, 8-data, no-parity, 2 stop bits, and no 

flow control  

 Connect the PK-232 to the port configured in Hyperterm  

 Turn on the PK-232  

 Type a few "*" characters so your PK-232 will autobaud to the 1200 baud rate  

 Now place the PK-232 in the RTTY mode by typing the command "BAUDOT". It should respond 

OPMODE now BAUDOT  

 Turn the threshold pot full clockwise and make sure the LED is on  

 Also make sure the unit is set up for software handshaking XFLOW = ON  

 Once you are communicating with the PK-232 and have it in the BAUDOT mode, you can also 

tune in a RTTY signal and it will decode and print on the Hyperterm window  

 Now try a transmit by typing a "X" on the keyboard followed by several characters that you 
wish to transmit. To get back to receive, type a Ctrl+C and a "R"  

 If you have problems, consult your PK-232 manual  

 Now exit the Hyperterm program and start Logger. In the DI Setup window under the Macro 
Setup tab, select the "Other" Digital Macro Set, and program the TX, RX and Esc buttons as 

follows:  
o TX: X{ENTER}  
o RX: {CTRL-D}  
o Esc: {CTRL-C}R{ENTER}TC{ENTER}  

 If this has been done correctly, the {TX} and {RX} macros in your messages should now work 

correctly, and the Esc key should be able to interrupt (abort) an outgoing message 
immediately when it is pressed  



8.1. Setting up the PK-232 

By John VK4WPX / VK4CEJ  

Setting up the PK-232 for RTTY is very simple and straightforward.  

 First, open the 'Configurer' (On the main logging window click Config, Configure Ports, Telnet 
addresses, Other)  

 Click the Hardware tab  

o Click in the box adjacent to the COM port that you have your PK-232 connected to in 
the column labeled 'Digital'  

o See picture below, the example here shows the PK-232 on COM-2  

 

 Next, click on the Digital Modes tab and set up the Digital Interface 1 parameters  
o The example in the picture below shows that the PK-232 is set for 9600 baud, no 

parity and 8 data bits  



 

Setting up macros and the main logging window "F" keys for the PK-232 is also really very simple.  

 Modify any existing macros that came pre-configured by replacing every instance of ' {TX} ' 

with ' {Ctrl-C}Xmit{ENTER} '  
o I found that the command did not work every time unless it was followed by the 

{ENTER}  
o or, if the macro does not have {TX} or {RX} in it and you want it to start transmitting 

or go to receive, add those commands and, replace every instance of {RX} with {Ctrl-
D}  

 Example: F1 "CQ" macro would therefore be " {Ctrl-C}Xmit{ENTER}CQ CQ CQ DE * * * 

K{Ctrl-D} "  

 Example: F5 macro "Hiscall" would be " {Ctrl-C}Xmit{ENTER}! "  

o Which would leave the rig in transmit mode so that you could type more info in the 
transmit window  

o To return to receive, press Ctrl+D (hold down the Ctrl key and press D)  

9. SCS PTC Setup 

 Take the PTC as you use it for other digimode programs e.g. ALPHA (by DH7RG), XPWIN (By 
KF7XP), LOGGER (by K4CY)  

 Set the PTC to SERBAUD 19200 (not AUTO ! ) > switch the PTC OFF  



 Start N1MMLogger and go to 'Config | Configure Ports, Telnet Address, Other', Select the tab 

'Digital Modes'. Set 'Digital Interface 1 TU Type' to 'CW/Other', set the used serial port to 
19200 Baud, N-8-1-none. Set the 'Digital Interface 2 TU Type' to 'None'. Save with 'OK'  

 Click on Windows and select Digital Interface  

 Be sure that the PTC is connected to the right serial port and switch it ON and the start info 

will appear in the upper window finished by the prompt cmd: If you can't see anything check 
serial port and settings  

 Click in the lower window, enter with the keyboard 'Escape+Shift bau 45 ENTER' the PTC will 

switch to RTTY (look at the PTC mode display). Add 'Escape+Shift term 1 ENTER' to switch the 
PTC to echo the transmitted signs in the upper window. Note : Escape without Shift will switch 
the cursor to the main window  

 In the open Digital Interface select 'File | Settings' and select Tab: 'Macro Setup'. Select 

behind 'Digital Macro Set' 'Other 1'. Now three buttons appear with TX, RX and ESC on it. 
These buttons have to filled with the sequence to put the PTC in TX and RX and to get a 
correct function for canceling the AUTO-CQ function or make a break with the ESC-key on the 
keyboard  

o Digital Macro Set: Other 1  
o TX button: {Ctrl-Y} NB. in capital letters  

 Now the macro {TX} can be used to switch the TX ON  
o RX button: {Ctrl-Y} NB. in capital letters  

 Now the macro {RX} can be used to switch the TX OFF  
o ESC button: {ESC}CLR{ENTER}{Ctrl-D}{ENTER}  

 The macro will reset the PTC-2 to PACTOR, clear the TX buffer and switch the 
PTC-2 back to RTTY  

 There are a maximum of 24 extra functionkeys. One of them may be configured to switch the 

PTC-2 from the default state PACTOR to RTTY  
o Name button: RTTY  
o Contents button: {ESC}clear{ENTER}{ESC}bau 45{ENTER}{ESC}term 1{ENTER}  

 Every time you start the PTC-2 you may click on this key to start the RTTY-

mode. You need 'term 1' to get a delayed echo on the RX-window when your 
text is transmitted  

 You may generate more macros with simple QSO texts using the installed N1MMLogger 

macros as !, *, DATE, TIME etc  

 Don't forget to start a functionkey with {TX} and at the end place {RX} to switch back to 
receive  

 See for some macro examples at macros page  

 

2.8 Single Operator Contesting 

 1 Single Operator Two VFO Operation (SO2V) 

 2 Single Operator Two Radio Operation (SO2R) 

 3 Single Operator Split Operation 

 4 Single Operator Call Stacking 

 

2.8.1 Single Operator Two VFO Operation (SO2V) 

 2.8 Single Operator Contesting  

 2.8.1 Single Operator Two VFO Operation (SO2V)  

o 1. Advanced SO2V for Radios with Separate Sub-Receivers  
o 2. Approximating the Capability with Radios that do not have a Sub-Receiver  
o 3. More advice on using SO2V - from VE3KI  

http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+VFO+Operation+%28SO2V%29&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Split+Operation&structure=N1MM+Logger+Digging+Deeper
http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking&structure=N1MM+Logger+Digging+Deeper


o 4. SO2V RTTY with MMTTY  

A number of N1MM users are interested in using the advanced VFO and/or subreceiver capabilities of 
modern transceivers to improve their scores by approximating SO2R techniques, but with a single 
radio. This has led to the definition of an operating mode called SO2V (Single Operator Two VFOs). 
This section will deal with the features of N1MM Logger that are designed for use in this mode.  

1. Advanced SO2V for Radios with Separate Sub-Receivers 

 
Additional SO2V features are available for radios that have dual receivers or Main/Sub receive. As of 
the last manual update the complete radio list is: IC-756/Pro/Pro2/Pro3,IC-7600, IC7800, IC-781, 

Orion/2, K3, KX3, TS-990, FTdx9000, FTdx5000, FT2000, FT1000/D/MP/MKV/MPSteppIr, and the Flex 
Radios.  

In SO2V mode, the \ key changes the RX focus to the Sub receiver and enables the Sub audio if 
necessary (Orion). To use this feature  
set the CQ repeat time a longer than normal and start a repeating CQ using VFOA (Main). If nobody 
answers, press the \ key to enable the Sub receiver and tune the band. Pressing \ again will change 
the RX focus back to VFOA and turn off the Sub if Config > Dual Rx Always On is not checked. With 
Icom radios that only have one VFO knob, pressing the \ key also changes the knob association to the 
Sub VFO.  

If you do not find someone to call before the CQ timer expires, the program will call CQ again on 
VFOA. With RX focus on VFOB (Sub) Entry window, typing a letter will cancel the repeating CQ running 
on VFOA.  

Pressing a function key to call someone or send an exchange will automatically switch the TX focus to 

the proper VFO prior to transmitting. Some radios switch faster because they require fewer 
configuration commands. If the RX focus is on then VFOB (Sub) Entry window and the CQ repeat 
needs to start again on VFOA, simply press the CTRL+CQ-Key. The program default for the CQ-key is 
F1 and this is set in Configurer > Function Keys tab.  

If someone answers your CQ while the RX focus is on VFOB (Sub), press the \ key to change the RX 
focus prior to entering the callsign. If you want to change the TX and RX focus together press the 
PAUSE key.  

There is special functionality associated with the Ctrl+Alt+D and Grave accent keystrokes for the 
SO2V radios. See the appropriate radio model in the Supported Radios section.  

2. Approximating the Capability with Radios that do not have a Sub-
Receiver 

Some basic SO2V functionality has been implemented for all VFOA/B radios (those without a sub-
receiver).  

You may find the CTRL+Shift+Up/Dn command useful. It programs VFOB with the next spot Up or Dn 
in the Bandmap. When you have time to listen or call the station, press the PAUSE (or 

Ctrl+RightArrow) key. To return to your Run frequency, press the PAUSE (or LeftArrow) key, it won't 
change your RUN frequency. Instead, the program will let you know that split is necessary with a 
status message at the bottom of the Entry window.  

See the Supported Radio section of the manual for radio specific information regarding general and 
SO2V operation.  

http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Radios


3. More advice on using SO2V - from VE3KI 

SO2V is a kind of halfway point between SO2R (single-op two radios) and SO1V (standard single-
receiver operation). The most efficient of the three is SO2R. The main advantage of SO2R over 
traditional one-radio one-VFO operation (SO1V) is that you can be listening in one QSO while you are 

transmitting in a different QSO. Ideally, you could be doing two QSOs at once on different bands even 
though you never have more than one transmitted signal at a time, interleaving between the two and 
doubling your overall speed (at least when things are going very well). This is simply not possible with 
only one radio, even if it has two receivers, but SO2V is an attempt to make use of the second 
receiver to gain at least some of the advantages of SO2R.  

In SO2V, you are deaf whenever you are transmitting, so the key advantage of SO2V over SO1V is to 
be able to receive two signals in parallel. You don't conduct two QSOs at once, but you can at least 
determine whether there is someone worth working on either of two frequencies at once. That would 
seem to require two receivers, one receiver in each ear, not just two VFOs. You need to be able to tell 
which signal is coming from which receiver (e.g. stereo headphones).  

I am by no means all that proficient, but the main way I use SO2V is CQing on one frequency while 

S&Ping elsewhere in the same band. Again, more to get this out of the way than to describe SO2V, 
note that if it's a good run, people are coming back to you right away and you don't have time for 
SO2V techniques. In fact, what you may need is LOGTHENPOP to cope with multiple callers, and when 
you are doing this in CW or SSB you don't need the distraction of a second receiver. Instead, you 
would leave the second receiver turned off while things are going this well.  

However, if things slow down, as they often do late at night or late in the contest, then while you are 
CQing on VFO A and find you have to send CQ several times before anyone shows up calling you back, 
you can turn your second receiver on and start using it to S&P up and down the band while you keep 
on CQing.  

After your transmitter stops at the end of the CQ message, in SO2V you have two receivers both 
active. One is on your transmit frequency, listening for someone calling you back. The other one is 
somewhere else on the band, looking for a station CQing that you can call.  

Suppose: (1) no-one answers your CQ (IMHO your first duty is always to answer someone who 
answers your CQ); and (2) you find someone on VFO B that you haven't worked yet, and they are 

calling CQ or just about at the end of a QSO. In that case, what you can do is switch to the VFO B 
entry window (with the mouse if you are mousing, e.g. in RTTY, or with the \ key if you are 
keyboarding) and have (or try to have) a QSO on the VFO B frequency. Once that QSO is completed 
(or as soon as the other guy comes back to someone else instead of you), you switch back to VFO A, 
hope that someone hasn't taken over your run frequency while you were away, and send a CQ again 
to repeat the whole process.  

In SO2R, you can keep listening to the other station on the S&P VFO even while you are transmitting 
on your CQ frequency in between transmissions on the S&P radio, but in SO2V you have to stay on 
the S&P frequency for the entire duration of the S&P QSO, which means you run a significant risk of 

losing your run frequency. You have to weigh the risk of this happening against the benefit of picking 
up the S&P QSO during a dead period on your run frequency.  

You will probably want to turn autoCQ off while you are doing this. If I leave autoCQ on, inevitably I 
find that the transmitter fires up at exactly the wrong time, just before the other station sends his call 
sign, or when his QSO is ending and it's time to drop in my call sign on the VFO B frequency.  

You can also use SO2V to S&P with two receivers at once. Tune one up the band and the other down 
the band at the same time, and simply decide which one to use based on where you hear a new 
station to work first. You can use the \ key to jump back and forth between the two entry windows.  



SO2V is more productive if you are in the Assisted class. You can use spots from the cluster or RBN to 

guide where you tune with VFO B, instead of just tuning up and down the band. Instead of turning the 
VFO B tuning knob to find the next station to work, you can jump VFO B to the next workable spotted 
station using Ctrl+Shift+Up/Down arrows. This greatly increases the odds of quickly finding someone 

to work on VFO B versus just randomly tuning and screening out the ones you have previously 
worked.  

You can also use the cluster this way in SO1V with only one receiver, but with a significant 
disadvantage. Once you tune away from your run frequency after listening for someone calling you 
back, you then often have to wait some more listening on the second frequency until the caller is at 
the right point for you to call him. With two receivers, you can time your CQs on VFO A so that you 
don't have to waste time listening first on VFO A and then on VFO B; you can listen to both at the 
same time and line up the times so you either respond to a caller on VFO A if one is there, or else 
send your call to a CQer on VFO B, in this way minimizing the time you are away from your run 
frequency.  

To set up for SO2V with a dual-receiver radio, you select the SO2V button in the Configurer, and in 

the Config menu you check the "Dual Rx always on" menu item. In RTTY, you can set up the two DI 
windows with two separate interfaces listening on different channels of the sound card and just leave 
both receivers on all the time. In CW/SSB, you will probably want to learn how to use the ` and 
Ctrl+Alt+D keys (see the documentation on Supported Radios) to turn the second receiver on and off.  

I am probably missing some important things, but this is how I use SO2V with my dual-receiver K3.  

4. SO2V RTTY with MMTTY 

Instructions for setting up two copies of MMTTY for use in SO2V (Note: there are more detailed 
instructions on setting up for digital modes in the Digital Modes section - this section focuses on the 
SO2V aspects):  

 Create two separate folders for the two copies of MMTTY. This allows each copy to have its 

own configuration  

 Copy the MMTTY.exe, MMTTY.ini and UserPara.ini files (plus extfsk.dll, if you use EXTFSK) 
from the main MMTTY program folder into each of the two folders you will use for SO2V  

 Start N1MM Logger and open the Configurer (Config > Configure Ports, Audio, Mode Control, 

Other)  

 Select the Hardware tab  
o Select the SO2V option  

o This next step is optional for many users, but mandatory for some. If you are using 
serial ports for PTT and/or FSK from MMTTY, you may wish or need to check the 
Digital check box beside the ports used by the two copies of MMTTY. This step is 
necessary if you use the same port for CW or PTT keying from N1MM Logger in CW or 
SSB modes; if the only place you use a port is from MMTTY, the step is optional; and if 
the port number is higher than 8, you have to skip this step and perform all of the 
setup for this port within MMTTY.  

 Note that you must use either two serial ports, one for each copy of MMTTY, or 

no serial ports (AFSK; PTT controlled either by the main N1MM Logger 
program or in hardware, e.g. PTT via radio command or by VOX). If you are 
using two serial ports, their FSK keying outputs must both be connected to the 
radio's FSK input  

 Click on the Set button for the port you will use with VFO A and set the Radio 

Nr and the Dig Wnd Nr both to 1  
 Click on the Set button for the port you will use with VFO B and set the Radio 

Nr to 1 and the Dig Wnd Nr to 2  

 Select the Digital Modes tab  
o Under Digital Interface 1, TU Type, select Soundcard. Similarly for Digital Interface 2  



o Under DI-1 MMTTY Setup, select AFSK or FSK as appropriate for your setup and set 

the MMTTY Path to point to the copy of MMTTY.exe in the first folder  
o Under DI-2 MMTTY Setup, select AFSK or FSK as appropriate and set the MMTTY Path 

to point to the copy of MMTTY.exe in the second folder (this must be a different copy 

from the one in the DI-1 MMTTY Setup path)  

 Close the Configurer  

 Open the Digital Interface 1 Window (Window > Digital Interface menu item in the main VFO A 

Entry window). Make sure the program is in RTTY mode (if necessary, type RTTY into the 
Entry Window callsign box and press Enter)  

o If an MMTTY window does not appear (e.g. if you see an MMVARI window instead), 
then in the DI-1 Window select the Interface > MMTTY menu item to open the MMTTY 
window  

o Select the Setup > Settings menu item in the DI-1 window  
 Under Preferred RTTY Interface (lower left), select MMTTY  
 Under Alignment Frequency (lower right), enter your Mark audio frequency 

(e.g. 2125)  
 Under MMTTY Window Settings, select either Normal or Control Menus, in 

order to have easy access to the MMTTY setup window  
 Click on Save Configuration  

o In the MMTTY window for the first copy of MMTTY (the title bar reads RTTY Engine 1), 
select the Option(O) > Setup(O) menu item  

 Select the TX tab and set the PTT & FSK port you will be using for the VFO A 
copy of MMTTY (this is the port with Dig Wnd Nr = 1 in the Configurer). If you 
are using AFSK and doing PTT from the main N1MM Logger program, set this 
port to None  

 Select the SoundCard tab (MMTTY version 1.66 or newer) and select the 
Reception sound card you will use with VFO A. If you are using AFSK, you 
must also select the Transmission sound card  

 Under the Misc tab, select the channel (left or right) under Source (usually the 
left channel for VFO A )  

 Close the MMTTY Setup window  

 If the second Entry window is not open, open it by pressing the Pause key, the backslash (\) 

key or Ctrl+Right Arrow  

 Open the Digital Interface 2 Window (Window > Digital Interface menu item in the VFO B 

Entry window). Make sure the program is in RTTY mode for VFO B (if necessary, type RTTY 
into the VFO B Entry Window callsign box and press Enter)  

o If an MMTTY window does not appear (e.g. if you see an MMVARI window instead), 
then in the DI-2 Window select the Interface > MMTTY menu item to open the MMTTY 
window  

o In the MMTTY window for the second copy of MMTTY (the title bar reads RTTY Engine 

2), select the Option(O) > Setup(O) menu item  
 Select the TX tab and set the PTT & FSK port you will be using for the VFO B 

copy of MMTTY (the port with Dig Wnd Nr = 2 in the Configurer); this must be 
a different COM port from the one that is used for VFO A. If you are using 
AFSK and doing PTT from the main N1MM Logger program, set this port to 
None  

 Select the SoundCard tab (MMTTY version 1.66 or newer) and select the 

Reception sound card you will use with VFO B. If you are using AFSK, you 

must also select the Transmission sound card (in SO2V this will likely be the 
same as the Transmission sound card used for VFO A)  

 Under the Misc tab, select the channel (left or right) under Source (usually the 
right channel for VFO B )  

 Close the MMTTY Setup window  

 

2.8.2 Single Operator Two Radio Operation (SO2R) 



 2.8.2 Single Operator Two Radio Operation (SO2R)  
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SO2R  

 14.2. Soundcard Option #2: Singlecard - Two radio, No Soundcard SO2R  
 14.3. Soundcard Option #3: Single Card - Two radio, Soundcard SO2R, CW 

Only  
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1. SO2R Basics 

Single Operator 2 Radio (aka SO2R) is an operating technique that when done properly, can add many 

extra QSOs and multipliers to your log. This is accomplished by increasing your efficiency during slow 
times, for example, when you are CQing on one radio, but getting few answers. Efficiency is increased 

by listening on a 2nd radio while you are transmitting on the 1st radio. On the 2nd radio you are 
scanning the bands for needed QSOs and multipliers. If you find a new station to work on the 2nd 
radio, you leave it staged on the 2nd Entry Window until you get a free moment to work this station. 
Even adding a few QSOs an hour will greatly boost your score.  

The philosophy for SO2R development is to allow any two radios to be used; they do not have to be 
identical. In its most simple form, two transceivers feed two separate antennas on two different 
bands. With sufficient attention to antenna separation and filtering, it is possible to do this without 

interference from a transmitting radio to a receiving radio. Many serious SO2R operators use identical 
radios to reduce the confusion factor, but having identical radios isn't necessary.  



The receiver on one band is used to locate new contacts during the time that the transmitter on the 

other band is active. This can mean that you tune the 2nd radio while N1MM Logger sends CQ on the 
1st radio. The most critical requirement for SO2R is automated transmission — if you have to speak 
into a microphone or squeeze a paddle while you tune the receiver you will not make the most of the 

second radio. It's easy to reach a level of mental fatigue while operating SO2R that results in an 
overall score reduction rather than helping your score.  

If your radio is not supported by N1MM Logger, or it's an older radio with no computer interface, the 
radio can still be used, but you just don't get many of the advantages automated radio control offered 
by N1MM Logger.  

N1MM Logger also supports "Single Operator 2 VFOs", or SO2V. If your radio simply has 2 VFOs, VFO 
A/B will be assigned to each of the two Entry Windows. If you have a radio with a sub-receiver, each 
of the receivers gets assigned to each of the Entry Windows. When developing the specs, we actually 
felt SO2V would be more widely used than SO2R.When operating SO2V (and SO2R), you also need to 
change your LPT or Winkeyer keying from Radio 1 (default) to BOTH. Otherwise, you will not get any 
keying on VFO B or Radio 2.  

N1MM Logger's SO2V interface is essentially identical to the SO2R interface, but with SO2V you are 
using a single radio. Two windows can be displayed in SO2V, one for VFO A & B. SO2V makes better 

use of the 2nd receiver now present in most high-end radios. With the 2nd receiver, you can be tuning 
the band while you are listening for a response to your CQ. Since you cannot listen on the sub-
receiver while transmitting, SO2V is not as efficient as SO2R.  

A maximum of two radios are supported with N1MM Logger using a single computer. There is a 
workaround for 2-computer 2-radio SO2R, explained below.  

For the new SO2R operator, we have 3 words for you: practice, practice, practice! SO2R is definitely a 
learned skill that takes time to learn, and even longer to master.  

1.1. Two-Computer SO2R 

Some operators, particularly on RTTY, prefer to use separate computers for SO2R. This is not explicitly 
supported by N1MM Logger, but there is a way.  

First, be sure both computers are running the same version of N1MM Logger. Turn on Networked-
Computer mode (Config >Networked-Computer Mode), and configure the network between your 
computers as explained in the section on Network Setup and Configuration?. Then set up your contest 
class as Multi-One.  

Set your lockout style under Config >Multi-User Tools as explained here?  

 First One Wins  
o UNCHECK >Multi-User Tools >Force Other Station to Stop Transmitting When I 

Transmit  

o UNCHECK >Multi-User Tools >Block My TX Only if Other Stn Transmitting on Same 

Band & Mode (Multi-One)  

 Last One Wins  
o CHECK >Multi-User Tools >Force Other Station to Stop Transmitting When I Transmit 

is CHECKED  

o UNCHECK >Multi-User Tools >Block my TX Only if Other Stn Transmitting on Same 
Band & Mode (Multi-One)  

 
Please note that a number of N1MM Logger's advanced SO2R features cannot be used in this style of 

http://n1mm.hamdocs.com/tiki-editpage.php?page=Networked-Computer+Support
http://n1mm.hamdocs.com/tiki-editpage.php?page=SO2R


SO2R operation,. The list includes Ctrl+Fx (send Fx on the opposite radio), {CtrlFx} (the same as a 

macro), dueling CQs, Advanced SO2R and FocusOther. All of these require both radios to be connected 
to the same computer. Serial numbering, if used, will conform to the Multi-Single rules for the contest 
in question.  

Don't forget to change your entry class back to Single Op or Single Op Assisted in the Contest Setup 
window before you generate your Cabrillo file.  

 

Users Please Note 

Please be aware that the developers will not implement Feature Requests or respond to Bug Requests 

that result from 2-computer SO2R's not conforming to single-computer SO2R expectations.  

2. Intuitive User Interface 

As you will quickly see, N1MM Logger's SO2R implementation is more intuitive than most other SO2R 
implementations:  

 Entry Windows can be arranged to reflect equipment layout  

 Entry Windows can be used for any function (not dedicated functions like others)  

 You always know what each VFO or radio is going to send next (when in ESM mode)  

 Visual cues identifying transmit focus, Run vs. S&P, and more!  

3. Supported Features 

N1MM Logger supports all of the features you would expect from any world-class SO2R software. In 
addition, there are a lot of unique features:  

 Two Entry windows are displayed that are fully interchangeable in functionality (windows are 

not dedicated to a specific task)  

 Running and S&P modes are maintained for each SO2R Entry window, such that the 2 

windows can be used for  
o Running / S&P  
o S&P / Running  
o S&P / S&P  
o Running / Running  

 Entry windows can be arranged on screen as desired: typically left/right, or top/bottom, to 
represent physical station layout  

 Each Entry Window has a frequency readout in the top pane  

 'LEDs' identify which radio has focus. The sending radio has a red LED indicating TX Focus, a 
green LED identifies the radio that has RX and Keyboard focus (combined)  

 Background colors of the entry field change color depending on whether that radio is running 

or S&P: white = run; canary = S&P  

 Ability to change frequency of inactive radio from the active radio. Use the / before entering 

the frequency in the callsign field to enter frequency for other radio/VFO  

 Supports Enter Sends Messages Mode (ESM) on both windows  

 Typing a call in inactive radio Entry window does not abort sending on the active radio  

 Hitting Escape stops sending on either VFO or radio, but does not change keyboard focus  

 Changing transmit focus (for any function) stops sending before switching and sending on 

alternate radio  

 Ctrl+function keys and Ctrl+Enter sends messages on alternate radio (Concept is Ctrl = 

Alternate radio control)  

 "Hotkey's" for specific tasks and sending on alternate radio  

 All Key Assignments work on both radios (unless otherwise specified)  



 Supports Top Ten DX Doubler, WX0B Station Master, Microham MK2R, YCCC SO2R, and other 

SO2R controllers.  

 Support SO2R without interfaced radios.  

 Dueling CQ's will send CQ alternately on each radio (Ctrl+B)  

o If dueling CQ's is enabled, and CQ sent then both radios become Run radios  
o Ctrl+F1 or Ctrl+Enter will not start Dueling CQ  
o Dueling SSB and CW CQ's (different modes in each Entry window) are supported  
o When you disable Dueling CQs, the pre-existing SO2R options are restored  

 A SO2R software radio lockout for is implemented  

 CQ-repeat is terminated when a message is sent on the other radio  

 The macro {JUMPRX} changes the receive focus to the other input window  

 Supports 2 radios - No support for 3 or more radios  

 Support SO2R with zero, one or two sound cards (5$ SO2R)  

 When changing band using Ctrl+PgUp/Down key will skip the other radio's band  

o THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!!  

 The sent CW will echo in the status bar of the Entry Window (only when in SO2R)  

 During VOX operation, in "$5 SO2R" operation the TX audio should will track the TX focus all 
the time  

 
There is currently no support for two networked computers for SO2R.  

4. Entry Windows 

Entry windows can be placed anywhere on the screen. Typically people will position them similar to 
their equipment layout i.e. if the radios are positioned left/right, the windows are arranged reflect 
that. For those who stack their equipment top/bottom, you can position the screens so they logically 
mirror that radio setup too.  

Screen real estate is in short supply. To minimize screen real estate, you can shrink the Entry 

Windows compared to the default layout. Below is an example of the default Entry Window and a 
minimized version. Also the use of two monitors more screen real estate.  

 

 

 

 
To launch the 2nd Entry Window, hit the \ button.  

5. Typical SO2R Entry Windows 



Most people who are comfortable with N1MM Logger tend to use the reduced size Entry Windows in 

the examples below. All of the vital information an operator needs is displayed in the smaller window. 
Most SO2R operators get the most efficiency while CQing on 1 radio, and S&Ping on the other. The 
Entry Window examples below reflect a typical setup: The left VFO (A) is now assigned to running, and 
the right VFO (B) is assigned to S&P.  

 

 

All of the features that are available to the single radio operator also work in SO2R/SO2V. For 

example, when tuning the band with the S&P VFO, spots that are in the bandmap are automatically 
inserted into each call frame (above the callsign in the entry window) when you tune across the 

frequency of the spot. Hitting the space bar will pull the callsign from the call frame into the callsign 
field. If a station calls you on the run radio, toggling back and forth between Entry Windows with the \ 
key or Ctrl Left/Right arrows will maintain the all of the information in each Entry Window until the 
respective stations are logged, wiped clean via Alt+W or Ctrl+W, or you QSY and the callsign is 
entered into the bandmap (if "QSYing wipes the call && spots QSO in bandmap" is implemented).  

6. The SO2R Dots (LEDs) 

On the Entry Window a green and/or a red dot (LED) will be shown. The LEDs are visual aids that help 
you easily identify what is happening on each radio. This is part of N1MM's continuing philosophy of 
letting the operator easily know what's happening at any give time.  

The green LED indicates that the VFO or radio has receive/entry focus and the red LED indicates that 
VFO has transmit (TX) focus. In addition, the red TX LED changes between dark red (not transmitting) 
and bright red (VFO/radio is transmitting). Inside the LED are letters which identify different states 

(see below). It is important to note, though, that when a function key is used to send a message or 
perform another function, the radio or VFO that has the RX/entry focus  

6.1. Dot/LED Colors Used: 

Green dot/LED - This VFO/Radio has receive (RX) and entry focus. RX and entry focus are always 
together.  

 Inside the green dot the Ru/SP (Run/S&P) designators are shown. Ru means the radio or VFO 

is in running mode, and SP means it is in S&P mode  
o when clicking on the green dot it toggles between running mode (Ru) and Search & 

Pounce mode (SP)  

 RX/keyboard focus can be toggled between the VFOs/radios by  

o using a mouse to click on a free space in one of the two Entry windows  
o pressing the \ key (backslash)  

 To move both Transmit and Receive focus  



o pressing Ctrl+Left-Arrow / Ctrl+Right-Arrow will move both foci to the left and 
right radios. Pressing Pause  

 
Red dot/LED - This VFO/Radio has transmit (TX) focus. This means that the radio or VFO either is 
transmitting or was the last to transmit. When the other window has entry focus and you press a 
function key to send a stored message, the transmit focus shifts to that radio as soon as the function 
key is executed.  

 Transmit (TX) focus can be changed between the VFOs/radios by pressing the Alt+F10 key  

 Pressing Pause or Ctrl+Left-Arrow / Ctrl+Right-Arrow will move both foci to the left or 
right radios  

 When transmitting the TX focus can not be changed  

 Inside the red dot the R (Repeat) designator is shown when Repeat mode (for CQing) is active  

 Inside the red dot the D (Dueling CQ) designator is shown when Dueling CQ is active  

7. Key Assignments (unique to SO2R) 

 

"Sticky" options  

The Focus Other and Ctrl+Fx settings, whether controlled through keyboard shortcuts or through the 
SO2R sub-menu of the Configurer, are "sticky" - that is they are remembered the next time the 
program is opened. This can surprise you if you don't remember having set them. 

7.1. Entry Window Features 

 Backslash ( \ ) - Launches a second Entry Window if only one Entry window is open  

o One radio - Moves RX focus between the 2 VFOs on the radio  
o Two radios - Moves RX focus between the 2 radios  

 Ctrl+Enter - Send next ESM state on alternate radio (assuming ESM turned on)  

 Ctrl+F1 to F8 - Send Fn message on alternate radio  

 Ctrl+Left Arrow - In SO2R move both Transmit and Receive/Keyboard focus to left radio, or 

in SO2V move both TX and RX/Keyboard focus to VFO A  

 Ctrl+Right Arrow - In SO2R move both Transmit and Receive/Keyboard focus to right radio, 

or in SO2V move both TX and RX/Keyboard focus to VFO B  

 Pause - Move both TX and RX Keyboard focus to other radio (or other VFO in SO2V). If TX 
and RX focus are split when you hit pause, TX focus will move to where the RX focus is  

 Alt+F5 - Swap radio frequency, mode, and callsigns between VFOs (SO2V) or radios (SO2R). 

In SO2R, the receive focus changes to the non-active radio  

 Alt+F6 - Identical to Alt+F5 except the receive focus does not change  

 Ctrl+B - Dueling CQ's will send CQ alternately on each radio. If Dueling CQ's is turned on, 
both radios become run radios. A delay can be inserted between each CQ by setting the "Set 
Dueling CQ Repeat Time" under the SO2R menu. Dueling SSB and CW CQ's are supported too.  

 __Backquote (grave accent or unshifted tilde key (~) - Toggle STEREO mode on/off, or toggle 

Auto/PTT modes with modified DXD . Notes: On US keyboards, the key we are talking about is 
the key just to the left of the number 1 key.  

 Ctrl+I - Toggle through the SO2R modes supported by the program and your sound card 

configuration (see below). Only operative in '$5SO2R' when N1MM logger controls the audio, 
not when using an external SO2R controller  

 Ctrl+PgUp/Down - When changing band using Ctrl+PgUp/Down will skip the other radio's 

band  
o THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!  

 Ctrl+Shift+I - toggle 'Advanced SO2R'  



o With Advanced SO2R on, focus will be set to sending radio's entry window when a 

message completes. The exception is if there is a call or partial call entered in the non-
sending radio's entry window.  

o Or simply put, if you tune your S&P radio, and you aren't working someone on either 

radio (like calling CQ), the entry focus will go automatically to the S&P radio so you 
can tune aggressively without having to worry about getting the entry focus in the 
right place before you enter a callsign to work  

 Ctrl+Shift+N - Adjustable delay for Advanced SO2R.  

o The user can keep focus on the run radio after sending has stopped, or turn it over to 
the S&P radio beforehand by this adjustable time parameter. Typically the CQ Repeat 
time is set to something like 3 sec and the Adjustable Delay to perhaps 2 seconds. It 
has been suggested that, at the beginning of a contest, this parameter be set high 
(LOT of callers on run) and toward the end of the contest it be dropped- all doable via 
Ctrl+Shift+N  

 Ctrl+Shift+K - FocusOther, Another method of focus control (Focus on Other Radio), 

preferred by many contesters over "Advanced SO2R". When FocusOther is active, the RX focus 
is automatically shifted between the "Run" radio and the "S&P" radio, depending on whether 

the Run radio is transmitting. When the Run radio is transmitting, RX focus is shifted to the 
S&P radio. When the Run radio stops transmitting, RX focus shifts back to the Run radio, 

unless an unworked callsign has been entered in the S&P entry window. This allows a callsign 
to be entered in the S&P radio Entry Window while CQ is being sent on the Run radio.  

o FocusOther is mutually exclusive from Advanced SO2R and does not use adjustable 
time on the Run radio.  

 Ctrl+Shift+L - This enables/disables the use of {CTRLFx} in function key macros. {CTRLFx} 

is a convenient way to automatically send a function key on the alternate radio. For example, 
by programming your S&P F4 key to "* {CTRLF1}", your call will be sent on the S&P radio, 
immediately followed by your CQ message on the Run radio.  

7.2. Bandmap Features 

 Shift+Click on frequency (SO2R only) - Jump to that frequency on the inactive radio, 
without changing TX or RX focus. This allows you to be active and sending on one radio and 

change the frequency on the other radio without making it the active radio.  

 Shift+Click on bandmap callsign (SO2R only) - Send the frequency to the inactive radio 
and place the callsign on the other radio's callsign frame, without making it the active radio.  

7.3. Using SO2R Key Assignments 

Backslash ( \ ) - Once you have launched your second Entry Window, the \ key will likely be your 
most widely used key in SO2R. The \ key will move RX focus between Entry Window A & B (often 
referred to as Radio 1 & Radio 2 respectively). When using the \ key to control RX focus, you really 
don't have to worry where TX focus is. By using the \ key to control only RX focus, when you hit a Fn 

key or Enter (using ESM), the TX focus will move to where the RX focus is, and send the 
corresponding message.  

Example: You are CQing on Radio 1, and S&Ping on Radio 2. Both RX and TX focus start off in your 

Run Entry Window (Radio 1 in this example). You are S&Ping on Radio 2, and you hear someone on 
the S&P radio you want to look up in your Check Window. Hit the \ key to move RX focus to the S&P 
Entry Window. You type in the call, and you need it, and are just waiting for a good time to send your 
call. If no one is answering your CQ on the Run Radio, just hit the Enter Key (assuming you are using 
ESM), and the TX focus will move from the Run Radio to the S&P radio (Radio 2), and send your 
callsign (actually the first ESM message in the S&P sequence). If the station comes back to you, then 

hit Enter again to send your exchange, and you just completed a S&P QSO. Now move the RX focus 
with the \ key to the Run radio, or just leave it in the S&P Entry Window if S&P is more productive.  



Now let's assume in the middle of the S&P QSO, someone answers your CQ on Radio 1. Your 

exchange just happens to be sending on the S&P radio. To copy the call on the Run Radio (while your 
exchange is being sent on the S&P radio), hit the \ key to move RX focus to the Run Radio, and type 
his call in the Run Entry Window. Assuming your exchange is finished sending on Radio 2, just hit 

Enter again, and the TX focus will move back to the Run Radio, and the program will send his call and 
your exchange on the Run Radio. You now have QSOs going on both radios! Just move RX focus as 
needed to send/copy on what ever radio you need. This is easier said, than done during a contest !  

 

Tracking TX Focus 

In the above examples, you never have to control where TX focus is, since TX focus always moves 
automatically to where the RX focus is when Fn or Enter (ESM) is used. This should be your standard 
operating mode, as you only need to worry about using a single key to do most of your navigation 
between the two Entry Windows. 

 

Ctrl+Enter, or Ctrl+Fn - Using these commands will send the corresponding message on the 
alternate radio; with the alternate radio defined as the radio that does not have RX focus. Using 
Ctrl+Fn (or Ctrl+Enter) will only move the TX focus to send the message - RX focus will stay in it's 
current location. Once the message is sent, TX focus will remain on the alternate radio. This is done by 
design.  

The most common scenario would be if you are CQing on Radio 1, but you are not getting callers. You 
hit the \ key to copy a callsign on the S&P radio. Without moving the RX focus from the S&P radio, at 
some point you will probably want to send another CQ on the Run Radio. You do this by hitting 
Ctrl+F1 or Ctrl+Enter. You will also likely use these commands if you have a QSO in progress at the 

same time on both the Run and S&P radio. The easiest way to send a message at the right time on the 
other radio is to use these commands, and leave RX focus where it is. Alternatively, you can program 
function keys with the {CTRLFx} macro to send messages to the other radio.  

Pause Key - If both TX and RX focus are in the same Entry Window, hitting Pause will move both TX 

and RX focus to the other radio. If TX and RX focus are split between the Entry Windows, the pause 
key will move TX focus to where RX focus is. Mostly you will use this key in order to get your foci back 
in sync.  

Ctrl+Right Arrow and Ctrl+Left Arrow - These commands will force both TX and RX focus to the 
right or left radio.  

Ctrl+B - Enable Dueling CQ's.  

{CTRLFn} macro - This macro allows the user to send on the other radio.  

 Make sure that "Toggle {CTRLFx}" macro is checked on in the Configurer SO2R submenu (or 
use Ctrl-Shift-L to enable/disable the use of {CTRLFx} macros. When disabled, the {CTRLFx} 
macro is ignored  

 Thus, a CW Button might look like: "tu EXCH{CTRLF9}" Where F9 on the other radio is set to 

send a CQ.  

 Example: If your entry focus is on the S&P radio and you manually press Ctrl+F1, the 

program will send F1 on the OTHER radio. That's all the {CTRLFx} macro does. For a simple 
test, modify your S&P F4 key to read *{CTRLF1}. Now, when you press that key, the program 
sends your call on the S&P radio and then sends the contents of F1 on the Run radio. In a 
practical situation, you would probably not want to send a full-length CQ while trying to work 
someone on the S&P radio, because that will nearly always require you to interrupt it before it 
is done. So the idea of {CTRLFx} is that you can stash a short CQ (like "N4ZR test"} in, for 

example, Run F12. Then make S&P F4 read "* {CTRLF12}. Now when you press F4 on the 



S&P radio, it will send your call, and immediately switch to the Run radio and send F12, that 

very short CQ. Should help hold your frequency.  

 Another way to use this: Make your S&P F2 read, for example, 5NN14{CTRLF1}. Then when 

you press F2 or Enter to send your exchange and/or log the S&P QSO, the program will 
automatically begin a CQ on the Run radio as soon as that is done  

8. Mouse Assignments 

 Left mouse and Right mouse buttons_  
o On an empty space in one of the two Entry windows, these mouse buttons change the 

Receive focus to that radio/VFO  

9. SO2R Menu 

 SO2R  

o Dueling CQ's Ctrl+B - will send CQ alternately on each radio  
o Set Dueling CQ Repeat Time  
o Advanced SO2R  
o Advanced SO2R Delay Time  

o Focus on Other Radio - A method of focus control, preferred by many contesters 
over "Advanced SO2R". When FocusOther is active, the RX focus is automatically 
shifted between the "Run" radio and the "S&P" radio, depending on whether the Run 
radio is transmitting. When the Run radio is transmitting, RX focus is shifted to the 
S&P radio. When the Run radio stops transmitting, RX focus shifts back to the Run 
radio, unless an unworked callsign has been entered in the S&P entry window. This 
allows a callsign to be entered in the S&P radio Entry Window while CQ is being sent 

on the Run radio.  
o FocusOther Always Swap - Used in conjunction with Focus on Other Radio. When 

FocusOther Always Swap is enabled, RX focus will always shift back to the Run radio 
when the Run radio stops transmitting.  

o Toggle CTRLFx Macro - This enables/disables the use of {CTRLFx} in function key 

macros.  

o TX Lockout - Select a lockout item (Digital modes only)  
 Multi-TX - This is the default setting. Start CQ on radio A, Start CQ on radio 

B, both are active. (no lockout)  
 First one wins - Start CQ on radio A, pause, Start CQ on radio B. The radio B 

CQ is ignored since radio A is already active, so if you press a F-key for the 
second radio while radio1 is transmitting, the radio B F-key is ignored  

 Last one wins - Start CQ on radio A (CQ starts), pause, Start CQ on radio B. 

The CQ on radio A will aborted and the CQ on radio B will start so if you press 
a F-key for the second radio while radio A is transmitting, the radio A 
transmission is interrupted and radio B transmits  

 Toggle SO2R mode Ctrl+I - Toggle between the possible SO2R modes 
supported by the program. The SO2R mode is shown in the Entry window 
statusbar.  

 Note: Ctrl+I is only operative in '$5 SO2R' mode when N1MM logger 

controls the audio, not when using an external SO2R controller.  

 SO2R mode: Manual - Audio is switched when moving focus 
between windows  

 SO2R mode: Auto  
 Run radio = TX -you hear S&P audio in both ears  
 Run radio = RX - left ear = left audio, right ear = right 

audio  
 SO2R mode: One-Rig Auto - Always listen to the audio of 

the non-TX-ing rig. This means that as soon as the running rig 
goes into TX, you hear the S&P audio, which goes back to the 



run radio's audio in both ears as soon as the CQ message is 
played  

10. Software Setup 

Setting up SO2R and SO2V starts in the Config menu:  

 Config > "Configure Ports, Telnet Address, Other" > Hardware Tab  

Then if SO2R: 

 Set up radios 

 Set up keying if necessary (LPT or 

Winkeyer) 

 Click SO2R button 

 Configure left/right radio in pop up box 
(when you click on SO2R button) 

 Click OK 

 Launch N1MM Logger, set up contest etc. 

 If 2nd Entry Window is not shown, hit the \ 

key (backslash key) 

 SO2R - 1 computer radio + 1 manual radio 

(so two radios) 

 SO2V - 1 computer radio with 2 VFOs and 
no manual radio (so one radio) 

Then if SO2V: 

 Set up radio 

 Set up keying if necessary (LPT or 

Winkeyer) 

 Click SO2V button 

 Click OK to close Config window 

 Launch N1MM Logger, set up contest etc. 

 If 2nd Entry Window is not shown, hit the \ 
key (backlash key) 

Selected 
Mode 

Radios Attached Choices Selection 

SO2R none SO2R - Left Manual, Right Manual  
Automatically 

selected 

SO2R 
1 

(Kenwood) 
sO2R - Left Manual, Right Kenwood Com1 
SO2R - Left Kenwood Com1, Right Manual  

Select one 

SO2R 
2 

(Kenwood & 
FT847) 

SO2R - Left Kenwood Com 1, Right FT847 
Com 2 
SO2R - Left FT847 Com1, Right Kenwood 

Com 2  

Select one 

SO2V 
1 

(Kenwood) 
SO2V - Kenwood  

Automatically 
selected 

10.1. LPT Keying 

When operating SO2V, and using LPT port keying, the Radio Nr in the LPT port configuration must be 
set to Both.  

When operating SO2R, and using a single LPT port for keying, the Radio Nr in the LPT port 
configuration must be set to Both. This configuration will require an external box to switch the keying 
line between the two radios. The external box can be controlled using LPT pin 14.  

When operating SO2R and using a separate LPT port for each radio, the Radio Nr in the LPT port 
configuration must be set to (Radio) 1, and 2.  



10.2. Winkeyer and WinkeyerUSB keying 

When operating SO2R, and using Winkeyer, the Radio Nr in the Winkeyer COM port configuration must 
be set to Both.  

When operating SO2R, and using a single Winkeyer port for keying, the Radio Nr in the Winkeyer COM 
port configuration must be set to Both. This configuration will require an external box to switch the 
keying line between the two radios. The external box can be controlled using LPT pin 14.  

When operating SO2R and using Winkeyer's "2nd CW Output", the Radio Nr in the Winkeyer COM port 
configuration must be set to Both.  

11. SO2R Radio Support 

All supported radios will work with SO2R. N1MM Logger will allow you to use any combination of 

computer controlled and non-computer controlled radios. If you use a radio that is not supported or 
has no radio control, do not set up a radio COM port. You only set up that information when you have 
a computer controlled radio.  

12. Using External SO2R Controllers 

N1MM Logger is compatible with most hardware SO2R controllers using the LPT port (legacy) such as 

the Top Ten Devices "DX Doubler", the Array Solutions (aka WX0B) "SO2R Master". These products 
will automatically control keying, PTT and audio lines to each radio. New products like the microHAM 
MK2R can be fully controlled via USB or via an LPT port (legacy). The EZmaster from Ham Radio 
Solutions.is only supported using the LPT port and not the USB port.  

Hooking up these controllers will require a straight-through DB-25 cable from your LPT port of your 
computer to the input DB-25 connector on these products. For hooking up the rest of the keying and 
audio lines for these products, consult their respective manuals. All products use the same pin-outs on 
the LPT port.  

DX Doubler and SO2R Master have two basic settings for software: "CT/TR/Writelog" and "NA". NA 
uses slightly different controls. To use N1MM Logger with these external devices, just configure the 
external controller for "CT/TR/Writelog".  

To get N1MM Logger to correctly key and control these devices, you need to set up your keying as 
follows:  

12.1. LPT Keying with External SO2R Controllers Using LPT Port 

 Config >Configure Ports, Telnet Address, Other >Hardware tab  

 Check LPT keying box - check only one LPT box  

 Click on the corresponding "Set" button for the LPT port  

 Click on "Radio Nr" drop down box and select "Both"  

 Click on OK to set configuration  

 

Modifying the DX Doubler  

There were a couple of errors on the DX-doubler PC board. Go to: 

http://www.qth.com/topten/appnotes.htm to see the DX Doubler modifications. 

12.2. Using Winkeyer and WinkeyerUSB 



The original Winkeyer, uses a RS-232 COM port, and is not a USB device. Winkeyer has an internal pin 

3 output, which is normally CW for 1 radio, and an internal pin 5 which is normally PTT for a single 
radio. Under N1MM Logger software control, pin 3 can set for Radio 1 CW output and Pin 5 can be set 
for Radio 2 CW output. The serial port assigned to the Winkeyer device should have the "Hardware" 

tab "Set" and Winkeyer checked and Radio Nr set to 'Both'. Then go to the "Winkeyer" tab and set Pin 
5 function to "2nd CW"  

The "K" output on the Winkeyer board goes to Radio 1 CW and the "P" output goes to Radio 2 CW. 
N1MM Logger takes care of all the switching provided you activate the proper radio.  

The WinkeyerUSB (sometimes called "Winkeyer 2") has separate CW and PTT outputs for each radio. 
The 2nd radio CW is enabled from the Winkeyer tab "Use 2nd Output".  

13. SO2R Using the DX Doubler 

13.1. Internal DXD Jumpers 

Internal DX Doubler Jumpers 

Operating 
Mode 

Jumper 
1 

Jumper 
2 

Jumper 
3 

Normal 1-2 4-5 8-9 

Stereo 1-2 5-6 8-9 

 
The Normal Mode is the CT/TR/WriteLog settings in the manual. N1MM uses the same convention as 
CT/TR/WriteLog, but the DXD manual does not reflect this.  

13.2. DXD & STEREO Feature 

The STEREO mode is for use with the Top Ten Devices DX Doubler. It will probably work with other 
SO2R controllers which use pin 5 on the LPT port to switch audio between radios.  

The Stereo Mode was fashioned after the NA Stereo feature, i.e. use a keyboard command to toggle 
from the run station's audio in both ears, to one radio in the left ear and other radio in the right ear. 
The Stereo feature toggles pin 5 alternately high and low on the LPT port.  

To use the STEREO feature with the DX Doubler, the DXD should be configured for CT/TR/Writelog 

with the exception of JUMPER 2. Move JUMPER 2 from PINS 4-5 to PINS 5-6. This puts the control 
signal from LPT-pin 5 into the logic in the DXD. Now, with the DXD AUDIO control switch set to "Auto", 
the unshifted tilde (variously called the backquote, grave accent or simply the ` key) will toggle the 
STEREO mode on and off.  

 

Enabling DXD's Stereo Feature 

With the DXD Audio switch in PTT mode, the stereo capability is disabled and the DXD operates 
normally in the PTT mode. 

 
Stereo "ON" will split the audio: Radio-A/left ear, Radio-B/right ear. Stereo "OFF" means full audio 
from the RUN radio in both ears.  



` (backquote or unshifted tilde) 
Toggle 

DXD Audio 
Mode 

Run Radio S&P Radio 

"NA" mode OFF AUTO 

Both Ears 

(TX focus on RUN 
radio) 

Both Ears 

(TX focus on S&P 
radio) 

"NA" mode ON AUTO Left Ear Right Ear 

Auto/PTT OFF PTT Left Ear Right Ear 

Auto/PTT ON PTT 
Both Ears 

(TX focus on RUN 

radio) 

Both Ears 
(TX focus on S&P 

radio) 

 

N1MM further refined the STEREO feature by building the following macros so you can automate the 
process: {STEREOON} {END} {STEREOOFF}  

These macros are included in the function keys (Message Buttons) to switch the audio automatically 

according to the operator's preference. (refer to Macros Definitions, section 36.1.1) If Stereo Macros 
are used, you can momentarily toggle the Stereo state if needed. Once a Fn message is sent that 
includes a macro, the Stereo feature will go back to its programmed state.  

Example for F1 - CQ Message Button : {STEREOON} CQ TEST * * TEST {END} {STEREOOFF}  

14. Sound Card Options 

Option 
#  

Radios  
Play 
WAV 

Files  

Record 
new 
SSB 

messages  

Mute 
mic  

What is 
Recorded  

Switch 
Headphones  

Special 
CD/Aux 
Cable 

Required  

Comments 

1 1 Yes Yes Yes 
Two channels 

heard 
No No 

Normal one-radio 

setup 

2 2 Yes Yes Yes 
One channel 

for each radio 
No No 

External switching 
required for SO2R 

3 2 Yes Yes Yes 
One channel 

for each radio 
CW/Digi Only Yes 

External switching 
required for SSB 
SO2R 

4 2 Yes Yes Yes 
Two channels 

heard 
All modes Yes $5 SO2R 

 

Two soundcard SO2R or $5 SO2R is a cheap way to get into SO2R. The only extra device needed to 
your computer is an extra $5 soundcard and some cables to the radios. Serious competitors should 
probably use a hardware device that can insure lockout.  

14.1. Soundcard Option #1: Zero or Single Card, One radio, No Soundcard SO2R 

One radio and one soundcard to play wav files and record new messages and mute the microphone 
when playing wav files.  

Select '1 - Single Card - One radio, No Soundcard SO2R' on the 'Audio' tab and setup the top part of 
this dialog.  
The sound is centered rather than set to a radio channel.  



 
 
 

14.2. Soundcard Option #2: Singlecard - Two radio, No Soundcard SO2R 

Not SO2R but two radios and one soundcard to play wav files and record both radios.  
Select '2 - Single Card - Two radio, No Soundcard SO2R' on the 'Audio' tab and setup the top part of 
this dialog.  

 
 
 



14.3. Soundcard Option #3: Single Card - Two radio, Soundcard SO2R, CW Only 

In order to use SO2R with one soundcard, CW only, you'll need to define your radios as SO2R in the 
Hardware tab and select '3 - Single Card - Two radio, Soundcard SO2R, CW Only' on the 'Audio' tab. 
Setup the top and bottom parts of this dialog.  

 
 
 

 

SO2R with one soundcard. The drawback here is that no switching of the phones is done.  
Note that you will have to wire a cable to the cd or aux input of a soundcard in order to make use of 
this feature.  



 
 
 

 

This is an example how to set up the configurer. Note that the top part should not matter. For #3, we 
are interested in the bottom frame.  



 
 
 

 

This picture shows the mixer for my sound card (windows default mixer). The mute buttons and the 
balance sliders will change while CQing, then back after the message is over.  

14.4. Soundcard Option #4: Dual Cards - Two radio, Soundcard SO2R 

Kudos to David, K1TTT for coding all the interfaces necessary to allow SO2R with two cheap 
soundcards. Check the pictures below and see how easy it all is. K1TTT also designed the switching 
rules and wiring.  
Note that you will have to wire a cable to the cd or aux input of a soundcard in order to make use of 

this feature.  
In order to use SO2R with two soundcards, you'll need to define your radios as SO2R in the Hardware 
tab and select '4 - Dual Cards - Two radio, Sound Card SO2R' on the 'Audio' tab. Setup the top and 
bottom parts of this dialog.  



 
 
 

 

CW - Yes, it will work for CW as well. The CW is not shown since you already have solutions for that. 
You can use separate serial, parallel or USB ports to separate the CW. You can use radio or 
Serial/Parallel/USB port PTT to two rigs. If you want to, you can use pin 14 and a relay to switch, but 
that is not necessary. The headphones work the same for either mode.  

RTTY - We have not discussed the implications for RTTY yet.  

Mode  

INPUT 

Keyboard 
Focus  

INPUT 

CQ 
Playing  

INPUT 
Dual  

OUTPUT 
SndCard 

Left 
Input  

OUTPUT 
SndCard 

Right 
Input  

OUTPUT 
Radio 
Left 
Dual  

OUTPUT 
Radio 
Right 
Dual  

OUTPUT 
Audio 
Left 
Ear  

OUTPUT 
Audio 
Right 
Ear 

Auto Left None Off Left Right Off Off L-main R-main 

- Left Left 
Off/R-
on? 

Mute Center Off 
Off/Note 

1 
R-main 

R-
main/sub? 

- Left Right 
Off/L-
on? 

Center Mute 
Off/Note 

1 
Off L-main 

L-
main/sub? 

- Right None Off Left Right Off Off L-main R-main 

- Right Left 
Off/R-

on? 
Mute Center Off 

Off/Note 

1 
R-main 

R-

main/sub? 

- Right Right 
Off/L-
on? 

Center Mute 
Off/Note 

1 
Off L-main 

L-
main/sub? 

One rig Left None Don't Center Mute NC NC L-main L-



Mode  
INPUT 

Keyboard 
Focus  

INPUT 
CQ 

Playing  

INPUT 
Dual  

OUTPUT 
SndCard 

Left 

Input  

OUTPUT 
SndCard 

Right 

Input  

OUTPUT 
Radio 
Left 

Dual  

OUTPUT 
Radio 
Right 

Dual  

OUTPUT 
Audio 
Left 

Ear  

OUTPUT 
Audio 
Right 

Ear 

auto care main/sub? 

- Left Left 
Don't 
care 

Mute Center NC NC R-main 
R-

main/sub? 

- Left Right 
Don't 
care 

Center Mute NC NC L-main 
L-

main/sub? 

- Right None 
Don't 
care 

Mute Center NC NC R-main 
R-

main/sub? 

- Right Left 
Don't 
care 

Mute Center NC NC R-main 
R-

main/sub? 

- Right Right 
Don't 
care 

Center Mute NC NC L-main 
L-

main/sub? 

Manual Left 
Don't 

care 

Don't 

care 
Center Mute NC NC L-main 

L-

main/sub? 

- Left 
Don't 
care 

Don't 
care 

Center Mute NC NC L-main 
L-

main/sub? 

- Left 
Don't 
care 

Don't 
care 

Center Mute NC NC L-main 
L-

main/sub? 

- Right 
Don't 
care 

Don't 
care 

Mute Center NC NC R-main 
R-

main/sub? 

- Right 
Don't 
care 

Don't 
care 

Mute Center NC NC R-main 
R-

main/sub? 

- Right 
Don't 
care 

Don't 
care 

Mute Center NC NC R-main 
R-

main/sub? 

 
NC - no change, whatever user has set  

Note 1 - could use dual on non-CQ-ing radio while cq is playing on the other one, but would have to 
switch off when cq stops to get back to just main for full stereo. This would mean having some way to 
save the dual setting for the non-cq radio and switching it on/off for each cq. Maybe useful for times 
when doing dueling cq on combinations like 20 and 40m where you wanted to listen on both vfo's on 
40m. This is the case I would probably prohibit and always force dual off on both radios for full auto. 
Or if dual was on prohibit full auto and force one rig auto instead.  

15. LPT Port Basic SO2R Controller Design 

A basic SO2R controller design ... it's about as simple as there is but it works well with N1MM (or 
Writelog) in LPT mode. I decided to add support for CW from the LPT - the PTT relay can be replaced 

with a SPDT relay if CW is taken from two COM ports or Winkeyer USB is used (better). Joe, W4TV - 
5/30/2009 - Revision 1.0  

15.1. Basic SO2R LPT Port - Receive Interface 



 
 
 

 
SO2R LPT Receive interface  

15.2. Basic SO2R LPT Port - Transmit Interface 

SO2R LPT Transmit interface  



 
 
 

16. Advanced SO2R 

Advanced SO2R is a powerful feature intended for SO2R operators and is totally unique to N1MM. It 
can be used as an alternative to the FocusOther feature explained below. The feature automatically 
moves RX focus to where it logically should be for the SO2R operator. The two main scenarios 
Advanced SO2R addresses for SO2R are:  



Tuning the S&P radio will grab RX focus (i.e. when you are looking for mults) When the Run Radio 
finishes sending a CQ, RX focus moves back to the Run Radio.  

Advanced SO2R Rules for Moving RX Focus 

SO2R Rule Operating Implications 

Advanced 
Rule #1 

Tuning either VFO/Radio will result in the RX focus moving to that VFO/Radio if, and 
only if, both entry windows have empty call fields 

Advanced 
Rule #2 

RX focus is moved to the Run/TX radio when it finishes sending CQ (or Fn) message, 
UNLESS there is text entered in the S&P Entry Window 

Focus Anti-

Bounce 
(FaB) 

After CQ (or Fn) has been sent on the Run Radio and RX focus has moved to that 
radio, don't let tuning of S&P radio grab RX focus until 1000 ms has passed 

16.1. Advanced SO2R Theory of Operation 

Advanced SO2R will only move RX focus if there's no callsign (or partial callsigns) in either Entry 
Window. If there's a callsign (or partial callsign) in either Entry Window, it's assumed that the SO2R 
operator will want to control where RX focus should be.  

Basic Scenario: If you are CQing on VFO/Radio A, and S&Ping on VFO/Radio B, as you tune the S&P 
radio, Advanced SO2R assumes the SO2R op will want RX focus on the S&P radio so he can type in a 

callsign to see if it's needed. At the end of a CQ on the Run radio, if there is no callsign in the S&P 
window, RX focus is moved back to the Run Radio in anticipation of someone answering your CQ. If no 
one calls on the Run Radio, and you continue to QSY on the S&P Radio, the RX focus will automatically 
move back to the S&P radio again after a 1000 ms delay (learn more about the 1000 ms delay in the 
Focus anti-Bounce paragraph below).  

As you S&P during a CQ (or any sent Fn message) on the Run Radio, and you type a callsign into the 
S&P Entry window, at the end of a Run CQ (or Fn), RX focus will stay on the S&P radio. It's assumed if 
you have a callsign in (any) Entry window, that you will want RX focus to stay where it is to finish that 
QSO.  

If someone answers your CQ on the Run radio, and there's a callsign in the S&P window, it's up to you 
to decide who you will work, and where RX focus should be: do you finish working the S&P QSO, or 

move RX focus to the Run Radio to work the new caller? If you want to answer the response to your 
CQ, use the \ to move RX focus from the S&P Radio to the Run Radio. Otherwise leave RX focus on the 
S&P radio so you can finish working the S&P QSO and then hit \ to get back to the Run radio (this can 
be automated by inserting the {JUMPRX} macro if desired).  

Let's say that someone just answered your CQ on the Run radio (of course Advanced SO2R has 
already moved RX focus there from the S&P radio) and you have entered a callsign in the Run Entry 
Window. As you tune the S&P radio while you are working the guy on the Run Radio, RX focus will 

stay on the Run Entry Window. It's assumed that you will not want RX focus moved to the S&P radio 
during the middle of a Run QSO. After you log the Run QSO, and you continue to tune the S&P radio, 
RX focus will again move to the S&P radio if there's nothing in the Run Entry Window.  

Focus anti-Bounce (FaB): was created for the serious SO2R op who's got both right and left audio 

listening to the S&P radio while transmitting on the Run Radio. Let's say you are CQing on the Run 
Radio, and tuning on the S&P radio. Many SO2R ops will not be listening to the Run radio CQ sidetone, 
and will only be listening to the S&P radio. If you are still tuning the S&P radio when the CQ just 
finished, FaB will keep RX focus on the Run radio for 1000 ms. This brief delay will let you stop tuning 
the S&P radio, so RX focus stays on the Run Radio. If FaB wasn't there, and you didn't realize that the 



CQ was over, RX focus would bounce to the Run Radio at the end of a CQ, and then bounce back to 

the S&P radio since you are still QSYing. Thus if someone answered your CQ, you would often type 
that callsign in the S&P radio/entry window!  

However, there are some serious operational issues associated with the use of Advanced SO2R and 
Focus anti-Bounce, as explained by Steve, N2IC  

 

The primary difference between Advanced SO2R and FOOR is the Focus Anti-Bounce  
(FAB) feature in Advanced SO2R. I tried Advanced SO2R when I first started using  
N1MM Logger in 2006, and disliked the FAB. Here was the scenario:  

I finish a CQ, there is no call in the S&P window, so focus (and radio audio)  
automatically moves back to the CQ radio. Ideally, there is a single loud,  
competent caller on the CQ radio and I quickly type in a call and proceed with a  

QSO. But, bad things do happen with surprising frequency. Let's say I'm slow to  
stop changing the S&P radio frequency, and continuing changing the frequency of  
the S&P radio, even after the CQ ends. That's very easy to do, because you are  
now listening on the CQ radio, and don't even realize your hand is still tuning  
the S&P radio. Now, as an example, someone calls you on the CQ radio at 20 WPM,  
sending first my call, then, finally, their call. By the time they send their  
call and I start typing in the Entry Window, the FAB has moved me back to my S&P  

radio. Bad ! Another scenario is that there is an undecipherable pileup calling  
me. It can take me several seconds to pull out a call fragment and enter it in  
the Entry Window. Before that happens, FAB has slammed back to the S&P radio.  

There are other variants on this. Given the nature of the radio polling and  
radio frequency responses sent to N1MM Logger, it's very probable that a S&P  
radio frequency change will be erroneously detected after the CQ has ended, even  
though you have stopped tuning the S&P radio. This will provoke FAB into  
erroneously switching back to the S&P radio.  

Now, look at what happens with Advanced SO2R off and FOOR on. The CQ finishes  
and focus moves back to the CQ radio. Focus stays on the CQ radio, no matter how  
long I linger. No unplanned FAB shifts to the S&P radio. If I determine that no  

one is calling, I hit Enter to start a new CQ, and FOOR moves focus back to the  
S&P radio until the CQ ends. It's all very simple, deterministic, and effective.  
Just what you want in the heat of a contest - no surprises (except for the  
surprise of a rare multiplier calling you).  

16.2. Advanced SO2R Controls and Macros 

SO2R Macro  Operating Implications 

ON/OFF Macro 
You can turn on/off Advanced SO2R by using macros in CW/SSB key 

buttons: {ADVSO2RON} {ADVSO2ROFF} 

ON/OFF Shortcut Turn on/off Advanced SO2R with Ctrl+Shift+I 

RX Focus Control 

(Override) 

The backslash key (\) will always move RX focus to the "opposite" 
vfo/radio and stays there until another action/state 
takes RX focus control (in case RX focus ends up where you don't want it) 

Focus Anti-Bounce 
(see above) 

Advanced SO2R now has an adjustable delay (called Focus Anti-bounce) set 
via CTRL+SHIFT+N 



 

RULE: Tuning either VFO/Radio will result in the RX focus moving to that VFO/Radio if, and only if, 
both entry windows' call fields are blank.  

Radio A... 
Callsign 

Field 

 
Exchange 

Field 

 
 

Is: 

Radio B... 
Callsign 

Field 

 
Exchange 

Field 

 
 

Is: 

 
 

Focus Does: 

~|~ 
~|~ 
~|~ 
~|~ 
~|~ 

Tuning VFO 

~|~ 
Focus moves to VFOx 

      

~|~ 
~|~ 

Tuning VFO 
~|~ 

~|~ 
~|~ 
~|~ 

Focus moves to VFOx 

      

Filled 
~|~ 
~|~ 

~|~ 
~|~ 
~|~ 

Tune VFO B 
~|~ 

Focus stays where it was (VFO A) 

      

~|~ 

Filled 
~|~ 
~|~ 
~|~ 
~|~ 

Tune VFO A 

~|~ 
Focus stays where it was (VFO A) 

      

~|~ 
~|~ 

Tune VFO A 
~|~ 

Filled 

~|~ 
~|~ 
~|~ 

Focus stays where it was (VFO  

      

~|~ 
~|~ 

Tune VFO  
~|~ 
~|~ 

      



Radio A... 
Callsign 

Field 

 
Exchange 

Field 

 
 

Is: 

Radio B... 
Callsign 

Field 

 
Exchange 

Field 

 
 

Is: 

 
 

Focus Does: 

Filled 
~|~ 
~|~ 

Focus stays where it was (VFO  

17. Focus on Other Radio (FocusOther) 

A method of focus control, preferred by many contesters over "Advanced SO2R". When FocusOther is 
active, the RX focus is automatically shifted between the "Run" radio and the "S&P" radio, depending 

on whether the Run radio is transmitting. When the Run radio is transmitting, RX focus is shifted to 
the S&P radio. When the Run radio stops transmitting, RX focus shifts back to the Run radio, unless an 

unworked callsign has been entered in the S&P entry window. This allows a callsign to be entered in 
the S&P radio Entry Window while CQ is being sent on the Run radio.  

18. SO2R and MMTTY 

Instructions for setting up two copies of MMTTY for use in SO2R (Note: there are more detailed 
instructions on setting up for digital modes in the Digital Modes section - this section focuses on the 
SO2R aspects):  

 Create two separate folders for the two copies of MMTTY. This allows each copy to have its 

own configuration  
o Copy the MMTTY.exe, MMTTY.ini and UserPara.ini files (plus extfsk.dll, if you use 

EXTFSK) from the main MMTTY program folder into each of the two folders you will 
use for SO2R  

 Start N1MM Logger and open the Configurer (Config > Configure Ports, Audio, Mode Control, 

Other)  

 Select the Digital Modes tab  
o Under Digital Interface 1, TU Type, select Soundcard. Similarly for Digital Interface 2  
o Under DI-1 MMTTY Setup, select AFSK or FSK as appropriate for your setup and set 

the MMTTY Path to point to the copy of MMTTY.exe in the first folder  
o Under DI-2 MMTTY Setup, select AFSK or FSK as appropriate and set the MMTTY Path 

to point to the copy of MMTTY.exe in the second folder  

 Select the Hardware tab  

o Select the SO2R option  
o This next step is optional for many users, but mandatory for some. If you are using 

serial ports for PTT and/or FSK from MMTTY, you may wish or need to check the 
Digital check box beside the ports used by the two copies of MMTTY. This step is 
necessary if you use the same port for CW or PTT keying from N1MM Logger in CW or 
SSB modes; if the only place you use a port is from MMTTY, the step is optional; and if 
the port number is higher than 8, you have to skip this step and perform all of the 

setup for this port within MMTTY  
 Click on the Set button for the port you will use with Radio 1 and set the Radio 

Nr and the Dig Wnd Nr both to 1  
 Click on the Set button for the port you will use with Radio 2 and set the Radio 

Nr and the Dig Wnd Nr both to 2  

 Close the Configurer  

 Open the Digital Interface 1 Window (Window > Digital Interface menu item in the main or 
Radio 1 Entry window)  



o If an MMTTY window does not appear (e.g. if you see an MMVARI window instead), 

then in the DI Window select the Interface > MMTTY menu item to open the MMTTY 
window  

o Select the Setup > Settings menu item  

 Under Preferred RTTY Interface (lower left), select MMTTY  
 Under Alignment Frequency (lower right), enter your Mark audio frequency 

(e.g. 2125)  
 Click on Save Configuration  

o In the DI Window, select the Setup > Setup MMTTY menu item  
 Select the TX tab and set the PTT & FSK port you will be using for the Radio 1 

copy of MMTTY  

 Select the SoundCard tab (MMTTY version 1.66 or newer) and select the 
Reception sound card you will use with Radio 1. If you are using AFSK, you 
must also select the Transmission sound card  

 Under the Misc tab, select the channel (left or right) under Source. If you are 
using an older version of MMTTY, you may also have to set the Device 
numbers (this is not necessary if you have selected the sound card using the 

SoundCard tab)  
 Close the MMTTY Setup window  

 If the second Entry window is not open, open it by pressing the Pause key, the backslash (\) 
key or Ctrl+Right Arrow. In this window, select the Window > Digital Interface menu item to 

open the second Digital Interface window. Repeat the above steps using the COM port, sound 
card device and channel you will use with Radio 2  

 

18.1. SO2R RTTY with 1 Soundcard 

If you have a two-channel sound card and the necessary stereo Y cable to send audio output from 
both radios to the line input of the same sound card (left radio on the left channel, right radio on the 

right channel), you may be able to use a single sound card for SO2R RTTY. Just set both MMTTY 
instances to the same card, and in the configuration for each copy of MMTTY select the appropriate 

channel for that radio. Note that for AFSK transmit, MMTTY only uses the left channel regardless of 
which channel it is using on receive. Therefore if you are using AFSK for transmitting you will have to 
route the audio output from the left channel of the sound card to the audio inputs on both radios and 
rely on the SO2R switching to control which radio gets PTT.  

If your sound card does not support separate inputs for the two channels, such as a laptop sound card 
with only a mono mic input, you won't be able to do this and you will have to use two sound cards for 
SO2R.  

19. Example Screen Layouts 

Below two screen shots for SO2R. Notice the window symmetry for left and right VFO, as well as left 
and right band map. Essential information that is used by both radios was placed in the center: Check 

Window and Log Window. Of course other operators may have different preferences regarding window 
layout - but the most intuitive is to have the window layout reflect the equipment configuration.  



 
 
 

 
The screen above was taken by K2KW from a 17" screen.  



 
 
 

 
The screen shot above was taken by F6IRF and gives an example of a SO2R screen for RTTY.  

 

2.8.3 Single Operator Split Operation 

 2.8.3 Single Operator Split Operation  

o 1. Am I Transmitting Split?  
o 2. Setting Split Transmit Frequencies Manually  
o 3. Split Mode and Frequencies Set Automatically from Cluster Spots  
o 4. Resetting to Non-Split Mode  
o 5. Split Operation Key Assignments  
o 6. Split mode vs. SO2V  

Split operation is when you transmit on a frequency different from the one where you are listening. 
This is often used when stations have huge pileups like some DXpeditions, or when frequency 
allocations do not allow people in different countries or IARU regions to make contact on the same 



frequency. An example is 40 meter SSB between Europe and the USA. Many European stations 

operate below 7.125 MHz, the bottom edge of the US allocation. When N1MM Logger is controlling a 
transceiver with split capability, the program enables you to split and "unsplit", to change frequencies, 
and perform other useful operations.  

When used in this manual, the term "split frequency" always refers to the transmitting frequency. The 
assumption is that you will listen first, either to identify a station to call or a clear listening frequency 
to use while running, and then set your transmit frequency.  

1. Am I Transmitting Split? 

There are a number of ways that the program tells you whether you are in Split mode, which can 
avoid some embarrassing moments or potentially, a citation for out-of-band operation. In the Entry 
window Split is displayed in the title bar. The receive frequency is always displayed first, and the 
transmit frequency in parentheses, as in this example.  

 

In the Bandmap, there are two sets of indicators, shown in this example.  



 

You'll notice that the receive frequency is shown in bold blue letters at the top of the Bandmap, and 
the transmit frequency is shown below it in smaller type. You are also reminded by the indicators for 
your receive frequency (always blue) and your separate transmit frequency (always red).  

Clicking on either the receive or transmit frequencies in the top part of the Bandmap will toggle split 
operation.  

 

Running While Split 

Some people prefer to be in Split mode while running, in order to use the main tuning knob to tune in 

calling stations that are off frequency. One drawback is that if you tune your receive frequency outside 
the tuning tolerance set on the "Other" tab in Config > Ports,Other, the program switches from Run 
mode to S&P. The way to avoid this is to use Alt+F11 to temporarily lock the program in the current 
mode. That is, if you press Alt+F11, the program will not automatically change modes when you tune. 
Press Alt+F11 again to return to normal operation.  

2. Setting Split Transmit Frequencies Manually 



The easiest way to set a split transmit frequency is to type the desired frequency in kHz into the 

Callsign textbox in the Entry window, and then hit Ctrl+Enter. Another alternative is to use Alt+F7 to 
open the Split dialog, type the transmit frequency, and hit Enter. The split frequency may be entered 
either in full (e.g. 7027), as a difference from the lower band edge (e.g. 27), or as a positive or 

negative difference from the receive frequency (e.g. +2) . Decimals are allowed (7032.3, or 7032,3 if 
your regional preferences in Windows use the comma as the decimal separator).  

3. Split Mode and Frequencies Set Automatically from Cluster Spots 

If you click on a station in the Bandmap which was spotted with a QSX (transmit) frequency specified 
— in the format "DX PA1T 7095 QSX 7130"), the radio will be put into split mode and the frequencies 
set automatically. You will be set up to transmit on 7130 (in this example).  

4. Resetting to Non-Split Mode 

Resetting to non-split mode is done by moving to another frequency or band, using the program to 
do so. Simply turning the VFO on your transceiver will not do it. You can:  

 Click on another spot or frequency in the Bandmap  

 Click on a non-split spot in the Packet/Telnet window  

 Click on the transmit frequency or receive frequency in the top part of the Bandmap  

 Click on a band button in the Available Mult's & Q's window to change bands  

 Press Ctrl+PgUp or Ctrl+PgDn (which also changes bands)  

 

Icom Precautions 

Icom radios can't report VFO B without being set to VFO B, and don't report whether the radio is in 
Split mode. To operate split successfully, you need to set and cancel splits solely from the computer. 

Use Ctrl+Enter or Alt+F7, as above. Only turn Split on/off from the keyboard/program and not on the 
radio, to make sure it stays in sync with the program. 

5. Split Operation Key Assignments 

Alt+F7 - Set split frequency or offset from current frequency for the active radio. When hitting Enter 
or click OK with nothing on the line split will be cleared. Press ESC or click Cancel to exit.  

Alt+S - When your rig is in Split mode, Alt+S will reset the receive frequency back to your transmit 
frequency, but the split mode is preserved. This is used to run a pileup with the rig in split mode. With 
a radio which has VFO A/B they use the 2nd VFO as an RIT. This is done since many RIT knobs are 
small or hard to get at, while some find it more natural to use the main VFO to tune in a caller rather 

than use the RIT. By running split, you can use the main knob to tune in the caller, while your TX 
frequency doesn't change. The Alt+S acts like an "RIT clear" when you are running split.  

This operates on VFO-A only. With Main/Sub radios like the Icom 756/7800 series you can not RX on 

SUB without receiving on both VFOs. In this case put RX on Main and TX on SUB for Alt+S to work.  

"Reset RX freq when running split", an option found on the Entry window's Config menu, is a way of 

automating the Alt+S function. When this option is checked, the program will automatically do an 
Alt+S as you log each QSO. This gives you an automated ÃƒÂ¢Ã¢â€šÂ¬Ã…â€œRIT clear" after every 
QSO when you are running split.  

Ctrl+S - When not in split mode, the first press of this combination puts the radio and program into 
Split mode. After that Ctrl+S will toggle the RX frequency between the split RX frequency and the 
RX/TX frequency while maintaining split mode. Application: This was designed primarily to help SSB 



operators run on 40 or 80mM where split operation is widely used. For example, "CQ CQ de N1MM 

listening on this frequency (7183) and 7068". Use the Ctrl+S key to toggle between 7183 and 7068 to 
check for both USA or DX callers.  

Ctrl+Alt+S - Toggle Split mode on the radio. 'Split' will be shown in the Entry window.  

Ctrl+Enter - Entering a frequency or offset in the callsign with Ctrl+Enter will set a split frequency.  

 

Using Split - Some Hints 

Click on a spot in the Bandmap or Available window. Then look at the Bandmap or the Entry window 
title bar to see if you are going to transmit out-of-band. If you SINGLE-click on a spot on 40 or 80, 
and don't see the split indicator, then wait for the station to announce his listening frequency. If he 
says "listening 214.5", type 214.5 in the Callsign textbox and press Ctrl+Enter - you are then ready to 

call him.  

6. Split mode vs. SO2V 

 
With a dual-receiver radio, the difference between Split mode and dual receive operation can be 
tricky. If both receivers are on, the radio is set up exactly the same way for split from the VFO A Entry 
window (listen to the other station on VFO A, monitor your transmit frequency on VFO B, transmit on 
VFO B ) and for SO2V with the Entry window focus on VFO B (conduct a simplex QSO on VFO B while 
monitoring the VFO A receiver somewhere else on the band). However, although these two situations 

are identical on the radio, they are quite different in the logging software. In the split operation 
scenario, the QSO is logged from the VFO A Entry window, with different RX (VFO A ) and TX (VFO B ) 
frequencies in the log. In the SO2V scenario, the QSO is logged from the VFO B Entry window with the 
RX and TX frequencies the same (both from VFO B ).  

By changing the transmit VFO from VFO B to VFO A, you can switch to either one of two new 

situations - split from the VFO B Entry window (listen to the other station on VFO B, monitor your 
transmit frequency and transmit on VFO A ) or SO2V with the Entry window focus on VFO A (conduct a 
simplex QSO on VFO A while monitoring the VFO B frequency somewhere else on the band). Again, 

these two are the same on the radio, but different in the logging software - split logged from the VFO 
B Entry window with different RX and TX frequencies in the log vs. SO2V logged from the VFO A Entry 
window.  

Because there are four possible logging scenarios but only two different radio configurations, you 
cannot depend on making adjustments from the radio to get QSOs logged correctly. By default, in 
SO2V mode with both receivers active, N1MM Logger will assume you are operating in one of the two 
SO2V modes and will log QSOs using the callsign and exchange from the active Entry window and 
logging both TX and RX frequencies from the active Entry window's VFO.  

It is possible to work and log split mode QSOs in SO2V mode, but it takes care and practice to get it 
right. In order to work and log QSOs in split while the Logger is in SO2V mode, you must tell the 

Logger that you are operating split. Since you cannot do this from the radio, you must turn Split on or 
off from the keyboard/program, using Ctrl+S and Ctrl+Alt+S. You need to take care to do this from 

the correct entry window (the one whose VFO you are receiving the other station on), and to be aware 
at all times of which frequency you are transmitting on.  

 

2.8.4 Single Operator Call Stacking 



 2.8.4 Single Operator Call Stacking  

o 1. Call Stacking Overview  
o 2. Additional SOCALLSTACK Information  
o 3. Digital Call Stacking  
o 4. How to Tell Visually Which Call Will be Put in Next  

1. Call Stacking Overview 

Macros and keystrokes used for call stacking are {SOCALLSTACK}, {STACKANOTHER}, CTRL+ALT+G, 
{LOGTHENPOP}, and ALT+D. The first three are used to place calls onto the stack and the last two are 
used to take calls off the stack. The macros only operate in RUN mode and stacked callsigns appear in 
the Bandmap on your RUN frequency. SOCallstacking is functional in CW, phone, and digital modes 
and is compatible with manual key operation or ESM. It can also be used in SO1V, SO2V and SO2R 
modes and in multi-station environments.  

{SOCALLSTACK} or {STACKANOTHER} or CTRL+ALT+G  

The operator can stack a full callsign or a partial callsign that may include a "?" and it will be 
highlighted when that callsign is removed from the stack. The operation of the {SOCALLSTACK} and 
{STACKANOTHER} macros differ slightly.  

{STACKANOTHER} or the keystroke short cut, CTRL+ALT+G, simply pushes callsigns onto the 
stack and clears the Entry Window callsign box.  

{SOCALLSTACK} functions as a single level stack macro. The first execution of {SOCALLSTACK}, 
stacks the first callsign and clears the Entry Window callsign line. When a second callsign is entered 
and {SOCALLSTACK} is executed again, the two callsigns are exchanged. If the callsign window is 
empty when {SOCALLSTACK} is executed, the callsign is removed from the stack and placed into the 
callsign Entry Window.  

{LOGTHENPOP}, ALT+D  
The stacked callsigns can be removed from the stack with several methods. Logging the current call, 

unstacking the next callsign with {LOGTHENPOP} or manually removing the stacked callsign with the 

keystroke ALT+D. The ALT+D keystroke is useful if a callsign appears on the stack via a telnet spot. 
The next callsign on the stack is displayed on the callframe when the CQ-Literal is not present. 
Pressing Space will move a stacked call from the Callframe to the callsign box and remove it from 
Bandmap.  

ESM Automation  
The Configurer, Function Key tab, Next Call Key is used to select the function key that contains the 
{LOGTHENPOP} macro along with the message string for ESM automation. If a Next Call Key has been 
specified, then when Enter is pressed to finish a QSO and there is another call sign on the callsign 
stack, the Next Call Key will be sent instead of the TU(F3) Key. The last option in the drop down menu 
for the Next Call Key allows the ESM SOCallstacking automation to be disabled.  

SOCALLSTACK ESM Example  

Program F9 key to: {STACKANOTHER} or {SOCALLSTACK}  

Program F10 key to: {LOGTHENPOP}TU NW {F5} {F2}  
The appropriate SSB wave file can be inserted into the F10 message in place of the " TU NW" letters 
above. 
 
For example: {LOGTHENPOP}C:\Program Files\N1MM logger\wav\{operator}\TnxNow.wav {F5} {F2}  

Set >Config >Function Key tab >"Next Call Key" to F10  

Select RUN mode and turn ESM on. For this example two stations are calling, N2IC and K3CT  
Type K3CT, press F9, type N2IC and press Enter  



Copy N2IC's report and press Enter. This will log N2IC, send the TU, unstack K3CT, and send the 
exchange  

SOCALLSTACK Non-ESM Example  
Program the function keys as listed above.  
Select RUN mode.  
Type K3CT, press F9, type N2IC and press the exchange key programmed in Configurer, usually ";". 
This key is programmed to F5 & F2.  

Copy N2IC's report and press F10. This will log N2IC, unstack K3CT, and send the exchange  

If multiple callsigns are stacked, ESM will continue to unstack the callsigns. The same is true in non-
ESM mode as F10 is pressed. Should a logging error occur such as a bad call, the sequence will be 
interrupted until the error is corrected. When no calls remain on the stack, the TU message is sent. If 

there are multiple callsigns on the stack, the order that they are removed or exchanged with 
{SOCALLSTACK} depends on the internal sorting order and not the order they were stacked.  

2. Additional SOCALLSTACK Information 

It is important that the contest callsign is entered in the Config, Station Information window. That 
way, the station callsign will not appear in the Bandmap via a telnet spot and the SOCALLSTACK code 
will not place the station callsign or the Busy literal (ALT+M) into the callsign box.  

If a callsign appears on the callsign stack via a telnet spot that you want to remove, use the ALT+D 
keystroke to remove it without popping it off the stack.  

SOCallstacking does overlap slightly with multi-operator call stacking. Multi-operator call stacking is 
the program feature that allows a second operator to listen to the run radio and send calls to the run 
operator's Entry Window.  

3. Digital Call Stacking 

In digital modes there are two different ways to work stations one after the other in series when more 
than one station responds to your CQ. The first method is based on the Single Operator Call Stacking 
described in the previous sections, adapted to use the features of the DI window. The second method, 
using the Grab list, is unique to digital modes.  

LOGTHENPOP: To use this, you must program a function key using the {LOGTHENPOP} macro, e.g.:  
{TX} ! {LOGTHENPOP} TU NW {F5}{F2} {RX}  

When this function key is pressed or clicked on at the end of a QSO instead of the normal TU key, it 
will log the previous contact, pull the top call sign off the single operator call stack in the Bandmap 
window, and send the exchange to the new station. If you designate this function key as the Next Call 
Key in the Configurer under the Function Keys tab, ESM will automatically select this key instead of 
the TU key at the end of a QSO whenever there is an unworked call sign remaining on the call stack in 
the Bandmap. Note that you must use two different function keys for the TU and Next keys; do not 

put {LOGTHENPOP} into the TU key. Don't program the exchange (e.g. # in a serial number contest) 

directly into the Next key; use the {F2} macro to call up your regular exchange message, as in the 
example above. Using # in the Next key will send the wrong serial number.  

How do you get call signs onto the call stack in the bandmap? You can do this effectively in digital 
modes by selecting the Setup > Digital Call Stacking menu item in the Digital Interface window's 
menu bar. This enables an efficient way to place call signs on the single operator call sign stack in the 
Bandmap window. You have three choices, depending on which order you want calls to be popped off 
the stack ready to be worked: Enable using First In First Out (the first call to be worked will be the 
one that was placed on the stack first); Enable using Last In First Out (the first call to be worked will 



be the one that was most recently placed on the stack); and starting with version 12.2.2, Enable using 

FIFO Mults First (callsigns will be taken off the stack in order of their multiplier value. In those 
contests where one QSO can yield 2 or 3 mults, the higher-mult calls will be taken first. Among calls 
with the same multiplier value, the first call to be worked will be the one that was placed on the stack 
first).  

When Digital Call Stacking is enabled and you are in Run mode:  

 If there is already a call sign in the call sign box in the Entry window when you mouse-click on 

another call sign in the RX window, clicking on the new call sign in the RX window will move 
the call sign that was formerly in the Entry window onto the stack in the Bandmap, and will 
bring the new call sign into the Entry window. The call sign that will be removed from the 
stack next will be put in the frame above the call sign box in the Entry window as a reminder 
that it is on the stack, ready to be used by {LOGTHENPOP} at the end of the QSO with the 

first station  

 Alt+left-clicking on a call sign in the RX window will move that call sign directly onto the stack 

in the Bandmap without changing the call sign in the call sign box in the Entry window. You 
can place any number of call signs on the stack ready for working one after the other  

 Instead of using {GRAB} or Alt+G to pull the highlighted call sign off the Grab list into the 

Entry window, you can use {STACKANOTHER} or Ctrl+Alt+G to move that call sign from the 
Grab list directly onto the stack without changing the call sign in the call sign box in the Entry 
window  

 
When Digital Call Stacking is enabled, left-click, Alt+left-click, {GRAB}/Alt+G and 
{STACKANOTHER}/Ctrl+Alt+G give you a variety of ways to choose which call signs you want to place 

onto the call sign stack and into the Entry window. Once there are one or more call signs on the call 
sign stack, after working the first station in the Entry window, the Next key (automated with ESM) lets 
you work the call signs from the stack rapidly one after the other.  

LOGTHENGRAB: There is a separate method that uses the Grab list in the DI window with the 

{LOGTHENGRAB} macro. You do not need to enable Digital Call Stacking to use this method. You can 
use any method you wish to get the first call sign into the Entry window so you can work that station. 
At the end of the QSO with the first station, if you want to work the call sign that is highlighted in the 
Grab list, you can use an F-key or message button that contains:  
{TX} ! {LOGTHENGRAB} TU NW {F5}{F2} {RX}  

This will log the contact with the first station, then grab the highlighted call sign from the Grab list and 
send the exchange to that station. You can repeat this for as long as there are workable call signs 
being highlighted in the Grab list. If the next highlighted call sign in the Grab list is invalid or not 
workable, you should press or click on the normal TU key instead, in order to avoid attempting to work 
a bad call sign. You can also program a {DELSEL} macro into an unused function key or DI message 
button for use in removing unwanted call signs from the Grab list. Don't program the exchange (e.g. 
# in a serial number contest) directly into the function key that has the {LOGTHENGRAB} macro in it 

(the # macro in this key will send the wrong serial number); use the {F2} macro to call up your 
regular exchange message, as in the example above, to get the correct exchange sent to the second 
station.  

Using this method, the Grab list is populated automatically, but you have to decide manually whether 
to use the normal TU function key or the message key containing the {LOGTHENGRAB} macro. This is 
because of the possibility of unwanted or incorrect call signs in the Grab list - it is up to you to decide 
whether the next call in the Grab list is one you want to work using {LOGTHENGRAB}, or whether you 
just want to end the QSO with a normal TU message. Do not put a {LOGTHENGRAB} macro in your 

normal TU function key, or in the Next Call function key if you are using one. {LOGTHENGRAB} must 
be in a separate function key or in one of the DI message buttons.  

4. How to Tell Visually Which Call Will be Put in Next 



If "CQ Frequency" is on the call frame, then look at the Bandmap.  

The {LOGTHENPOP} calls the {SOCALLSTACK} routine. {SOCALLSTACK} will remove the CQ-Literal 
("CQ Frequency") and take the next callsign listed on the Bandmap's run frequency. There are cases 
where the CQ-Literal string will replace the callsign on the call frame. The stacked callsign isn't lost, 
look at the Bandmap.  

The same is true when you are spotted. Your callsign will appear in the call frame but the routine will 
not pop it into the callsign box. If you find that it does, you don't have "your callsign" entered into 
Station Data window. When you use {LOGTHENPOP}or {SOCALLSTACK} they remove the station 
callsign and discard the callsign, then grab the next call on the stack.  

If you have {SOCALLSTACK} programmed to an F-key, pressing it once at any time will exchange the 
current callsign with the next callsign on the stack. If there is no callsign on the stack, then it stacks 

the call and gives you an empty callsign window to enter one. Pressing the F-key again will reverse 
them again.  

 

 

2.9 Multiple Operator Contesting 

 2.9 Multiple Operator Contesting  
o 1. Customization for Multiple Operators  
o 2. Multiple Radios and Multiple Computers  
o 3. Call Stacking (same or different bands) - Networked-Computer Mode  

1. Customization for Multiple Operators 

The simplest form of multi-operator contesting involves a single radio and a single computer, i.e. it is 
just like single-operator contesting except that two or more operators take turns, spelling each other 
off. Of course, you have to ensure the correct entry class is entered in the Contest Setup dialog. If you 
wish to keep track of which contacts were made by which operator, you should use the Ctrl+O key, or 
the OPON direct entry command in the Entry window, and enter the call sign of the incoming operator 
every time the operator is changed. N1MM Logger will keep track of which operator made each 

contact, and that information will be displayed in the Log window. For the simplest setups, including 
CW and RTTY, and SSB without voice keying messages, this is almost all there is to it.  

However, if you are using voice keying messages in a phone contest and you change operators 
without changing the wav files in your messages, the voices heard over the air could vary during a 
single QSO between recorded messages and live voicing. This can be very confusing to the other 
station. To avoid this, it is best to have each operator record a separate complete set of voice keyer 
messages. To do this, create a separate subfolder for each operator within your wav files folder, 
labelled with that operator's call sign. Make sure the path to your wav files in your function key 

messages includes the {OPERATOR} macro, as in wav\{OPERATOR}\CQ.wav. Before the contest, 

have each operator enter his or her call sign with Ctrl+O or OPON and then record all of the voice 
keyer messages in his or her own voice, for example using Ctrl+Shift+Fkey. Once the messages are 
all set up, the Logger will use the operator call sign entered during the contest with Ctrl+O or OPON to 
select which set of recorded messages to use.  

2. Multiple Radios and Multiple Computers 



More elaborate multi-operator setups may involve more than one radio and/or more than one 

networked computer. The details of how to set up a networked computer system are in the Multiple 
Computer Contesting section. 

Many of the features in N1MM Logger's networked-computer support are designed for multi-station 
multi-operator use. These will not be described in full here, but you should be aware of their 
existence:  

 Information about the status of other stations in the network is displayed in the Info window  

 Every computer in the network has a complete copy of the log; however, only the computer 
that originally logged a QSO has the right to edit or delete that QSO, i.e. in effect the QSOs 
from other computers on the network are "read-only"  

 Message passing - you can send text messages to other stations on the network by right-
clicking on the icon for the other station in the Info window, or using {MESSAGE} macros  

 Other stations' CQ frequencies, or "Pass frequencies", are displayed in the Info window and 

can be included automatically in messages such as your TU message using {PASS} macros, to 
ask a station you have just worked to QSY and work one of the other stations  

 

3. Call Stacking (same or different bands) - Networked-Computer 
Mode 

A callsign can be stacked from one radio to another when in 'Networked-Computer Mode'. It does not 

matter if the target station is on a different band or the same band. A second operator can 
stack a call on your PC, and he could find stations and stack them for you to work.  

 To indicate which station you want to stack for, right click on its "cue-ball" in the info window, 
and select the option "Target for call stacking"  

 A maximum of one callsign can be stacked. If the stack is empty another one may be stacked  

 After the target station pops the call into the entry window callsign area, the partner station 
needs to manually wipe his entry line before entering another call. It doesn't automatically 
clear  

 
Stacking within same band but not on the same frequency - Use the bandmap by tuning off a 
station whose callsign you copied.  

Additional functionality when on the same CQ frequency (within tuning tolerance) then you will see 
the other station keystrokes in your callframe and vice-versa.  

 

2.10 Multiple Computer Contesting 

 2.10 Multiple Computer Contesting  
o 1. Features  
o 2. Network Setup and Configuration  

o 3. Networked-Computer Tools Menu  
o 4. Information  

 4.1. Rules  
 4.2. Displaying Rules  

o 5. Macro keys  
o 6. Features  



o 7. Where to Place the Database Files  

o 8. Other Information  
o 9. Example Networked-Computer Setup  

 9.1. Before the Contest  

 9.2. During the Contest  
 9.3. After the Contest  

o 10. Networked-Computer Log Synchronization  
o 11. Multi-Multi Distributed - Networked-Computers via the Internet  

 11.1. Configuration  
 11.2. Footswitch Support for Lockout  

It is possible to use N1MM logger in a multi-computer networking environment, either supporting the 
multi-operator contest categories or for special purposes for a single operator (continuous backup, 
two-computer SO2R, to separate the radio control and Internet access functions into two computers, 

...). For this to work you need at least two networked computers, with a maximum of 16. These 
computers need to have network interface cards or wireless interfaces. The networking protocol used 
is TCP/IP. Each computer has its own separate copy of the database; this is not a client-server shared-

database configuration. Nevertheless, the network needs a so-called "Master" station. The "Master" 
station is the one that sets the time, connects to packet/telnet, etc. The Master station is always 
station number 0, in the "Edit Station Computer Names" table.  

1. Features 

 Maximum of 16 networked computers with one 'master' station (0-15)  

 Use of standard network interface cards (NIC's) and wireless interfaces  

 Dynamic naming or static IP addressing can be used for station identification  

 Connected computers can be on the same subnet, or distributed across a wide area to any 

internet-connected computer  

 Talk capability between networked stations  

 Automatic time synchronization  

 Pass frequency information between stations  

 DX Spots from Telnet or Packet  

o Distributed to all connected computers  
o The ability to send spotting commands from any station on the network  

 Error messages when a station can't be questioned/updated  

 The Info Window gives status information and extra options  

 The Config menu has a special Multi-User Tools menu  

 Auto resync when a station comes on-line  

 

Turning Off Networked-Computer Mode 

NEVER turn off the networked-computer switch during a contest. This results in contacts being logged 
to the wrong station while the networked-computer switch is turned off. During testing, to simulate a 
network failure, kill the ethernet connection. 

2. Network Setup and Configuration 

These instructions assume that your computer network is setup and working correctly. You must be 
able to ping every computer from every other computer before proceeding with these instructions. It 
does not matter whether your network connections are twisted pair, CAT5, wireless, etc - as long as 
the PCs can all see each other. There is no need to 'see' all the other computers in the Windows 
'Networking environment' (My Network Places etc.), but this may be helpful for 

sharing/copying/updating files outside of N1MM Logger.  
Networks connected using serial ports (older DOS programs) are not supported.  



 

Problems with Windows XP/SP2 and IP address range 10.x.x.x. 

Windows XP/SP2 has known problems when using the 10.x.x.x range and subnet mask 
255.255.255.0. If you must use 10.x.x.x., set the subnet mask to 255.0.0.0. If possible, the IP 

address range 192.168.x.x range is recommended, with a subnet mask of 255.255.255.0 

 Setup all the computers  
o Setup all the computers with their radio's as if they were being used stand-alone. 

Verify that the radio can be controlled, PTT/CW/.Wav files are working etc.  
o All computers must use the same version of the program N1MM Logger  

 Designate one computer to be defined as the Master station, and the rest of the computers to 
be Slave stations.  

 Only for the Master station  

o Packet/Telnet has to be working only on this computer  
o Set the computer clock to the correct time. Every computer will use this time! (See 

http://www.m0ukd.com/temp/Time_Sync_Interval_Change_Vista_XP.pdf  for how to 

change the Windows time interval to something less than every 7 days.)  
o This has to be station 0 in >Config >Edit Station Computer Names!  

 All other networked stations (slave stations, not the Master station 0)  
o Select >Window >Packet/Telnet, "Telnet" tab to see the DX cluster feed from the 

master station  
 Always use the "Telnet" tab on the slaves, regardless of the Packet or Telnet 

setting on the master station  
 The "Packet" tab will not give any info on a slave computer  

 Define the station numbers, station names, and computer IP addresses (or Windows names) 
on all computers. The definitions must be identical in all >Config >Edit Station Computer 

Names tables before starting Multi-User mode. Your window will be similar to this one. This is 
an example of a five station network.  

 

 Go to >Config >Edit Station Computer Names  
o Stn # (0-15): Stn Name column - Enter the station number starting with 0 for the 

master station. A station name can optionally be entered after a colon : (for example 
0:15m) The station name can be assigned independently from the Windows computer 
(NetBIOS) name. The Master station MUST BE number 0 and the others must be 
numbered 1, 2, 3, etc., in order.  

o Computer IP Address column - Enter the computer IP address or the Windows 
computer name. Your choice depends on whether the computers are using DYNAMIC 
or STATIC IP addresses. If you don't know which, it's safest to use the Windows 
computer name when setting station computer names. If the computer uses dynamic 
IP addresses (DHCP), you should always use the Windows computer name. If the 
computer uses static IP addresses, you can use either the IP address or the Windows 

http://www.m0ukd.com/temp/Time_Sync_Interval_Change_Vista_XP.pdf


computer name. Most computers that interface to the internet are set for dynamic IP 

addresses. The use of static IP addresses in an N1MM Logger network is strongly 
recommended.  

 NOTE: In the above example, the 10-160m, 15m, and 80m stations are using 

static IP addresses, and the 20m and 40m computers have dynamic IP 
addresses  

o To check or create your Windows computer names, go to: Windows >Control Panel 
>System. In the Systems Properties window that opens, click on the Computer Name 
tab. The computer name will appear there. To change the computer name, click on the 
"Change" button in this window  

 NOTE: Verify the "WORKGROUP" name is the same on all workstations. Any 

deviation in the workgroup name will prevent basic Windows communication 
between the workstations (not needed for N1MM Logger but it is desirable for 
copying files among the computers on the network).  

o To check the IP address of your workstation, look at the title bar of the N1MM Logger 
>Config >Edit Station Computer Names window. The IP address will be displayed 
there, as shown in the graphic above. The following method allows you to check and 

change a static IP address if necessary. Go to: Windows > Control Panel > Network 
Connections > Right Click on the connection that's used to access the internet and 
select Properties. In the new window, go to the middle box with the slider and find the 
line with Internet Protocol (TCP/IP) and double click on that line. In the new window 
on the "General" tab, check or set your IP address.  

 NOTE: Each workstation on the network must have a unique IP address 
assignment.  

o If you do not use a local IP for your address, put an asterisk in the description for the 
node, so that the program will know not to connect to that port  

o An error dialog will be shown when a station connects from an unexpected IP address  

 All the computers must have the same settings in the "Edit Station Computer 

Names" table, in the same order. Don't swap any entries!  

 A warning is shown if a blank entry has been added to the multi-computer station table. A 
blank entry can cause computers to not be able to connect to each other  

 

Copying Setup Information 

The setup information is kept in the database. The network configuration will apply to all contest logs 
stored within the database. To save time, you can set up the contest & the Multi-User configuration 

info on one computer including messages etc. and then copy the database (*.mdb file) to all the other 
computers. Next, start Logger, select the database, and select the contest. Enable Multi-User mode 
and all workstations should come online within a minute or less. 

 Start Networked-Computer mode  
o Go to >Config >Networked-Computer Mode.  

Clicking on this selection will enable this option.  

 

Number Your Networked Computers 

Multi-2 support: You need to identify which station is run1 and which is run 2. There is a large blue 

number in the Info Window to remind you what you have set for that station. Set up Run radio 2 in 
the Networked-Computer Tools menu as: Set station as Run 2. In the Configurer under Setup Run 
radio 1 to use Port 1 and Run radio 2 to use Port 2 (so not both to Both, 1 or 2) 

3. Networked-Computer Tools Menu 



NB - this section is currently undergoing extensive revision.  

Adding and deleting QSOs all works automatically. Also that the bandmaps are filled with spots from 
the packet/telnet connection from the "Master" station. Below are some tools which you may use.  

Go to >Config >Networked-Computer Tools  

 Multi Call Stacking Options - Multiple options can be selected (one selection per set below)  

 
A callsign can be stacked from one radio/computer to another when in ' Networked-Computer Mode'. 
It does not matter if the target station is on a different band or the same band. A second 
operator can stack a call on your PC, and he could find stations and stack them for you to work.  

 To indicate which station you want to stack for, right click on it's "cue-ball" in the Info window, 

and select the option "Target for call stacking"  

 A maximum of one callsign can be stacked. as soon as the stack is empty another one may be 

stacked  

 After the target station pops the call into the entry window callsign area, depending on the 
Wipe Partner Call if Logged by Stack Target option below, the partner station may need to 
manually wipe his entry line before entering another call.  

 
Stacking within same band but not on the same frequency - You can do this simply by storing the 

call in the bandmap, for example by copying the call sign and then tuning off the frequency (using 
QSYing wipes the call and spots frequency). When on the same CQ frequency (within tuning 
tolerance) then you will see the other station keystrokes in your callframe and vice-versa. The intent 
is to have a helper working with you to pick calls out of the pileup.  

o Send Freq/mode to Call Stack Target Station Alt+I - This command was originally put 
in for WRTC-2006 competitors. It allows the partner station to remotely load VFO B on 
a target station. NB Will only work when Multi-user mode is selected  

o Send Partner F-Keys to Stack Target VFOA/Radio 1  
o Send Partner F-Keys to Stack Target VFOB/Radio 2  
o Send Partner F-Keys to Stack Target - Disabled - disables this feature  

o Wipe Partner Call if Logged By Stack Target - Disabled - partner station will need to 
wipe calls manually  

o Wipe Partner Call if Logged By Stack Target - Enabled - when station is logged, call is 
wiped  

o Partner Logging - Disabled - disables all partner logging features  
o Partner Logging - Enabled - enables all partner logging features  

 Talk to another station Ctrl+E - Send a message (chat) to one or all stations. The text sent 

will appear in big red letters in the messages part of the Info window from the receiving 
station. Enter station number (0-15 or *) followed by a space followed by the text of the 
message. By default the program places a * and behind that the band of the station who 
sends the message.  

o Station Possible station numbers  

 * - Send the message to all stations. Or, omitting the number sends the 
message to all connected stations  

 0 - Send a message to station 0 (Master station)  
 1 - Send a message to station 1  
 . . .  



 

 Force Time Sync Now - Force date and time synchronization with the "Master" computer. 
This happens automatically at start up and every 5 minutes thereafter.  

o There are tools for resyncing your time with Internet time standards. A nice one used 
by N1MM logger users is Dimension 4  

 Set your pass frequency Alt+Z - Send the frequency that you would like other stations to 

send contacts to. The pass frequency will be sent to all your Multi-User computers currently 
connected. If you just want stations sent to your CQ frequency, you do not need to set the 
pass frequency. At the present time, the pass frequency is reset only after restarting the 

program. If you put {PASS 3} in one of your CW or RTTY messages, the current pass (or CQ) 
frequency for station #3 will be sent in the message. When sent in CW, the program will 
automatically substitute 'R' for the decimal point. DO NOT enter 'R' in the pass frequency.  

o Enter 0 to reset your frequency.  
o The pass frequency is shown in the first bottom pane of the Entry window when 

entered and in the info window .  

 

 

 Log QSOs at all stations - Check this option to log all QSOs on all stations. Selected by 

default. All other information (packet spots, pass frequencies) are still distributed to all 
networked stations.  

 Show Connections - Show connection info from all the networked stations.  

 



o Status messages  

 Connected - a connection has been made with that station  
 Listening - listening for the master station, no connection made (yet)  
 Error - the Master station is not there (or not in Multi-User mode)  

 Reset Serial Numbers on all Stations - All QSO numbers on all attached stations will be set 

to 0. This is an option when the contest starts to have all attached computers start with 0 
even when there are 'practice' QSOs in the log  

 Resync Logs by Date - Allows a computer to gather all differing QSOs from other computers 
in the network for a 48 hour period  

o Enter the start date for the resync (48 hour contests). The date and time shown 

defaults to the time of the first contact in this computers log. If there is no log, then it 
defaults to the date of the contest from the log selection dialog.  

o The contests to resync have to be the same (all computers should have selected the 
same contest. Example: CQWWSSB).  

o Resync only pulls QSOs from other computers to the computer where the resync is 
requested. The resync is not bi-directional. It does not push QSOs to other stations. 
This way it does not load down the other computers as much.  

o When resyncing old logs you should just have to put in the correct starting point. The 
contacts must be logged with the correct station number (which is in the database). 
I.e. Station 0 will only send QSOs that are recorded for station 0. Station 1 will only 
send QSOs that are recorded for station 1  

 

 Resync Last n Hours - Allows a computer to gather all differing QSOs from other computers 

for a period. The period is set in hours. For more info about resync see 'Resync Logs by Date'  

 Rescore last n Hours - Rescore the last N hours for the current contest. It may be run at any 
time but is rather slow  

 Trace Networked-Computer Messages - Check this option to trace the Networked-

Computer messages send and received by the station to a trace file (*.TRC). A file name can 
be entered. This option is normally only used for error/bug tracking  

 Force Other Station to Stop Transmitting When I Transmit - Option to force other 
station to stop sending  

o In M/2 and Multi-Single it stops other stations with the same run1/2 selection  

 Block my Tx Only if Other Stn Transmitting on Same Band&Mode (Multi-One) - This 
option permits a second (mult) TRX to transmit simultaneously on another band. If this option 
is not checked, the second TRX is locked out on all bands, not just the same band&mode (for 

multi-one stations - check the contest rules!)  

 Disable all Transmit Interlocks - does what it says  

 Don't automatically change to S&P mode - This option disables automatic change to S&P 

when QSY. Useful when there is more than one radio on the same band.  

 Set station as Run 2 - Set this station as the Run 2 station (when in M/2)  

 Don't work non-mults - Do not allow this computer to log non-multipliers. Also giving CQ on 

this computer/radio is not allowed when selected  



 Show Computer Name _ IP Address Info - Shows computer name and IP address info by 

running the program 'IPCONFIG /ALL'  

 

CAUTION about Software Lockouts 

The "Force Other Station to Stop Transmitting When I Transmit" and "Block my Tx Only if 

Other Stn Transmitting on Same Band&Mode (Multi-One)" menu items are software lockouts. 
They are subject to network latencies and cannot be guaranteed to prevent simultaneous transmitting. 
Because of network latencies, lost packets, network dropouts or network failures there could be short 
overlaps in transmissions, or even complete failure of the lockout. For protection against damage from 
simultaneous transmitting, and/or to be absolutely certain that contest rules forbidding simultaneous 
transmissions are obeyed at all times, you must use a dependable hardware lockout system. Do not 

depend on software lockouts to prevent equipment damage and do not expect software 
lockouts to give you an ironclad guarantee of compliance with contest rules!  

4. Information 

The picture below shows the bottom part of the Info Window where multi-user information is 
displayed. Right clicking on the green/red icons will show a menu. See the Info Window for more 
information.  

 

 Connection status:  
o Green - Connected  
o Red - Not connected, but the other computer is being actively polled. Initially, when a 

computer is unable to reach another computer in the N1MM Logger network, the 
connection "ball" in the Info Window will turn red polling for the unreachable computer 

will continue for 3 minutes. . Users may experience delays or stuttering in this state. 
After 3 minutes, the polling will be automatically suspended, and the connection "ball" 
will turn blue. Since polling has been suspended, there will be no performance impact 
on users. When the unreachable computer comes back on-line, the computers will 
automatically reconnect, and the connection "ball" will turn green.  

o Blue - Not connected, but the other computer is not being polled. When the other 
computer becomes reachable, the connection will be automatically reestablished. 

Users will not experience delays or stuttering in this state.  
o Light red - Connection in progress or connection lost, the program will try to solve this 

situation. This is a transient state.  

 Station name  

 Pass frequency - clicking the pass frequency will send a message to the selected station. If the 
selected station is your own computer then the left VFO frequency will be changed to the 
current pass frequency.  

 Is he running or S&P  

 Who is the operator  

 Rate information  

 Run/pass frequency  

4.1. Rules 

The following 'smart' rules for run/pass frequency are implemented.  



 Running  

o I'm on & running  
 If the running check box is checked, always send to run frequency  

 Not running  

o I have a run frequency, but I'm chasing a multiplier  
 The run frequency holds for 1 min, then gets zeroed  

o I'm not running, and I have a pass frequency way up the band  
 The user will have to specify the pass frequency  

o Don't pass, my pass frequency is no good  
 I guess it is the operators responsibility to zero the pass frequency  
 Maybe a timer to remind if no QSOs on pass frequency for n minutes? (not yet 

implemented)  
o Don't pass, my CQ frequency is no good  

 Timer with no CQ's or QSOs on run frequency for 1 min? (not yet 
implemented)  

4.2. Displaying Rules 

Running - Show the run frequency  

Not running - Show the pass frequency if non-zero, if no pass frequency then show last CQ 
frequency if non-zero.  

5. Macro keys 

Macro key substitution is supported by most programmable buttons in the program. For Multi-User 
mode there are a few specific macros which can be found on the Macros Chapter.  

6. Features 

 Call stacking - Call stacking between computers, enter a callsign on a remote computers 
'stack'  

o To indicate which station you want to stack for, right click on it's "cue-ball" in the info 

window, and select the option "Target for call stacking"  
o A maximum of one callsign can be stacked. If the stack is empty another one may be 

stacked  

 Prohibit transmitting  
o If another station is sending (single operator or multi-one) don't allow sending if 

another station is sending  
o If another station is sending (multi-two or multi-multi) don't allow sending on same 

band  
o See also the option in the Networked-Computer tools under Config: Force Other 

Station to Stop Transmitting When I Transmit  

7. Where to Place the Database Files 

Do not share the log on a server, place it locally on the hard disk of each station.  

 Sharing logs on a server will MOSTLY not work. Mostly is not good enough. You will think you 

are ok, but are not. I do not check for Networked-Computer temporary errors. The program 
was NOT designed nor tested for this  

 Having the log on every PC provides redundancy, which is important in an RF-filled 
environment  



 It will not perform as well. Local access is almost always faster.  

 
There is no harm in using a server to aid in copying files. The mdb files are simply files. They may be 
moved around. It is best to close the program before moving them, as with any program writing to an 
open file.  

8. Other Information 

 Deleting QSOs made by another station in a Networked-Computer situation is not allowed, and 
a warning message is shown. QSO's must be deleted on the station that made the QSO.  

 Station 0 sends all incoming spots to every station so the bandmaps are being filled. Use the 

Telnet window (not the Packet window) on the other computers in the network. If you send a 
message to the packet cluster from any station in the network it will be sent out to 
packet/telnet via computer 0. The received answer from the packet cluster will be send out on 

the network to all stations  

 The program should not be shutdown while initializing Networked-Computer mode, otherwise 
unpredictable situations could occur  

 You will be prompted for the operator call if it has not been entered (with Ctrl+O). A periodic 

warning message will be shown if no operator has been specified  

 After you have entered the operator call, you can go to Save Window Positions on the entry 
window's Tools menu and save the window setup for that particular operator. Thereafter, 

when that operator signs on again, the window setup will be adjusted to the operator's 
preference.  

 The CQ/pass frequencies will be requested at startup  

 When going through the possible contests you will see a "contest" DELETEDQS. This is not a 

contest but deleted QSOs will be moved here by the program. This can be useful after the 
contest.  

 Connection status is shown at the bottom of the info window  

 A connection is checked every 10 seconds  

 All connections are stopped/started when the database, the contest or the connection list is 

changed  

 Also Non-master stations are allowed to close telnet/packet ports  

 Time synchronization is only shown on the master station  

 Non-master stations in Windows Vista, 7 or 8 should be run using the "Run as Administrator" 

option in Windows, in order to allow the Master station to adjust the system time in the non-
master stations so all computers have the same time  

 If you Mark or Store spots on a local machine, they will be Marked or Stored on all other 
machines  

 The station name prefixes telnet/packet commands that are displayed. The prefix is not sent 
to the cluster. Example: 20M sh/dx  

 When a connection drops out it will try to reconnect every 30 seconds  

 Ctrl+Alt+M changes the station status. For Multi-single, ctrl-alt-M changes toggles the station 
between Run and Mult status. For multi-2, ctrl-alt-M toggles the station between Run1 and 
Run2 status. This station status will be shown on the Cabrillo output.  

 In the multi-multi category the Cabrillo output will show the station number. In the multi-
single category, the Cabrillo output will show whether the QSO was made by the Run or Mult 
station. In the mult-2 category, the Cabrillo output will show whether the QSO was made by 
the Run1 or Run2 station.  

 Any station that is harmonically related with the frequency will be colored red in the Info 
window  

 For single operator and multi-one, the operator callsign will be colored red when transmitting  

 Group edits are not allowed in the Log window while in Networked-Computer mode  

 If a station has selected 'Config | Networked-Computer Tools | Don't work non-mults' , CQing 

on that station is not allowed  

http://n1mm.hamdocs.com/20M


 Only the master station will auto-reconnect to packet/telnet when enabled  

9. Example Networked-Computer Setup 

The example below uses file sharing and Netbios lookup for computer (you can see them in the 

Networking environment). This is not necessary for N1MM logger to work in Networked-Computer 
mode. When the computers can be 'pinged' from both sides this is enough to work. All lines with a * 
are not necessary to work but are nice to have for other purposes like updating of files etc. This does 
not mean that the action mentioned should not be done. It can also be done via other media (CD / 
diskettes). In that case the Windows network is not used, as the N1MM network is using the TCP/IP 
stack only.  

9.1. Before the Contest 

Master computer  

 Enable File sharing for Windows networks (*)  

 Have all installation files ready on master (*)  

 Set Master IP address according to Station Computer Names list (see below)  

o Note previous IP setting for restoration after contest  

 Note master Windows computer (NetBIOS) name & workgroup (*)  

 Start N1MM Logger  

 Select a new empty database (e.g. PACC2003.MDB) on master  

 Start a new log for the contest (e.g. PACC) (check manual)  

 Configure Function keys (SSB/CW/Packet)  

 Edit Station Computer Names according to plan. For example:  

o Stn#:Stn Name Computer IP Address  
o 0:master 192.168.10.10  
o 1:160M 192.168.10.1  
o 2:80M 192.168.10.2  

 Load the relevant country file (e.g. CTY-PACC.DAT) (Tools menu)  

 Select the Master.dta file to use ('File | Choose Which Contest to Log')  

 Establish DX cluster communications on the master computer (Packet or Telnet)  

 Setup or disable internal firewall  

 
Non-master computers  

 Install Network card& TCP/IP when not already done  

 Setup or disable internal firewall  

 Enable File sharing for Windows networks (*)  

 Set IP address according to Station Computer Names list  
o Note previous IP setting for restoration after contest  

 Find master on the Windows network (*)  

o Use Search Computers in Network Neighborhood/Places using the masters Windows 
computer (NetBIOS) name)  

 Install/Update N1MM Logger  

o Copy from master via network (*)  

 Copy database (eg.PACC2003.MDB) from master on this computer  

o Copy from master via network (*)  

 Copy WAV directory from master on this computer  
o Copy from master via network (*)  



 
All computers  

 Start N1MM Logger  

 Import windows settings  

 Open database (e.g. PACC2003.MDB) ('File menu) | Select: PACC log')  

 Set Networked-Computer mode on  

 Setup configuration (Rig control, PTT, CW)  

 Turn off Windows sounds if using WAV files  
o Control Panel - Sounds - Scheme: No Sounds  

 
Always  

 Make sure you are running the same version of the program on all computers  

 Make sure you are using the same contest on all computers  

 Make sure that all computers have the same time zone and daylight savings offset  

 Preferable, see if all computers have the same regional settings for numbers, dates, currency, 
etc  

 Preferable, see if all computers have the same short and long date and time formats  

9.2. During the Contest 

 Check master time setting regularly  

o Use Internet time server if possible so it is done automatically  

 Observe network status, and reconnect/resync if necessary on all computers  

o Note that a resync only imports QSOs to the computer you import from! The computer 
where the import comes from is not being updated with the log from computer where 
you import to. Stated another way, a workstation will always "pull" QSOs from another 
workstation log, it never "pushes" QSOs out.  

 

Changing Out a Computer During a Contest 

The best way to swap out a computer in the middle of a contest is to simply leave the old computer in 
the computer names list, and add the new computer to the end of the computer names list.  

The new computer should have a unique IP address - different than the old computer. Yes, you would 

have to change the computer names table on every computer in the network, but it is the most fail-
safe method.  

You should definitely NOT try changing the IP address of the new computer to the same IP address as 
the old computer, nor remove the old computer from the station computer names list. Doing either of 

those is asking for problems. 

9.3. After the Contest 

 Make sure all used computers are connected  

 Do a resync on all computers  

 Check QSOs/multiplier status on all computers & compare  

 Copy & compact database (e.g. PACC2003.MDB) to backup directory  

 Restore IP settings & Windows sounds scheme on borrowed PCs  

10. Networked-Computer Log Synchronization 



Log synchronization is something you should run very infrequently. Each station has its own copy of 

the log, so syncing them is only necessary to keep track of mults. They will get out of sync when one 
of the stations goes off line. Generally, you should only need to resync the last hour, if you were 
disconnected for less time than that. If a new station comes on line, then one of the stations should 

email him their database, and he can resync the log when he gets it, for the few minutes he missed. 
Where it would take a long time is when a station was off for many hours, and you want to preserve 
any contacts that may be in his log, but not in the others.  

11. Multi-Multi Distributed - Networked-Computers via the 
Internet 

It is possible to set up N1MM Logger to allow some or all of the other stations outside your LAN to 
communicate over the internet. Possible uses for this feature are: Headquarters (HQ) stations in the 
IARU contest, the CQWW "Extreme" category, and distributed special event stations.  

11.1. Configuration 

 
There are some caveats when trying this. You need more than basic computer knowledge for this. You 
need to know about IP-addresses, firewalls, routers, port settings, NAT etc.  

You need to know your computer (external) IP-address. When directly connected to the internet, this 
can be obtained using the program ipconfig. The command 'ipconfig' should be entered in a command 
(cmd) window to see the output. When your computer is in a LAN your connection to the internet will 
probably be made via a router. All computers will use internal IP-addresses; the router uses the 
external IP-address. This link will give your (external) ip-address: http://www.whatsmyip.org/  

When a Networked-Computer connection is not working, check the external IP-addresses. It is 
strongly recommended that static external IP addresses be used. When DHCP is used to obtain the 

external IP address from the Internet Service Provider (ISP), the external IP address can change at 

random and unexpected times. You should not depend on Dynamic DNS (dyndns.org) and similar 
services to provide the correct IP address to other computers in the extended network. Often, the 
domain name-to-IP address mapping is stored in your local computer or router, and may not be 
updated by Dynamic DNS.  

The router should be set up to route incoming UDP and TCP traffic to your local PC IP address. This is 
done using a router feature that is typically called Network Address Translation (NAT), Port Forwarding 
or Port Redirection.  

The incoming port will be 12070 + Station Nr (0-15). 12070 is used for the first PC in the list, 12071 
for the second etc.  

You must also configure your computer and router Firewall(s) to allow port 12070 + Station Nr (0-15) 
to be passed for incoming UDP and TCP traffic.  

>Config >Edit Station Computer Names  

 Computers using N1MM logger in the local network need to use the local IP address, 
computers outside the local network need to use the external ip-address from the external 

network. The router on the external network should use port forwarding to the correct 
computer using N1MM logger  

 Example setup:  
o The address 192.168.1.11 is the local IP-address at my end (PA1M)  



o The first two entries are two instances of N1MM logger on two different PC's from Tom 

(N1MM)  
o Example 'Port redirection table' in the router used at PA1M, the given names differ per 

router brand:  

 Service name : N1MM (does not matter)  
 Protocol: TCP and UDP  
 Public Port: 12072  
 12072 = 12070 + 2, my local pc which needs to be connected from the 

'outside'  
 Private IP: 192.168.1.11  
 Private Port: 12072  

 Active: Yes  
o NB the IP-address given in this example is not the IP-address used by Tom, N1MM any 

more  

 

 
The latencies when we tested were in the 100 mSec range.  

 

IP Addresses 

The list of IP addresses needs to be different on each machine. Make sure the remote machine has its 
external IP address, and the local machine(s) has its internal address 

 

Example at PA1M 
 
0:N1MM 64.252.138.65  
1:N1MM-2 64.252.138.65  
2:PA1M 192.168.1.11  

Configure router and firewall to pass and forward UDP and TCP port 12072 to 192.168.1.11  

Example at N1MM 
 
0:N1MM 192.168.0.1  
1:N1MM-2 192.168.0.2  
2:PA1M 63.133.11.55  

Configure router and firewall to pass and forward UDP and TCP port 12070 to 192.168.0.1.  
Configure router and firewall to pass and forward UDP and TCP port 12071 to 192.168.0.2.  



11.2. Footswitch Support for Lockout 

Footswitch lockout support has been added for multiple distributed stations. 
 
In the IARU contest a headquarters station is allowed to use multiple stations located within one IARU 

zone, but the rule of one signal per band/mode is still in effect. So there could be 2 (one running 
station and another looking for multiplier) or more stations on the same band and same mode and 
they should keep only one TX signal on this band at any time. Now you can hook up a footswitch to 
the LPT port 15 (the LPT port must be enabled even if it is not being used for other purposes. There is 
no special check box to turn the footswitch feature on/off). If the station is not in multi-multi operator 
category the footswitch will directly control PTT just like Alt+T. If it is a multi-multi station (connected 
to other stations on LAN or via the Internet in Multi User mode) it will prevent two stations on the 

network from both transmitting on the same band/mode combination. 
 
This is a software lockout only, and is subject to network latencies. As such, it should be considered a 
backup. Multiple stations on the same band/mode should always coordinate operations (with the help 

of message passing over the network from the Info window), and not depend on software lockout to 
ensure compliance with contest rules.  

 

2.12.4 Spot Filtering 

 2.12.4 Spot Filtering  

 
There are three levels of spot filtering available. The first of these is at the DX cluster node, using 
whatever filtering capabilities are built into the node. Because N1MM Logger stops processing telnet 
messages when CW is being sent, users who are connected to a very high volume node, such as the 
Reverse Beacon Network's Telnet node, may find it advantageous to block some of the less useful 

spots (for US users, you might not want spots from VK, for example).  

The second level of spot filtering is accessible from the right-click menu of the Packet/Telnet window, 
and decides which spots received from the cluster node should be forwarded to the Bandmap and the 

Available window. If too many spots are forwarded, depending on how fast your computer is, you may 
encounter brief delays in execution of commands (such as sending of CW messages) while the 
program catches up,. See the section on the Packet and Telnet window for specifics.  

The third level of filtering is set in the right-click menu of the Available Mults and Qs window, and it 
only governs which spots are shown in that window's lower pane. For example, if you decide only to 
list CW spots, the bandmaps will continue to display all spots, and the top pane of the Available 
window will continue to display overall spot numbers for each band, but the lower pane's list of spots 
will contain only CW spots. You can quickly switch back and forth between showing all spots, just 
those on the current band, only CW or SSB or digital spots, or any other band/mode combination.  

 

2.12 VHF and Up Contesting 

 2.12 VHF and Up Contesting  
o 1. VHF Options  

 1.1. Frequency display  
 1.2. Multiplier by Band Window  

o 2. Gridsquare Key Assignments (VHF and up)  

http://n1mm.hamdocs.com/tiki-index.php?page=Packet+and+Telnet+Window
http://n1mm.hamdocs.com/tiki-index.php?page=Available+Mults+and+Qs+Window


o 3. Call History Lookup  

 3.1. Updating the Call History File  
o 4. VHF master.dta File  
o 5. Transverter Support  

o 6. VHF Beacons  
o 7. Example Contest Setup  

 7.1. Create (Days Before the Contest)  
 7.2. Before Starting the Program  
 7.3. After Starting the Program  

N1MM logger has some features which will be appreciated especially by VHF and up contesters. The 
program supports bands up to the SHF bands 10, 24, 47, 76, 142 and 241 GHz  

1. VHF Options 

1.1. Frequency display 

The frequency is shown in the Bandmap and in the Entrywindow. When the frequency is above 1 GHz 
the band will be shown in cm, not the exact frequency in the Entry window. When entering QSOs it's 
easy this way to recognize the band in which you log.  

1.2. Multiplier by Band Window 

The Multiplier by Band window includes a Grid Square option. Start the program, open a VHF contest, 
open the Multiplier window and then click on the "Other" radio button at the bottom. You'll see the 
following display, centered on your grid square - the one entered on your Station Data window.  



 

The Grid Square display has a few additional features, in a right-click menu. Click somewhere in the 
grid array and the following menu appears:  

 

 Show Calls Worked - Grid squares you have already worked are colored pink. To see which 

calls you've worked in a given grid, right-click on that square to bring up the menu, and then 
left-click on this option. A separate window will open displaying the calls and times they were 
worked.  

 Set Grid Center - Right-click anywhere in the grid array, and then left-click on this option. 

Enter the four-character grid square you want in the dialog that appears, and hit Enter.  

 Show Bearing to Grid - Right-click on a grid square, left-click on this option, and a window will 
open displaying the bearing and distance from your QTH to the center of the square.  

 Turn Antenna to Grid - Right-click on a grid square, left click on this option, and if you have a 
rotator interfaced with the program, the antenna will be turned to the correct bearing.  



 Set Rover QTH - Right-click on the square you are in, and left-click on this option, and the 

program will temporarily reset the reference point for bearings, etc. to your current location. 
Works only if you select Rover as your class.  

 Minimum Grid Square Box - Right-click anywhere in the grid array, and then left-click in this 
option to display a grid array with absolutely minimum-sized squares (just large enough to 

contain 2 letters and 2 numbers). You can toggle this off, or it will close automatically if you 
either close the Multiplier window or the program.  

 

2. Gridsquare Key Assignments (VHF and up) 

 Alt+equal (=) - Search entered info from both the Callsign field and the Gridsquare field in 
the call history table  

o The results will be shown in the Check window  

 Alt+minus (-) - Toggle through call history and entered grid squares (max 3) in the grid 

square entry field  
o When no grids are found in the call history there is nothing to toggle  

3. Call History Lookup 

More information about this can be found in the Before the Contest chapter.  

This feature is very useful in VHF contests. Lookup examples are lookups for names (Friends file in 
RTTY contests), gridsquares for VHF contests, ages in All Asian DX contests etc. With the importing 
and exporting options the call history table can be updated.  

Call history lookup is enabled with the option >Config >Call History Lookup. If enabled, it will look up 
in VHF contests: Grid Square (max 2) and Name.  

3.1. Updating the Call History File 

The program itself does have a function to export the log file to (update) the call history table under 
>Tools >Update Call History with current log'. This function will fill the call history table with the 
contents of the currently selected log.  

Another method used which gives more control is the separate program called Thucydides by Carel, 
PC5M. Check it out in the Links chapter chapter and the Third Party Software chapter..  

4. VHF master.dta File 

For HF there are several master.dta files which contain callsigns of active contesters. Select the Master 

Callsign database link on the download page. There are separate files for RTTY and for VHF and up 

contesting. A very nice tool to create a master.dta file has been written by Alex, VE3NEA. This tool can 
be downloaded from his site (see the Links chapter) and is freeware! A text file with callsigns is 
needed. An example master.dta file for VHF is available from the N1MM website in the 'Other Files' 
menu under 'Downloads'.  

5. Transverter Support 

N1MM logger has transverter support in the form that per band an offset frequency can be set. Right 
click on the bandmap and select >Set transceiver offset frequency. The offset value is saved by the 
program so after a restart the offset is still there.  
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 Band (kHz) - enter the transmit frequency of the transverter  

 IF Freq (kHz) - the frequency used between the radio and the transverter  

 

An offset can also be added to adjust the transverteror radio to the exact frequency (like when the 
oscillator is a bit off).  
See the 432000,12 example where a correction is being made of 120 Hz. Great to have to be right on 
the packet cluster spots!  

Bandup/Banddown 
 
If you have a radio that has 160-2m, and you want to use bandup/banddown, you'll need to put 
entries in for bands that you do not have transverters for, if there are gaps in bands that the 

radio/transverters cover. You would really have to put a lot of transverters offsets in if you want the 
frequencies to "wrap".  

 

Next Offset Band 

If the next band is not defined as offset to a frequency that my radio can handle and bandup/down is 

used, it goes to an HF frequency (without offset). 

 It does not work if your radio does not accept the calculated frequency. For example, set up 
for Band: 144000 and IF freq: 28000 and you put in 146100 and your radio can't go to 30100, 

you will get strange results  

 Remember to enter the frequency of the transceiver and not that of the transverter when 
going into split mode (Alt+F7).  

6. VHF Beacons 

N1MM logger is capable to show beacons in the bandmaps for a defined period of time. Normally every 

spot in the bandmaps will disappear after the 'Packet Spot Timeout' which is valid for every spot in the 
bandmap. The same for beacons coming in as spots. So an extra import option has been added for 
beacons with where the spot timeout can be set to a much higher value (like days or even weeks).  

Importing beacons and showing them in the bandmaps for the bands can be done by importing a text 

file in a specific format. Enter the text BEACONS in the Entry window callsign field and a file selection 

dialog will open where a .txt file (with beacons in the correct format) can be imported. An example 
beacons text file can be found in the N1MM logger program directory (called Beacons.txt). In the 



beacons text file lines with a # are remarks, the first line in the text is the timeout for all beacons in 

hours. Every line with a beacon must contain callsign, frequency (in kHz) and grid locator (4 or 6 
digit). The frequency may be in either US (50000.25) or European (50000,25) format. A comment per 
beacon is optional. Note the ; as separator (don't forget one or it won't import). Below an example 
beacons.txt file.  

# Hours to stay in bandmap (mostly > 24 or > 48) 

 
60 

 
# Call beacon;Frequency;Grid;Comments 

 
OZ7IGY/B;144471,1;JO55WM; 

 
PI7CIS/B;144416,2;JO22DC;Should always be heard 

 
DL0PR/B;144486,3;JO44JH;Switches power! 

 
GB3VHF/B;144430.4;JO01DH;QRG with a . 

 
ON0VHF/B;144418,5;JO20;4 digit grid 

A file with beacons in the correct format for Europe (Region I) can be found on the N1MM website 
under 'Other Files' in the 'Download' menu.  

 

The NCDXF/IARU Beacon Network 

No need to add the NCDXF/IARU Beacon Network on 14.100, 18.110, 21.150, 24.930 and 28.200. 

They are already incorporated in the program and the beacon transmitting at that time (when your PC 
clock is correct) will be shown in the Entry window statusbar when you are listening on one of these 
frequencies. 

7. Example Contest Setup 

Additions are welcome!  

7.1. Create (Days Before the Contest) 

 New master.dta file  

o Use tool from Alex, VE3NEA, see the Links chapter  

 Create 'N1MM logger.ini' to use during the contest  
o Setup all the program setting and place the windows as you like them during the 

contest (on the computer to use)  
o Don't forget the tab 'Mode Control' in the Configurer.  
o After closing the program it has created a file called 'N1MM logger.ini 'with all the 

settings  
o Copy 'N1MM logger.ini' (not .init) to ' VHFsettings.ini'.  

 Text file with contents Function keys for SSB/CW  

o As a start:  
 'File | Export | Export Function Keys to file... | SSB Function Keys'  

 Give a name like: VHFssbfunctionkeys.mc  
 'File | Export | Export Function Keys to file... | CWFunction Keys'  
 Update these text files if needed  

o Check possible macros in the Macros chapter  

 Packet/Telnet button text file  
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o As a start: >File >Export >Export Packet/Telnet Buttons to file...'  

o Update this text file if needed  
o Give a name like: VHFpacketbuttons.txt  
o Check possible macros in the Macros chapter like {GRIDSQUARE}  

 Lookup database text file for the VHF contests to use  
o Create a text file with callsign, name, locators etc.  
o Give a name like: VHFlookup.txt  
o See info about CallHist file  

 SSB: Wav files for CQ, rst, exchange etc.  
o Create wav files for all operators  
o See {OPERATOR} macro in the Macros chapter  

 Download up to date country file (cty.dat)  

o mostly a country file is not used for VHF and up contesting but the program gives 
information in the Info window about the logged callsign so download the latest 
version  

 Check if the selected contest is still ok, make some test QSOs  

o This should be done weeks before the contest!  

 ....  

7.2. Before Starting the Program 

 Copy the created master.dta file in the N1MM logger program directory  

 Copy the wav files from all operators in the WAV directory  

 Turn off Windows sounds if using WAV files  

o Windows >Control Panel >Sounds - Scheme: No Sounds  

 Rename ' VHFsettings.ini'. to 'N1MM logger.ini' and copy it into the program directory  
o The program will start using the settings as set up days before the contest  

7.3. After Starting the Program 

 Select/Check if correct database is used  

o >File >Open Log in Database, select VHF database'.  

 Import  

o This has to be done only once if every time the same database is used!  
o Each database can handle many contests and thousands of QSOs, don't use a 

database for every contest!  
o Updated files (like the lookup file) have to be imported before every contest.  

 The function keys macros (SSB/CW)  
 >File >Import >Import Function Keys to file... >SSB Function Keys. 

Use file created above (Example: VHFssbfunctionkeys.mc)  
 >File >Import >Import Function Keys to file... >CW Function Keys. 

Use file created above (Example: VHFcwfunctionkeys.mc)  
 The packet/telnet buttons  

 >File >Import >Import Packet/Telnet Buttons from file... Use file 
created above (Example: VHFpacketbuttons.txt)  

 Lookup file  

 >File >Import >Import Call History File. Use file created above 
(Example: VHFlookup.txt)  

 Country file  
 >Tools >Import country list from downloaded file. Use file 

downloaded/updated above  
o Check Station dialog (>Config >Change your Station Data)  

o The locator from this dialog is used for distance calculation so needs to be entered!  

 Check contest ( >File >Choose Which Contest to Log)  
o Check if entered information is correct.  
o Enter Sent Exchange (this is contest specific, see Setup Contests chapter)  
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 Setup configuration (Rig control, PTT, CW)  

o Check Configurer >Mode Control tab  

 When using a transverter, enter offset for bandmap A and bandmap B  

 ....  

 
Have fun during the contest!  

 

2.11 Error Messages (and what they mean) 

 
Often, particularly for new users, the variety of error messages that may be seen when using N1MM 
Logger is intimidating. Some of them are produced by the program and some by Windows. In the 

table below, we have tried to de-mystify some of the most common ones by giving a plain-language 
explanation and providing links to relevant sections of the documentation.  

Error Message  Explanation  Solution 

EntryWindow (ValidateIniLookup) - 3159 
and Run time error 91 - Object variable 

or with block variable not set 

This typically occurs when just starting 
the program, and probably indicates 
that Windows has changed the 
enumeration of your audio devices or 
virtual port numbering, which now do 
not match the N1MM Logger.ini file 

Rename your N1MM Logger.ini file so that the 
program cannot find it, restart the program, and 
reset your port and audio device information, working 

with Device Manager to ascertain what Windows has 
done. 

EntryWindow(stn_WindowFocusSwapped) 

10014 - Invalid Argument  

Can occur when switching radios (in 
SO2R) or VFOs (in SO2V) with the 
keyboard hot-keys, if you are also using 
N1MM Rotor Control and if the version of 

the Microsoft Winsock control 
(mswinsck.ocx) on your computer is in 
the range from 6.01.9812 to 6.01.9816  

This bizarre error is probably the result of a Microsoft 

update, and if so, a hotfix is available from Microsoft 
(see http://support.microsoft.com/kb/972877 for 
details). Try closing Rotor Control and see if the error 

stops happening. If so, search your machine for 
mswinsck.ocx. If it is in the range described in the 
Microsoft Knowledge Base, contact Microsoft Support 
for the hotfix. 

Err 8 - Error opening wav file  

Means that the program cannot find the 
WAV file named at the location specified 
in the table of SSB function key 
definitions. You can access and edit this 
table by right-clicking on the Function 
Key buttons in the Entry Window.  

Refer to Interfacing Basics for help. 

Another station is transmitting  

In certain multi-operator classes, in 
particular contests, transmitting more 
than one or more than two signals at 
the same time is not permitted. You 
may have selected the wrong class or 
contest.  

See Multi-User Support? 

Cabrillo not supported for this contest. 
Please use: Export to File (Generic)...  

Some contests do not accept Cabrillo, so 

if you try to generate a Cabrillo file you 
will get this error.  

Self-explanatory 

Error sending CW. Check port selection in 
the Configuration dialog.  

You didn't designate a CW port and/or 
method  

See the Configurer 

hamtemp.mdb already exists. Please 
rename it before proceeding  

Appears when trying to copy a database, 
if you have previously had some 
difficulty with the program that caused a 

temporary database file to be left in the 

Use Windows Explorer to delete hamtemp.mdb from 
the program directory. 
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Error Message  Explanation  Solution 

program directory rather than deleted.  

Invalid Sent Exchange value: Use File, 
Open Log in Database to correct.  

When generating a Cabrillo file, if the 
Sent Exchange is incorrectly set in the 
Contest Setup dialog, you'll see this 
message.  

Check Contest Setup Instructions for the current 
contest and correct as necessary 

Multi-User mode should not be disabled 
during a contest.Contacts made while in 
single-user mode may be deleted during 

a multi-user sync.To disable a non-
working computer, right click its 'cue-
ball' and choose 'Prevent Automatic 
Reconnect Attempts' from the other 
computers.  

DO NOT DISABLE multi-user mode and 
then make contacts on that computer. 
The contacts will be logged with the 

wrong computer/station number and will 
be deleted by the other station when 
you reconnect. This is a common 
operator error during multi-op 
contesting.  

See Multi-User Support? 

N1MM Logger.ini is read-only. No 

program settings or window settings will 

be saved. Use Windows Explorer to 
change its properties.  

Self-explanatory. This sometimes 

happens when using a USB drive or CD-

ROM disk to transfer an ini file from one 
computer to another 

 

This contact cannot be logged because it 
is not a mult. If you wish to log mults on 
this computer, turn off the option in the 
Config/Multi-User Tools menu. You have 

chosen to only work mults on this 
computer!  

In some contests, a second transmitter 
may only work new multipliers.  

See Multi-User Support?. 

You must install base version 10.0.0 
before installing this one  

Seen only when first installing the 
program. You must do a Base (also 
called "Full") installation before installing 
the latest update.  

See the installation instructions 

Macro subscript out of range  

Typically seen when trying to load a set 

of function key definitions from a text 
file.  

Use Notepad to open the text file and check for line 

wraps. Each line in the table should be just one line, 

no matter how long (up to 255 character. Also check 
for extra lines at the end of the text file. Remove 
them, as well as any wraps, and re-try. 

8020 or Error 8020  

Appears in the lower left corner of the 
Entry Window, and is an indication that 
the USB-to-serial adapter driver you are 
using is not compatible with Visual Basic 
6.0  

See USB Interface Devices for a summary of user 
experience with various adapters and their drivers. 
You may be able to find an updated driver for your 

adapter on the Internet. This is thought to be specific 
to adapters using Prolific chip sets. See also: this 

Microsoft Knowledge Base article  For prolific chip 
set adapters, try installing the latest driver from: 
http://www.prolific.com.tw/eng/downloads.asp?id=31

 

This action cannot be completed because 
the other application is busy. Chose 
'switch to' to activate the busy 

application and correct the problem  

This usually results from a conflict 
between the main and CW sending 
components of the program, usually 
because of a configuration error. Please 

report all instances as a help to 
identifying the specific source(s).  

Rename your N1MM Logger.INI file so that the 
program will start fresh, and check under Processes 
in Windows Task Manager to be sure that CW IF.EXE 
is not still running. If it is, stop it before restarting 

the program. If the program then restarts normally, 
reconfigure. 

Entry Window (Station.Initialize) 48 Error 

in Loading DLL  

Indicates that the program cannot find a 
DLL it needs to run. This is usually a 
result of problems in the initial Full 
Install on Vista or Windows 7, often 
caused by installing to the Program Files 
folder. This can lead to problems with 
User Access Control (UAC).  

See Installing the Software. If installing the software 
doesn't eliminate the error, place a copy of 
DAO360.DLL V3.60.2521.8 in the program directory. 
Current program versions display this instruction in 
the error message box. 
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Error Message  Explanation  Solution 

Err 14 - Device not found and the path to 
the wav file  

Appears in the lower left corner of the 

Entry Window. Means that the program 
could not find the sound card or other 
device used for playing back stored 
messages.  

See the Audio tab in the Configurer 

ADIF import error- message This file 
must be imported into a contest of type 
[contest name].  

If you have opened the right contest in 
N1MM before attempting an ADIF import 
from another program, this error 

probably means that something in the 
incoming ADIF file is not in the format 
that N1MM Logger expects.  

The easiest way to trouble-shoot this is to create a 
log in N1MM Logger in the affected contest and 
export an ADIF file with at least one dummy QSO. 

Then compare the structure of the export with the 
ADIF you are trying to import, and correct as 
required. 

The radio mode is not set. The radio may 

not be connected.  

If your radio is not connected, or not 
communicating properly with the 
program, then N1MM Logger does not 

know what mode (CW, SSB or Digital) 
you want to log in.  

You can set the mode, even without a radio 
connected, by typing CW, USB, LSB or RTTY in the 
callsign field of the Entry Window, and pressing 
Enter. The mode will then show in the Entry Window's 

title bar. If you change modes, repeat this process. 
See the Configurer and the list of supported radios for 
help in interfacing your radio. 

Missing/Invalid Exch  

When this message appears in the lower 
left-hand corner of the Entry Window 
and the program will not log the QSO, 

the reason is that it does not believe 
your entered exchange is in the proper 
format for the contest.  

Check what you have typed. Common errors include 
the letter "O" instead of zero in a serial number 

contest. If you can't find an answer, you can force 
logging by pressing Ctrl+Alt+Enter. 

Not enough memory to complete this 
operation. Quit one or more applications 
to increase available memory and try 
again.  

This error message occurs with Windows 
Sound Recorder when trying to record 
with more than 2 GB of available 
memory (as in the case of many modern 

Windows 7 computers). See 
http://support.microsoft.com/kb/284893

.  

Use another application to record your messages. 
Audacity?is a particularly good choice for this 

purpose. 

Run-time error 383  

Reported when trying to open N1MM 
Logger when digital modes and MMVARI 
are selected. Typically, results because 
another program using an earlier 
version of MMVARI.ocx was installed 
after N1MM, causing the registry to be 

incorrectly modified.  

If you are comfortable with registering .dll and .ocx 
files, you can simply un-register and re-register the 
version of MMVARI.ocx supplied with N1MM Logger in 

the program directory. Otherwise, you will need to 
uninstall N1MM Logger, run the Full Install, and then 
run the Latest Update to register the right version of 
the .ocx in its proper place and return to proper 
operation. 

Err 429 - EntryWindow 
(Database_Initialize) - 429 - ActiveX 
component can't create object  

Unable to launch N1MM Logger from a 
fresh install  

From Windows >Start >Run, CMD. From the CMD 
window, enter the following commands: 

regsvr32 "C:\WINDOWS\System32\scrrun.dll" 
regsvr32 "C:\Program Files\Common Files\Microsoft 
Shared\DAO\dao360.dll" 
(Yes, the double-quotes are required) 
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